Modeling and Multivariate Methods
Get the Most from JMP®

Whether you are a first-time or a long-time user, there is always something to learn about JMP.

Visit JMP.com and to find the following:

- live and recorded Webcasts about how to get started with JMP
- video demos and Webcasts of new features and advanced techniques
- schedules for seminars being held in your area
- success stories showing how others use JMP
- a blog with tips, tricks, and stories from JMP staff
- a forum to discuss JMP with other users

http://www.jmp.com/getstarted/
“The real voyage of discovery consists not in seeking new landscapes, but in having new eyes.”

Marcel Proust
# Contents

JMP Modeling and Multivariate Methods

## 1 Introduction to Model Fitting

### The Fit Model Platform

- The Fit Model Dialog: A Quick Example ........................................... 3
- Types of Models .............................................................................. 5
- The Response Buttons (Y, Weight, Freq, and By) ......................... 7
- Construct Model Effects Buttons ..................................................... 7
- Macros Popup Menu ........................................................................ 8
- Effect Attributes and Transformations ........................................... 10
  - Transformations (Standard Least Squares Only) ......................... 12
- Fitting Personalities ....................................................................... 12
- Other Model Dialog Features ......................................................... 14
  - Emphasis Choices ....................................................................... 14
  - Run ............................................................................................. 14
  - Validity Checks ........................................................................... 14
  - Other Model Specification Options ............................................. 15
- Formula Editor Model Features ....................................................... 16
  - Parametric Models ...................................................................... 16
  - Adding Parameters ..................................................................... 19

## 2 Standard Least Squares: Introduction

### The Fit Model Platform

- Launch the Platform: A Simple Example ........................................ 23
- Regression Plot .............................................................................. 26
- Option Packages for Emphasis ....................................................... 27
- Whole-Model Statistical Tables ....................................................... 28
  - The Summary of Fit Table ............................................................. 28
  - The Analysis of Variance Table ................................................... 30
  - The Lack of Fit Table .................................................................. 31
  - The Parameter Estimates Table ................................................... 33
# Chapter 3: Standard Least Squares: Perspectives on the Estimates

## Fit Model Platform

<table>
<thead>
<tr>
<th>Table/Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Effect Test Table</td>
<td>34</td>
</tr>
<tr>
<td>Saturated Models</td>
<td>35</td>
</tr>
<tr>
<td>Leverage Plots</td>
<td>36</td>
</tr>
<tr>
<td>Effect Details</td>
<td>40</td>
</tr>
<tr>
<td>LSMeans Table</td>
<td>40</td>
</tr>
<tr>
<td>LSMeans Plot</td>
<td>41</td>
</tr>
<tr>
<td>LSMeans Contrast</td>
<td>43</td>
</tr>
<tr>
<td>LSMeans Student’s t, LSMeans Tukey’s HSD</td>
<td>45</td>
</tr>
<tr>
<td>Test Slices</td>
<td>46</td>
</tr>
<tr>
<td>Power Analysis</td>
<td>46</td>
</tr>
<tr>
<td>Summary of Row Diagnostics and Save Commands</td>
<td>46</td>
</tr>
<tr>
<td>Row Diagnostics</td>
<td>47</td>
</tr>
<tr>
<td>Save Columns Command</td>
<td>48</td>
</tr>
<tr>
<td>Examples with Statistical Details</td>
<td>49</td>
</tr>
<tr>
<td>One-Way Analysis of Variance with Contrasts</td>
<td>50</td>
</tr>
<tr>
<td>Analysis of Covariance</td>
<td>52</td>
</tr>
<tr>
<td>Analysis of Covariance with Separate Slopes</td>
<td>54</td>
</tr>
<tr>
<td>Singularity Details</td>
<td>56</td>
</tr>
<tr>
<td>3 Standard Least Squares: Perspectives on the Estimates</td>
<td>57</td>
</tr>
<tr>
<td>Estimates and Effect Screening Menus</td>
<td>59</td>
</tr>
<tr>
<td>Show Prediction Expression</td>
<td>59</td>
</tr>
<tr>
<td>Sorted Estimates</td>
<td>60</td>
</tr>
<tr>
<td>Expanded Estimates and the Coding of Nominal Terms</td>
<td>61</td>
</tr>
<tr>
<td>Scaled Estimates and the Coding Of Continuous Terms</td>
<td>62</td>
</tr>
<tr>
<td>Indicator Parameterization Estimates</td>
<td>63</td>
</tr>
<tr>
<td>Sequential Tests</td>
<td>63</td>
</tr>
<tr>
<td>Custom Test</td>
<td>64</td>
</tr>
<tr>
<td>Joint Factor Tests</td>
<td>65</td>
</tr>
<tr>
<td>Inverse Prediction</td>
<td>66</td>
</tr>
<tr>
<td>Cox Mixtures</td>
<td>70</td>
</tr>
<tr>
<td>Parameter Power</td>
<td>71</td>
</tr>
<tr>
<td>The Power Analysis Dialog</td>
<td>72</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Effect Size</td>
<td>74</td>
</tr>
<tr>
<td>Text Reports for Power Analysis</td>
<td>75</td>
</tr>
<tr>
<td>Plot of Power by Sample Size</td>
<td>75</td>
</tr>
<tr>
<td>The Least Significant Value (LSV)</td>
<td>76</td>
</tr>
<tr>
<td>The Least Significant Number (LSN)</td>
<td>76</td>
</tr>
<tr>
<td>The Power</td>
<td>77</td>
</tr>
<tr>
<td>The Adjusted Power and Confidence Intervals</td>
<td>77</td>
</tr>
<tr>
<td>Prospective Power Analysis</td>
<td>77</td>
</tr>
<tr>
<td>Correlation of Estimates</td>
<td>79</td>
</tr>
<tr>
<td>Effect Screening</td>
<td>80</td>
</tr>
<tr>
<td>Lenth's Method</td>
<td>80</td>
</tr>
<tr>
<td>Parameter Estimates Population</td>
<td>80</td>
</tr>
<tr>
<td>Normal Plot</td>
<td>83</td>
</tr>
<tr>
<td>Half-Normal Plot</td>
<td>84</td>
</tr>
<tr>
<td>Bayes Plot</td>
<td>84</td>
</tr>
<tr>
<td>Bayes Plot for Factor Activity</td>
<td>85</td>
</tr>
<tr>
<td>Pareto Plot</td>
<td>86</td>
</tr>
<tr>
<td>4 Standard Least Squares: Exploring the Prediction Equation</td>
<td></td>
</tr>
<tr>
<td>The Fit Model Platform</td>
<td>89</td>
</tr>
<tr>
<td>Exploring the Prediction Equation</td>
<td>91</td>
</tr>
<tr>
<td>The Profiler</td>
<td>91</td>
</tr>
<tr>
<td>Contour Profiler</td>
<td>92</td>
</tr>
<tr>
<td>Mixture Profiler</td>
<td>93</td>
</tr>
<tr>
<td>Surface Profiler</td>
<td>94</td>
</tr>
<tr>
<td>Interaction Plots</td>
<td>95</td>
</tr>
<tr>
<td>Cube Plots</td>
<td>96</td>
</tr>
<tr>
<td>Response Surface Curvature</td>
<td>97</td>
</tr>
<tr>
<td>Parameter Estimates</td>
<td>99</td>
</tr>
<tr>
<td>Canonical Curvature Table</td>
<td>99</td>
</tr>
<tr>
<td>Box Cox Y' Transformations</td>
<td>100</td>
</tr>
<tr>
<td>5 Standard Least Squares: Random Effects</td>
<td></td>
</tr>
<tr>
<td>The Fit Model Platform</td>
<td>103</td>
</tr>
<tr>
<td>Topics in Random Effects</td>
<td>105</td>
</tr>
<tr>
<td>Introduction to Random Effects</td>
<td>105</td>
</tr>
<tr>
<td>Generalizability</td>
<td>106</td>
</tr>
</tbody>
</table>
### Multivariate Tests
- The Extended Multivariate Report .................................................. 141
- Comparison of Multivariate Tests .................................................... 142
- Univariate Tests and the Test for Sphericity .................................... 143
- Multivariate Model with Repeated Measures ................................... 145
- Repeated Measures Example ............................................................ 145
- A Compound Multivariate Model ...................................................... 147
- Commands for Response Type and Effects ........................................ 149
- Test Details (Canonical Details) ....................................................... 149
- The Centroid Plot ............................................................................. 150
- Save Canonical Scores (Canonical Correlation) ................................ 151

### Discriminant Analysis
- ........................................................................................................ 152

### Fitting Dispersion Effects with the LogLinear Variance Model
#### The Fit Model Platform ................................................................. 155
- The Loglinear Variance Model ........................................................... 157
- Estimation Method .......................................................................... 157
- Loglinear Variance Models in JMP .................................................. 157
- Model Specification .......................................................................... 157
- Example .......................................................................................... 158
- Displayed Output ............................................................................ 159
- Platform Options ............................................................................ 160
- Examining the Residuals ................................................................. 161
- Profiling the Fitted Model ............................................................... 162
- Comments ....................................................................................... 164

### Logistic Regression for Nominal and Ordinal Response
#### The Fit Model Platform ................................................................. 165
- Introduction to Logistic Models ....................................................... 167
- The Statistical Report ...................................................................... 168
- Logistic Plot .................................................................................... 169
- Iteration History ............................................................................. 170
- Whole Model Test .......................................................................... 170
- Lack of Fit Test (Goodness of Fit) .................................................. 172
- Parameter Estimates ........................................................................ 173
- Likelihood-ratio Tests ..................................................................... 174
- Platform Options .......................................................................... 174
### Nonlinear Regression

#### The Nonlinear Platform

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Nonlinear Fitting Process</td>
<td>231</td>
</tr>
<tr>
<td>A Simple Exponential Example</td>
<td>231</td>
</tr>
<tr>
<td>Creating a Formula with Parameters</td>
<td>231</td>
</tr>
<tr>
<td>Launch the Nonlinear Platform</td>
<td>232</td>
</tr>
<tr>
<td>Drive the Iteration Control Panel</td>
<td>233</td>
</tr>
<tr>
<td>Using the Model Library</td>
<td>235</td>
</tr>
<tr>
<td>Customizing the Nonlinear Model Library</td>
<td>239</td>
</tr>
<tr>
<td>Details for the Formula Editor</td>
<td>239</td>
</tr>
<tr>
<td>Details of the Iteration Control Panel</td>
<td>240</td>
</tr>
<tr>
<td>Panel Buttons</td>
<td>241</td>
</tr>
<tr>
<td>The Current Parameter Estimates</td>
<td>242</td>
</tr>
<tr>
<td>Save Estimates</td>
<td>242</td>
</tr>
<tr>
<td>Confidence Limits</td>
<td>242</td>
</tr>
<tr>
<td>The Nonlinear Fit Popup Menu</td>
<td>242</td>
</tr>
<tr>
<td>Details of Solution Results</td>
<td>248</td>
</tr>
<tr>
<td>The Solution Table</td>
<td>248</td>
</tr>
<tr>
<td>Excluded Points</td>
<td>249</td>
</tr>
<tr>
<td>Profile Confidence Limits</td>
<td>250</td>
</tr>
<tr>
<td>Fitted Function Graph</td>
<td>251</td>
</tr>
<tr>
<td>Chemical Kinetics Example</td>
<td>252</td>
</tr>
<tr>
<td>How Custom Loss Functions Work</td>
<td>253</td>
</tr>
<tr>
<td>Maximum Likelihood Example: Logistic Regression</td>
<td>255</td>
</tr>
<tr>
<td>Iteratively Reweighted Least Squares Example</td>
<td>257</td>
</tr>
<tr>
<td>Probit Model with Binomial Errors: Numerical Derivatives</td>
<td>260</td>
</tr>
<tr>
<td>Poisson Loss Function</td>
<td>262</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Notes Concerning Derivatives</td>
<td>264</td>
</tr>
<tr>
<td>Notes on Effective Nonlinear Modeling</td>
<td>266</td>
</tr>
<tr>
<td>Notes Concerning Scripting</td>
<td>267</td>
</tr>
<tr>
<td>Nonlinear Modeling Templates</td>
<td>268</td>
</tr>
<tr>
<td><strong>13 Creating Neural Networks</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Using the Neural Platform</strong></td>
<td>271</td>
</tr>
<tr>
<td>Overview of Neural Networks</td>
<td>273</td>
</tr>
<tr>
<td>Launch the Neural Platform</td>
<td>273</td>
</tr>
<tr>
<td>The Neural Launch Window</td>
<td>274</td>
</tr>
<tr>
<td>The Model Launch</td>
<td>275</td>
</tr>
<tr>
<td>Model Reports</td>
<td>280</td>
</tr>
<tr>
<td>Training and Validation Measures of Fit</td>
<td>281</td>
</tr>
<tr>
<td>Confusion Statistics</td>
<td>282</td>
</tr>
<tr>
<td>Model Options</td>
<td>282</td>
</tr>
<tr>
<td>Example of a Neural Network</td>
<td>284</td>
</tr>
<tr>
<td><strong>14 Gaussian Processes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Models for Analyzing Computer Experiments</strong></td>
<td>287</td>
</tr>
<tr>
<td>Launching the Platform</td>
<td>289</td>
</tr>
<tr>
<td>The Gaussian Process Report</td>
<td>290</td>
</tr>
<tr>
<td>Actual by Predicted Plot</td>
<td>291</td>
</tr>
<tr>
<td>Model Report</td>
<td>291</td>
</tr>
<tr>
<td>Marginal Model Plots</td>
<td>293</td>
</tr>
<tr>
<td>Platform Options</td>
<td>293</td>
</tr>
<tr>
<td>Borehole Hypercube Example</td>
<td>294</td>
</tr>
<tr>
<td><strong>15 Recursive Partitioning</strong></td>
<td></td>
</tr>
<tr>
<td><strong>The Partition Platform</strong></td>
<td>297</td>
</tr>
<tr>
<td>Introduction to Partitioning</td>
<td>299</td>
</tr>
<tr>
<td>Launching the Partition Platform</td>
<td>299</td>
</tr>
<tr>
<td>Partition Method</td>
<td>300</td>
</tr>
<tr>
<td>Decision Tree</td>
<td>300</td>
</tr>
<tr>
<td>Bootstrap Forest</td>
<td>311</td>
</tr>
<tr>
<td>Boosted Tree</td>
<td>314</td>
</tr>
<tr>
<td>Validation</td>
<td>317</td>
</tr>
</tbody>
</table>
16 Time Series Analysis

The Time Series Platform ................................................. 333

Launch the Platform .................................................... 335

Select Columns into Roles .......................................... 335

The Time Series Graph ................................................. 336

Time Series Commands .................................................. 336

Graph ................................................................. 337

Autocorrelation ....................................................... 337

Partial Autocorrelation ............................................. 337

Variogram ............................................................ 338

AR Coefficients ....................................................... 338

Spectral Density ....................................................... 339

Save Spectral Density ............................................... 340

Number of Forecast Periods .................................... 341

Difference ............................................................ 341

Modeling Reports ..................................................... 342

Model Comparison Table ........................................... 342

Model Summary Table ............................................... 343

Parameter Estimates Table ....................................... 345

Forecast Plot ........................................................ 346

Residuals ............................................................... 346

Iteration History ...................................................... 346

Model Report Options ............................................... 347

ARIMA Model .......................................................... 347

Seasonal ARIMA ......................................................... 348
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Design Engineering</td>
<td>385</td>
</tr>
<tr>
<td>Data for the Choice Platform</td>
<td>386</td>
</tr>
<tr>
<td>Example: Pizza Choice</td>
<td>387</td>
</tr>
<tr>
<td>Launch the Choice Platform and Select Data Sets</td>
<td>388</td>
</tr>
<tr>
<td> Choice Model Output</td>
<td>391</td>
</tr>
<tr>
<td> Subject Effects</td>
<td>392</td>
</tr>
<tr>
<td> Utility Grid Optimization</td>
<td>394</td>
</tr>
<tr>
<td>Platform Options</td>
<td>396</td>
</tr>
<tr>
<td>Example: Valuing Trade-offs</td>
<td>396</td>
</tr>
<tr>
<td>One-Table Analysis</td>
<td>402</td>
</tr>
<tr>
<td> Example: One-Table Pizza Data</td>
<td>403</td>
</tr>
<tr>
<td>Segmentation</td>
<td>405</td>
</tr>
<tr>
<td>Special Data Rules</td>
<td>409</td>
</tr>
<tr>
<td> Default choice set</td>
<td>409</td>
</tr>
<tr>
<td> Subject Data with Response Data</td>
<td>410</td>
</tr>
<tr>
<td> Logistic Regression</td>
<td>410</td>
</tr>
<tr>
<td>Transforming Data</td>
<td>414</td>
</tr>
<tr>
<td> Transforming Data to Two Analysis Tables</td>
<td>414</td>
</tr>
<tr>
<td> Transforming Data to One Analysis Table</td>
<td>418</td>
</tr>
</tbody>
</table>

19 Correlations and Multivariate Techniques

The Multivariate Platform                                              | 421  |
<p>| Launch the Platform and Select Options                                 | 423  |
|  Correlations Multivariate                                            | 424  |
|  CI of Correlation                                                     | 425  |
|  Inverse Correlations and Partial Correlations                         | 425  |
|  Set $\alpha$ Level                                                   | 426  |
|  Scatterplot Matrix                                                    | 426  |
|  Covariance Matrix                                                     | 429  |
|  Pairwise Correlations                                                 | 429  |
|  Color Maps                                                            | 429  |
|  Simple Statistics                                                     | 430  |
|  Nonparametric Correlations                                            | 431  |
|  Outlier Analysis                                                      | 431  |
|  Principal Components                                                  | 434  |
|  Item Reliability                                                      | 434  |
|  Parallel Coordinate Plot                                              | 436  |</p>
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discriminant Method</td>
<td>478</td>
</tr>
<tr>
<td>Stepwise Selection</td>
<td>479</td>
</tr>
<tr>
<td>Canonical Plot</td>
<td>481</td>
</tr>
<tr>
<td>Discriminant Scores</td>
<td>481</td>
</tr>
<tr>
<td>Commands and Options</td>
<td>482</td>
</tr>
<tr>
<td>Validation</td>
<td>487</td>
</tr>
<tr>
<td>23 Partial Least Squares</td>
<td></td>
</tr>
<tr>
<td>The PLS Platform</td>
<td>489</td>
</tr>
<tr>
<td>PLS</td>
<td>491</td>
</tr>
<tr>
<td>Launch the Platform</td>
<td>491</td>
</tr>
<tr>
<td>Model Coefficients and PRESS Residuals</td>
<td>496</td>
</tr>
<tr>
<td>Test Set Validation</td>
<td>497</td>
</tr>
<tr>
<td>Platform Options</td>
<td>497</td>
</tr>
<tr>
<td>Statistical Details</td>
<td>502</td>
</tr>
<tr>
<td>Centering and Scaling</td>
<td>502</td>
</tr>
<tr>
<td>Missing Values</td>
<td>502</td>
</tr>
<tr>
<td>24 Item Response Theory</td>
<td></td>
</tr>
<tr>
<td>The Item Analysis Platform</td>
<td>503</td>
</tr>
<tr>
<td>Introduction to Item Response Theory</td>
<td>505</td>
</tr>
<tr>
<td>Launching the Platform</td>
<td>508</td>
</tr>
<tr>
<td>Item Analysis Output</td>
<td>510</td>
</tr>
<tr>
<td>Characteristic Curves</td>
<td>510</td>
</tr>
<tr>
<td>Information Curves</td>
<td>511</td>
</tr>
<tr>
<td>Dual Plots</td>
<td>511</td>
</tr>
<tr>
<td>Platform Commands</td>
<td>513</td>
</tr>
<tr>
<td>Technical Details</td>
<td>514</td>
</tr>
<tr>
<td>25 Plotting Surfaces</td>
<td></td>
</tr>
<tr>
<td>The Surface Plot Platform</td>
<td>515</td>
</tr>
<tr>
<td>Surface Plots</td>
<td>517</td>
</tr>
<tr>
<td>Launching the Platform</td>
<td>517</td>
</tr>
<tr>
<td>Plotting a Single Mathematical Function</td>
<td>518</td>
</tr>
<tr>
<td>Plotting Points Only</td>
<td>519</td>
</tr>
<tr>
<td>Plotting a Formula from a Column</td>
<td>520</td>
</tr>
<tr>
<td>Isosurfaces</td>
<td>522</td>
</tr>
</tbody>
</table>
The Surface Plot Control Panel ........................................... 524
Appearance Controls .................................................... 525
Independent Variables ..................................................... 525
Dependent Variables ....................................................... 526
Plot Controls and Settings .................................................. 527
Rotate .............................................................................. 527
Axis Settings ..................................................................... 528
Lights .............................................................................. 529
Sheet or Surface Properties ............................................... 529
Other Properties and Commands ......................................... 530
Keyboard Shortcuts .............................................................. 531

26 Profiling
Response Surface Visualization, Optimization, and Simulation .......... 533
Introduction to Profiling ....................................................... 535
Profiling Features in JMP .................................................... 535
The Profiler ........................................................................ 537
Interpreting the Profiles ..................................................... 538
Profiler Options ................................................................. 542
Desirability Profiling and Optimization ..................................... 546
Special Profiler Topics .......................................................... 551
Propagation of Error Bars ................................................... 551
Customized Desirability Functions .......................................... 552
Mixture Designs ................................................................ 554
Expanding Intermediate Formulas .......................................... 555
Linear Constraints ................................................................ 555
Contour Profiler ................................................................ 557
Contour Profiler Pop-up Menu ............................................... 558
Mixtures ............................................................................ 558
Constraint Shading ............................................................... 559
Mixture Profiler ................................................................... 560
Explanation of Ternary Plot Axes ........................................ 561
More than Three Mixture Factors ......................................... 561
Mixture Profiler Options ..................................................... 562
Linear Constraints ............................................................... 563
Examples .......................................................................... 564
Surface Profiler ................................................................... 571
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Custom Profiler</td>
<td>571</td>
</tr>
<tr>
<td>Custom Profiler Options</td>
<td>571</td>
</tr>
<tr>
<td>The Simulator</td>
<td>572</td>
</tr>
<tr>
<td>Specifying Factors</td>
<td>573</td>
</tr>
<tr>
<td>Specifying the Response</td>
<td>574</td>
</tr>
<tr>
<td>Run the Simulation</td>
<td>575</td>
</tr>
<tr>
<td>The Simulator Menu</td>
<td>575</td>
</tr>
<tr>
<td>Using Specification Limits</td>
<td>576</td>
</tr>
<tr>
<td>Simulating General Formulas</td>
<td>577</td>
</tr>
<tr>
<td>The Defect Profiler</td>
<td>580</td>
</tr>
<tr>
<td>Notes</td>
<td>582</td>
</tr>
<tr>
<td>Defect Profiler Example</td>
<td>582</td>
</tr>
<tr>
<td>Stochastic Optimization Example</td>
<td>586</td>
</tr>
<tr>
<td>Noise Factors (Robust Engineering)</td>
<td>594</td>
</tr>
<tr>
<td>Profiling Models Stored in Excel</td>
<td>601</td>
</tr>
<tr>
<td>The Excel Model</td>
<td>601</td>
</tr>
<tr>
<td>Using the JMP Add-In for Profiling</td>
<td>602</td>
</tr>
<tr>
<td>Using the Excel Profiler From JMP</td>
<td>605</td>
</tr>
<tr>
<td>Fit Group</td>
<td>605</td>
</tr>
<tr>
<td>Statistical Details</td>
<td>606</td>
</tr>
</tbody>
</table>

A **Statistical Details**

Models in JMP ............................................. 621

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Response Models</td>
<td>623</td>
</tr>
<tr>
<td>Continuous Responses</td>
<td>623</td>
</tr>
<tr>
<td>Nominal Responses</td>
<td>623</td>
</tr>
<tr>
<td>Ordinal Responses</td>
<td>625</td>
</tr>
<tr>
<td>The Factor Models</td>
<td>626</td>
</tr>
<tr>
<td>Continuous Factors</td>
<td>626</td>
</tr>
<tr>
<td>Nominal Factors</td>
<td>627</td>
</tr>
<tr>
<td>Ordinal Factors</td>
<td>637</td>
</tr>
<tr>
<td>The Usual Assumptions</td>
<td>643</td>
</tr>
<tr>
<td>Assumed Model</td>
<td>643</td>
</tr>
<tr>
<td>Relative Significance</td>
<td>643</td>
</tr>
<tr>
<td>Multiple Inferences</td>
<td>644</td>
</tr>
<tr>
<td>Validity Assessment</td>
<td>644</td>
</tr>
<tr>
<td>Alternative Methods</td>
<td>644</td>
</tr>
</tbody>
</table>
Index

Modeling and Multivariate Methods 659
Credits and Acknowledgments

Origin
JMP was developed by SAS Institute Inc., Cary, NC. JMP is not a part of the SAS System, though portions of JMP were adapted from routines in the SAS System, particularly for linear algebra and probability calculations. Version 1 of JMP went into production in October 1989.

Credits
JMP was conceived and started by John Sall. Design and development were done by John Sall, Chung-Wei Ng, Michael Hecht, Richard Potter, Brian Corcoran, Annie Dudley Zangi, Bradley Jones, Craige Hales, Chris Gotwalt, Paul Nelson, Xan Gregg, Jianfeng Ding, Eric Hill, John Schroedl, Laura Lancaster, Scott McQuiggan, Melinda Thielbar, Clay Barker, Peng Liu, Dave Barbour, Jeff Polzin, John Ponte, and Steve Amerige.

In the SAS Institute Technical Support division, Duane Hayes, Wendy Murphrey, Rosemary Lucas, Win LeDinh, Bobby Riggs, Glen Grimme, Sue Walsh, Mike Stockstill, Kathleen Kiernan, and Liz Edwards provide technical support.

Nicole Jones, Kyoko Keener, Hui Di, Joseph Morgan, Wenjun Bao, Fang Chen, Susan Shao, Yusuke Ono, Michael Crotty, Jong-Seok Lee, Tonya Mauldin, Audrey Ventura, Ani Eloyan, Bo Meng, and Sequola McNeill provide ongoing quality assurance. Additional testing and technical support are provided by Noriki Inoue, Kyoko Takenaka, and Masakazu Okada from SAS Japan.

Bob Hickey and Jim Borek are the release engineers.

The JMP books were written by Ann Lehman, Lee Creighton, John Sall, Bradley Jones, Erin Vang, Melanie Drake, Meredith Blackwelder, Diane Perhac, Jonathan Gatlin, Susan Conaghan, and Sheila Loring, with contributions from Annie Dudley Zangi and Brian Corcoran. Creative services and production was done by SAS Publications. Melanie Drake implemented the Help system.

Jon Weisz and Jeff Perkinson provided project management. Also thanks to Lou Valente, Ian Cox, Mark Bailey, and Malcolm Moore for technical advice.

Thanks also to Georges Guirguis, Warren Sarle, Gordon Johnston, Duane Hayes, Russell Wolfinger, Randall Tobias, Robert N. Rodriguez, Ying So, Warren Kuhfeld, George MacKensie, Bob Lucas, Warren Kuhfeld, Mike Leonard, and Padraic Neville for statistical R&D support. Thanks are also due to Doug Melzer, Bryan Wolfe, Vincent DelGobbo, Biff Beers, Russell Gonsalves, Mitchel Soltys, Dave Mackie, and Stephanie Smith, who helped us get started with SAS Foundation Services from JMP.

Acknowledgments
We owe special gratitude to the people that encouraged us to start JMP, to the alpha and beta testers of JMP, and to the reviewers of the documentation. In particular we thank Michael Benson, Howard
Yetter (d), Andy Mauromoustakos, Al Best, Stan Young, Robert Muenchen, Lenore Herzenberg, Ramon Leon, Tom Lange, Homer Hagedus, Skip Weed, Michael Emptage, Pat Spagan, Paul Wenz, Mike Bowen, Lori Gates, Georgia Morgan, David Tanaka, Zoe Jewell, Sky Alibhai, David Coleman, Linda Blazek, Michael Friendly, Joe Hockman, Frank Shen, J.H. Goodman, David Iklé, Barry Hembree, Dan Obermiller, Jeff Sweeney, Lynn Vanatta, and Kris Ghosh.

Also, we thank Dick DeVeaux, Gray McQuarrie, Robert Stine, George Fraction, Avigdor Cahaner, José Ramirez, Gudmundur Axelson, Al Fulmer, Cary Tuckfield, Ron Thisted, Nancy McDermott, Veronica Czitrom, Tom Johnson, Cy Wegman, Paul Dwyer, DaRon Huffaker, Kevin Norwood, Mike Thompson, Jack Reese, Francois Mainville, and John Wass.

We also thank the following individuals for expert advice in their statistical specialties: R. Hocking and P. Spector for advice on effective hypotheses; Robert Mee for screening design generators; Roselinde Kessels for advice on choice experiments; Greg Piepel, Peter Goos, J. Stuart Hunter, Dennis Lin, Doug Montgomery, and Chris Nachtsheim for advice on design of experiments; Jason Hsu for advice on multiple comparisons methods (not all of which we were able to incorporate in JMP); Ralph O’Brien for advice on homogeneity of variance tests; Ralph O’Brien and S. Paul Wright for advice on statistical power; Keith Muller for advice in multivariate methods, Harry Martz, Wayne Nelson, Ramon Leon, Dave Trindade, Paul Tobias, and William Q. Meeker for advice on reliability plots; Lijian Yang and J.S. Marron for bivariate smoothing design; George Milliken and Yuri P. Bulavski for development of mixed models; Will Potts and Cathy Maahs-Fladung for data mining; Clay Thompson for advice on contour plotting algorithms; and Tom Little, Damon Stoddard, Blanton Godfrey, Tim Clapp, and Joe Ficalora for advice in the area of Six Sigma; and Josef Schmee and Alan Bowman for advice on simulation and tolerance design.

For sample data, thanks to Patrice Strahle for Pareto examples, the Texas air control board for the pollution data, and David Coleman for the pollen (eureka) data.

**Translations**

Trish O’Grady coordinates localization. Special thanks to Noriki Inoue, Kyoko Takenaka, Masakazu Okada, Naohiro Masukawa and Yusuke Ono (SAS Japan); and Professor Toshiro Haga (retired, Tokyo University of Science) and Professor Hirohiko Asano (Tokyo Metropolitan University) for reviewing our Japanese translation; Professors Fengshan Bai, Xuan Lu, and Jianguo Li at Tsinghua University in Beijing, and their assistants Rui Guo, Shan Jiang, Zhicheng Wan, and Qiang Zhao; and William Zhou (SAS China) and Zhongguo Zheng, professor at Peking University, for reviewing the Simplified Chinese translation; Jacques Goupy (consultant, ReConFor) and Olivier Nuñez (professor, Universidad Carlos III de Madrid) for reviewing the French translation; Dr. Byung Chun Kim (professor, Korea Advanced Institute of Science and Technology) and Duk-Hyun Ko (SAS Korea) for reviewing the Korean translation; Bertram Schäfer and David Meintrup (consultants, StatCon) for reviewing the German translation; Patrizia Omodei, Maria Scaccabarozzi, and Letizia Bazzani (SAS Italy) for reviewing the Italian translation. Finally, thanks to all the members of our outstanding translation teams.

**Past Support**

Many people were important in the evolution of JMP. Special thanks to David DeLong, Mary Cole, Kristin Nauta, Aaron Walker, Ike Walker, Eric Gjertsen, Dave Tilley, Ruth Lee, Annette Sanders, Tim Christensen, Eric Wasserman, Charles Soper, Wenjie Bao, and Junji Kishimoto. Thanks to SAS Institute quality assurance by Jeanne Martin, Fouad Younan, and Frank Lassiter. Additional testing for Versions 3 and 4 was done by Li Yang, Brenda Sun, Katinka Hauser, and Andrea Ritter.
Also thanks to Jenny Kendall, John Hansen, Eddie Routten, David Schlotzhauer, and James Mulherin. Thanks to Steve Shack, Greg Weier, and Maura Stokes for testing JMP Version 1.

Thanks for support from Charles Shipp, Harold Gugel (d), Tim Winters, Matthew Lay, Tim Rey, Rubin Gabriel, Brian Ruff, William Lisowski, Tom Esposito, Susan West, Chris Fehily, Dan Chilko, Jim Shook, Ken Bodner, Rick Blahunka, Dana C. Aultman, and William Fehlner.

**Technology License Notices**

Scintilla is Copyright 1998-2003 by Neil Hodgson <neilh@scintilla.org>. NEIL HODGSON DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL NEIL HODGSON BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

XRender is Copyright © 2002 Keith Packard. KEITH PACKARD DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL KEITH PACKARD BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

ImageMagick software is Copyright © 1999-2010 ImageMagick Studio LLC, a non-profit organization dedicated to making software imaging solutions freely available.

bzlib software is Copyright © 1991-2009, Thomas G. Lane, Guido Vollbeding. All Rights Reserved.

FreeType software is Copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.
**Chapter 1**

**Introduction to Model Fitting**

The Fit Model Platform

*Analyze > Fit Model* launches the *general fitting platform*, which lets you construct linear models that have more complex effects than those assumed by other JMP statistical platforms. *Fit Model* displays the Fit Model dialog that lets you define complex models. You choose specific model effects and error terms and add or remove terms from the model specification as needed.

The Fit Model dialog is a unified launching pad for a variety of fitting *personalities* such as:

- standard least squares fitting of one or more continuous responses (multiple regression)
- screening analysis for experimental data where there are many effects but few observations
- stepwise regression
- multivariate analysis of variance (MANOVA) for multiple continuous responses
- log-linear variance fitting to fit both means and variances
- logistic regression for nominal or ordinal response
- proportional hazard and parametric survival fits for censored survival data
- generalized linear model fitting with various distributions and link functions.

Contents

The Fit Model Dialog: A Quick Example .............................................................. 3
Types of Models .................................................................................................. 5
The Response Buttons (Y, Weight, Freq, and By) ............................................... 7
Construct Model Effects Buttons ........................................................................ 7
Macros Popup Menu ............................................................................................... 8
Effect Attributes and Transformations ................................................................. 10
Transformations (Standard Least Squares Only) .................................................. 12
Fitting Personalities .............................................................................................. 12
Other Model Dialog Features ............................................................................... 14
  Emphasis Choices ............................................................................................... 14
  Run ...................................................................................................................... 14
  Validity Checks ................................................................................................. 14
  Other Model Specification Options ................................................................... 15
Formula Editor Model Features .......................................................................... 16
  Parametric Models ............................................................................................ 16
  Adding Parameters ........................................................................................... 19
The Fit Model Dialog: A Quick Example

The **Fit Model** command first displays the Fit Model dialog, shown in Figure 1.1. You use this dialog to tailor a model for your data. The Fit Model dialog is *nonmodal*, which means it persists until you explicitly close it. This is useful to change the model specification and fit several different models before closing the window.

The example in Figure 1.1, uses the *Fitness.jmp* (SAS Institute 1987) data table in the Sample Data folder. The data are results of an aerobic fitness study. The *Oxy* variable is a continuous response (dependent) variable. The variables *Weight*, *Runtime*, *RunPulse*, *RstPulse*, and *MaxPulse* that show in the Construct Model Effects list are continuous effects (also called regressors, factors, or independent variables). The popup menu at the upper-right of the dialog shows **Standard Least Squares**, which defines the fitting method or fitting *personality*. The various fitting personalities are described later in this chapter.

![Figure 1.1 The Fit Model Dialog Completed for a Multiple Regression](image)

This standard least squares example, with a single continuous *Y* variable and several continuous *X* variables, specifies a multiple regression.

After a model is defined in the Fit Model dialog, click **Run** to perform the analysis and generate a report window with the appropriate tables and supporting graphics.
Introduction to Model Fitting
The Fit Model Dialog: A Quick Example

A standard least squares analysis such as this multiple regression begins by showing you the Summary of Fit table, the Parameter Estimates table, the Effect Tests table, Analysis of Variance, and the Residual by Predicted and Leverage plots. If you want, you can open additional tables and plots, such as those shown in Figure 1.2, to see details of the analysis. Or, if a screening or response surface analysis seems more appropriate, you can choose commands from the Effect Screening and Factor Profiling menus at the top of the report.


See Table 1.1 “Types of Models,” p. 5, and Table 1.2 “Clicking Sequences for Selected Models,” p. 6, in the next section for a description of models and the clicking sequences needed to enter them into the Fit Model dialog.

Detailed Example of the Fit Model Dialog
1. Open the Fitness jmp sample data table.
2. Select Analyze > Fit Model.
3. Select Oxy and click Y.
4. Select Weight, Runtime, RunPulse, RstPulse, and MaxPulse and click Add.
5. Click Run.

Figure 1.2 Partial Report for Multiple Regression
Types of Models

The list in Table 1.1 “Types of Models,” p. 5 is a catalog of model examples that can be defined using the Fit Model dialog, where the effects $X$ and $Z$ have continuous values, and $A$, $B$, and $C$ have nominal or ordinal values. This list is not exhaustive.

When you correctly specify the type of model, the model effects show in the Construct Model Effects list on the Fit Model dialog. Refer to Table 1.2 “Clicking Sequences for Selected Models,” p. 6 to see the clicking sequences that produce some of these sets of model effects.

Table 1.1 Types of Models

<table>
<thead>
<tr>
<th>Type of Model</th>
<th>Model Effects</th>
</tr>
</thead>
<tbody>
<tr>
<td>simple regression</td>
<td>$X$</td>
</tr>
<tr>
<td>polynomial ($x$) to Degree 2</td>
<td>$X$, $X^2$</td>
</tr>
<tr>
<td>polynomial ($x$, $z$) to Degree 2</td>
<td>$X$, $X^2$, $Z$, $Z^2$</td>
</tr>
<tr>
<td>cubic polynomial ($x$)</td>
<td>$X$, $X^2$, $X^3$</td>
</tr>
<tr>
<td>multiple regression</td>
<td>$X$, $Z$, ..., other continuous columns</td>
</tr>
<tr>
<td>one-way analysis of variance</td>
<td>$A$</td>
</tr>
<tr>
<td>two-way main effects analysis of variance</td>
<td>$A$, $B$</td>
</tr>
<tr>
<td>two-way analysis of variance with interaction</td>
<td>$A$, $B$, $A^\times B$</td>
</tr>
<tr>
<td>three-way full factorial</td>
<td>$A$, $B$, $A^\times B$, $C$, $A^\times C$, $B^\times C$, $A^\times B^\times C$</td>
</tr>
<tr>
<td>analysis of covariance, same slopes</td>
<td>$A$, $X$</td>
</tr>
<tr>
<td>analysis of covariance, separate slopes</td>
<td>$A$, $X$, $A^\times X$</td>
</tr>
<tr>
<td>simple nested model</td>
<td>$A$, $B[A]$</td>
</tr>
<tr>
<td>compound nested model</td>
<td>$A$, $B[A]$, $C[A B]$</td>
</tr>
<tr>
<td>simple split-plot or repeated measure</td>
<td>$A$, $B[A]$&amp;Random, $C$, $A^\times C$</td>
</tr>
<tr>
<td>response surface ($x$) model</td>
<td>$X$&amp;RS, $X^2$</td>
</tr>
<tr>
<td>response surface ($x$, $z$) model</td>
<td>$X$&amp;RS, $Z$&amp;RS, $X^2$, $Z$, $Z^2$, $X^2$</td>
</tr>
<tr>
<td>MANOVA</td>
<td>multiple $Y$ variables</td>
</tr>
</tbody>
</table>
The following convention is used to specify clicking:

- If a column name is in plain typeface, click the name in the column selection list.
- If a column name is **bold**, then select that column in the dialog model effects list.
- The name of the button to click is shown in all CAPITAL LETTERS.

**Table 1.2 Clicking Sequences for Selected Models**

<table>
<thead>
<tr>
<th>Type of Model</th>
<th>Clicking Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>simple regression</td>
<td>X, ADD</td>
</tr>
<tr>
<td>polynomial ((x)) to Degree 2</td>
<td>X, <strong>Degree 2</strong>, select <strong>Polynomial to Degree</strong> in the <strong>Macros</strong> popup menu</td>
</tr>
<tr>
<td>polynomial ((x, z)) to Degree 3</td>
<td>X, Z, <strong>Degree 3</strong>, select <strong>Polynomial to Degree</strong> in the <strong>Macros</strong> popup menu</td>
</tr>
<tr>
<td>multiple regression</td>
<td>X, ADD, Z, ADD,… or X, Z, …, ADD</td>
</tr>
<tr>
<td>one-way analysis of variance</td>
<td>A, ADD</td>
</tr>
<tr>
<td>two-way main effects</td>
<td>A, ADD B, ADD, or A, B, ADD</td>
</tr>
<tr>
<td>analysis of variance</td>
<td></td>
</tr>
<tr>
<td>two-way analysis of variance with interaction</td>
<td>A, B, ADD, A, B, CROSS or A, B, select <strong>Full Factorial</strong> in <strong>Macros</strong> popup menu</td>
</tr>
<tr>
<td>three-way full factorial</td>
<td>A, B, C, select <strong>Full Factorial</strong> in <strong>Macros</strong> popup menu</td>
</tr>
<tr>
<td>analysis of covariance, same slopes</td>
<td>A, ADD, X, ADD or A, X, ADD</td>
</tr>
<tr>
<td>analysis of covariance, separate slopes</td>
<td>A, ADD, X, ADD, A, X, CROSS</td>
</tr>
<tr>
<td>simple nested model</td>
<td>A, ADD, B, ADD, A, B, NEST, or A, B, ADD, A, B, NEST</td>
</tr>
<tr>
<td>compound nested model</td>
<td>A, B, ADD, A, B, NEST, C, ADD, A, B, C, NEST</td>
</tr>
<tr>
<td>simple split-plot or repeated measure</td>
<td>A, ADD, B, ADD, A, B, NEST, select <strong>Random</strong> from the <strong>Effect Attributes</strong> popup menu, C, ADD, C, A, CROSS</td>
</tr>
<tr>
<td>two-factor response surface</td>
<td>X, Z, select <strong>Response Surface</strong> in the <strong>Macros</strong> popup menu</td>
</tr>
</tbody>
</table>
The Response Buttons (Y, Weight, Freq, and By)

The column selection list in the upper left of the dialog lists the columns in the current data table. When you click a column name, it highlights and responds to the action that you choose with other buttons on the dialog. Either drag across columns or Shift-click to extend a selection of column names, and Control-click (-click on the Macintosh) to select non-adjacent names.

To assign variables to the Y, Weight, Freq, or By roles, select them and click the corresponding role button:

- **Y** identifies one or more response variables (the dependent variables) for the model.
- **Weight** is an optional role that identifies one column whose values supply weights for the response. Weighting affects the importance of each row in the model.
- **Freq** is an optional role that identifies one column whose values assign a frequency to each row for the analysis. The values of this variable determine how degrees of freedom are counted.
- **By** is used to perform a separate analysis for each level of a classification or grouping variable.

If you want to remove variables from roles, highlight them and click Remove or hit the backspace key.

Construct Model Effects Buttons

Suppose that a data table contains the variables X and Z with continuous values, and A, B, and C with nominal values. The following paragraphs describe the buttons in the Fit Model dialog that specify model effects.

**Add**

To add a simple regressor (continuous column) or a main effect (nominal or ordinal column) as an x effect to any model, select the column from the column selection list and click Add. That column name appears in the model effects list. As you add effects, be aware of the modeling type declared for that variable and the consequences that modeling type has when fitting the model:

- Variables with continuous modeling type become simple regressors.
- Variables with nominal modeling types are represented with dummy variables to fit separate coefficients for each level in the variable.
- Nominal and ordinal modeling types are handled alike, but with a slightly different coding. See the appendix “Statistical Details,” p. 621, for details on coding of effects.

If you mistakenly add an effect, select it in the model effects list and click Remove.
Cross

To create a compound effect by crossing two or more variables, Shift-click in the column selection list to select them if they are next to each other in the Select Columns list. Control-click (-click on the Macintosh) if the variables are not contiguous in the column selection list. Then click Cross:

• Crossed nominal variables become interaction effects.
• Crossed continuous variables become multiplied regressors.
• Crossing a combination of nominal and continuous variables produces special effects suitable for testing homogeneity of slopes.

If you select both a column name in the column selection list and an effect in the model effects list, the Cross button crosses the selected column with the selected effect and adds this compound effect to the effects list.

See the appendix "Statistical Details," p. 621, for a discussion of how crossed effects are parameterized and coded.

Nest

When levels of an effect B only occur within a single level of an effect A, then B is said to be nested within A and A is called the outside effect. The notation B[A] is read “B within A” and means that you want to fit a B effect within each level of A. The B[A] effect is like pooling B and A*B. To specify a nested effect

• select the outside effects in the column selection list and click Add or Cross
• select the nested effect in the column selection list and click Add or Cross
• select the outside effect in the column selection list
• select the nested variable in the model effects list and click Nest

For example, suppose that you want to specify A*B[C]. Highlight both A and B in the column selection list. Then click Cross to see A*B in the model effects list. Highlight the A*B term in the model effects list and C in the column selection list. Click Nest to see A*B[C] as a model effect.

Note: The nesting terms must be specified in order, from outer to inner. If B is nested within A, and C is nested within B, then the model is specified as: A, B[A], C[B,A].

JMP allows up to ten terms to be combined as crossed and nested.

Macros Popup Menu

Commands from the Macros popup menu automatically generate the effects for commonly used models. You can add or remove terms from an automatic model specification as needed.

Full Factorial  To look at many crossed factors, such as in a factorial design, use Full Factorial. It creates the set of effects corresponding to all crossings of all variables you select in the columns list. For example, if you select variables A, B, and C, the Full Factorial selection generates A, B, A*B, C, A*C, B*C, A*B*C in the effect lists. To remove unwanted model interactions, highlight them and click Remove.
**Factorial to Degree**  To create a limited factorial, enter the degree of interactions that you want in the Degree box, then select Factorial to a Degree.

**Factorial Sorted**  The Factorial Sorted selection creates the same set of effects as Full Factorial but lists them in order of degree. All main effects are listed first, followed by all two-way interactions, then all three-way interactions, and so forth.

**Response Surface**  In a response surface model, the object is to find the values of the terms that produce a maximum or minimum expected response. This is done by fitting a collection of terms in a quadratic model. The critical values for the surface are calculated from the parameter estimates and presented with a report on the shape of the surface.

To specify a response surface effect, select two or more variables in the column selection list. When you choose Response Surface from the Effect Macros popup menu, response surface expressions appear in the model effects list. For example, if you have variables $A$ and $B$

$\text{Surface}(A)$ fits $\beta_1 A + \beta_{11} A^2$

$\text{Surface}(A,B)$ fits $\beta_1 A + \beta_{11} A^2 + \beta_2 B + \beta_{22} B^2 + \beta_{12} AB$

The response surface effect attribute, prefixed with an ampersand (&), is automatically appended to the effect name in the model effects list. The next section discusses the Attributes popup menu.

**Mixture Response Surface**  The Mixture Response Surface design omits the squared terms and the intercept and attaches the &RS effect attribute to the main effects. For more information see the Design of Experiments Guide.

**Polynomial to Degree**  A polynomial effect is a series of terms that are powers of one variable. To specify a polynomial effect:

- click one or more variables in the column selection list;
- enter the degree of the polynomial in the Degree box;
- use the Polynomial to Degree command in the Macros popup menu.

For example, suppose you select variable $x$. A 2nd polynomial in the effects list fits parameters for $x$ and $x^2$. A 3rd polynomial in the model dialog fits parameters for $x$, $x^2$, and $x^3$.

**Scheffe Cubic**  When you fit a 3rd degree polynomial model to a mixture, it turns out that you need to take special care not to introduce even-powered terms, because they are not estimable. When you get up to a cubic model, this means that you can’t specify an effect like $X^1*X^1*X^2$. However, it turns out that a complete polynomial specification of the surface should introduce terms of the form:

$X^1*X^2*(X^1 – X^2)$

which we call Scheffe Cubic terms.

In the Fit Model dialog, this macro creates a complete cubic model, including the Scheffe Cubic terms if you either (a) enter a 3 in the Degree box, then do a “Mixture Response Surface” command on a set of mixture columns, or(b) use the Scheffe Cubic command in the Macro button.

**Radial**  fits a radial-basis smoothing function using the selected variables.
Effect Attributes and Transformations

The Attributes popup menu has five special attributes that you can assign to an effect in a model:

**Random Effect**  If you have multiple error terms or random effects, as with a split-plot or repeated measures design, you can highlight them in the model effects list and select Random Effect from the Attributes popup menu. See the chapter “Standard Least Squares: Random Effects,” p. 103, for a detailed discussion and example of random effects.

Response Surface Effect  If you have a response surface model, you can use this attribute to identify which factors participate in the response surface. This attribute is automatically assigned if you use the Response Surface effects macro. You need only identify the main effects, not the crossed terms, to obtain the additional analysis done for response surface factors.

Log Variance Effect  Sometimes the goal of an experiment is not just to maximize or minimize the response itself but to aim at a target response and achieve minimum variability. To analyze results from this kind of experiment:

1. Assign the response (Y) variable and choose Loglinear Variance as the fitting personality
2. Specify loglinear variance effects by highlighting them in the model effects list and select LogVariance Effect from the Attributes popup menu. The effect appears in the model effects list with &LogVariance next to its name.

If you want an effect to be used for both the mean and variance of the response, you must specify it as an effect twice, once with the LogVariance Effect attribute.

Mixture Effect  You can use the Mixture Effect attribute to specify a mixture model effect without using the Mixture Response Surface effects macro. If you don't use the effects macro you have to add this attribute to the effects yourself so that the model understands which effects are part of the mixture.

Excluded Effect  Use the Excluded Effect attribute when you want to estimate least squares means of an interaction, or include it in lack of fit calculations, but don't want it in the model.

Knotted Spline Effect  Use the Knotted Spline Effect attribute to have JMP fit a segmentation of smooth polynomials to the specified effect. When you select this attribute, a dialog box appears that allows you to specify the number of knot points.

Note: Knotted splines are only implemented for main-effect continuous terms.

JMP follows the advice in the literature in positioning the points. The knotted spline is also referred to as a Stone spline or a Stone-Koo spline. See Stone and Koo (1986). If there are 100 or fewer points, the first and last knot are the fifth point inside the minimum and maximum, respectively. Otherwise, the first and last knot are placed at the 0.05 and 0.95 quantile if there are 5 or fewer knots, or the 0.025 and 0.975 quantile for more than 5 knots. The default number of knots is 5 unless there are less than or equal to 30 points, in which case the default is 3 knots.

Knotted splines have the following properties in contrast to smoothing splines:

- Knotted splines work inside of general models with many terms, where smoothing splines are for bivariate regressions.
- The regression basis is not a function of the response.
Chapter 1
Introduction to Model Fitting
Effect Attributes and Transformations

- Knotted splines are parsimonious, adding only \( k - 2 \) terms for curvature for \( k \) knot points.
- Knotted splines are conservative compared to pure polynomials in the sense that the extrapolation outside the range of the data is a straight line, rather than a (curvy) polynomial.
- There is an easy test for curvature.

To test for curvature, select **Estimates > Custom Test** and add a column for each knotted effect, as follows:

1. Open the `Growth.jmp` sample data table.
2. Select **Analyze > Fit Model**.
3. Assign **ratio** to **Y** and add **age** as an effect to the model.
4. Select the **age** variable in the Construct Model Effects box and select **Attributes > Knotted Spline Effect**.
5. Specify the number of knots as 5, and click **OK**.
6. Click **Run**.

When the report appears:

7. Select **Estimates > Custom Test** and notice that there is only one column. Therefore, click the **Add Column** button twice to produce a total of three columns.
8. Fill in the three knotted columns with ones so that they match Figure 1.3.

**Figure 1.3** Construction of Custom Test for Curvature

9. Click **Done**.

This produces the report shown in Figure 1.4. The low Prob > F value indicates that there is indeed curvature to the data.
Transformations (Standard Least Squares Only)

The Transformations popup menu has eight functions available to transform selected continuous effects or $Y$ columns for standard least squares analyses only. The available transformations are None, Log, Sqrt, Square, Reciprocal, Exp, Arrhenius, and ArrheniusInv. These transformations are only supported for single-column continuous effects.

The Arrhenius transformation is \[ T^* = \frac{11605}{Temp + 273.15} \]

Fitting Personalities

The Fit Model dialog in JMP serves many different fitting methods. Rather than have a separate dialog for each method, there is one dialog with a choice of fitting personality for each method. Usually the personality is chosen automatically from the context of the response and factors you enter, but you can change selections from the Fitting Personality popup menu to alternative methods.

The following list briefly describes each type of model. Details about text reports, plots, options, special commands, and example analyses are found in the individual chapters for each type of model fit:

- **Standard Least Squares** JMP models one or more continuous responses in the usual way through fitting a linear model by least squares. The standard least squares report platform offers two flavors of tables and graphs:
  - **Traditional statistics** are for situations where the number of error degrees of freedom allows hypothesis testing. These reports include leverage plots, least squares means, contrasts, and output formulas.
Screening and Response Surface Methodology analyze experimental data where there are many effects but few observations. Traditional statistical approaches focus on the residual error. However, because in near-saturated designs there is little or no room for estimating residuals, the focus is on the prediction equation and the effect sizes. Of the many effects that a screening design can fit, you expect a few important terms to stand out in comparison to the others. Another example is when the goal of the experiment is to optimize settings rather than show statistical significance; the factor combinations that optimize the predicted response are of overriding interest.

**Stepwise**  
Stepwise regression is an approach to selecting a subset of effects for a regression model. The **Stepwise** feature computes estimates that are the same as those of other least squares platforms, but it facilitates searching and selecting among many models. The **Stepwise** personality allows only one continuous $Y$.

**Manova**  
When there is more than one $Y$ variable specified for a model with the **Manova** fitting personality selected, the Fit Model platform fits the $Y$’s to the set of specified effects and provides multivariate tests.

**LogLinear Variance**  
LogLinear Variance is used when one or more effects model the variance rather than the mean. The **LogLinear Variance** personality must be used with caution. See “Fitting Dispersion Effects with the LogLinear Variance Model,” p. 155 for more information on this feature.

**Nominal Logistic**  
If the response is nominal, the Fit Model platform fits a linear model to a multilevel logistic response function using maximum likelihood.

**Ordinal Logistic**  
If the response variable has an ordinal modeling type, the Fit Model platform fits the cumulative response probabilities to the logistic distribution function of a linear model by using maximum likelihood.

**Proportional Hazard**  
The proportional hazard (Cox) model is a special fitting personality that lets you specify models where the response is time-to-failure. The data may include right-censored observations and time-independent covariates. The covariate of interest may be specified as a grouping variable that defines sub populations or strata.

**Parametric Survival**  
Parametric Survival performs the same analysis as the **Fit Parametric Survival** command on the **Analyze > Reliability and Survival** menu. See Quality and Reliability Methods for details.

**Generalized Linear Model**  
fits generalized linear models with various distribution and link functions. See the chapter “Generalized Linear Models,” p. 197 for a complete discussion of generalized linear models.

<table>
<thead>
<tr>
<th>Personality</th>
<th>Response ($Y$) Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Least Squares</td>
<td>$\geq 1$ continuous</td>
<td>all effect types</td>
</tr>
<tr>
<td>Stepwise</td>
<td>1 continuous</td>
<td>all effect types</td>
</tr>
<tr>
<td>MANOVA</td>
<td>$&gt; 1$ continuous</td>
<td>all effect types</td>
</tr>
<tr>
<td>LogLinear Variance</td>
<td>1 continuous</td>
<td>variance effects</td>
</tr>
</tbody>
</table>
Introduction to Model Fitting
Other Model Dialog Features

Emphasis Choices

The Emphasis popup menu controls the type of plots you see as part of the initial analysis report.

Effect Leverage begins with leverage and residual plots for the whole model. You can then request effect details and other statistical reports.

Effect Screening shows whole model information followed by a scaled parameter report with graph and the Prediction Profiler.

Minimal Report suppresses all plots except the regression plot. You request what you want from the platform popup menu.

Run

The Run button submits the model to the fitting platform. Because the Fit Model dialog is nonmodal, the Run button does not close the dialog window. You can continue to use the dialog and make changes to the model for additional fits. You can also make changes to the data and then refit the same model.

Keep Dialog Open

Checking this option keeps the Model Specification Dialog open after clicking Run.

Validity Checks

Fit Model checks your model for errors such as duplicate effects or missing effects in a hierarchy. If you get an alert message, you can either Continue the fitting despite the situation, or click Cancel in the alert message to stop the fitting process.

In addition, your data may have missing values. The default behavior is to exclude rows if any Y or X value is missing. This can be wasteful of rows for cases when some Y’s have non-missing values and other Y’s are missing. Therefore, you may consider fitting each Y separately.

Table 1.3 Characteristics of Fitting Personalities (Continued)

<table>
<thead>
<tr>
<th>Personality</th>
<th>Response (Y) Type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Logistic</td>
<td>1 nominal</td>
<td>all effect types</td>
</tr>
<tr>
<td>Ordinal Logistic</td>
<td>1 ordinal</td>
<td>all effect types</td>
</tr>
<tr>
<td>Proportional Hazard</td>
<td>1 continuous</td>
<td>survival models only</td>
</tr>
<tr>
<td>Parametric Survival</td>
<td>≥ 1 continuous</td>
<td>survival models only</td>
</tr>
<tr>
<td>Generalized Linear Model</td>
<td>continuous, nominal, ordinal</td>
<td>all effect types</td>
</tr>
</tbody>
</table>
When this situation occurs, you are alerted with a window that asks: “Missing values different across Y columns. Fit each Y separately?” Fitting the Y’s separately uses all non-missing rows for that particular Y. Fitting the Y’s together uses only those rows that are non-missing for both Y’s.

When Y’s are fit separately, the results for the individual analyses are given in a Fit Group report. This allows all the Y’s to be profiled in the same Profiler.

**Note:** This dialog only appears when the model is run interactively. Scripts continue to use the default behavior, unless Fit Separately is placed inside the Run command.

### Other Model Specification Options

The popup menu on the title bar of the Model Specification window gives additional options:

- **Center Polynomials** causes a continuous term participating in a crossed term to be centered by its mean. Exceptions to centering are effects with coded or mixture properties. This option is important to make main effects tests be meaningful hypotheses in the presence of continuous crossed effects.

- **Set Alpha Level** is used to set the alpha level for confidence intervals in the Fit Model analysis.

- **Save to Data Table** saves the model as a property of the current data table. A Model popup menu icon appears in the Tables panel at the left of the data grid with a Run Script command. If you then select this Run Script command to submit the model, a new completed Fit Model dialog appears. The JMP Scripting Guide is the reference for JSL statements.

- **Save to Script window** saves the JSL commands for the completed model in a new open script window. You can save the script window and recreate the model at any time by running the script.

- **Create SAS job** creates a SAS program in a script window that can recreate the current analysis in SAS. Once created, you have several options for submitting the code to SAS.
  1. Copy and Paste the resulting code into the SAS Program Editor. This method is useful if you are running an older version of SAS (pre-version 8.2).
  2. Select Edit > Submit to SAS.

- **Submit to SAS** brings up a dialog (shown here) that allows you to enter the machine name and port of an accessible SAS server (reached through an integrated object model, or IOM), or you can connect directly to SAS on your personal computer. The dialog allows you to enter profiles for any new SAS servers. Results are returned to JMP and are displayed in a separate log window.
3. Save the file and double-click it to open it in a local copy of SAS. This method is useful if you would like to take advantage of SAS ODS options, e.g. generating HTML or PDF output from the SAS code.

**Load Version 3 Model** presents an Open File dialog for you to select a text file that contains JMP Version 3 model statements. The model then appears in the Fit Model dialog, and can be saved as a current-version model.

**Formula Editor Model Features**

There are several features in the Formula Editor that are useful for constructing models.

**Parametric Models**

In the Functions List, the Parametric Model group is useful in creating linear regression components. Each presents a dialog that allows you to select the columns involved in the model.
Linear Model builds a linear model, with a parameter as the coefficient as each term.

Examples of Parametric Models
1. Open the Odor Control Original.jmp sample data table.
2. Double-click in the empty column after odor to create a new column. Name the column Linear Model.
3. Right-click on the Linear Model column and select Formula.
4. Scroll down to the bottom of the Function list, and select Parametric Model > Linear Model.
5. Select the following columns: temp, gl ratio, and ht, and click OK.

Figure 1.7 shows the resulting linear model formula.
Interactions Model builds a linear model with first-order interactions:

6. Select Parametric Model > Interactions Model.
7. Select the following columns: temp, gl ratio, and ht, and click OK.

Figure 1.8 shows the resulting interactions model formula.

Figure 1.8 Interactions Model Formula

```
Intercept
+ temp_Parm * temp
+ gl_ratio_Parm * gl_ratio
+ ht_Parm * ht
+ gl_ratio_temp_Parm * gl_ratio * temp
+ ht_temp_Parm * ht * temp
+ ht_gl_ratio_Parm * ht * gl_ratio
```

Full Quadratic Model builds a model with linear, first-order interaction, and quadratic terms.

8. Select Parametric Model > Full Quadratic Model.
9. Select the following columns: temp, gl ratio, and ht, and click OK.

Figure 1.8 shows the resulting full quadratic model formula.

Figure 1.9 Full Quadratic Model Formula

```
Intercept
+ temp_Parm * temp
+ gl_ratio_Parm * gl_ratio
+ ht_Parm * ht
+ temp_temp_Parm * temp * temp
+ gl_ratio_temp_Parm * gl_ratio * temp
+ gl_ratio_gl_ratio_Parm * gl_ratio * gl_ratio
+ ht_temp_Parm * ht * temp
+ ht_gl_ratio_Parm * ht * gl_ratio
+ ht_ht_Parm * ht * ht
```
Adding Parameters

When adding a parameter to a model in the Formula Editor, the Expand into categories checkbox is useful for making parametric expressions across categories.

Example of Adding a Parameter

1. Open the Odor Control Original.jmp sample data table.
2. Add a parameter for each level of the temp variable:
3. Right-click on the temp column and select Formula.
4. Click on the arrow next to Table Columns and select Parameters.
5. Select New Parameter.
6. Keep the parameter name b0.
7. Next to value, type tempParam.
8. Select Expand into categories, selecting columns and click OK.
9. Select temp and click OK.
10. Click on the new parameter, b0_temp = “tempParam”.

Figure 1.10 New Parameter

This formula creates new parameters named b0_temp_n for each level of temp.
The Fit Model platform contains the Standard Least Squares personality. This fitting facility can fit many different types of models (regression, analysis of variance, analysis of covariance, and mixed models), and you can explore the fit in many ways. Even though this is a sophisticated platform, you can do simple tasks very easily.

This Standard Least Squares fitting personality is used for a continuous-response fit to a linear model of factors using least squares. The results are presented in detail, and include leverage plots and least squares means. There are many additional features to consider, such as making contrasts and saving output formulas. More detailed discussions of the Standard Least Squares fitting personality are included in other chapters.

- If you haven't learned how to specify your model in the Model Specification window, you can refer to the chapter “Introduction to Model Fitting,” p. 1.
- If you have response surface effects or want retrospective power calculations, see the chapter “Standard Least Squares: Perspectives on the Estimates,” p. 57.
- For screening applications, see the chapter “Standard Least Squares: Exploring the Prediction Equation,” p. 89.
- If you have random effects, see the chapter “Standard Least Squares: Random Effects,” p. 103.
- If you need the details on how JMP parameterizes its models, see the appendix “Statistical Details,” p. 621.

## Contents

Launch the Platform: A Simple Example ......................................................... 23
  Regression Plot .................................................................................... 26

Option Packages for Emphasis ..................................................................... 27

Whole-Model Statistical Tables ................................................................. 28
  The Summary of Fit Table ..................................................................... 28
  The Analysis of Variance Table .............................................................. 30
  The Lack of Fit Table ........................................................................ 31
  The Parameter Estimates Table ............................................................... 33
  The Effect Test Table .......................................................................... 34

Saturated Models ........................................................................................ 35

Leverage Plots ............................................................................................... 36

Effect Details ............................................................................................... 40
  LSMeans Table .................................................................................. 40
  LSMeans Plot .................................................................................... 41
  LSMeans Contrast ............................................................................. 43
  LSMeans Student's t, LSMeans Tukey's HSD ....................................... 45
  Test Slices .......................................................................................... 46
  Power Analysis .................................................................................... 46

Summary of Row Diagnostics and Save Commands ..................................... 46
  Row Diagnostics ................................................................................ 47
  Save Columns Command ....................................................................... 48

Examples with Statistical Details ................................................................. 49
  One-Way Analysis of Variance with Contrasts ..................................... 50
  Analysis of Covariance ........................................................................ 52
  Analysis of Covariance with Separate Slopes ..................................... 54

Singularity Details ....................................................................................... 56
Launch the Platform: A Simple Example

To introduce the Fit Model platform, consider a simple one-way analysis of variance to test if there is a difference in the mean response among three drugs. The example data (Snedecor and Cochran 1967) is a study that measured the response of 30 subjects after treatment by each of three drugs labeled a, d, and f. The results are in the Drug.jmp sample data table.

1. Open the Drug.jmp sample data table.
2. Select Analyze > Fit Model.
   
   See the chapter “Introduction to Model Fitting,” p. 1, for details about how to use this window.
3. Select y and click Y.
   
   When you select the column y to be the Y response, the Fitting Personality becomes Standard Least Squares and the Emphasis is Effect Leverage. You can change these options in other situations.
4. Select Drug and click Add.

5. Click Run.

   At the top of the output are the graphs in Figure 2.2 that show how the data fit the model. These graphs are called leverage plots, because they convey the idea of the data points pulling on the lines representing the fitted model. Leverage plots have these useful properties:

   • The distance from each point to the line of fit is the error or residual for that point.
• The distance from each point to the horizontal line is what the error would be if you took out effects in the model.

Thus, strength of the effect is shown by how strongly the line of fit is suspended away from the horizontal by the points. Confidence curves are on the graph so you can see at a glance whether an effect is significant. In each plot, if the 95% confidence curves cross the horizontal reference line, then the effect is significant. If the curves do not cross, then it is not significant (at the 5% level).

Figure 2.2 Whole Model Leverage Plot and Drug Effect Leverage Plot

In this simple case where predicted values are simple means, the leverage plot for Drug shows a regression of the actual values on the means for the drug level. Levin, Serlin, and Webne-Behrman (1989) showcase this idea.

Because there is only one effect in the model, the leverage plot for Whole Model and for the effect Drug are equivalent. They differ only in the scaling of the x-axis. The leverage plot for the Whole Model is a plot of the actual response versus the predicted response. So, the points that fall on the line are those that are perfectly predicted.

In this example, the confidence curve does cross the horizontal line. Thus, the drug effect is marginally significant, even though there is considerable variation around the line of fit (in this case around the group means).

After you examine the fit graphically, you can look below it for textual details. In this case there are three levels of Drug, giving two parameters to characterize the differences among them. Text reports show the estimates and various test statistics and summary statistics concerning the parameter estimates. The Summary of Fit table and the Analysis of Variance table beneath the whole-model leverage plot show the fit as a whole. Because Drug is the only effect, the same test statistic appears in the Analysis of Variance table and in the Effects Tests table. Results for the Summary of Fit and the Analysis of Variance are shown in Figure 2.3.
The Analysis of Variance table shows that the Drug effect has an observed significance probability (Prob > F) of 0.0305, which is significant at a 0.05 level. The RSquare value means that 22.8% of the variation in the response can be absorbed by fitting this model.

Whenever there are nominal effects (such as Drug), it is interesting to compare how well the levels predict the response. Rather than use the parameter estimates directly, it is usually more meaningful to compare the predicted values at the levels of the nominal values. These predicted values are called the least squares means (LSMeans), and in this simple case, they are the same as the ordinary means. Least squares means can differ from simple means when there are other effects in the model, as seen in later examples. The Least Squares Means table for a nominal effect shows beneath the effect’s leverage plot (Figure 2.4).

The popup menu for an effect also lets you request the LSMeans Plot, as shown in Figure 2.4. The plot graphically shows the means and their associated 95% confidence interval.
The later section "Examples with Statistical Details," p. 49, continues the drug analysis with the Parameter Estimates table and looks at the group means with the LSMeans Contrast.

**Regression Plot**

If there is exactly one continuous term in a model, and no more than one categorical term, then JMP plots the regression line (or lines). The regression plot for the drug data is shown in Figure 2.5 and is done as follows:

- Specify the model as in "Launch the Platform: A Simple Example," p. 23 but this time, add x with Drug as a model effect.
- The Regression Plot appears by default. You can elect to not show this plot in the output by selecting Response y in the title bar > Row Diagnostics > Plot Regression. Selecting this command turns the plot off and on.
The model fitting process can produce a wide variety of tables, plots, and graphs. For convenience, three standard option packages let you choose the report layout that best corresponds to your needs. Just as automobiles are made available with luxury, sport, and economy option packages, linear model results are made available in choices to adapt to your situation. Table 2.1 “Standard Least Squares Report Layout Defined by Emphasis,” p. 27, describes the types of report layout for the standard least squares analysis.

The chapter “Introduction to Model Fitting,” p. 1, introduces the Emphasis menu. The default value of Emphasis is based on the number of effects that you specify and the number of rows (observations) in the data table. The Emphasis menu options are summarized in Table 2.1.

<table>
<thead>
<tr>
<th>Emphasis</th>
<th>Description of Reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect Leverage</td>
<td>Choose <strong>Effect Leverage</strong> when you want details on the significance of each effect. The initial reports for this emphasis features leverage plots, and the reports for each effect are arranged horizontally.</td>
</tr>
<tr>
<td>Effect Screening</td>
<td>The <strong>Effect Screening</strong> layout is better when you have many effects, and don’t want details until you see which effects are stronger and which are weaker. This is the recommended method for screening designs, where there are many effects and few observations, and the quest is to find the strong effects, rather than to test significance. This arrangement initially displays whole model information followed by effect details, scaled estimates, and the prediction profiler.</td>
</tr>
<tr>
<td>Minimal Report</td>
<td><strong>Minimal Report</strong> starts simple; you customize the results with the tables and plots you want to see. Choosing <strong>Minimal Report</strong> suppresses all plots (except the regression plot), and arranges whole model and effect detail tables vertically.</td>
</tr>
</tbody>
</table>
Whole-Model Statistical Tables

This section starts the details on the standard statistics inside the reports. You might want to skim some of these details sections and come back to them later.

Regression reports can be turned on and off with the Regression Reports menu. This menu, shown in Figure 2.6, is accessible from the report’s red triangle menu.

The Whole Model section shows how the model fits as a whole. The next sections describe these tables:

- Summary of Fit
- Analysis of Variance
- Lack of Fit
- Parameter Estimates
- Effect Tests

Discussion of tables for effects and leverage plots are described under the sections “The Effect Test Table,” p. 34, and “Leverage Plots,” p. 36.

The Show All Confidence Intervals command shows confidence intervals for parameter estimates in the Parameter Estimates report, and also for least squares means in Least Squares Means Tables. The AICc command shows AICc and BIC in the Summary of Fit report.

The following examples use the Drug.jmp data table from the Sample Data folder. The model specifies $y$ as the response variable ($Y$) and Drug and $x$ as effects, where Drug has the nominal modeling type.

The Summary of Fit Table

The Summary of Fit table appears first. The numeric summaries of the response for the multiple regression model are shown in Figure 2.7.
The Summary of Fit for the response includes:

**RSquare** estimates the proportion of the variation in the response around the mean that can be attributed to terms in the model rather than to random error. Using quantities from the corresponding Analysis of Variance table, $R^2$ is calculated:

$$R^2 = \frac{\text{Sum of Squares(Model)}}{\text{Sum of Squares(C. Total)}}$$

It is also the square of the correlation between the actual and predicted response. An $R^2$ of 1 occurs when there is a perfect fit (the errors are all zero). An $R^2$ of 0 means that the fit predicts the response no better than the overall response mean.

**Rsquare Adj** adjusts $R^2$ to make it more comparable over models with different numbers of parameters by using the degrees of freedom in its computation. It is a ratio of mean squares instead of sums of squares and is calculated

$$1 - \frac{\text{Mean Square(Error)}}{\text{Mean Square(C. Total)}}$$

where mean square for Error is found in the Analysis of Variance table (shown next under “The Analysis of Variance Table,” p. 30) and the mean square for C. Total can be computed as the C. Total sum of squares divided by its respective degrees of freedom.

**Root Mean Square Error** estimates the standard deviation of the random error. It is the square root of the mean square for error in the corresponding Analysis of Variance table, and it is commonly denoted as $s$.

**Mean of Response** is the overall mean of the response values. It is important as a base model for prediction because all other models are compared to it. The variance measured around this mean is the Sum of Squares Corrected Total (C. Total) in the Analysis of Variance table.

**Observations (or Sum of Weights)** records the number of observations used in the fit. If there are no missing values and no excluded rows, this is the same as the number of rows in the data table. If there is a column assigned to the role of weight, this is the sum of the weight column values.
The Analysis of Variance Table

The Analysis of Variance table is displayed in Figure 2.8 and shows the basic calculations for a linear model.

**Figure 2.8 Analysis of Variance Table**

<table>
<thead>
<tr>
<th>Source</th>
<th>DF</th>
<th>Sum of Squares</th>
<th>Mean Square</th>
<th>F Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>3</td>
<td>671.4974</td>
<td>223.8258</td>
<td>18.1938</td>
</tr>
<tr>
<td>Error</td>
<td>26</td>
<td>417.2056</td>
<td>16.0465</td>
<td>Prob &gt; F</td>
</tr>
<tr>
<td>C. Total</td>
<td>29</td>
<td>1288.7030</td>
<td>&lt;.0001</td>
<td></td>
</tr>
</tbody>
</table>

The table compares the model fit to a simple fit of a single mean:
- **Source** lists the three sources of variation, called Model, Error, and C. Total (Corrected Total).
- **DF** records an associated degrees of freedom (DF) for each source of variation.
  - The C. Total degrees of freedom is shown for the simple mean model. There is only one degree of freedom used (the estimate of the mean parameter) in the calculation of variation so the C. Total DF is always one less than the number of observations.
  - The total degrees of freedom are partitioned into the Model and Error terms:
    - The Model degrees of freedom shown is the number of parameters (except for the intercept) used to fit the model.
    - The Error DF is the difference between the C. Total DF and the Model DF.
- **Sum of Squares** records an associated sum of squares (SS for short) for each source of variation. The SS column accounts for the variability measured in the response. It is the sum of squares of the differences between the fitted response and the actual response.
  - The total (C. Total) SS is the sum of squared distances of each response from the sample mean, which is 1288.7 in the example shown at the beginning of this section. That is the base model (or simple mean model) used for comparison with all other models.
  - The Error SS is the sum of squared differences between the fitted values and the actual values, and is 417.2 in the previous example. This sum of squares corresponds to the unexplained Error (residual) after fitting the regression model.
  - The total SS less the error SS gives the sum of squares attributed to the Model.
  - One common set of notations for these is SSR, SSE, and SST for sum of squares due to regression (model), error, and total, respectively.
- **Mean Square** is a sum of squares divided by its associated degrees of freedom. This computation converts the sum of squares to an average (mean square).
  - The Model mean square is 290.5 in the table at the beginning of this section.
  - The Error Mean Square is 16.046 and estimates the variance of the error term. It is often denoted as MSE or s².
**F Ratio** is the model mean square divided by the error mean square. It tests the hypothesis that all the regression parameters (except the intercept) are zero. Under this whole-model hypothesis, the two mean squares have the same expectation. If the random errors are normal, then under this hypothesis the values reported in the SS column are two independent Chi-squares. The ratio of these two Chi-squares divided by their respective degrees of freedom (reported in the DF column) has an \( F \)-distribution. If there is a significant effect in the model, the **F Ratio** is higher than expected by chance alone.

**Prob > F** is the probability of obtaining a greater \( F \)-value by chance alone if the specified model fits no better than the overall response mean. Significance probabilities of 0.05 or less are often considered evidence that there is at least one significant regression factor in the model.

Note that large values of **Model** SS, relative to small values of **Error** SS, lead to large \( F \)-ratios and low \( p \) values. (This is desired if the goal is to declare that terms in the model are significantly different from zero.) Most practitioners check this \( F \)-test first and make sure that it is significant before delving further into the details of the fit. This significance is also shown graphically by the whole-model leverage plot described in the previous section.

---

**The Lack of Fit Table**

The Lack of Fit table in Figure 2.9 shows a special diagnostic test and appears only when the data and the model provide the opportunity.

---

**Figure 2.9 Lack of Fit Table**

<table>
<thead>
<tr>
<th>Source of Lack of Fit</th>
<th>DF</th>
<th>SS</th>
<th>Mean Square</th>
<th>F Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lack of Fit</td>
<td>16</td>
<td>254.863926</td>
<td>14.1694</td>
<td>0.6970</td>
</tr>
<tr>
<td>Pure Error</td>
<td>8</td>
<td>182.333033</td>
<td>20.2917</td>
<td>0.7507</td>
</tr>
<tr>
<td>Total Error</td>
<td>26</td>
<td>417.20306</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The idea is that sometimes you can estimate the error variance independently of whether you have the right form of the model. This occurs when observations are exact replicates of each other in terms of the \( X \) variables. The error that you can measure for these exact replicates is called pure error. This is the portion of the sample error that cannot be explained or predicted by the form that the model uses for the \( X \) variables. However, a lack of fit test is not very useful if it has only a few degrees of freedom (not many replicated \( x \) values).

The difference between the residual error from the model and the pure error is called lack of fit error. A lack of fit error can be significantly greater than pure error if you have the wrong functional form of a regressor, or if you do not have enough interaction effects in an analysis of variance model. In that case, you should consider adding interaction terms, if appropriate, or try to better capture the functional form of a regressor.

There are two common situations where there is no lack of fit test:

1. There are no exactly replicated points with respect to the \( X \) data, and therefore there are no degrees of freedom for pure error.
2. The model is *saturated*, meaning that the model itself has a degree of freedom for each different \( x \) value. Therefore, there are no degrees of freedom for lack of fit.

The Lack of Fit table shows information about the error terms:

- **Source** lists the three sources of variation called Lack of Fit, Pure Error, and Total Error.
- **DF** records an associated *degrees of freedom* (DF) for each source of error.

The Total Error DF is the degrees of freedom found on the Error line of the Analysis of Variance table. It is the difference between the Total DF and the Model DF found in that table. The Error DF is partitioned into degrees of freedom for lack of fit and for pure error.

The Pure Error DF is pooled from each group where there are multiple rows with the same values for each effect. For example, in the sample data, Big Class.jmp, there is one instance where two subjects have the same values of age and weight (Chris and Alfred are both 14 and have a weight of 99). This gives \((2 - 1) = 1\) DF for Pure Error. In general, if there are \( g \) groups having multiple rows with identical values for each effect, the pooled DF, denoted \( DF_p \), is

\[
DF_p = \sum_{i=1}^{g} (n_i - 1)
\]

where \( n_i \) is the number of replicates in the \( i \)th group. The Lack of Fit DF is the difference between the Total Error and Pure Error degrees of freedom.

- **Sum of Squares** records an associated sum of squares (SS for short) for each source of error.

The Total Error SS is the sum of squares found on the Error line of the corresponding Analysis of Variance table.

The Pure Error SS is pooled from each group where there are multiple rows with the same values for each effect. This estimates the portion of the true random error that is not explained by model effects. In general, if there are \( g \) groups having multiple rows with like values for each effect, the pooled SS, denoted \( SS_p \) is written

\[
SS_p = \sum_{i=1}^{g} SS_i
\]

where \( SS_i \) is the sum of squares for the \( i \)th group corrected for its mean.

The Lack of Fit SS is the difference between the Total Error and Pure Error sum of squares. If the lack of fit SS is large, it is possible that the model is not appropriate for the data. The \( F \)-ratio described below tests whether the variation due to lack of fit is small enough to be accepted as a negligible portion of the pure error.

- **Mean Square** is a sum of squares divided by its associated degrees of freedom. This computation converts the sum of squares to an average (mean square). \( F \)-ratios for statistical tests are the ratios of mean squares.

- **F Ratio** is the ratio of mean square for Lack of Fit to mean square for Pure Error. It tests the hypothesis that the lack of fit error is zero.
**Prob > F** is the probability of obtaining a greater $F$-value by chance alone if the variation due to lack of fit variance and the pure error variance are the same. This means that an insignificant proportion of error is explained by lack of fit.

**Max RSq** is the maximum $R^2$ that can be achieved by a model using only the variables in the model. Because Pure Error is invariant to the form of the model and is the minimum possible variance, Max RSq is calculated

\[
1 - \frac{SS(\text{Pure Error})}{SS(\text{Total for whole model})}
\]

### The Parameter Estimates Table

The Parameter Estimates table shows the estimates of the parameters in the linear model and a $t$-test for the hypothesis that each parameter is zero. Simple continuous regressors have only one parameter. Models with complex classification effects have a parameter for each anticipated degree of freedom. The Parameters Estimates table is shown in Figure 2.10.

**Figure 2.10 Parameter Estimates Table**

| Term  | Estimate | Std Error | t Ratio | Prob>|t| |
|-------|----------|-----------|---------|-----|----|
| Intercept | -2.656773 | 1.911055 | -1.41 | 0.1752 |
| D[j][d]       | -1.15037  | 1.059222 | -1.12 | 0.2742 |
| D[j][q]       | -1.076865 | 1.041298 | -1.03 | 0.3108 |
| $x$            | 0.9071098 | 0.104498 | 8.60 | <.0001* |

The Parameter Estimates table shows these quantities:

- **Term** names the estimated parameter. The first parameter is always the intercept. Simple regressors show as the name of the data table column. Regressors that are dummy indicator variables constructed from nominal or ordinal effects are labeled with the names of the levels in brackets. For nominal variables, the dummy variables are coded as 1 except for the last level, which is coded as –1 across all the other dummy variables for that effect. The parameters for ordinally coded indicators measure the difference from each level to the level before it. See “Interpretation of Parameters,” p. 627 in the “Statistical Details” chapter, for additional information.

- **Estimate** lists the parameter estimates for each term. They are the coefficients of the linear model found by least squares.

- **Std Error** is the standard error, an estimate of the standard deviation of the distribution of the parameter estimate. It is used to construct $t$-tests and confidence intervals for the parameter.

- **$t$ Ratio** is a statistic that tests whether the true parameter is zero. It is the ratio of the estimate to its standard error and has a Student’s $t$-distribution under the hypothesis, given the usual assumptions about the model.

- **Prob > |t|** is the probability of getting an even greater $t$-statistic (in absolute value), given the hypothesis that the parameter is zero. This is the two-tailed test against the alternatives in each
direction. Probabilities less than 0.05 are often considered as significant evidence that the parameter is not zero.

Although initially hidden, the following columns are also available. Right-click (control-click on the Macintosh) and select the desired column from the **Columns** menu. Alternatively, there is a preference that can be set to always show the columns.

- **Std Beta** are the parameter estimates that would have resulted from the regression had all the variables been standardized to a mean of 0 and a variance of 1.
- **VIF** shows the variance inflation factors. High VIFs indicate a collinearity problem.
  
  Note that the VIF is defined as
  
  \[ VIF = \frac{1}{1 - R_i^2} \]
  
  where \( R_i^2 \) is the coefficient of multiple determination for the regression of \( x_i \) as a function of the other explanatory variables.

  Note that the definition of \( R_i^2 \) changes for no-intercept models. For no-intercept and hidden-intercept models, \( R_i^2 \) from the uncorrected Sum of Squares or from the zero model is used, rather than the corrected sum of squares from the mean model.

- **Lower 95%** is the lower 95% confidence interval for the parameter estimate.
- **Upper 95%** is the upper 95% confidence interval for the parameter estimate.
- **Design Std Error** is the standard error without being scaled by sigma (RMSE), and is equal to
  
  \[ \sqrt{\text{diag}(X'X)^{-1}} \]

### The Effect Test Table

The effect tests are joint tests that all the parameters for an individual effect are zero. If an effect has only one parameter, as with simple regressors, then the tests are no different from the *t*-tests in the Parameter Estimates table. Parameterization and handling of singularities are different from the SAS GLM procedure. For details, see the appendix “Statistical Details,” p. 621. The Effect Tests table is shown in Figure 2.11.

#### Figure 2.11 Effect Tests Table

<table>
<thead>
<tr>
<th>Source</th>
<th>Df</th>
<th>Sum of Squares</th>
<th>F Ratio</th>
<th>Prob &gt; F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drug</td>
<td>2</td>
<td>69.5637</td>
<td>1.1301</td>
<td>0.3384</td>
</tr>
<tr>
<td>x</td>
<td>1</td>
<td>177.9674</td>
<td>35.9145</td>
<td>&lt;.0001*</td>
</tr>
</tbody>
</table>

The Effect Tests table shows the following information for each effect:

- **Source** lists the names of the effects in the model.
**Nparm** is the number of parameters associated with the effect. Continuous effects have one parameter. Nominal effects have one less parameter than the number of levels. Crossed effects multiply the number of parameters for each term. Nested effects depend on how levels occur.

**DF** is the degrees of freedom for the effect test. Ordinarily Nparm and DF are the same. They are different if there are linear combinations found among the regressors such that an effect cannot be tested to its fullest extent. Sometimes the DF is zero, indicating that no part of the effect is testable. Whenever DF is less than Nparm, the note **Lost DFs** appears to the right of the line in the report.

**Sum of Squares** is the sum of squares for the hypothesis that the listed effect is zero.

**F Ratio** is the $F$-statistic for testing that the effect is zero. It is the ratio of the mean square for the effect divided by the mean square for error. The mean square for the effect is the sum of squares for the effect divided by its degrees of freedom.

**Prob > F** is the significance probability for the $F$-ratio. It is the probability that if the null hypothesis is true, a larger $F$-statistic would occur only due to random error. Values less than 0.0005 appear as <.0001, which is conceptually zero.

Although initially hidden, a column that displays the Mean Square is also available. Right-click (control-click on the Macintosh) and select **Mean Square** from the **Columns** menu.

### Saturated Models

Screening experiments often involve fully saturated models, where there are not enough degrees of freedom to estimate error. Because of this, neither standard errors for the estimates, nor $t$-ratios, nor $p$-values can be calculated in the traditional way.

For these cases, JMP uses the relative standard error, corresponding to a residual standard error of 1. In cases where all the variables are identically coded (say, $[-1,1]$ for low and high levels), these relative standard errors are identical.

JMP also displays a Pseudo-$t$-ratio, calculated as

\[
\text{Pseudo } t = \frac{\text{estimate}}{\text{relative std error} \times \text{PSE}}
\]

using Lenth’s PSE (pseudo standard-error) and degrees of freedom for error (DFE) equal to one-third the number of parameters. The value for Lenth’s PSE is shown at the bottom of the report.

### Example of a Saturated Model
1. Open the **Reactor.jmp** sample data table.
2. Select **Analyze > Fit Model**.
3. Select $Y$ and click $Y$.
4. Select the following five columns: $F$, $Ct$, $A$, $T$ and $Cn$.
5. Click on the **Macros** button and select **Full Factorial**.
6. Click **Run**.
The parameter estimates are presented in sorted order, with smallest \( p \)-values listed first. The sorted parameter estimates are presented in Figure 2.12.

**Figure 2.12** Saturated Report

<table>
<thead>
<tr>
<th>Term</th>
<th>Estimate</th>
<th>Relative Std Error</th>
<th>Pseudo t-Ratio</th>
<th>Pseudo p-Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI</td>
<td>0.75</td>
<td>0.179777</td>
<td>14.96</td>
<td>&lt;.0001*</td>
</tr>
<tr>
<td>C1</td>
<td>6.925</td>
<td>0.179777</td>
<td>10.10</td>
<td>&lt;.0001*</td>
</tr>
<tr>
<td>TCh</td>
<td>-5.5</td>
<td>0.179777</td>
<td>-3.38</td>
<td>&lt;.0001*</td>
</tr>
<tr>
<td>T</td>
<td>-5.375</td>
<td>0.179777</td>
<td>8.19</td>
<td>&lt;.0001*</td>
</tr>
<tr>
<td>Cn</td>
<td>-3.125</td>
<td>0.179777</td>
<td>-4.76</td>
<td>0.0027*</td>
</tr>
<tr>
<td>FMACh</td>
<td>-1.25</td>
<td>0.179777</td>
<td>-1.90</td>
<td>0.0650</td>
</tr>
<tr>
<td>AT</td>
<td>1.0625</td>
<td>0.179777</td>
<td>1.92</td>
<td>0.1355</td>
</tr>
<tr>
<td>CPhCn</td>
<td>1</td>
<td>0.179777</td>
<td>1.52</td>
<td>0.1576</td>
</tr>
<tr>
<td>FMTCh</td>
<td>-0.9375</td>
<td>0.179777</td>
<td>-1.43</td>
<td>0.1826</td>
</tr>
<tr>
<td>FMPA</td>
<td>0.75</td>
<td>0.179777</td>
<td>1.14</td>
<td>0.2789</td>
</tr>
<tr>
<td>FCPACh</td>
<td>0.75</td>
<td>0.179777</td>
<td>1.14</td>
<td>0.2789</td>
</tr>
<tr>
<td>FCP</td>
<td>0.6975</td>
<td>0.179777</td>
<td>1.95</td>
<td>0.3187</td>
</tr>
<tr>
<td>FMT</td>
<td>0.6975</td>
<td>0.179777</td>
<td>1.95</td>
<td>0.3187</td>
</tr>
<tr>
<td>CPAT</td>
<td>0.5625</td>
<td>0.179777</td>
<td>0.86</td>
<td>0.4168</td>
</tr>
<tr>
<td>FMTCh</td>
<td>0.5</td>
<td>0.179777</td>
<td>0.76</td>
<td>0.4622</td>
</tr>
<tr>
<td>FT</td>
<td>-0.4375</td>
<td>0.179777</td>
<td>-0.67</td>
<td>0.6186</td>
</tr>
<tr>
<td>CPA</td>
<td>0.4375</td>
<td>0.179777</td>
<td>0.67</td>
<td>0.5186</td>
</tr>
<tr>
<td>ACh</td>
<td>0.4375</td>
<td>0.179777</td>
<td>0.67</td>
<td>0.5186</td>
</tr>
<tr>
<td>PM</td>
<td>0.375</td>
<td>0.179777</td>
<td>0.57</td>
<td>0.5759</td>
</tr>
<tr>
<td>FMT</td>
<td>-0.375</td>
<td>0.179777</td>
<td>-0.57</td>
<td>0.5759</td>
</tr>
<tr>
<td>A</td>
<td>-0.3125</td>
<td>0.179777</td>
<td>-0.48</td>
<td>0.6438</td>
</tr>
<tr>
<td>FMTCh</td>
<td>0.3125</td>
<td>0.179777</td>
<td>0.48</td>
<td>0.6438</td>
</tr>
<tr>
<td>FCPAT</td>
<td>0.3125</td>
<td>0.179777</td>
<td>0.48</td>
<td>0.6438</td>
</tr>
<tr>
<td>CPATCh</td>
<td>0.3125</td>
<td>0.179777</td>
<td>0.48</td>
<td>0.6438</td>
</tr>
<tr>
<td>FCPMTCh</td>
<td>-0.3125</td>
<td>0.179777</td>
<td>-0.48</td>
<td>0.6438</td>
</tr>
<tr>
<td>FTCh</td>
<td>-0.3125</td>
<td>0.179777</td>
<td>-0.48</td>
<td>0.6438</td>
</tr>
<tr>
<td>FCh</td>
<td>-0.3125</td>
<td>0.179777</td>
<td>-0.48</td>
<td>0.6438</td>
</tr>
<tr>
<td>CPh</td>
<td>0.0925</td>
<td>0.179777</td>
<td>0.10</td>
<td>0.9259</td>
</tr>
<tr>
<td>AM</td>
<td>0.0925</td>
<td>0.179777</td>
<td>0.10</td>
<td>0.9259</td>
</tr>
<tr>
<td>CPhA</td>
<td>0</td>
<td>0.179777</td>
<td>0.00</td>
<td>1.0000</td>
</tr>
</tbody>
</table>

No error degrees of freedom, see ordinary least uncomputable.
Relative Std Error corresponds to residual standard error of 1.
Pseudo t-Ratio and p-Value calculated using Lenth PSE = 0.6025 and DFE=10.203

In cases where the relative standard errors are different (perhaps due to unequal scaling), a similar report appears. However, there is a different value for Lenth’s PSE for each estimate.

**Leverage Plots**

To graphically view the significance of the model or focus attention on whether an effect is significant, you want to display the data by focusing on the hypothesis for that effect. You might say that you want more of an X-ray picture showing the inside of the data rather than a surface view from the outside. The leverage plot gives this view of your data; it offers maximum insight into how the fit carries the data.
The effect in a model is tested for significance by comparing the sum of squared residuals to the sum of squared residuals of the model with that effect removed. Residual errors that are much smaller when the effect is included in the model confirm that the effect is a significant contribution to the fit.

The graphical display of an effect’s significance test is called a leverage plot. See Sall (1990). This type of plot shows for each point what the residual would be both with and without that effect in the model. Leverage plots are found in the Row Diagnostics submenu, shown in Figure 2.13 of the Fit Model report.

A leverage plot is constructed as illustrated in Figure 2.14. The distance from a point to the line of fit shows the actual residual. The distance from the point to the horizontal line of the mean shows what the residual error would be without the effect in the model. In other words, the mean line in this leverage plot represents the model where the hypothesized value of the parameter (effect) is constrained to zero.

Historically, leverage plots are referred to as a partial-regression residual leverage plot by Belsley, Kuh, and Welsch (1980) or an added variable plot by Cook and Weisberg (1982).

The term leverage is used because a point exerts more influence on the fit if it is farther away from the middle of the plot in the horizontal direction. At the extremes, the differences of the residuals before and after being constrained by the hypothesis are greater and contribute a larger part of the sums of squares for that effect’s hypothesis test.

The fitting platform produces a leverage plot for each effect in the model. In addition, there is one special leverage plot titled Whole Model that shows the actual values of the response plotted against the predicted values. This Whole Model leverage plot dramatizes the test that all the parameters (except intercepts) in the model are zero. The same test is reported in the Analysis of Variance report.
The leverage plot for the linear effect in a simple regression is the same as the traditional plot of actual response values and the regressor.

**Example of a Leverage Plot for a Linear Effect**

1. Open the Big Class.jmp sample data table.
2. Select Analyze > Fit Model.
3. Select height and click Y.
4. Select age and click Add.
5. Click Run.

The plot on the left is the Whole Model test for all effects, and the plot on the right is the leverage plot for the effect age.
The points on a leverage plot for simple regression are actual data coordinates, and the horizontal line for the constrained model is the sample mean of the response. But when the leverage plot is for one of multiple effects, the points are no longer actual data values. The horizontal line then represents a partially constrained model instead of a model fully constrained to one mean value. However, the intuitive interpretation of the plot is the same whether for simple or multiple regression. The idea is to judge if the line of fit on the effect’s leverage plot carries the points significantly better than does the horizontal line.

Figure 2.14 is a general diagram of the plots in Figure 2.15. Recall that the distance from a point to the line of fit is the actual residual and that the distance from the point to the mean is the residual error if the regressor is removed from the model.

Confidence Curves

The leverage plots are shown with confidence curves. These indicate whether the test is significant at the 5% level by showing a confidence region for the line of fit. If the confidence region between the curves contains the horizontal line, then the effect is not significant. If the curves cross the line, the effect is significant. Compare the examples shown in Figure 2.16.

**Figure 2.16 Comparison of Significance Shown in Leverage Plots**

**Interpretation of X Scales**

If the modeling type of the regressor is continuous, then the x-axis is scaled like the regressor and the slope of the line of fit in the leverage plot is the parameter estimate for the regressor. (See the left illustration in Figure 2.17.)

If the effect is nominal or ordinal, or if a complex effect like an interaction is present instead of a simple regressor, then the x-axis cannot represent the values of the effect directly. In this case the x-axis is scaled like the y-axis, and the line of fit is a diagonal with a slope of 1. The whole model leverage plot is a version of this. The x-axis turns out to be the predicted response of the whole model, as illustrated by the right-hand plot in Figure 2.17.
The influential points in all leverage plots are the ones far out on the x-axis. If two effects in a model are closely related, then these effects as a whole don’t have much leverage. This problem is called *collinearity*. By scaling regressor axes by their original values, collinearity is shown by shrinkage of the points in the x direction.

See the appendix “Statistical Details,” p. 621, for the details of leverage plot construction.

Effect Details

Each effect has the popup menu shown Figure 2.18 next to its name. The effect popup menu items let you request tables, plots, and tests for that effect. The commands for an effect append results to the effect report. You can close results or dismiss the results by deselecting the item in the menu.

The next sections describe the Effect popup menu commands.

**LSMeans Table**

Least squares means are predicted values from the specified model across the levels of a categorical effect where the other model factors are controlled by being set to *neutral* values. The neutral values are the sample means (possibly weighted) for regressors with interval values, and the average coefficient over the levels for unrelated nominal effects.
Least squares means are the values that let you see which levels produce higher or lower responses, holding the other variables in the model constant. Least squares means are also called adjusted means or population marginal means.

Least squares means are the statistics that are compared when effects are tested. They might not reflect typical real-world values of the response if the values of the factors do not reflect prevalent combinations of values in the real world. Least squares means are useful as comparisons in experimental situations. The Least Squares Mean Table for Big Class.jmp is shown in Figure 2.19. For details on recreating this report, see “Example of a Leverage Plot for a Linear Effect,” p. 38.

**Figure 2.19 Least Squares Mean Table for Big Class.jmp**

<table>
<thead>
<tr>
<th>Level</th>
<th>Least Sq Mean</th>
<th>Std Error</th>
<th>Mean</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>58.125030</td>
<td>1.1996190</td>
<td>58.125030</td>
</tr>
<tr>
<td>13</td>
<td>60.205714</td>
<td>1.2784089</td>
<td>60.205714</td>
</tr>
<tr>
<td>14</td>
<td>64.158667</td>
<td>0.8794695</td>
<td>64.158667</td>
</tr>
<tr>
<td>15</td>
<td>64.571429</td>
<td>1.2784089</td>
<td>64.571429</td>
</tr>
<tr>
<td>16</td>
<td>64.535333</td>
<td>1.8629216</td>
<td>64.535333</td>
</tr>
<tr>
<td>17</td>
<td>68.688667</td>
<td>1.9529216</td>
<td>68.688667</td>
</tr>
</tbody>
</table>

A Least Squares Means table with standard errors is produced for all categorical effects in the model. For main effects, the Least Squares Means table also includes the sample mean. It is common for the least squares means to be closer together than the sample means. For further details on least squares means, see the appendix “Statistical Details,” p. 621.

The Least Squares Means table shows these quantities:

- **Level** lists the names of each categorical level.
- **Least Sq Mean** lists the least squares mean for each level of the categorical variable.
- **Std Error** lists the standard error of the Least Sq Mean for each level of the categorical variable.
- **Mean** lists the response sample mean for each level of the categorical variable. This is different from the least squares mean if the values of other effects in the model do not balance out across this effect.

Although initially hidden, columns that display the upper and lower 95% confidence intervals of the mean are also available. Right-click (control-click on the Macintosh) and select **Lower 95%** or **Upper 95%** from the **Columns** menu.

**LSMeans Plot**

The **LSMeans Plot** option plots least squares means (LSMeans) plots for nominal and ordinal main effects and two-way interactions. The chapter "Standard Least Squares: Exploring the Prediction Equation,” p. 89, discusses the **Interaction Plots** command in the **Factor Profiling** menu, which offers interaction plots in a different format.
**Standard Least Squares: Introduction**  
**Effect Details**

To see an example of the LSMeans Plot:

1. Open Popcorn.jmp from the sample data directory.
2. Click on Analyze > Fit Model.
3. Select yield as Y and add popcorn, oil amt, and batch for the model effects.
4. Select popcorn in the Construct Model Effects section and batch in the Select Columns section.
5. Click on the Cross button to obtain the popcorn*batch interaction.
6. Click on Run.
7. Select LSMeans Plot from the red-triangle menu for each of the effects.

Figure 2.20 shows the effect plots for main effects and the two-way interaction. An interpretation of the data (Popcorn.jmp) is in the chapter “A Factorial Analysis” in the JMP Introductory Guide. In this experiment, popcorn yield measured by volume of popped corn from a given measure of kernels is compared for three conditions:

- type of popcorn (gourmet and plain)
- batch size popped (large and small)
- amount of oil used (little and lots)

**Figure 2.20** LSMeans Plots for Main Effects and Interactions

To transpose the factors of the LSMeans plot for a two-factor interaction, use Shift and select the LSMeans Plot option. Figure 2.21 shows both the default and the transposed factors plots.
A contrast is a set of linear combinations of parameters that you want to jointly test to be zero. JMP builds contrasts in terms of the least squares means of the effect. By convention, each column of the contrast is normalized to have sum zero and an absolute sum equal to two.

If a contrast involves a covariate, you can specify the value of the covariate at which to test the contrast.

To illustrate using the **LSMeans Contrast** command:

1. Open Big Class.jmp from the sample data directory.
2. Click on **Analyze > Fit Model**.
3. Select **height** as the **Y** variable and **age** as the effect variable.
4. Click **Run**.
5. In the red-triangle menu for the **age** effect, select the **LSMeans Contrast** command.

A window is displayed for specifying contrasts with respect to the **age** effect. (This command is enabled only for pure classification effects.) The contrast window for the **age** effect using Big Class.jmp is shown in Figure 2.22.
This Contrast window shows the name of the effect and the names of the levels in the effect. Beside the levels is an area enclosed in a rectangle that has a column of numbers next to boxes of + and - signs.

To construct a contrast, click the + and - boxes beside the levels that you want to compare. If possible, the window normalizes each time to make the sum for a column zero and the absolute sum equal to two each time you click; it adds to the plus or minus score proportionately.

For example, to form a contrast that compares the first two age levels with the second two levels, click + for the ages 12 and 13, and click - for ages 14 and 15. If you want to do more comparisons, click the New Column button for a new column to define the new contrast. The contrast for age is shown in Figure 2.23.

Figure 2.23  LSMeans Contrast Specification for Age

After you are through defining contrasts, click Done. The contrast is estimated, and the Contrast table shown in Figure 2.24 is appended to the other tables for that effect.

Figure 2.24  LSMeans Contrast Results
The Contrast table shows:

- the contrast as a function of the least squares means
- the estimates and standard errors of the contrast for the least squares means, and \( t \)-tests for each column of the contrast
- the \( F \)-test for all columns of the contrast tested jointly
- the Parameter Function table that shows the contrast expressed in terms of the parameters. In this example the parameters are for the ordinal variable, \( \text{age} \).

**LSMeans Student's t, LSMeans Tukey's HSD**

The **LSMeans Student's t** and **LSMeans Tukey's HSD** commands give multiple comparison tests for model effects.

- **LSMeans Student's t** computes individual pairwise comparisons of least squares means in the model using Student's \( t \)-tests. This test is sized for individual comparisons. If you make many pairwise tests, there is no protection across the inferences. Thus, the alpha-size (Type I) error rate across the hypothesis tests is higher than that for individual tests.
- **LSMeans Tukey's HSD** gives a test that is sized for all differences among the least squares means. This is the Tukey or Tukey-Kramer HSD (Honestly Significant Difference) test. (Tukey 1953, Kramer 1956). This test is an exact alpha-level test if the sample sizes are the same and conservative if the sample sizes are different (Hayter 1984).

These tests are discussed in detail in the *Basic Analysis and Graphing* book, which has examples and a description of how to read and interpret the multiple comparison tables.

The reports from both options have menus that allow for the display of additional reports.

- **Crosstab Report** shows or hides the crosstab report. This report is a two-way table that highlights significant differences in red.
- **Connecting Letters Report** shows or hides a report that illustrates significant differences with letters (similar to traditional SAS GLM output). Levels not connected by the same letter are significantly different.
- **Ordered Differences Report** shows or hides a report that ranks the differences from lowest to highest. It also plots the differences on a histogram that has overlaid confidence interval lines. See the *Basic Analysis and Graphing* book for an example of an Ordered Differences report.
- **Detailed Comparisons** shows reports and graphs that compare each level of the effect with all other levels in a pairwise fashion. See the *Basic Analysis and Graphing* book for an example of a Detailed Comparison Report.
- **Equivalence Test** uses the TOST method to test for practical equivalence. See the *Basic Analysis and Graphing* book for details.
Test Slices

The Test Slices command, which is enabled for interaction effects, is a quick way to do many contrasts at the same time. For each level of each classification column in the interaction, it makes comparisons among all the levels of the other classification columns in the interaction. For example, if an interaction is A*B*C, then there is a slice called A=1, which tests all the B*C levels when A=1. There is another slice called A=2, and so on, for all the levels of B, and C. This is a way to detect the importance of levels inside an interaction.

Power Analysis


Summary of Row Diagnostics and Save Commands

When you have a continuous response model and click the red triangle next to the response name on the response name title bar, the menu in Figure 2.25 is displayed.

The specifics of the Fit Model platform depend on the type of analysis you do and the options and commands you ask for. Menu commands and options are available at each level of the analysis. You always have access to all tables and plots through these menu items. Also, the default arrangement of results can be changed by using preferences or script commands.

The next sections summarize commands in the Row Diagnostics and Save menus.

**Row Diagnostics**

Leverage Plots (the Plot Actual by Predicted and Plot Effect Leverage commands) are covered previously in this chapter under “Leverage Plots,” p. 36.

- **Plot Actual by Predicted** displays the observed values by the predicted values of $Y$. This is the leverage plot for the whole model.

- **Plot Effect Leverage** produces a leverage plot for each effect in the model showing the point-by-point composition of the test for that effect.

- **Plot Residual By Predicted** displays the residual values by the predicted values of $Y$. You typically want to see the residual values scattered randomly about zero.

- **Plot Residual By Row** displays the residual value by the row number of its observation.

- **Press** displays a Press statistic, which computes the residual sum of squares where the residual for each row is computed after dropping that row from the computations. The Press statistic is the total prediction error sum of squares and is given by

$$ Press_p = \sum_{i=1}^{n} \left( \hat{y}_{(i)p} - y_i \right)^2 $$

where $p$ is the number of variables in the model, $y_i$ is the observed response value of the $i^{th}$ observation, and $\hat{y}_{(i)p}$ is the predicted response value of the omitted observation.

The Press RMSE is defined as $\sqrt{Press/n}$.

The Press statistic is useful when comparing multiple models. Models with lower Press statistics are favored.

- **Durbin-Watson Test** displays the Durbin-Watson statistic to test whether the errors have first-order autocorrelation. The autocorrelation of the residuals is also shown. The Durbin-Watson table has a popup command that computes and displays the exact probability associated with the statistic. This Durbin-Watson table is appropriate only for time series data when you suspect that the errors are correlated across time.

**Note:** The computation of the Durbin-Watson exact probability can be time-intensive if there are many observations. The space and time needed for the computation increase with the square and the cube of the number of observations, respectively.
Save Columns Command

The Save submenu offers the following choices. Each selection generates one or more new columns in the current data table titled as shown, where colname is the name of the response variable:

**Prediction Formula** creates a new column, called Pred Formula colname, containing the predicted values computed by the specified model. It differs from the Predicted colname column, because it contains the prediction formula. This is useful for predicting values in new rows or for obtaining a picture of the fitted model.

Use the Column Info command and click the Edit Formula button to see the prediction formula. The prediction formula can require considerable space if the model is large. If you do not need the formula with the column of predicted values, use the Save Columns > Predicted Values option. For information about formulas, see the JMP User Guide.

**Note:** When using this command, an attempt is first made to find a Response Limits property containing desirability functions. The desirability functions are determined from the profiler, if that option has been used. Otherwise, the desirability functions are determined from the response columns. If you reset the desirabilities later, it affects only subsequent saves. (It does not affect columns that has already been saved.)

**Predicted Values** creates a new column called Predicted colname that contain the predicted values computed by the specified model.

**Residuals** creates a new column called Residual colname containing the residuals, which are the observed response values minus predicted values.

**Mean Confidence Interval** creates two new columns called Lower 95% Mean colname and Upper 95% Mean colname. The new columns contain the lower and upper 95% confidence limits for the line of fit.

**Note:** If you hold down the Shift key and select the option, you are prompted to enter an α-level for the computations.

**Indiv Confidence Interval** creates two new columns called Lower 95% Indiv colname and Upper 95% Indiv colname. The new columns contain lower and upper 95% confidence limits for individual response values.

**Note:** If you hold down the Shift key and select the option, you are prompted to enter an α-level for the computations.

**Studentized Residuals** creates a new column called Studentized Resid colname. The new column values are the residuals divided by their standard error.

**Hats** creates a new column called h colname. The new column values are the diagonal values of the matrix \(X(X'X)^{-1}X\), sometimes called hat values.

**Std Error of Predicted** creates a new column, called StdErr Pred colname, containing the standard errors of the predicted values.

**Std Error of Residual** creates a new column called, StdErr Resid colname, containing the standard errors of the residual values.

**Std Error of Individual** creates a new column, called StdErr Indiv colname, containing the standard errors of the individual predicted values.
Effect Leverage Pairs  creates a set of new columns that contain the values for each leverage plot. The new columns consist of an $X$ and $Y$ column for each effect in the model. The columns are named as follows. If the response column name is $R$ and the effects are $X_1$ and $X_2$, then the new column names are:

- $X$ Leverage of $X_1$ for $R$
- $Y$ Leverage of $X_1$ for $R$
- $X$ Leverage of $X_2$ for $R$
- $Y$ Leverage of $X_2$ for $R$.

Cook's D Influence  saves the Cook's $D$ influence statistic. Influential observations are those that, according to various criteria, appear to have a large influence on the parameter estimates.

StdErr Pred Formula  creates a new column, called $\text{PredSE colname}$, containing the standard error of the predicted values. It is the same as the Std Error of Predicted option but saves the formula with the column. Also, it can produce very large formulas.

Mean Confidence Limit Formula  creates a new column in the data table containing a formula for the mean confidence intervals.

Note:  If you hold down the Shift key and select the option, you are prompted to enter an $\alpha$-level for the computations.

Indiv Confidence Limit Formula  creates a new column in the data table containing a formula for the individual confidence intervals.

Note:  If you hold down the Shift key and select the option, you are prompted to enter an $\alpha$-level for the computations.

Save Coding Table  produces a new data table showing the intercept, all continuous terms, and coded values for nominal terms.

Note:  If you are using the Graph command to invoke the Profiler, then you should first save the columns Prediction Formula and StdErr Pred Formula to the data table. Then, place both of these formulas into the Y,Prediction Formula role in the Profiler launch window. The resulting window asks if you want to use the PredSE colname to make confidence intervals for the Pred Formula colname, instead of making a separate profiler plot for the PredSE colname.

Examples with Statistical Details

This section continues with the example at the beginning of the chapter that uses the Drug.jmp data table Snedecor and Cochran (1967, p. 422). The introduction shows a one-way analysis of variance on three drugs labeled a, d, and f, given to three groups randomly selected from 30 subjects.

Run the example again with response y and effect Drug. The next sections dig deeper into the analysis and also add another effect, x, that has a role to play in the model.
One-Way Analysis of Variance with Contrasts

In a one-way analysis of variance, a different mean is fit to each of the different sample (response) groups, as identified by a nominal variable. To specify the model for JMP, select a continuous \( Y \) and a nominal \( X \) variable such as Drug. In this example Drug has values a, d, and f. The standard least squares fitting method translates this specification into a linear model as follows: The nominal variables define a sequence of dummy variables, which have only values 1, 0, and –1. The linear model is written

\[
y_i = \beta_0 + \beta_1 x_{1i} + \beta_2 x_{2i} + \varepsilon_i
\]

where

- \( y_i \) is the observed response in the \( i^{th} \) trial
- \( x_{1i} \) is the level of the first predictor variable in the \( i^{th} \) trial
- \( x_{2i} \) is the level of the second predictor variable in the \( i^{th} \) trial
- \( \beta_0, \beta_1, \) and \( \beta_2 \) are parameters for the intercept, the first predictor variable, and the second predictor variable, respectively, and
- \( \varepsilon_i \) are the independent and normally distributed error terms in the \( i^{th} \) trial

As shown here, the first dummy variable denotes that Drug=a contributes a value 1 and Drug=f contributes a value –1 to the dummy variable.

\[
\begin{align*}
1 & \quad a \\
0 & \quad d \\
-1 & \quad f
\end{align*}
\]

The second dummy variable is given values

\[
x_{2i} = \begin{bmatrix}
0 & a \\
1 & d \\
-1 & f
\end{bmatrix}
\]

The last level does not need a dummy variable because in this model its level is found by subtracting all the other parameters. Therefore, the coefficients sum to zero across all the levels.

The estimates of the means for the three levels in terms of this parameterization are:

\[
\begin{align*}
\mu_1 &= \beta_0 + \beta_1 \\
\mu_2 &= \beta_0 + \beta_2 \\
\mu_3 &= \beta_0 - \beta_1 - \beta_2
\end{align*}
\]

Solving for \( \beta_1 \) yields

\[
\beta_0 = \frac{(\mu_1 + \mu_2 + \mu_3)}{3} = \mu \quad \text{(the average over levels)}
\]

\[
\beta_1 = \mu_1 - \mu
\]
Chapter 2
Standard Least Squares: Introduction
Examples with Statistical Details

Thus, if regressor variables are coded as indicators for each level minus the indicator for the last level, then
the parameter for a level is interpreted as the difference between that level’s response and the average
response across all levels. See “Nominal Factors,” p. 627 in the “Statistical Details” chapter for additional
information about the interpretation of the parameters for nominal factors.

Figure 2.26 shows the Parameter Estimates and the Effect Tests reports from the one-way analysis of the
drug data. Figure 2.4, at the beginning of the chapter, shows the Least Squares Means report and LS Means
Plot for the Drug effect.

Figure 2.26 Parameter Estimates and Effect Tests for Drug.jmp

<table>
<thead>
<tr>
<th>Term</th>
<th>Estimate</th>
<th>StdError</th>
<th>t Ratio</th>
<th>Prob&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercep</td>
<td>7.9</td>
<td>1.109088</td>
<td>7.12</td>
<td>0.001*</td>
</tr>
<tr>
<td>Drug[a]</td>
<td>-2.6</td>
<td>1.567494</td>
<td>-1.66</td>
<td>0.1988</td>
</tr>
<tr>
<td>Drug[d]</td>
<td>-1.9</td>
<td>1.567494</td>
<td>-1.15</td>
<td>0.2809</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Source</th>
<th>Sum of Squares</th>
<th>Df</th>
<th>F Ratio</th>
<th>Prob &gt; F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drug</td>
<td>263.600000</td>
<td>2</td>
<td>3.9821</td>
<td>0.0395*</td>
</tr>
</tbody>
</table>

The Drug effect can be studied in more detail by using a contrast of the least squares means. To do this, click
the red triangle next to the Drug effect title and select LSMeans Contrast to obtain the Contrast
specification window.

Click the + boxes for drugs a and d, and the - box for drug f to define the contrast that compares drugs a
and d to f (shown in Figure 2.27). Then click Done to obtain the Contrast report. The report shows that
the Drug effect looks more significant using this one-degree-of-freedom comparison test; The LSMean for
drug f is clearly significantly different from the average of the LSMeans of the other two drugs.
Analysis of Covariance

An analysis of variance model with an added regressor term is called an analysis of covariance. Suppose that the data are the same as above, but with one additional term, $x_3$, in the formula as a new regressor. Both $x_1$ and $x_2$ continue to be dummy variables that index over the three levels of the nominal effect. The model is written

$$y_i = \beta_0 + \beta_1 x_{1i} + \beta_2 x_{2i} + \beta_3 x_{3i} + \epsilon_i$$

Now there is an intercept plus two effects, one a nominal main effect using two parameters, and the other an interval covariate regressor using one parameter.

Rerun the Snedecor and Cochran Drug.jmp example, but add the $x$ to the model effects as a covariate. Compared with the main effects model (Drug effect only), the $R^2$ increases from 22.8% to 67.6%, and the standard error of the residual reduces from 6.07 to 4.0. As shown in Figure 2.28, the $F$-test significance probability for the whole model decreases from 0.03 to less than 0.0001.
Sometimes you can investigate the functional contribution of a covariate. For example, some transformation of the covariate might fit better. If you happen to have data where there are exact duplicate observations for the regressor effects, it is possible to partition the total error into two components. One component estimates error from the data where all the $x$ values are the same. The other estimates error that can contain effects for unspecified functional forms of covariates, or interactions of nominal effects. This is the basis for a lack of fit test. If the lack of fit error is significant, then the fit model platform warns that there is some effect in your data not explained by your model. Note that there is no significant lack of fit error in this example, as seen by the large probability value of 0.7507.
The covariate, $x$, has a substitution effect with respect to Drug. It accounts for much of the variation in the response previously accounted for by the Drug variable. Thus, even though the model is fit with much less error, the Drug effect is no longer significant. The effect previously observed in the main effects model now appears explainable to some extent in terms of the values of the covariate.

The least squares means are now different from the ordinary mean because they are adjusted for the effect of $x$, the covariate, on the response, $y$. Now the least squares means are the predicted values that you expect for each of the three values of Drug, given that the covariate, $x$, is held at some constant value. The constant value is chosen for convenience to be the mean of the covariate, which is 10.7333.

So, the prediction equation gives the least squares means as follows:

**fit equation:**  
$$-2.696 - 1.185 \times \text{Drug} - 1.0761 \times \text{Drug} + 0.98718 \times x$$  
**for a:**  
$$-2.696 - 1.185 \times (1) - 1.0761 \times (0) + 0.98718 \times (10.7333) = 6.71$$  
**for d:**  
$$-2.696 - 1.185 \times (0) - 1.0761 \times (1) + 0.98718 \times (10.7333) = 6.82$$  
**for f:**  
$$-2.696 - 1.185 \times (-1) - 1.0761 \times (-1) + 0.98718 \times (10.7333) = 10.16$$

Figure 2.29 shows a leverage plot for each effect. Because the covariate is significant, the leverage values for Drug are dispersed somewhat from their least squares means.

---

**Analysis of Covariance with Separate Slopes**

This example is a continuation of the Drug.jmp example presented in the previous section. The example uses data from Snedecor and Cochran (1967, p. 422). A one-way analysis of variance for a variable called Drug, shows a difference in the mean response among the levels a, d, and f, with a significance probability of 0.03.

The lack of fit test for the model with main effect Drug and covariate $x$ is not significant. However, for the sake of illustration, this example includes the main effects and the Drug$x$ effect. This model tests whether the regression on the covariate has separate slopes for different Drug levels.
This specification adds two columns to the linear model (call them $x_{4i}$ and $x_{5i}$) that allow the slopes for the covariate to be different for each Drug level. The new variables are formed by multiplying the dummy variables for Drug by the covariate values giving

$$y_i = \beta_0 + \beta_1 x_{1i} + \beta_2 x_{2i} + \beta_3 x_{3i} + \beta_4 x_{4i} + \beta_5 x_{5i} + \epsilon_i$$

Table 2.2 “Coding of Analysis of Covariance with Separate Slopes,” p. 55, shows the coding of this Analysis of Covariance with Separate Slopes. **Note:** The mean of $X$ is 10.7333.

### Table 2.2 Coding of Analysis of Covariance with Separate Slopes

<table>
<thead>
<tr>
<th>Regressor</th>
<th>Effect</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>$X_1$</td>
<td>Drug[a]</td>
<td>$+1$ if a, $0$ if d, $-1$ if f</td>
</tr>
<tr>
<td>$X_2$</td>
<td>Drug[d]</td>
<td>$0$ if a, $+1$ if d, $-1$ if f</td>
</tr>
<tr>
<td>$X_3$</td>
<td>$X$</td>
<td>the values of $X$</td>
</tr>
<tr>
<td>$X_4$</td>
<td>Drug[a]*(X - 10.733)</td>
<td>$+X - 10.7333$ if a, $0$ if d, $-(X - 10.7333)$ if f</td>
</tr>
<tr>
<td>$X_5$</td>
<td>Drug[d]*(X - 10.733)</td>
<td>$0$ if a, $+X - 10.7333$ if d, $-(X - 10.7333)$ if f</td>
</tr>
</tbody>
</table>

A portion of the report is shown in Figure 2.30. The Regression Plot shows fitted lines with different slopes. The Effect Tests report gives a p-value for the interaction of 0.56. This is not significant, indicating the model does not need to have different slopes.

**Figure 2.30** Plot with Interaction
Singularity Details

When there are linear dependencies between model effects, the Singularity Details report appears.

Figure 2.31  Singularity Report
Though the fitting platform always produces a report on the parameter estimates and tests on the effects, there are many options available to make these more interpretable. The following sections address these questions:

- How do I interpret estimates for nominal factors? How can I get the missing level coefficients?
- How can I measure the size of an effect in a scale-invariant fashion?
- If I have a screening design with many effects but few observations, how can I decide which effects are sizable and active?
- How can I get a series of tests of effects that are independent tests whose sums of squares add up to the total, even though the design is not balanced?
- How can I test some specific combination?
- How can I predict (backwards) which x value led to a given y value?
- How likely is an effect to be significant if I collect more data, have a different effect size, or have a different error variance?
- How strongly are estimates correlated?
Contents

Estimates and Effect Screening Menus ................................................................. 59
Show Prediction Expression .................................................................................. 59
Sorted Estimates ................................................................................................. 60
Expanded Estimates and the Coding of Nominal Terms ...................................... 61
Scaled Estimates and the Coding Of Continuous Terms ..................................... 62
Indicator Parameterization Estimates .................................................................. 63
Sequential Tests .................................................................................................. 63
Custom Test ......................................................................................................... 64
Joint Factor Tests ................................................................................................ 65
Inverse Prediction ............................................................................................... 66
Cox Mixtures ....................................................................................................... 70
Parameter Power .................................................................................................. 71
  The Power Analysis Dialog .............................................................................. 72
  Effect Size ......................................................................................................... 74
Text Reports for Power Analysis ......................................................................... 75
Plot of Power by Sample Size ........................................................................... 75
The Least Significant Value (LSV) ...................................................................... 76
The Least Significant Number (LSN) ................................................................... 76
The Power ........................................................................................................... 77
The Adjusted Power and Confidence Intervals ................................................... 77
Prospective Power Analysis ............................................................................... 77
Correlation of Estimates ...................................................................................... 79
Effect Screening .................................................................................................. 80
  Lenth's Method ................................................................................................. 80
Parameter Estimates Population ......................................................................... 80
Normal Plot ......................................................................................................... 83
Half-Normal Plot ................................................................................................. 84
Bayes Plot .......................................................................................................... 84
Bayes Plot for Factor Activity ............................................................................ 85
Pareto Plot .......................................................................................................... 86
Estimates and Effect Screening Menus

Most parts of the Model Fit results are optional. When you click the popup icon next to the response name at the topmost outline level, the menu shown in Figure 3.1 lists commands for the continuous response model.

Figure 3.1 Commands for a Least Squares Analysis: the Estimates and Effect Screening Menus

The specifics of the Fit Model platform depend on the type of analysis you do and the options and commands you ask for. The popup icons list commands and options at each level of the analysis. You always have access to all tables and plots through menu items. Also, the default arrangement of results can be changed by using preferences or script commands.

The focus of this chapter is on items in the Estimates and Effect Screening menus, which includes inverse prediction and a discussion of parameter power.

Show Prediction Expression

The Show Prediction Expression command places the prediction expression in the report. Figure 3.2 shows the equation for the Drug.jmp data table with Drug and x as predictors.

Figure 3.2 Prediction Expression
Sorted Estimates

The sorted Estimates command produces a different version of the Parameter Estimates report that is more useful in screening situations. This version of the report is especially useful if the design is saturated, when typical reports are less informative.

Example of a Sorted Estimates Report

1. Open the Drug.jmp sample data table.
2. Select Analyze > Fit Model.
3. Select y and click Y.
4. Add Drug and x as the effects.
5. Click Run.
6. From the red triangle menu next to Response y, select Estimates > Sorted Estimates.

Figure 3.3 Sorted Parameter Estimates

<table>
<thead>
<tr>
<th>Term</th>
<th>Estimate</th>
<th>Std Error</th>
<th>t Ratio</th>
<th>Prob&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>0.6716883</td>
<td>0.1844588</td>
<td>3.60</td>
<td>&lt;.0001*</td>
</tr>
<tr>
<td>Drug[1]</td>
<td>-1.185029</td>
<td>1.906522</td>
<td>-1.12</td>
<td>0.2742</td>
</tr>
<tr>
<td>Drug[2]</td>
<td>-1.873685</td>
<td>1.841350</td>
<td>-1.63</td>
<td>0.1069</td>
</tr>
</tbody>
</table>

This report is shown automatically if all the factors are two-level. It is also shown if the emphasis is screening and all the effects have only one parameter. In that case, the Scaled Estimates report is not shown.

Note the following differences between this report and the Parameter Estimates report:

- This report does not show the intercept.
- The effects are sorted by the absolute value of the t-ratio, showing the most significant effects at the top.
- A bar graph shows the t-ratio, with a line showing the 0.05 significance level.
- If JMP cannot obtain standard errors for the estimates, relative standard errors are used and notated.
- If there are no degrees of freedom for residual error, JMP constructs t-ratios and p-values using Lenth’s Pseudo-Standard Error. These quantities are labeled with Pseudo in their name. A note explains the change and shows the PSE. To calculate p-values, JMP uses a DFE of m/3, where m is the number of parameter estimates excluding the intercept.
- If the parameter estimates have different standard errors, then the PSE is defined using the t-ratio rather than a common standard error.
Expanded Estimates and the Coding of Nominal Terms

Expanded Estimates is useful when there are categorical (nominal) terms in the model and you want a full set of effect coefficients.

When you have nominal terms in your model, the platform needs to construct a set of dummy columns to represent the levels in the classification. Full details are shown in the appendix “Statistical Details,” p. 621. For \( n \) levels, there are \( n - 1 \) dummy columns. Each dummy variable is a zero-or-one indicator for a particular level, except for the last level, which is coded –1 for all dummy variables. For example, if column \( A \) has levels \( A_1, A_2, A_3 \), then the dummy columns for \( A_1 \) and \( A_2 \) are as shown here.

\[
\begin{array}{c|cc}
A & A_1 \text{ dummy} & A_2 \text{ dummy} \\
A_1 & 1 & 0 \\
A_2 & 0 & 1 \\
A_3 & -1 & -1 \\
\end{array}
\]

These columns are not displayed. They are just for conceptualizing how the fitting is done. The parameter estimates are the coefficients fit to these columns. In this case, there are two of them, labeled \( A[A_1] \) and \( A[A_2] \).

This coding causes the parameter estimates to be interpreted as how much the response for each level differs from the average across all levels. Suppose, however, that you want the coefficient for the last level, \( A[A_3] \). The coefficient for the last level is the negative of the sum across the other levels, because the sum across all levels is constrained to be zero. Although many other codings are possible, this coding has proven to be practical and interpretable.

However, you probably don’t want to do hand calculations to get the estimate for the last level. The Expanded Estimates command in the Estimates menu calculates these missing estimates and shows them in a text report. You can verify that the mean (or sum) of the estimates across a classification is zero.

Keep in mind that the Expanded Estimates option with high-degree interactions of two-level factors produces a lengthy report. For example, a five-way interaction of two-level factors produces only one parameter but has \( 2^5 = 32 \) expanded coefficients, which are all the same except for sign changes.

To recreate the reports in Figure 3.4, follow the steps in “Example of a Sorted Estimates Report,” p. 60, except instead of selecting Sorted Estimates, select Expanded Estimates.
Scaled Estimates and the Coding Of Continuous Terms

The parameter estimates are highly dependent on the scale of the factor. If you convert a factor from grams to kilograms, the parameter estimates change by a multiple of a thousand. If the same change is applied to a squared (quadratic) term, the scale changes by a multiple of a million. If you are interested in the effect size, then you should examine the estimates in a more scale-invariant fashion. This means converting from an arbitrary scale to a meaningful one so that the sizes of the estimates relate to the size of the effect on the response. There are many approaches to doing this. In JMP, the **Scaled Estimates** command on the **Effect Screening** menu gives coefficients corresponding to factors that are scaled to have a mean of zero and a range of two. If the factor is symmetrically distributed in the data then the scaled factor will have a range from –1 to 1. This corresponds to the scaling used in the design of experiments (DOE) tradition. Thus, for a simple regressor, the scaled estimate is half the predicted response change as the regression factor travels its whole range.

Scaled estimates are important in assessing effect sizes for experimental data in which the uncoded values are used. If you use coded values (–1 to 1), then the scaled estimates are no different than the regular estimates.

Also, you do not need scaled estimates if your factors have the Coding column property. In that case, they are converted to uncoded form when the model is estimated and the results are already in an interpretable form for effect sizes.

To recreate the report in Figure 3.5, follow the steps in “Example of a Sorted Estimates Report,” p. 60, except instead of selecting **Estimates > Expanded Estimates**, select **Effect Screening > Scaled Estimates**.

As noted in the report, the estimates are parameter centered by the mean and scaled by range/2.
Scaled estimates also take care of the issues for polynomial (crossed continuous) models even if they are not centered by the parameterized Center Polynomials default launch option.

**Indicator Parameterization Estimates**

This command displays the estimates using the Indicator Variable parameterization. To recreate the report in Figure 3.6, follow the steps in “Example of a Sorted Estimates Report,” p. 60, except instead of selecting Expanded Estimates, select Indicator Parameterization Estimates.

This parameterization is inspired by the PROC GLM parameterization. Some models will match, but others, such as no-intercept models, models with missing cells, and mixture models, will most likely show differences.

**Sequential Tests**

Sequential Tests shows the reduction in residual sum of squares as each effect is entered into the fit. The sequential tests are also called Type I sums of squares (Type I SS). A desirable property of the Type I SS is that they are independent and sum to the regression SS. An undesirable property is that they depend on the order of terms in the model. Each effect is adjusted only for the preceding effects in the model.

The following models are considered appropriate for the Type I hypotheses:

- balanced analysis of variance models specified in proper sequence (that is, interactions do not precede main effects in the effects list, and so forth)
Custom Test

If you want to test a custom hypothesis, select **Custom Test** from the **Estimates** popup menu. Click on **Add Column**. This displays the dialog shown to the left in Figure 3.7 for constructing the test in terms of all the parameters. After filling in the test, click **Done**. The dialog then changes to a report of the results, as shown on the right in Figure 3.7.

The space beneath the **Custom Test** title bar is an editable area for entering a test name. Use the Custom Test dialog as follows:

- **Parameter** lists the names of the model parameters. To the right of the list of parameters are columns of zeros corresponding to these parameters. Click a cell here, and enter a new value corresponding to the test you want.
- **Add Column** adds a column of zeros so that you can test jointly several linear functions of the parameters. Use the **Add Column** button to add as many columns to the test as you want.

The last line in the Parameter list is labeled =. Enter a constant into this box to test the linear constraint against. For example, to test the hypothesis $\beta_0=1$, enter a 1 in the = box. In Figure 3.7, the constant is equal to zero.

When you finish specifying the test, click **Done** to see the test performed. The results are appended to the bottom of the dialog.

When the custom test is done, the report lists the test name, the function value of the parameters tested, the standard error, and other statistics for each test column in the dialog. A joint $F$-test for all columns shows at the bottom.

Warning: The test is always done with respect to residual error. If you have random effects in your model, this test may not be appropriate if you use EMS instead of REML.

**Note:** If you have a test within a classification effect, consider using the contrast dialog (which tests hypotheses about the least squares means) instead of a custom test.
Chapter 3  Standard Least Squares: Perspectives on the Estimates

Joint Factor Tests

This command appears when interaction effects are present. For each main effect in the model, JMP produces a joint test on all the parameters involving that main effect.

Example of a Joint Factor Tests Report

1. Open the Big Class.jmp sample data table.
2. Select Analyze > Fit Model.
3. Select weight and click Y.
4. Select age, sex, and height and click Macros > Factorial to degree.
5. Click Run.
6. From the red triangle next to Response weight, select Estimates > Joint Factor Tests.

Figure 3.8 Joint Factor Tests for Big Class model

<table>
<thead>
<tr>
<th>Term</th>
<th>DF</th>
<th>Sum of Squares</th>
<th>F Ratio</th>
<th>Prob &gt; F</th>
</tr>
</thead>
<tbody>
<tr>
<td>age</td>
<td>18</td>
<td>6,112,217.8</td>
<td>2.812</td>
<td>0.012*</td>
</tr>
<tr>
<td>sex</td>
<td>1</td>
<td>2,143,108.8</td>
<td>1.196</td>
<td>0.299</td>
</tr>
<tr>
<td>height</td>
<td>1</td>
<td>2,317,615.9</td>
<td>0.9232</td>
<td>0.3051</td>
</tr>
</tbody>
</table>

Figure 3.7 The Custom Test Dialog and Test Results for Age Variable

Joint Factor Tests

This command appears when interaction effects are present. For each main effect in the model, JMP produces a joint test on all the parameters involving that main effect.

Example of a Joint Factor Tests Report

1. Open the Big Class.jmp sample data table.
2. Select Analyze > Fit Model.
3. Select weight and click Y.
4. Select age, sex, and height and click Macros > Factorial to degree.
5. Click Run.
6. From the red triangle next to Response weight, select Estimates > Joint Factor Tests.

Figure 3.8 Joint Factor Tests for Big Class model

<table>
<thead>
<tr>
<th>Term</th>
<th>DF</th>
<th>Sum of Squares</th>
<th>F Ratio</th>
<th>Prob &gt; F</th>
</tr>
</thead>
<tbody>
<tr>
<td>age</td>
<td>18</td>
<td>6,112,217.8</td>
<td>2.812</td>
<td>0.012*</td>
</tr>
<tr>
<td>sex</td>
<td>1</td>
<td>2,143,108.8</td>
<td>1.196</td>
<td>0.299</td>
</tr>
<tr>
<td>height</td>
<td>1</td>
<td>2,317,615.9</td>
<td>0.9232</td>
<td>0.3051</td>
</tr>
</tbody>
</table>
Note that age has 15 degrees of freedom because it is testing the five parameters for age, the five parameters for age*sex, and the five parameters for height*age, all tested to be zero.

**Inverse Prediction**

To find the value of \( x \) for a given \( y \) requires *inverse prediction*, sometimes called *calibration*. The **Inverse Prediction** command on the **Estimates** menu displays a dialog (Figure 3.10) that lets you ask for a specific value of one independent (\( X \)) variable, given a specific value of a dependent variable and other \( x \) values. The inverse prediction computation includes confidence limits (fiducial limits) on the prediction.

**Example of Inverse Prediction**

1. Open the Fitness.jmp sample data table.
2. Select **Analyze > Fit Y by X**.
4. Select Runtime and click X, Factor.
   - When there is only a single \( X \), as in this example, the Fit Y by X platform can give you a visual approximation of the inverse prediction values.
5. Click OK.
6. From the red triangle menu, select **Fit Line**.
   - Use the crosshair tool to approximate inverse prediction.
7. Select **Tools > Crosshairs**.
8. Position the crosshair tool with its horizontal line crossing the Oxy axis at about 50, and its intersection with the vertical line positioned on the prediction line.

**Figure 3.9  Bivariate Fit for Fitness.jmp**
This shows which value of Runtime gives an Oxy value of 50, intersecting the Runtime axis at about 9.779, which is an approximate inverse prediction. However, to see the exact prediction of Runtime, use the Fit Model dialog, as follows:

1. From the Fitness.jmp sample data table, select Analyze > Fit Model.
2. Select Oxy and click Y.
3. Add Runtime as the single model effect.
4. Click Run.
5. From the red triangle menu next to Response Oxy, select Estimates > Inverse Prediction.

6. Type the values for Oxy, as shown in Figure 3.10.
7. Click OK.

The dialog disappears and the Inverse Prediction table in Figure 3.11 gives the exact predictions for each Oxy value specified, with upper and lower 95% confidence limits. The exact prediction for Runtime when Oxy is 50 is 9.7935, which is close to the approximate prediction of 9.75 found using the Fit Y by X platform.
**Figure 3.11** Inverse Prediction Given by the Fit Model Platform

<table>
<thead>
<tr>
<th>Specified</th>
<th>Predicted</th>
<th>Lower 95%</th>
<th>Upper 95%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oxy</td>
<td>Runtime</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40.000000</td>
<td>12.81418</td>
<td>12.32145</td>
<td>13.3074</td>
</tr>
<tr>
<td>45.000000</td>
<td>11.30377</td>
<td>10.69939</td>
<td>11.89837</td>
</tr>
<tr>
<td>50.000000</td>
<td>9.78345</td>
<td>9.39003</td>
<td>10.17680</td>
</tr>
<tr>
<td>55.000000</td>
<td>8.26313</td>
<td>7.55787</td>
<td>8.93704</td>
</tr>
</tbody>
</table>

**Note:** The fiducial confidence limits are formed by Fieller’s method. Sometimes this method results in a degenerate (outside) interval, or an infinite interval, for one or both sides of an interval. When this happens for both sides, Wald intervals are used. If it happens for only one side, the Fieller method is still used and a missing value is returned. See the appendix “Statistical Details,” p. 621, for information about computing the confidence limits.

The inverse prediction command also predicts a single \( x \) value when there are multiple effects in the model. To predict a single \( x \), you supply one or more \( y \) values of interest and set the \( x \) value you want to predict to be missing. By default, the other \( x \) values are set to the regressor’s means but can be changed to any desirable value.

**Example Predicting a Single X Value with Multiple Model Effects**

1. From the Fitness.jmp sample data table, select Analyze > Fit Model.
2. Select Oxy and click Y.
3. Add Runtime, RunPulse, and RstPulse as effects.
4. Click Run.
5. From the red triangle menu next to Response Oxy, select Estimates > Inverse Prediction.
6. Type the values for Oxy, as shown in Figure 3.12.
7. Delete the value for Runtime, since that is the value you want to predict.
8. Click OK.

**Figure 3.13** Inverse Prediction for a Multiple Regression Model
Cox Mixtures

**Note:** This option is available only for mixture models.

In mixture designs, the model parameters cannot easily be used to judge the effects of the mixture components. The Cox Mixture model (a reparameterized and constrained version of the Scheffe model) produces parameter estimates from which inference can be made about factor effects and the response surface shape, relative to a reference point in the design space. See Cornell (1990) for a complete discussion.

**Example of Cox Mixtures**
1. Open the *Five Factor Mixture.jmp* sample data table.
2. Select **Analyze > Fit Model**.
3. Select **Y1** and click **Y**.
4. Select **X1**, **X2**, and **X3**. Click on **Macros > Mixture Response Surface**.
5. Click **Run**.
6. From the red triangle menu next to Response Y1, select **Estimates > Cox Mixtures**.

**Figure 3.14** Cox Mixtures Dialog

Specify the reference mixture points. Note that if the components of the reference point do not sum to one, then the values are scaled so that they do sum to one.

7. Replace the existing values as shown in Figure 3.14, and click **OK**.
Parameter Power

Suppose that you want to know how likely your experiment is to detect some difference at a given \( \alpha \)-level. The probability of getting a significant test result is termed the power. The power is a function of the unknown parameter values tested, the sample size, and the unknown residual error variance.

Or, suppose that you already did an experiment and the effect was not significant. If you think that it might have been significant if you had more data, then you would like to get a good guess of how much more data you need.

JMP offers the following calculations of statistical power and other details relating to a given hypothesis test.

- **LSV**, the least significant value, is the value of some parameter or function of parameters that would produce a certain \( p \)-value alpha.
- **LSN**, the least significant number, is the number of observations that would produce a specified \( p \)-value alpha if the data has the same structure and estimates as the current sample.
- **Power** is the probability of getting at or below a given \( p \)-value alpha for a given test.

The LSV, LSN, and power values are important measuring sticks that should be available for all test statistics. They are especially important when the test statistics do not show significance. If a result is not significant, the experimenter should at least know how far from significant the result is in the space of the estimate (rather than in the probability) and know how much additional data is needed to confirm significance for a given value of the parameters.

Sometimes a novice confuses the role of the null hypotheses, thinking that failure to reject the null hypothesis is equivalent to proving it. For this reason, it is recommended that the test be presented in these other aspects (power and LSN) that show how sensitive the test is. If an analysis shows no significant difference, it is useful to know the smallest difference the test is likely to detect (LSV).

The power details provided by JMP can be used for both prospective and retrospective power analyses. A prospective analysis is useful in the planning stages of a study to determine how large your sample size must

---

**Figure 3.15** Cox Mixtures

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Estimate</th>
<th>Std Error</th>
<th>t Value</th>
<th>Prob</th>
<th>t</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>1.25000</td>
<td>1.919923</td>
<td>0.652</td>
<td>0.5182</td>
<td>X1</td>
<td>0.220000</td>
</tr>
<tr>
<td>X1</td>
<td>0.05000</td>
<td>2.057694</td>
<td>0.227</td>
<td>0.8210</td>
<td>X1</td>
<td>0.440000</td>
</tr>
<tr>
<td>X2</td>
<td>1.25000</td>
<td>1.80914</td>
<td>1.059</td>
<td>0.2771</td>
<td>X2</td>
<td>0.440000</td>
</tr>
<tr>
<td>X3</td>
<td>-4.25000</td>
<td>4.159338</td>
<td>-1.022</td>
<td>0.3183</td>
<td>X3</td>
<td>0.240000</td>
</tr>
<tr>
<td>X1*X2</td>
<td>0.08662</td>
<td>4.215583</td>
<td>0.196</td>
<td>0.8450</td>
<td>X1</td>
<td>0.220000</td>
</tr>
<tr>
<td>X1*X3</td>
<td>3.89249</td>
<td>2.842654</td>
<td>0.842</td>
<td>0.4027</td>
<td>X1</td>
<td>0.220000</td>
</tr>
<tr>
<td>X2*X3</td>
<td>5.13190</td>
<td>5.121420</td>
<td>1.014</td>
<td>0.3140</td>
<td>X2</td>
<td>0.440000</td>
</tr>
<tr>
<td>X1<em>X1</em>X2</td>
<td>-1.76705</td>
<td>6.243061</td>
<td>0.283</td>
<td>0.7780</td>
<td>X1</td>
<td>0.220000</td>
</tr>
<tr>
<td>X1<em>X1</em>X3</td>
<td>1.00474</td>
<td>7.289708</td>
<td>0.142</td>
<td>0.8976</td>
<td>X1</td>
<td>0.220000</td>
</tr>
<tr>
<td>X2<em>X2</em>X3</td>
<td>-6.41642</td>
<td>8.439419</td>
<td>-0.889</td>
<td>0.3215</td>
<td>X2</td>
<td>0.440000</td>
</tr>
</tbody>
</table>

The parameter estimates are added to the report window, along with standard errors, hypothesis tests, and the reference mixture.
Standard Least Squares: Perspectives on the Estimates

Chapter 3

Parameter Power

be in order to obtain a desired power in tests of hypothesis. See the section “Prospective Power Analysis,” p. 77, for more information and a complete example. A retrospective analysis is useful during the data analysis stage to determine the power of hypothesis tests already conducted.

Technical details for power, LSN, and LSV are covered in the section “Power Calculations,” p. 654 in the appendix “Statistical Details” chapter.

Calculating retrospective power at the actual sample size and estimated effect size is somewhat non-informative, even controversial [Hoenig and Heisey, 2001]. Certainly, it doesn’t give additional information to the significance test, but rather shows the test in just a different perspective. However we believe that many studies fail due to insufficient sample size to detect a meaningful effect size, and there should be some facility to help guide for the next study, for specified effect sizes and sample sizes.


Power commands are available only for continuous-response models. Power and other test details are available in the following contexts:

- If you want the 0.05 level details for all parameter estimates, use the Parameter Power command in the Estimates menu. This produces the LSV, LSN, and adjusted power for an alpha of 0.05 for each parameter in the linear model.
- If you want the details for an F-test for a certain effect, find the Power Analysis command in the popup menu beneath the effect details for that effect.
- If you want the details for a Contrast, create the contrast from the popup menu next to the effect’s title and select Power Analysis in the popup menu next to the contrast.
- If you want the details for a custom test, first create the test you want with the Custom Test command from the platform popup menu and then select Power Analysis command in the popup menu next to the Custom Test.

In all cases except the first, a Power Analysis dialog lets you enter information for the calculations you want.

The Power Analysis Dialog

The Power Analysis dialog (Figure 3.16) displays the contexts and options for test detailing. You fill in the values as described next, and then click Done. The results are appended at the end of the report. To create the dialog shown in Figure 3.16, select Power Analysis on the age red triangle menu.

Example of Power Analysis

1. Open the Big Class.jmp sample data table.
2. Select Analyze > Fit Model.
3. Select weight and click Y.
4. Add age, sex, and height as the effects.
5. Click Run.
6. From the red triangle next to age, select Power Analysis.
7. Replace the delta values with 3, 6, and 1 as shown in Figure 3.16.
   For details about these columns, see “Power Details Columns,” p. 73.
8. Replace the Number values with 20, 60, and 10 as shown in Figure 3.16.
9. Select Solve for Power and Solve for Least Significant Number.
10. Click Done.
   For details about the output window, see “Text Reports for Power Analysis,” p. 75.

**Power Details Columns**

For each of four columns Alpha, Sigma, Delta, and Number, you can fill in a single value, two values, or the start, stop, and increment for a sequence of values, as shown in the dialog in Figure 3.16. Power calculations are done on all possible combinations of the values you specify.

- **Alpha (α)** is the significance level, between 0 and 1, usually 0.05, 0.01, or 0.10. Initially, Alpha automatically has a value of 0.05. Click on one of the three positions to enter or edit one, two, or a sequence of values.

- **Sigma (σ)** is the standard error of the residual error in the model. Initially, RMSE, the square root of the mean square error, is supplied here. Click on one of the three positions to enter or edit one, two, or a sequence of values.

- **Delta (δ)** is the raw effect size. See “Effect Size,” p. 74, for details. The first position is initially set to the square root of the sum of squares for the hypothesis divided by \( n \). Click on one of the three positions to enter or edit one, two, or a sequence of values.

- **Number (n)** is the sample size. Initially, the actual sample size is in the first position. Click on one of the three positions to enter or edit one, two, or a sequence of values.

Click the following check boxes to request the results you want:

- **Solve for Power** Check to solve for the power (the probability of a significant result) as a function of \( \alpha, \sigma, \delta, \) and \( n \).
**Solve for Least Significant Number**  Check to solve for the number of observations expected to be needed to achieve significance alpha given $\alpha$, $\sigma$, and $\delta$.

**Solve for Least Significant Value**  Check to solve for the value of the parameter or linear test that produces a $p$-value of alpha. This is a function of $\alpha$, $\sigma$, and $n$. This feature is available only for one-degree-of-freedom tests and is used for individual parameters.

**Adjusted Power and Confidence Interval**  To look at power retrospectively, you use estimates of the standard error and the test parameters. Adjusted power is the power calculated from a more unbiased estimate of the noncentrality parameter. The confidence interval for the adjusted power is based on the confidence interval for the noncentrality estimate. Adjusted power and confidence limits are computed only for the original $\delta$, because that is where the random variation is.

### Effect Size

The power is the probability that an $F$ achieves its $\alpha$-critical value given a noncentrality parameter related to the hypothesis. The noncentrality parameter is zero when the null hypothesis is true—that is, when the effect size is zero. The noncentrality parameter $\lambda$ can be factored into the three components that you specify in the JMP Power dialog as

$$\lambda = \frac{(n\delta^2)}{\sigma^2}.$$  

Power increases with $\lambda$, which means that it increases with sample size $n$ and raw effect size $\delta$ and decreases with error variance $\sigma^2$. Some books (Cohen 1977) use standardized rather than raw Effect Size, $\Delta = \frac{\delta}{\sigma}$, which factors the noncentrality into two components $\lambda = n\Delta^2$.

Delta ($\delta$) is initially set to the value implied by the estimate given by the square root of $\text{SSH}/n$, where $\text{SSH}$ is the sum of squares for the hypothesis. If you use this estimate for delta, you might want to correct for bias by asking for the Adjusted Power.

In the special case for a balanced one-way layout with $k$ levels

$$\delta^2 = \frac{\sum (\alpha_i - \bar{\alpha})^2}{k}.$$  

Because JMP uses parameters of the form

$$\beta_i = \left(\alpha_i - \bar{\alpha}\right) \text{ with } \beta_k = -\sum_{m=1}^{k-1} \alpha_m$$  

the delta for a two-level balanced layout is

$$\delta^2 = \frac{\beta_1^2 + (-\beta_1)^2}{2} = \left|\beta_1\right|^2.$$
Text Reports for Power Analysis

The power analysis facility calculates power as a function of every combination of $\alpha$, $\sigma$, $\delta$, and $n$ values you specify in the Power Analysis Dialog.

- For every combination of $\alpha$, $\sigma$, and $\delta$ in the Power Analysis dialog, it calculates the least significant number.
- For every combination of $\alpha$, $\sigma$, and $n$ it calculates the least significant value.

For example, if you run the request shown in Figure 3.16, you get the tables shown in Figure 3.17.

If you check Adjusted Power and Confidence Interval in the Power Analysis dialog, the Power report includes the AdjPower, LowerCL, and UpperCL columns.

Plot of Power by Sample Size

The red triangle menu (shown in Figure 3.17) located at the bottom of the Power report gives you the command Power Plot, which plots the Power by N columns from the Power table. The plot on the right in Figure 3.18 shows the result when you plot the example table in Figure 3.17. This plot can be enhanced with horizontal and vertical grid lines on the major tick marks. Double-click on the axes and complete the dialog to change tick marks and add grid lines on an axis.
The Least Significant Value (LSV)

After a single-degree of freedom hypothesis test is performed, you often want to know how sensitive the test was. Said another way, you want to know how small an effect would be declared significant at some \( p \)-value \( \alpha \). The LSV provides a significance measuring stick on the scale of the parameter, rather than on a probability scale. It shows how sensitive the design and data are. It encourages proper statistical intuition concerning the null hypothesis by highlighting how small a value would be detected as significant by the data.

- The LSV is the value that the parameter must be greater than or equal to in absolute value to give the \( p \)-value of the significance test a value less than or equal to \( \alpha \).
- The LSV is the radius of the confidence interval for the parameter. A 1–\( \alpha \) confidence interval is derived by taking the parameter estimate plus or minus the LSV.
- The absolute value of the parameter or function of the parameters tested is equal to the LSV, if and only if the \( p \)-value for its significance test is exactly \( \alpha \).

Compare the absolute value of the parameter estimate to the LSV. If the absolute parameter estimate is bigger, it is significantly different from zero. If the LSV is bigger, the parameter is not significantly different from zero.

The Least Significant Number (LSN)

The LSN or least significant number is defined to be the number of observations needed to drive down the variance of the estimates enough to achieve a significant result with the given values of \( \alpha \), \( \sigma \), and \( \delta \) (the significance level, the standard deviation of the error, and the effect size, respectively). If you need more data points (a larger sample size) to achieve significance, the LSN helps tell you how many more.

**Note:** LSN is not a recommendation of how large a sample to take because the probability of significance (power) is only about 0.5 at the LSN.
The LSN has these characteristics:

- If the LSN is less than the actual sample size \( n \), then the effect is significant. This means that you have more data than you need to detect the significance at the given alpha level.
- If the LSN is greater than \( n \), the effect is not significant. In this case, if you believe that more data will show the same standard errors and structural results as the current sample, the LSN suggests how much data you would need to achieve significance.
- If the LSN is equal to \( n \), then the \( p \)-value is equal to the significance level alpha. The test is on the border of significance.
- Power (described next) calculated when \( n = \text{LSN} \) is always greater than or equal to 0.5.

**The Power**

The power is the probability of getting a significant result. It is a function of the sample size \( n \), the effect size \( \delta \), the standard deviation of the error \( \sigma \), and the significance level \( \alpha \). The power tells you how likely your experiment is to detect a difference at a given \( \alpha \)-level. Power has the following characteristics:

- If the true value of the parameter is the hypothesized value, the power should be alpha, the size of the test. You do not want to reject the hypothesis when it is true.
- If the true value of the parameters is not the hypothesized value, you want the power to be as great as possible.
- The power increases with the sample size. The power increases as the error variance decreases. The power increases as the true parameter gets farther from the hypothesized value.

**The Adjusted Power and Confidence Intervals**

Because power is a function of population quantities that are not known, it is usual practice to substitute sample estimates in power calculations (Wright and O’Brien 1988). If you regard these sample estimates as random, you can adjust them to have a more proper expectation. You can also construct a confidence interval for this adjusted power. However, the confidence interval is often very wide. The adjusted power and confidence intervals can be computed only for the original \( \delta \) because that is where the random variation is. For details about adjusted power see “Computations for Adjusted Power,” p. 656 in the appendix “Statistical Details” chapter.

**Prospective Power Analysis**

Prospective analysis helps you answer the question, “Will I detect the group differences I am looking for given my proposed sample size, estimate of within-group variance, and alpha level?” In a prospective power analysis, you must provide estimates of the group means and sample sizes in a data table and an estimate of the within-group standard deviation \( \sigma \) in the Power Analysis dialog.
The **Sample Size and Power** command found on the **DOE** menu offers a facility that computes power, sample size, or the effect size you want to detect, for a given alpha and error standard deviation. You supply two of these values and the Sample Size and Power feature computes the third. If you supply only one of these values, the result is a plot of the other two. This feature assumes equal sample sizes. For unequal sample sizes, you can do as shown in the following example.

This example is from Wright and O’Brien (1988). Dr. Noah Decay, a dentist, is planning an experiment in which he wishes to compare two treatments that are believed to reduce dental plaque. Dr. Decay believes that the means for the control group and two treatments are 32, 26, and 24, respectively, and that the within-group standard deviation is between 6 and 9. The control group has twice as many patients as each treatment group.

To run a prospective power analysis on the test for the group effect, Dr. Decay must first create the data table shown here, with three columns **Group**, **Mean**, and **N**, that contain the group names, group means, and proposed group sizes. This example uses the **Noah Decay.jmp** data table.

Dr. Decay uses the *Fit Model* platform to set up a one-way analysis of variance (as shown here). Note that the sample size variable, N, is declared as **Freq**. Also, the **Minimal Reports** emphasis option is selected.

![Figure 3.19 Fit Model Dialog with Noah Decay.jmp variables](image)

The analysis yields zero for the sum of squares error and mean square error. However, Dr. Decay suspects that the standard deviation is between 6 and 9. He now chooses **Power Analysis** from the **grp** report popup menu beneath Effect Details and checks **Solve for Power** and **Solve for Least Significant Number**. Then, the Power Analysis dialog as shown to the left in Figure 3.20 gives calculations for all combinations of alpha = 0.05, sample sizes of 40 to 60, and standard deviations (sigma) of 6 to 9 by 1.
The **Delta** shown was calculated from the specified mean values. A prospective power analysis uses population values, which give an unbiased noncentrality parameter value, so adjusted power and confidence limits are not relevant.

**Figure 3.20** Power Details and Power by N Plot for Prospective Analysis

**Correlation of Estimates**

The **Correlation of Estimates** option on the **Estimates** menu produces a correlation matrix for all effects in a model. The example shown here uses the *Tiretread.jmp* data table with ABRASION as the response, two factors SILICA and SILANE, and their interaction.

**Figure 3.21** Correlation of Estimates Report
Effect Screening

The Effect Screening commands help examine the sizes of the effects. The Scaled Estimates command was covered earlier under “Scaled Estimates and the Coding Of Continuous Terms,” p. 62, which dealt with scaling issues. The other Effect Screening commands are discussed here. These commands correct for scaling and for correlations among the estimates. The features of these Effect Screening commands are derived by noticing three things:

1. The process of fitting can be thought of as converting one set of realizations of random values (the response values) into another set of realizations of random values (the parameter estimates). If the design is balanced with an equal number of levels per factor, these estimates are independent and identically distributed, just as the responses are. If there are as many parameters as data points, they even have the same variance as the responses.

2. If you are fitting a screening design with many effects and only a few runs, you expect that only a few effects are active. That is, a few effects have sizable impact and the rest of them are inactive (they are estimating zeroes). This is called the assumption of effect sparsity.

3. Given points 1 and 2 above, you can think of screening as a way to determine which effects are inactive with random values around zero and which ones are outliers, not part of the distribution of inactive effects.

Thus, you treat the estimates themselves as a set of data to help you judge which effects are active and which are inactive. If there are few runs, with little or no degrees of freedom for error, then there are no classical significance tests, and this approach is especially needed.

The last three Effect Screening commands look at parameters in this way. There are two default reports, Lenth’s PSE and the Parameter Estimates Population table with significant factors highlighted. The Effect Screening command also has a submenu for looking at the model parameters from different angles using scaled estimates and three plots.

Lenth’s Method

An estimate of standard error is calculated using the method of Lenth (1989) and shows in the Effect Screening table (shown above). This estimate, called the pseudo standard error, is formed by taking 1.5 times the median absolute value of the estimates after removing all the estimates greater than 3.75 times the median absolute estimate in the complete set of estimates.

Parameter Estimates Population

Most inferences about effect size first assume that the estimates are uncorrelated and have equal variances. This is true for fractional factorials and many classical experimental designs. However, for some designs it is not true. The last three Effect Screening commands display the Parameter Estimate Population report, which first finds the correlation of the estimates and tells you whether or not the estimates are uncorrelated and have equal variances.
If the estimates are correlated, a normalizing transformation can be applied to make them uncorrelated and have equal variances. If there is an estimate of error variance, the transformed estimates have variances of near 1 and are the same as the $t$-ratios. If an estimate of error variance is unavailable, the transformed estimates have the same variance as the error.

If the estimates are uncorrelated and have equal variances, then the following notes appear and the analysis is straightforward.
- The parameter estimates have equal variances
- The parameter estimates are not correlated

If the estimates are correlated and/or have unequal variances, then each of these two notes may change into a popup menu showing that it has transformed the estimates, and giving you the option to undo the transformation.

If you click these popup menus and undo both transformations, the lines look like this:

The transformation to make the estimates uncorrelated is the same as that used to calculate sequential sums of squares. The estimates measure the additional contribution of the variable after all previous variables have been entered into the model. An example of a data set with unequal variances and correlated estimates is Tiretread.jmp. Using Tiretread.jmp with ABRASION as $Y$ and using the four factors HARDNESS, SILICA, SILANE, and SULFUR, with all two-factor interactions included in the model gives the following Parameter Estimate Population table when selecting Effect Screening > Normal Plot from the red-triangle menu of the response.
An example of a data set with equal variances and uncorrelated estimates is Reactor.jmp. The analysis for Reactor.jmp data uses four factors, Ct, A, T, and Cn, with all two-factor interactions included in the model.

The Parameter Estimate Population table for Reactor.jmp is shown below.

The Parameter Estimate Population tables shown above contain some of the following columns, which are dependent upon whether or not the estimates have equal variances and whether or not the estimates are correlated:

- **Estimate** lists the parameter estimates for the fitted linear model. These estimates can be compared in size only if the X variables are scaled the same.
- **t Ratio** is the t test associated with this parameter.
Orthog Coded contains the orthogonalized estimates. They are used in the Pareto plot because this plot partitions the sum of the effects, which requires orthogonality. The orthogonalized values are computed by premultiplying the column vector of the Original estimates by the Cholesky root of $X'X$. These estimates depend on the model order unless the original design is orthogonal.

If the design was orthogonal and balanced, then these estimates will be identical to the original estimates. If they are not, then each effect’s contribution is measured after it is made orthogonal to the effects before it.

Orthog t-Ratio lists the parameter estimates after a transformation that makes them independent and identically distributed. These values are used in the Normal Plot (discussed next), which requires uncorrelated estimates of equal variance. The $p$-values associated with Orthog t-ratio estimates (given in the $\text{Prob}>|t|$ column) are equivalent to Type I sequential tests. This means that if the parameters of the model are correlated, the estimates and their $p$-values depend on the order of terms in the model. The Orthog t-ratio estimates are computed by dividing the orthogonalized estimates (Standardized Estimate) by their standard errors. The Orthog t-ratio values let JMP treat the estimates as if they were from a random sample for use in Normal plots or Bayes plots.

Standardized Estimate, initially hidden, shows the parameter estimates with centered and scaled factor values.

Prob>|t| is the significance level or $p$-value associated with the values in the Orthog t-Ratio column.

Normal Plot

The Normal Plot command displays the Parameter Estimates Population table (discussed in the previous section) and shows a normal plot of these parameter estimates (Daniel 1959). The estimates are on the vertical axis and the normal quantiles on the horizontal axis. The normal plot for $Y$ in the Reactor.jmp screening model is shown in Figure 3.26. If all effects are due to random noise, they tend to follow a straight line with slope $\sigma$, the standard error. The line with slope equal to the Lenth's PSE estimate is shown in blue.

The Normal plot helps you pick out effects that deviate from the normal lines. Estimates that deviate substantially are labeled. In this example, the $A$ factor does not appear important. But not only are the other three factors ($T$, $Ct$, and $Cn$) active, $T$ (temperature) appears to interact with both $Ct$ and $Cn$.

Figure 3.26 Normal Plot for the Reactor Data with Two-Factor Interactions
Half-Normal Plot

At the top of the Normal plot is a popup menu. Click this and select Half Normal Plot to obtain a plot of the absolute values of the estimates against the normal quantiles for the absolute value normal distribution, as shown in Figure 3.27. Some analysts prefer this to the Normal Plot.

Bayes Plot

Another approach to resolving which effects are important (sometimes referred to as which contrasts are active) is to compute posterior probabilities using a Bayesian approach. This method, due to Box and Meyer (1986), assumes that the estimates are a mixture from two distributions. Some portion of the effects is assumed to come from pure random noise with a small variance. The remaining terms are assumed to come from a contaminating distribution that has a variance $K$ times larger than the error variance.

The prior probability for an effect is the chance you give that effect of being nonzero, (or being in the contaminating distribution). These priors are usually set to equal values for each effect, and 0.2 is a commonly recommended prior probability value. The $K$ contamination coefficient is often set at 10, which says the contaminating distribution has a variance that is 10 times the error variance.

The Bayes plot is done with respect to normalized estimates (JMP lists as Orthog $t$-Ratio), which have been transformed to be uncorrelated and have equal variance. To see a Box-Meyer Bayesian analysis for the Reactor.jmp example, specify $Y$ as $Y$, and ADD F, Ct, A, T, and Cn with all two-factor interactions included in the model. After running the model, select Bayes Plot from the Effect Screening menu. The dialog panel, shown to the left in Figure 3.28, asks you to fill in the prior probabilities and the $K$ coefficient. You can also edit the other values. It is not necessary to have a nonzero DFE. Click Go to start the calculation of the posterior probabilities.
The Std Err Scale field is set to 0 for a saturated model with no estimate of error. If there is an estimate of standard error (the root mean square error), this field is set to 1 because the estimates have already been transformed and scaled to unit variance. If you edit the field to specify a different value, it should be done as a scale factor of the RMSE estimate.

The resulting posterior probabilities are listed and plotted with bars as shown in Figure 3.28. The literature refers to this as the Bayes Plot. An overall posterior probability is also listed for the outcome that the sample is uncontaminated. This is formed from the posteriors for each sample $\beta_i$ by

$$P(\text{uncontam}) = \prod_{i=1}^{n} (1 - \beta_i(\sigma))$$

**Bayes Plot for Factor Activity**

JMP includes a script that allows you to determine which factors are active in the design. Found in the Sample Scripts folder, BayesPlotForFactors.jsl can be used to produce the Factor Activity plot. Open and run the script (Edit > Run Script) on the Reactor.jmp data, using Y as Y and F, Ct, A, T, and Cn as factors. This produces the following plot.
In this case, we have specified that the highest order interaction to consider is two. Therefore, all possible models that include (up to) second order interactions are constructed, and, based on the value assigned to Prior Probability (see the Controls section of the plot), a posterior probability is computed for each of the possible models. The probability for a factor is the sum of the probabilities for each of the models where it was involved.

In this example, we see that \(C_t\), \(T\), and \(C_n\) are active and that \(A\) and \(F\) are not. This agrees with Figure 3.28.

**Note:** If the ridge parameter were zero (not allowed), all the models would be fit by least-squares. As the ridge parameter gets large the parameter estimates for any model shrink towards zero. Details on the ridge parameter (and why it cannot be zero) are explained in Box and Meyer (1993).

**Pareto Plot**

The **Pareto Plot** selection gives plots of the absolute values of the orthogonalized estimates showing their composition relative to the sum of the absolute values. The estimates are orthogonalized to be uncorrelated and standardized to have equal variances by default. If your data set has estimates that are correlated and/or have unequal variances, then your data is transformed, by default, to have equal variances and to be uncorrelated. However, you have the option of undoing the transformations. (See “**Parameter Estimates Population**,” p. 80.) In this case, the Pareto Plot represents your selection of equal variances/unequal variances and uncorrelated/correlated estimates.

Figure 3.30 shows a Pareto Plot for the sample data **Reactor.jmp**. For this data set, the estimates have equal variances and are not correlated.
Figure 3.30 Pareto Plot for Reactor.jmp
Chapter 3
Effect Screening
Chapter 4

Standard Least Squares: Exploring the Prediction Equation
The Fit Model Platform

Assuming that the prediction equation is estimated well, there is still work in exploring the equation itself to answer a number of questions:

• What kind of curvature does the response surface have?
• What are the predicted values at the corners of the factor space?
• Would a transformation on the response produce a better fit?

The tools described in this chapter explore the prediction equation to answer these questions in the context of assuming that the equation is correct enough to work with.
Contents

Exploring the Prediction Equation ......................................................... 91
The Profiler .......................................................................................... 91
Contour Profiler .................................................................................. 92
Mixture Profiler .................................................................................... 93
Surface Profiler ................................................................................... 94
Interaction Plots .................................................................................. 95
Cube Plots ............................................................................................ 96
Response Surface Curvature ................................................................. 97
  Parameter Estimates ............................................................................. 99
  Canonical Curvature Table ................................................................. 99
Box Cox Y Transformations ................................................................. 100
Exploring the Prediction Equation

Figure 4.1 (Reactor.jmp) illustrates the relevant commands available for the least squares fitting personality.

**Figure 4.1 Commands and Options for a Least Squares Analysis**

Here is a quick description of each feature to help you decide which section you need.

**Profiler, Contour Profiler, Mixture Profiler, and Surface Profiler** display cuts through response surfaces for analyzing and optimizing a model. For complete details on using the Profilers, see the “Profiling” chapter.

**Interaction plots** are multiple profile plots across one factor under different settings of another factor. The traces are not parallel when there is a sizable interaction.

**Cube Plots** show predicted values in the corners of the factor space.

**Box Cox Y Transformation** finds a power transformation of the response that fits best.

**The Profiler**

The Profiler displays prediction traces (see Figure 4.2) for each $X$ variable. The vertical dotted line for each $X$ variable shows its current value or current setting.

If the variable is nominal, the $x$-axis identifies categories.

For each $X$ variable, the value above the factor name is its current value. You change the current value by clicking in the graph or by dragging the dotted line where you want the new current value to be.

- The horizontal dotted line shows the current predicted value of each $Y$ variable for the current values of the $X$ variables.
- The black lines within the plots show how the predicted value changes when you change the current value of an individual $X$ variable. The 95% confidence interval for the predicted values is shown by a dotted curve surrounding the prediction trace (for continuous variables) or an error bar (for categorical variables).

The Prediction Profiler is a way of changing one variable at a time and looking at the effect on the predicted response.
Contour Profiler

The Contour Profiler option in the Factor Profiling submenu brings up an interactive contour profiling facility. This is useful for optimizing response surfaces graphically. To use the Contour Profiler:

1. Select Fit Model for Tiretread.jmp.
2. Specify ABRASION, MODULUS, ELONG, and HARDNESS as Y.
3. Select SILICA, SILANE, and SULFUR for X and select Response Surface from the Macros drop-down menu.
4. Click Run.
5. Select Profilers > Contour Profiler from the red-triangle menu of the Least Squares Fit report. (See Figure 4.3.)
Figure 4.3 Contour Profiler for Response Surface Model

Details on the Contour profiler are found in the “Contour Profiler,” p. 557 in the “Profiling” chapter.

Mixture Profiler

The Mixture Profiler shows response contours of mixture experiment models on a ternary plot. This feature is useful when three or more factors in the experiment are components in a mixture. The Mixture Profiler allows you to visualize and optimize the response surfaces of your experiment.

Figure 4.4 shows an example of a mixture experiment from Plasticizer.jmp. To use the Mixture Profiler:

1. Select Analyze > Fit Model. (The response and predictor variables for the sample data, Plasticizer.jmp, should be automatically populated.)
2. For other data sets, select an appropriate response variable for Y.
3. Select appropriate $X$ variables and click Macros > Mixture Response Surface.
4. Click Run.
5. From the red-triangle menu of the response, select **Factor Profiling > Mixture Profiler**.

The radio buttons at the top left of the plot may be used to modify plot axes for the factors and the Lo and Hi Limit columns at the upper right of the plot allow you to enter constraints for both the factors and the response.

For a detailed explanation of the Mixture Profiler, see "Mixture Profiler," p. 560 in the “Profiling” chapter.

---

**Figure 4.4** Mixture Profiler for Mixture Response Surface

---

**Surface Profiler**

The Surface Profiler shows a three-dimensional surface plot of the response surface. Open the Odor.jmp data table. Run the attached Model script and click Run on the Fit Model Dialog. Select **Factor Profiling > Surface Profiler** to obtain Figure 4.5. Details of Surface Plots are found in the “Plotting Surfaces” chapter.
Interaction Plots

The Interaction Plots selection in the Factor Profiling submenu shows a matrix of interaction plots when there are interaction effects in the model. As an example, use the Reactor.jmp sample data with factors Ct, A, T, and Cn, and all two-factor interactions. You can then see the interaction effects with the Interaction Plots command.

In an interaction plot, evidence of interaction shows as nonparallel lines. For example, in the T*Cn plot in the bottom row of plots (Figure 4.6) the effect of Cn is very small at the low values of temperature, but it diverges widely for the high values of temperature. The interaction of Cn with T tends to mask the effect of Cn as a main effect.
Cube Plots

The Cube Plots option in the Factor Profiling submenu displays a set of predicted values for the extremes of the factor ranges, laid out on the vertices of cubes, as illustrated in Figure 4.7. If a factor is nominal, the vertices are the first and last level.

If you want to change the layout so that the factors are mapped to different cube coordinates, click one of the factor names in the first cube and drag it to the desired axis. For example, if you click T, as shown in Figure 4.7, and drag it over C, then T and C exchange places, along with their corresponding coordinates, as shown in Figure 4.8. If there is more than one response, the multiple responses are shown stacked at each vertex.
Often in industrial experiments, the goal is to find values for one or more factors that maximize or minimize the response. JMP provides surface modeling with special reports that show the critical values, the surface curvature, and a response contour plot.

The Response Surface selection in the Effect Macros popup menu automatically constructs all the linear, quadratic, and cross product terms needed for a response surface model.

The same model can be specified using the Add and Cross buttons to create model effects in the Fit Model dialog. You then select a model term and assign it the Response Surface effect attribute found in the Attributes popup menu. The response surface effects show with &RS after their name in the Construct Model Effects list, as shown in Figure 4.9.
Note: Curvature analysis is not shown for response surface designs of more than 20 factors in the Fit Model platform. No error message or alert is given. All other analyses contained within the report are valid and are shown. For additional information on response surface designs, see the Design of Experiments Guide Guide, Chapter 5, Response Surface Designs.

After the parameters are estimated, critical values for the factors in the estimated surface can be found. Critical points occur at either maximums, minimums, or saddle points in the surface. The eigenvalues and eigenvectors of the calculated quadratic parameters determine the type of curvature. The eigenvectors show the principal directions of the surface, including the directions of greatest and smallest curvature.

The following example uses the Odor Control Original.jmp file in the Sample Data folder. The example uses data discussed in John (1971). The objective is to find the range of temperature (temp), gas-liquid ratio (gl ratio), and height (ht) values that minimize the odor of a chemical production process. To run this response surface model, select the response variable, odor, from the variable selector list and click Y. Highlight the factors temp, gl ratio, and ht, and choose Response Surface from the Macros popup menu. Note that the main effects automatically appear in the Construct Model Effects list with &RS after their name (see Figure 4.9).

Figure 4.9 Fit Model Dialog For Response Surface Analysis
Chapter 4  Standard Least Squares: Exploring the Prediction Equation
Response Surface Curvature

Parameter Estimates

The Parameter Estimates table shows estimates of the model parameters.

The Parameter Estimates table shows estimates of the model parameters.

| Term       | Estimate | Std Error | t Ratio | Prob>|F |
|------------|----------|-----------|---------|-----|
| Intercept  | -30.66067| 12.97761  | -2.36   | 0.0645|
| temp       | -12.135  | 7.941353  | -1.53   | 0.1816|
| gl ratio   | -17      | 7.941353  | -2.14   | 0.0854|
| int*temp   | -21.375  | 7.941353  | -2.68   | 0.0433*|
| temp*gl    | 32.600333| 11.66019  | 2.74    | 0.0467*|
| temp/gl    | 8.26     | 11.22025  | 0.73    | 0.4959|
| gl ratio*gl| 47.820333| 11.66019  | 4.09    | 0.0005*|
| temp*int   | 1.5      | 11.22025  | 0.13    | 0.8624|
| gl ratio*nt| -1.75    | 11.22025  | -0.16   | 0.8624|
| int*nt     | 6.0003333| 11.66019  | 0.52    | 0.6052|

If you use the Prediction Formula command in the Save Columns submenu, a new data table column called Pred Formula odor saves the prediction formula using the coefficients from the Parameter Estimates table.

The probability value of 0.0657 in the Analysis of Variance table indicates that the three-variable response surface model is only marginally better than the sample mean.

<table>
<thead>
<tr>
<th>Source</th>
<th>DF</th>
<th>Sum of Squares</th>
<th>Mean Square</th>
<th>F Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>9</td>
<td>18.381 083</td>
<td>2.042 86</td>
<td>4.1521</td>
</tr>
<tr>
<td>Error</td>
<td>5</td>
<td>2.526 417</td>
<td>505.26</td>
<td>0.0000</td>
</tr>
<tr>
<td>C. Total</td>
<td>14</td>
<td>21.908 400</td>
<td>6.0967</td>
<td></td>
</tr>
</tbody>
</table>

The response surface analysis also displays the Response Surface table and the Solution table (Figure 4.10). The Solution table shows the critical values for the surface variables and indicates that the surface solution point is a minimum for this example.

Canonical Curvature Table

The Canonical Curvature report, found under the Response Surface title, shows the eigenstructure (Figure 4.10), which is useful for identifying the shape and orientation of the curvature, and results from the eigenvalue decomposition of the matrix of second-order parameter estimates. The eigenvalues (given in the first row of the Canonical Curvature table) are negative if the response surface shape curves back from a maximum. The eigenvalues are positive if the surface shape curves up from a minimum. If the eigenvalues are mixed, the surface is saddle shaped, curving up in one direction and down in another direction.

The eigenvectors listed beneath the eigenvalues show the orientations of the principal axes. In this example the eigenvalues are positive, which indicates that the curvature bends up from a minimum. The direction where the curvature is the greatest corresponds to the largest eigenvalue (48.8588) and the variable with the largest component of the associated eigenvector (gl ratio). The direction with the eigenvalue of 31.1035 is loaded more on temp, which has nearly as much curvature as that for gl ratio.
Sometimes a zero eigenvalue occurs. This means that along the direction described by the corresponding eigenvector, the fitted surface is flat.

**Figure 4.10** Basic Reports for Response Surface Model

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>temp</code></td>
<td>0.1219126</td>
</tr>
<tr>
<td><code>gratio</code></td>
<td>0.1996768</td>
</tr>
<tr>
<td><code>ht</code></td>
<td>1.7796233</td>
</tr>
</tbody>
</table>

Solution

<table>
<thead>
<tr>
<th>Critical Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>temp</code></td>
</tr>
<tr>
<td><code>gratio</code></td>
</tr>
<tr>
<td><code>ht</code></td>
</tr>
</tbody>
</table>

Solution is a Minimum

Predicted Value at Solution: 52.02463

**Canonical Curvature**

<table>
<thead>
<tr>
<th>Eigenvalues and Eigenvectors</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>temp</code></td>
</tr>
<tr>
<td><code>gratio</code></td>
</tr>
<tr>
<td><code>ht</code></td>
</tr>
</tbody>
</table>

Box Cox Y Transformations

Sometimes a transformation on the response fits the model better than the original response. A commonly used transformation raises the response to some power. Box and Cox (1964) formalized and described this family of power transformations. The **Factor Profiling** menu has the **Box Cox Y Transformation** command. The formula for the transformation is constructed so that it provides a continuous definition and the error sums of squares are comparable.

\[
y(\lambda) = \begin{cases} 
\frac{\lambda - 1}{\lambda} y \quad & \text{if } \lambda \neq 0 \\
\ln(y) \quad & \text{if } \lambda = 0
\end{cases}
\]

where \( \bar{y} \) is the geometric mean.
The plot shown here illustrates the effect of this family of power transformations on $Y$.

The **Box-Cox Y Transformation** command fits transformations from $\lambda = -2$ to 2 in increments of 0.2, and it plots the sum of squares error (SSE) across the $\lambda$ power. The plot below shows the best fit when $\lambda$ is between 1.0 and 1.5 for the Reactor.jmp data using the model with effects $F$, $Ct$, $A$, $T$, and $Cn$ and all two-factor interactions. The best transformation is found on the plot by finding the lowest point on the curve.

The Box-Cox Transformation red triangle menu has the following options:

- The **Save Best Transformation** command creates a new column in the data table and saves the formula for the best transformation.
- The **Save Specific Transformation** command behaves in the same way, but first prompts for a lambda value.
- The **Table of Estimates** command creates a new data table containing parameter estimates and SSE for all values of $\lambda$ from -2 to 2.
Random effects are those where the effect levels are chosen randomly from a larger population of levels. These random effects represent a sample from the larger population. In contrast, the levels of fixed effects are of direct interest rather than representative. If you have both random and fixed (nonrandom) effects in a model, it is called a mixed model.

**Important:** It is very important to declare random effects. Otherwise, the test statistics produced from the fitted model are calculated with the wrong assumptions.

Typical random effects are
- subjects in a repeated measures experiment, where the subject is measured at several times.
- plots in a split plot experiment, where an experimental unit is subdivided and multiple measurements are taken, usually with another treatment applied to the subunits.
- measurement studies, where multiple measurements are taken in order to study measurement variation.
- random coefficients models, where the random effect is built with a continuous term crossed with categories.

The Fit Model platform in JMP fits mixed models using modern methods now generally regarded as best practice:
- REML estimation method (REstricted Maximum Likelihood)
- Kenward-Roger tests

For historical interest only, the platform also offers the Method of Moments (EMS), but this is no longer a recommended method except in special cases where it is equivalent to REML.

If you have a model where all effects are random, you can also fit it in the Variability Chart platform.
Contents

Topics in Random Effects .................................................... 105
Introduction to Random Effects ............................................ 105
Generalizability ........................................................................ 106
The REML Method ................................................................... 106
Unrestricted Parameterization for Variance Components in JMP ................................. 107
Negative Variances .................................................................... 107
Random Effects BLUP Parameters ............................................ 108
REML and Traditional Methods Agree on the Standard Cases ........................................ 109
F-Tests in Mixed Models .......................................................... 109

Specifying Random Effects ..................................................... 110
Split Plot Example ..................................................................... 110
The Model Dialog ..................................................................... 111

REML Results ........................................................................... 112
REML Save Menu ....................................................................... 113

Method of Moments Results .................................................... 114
Topics in Random Effects

Introduction to Random Effects

Levels in random effects are randomly selected from a larger population of levels. For the purpose of testing hypotheses, the distribution of the effect on the response over the levels is assumed to be normal, with mean zero and some variance (called a variance component).

In one sense, every model has at least one random effect, which is the effect that makes up the residual error. The units making up individual observations are assumed to be randomly selected from a much larger population, and the effect sizes are assumed to have a mean of zero and some variance, $\sigma^2$.

The most common model that has random effects other than residual error is the repeated measures or split plot model. Table 5.1 “Types of Effects in a Split plot Model,” p. 105, lists the types of effects in a split plot model. In these models the experiment has two layers. Some effects are applied on the whole plots or subjects of the experiment. Then these plots are divided or the subjects are measured at different times and other effects are applied within those subunits. The effects describing the whole plots or subjects are one random effect, and the subplots or repeated measures are another random effect. Usually the subunit effect is omitted from the model and absorbed as residual error.

Table 5.1 Types of Effects in a Split plot Model

<table>
<thead>
<tr>
<th>Split Plot Model</th>
<th>Type of Effect</th>
<th>Repeated Measures Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>whole plot treatment</td>
<td>fixed effect</td>
<td>across subjects treatment</td>
</tr>
<tr>
<td>whole plot ID</td>
<td>random effect</td>
<td>subject ID</td>
</tr>
<tr>
<td>subplot treatment</td>
<td>fixed effect</td>
<td>within subject treatment</td>
</tr>
<tr>
<td>subplot ID</td>
<td>random effect</td>
<td>repeated measures ID</td>
</tr>
</tbody>
</table>

Each of these cases can be treated as a layered model, and there are several traditional ways to fit them in a fair way. The situation is treated as two different experiments:

1. The whole plot experiment has whole plot or subjects as the experimental unit to form its error term.
2. Subplot treatment has individual measurements for the experimental units to form its error term (left as residual error).

The older, traditional way to test whole plots is to do any one of the following:

• Take means across the measurements and fit these means to the whole plot effects.
• Form an $F$-ratio by dividing the whole plot mean squares by the whole plot ID mean squares.
• Organize the data so that the split or repeated measures form different columns and do a MANOVA model, and use the univariate statistics.

While these approaches work if the structure is simple and the data are complete and balanced, there is a more general model that works for any structure of random effects. This more generalized model is called the *mixed model*, because it has both fixed and random effects.
Another common situation that involves multiple random effects is in measurement systems where there are multiple measurements with different parts, different operators, different gauges, and different repetitions. In this situation, all the effects are regarded as random.

**Generalizability**

Random effects are randomly selected from a larger population, where the distribution of their effect on the response is assumed to be a realization of a normal distribution with a mean of zero and a variance that can be estimated.

Often, the exact effect sizes are not of direct interest. It is the fact that they represent the larger population that is of interest. What you learn about the mean and variance of the effect tells you something about the general population from which the effect levels were drawn. That is different from fixed effects, where you only know about the levels you actually encounter in the data.

**The REML Method**

The REML (REstricted or REsidual Maximum Likelihood) method for fitting mixed models is now the mainstream, state-of-the-art method, supplanting older methods.

In the days before availability of powerful computers, researchers needed to restrict their interest to situations in which there were computational short cuts to obtain estimates of variance components and tests on fixed effects in a mixed model. Most books today introduce mixed models using these short cuts that work on balanced data. See McCulloch, Searle, and Neuhaus (2008), Poduri (1997), and Searle, Casella, and McCulloch (1992). The Method of Moments provided a way to calculate what the expected value of Mean Squares (EMS) were in terms of the variance components, and then back-solve to obtain the variance components. It was also possible using these techniques to obtain expressions for test statistics that had the right expected value under the null hypotheses that were synthesized from mean squares.

If your model satisfies certain conditions (i.e., it has random effects that contain the terms of the fixed effects they provide random structure for) then you can use the EMS choice to produce these traditional analyses. However, since the newer REML method produces identical results to these models, but is considerably more general, the EMS method is never recommended.

The REML approach was pioneered by Patterson and Thompson in 1974. See also Wolfinger, Tobias, and Sall (1994) and Searle, Casella, and McCulloch (1992). The reason to prefer REML is that it works without depending on balanced data, or shortcut approximations, and it gets all the tests right, even contrasts that work across interactions. Most packages that use the traditional EMS method are either not able to test some of these contrasts, or compute incorrect variances for them.
Unrestricted Parameterization for Variance Components in JMP

**Note:** Read this section only if you are concerned about matching the results of certain textbooks.

There are two different statistical traditions for parameterizing the variance components: the unrestricted and the restricted approaches. JMP and SAS use the unrestricted approach. In this approach, while the estimated effects always sum to zero, the true effects are not assumed to sum to zero over a particular random selection made of the random levels. This is the same assumption as for residual error. The estimates make the residual errors have mean zero, and the true mean is zero. But a random draw of data using the true parameters will be some random event that might not have a mean of exactly zero.

You need to know about this assumption because many statistics textbooks use the restricted approach. Both approaches have been widely taught for 50 years. A good source that explains both sides is Cobb (1998, section 13.3).

Negative Variances

**Note:** Read this section only when you are concerned about negative variance components.

Though variances are always positive, it is possible to have a situation where the unbiased estimate of the variance is negative. This happens in experiments when an effect is very weak, and by chance the resulting data causes the estimate to be negative. This usually happens when there are few levels of a random effect that correspond to a variance component.

JMP can produce negative estimates for both REML and EMS. For REML, there are two checkboxes in the model launch window: *Unbounded Variance Components* and *Estimate Only Variance Components*. Unchecking the box beside *Unbounded Variance Components* constrains the estimate to be non-negative. We recommend that you do not uncheck this if you are interested in fixed effects. Constraining the variance estimates leads to bias in the tests for the fixed effects. If, however, you are only interested in variance components, and you do not want to see negative variance components, then checking the box beside *Estimate Only Variance Components* is appropriate.

If you remain uncomfortable about negative estimates of variances, please consider that the random effects model is statistically equivalent to the model where the variance components are really covariances across errors within a whole plot. It is not hard to think of situations in which the covariance estimate can be negative, either by random happenstance, or by a real process in which deviations in some observations in one direction would lead to deviations in the other direction in other observations. When random effects are modeled this way, the covariance structure is called *compound symmetry*.

So, consider negative variance estimates as useful information. If the negative value is small, it can be considered happenstance in the case of a small true variance. If the negative value is larger (the variance ratio can get as big as 0.5), it is a troubleshooting sign that the rows are not as independent as you had assumed, and some process worth investigating is happening within blocks.
Random Effects BLUP Parameters

Random effects have a dual character. In one perspective, they appear like residual error, often the error associated with a whole-plot experimental unit. In another respect, they are like fixed effects with a parameter to associate with each effect category level. As parameters, you have extra information about them—they are derived from a normal distribution with mean zero and the variance estimated by the variance component. The effect of this extra information is that the estimates of the parameters are shrunk towards zero. The parameter estimates associated with random effects are called BLUPs (Best Linear Unbiased Predictors). Some researchers consider these BLUPs as parameters of interest, and others consider them by-products of the method that are not interesting in themselves. In JMP, these estimates are available, but in an initially-closed report.

BLUP parameter estimates are used to estimate random-effect least squares means, which are therefore also shrunken towards the grand mean, at least compared to what they would be if the effect were treated as a fixed effect. The degree of shrinkage depends on the variance of the effect and the number of observations per level in the effect. With large variance estimates, there is little shrinkage. If the variance component is small, then more shrinkage takes place. If the variance component is zero, the effect levels are shrunk to exactly zero. It is even possible to obtain highly negative variance components where the shrinkage is reversed. You can consider fixed effects as a special case of random effects where the variance component is very large.

If the number of observations per level is large, the estimate will shrink less. If there are very few observations per level, the estimates will shrink more. If there are infinite observations, there is no shrinkage and the answers are the same as fixed effects.

The REML method balances the information on each individual level with the information on the variances across levels.

As an example, suppose that you have batting averages for different baseball players. The variance component for the batting performance across player describes how much variation is usual between players in their batting averages. If the player only plays a few times and if the batting average is unusually small or large, then you tend not to trust that estimate, because it is based on only a few at-bats; the estimate has a high standard error. But if you mixed it with the grand mean, that is, shrunk the estimate towards the grand mean, you would trust the estimate more. For players that have a long batting record, you would shrink much less than those with a short record.

You can run this example and see the results for yourself. The example batting average data are in the Baseball.jmp sample data file. To compare the Method of Moments (EMS) and REML, run the model twice. Assign Batting as Y and Player as an effect. Select Player in the Construct Model Effects box, and select Random Effect from the Attributes pop-up menu.

Run the model and select REML (Recommended) from the Method popup menu.

Run the model again with EMS (Traditional) as Method.

Table 5.2 “Comparison of Estimates Between Method of Moments and REML,” p. 109, summarizes the estimates between Method of Moments and REML across a set of baseball players in this simulated example. Note that Suarez, with only 3 at-bats, is shrunk more than the others with more at-bats.
REML and Traditional Methods Agree on the Standard Cases

It turns out that in balanced designs, the REML $F$-test values for fixed effects will be the same as with the Method of Moments (Expected Means Squares) approach. The degrees of freedom could differ in some cases. There are a number of methods of obtaining the degrees of freedom for REML $F$-tests; the one that JMP uses is the smallest degrees of freedom associated with a containing effect.

$F$-Tests in Mixed Models

**Note:** This section details the tests produced with REML.

The REML method obtains the variance components and parameter estimates, but there are a few additional steps to obtain tests on fixed effects in the model. The objective is to construct the $F$ statistic and associated degrees of freedom to obtain a $p$-value for the significance test.

Historically, in simple models using the Method of Moments (EMS), standard tests were derived by construction of quadratic forms that had the right expectation under the null hypothesis. Where a mean square had to be synthesized from a linear combination of mean squares to have the right expectation, Satterthwaite’s method could be used to obtain the degrees of freedom to get the $p$-value. Sometimes these were fractional degrees of freedom, just as you might find in a modern (Aspin-Welch) Student’s $t$-test.

With modern computing power and recent methods, we have much improved techniques to obtain the tests. First, Kackar and Harville (1984) found a way to estimate a bias-correction term for small samples. This was refined by Kenward and Roger (1997) to correct further and obtain the degrees of freedom that gave the closest match of an $F$-distribution to the distribution of the test statistic. These are not easy calculations, consequently they can take some time to perform for larger models.

If you have a simple balanced model, the results from REML-Kenward-Roger will agree with the results from the traditional approach, provided that the estimates aren’t bounded at zero.

---

Table 5.2 Comparison of Estimates Between Method of Moments and REML

<table>
<thead>
<tr>
<th></th>
<th>Method of Moments</th>
<th>REML</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variance Component</td>
<td>0.01765</td>
<td>0.019648</td>
<td></td>
</tr>
<tr>
<td>Anderson</td>
<td>0.295000000</td>
<td>0.29640407</td>
<td>6</td>
</tr>
<tr>
<td>Jones</td>
<td>0.20227273</td>
<td>0.20389793</td>
<td>11</td>
</tr>
<tr>
<td>Mitchell</td>
<td>0.32333333</td>
<td>0.32426295</td>
<td>6</td>
</tr>
<tr>
<td>Rodriguez</td>
<td>0.550000000</td>
<td>0.54713393</td>
<td>6</td>
</tr>
<tr>
<td>Smith</td>
<td>0.35681818</td>
<td>0.35702094</td>
<td>11</td>
</tr>
<tr>
<td>Suarez</td>
<td>0.550000000</td>
<td>0.54436227</td>
<td>3</td>
</tr>
<tr>
<td>Least Squares Means</td>
<td>same as ordinary means</td>
<td>shrunken from means</td>
<td></td>
</tr>
</tbody>
</table>
These results do not depend on analyzing the syntactic structure of the model. There are no rules about finding containing effects. The method doesn’t care if your whole plot fixed effects are purely nested in whole plot random effects—it will get the right answer regardless.

These results do not depend on having categorical factors. It handles continuous (random coefficient) models just as easily.

These methods will produce different (and better) results than older versions of JMP (that is, earlier than JMP 6) that implemented older, less precise, technology to do these tests.

These methods do not depend on having positive variance components. Negative variance components are not only supported, but need to be allowed in order for the tests to be unbiased.

Our goal in implementing these methods was not just to handle general cases, but to handle cases without the user needing to know very much about the details. Just declare which effects are random, and everything else is automatic. It is particularly important that engineers learn to declare random effects, because they have a history of performing inadvertent split-plot experiments where the structure is not identified.

### Specifying Random Effects

Models with Random Effects use the same Fit Model dialog as other models. To identify a random effect, highlight it in the model effects list and select Random Effect from the Attributes popup menu. This appends &Random to the effect name in the model effect list.

### Split Plot Example

The most common type of layered design is a balanced split plot, often in the form of repeated measures across time. One experimental unit for some of the effects is subdivided, (sometimes by time period) and other effects are applied to these subunits.

As an example, consider the Animals.jmp data found in the Sample Data folder (the data are fictional). Figure 5.1, shows a listing of the table. The study collected information about the difference in seasonal hunting habits of foxes and coyotes. Three foxes and three coyotes were marked and observed periodically (each season) for a year. The average number of miles (rounded to the nearest mile) they wandered from their dens during different seasons of the year was recorded. The model is defined by

- the continuous response variable called miles
- the species effect with values fox or coyote
- the season effect with values fall, winter, spring, and summer
- an animal identification code called subject, with nominal values 1, 2, and 3 for both foxes and coyotes.

There are two layers to the model.

1. The top layer is the between-subject layer, in which the effect of being a fox or coyote (species effect) is tested with respect to the variation from subject to subject. The bottom layer is the within-subject layer, in which the repeated-measures factor for the four seasons (season effect) is tested with respect to the variation from season to season within a subject. The within-subject variability is reflected in the residual error.
2. The \textit{season} effect can use the residual error for the denominator of its $F$-statistics. However, the between-subject variability is not measured by residual error and must be captured with the subject within species (\texttt{subject[species]}) effect in the model. The $F$-statistic for the between-subject effect \texttt{species} uses this nested effect instead of residual error for its $F$-ratio denominator.

The Model Dialog

The \textbf{Fit Model} command lets you construct model terms and identify error terms. To fit the nested model to the \textit{Animals.jmp} data with the correct $F$-statistics, specify the response column and add terms to the \textit{Construct Model Effects} list as follows to see the completed window in Figure 5.1.

1. Open the sample data \textit{Animals.jmp}.
2. Select \texttt{miles} from the column selector and click \texttt{Y}.
3. Select \texttt{species} from the column selector list and click \texttt{Add}.
4. Select \texttt{subject} from the column selector list and click \texttt{Add}.
5. Select \texttt{species} from the column selector list again.
6. Select \texttt{subject} in the \textit{Construct Model Effects} list.
7. Click \texttt{Nest} to add the subject within species (\texttt{subject[species]}) effect to the model.
8. Select the nested effect, \texttt{subject[species]}.
9. Select \texttt{Random Effect} from the \textit{Attributes} popup menu. (This nested effect is now identified as an error term for the \texttt{species} effect and shows as \texttt{subject[species]&Random}.)
10. Select \texttt{season} from the column selector list and click \texttt{Add}.

The completed dialog is shown Figure 5.1.
When you assign any effect as random from the Attributes popup menu, the Method options (REML and EMS) appear at the top-right of the dialog, with REML selected as the default.

**Menu Options for Random Effects when REML Method is Used**

When your model includes a Random Effect, Standard Least Squares, or Generalized Linear Model is selected as the Personality, and REML is selected as the Method in the launch window, a new menu called **Convergence Settings** becomes available in the red-triangle menu of the Model Specification title bar. This menu includes:

- **Maximum Iterations**
- **Convergence Limit**

Default values for the Maximum Iterations and Convergence Limit are 100 and .0000001, respectively. When you click on either of these options, you are able to enter new values for these limits. This can be important if you have a very large data set or a complicated model and want to limit the number of iterations, or if your model does not readily converge and you want to either increase the Maximum Iterations or increase the Convergence Limit.

**Note:** JMP only creates design columns for those combinations that actually occur in the data.

**REML Results**

A nice feature of REML is that the report doesn't need qualification (Figure 5.2). The estimates are all properly shrunk and the standard errors are properly scaled (SAS Institute Inc. 1996). The variance components are shown as a ratio to the error variance, and as a portion of the total variance.

There is no special table of synthetic test creation, because all the adjustments are automatically taken care of by the model itself. There is no table of expected means squares, because the method does not need this.

If you have random effects in the model, the analysis of variance report is not shown. This is because the variance does not partition in the usual way, nor do the degrees of freedom attribute in the usual way, for REML-based estimates. You can obtain the residual variance estimate from the REML report rather than from the analysis of variance report.
The Variance Component Estimates table shows 95% confidence intervals for the variance components using the Satterthwaite (1946) approximation. You can right-click on the Variance Components Estimates table to toggle on the Norm KHC (Kackar-Harville correction). This value is an approximation of the magnitude of the increase in the mean squared errors of the estimators for the mixed model. See Kackar and Harville (1984) for a discussion of approximating standard errors in mixed models.

**REML Save Menu**

When REML is used, the following commands appear in the Save submenu. All these commands allow the Random effects estimates to participate in the prediction, rather than using their expected value (zero).

- **Conditional Pred Formula** saves the prediction formula to a new column in the data table.
- **Conditional Pred Values** saves the predicted values to a new column in the data table.
- **Conditional Residuals** saves the model residuals to a new column in the data table.
- **Conditional Mean CI** saves the mean confidence interval.
- **Conditional Indiv CI** saves the confidence interval for an individual.
In addition to these options, a new profiler option becomes available

**Conditional Predictions** includes the random effects estimates in the predicted values and profiles.

---

**Method of Moments Results**

**Note:** This section is only of use in matching historical results.

We no longer recommend the Method of Moments, but we understand the need to support it for teaching use, in order to match the results of many textbooks still in use.

You have the option of choosing the **EMS (Traditional)** approach from the *Method* popup menu on the Fit Model dialog. This is also called the Method of Moments method.

Results from the steps for the Method of Moments are as follows:

- For each effect, the coefficients of the expected mean squares for that effect are calculated. This is a linear combination of the variance components and fixed effect values that describes the expected value of the mean square for that effect. All effects also have a unit coefficient on the residual variance.
- The coefficients of expected mean squares for all the random effects, including the residual error, are gathered into a matrix, and this is used to solve for variance components for each random effect.
- For each effect to be tested, a denominator for that effect is synthesized using the terms of the linear combination of mean squares in the numerator that don’t contain the effect to be tested or other fixed effects. Thus, the expectation is equal for those terms common to the numerator and denominator. The remaining terms in the numerator then constitute the effect test.
- Degrees of freedom for the synthesized denominator are constructed using Satterthwaite’s method.
- The effect tests use the synthetic denominator.

JMP handles random effects like the SAS GLM procedure with a **Random** statement and the **Test** option. Figure 5.3, shows example results.

**Warning:** Standard errors for least squares means and denominators for contrast *F*-tests also use the synthesized denominators. Contrasts using synthetic denominators might not be appropriate, especially in crossed effects compared at common levels. The leverage plots and custom tests are done with respect to the residual, so they might not be appropriate.

**Warning:** Crossed and nested relationships must be declared explicitly. For example, if knowing a subject ID also identifies the group that contains the subject, (that is, if each subject is in only one group), then subject must be declared as nested within group. In that situation, the nesting must be explicitly declared to define the design structure.

**Limitation:** JMP cannot fit a layered design if the effect for a layer’s error term cannot be specified under current effect syntax. An example of this is a design with a Latin Square on whole plots for which the error term would be **Row*Column–Treatment**. Fitting such special cases with JMP requires constructing your own *F*-tests using sequential sums of squares from several model runs.
For the Animals example above, the EMS reports are as follows.

**Figure 5.3 Report of Method of Moments Analysis for Animals Data**

### Summary of Fit
- **Response miles**
- **Source**: Zucker
- **DF**: 0
- **Mean Square**: 0.038417
- **Error**: 0.77274
- **Mean Square Error**: 1.219062
- **Model**: 4.458333
- **Residual**: 4.458333
- **Total**: 4.458333
- **DF for Sum Squares**: 24

### Analysis of Variance

<table>
<thead>
<tr>
<th>Source</th>
<th>DF</th>
<th>Sum of Squares</th>
<th>Mean Square</th>
<th>F Ratio</th>
<th>Prob &gt; F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>0</td>
<td>115.68607</td>
<td>14.4583</td>
<td>14.50</td>
<td>0.0001*</td>
</tr>
<tr>
<td>Error</td>
<td>15</td>
<td>22.29167</td>
<td>1.4861</td>
<td>1.48</td>
<td>0.012*</td>
</tr>
<tr>
<td>C. Total</td>
<td>23</td>
<td>137.95833</td>
<td>6.0001</td>
<td>6.00</td>
<td>0.0001*</td>
</tr>
</tbody>
</table>

### Parameter Estimates

<table>
<thead>
<tr>
<th>Term</th>
<th>Estimate</th>
<th>Std Error</th>
<th>t Ratio</th>
<th>Prob &gt;</th>
<th>t Prob &gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>4.458333</td>
<td>0.24884</td>
<td>17.02</td>
<td>&lt;0.0001*</td>
<td></td>
</tr>
<tr>
<td>species(COYOTE)</td>
<td>1.496033</td>
<td>0.24094</td>
<td>6.26</td>
<td>&lt;0.0001*</td>
<td></td>
</tr>
<tr>
<td>season[fall]</td>
<td>-0.625</td>
<td>0.431093</td>
<td>-1.45</td>
<td>0.1576</td>
<td></td>
</tr>
<tr>
<td>season[spring]</td>
<td>1.706333</td>
<td>0.431093</td>
<td>3.98</td>
<td>0.0012*</td>
<td></td>
</tr>
<tr>
<td>season[summer]</td>
<td>0.875</td>
<td>0.431093</td>
<td>2.03</td>
<td>0.0805</td>
<td></td>
</tr>
<tr>
<td>species(COYOTE)</td>
<td>-0.966087</td>
<td>0.49758</td>
<td>-1.94</td>
<td>0.0603</td>
<td></td>
</tr>
<tr>
<td>species[FOS]</td>
<td></td>
<td>0.49758</td>
<td>0.50</td>
<td>0.0227</td>
<td></td>
</tr>
</tbody>
</table>

### Expected Mean Squares

The Mean Square per row by the Variance Component per column

### Variance Component Estimates

<table>
<thead>
<tr>
<th>Component</th>
<th>Var</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>subject(species)</td>
<td>0.702160</td>
<td>32.263</td>
</tr>
<tr>
<td>species</td>
<td>1.480111</td>
<td>87.937</td>
</tr>
<tr>
<td>Total</td>
<td>2.1875</td>
<td>100.000</td>
</tr>
</tbody>
</table>

These estimates based on equaling Mean Squares to Expected Value

### Test Denominator Synthesis

<table>
<thead>
<tr>
<th>Source</th>
<th>MS Den</th>
<th>DF Den</th>
<th>Denom MS Synthesis</th>
</tr>
</thead>
<tbody>
<tr>
<td>species</td>
<td>4.28167</td>
<td>4</td>
<td>4.28167</td>
</tr>
<tr>
<td>subject(species)</td>
<td>1.48011</td>
<td>16</td>
<td>Residual</td>
</tr>
<tr>
<td>season</td>
<td>1.48011</td>
<td>16</td>
<td>Residual</td>
</tr>
</tbody>
</table>

### Tests wrt Random Effects

<table>
<thead>
<tr>
<th>Source</th>
<th>SS</th>
<th>MS Num</th>
<th>DF Num</th>
<th>F Ratio</th>
<th>Prob &gt; F</th>
</tr>
</thead>
<tbody>
<tr>
<td>subject(species)</td>
<td>51.0417</td>
<td>51.0417</td>
<td>1</td>
<td>11.8522</td>
<td>0.0041*</td>
</tr>
<tr>
<td>season</td>
<td>17.1667</td>
<td>4.28167</td>
<td>4</td>
<td>2.8978</td>
<td>0.0588</td>
</tr>
<tr>
<td>season</td>
<td>47.4583</td>
<td>15.8194</td>
<td>3</td>
<td>19.6449</td>
<td>0.0005*</td>
</tr>
</tbody>
</table>
The random submatrix from the EMS table is inverted and multiplied into the mean squares to obtain variance component estimates. These estimates are usually (but not necessarily) positive. The variance component estimate for the residual is the Mean Square Error.

Note that the CV of the variance components is initially hidden in the Variance Components Estimates report. To reveal it, right-click (Control-click on the Macintosh) and select **Columns > CV** from the menu that appears.
In JMP, stepwise regression is a personality of the Model Fitting platform; it is one of the selections in the Fitting Personality popup menu on the Fit Model dialog.

Stepwise regression is an approach to selecting a subset of effects for a regression model. It is used when there is little theory to guide the selection of terms for a model and the modeler, in desperation, wants to use whatever seems to provide a good fit.

The approach is somewhat controversial. The significance levels on the statistics for selected models violate the standard statistical assumptions because the model has been selected rather than tested within a fixed model. On the positive side, the approach has been of practical use for 30 years in helping to trim out models to predict many kinds of responses. The book *Subset Selection in Regression*, by A. J. Miller (1990), brings statistical sense to model selection statistics.

This chapter uses the term “significance probability” in a mechanical way to represent that the calculation would be valid in a fixed model, recognizing that the true significance probability could be nowhere near the reported one.

The Stepwise Fit also includes features for looking at all possible models and model averaging.
## Contents

Introduction to Stepwise Regression ................................................. 119
A Multiple Regression Example .................................................. 119
  Stepwise Regression Control Panel ........................................... 120
  Current Estimates Table ....................................................... 120
  Step History Table ............................................................. 123
  Forward Selection Example .................................................... 123
  Backwards Selection Example .................................................. 124
Models with Crossed, Interaction, or Polynomial Terms ....................... 125
Rules for Including Related Terms ............................................... 126
Models with Nominal and Ordinal Terms ........................................ 127
Make Model Command for Hierarchical Terms .................................. 128
Logistic Stepwise Regression ........................................................ 129
All Possible Models ..................................................................... 130
Model Averaging .......................................................................... 131
Validation ..................................................................................... 133
Introduction to Stepwise Regression

In JMP, stepwise regression is a *personality* of the Model Fitting platform—it is one of the selections in the Fitting Personality popup menu on the Fit Model dialog (see Figure 6.1). The *Stepwise* feature computes estimates that are the same as those of other least squares platforms, but it facilitates searching and selecting among many models.

A Multiple Regression Example

As an example, consider the Fitness.jmp (SAS Institute Inc. 1987) data table in the Sample Data folder, which is the result of an aerobic fitness study.

Aerobic fitness can be evaluated using a special test that measures the oxygen uptake of a person running on a treadmill for a prescribed distance. However, it would be more economical to find a formula that uses simpler measurements that evaluate fitness and predict oxygen uptake. To identify such an equation, measurements of age, weight, runtime, and pulse were taken for 31 participants who ran 1.5 miles.

To find a good oxygen uptake prediction equation, you need to compare many different regression models. The Stepwise platform lets you search through models with combinations of effects and choose the model you want.

Note: For purposes of illustration, certain values of MaxPulse and RunPulse have been changed from data reported by Rawlings (1988, p.105).

To do stepwise regression, first select *Fit Model* in the *Analyze* menu. In the Fit Model dialog, choose Oxy as the Y, and Runtime, Weight, RunPulse, RstPulse, MaxPulse as model effects. Then select *Stepwise* from the Personality menu. See Figure 6.1.

Figure 6.1 Fit Model Dialog for a Stepwise Model
Click Run.

When the model runs, it displays a window that shows three areas:

- The Stepwise Regression Control panel. See “Stepwise Regression Control Panel,” p. 120.
- The Current Estimates table. See “Current Estimates Table,” p. 121.
- The Step History table. See “Step History Table,” p. 123.

The red triangle menu on the Stepwise Fit report has the following options:

**K-Fold Crossvalidation** is used to perform K-Fold cross-validation in the selection process. When selected, this option enables the Max K-Fold RSquare stopping rule (“Stepwise Regression Control Panel,” p. 120). This is available only for continuous responses. For more information about validation, see “Validation,” p. 133.

**All Possible Models** see “All Possible Models,” p. 130. This is available only for continuous responses.

**Model Averaging** see “Model Averaging,” p. 131. This is available only for continuous responses.

**Plot Criterion History** produces a plot of AICc and BIC versus the number of parameters.

**Plot RSquare History** produces a plot of training and validation R-square versus the number of parameters. This is available only for continuous responses.

**Model Dialog** opens the Model Dialog window with the most recently used settings.

### Stepwise Regression Control Panel

The Stepwise Regression Control Panel (Control Panel for short), shown next, has editable areas, buttons and popup menus. You use these dialog features to limit regressor effect probabilities, determine the method of selecting effects, begin or stop the selection process, and create a model.

The **Stopping Rule** menu has the following options:

**P-value Threshold** uses p-values (significance levels) to enter and remove effects from the model. Two other options appear when P-value Threshold is chosen: **Prob to Enter** is the maximum p-value that an effect must have to be entered into the model during a forward step. **Prob to Leave** is the minimum p-value that an effect must have to be removed from the model during a backward step.
Minimum AICc uses the minimum corrected Akaike Information Criterion to choose the best model.

Minimum BIC uses the minimum Bayesian Information Criterion to choose the best model.

Max Validation RSquare uses the maximum R-square from the validation set to choose the best model. This is available only when a validation column is used, and the validation column has two or three distinct values. For more information about validation, see “Validation,” p. 133.

Max K-Fold RSquare uses the maximum R-square from K-fold cross-validation to choose the best model. This is available only when K-Fold cross-validation is used. For more information about validation, see “Validation,” p. 133.

The Direction menu provides options for choosing how effects enter and leave the model, and has the following options:

Forward brings in the regressor that most improves the fit, given that term is significant at the level specified by Prob to Enter.

Backward removes the regressor that affects the fit the least, given that term is not significant at the level specified in Prob to Leave.

Mixed alternates the forward and backward steps. It includes the most significant term that satisfies Prob to Enter and removes the least significant term satisfying Prob to Leave. It continues removing terms until the remaining terms are significant and then it changes to the forward direction.

Buttons on the control panel let you control the stepwise processing:

Go automates the selection process to completion.

Stop stops the selection process.

Step increments the selection process one step at a time.

Enter All enters all unlocked terms into the model.

Remove All removes all terms from the model.

Make Model forms a model for the Fit Model Dialog from the model currently showing in the Current Estimates table. In cases where there are nominal or ordinal terms, Make Model can create new data table columns to contain terms that are needed for the model.

Run runs the model currently showing in the Current Estimates table.

The right and left arrow buttons step forward and backward one step in the selection process.

Tip: If you have a hierarchy of terms in your model, you can specify their entry rules using the Rules drop-down menu. See “Rules for Including Related Terms,” p. 126 for details.

Current Estimates Table

The Current Estimates table lets you enter, remove, and lock in model effects. The platform begins with no terms in the model except for the intercept, as is shown here. The intercept is permanently locked into the model.
You use check boxes to define the stepwise regression process:

- **Lock** locks a term in or out of the model. **Lock** does not permit a term that is checked to be entered or removed from the model.

- **Entered** shows whether a term is currently in the model. You can click a term’s check box to manually bring an effect into or out of the model.

- **Parameter** lists the names of the effects.

- **Estimate** is the current parameter estimate. It is zero (0) if the effect is not currently in the model.

- **nDF** is the number of degrees of freedom for a term. A term has more than one degree of freedom if its entry into a model also forces other terms into the model.

- **SS** is the reduction in the error (residual) SS if the term is entered into the model or the increase in the error SS if the term is removed from the model. If a term is restricted in some fashion, it could have a reported SS of zero.

- **“F Ratio”** is the traditional test statistic to test that the term effect is zero. It is the square of a *t*-ratio. It is in quotation marks because it does not have an *F*-distribution for testing the term because the model was selected as it was fit.

- **“Prob>F”** is the significance level associated with the *F*-statistic. Like the “F Ratio,” it is in quotation marks because it is not to be trusted as a real significance probability.

- **R** initially hidden, is the multiple correlation with the other effects in the model.

Statistics for the current model appear above the list of effects:

- **SSE**, **DFE**, **RMSE** are the sum of squares, degrees of freedom, and root mean square error (residual) of the current model.

- **RSquare** is the proportion of the variation in the response that can be attributed to terms in the model rather than to random error.

- **RSquare Adj** adjusts $R^2$ to make it more comparable over models with different numbers of parameters by using the degrees of freedom in its computation. The adjusted $R^2$ is useful in stepwise procedure because you are looking at many different models and want to adjust for the number of terms in the model.
**Stepwise Regression**

A Multiple Regression Example

**Cp** is Mallow’s $C_p$ criterion for selecting a model. It is an alternative measure of total squared error defined as

$$C_p = \frac{(SSE_p)}{s^2} - (N - 2p)$$

where $s^2$ is the MSE for the full model and $SSE_p$ is the sum-of-squares error for a model with $p$ variables, including the intercept. Note that $p$ is the number of $x$-variables+1. If $C_p$ is graphed with $p$, Mallows (1973) recommends choosing the model where $C_p$ first approaches $p$.

$p$ is the number of parameters in the model, including the intercept.

**AICc** is the corrected Akaike’s Information Criterion defined as

$$AIC_c = -2\text{loglikelihood} + \frac{2k(k+1)}{n-k-1}$$

where $k$ is the number of estimated parameters, including intercept and error terms in the model, and $n$ is the number of observations in the data set. Burnham and Anderson (2004) discuss using $AIC_c$ for model selection. The best model has the smallest value, as discussed in Akaike (1974).

**BIC** is the Bayesian Information Criterion defined as

$$-2\text{loglikelihood} + k \ln(n)$$

where $k$ is the number of parameters, and $n$ is the sample size.

### Step History Table

As each step is taken, the Step History table records the effect of adding a term to the model. The Step History table for the Fitness data example shows the order in which the terms entered the model and shows the statistics for each model. Use the radio buttons on the right to choose a model.

<table>
<thead>
<tr>
<th>Step</th>
<th>Parameter</th>
<th>Action</th>
<th>&quot;Sig Prob&quot;</th>
<th>Seq SS</th>
<th>R2</th>
<th>Cp</th>
<th>p</th>
<th>AICc</th>
<th>BIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Runtime</td>
<td>Entered</td>
<td>0.0900</td>
<td>622.860</td>
<td>0.743</td>
<td>7.092</td>
<td>2</td>
<td>159.307</td>
<td>156.81</td>
</tr>
<tr>
<td>2</td>
<td>RunPulse</td>
<td>Entered</td>
<td>0.1567</td>
<td>16.59708</td>
<td>0.701</td>
<td>7.426</td>
<td>3</td>
<td>159.787</td>
<td>157.864</td>
</tr>
<tr>
<td>3</td>
<td>RestPulse</td>
<td>Entered</td>
<td>0.0140</td>
<td>41.34703</td>
<td>0.910</td>
<td>2.026</td>
<td>4</td>
<td>151.552</td>
<td>158.362</td>
</tr>
</tbody>
</table>

### Forward Selection Example

The default method of selection is the **Forward** selection. You can proceed with the Fitness.jmp data example using the **Step** button on the Control Panel. You see that after one step, the most significant term **Runtime** is entered into the model. Click **Go** to see the stepwise process run to completion. The bottom table in Figure 6.3 shows that all the terms have been added except **RestPulse** and **Weight**.
Backwards Selection Example

In backwards selection, terms are entered into the model and then least significant terms are removed until all the remaining terms are significant.

To do a backwards selection stepwise regression in JMP, start by clicking **Enter All**. All effects get entered into the model as shown in Figure 6.4. Then select **Backward** from the **Direction** popup menu.

Click the **Step** button. The first backward step removes **RstPulse** and the second step removes **Weight**. No further terms meet the **Prob to Leave** probability specified in the Control Panel. The Current Estimates and Step History tables shown in Figure 6.5 summarize the backwards stepwise selection process.
Models with Crossed, Interaction, or Polynomial Terms

Often with models from experimental designs, you have cross-product or interaction terms. For continuous factors, these are simple multiplications. For nominal and ordinal factors, the interactions are outer products of many columns. When there are crossed terms, you usually want to impose rules on the model selection process so that a crossed term cannot be entered unless all its subterms (terms that contain it) are in the model.

The next example uses the Reactor.jmp sample data (Box, Hunter, and Hunter 1978). The response is $Y$ and the variables are $F$, $Ct$, $A$, $T$, and $Cn$.

The model shown here is composed of all factorial terms up to two-factor interactions for the five continuous factors. Note that some terms have more than one degree of freedom (nDF) due to the restrictions placed on some of the terms. Under the model selection rules described above, a crossed term cannot be entered into the model until all its subterms (terms that contain it) are in the model. For example, if the stepwise process enters $F*Ct$, then it must also enter $F$ and $Ct$, which gives $F*Ct$ an nDF of 3.
Stepwise Regression

Chapter 6

Rules for Including Related Terms

The progress of multiterm inclusion is a balance between numerator degrees of freedom and opportunities to improve the fit. When there are significant interaction terms, often several terms enter at the same step. If the Step button is clicked once, Ct*T is entered along with its two contained effects Ct and T. However, a step back is not symmetric because a crossed term can be removed without removing its two component terms. Note that Ct now has 2 degrees of freedom because if Stepwise removes Ct, it also removes Ct*T.

### Rules for Including Related Terms

You can change the rules that are applied when there is a hierarchy of terms in the model. Notice that when terms are related, an extra popup menu called Rules appears.

![Current Estimates](image)

The Rules choices are used for related terms:

- **Combine**: groups a term with its precedent terms and calculates the group’s significance probability for entry as a joint F-test. **Combine** is the default rule.
- **Restrict**: restricts the terms that have precedents so that they cannot be entered until their precedents are entered.
- **No Rules**: gives the selection routine complete freedom to choose terms, regardless of whether the routine breaks a hierarchy or not.
Whole Effects enters only whole effects, when all terms involving that effect are significant. This rule applies only when categorical variables with more than two levels are entered as possible model effects.

Models with Nominal and Ordinal Terms

Traditionally, stepwise regression has not addressed the situation when there are categorical terms in the model. When nominal or ordinal terms are in regression models, they are carried as sets of dummy or indicator columns. When there are only two levels, there is no problem because they generate only a single column. However, for more than two levels, multiple columns must be handled. The convention in JMP for nominal variables in standard platforms is to model these terms so that the parameter estimates average out to zero across all the levels.

In the stepwise platform, categorical variables (nominal and ordinal) are coded in a hierarchical fashion, which is different from the other least squares fitting platforms. In hierarchical coding, the levels of the categorical variable are considered in some order and a split is made to make the two groups of levels that most separate the means of the response. Then, each group is further subdivided into its most separated subgroups, and so on, until all the levels are distinguished into \( k - 1 \) terms for \( k \) levels.

For nominal terms, the order of levels is determined by the means of the Ys. For ordinal terms, the order is fixed.

For example, consider the Football.jmp data. Specify Speed as the response, and Weight and Position2 as predictors. Position2 is a nominal variable with values representing football positions. The Current Estimates table is shown in Figure 6.7.

**Figure 6.7 Position Hierarchy**

<table>
<thead>
<tr>
<th>LockEnteredParameter</th>
<th>Estimate</th>
<th>nDF</th>
<th>SS</th>
<th>&quot;F Ratio&quot;</th>
<th>&quot;Prob&gt;F&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>61.035292</td>
<td>1</td>
<td>9</td>
<td>6.096</td>
<td>1</td>
</tr>
<tr>
<td>Weight</td>
<td>0.199598</td>
<td>1</td>
<td>77.64</td>
<td>2.2e-14</td>
<td></td>
</tr>
<tr>
<td>Position2{wr&amp;db&amp;o&amp;lb&amp;te–ki&amp;l}</td>
<td>1.233632</td>
<td>162.596</td>
<td>2e-17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position2{ki-l}</td>
<td>2.8199623</td>
<td>66.992</td>
<td>1.9e-19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position2{wr&amp;db&amp;o–lb&amp;te}</td>
<td>3.8244083</td>
<td>44.297</td>
<td>1.2e-18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position2{wb–lb}</td>
<td>4.8200089</td>
<td>32.993</td>
<td>7.4e-18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position2{lb–te}</td>
<td>5.011007</td>
<td>43.043</td>
<td>1.7e-19</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- The method first splits Position into two groups with the term Position2{wr&db&o&lb&te–ki&l}. One group (the slower group) consists of the wide receivers (wr), defensive backs (db), offensive backs (o), linebackers (lb), and tight ends (te). The other group (the faster group) is the kickers (ki), and linemen (l), which ultimately split as Position2{ki-l}.
- The next split subdivides the slower group into wide receivers (wr), defensive backs (db), and offensive backs(o) versus linebackers (lb) and tight ends (te), shown as Position2{wr&db&o–lb&te}. The linebackers (lb) and tight ends split (te) to form Position2{lb–te}. 
Stepwise Regression

Make Model Command for Hierarchical Terms

- The slower group divides again giving \( \text{Position2(wr&db-o)} \), wide receivers (wr) and defensive backs (db) versus offensive backs (o).
- The last subdivision is the wide receivers (wr) and defensive backs (db), \( \text{Position2(wr–db)} \).

These terms can be illustrated by the tree hierarchy shown at the top in Figure 6.8.

Figure 6.8 Tree Structure of Terms and Corresponding Current Estimates Table

Using the default Combine rule for terms to enter a model or the Restrict rule, a term cannot enter the model unless all the terms above it in the hierarchy have been entered. Thus, it is simple to bring in the term \( \text{Position2(wr&db&o&lb&te-ki&l)} \) because there is nothing above it in the hierarchy. But to enter \( \text{Position2(lb-te)} \) requires that the two other terms above it in the hierarchy are entered: \( \text{Position2(wr&db&o-lb&te)} \) and \( \text{Position2(wr&db&o&lb&te-ki&l)} \).

Reasons to choose a hierarchical coding include:
1. The hierarchy leads to natural stepping rules.
2. The groupings that make the greatest initial separation enter the model early.

Make Model Command for Hierarchical Terms

When you click Make Model or Run for a model with nominal or ordinal terms, Fit Model creates a new set of columns in the data table that it needs. The model appears in a new Fit Model window for the response variable. The next example uses the Hotdogs2 sample data to illustrate how Stepwise constructs a model with hierarchical effects.

A simple model (Figure 6.9) looks at the cost per ounce (\$/oz) as a function of Type (Meat, Beef, Poultry) and Size (Jumbo, Regular, Hors d’oeuvre). Choose P-value Threshold on the Stopping Rule menu, and Restrict on the Rules menu.
When you choose **Make Model** in the Stepwise Regression Control Panel, two actions occur:

- Indicator variables are created in the data table for those checked rows in the Current Estimates table that are partial levels of a main effect. In this example, two columns are created for Type and one column is created for Size.
- A new Fit Model dialog opens. The effects are those that were selected in the stepwise process.

### Logistic Stepwise Regression

JMP performs logistic stepwise regression in a similar way to standard least-squares logistic regression. To run a logistic stepwise regression, simply add terms to the model as usual and choose Stepwise from the personality drop-down menu.

The difference in the report when the response is categorical is in the **Current Estimates** section of the report. Wald/Score chi-square statistics appear, and the overall fit of the model is shown as \(-\text{LogLikelihood}\). An example is shown in Figure 6.10, using Fitness.jmp with **Sex** as the response, and **Weight**, **Runtime**, **RunPulse**, **RstPulse**, and **MaxPulse** as effects. Click the **Go** button on the Control Panel.
The enter and remove statistics are calculated using cheap Score or Wald chi-square tests respectively, but the regression estimates and log-likelihood values are based on the full iterative maximum likelihood fit. If you want to compare the Wald/Score values, look at the Step History report.

**All Possible Models**

For continuous responses, the Stepwise platform includes an All Possible Models command. It is accessible from the red-triangle menu on the Stepwise control panel. When selected, a new popup dialog is shown prompting you to enter values for the maximum number of terms to fit in any one model and for the maximum number of best model results to show for each number of terms in the model.

For an example, use the Fitness.jmp data table. Use Oxy as the response, and Runtime, RunPulse, RstPulse, and MaxPulse as the effects. For this example, the maximum number of terms is 3 and the number of best models is 5. See Figure 6.11.

**Figure 6.11** All Possible Models Popup Dialog

| All Possible Models |  |
|---------------------|--
| Maximum number of terms in a model | 3 |
| Number of best models to see | 5 |

After clicking OK, the platform fits all possible models up to three terms in a model. The results are shown in Figure 6.12.
Model Averaging

For continuous responses, the Stepwise platform includes a **Model Averaging** command, which is found on the red-triangle menu of the Stepwise Control Panel.

Model averaging is a technique which, instead of picking a single best model, allows you to average the fits for a number of models. The result is a model with excellent prediction capability.
This feature is particularly useful for new and unfamiliar models that you do not want to overfit. When many terms are selected into a model, the fit tends to inflate the estimates. Model averaging tends to shrink the estimates on the weaker terms, yielding better predictions. The models are averaged with respect to the AICc weight, calculated as:

$$AICcWeight = \exp[-0.5(AICc - AICcBest)]$$

where AICcBest is the smallest AICc value among the fitted models. The AICc Weights are then sorted in decreasing order. The AICc weights cumulating to less than one minus the cutoff of the total AICc weight are set to zero, allowing the very weak terms to have true zero coefficients instead of extremely small coefficient estimates.

Clicking on Model Averaging produces a new popup dialog that asks you to enter the maximum number of terms in any one model and a value that is used as the cutoff of the total AICc weight.

For an example, use the Fitness.jmp data table. Use Oxy as the response, and Runtime, RunPulse, RstPulse, and MaxPulse as the effects. For this example, the maximum number of terms is 3 and the weight cutoff is 0.95. See Figure 6.13.

Clicking OK yields the results shown in Figure 6.14. Average estimates and standard errors are shown for each parameter. The standard errors shown reflect the bias of the estimates toward zero.

The prediction formula can be saved in the original data table by clicking on Save Prediction Formula in the report.
Validation

Validation is the process of using part of a data set to estimate model parameters, and using the other part to assess the predictive ability of the model.

- The training set is the part that estimates model parameters.
- The validation set is the part that assesses or validates the predictive ability of the model.
- The test set is a final, independent assessment of the model’s predictive ability. The test set is available only when using a validation column.

The training, validation, and test sets are created by subsetting the original data into parts. This is done through the use of a validation column on the Fit Model launch window.

The validation column's values determine how the data is split, and what method is used for validation:

- If the column has two distinct values, then training and validation sets are created.
- If the column has three distinct values, then training, validation, and test sets are created.
- If the column has four or more distinct values, K-Fold crossvalidation is performed.

When validation is used, model fit statistics are given for the training, validation, and test sets.

K-Fold Crossvalidation

K-Fold crossvalidation divides the original data into K subsets. In turn, each of the K sets is used to validate the model fit on the rest of the data, fitting a total of K models. The model giving the best validation statistic is chosen as the final model. This method is best for small data sets, because it makes efficient use of limited amounts of data.

To use K-Fold crossvalidation, do one of the following:

- Use a validation column with four or more distinct values.
- Choose K-Fold Crossvalidation from the Stepwise Fit red triangle menu.
When more than one $Y$ is specified for a model in the Fit Model platform, you can choose the Manova personality for multivariate fitting. Multivariate models fit several $Y$'s to a set of effects. Functions across the $Y$'s can be tested with appropriate response designs. In addition to standard MANOVA models, you can do the following techniques with this facility:

- Repeated measures analysis when repeated measurements are taken on each subject and you want to analyze effects both between subjects and within subjects across the measurements. This multivariate approach is especially important when the correlation structure across the measurements is arbitrary.
- Canonical correlation to find the linear combination of the $X$ and $Y$ variables that has the highest correlation.
- Discriminant analysis to find distance formulas between points and the multivariate means of various groups so that points can be classified into the groups that they are most likely to be in. A more complete implementation of discriminant analysis is in the Discriminant platform.

Multivariate fitting has a different flavor from univariate fitting. The multivariate fit begins with a rudimentary preliminary analysis that shows parameter estimates and least squares means. You can then specify a response design across the $Y$'s, and multivariate tests are performed.
## Contents

- Multiple Response Model Specification ......................................................... 137
  - Initial Fit ......................................................................................... 137
  - Specification of the Response Design .................................................... 140
- Multivariate Tests ...................................................................................... 141
  - The Extended Multivariate Report ......................................................... 142
  - Comparison of Multivariate Tests .......................................................... 143
  - Univariate Tests and the Test for Sphericity .......................................... 143
- Multivariate Model with Repeated Measures .............................................. 145
  - Repeated Measures Example .................................................................. 145
- A Compound Multivariate Model ................................................................. 147
- Commands for Response Type and Effects .................................................. 149
  - Test Details (Canonical Details) ............................................................. 149
  - The Centroid Plot ............................................................................... 150
  - Save Canonical Scores (Canonical Correlation) ....................................... 151
- Discriminant Analysis .................................................................................. 152
Multiple Response Model Specification

To form a multivariate model, choose Fit Model from the Analyze menu and assign multiple Y’s in the dialog. Then select Manova from the fitting personality popup menu.

This example uses the Golf Balls.jmp sample data table (McClave and Dietrich, 1988). The data are a comparison of distances traveled and a measure of durability for three brands of golf balls. A robotic golfer hit a random sample of ten balls for each brand in a random sequence. The hypothesis to test is that distance and durability are the same for the three golf ball brands.

In the Fit Model platform, assign both Distance and Durability to the Y role, and assign Brand as an effect. Select Manova from the Personality menu. See Figure 7.1.

Figure 7.1 Manova Setup

Initial Fit

Click Run to perform the initial fit. The results are described in the next several sections. The initial results might not be very interesting in themselves, because no response design has been specified yet. After you specify a response design, the multivariate platform displays tables of multivariate estimates and tests. For details about specifying a response design, see “Specification of the Response Design,” p. 140.

The Manova Fit red-triangle menu has the following options:

- **Save Discrim** performs a discriminant analysis and saves the results to the data table. For more details, see “Discriminant Analysis,” p. 152.
- **Save Predicted** saves the predicted responses to the data table.
**Save Residuals** saves the residuals to the data table.

**Model Dialog** opens a Fit Model window populated with the settings of the most recent model.

**Parameter Estimates Table**

The Parameter Estimates (see Figure 7.2) report includes only the parameter estimates for each response variable, without details like standard errors or t-tests. There is a column for each response variable.

**Figure 7.2 Parameter Estimates**

<table>
<thead>
<tr>
<th>Parameter Estimates</th>
<th>Distance</th>
<th>Durability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>280.784322</td>
<td>257.986867</td>
</tr>
<tr>
<td>Brand[Brand B]</td>
<td>0.28966667</td>
<td>-20.366667</td>
</tr>
</tbody>
</table>

**Least Squares Means Report**

For each pure nominal effect, the Least Squares Means table reports the overall least squares means of all the response columns, least squares means of each nominal level, and LS means plots of the means. Figure 7.3 shows the LS Mean plot of the golf ball brands and the table of least squares means. The same plot and table are available for the overall means.

**Figure 7.3 Least Squares Means Report**
Partial Covariance and Correlation Tables

The Partial Correlation table (see Figure 7.4) shows the covariance matrix and the partial correlation matrix of residuals from the initial fit, adjusted for the $X$ effects.

Figure 7.4 Partial Correlation

Overall E&H Matrices

The main ingredients of multivariate tests are the $E$ and $H$ matrices (see Figure 7.5):

- The elements of the $E$ matrix are the cross products of the residuals.
- The $H$ matrices correspond to hypothesis sums of squares and cross products.

There is an $H$ matrix for the whole model and for each effect in the model. Diagonal elements of the $E$ and $H$ matrices correspond to the hypothesis (numerator) and error (denominator) sum of squares for the univariate $F$ tests. New $E$ and $H$ matrices for any given response design are formed from these initial matrices, and the multivariate test statistics are computed from them.

Figure 7.5 E and H Matrices
Specification of the Response Design

You use the Response Specification dialog (see Figure 7.6) to specify the response designs for various tests.

The dialog has these optional check boxes:

- The **Univariate Tests Also** check box is used in repeated measures models to obtain adjusted and unadjusted univariate repeated measures tests as well as multivariate tests.
- The **Test Each Column Separately Also** check box is used in obtaining univariate ANOVA tests on each response as well as multivariate tests.

The response design forms the $M$ matrix. The columns of an $M$ matrix define a set of transformation variables for the multivariate analysis. The Choose Response popup menu lists the choices for $M$ shown below. The popup menu has the following response matrices:

- **Repeated Measures** constructs and runs both Sum and Contrast responses.
- **Sum** is the sum of the responses, giving a single value.
- **Identity** uses each separate response, the identity matrix.
- **Contrast** compares each response and the first response.
- **Polynomial** constructs a matrix of orthogonal polynomials.
- **Helmert** compares each response with the combined responses listed below it.
- **Profile** compares each response with the following response.
- **Mean** compares each response versus the mean of the others.
- **Compound** creates and runs several response functions that are appropriate if the responses are compounded from two effects.
- **Custom** uses any custom $M$ matrix you enter.

The most typical response designs are **Repeated Measures** and **Identity** for multivariate regression. There is little difference in the tests given by **Contrast**, **Helmert**, **Profile**, and **Mean** because they span the same space. However, the tests and details in the Least Squares means and Parameter Estimates tables for them show correspondingly different highlights.
Chapter 7

Multiple Response Fitting

Multivariate Tests

The **Repeated Measures** and the **Compound** response selections display dialogs to specify response effect names. They then continue on to fit several response functions without waiting for further user input. Otherwise, selections expand the control panel and give you more opportunities to refine the specification.

Figure 7.7 shows the **Identity** dialog selected from the **Response Design** popup menu and the default $M$ matrix for the $Y$ variables *distance* and *durability*. The Response Specification dialog stays open to specify further response designs for estimation and testing.

**Figure 7.7 Identity Control Panel**

The response function is shown in the form of the $M$ matrix, and control buttons appear at the bottom of the dialog (see the figure below). You use this part of the dialog in the following ways:

- Check the **Univariate Tests Also** check box to see the adjusted and unadjusted univariate tests as well as the multivariate tests in a repeated measures situation. Univariate tests are done with respect to an orthonormalized version of $M$.
- Click any value in the $M$ matrix text edit boxes to change a value.
- Use the **Orthogonalize** button to orthonormalize the matrix. Orthonormalization is done after the column contrasts (sum to zero) for all response types except *Sum*.
- Use **Delete Last Column** to reduce the dimensionality of the transformation.

**Multivariate Tests**

After you complete the Response Specification dialog, click **Run** to see multivariate estimations and tests. Figure 7.8 shows the results of clicking Run on the dialog shown in Figure 7.7.
The **M Matrix** report gives the response design you specified. The **M-transformed Parameter Estimates** report gives the original parameter estimates matrix multiplied by the transpose of the M matrix.

**Note:** Initially in this chapter the matrix names $E$ and $H$ refer to the error and hypothesis cross products. After specification of a response design, $E$ and $H$ refer to those matrices transformed by the response design, which are actually $M'EM$ and $M'HM$.

### The Extended Multivariate Report

In multivariate fits, the sums of squares due to hypothesis and error are matrices of squares and cross products instead of single numbers. And there are lots of ways to measure how large a value the matrix for the hypothesis sums of squares and cross products (called $H$ or SSCP) is compared to that matrix for the residual (called $E$). JMP reports the four multivariate tests that are commonly described in the literature. If you are looking for a test at an exact significance level, you will have to go hunting for tables in reference books. Fortunately, all four tests can be transformed into an approximate $F$-test. If the response design yields a single value, or if the hypothesis is a single degree of freedom, the multivariate tests are equivalent and yield the same exact $F$-test. JMP labels the text Exact $F$; otherwise, JMP labels it Approx. $F$.

In the golf balls example, there is only one effect so the Whole Model test and the test for **Brand** are the same, which show the four multivariate tests with approximate $F$ tests. There is only a single intercept with two DF (one for each response), so the $F$-test for it is exact and is labeled Exact $F$.

The red-triangle menus on the Whole Model, Intercept, and Brand reports give options to generate additional information, which includes eigenvalues, canonical correlations, a list of centroid values, a centroid plot, and a **Save** command that lets you save canonical variates. These options are discussed in the section “Commands for Response Type and Effects,” p. 149.

The effect (**Brand** in this example) popup menu also includes the option to specify contrasts.
The custom test and contrast features are the same as those for regression with a single response. See the chapters the “Standard Least Squares: Introduction,” p. 21, and “Standard Least Squares: Perspectives on the Estimates,” p. 57, for a description and examples of contrasts and custom tests.

“Multivariate Details,” p. 651 in the appendix “Statistical Details,” p. 621, shows formulas for the MANOVA table tests.

Each MANOVA test table, except the Sphericity Test table, has these elements:

- **Test** labels each statistical test in the table. If the number of response function values (columns specified in the M matrix) is 1 or if an effect has only one degree of freedom per response function, the exact \( F \)-test is presented. Otherwise, the standard four multivariate test statistics are given with approximate F tests: Wilk’s Lambda (\( \Lambda \)), Pillai’s Trace, the Hotelling-Lawley Trace, and Roy’s Maximum Root.

- **Value** the value of each multivariate statistical test in the report.

- **Approx. F (or Exact F)** the \( F \)-values corresponding to the multivariate tests. If the response design yields a single value or if the test is one degree of freedom, this will be an exact \( F \)-test.

- **NumDF** the numerator degrees of freedom.

- **DenDF** the denominator degrees of freedom.

- **Prob>F** the significance probability corresponding to the \( F \)-value.

**Comparison of Multivariate Tests**

Although the four standard multivariate tests often give similar results, there are situations where they differ, and one may have advantages over another. Unfortunately, there is no clear winner. In general, the order of preference in terms of power is

1. Pillai’s Trace
2. Wilk’s Lambda
3. Hotelling-Lawley Trace
4. Roy’s Maximum Root.

When there is a large deviation from the null hypothesis and the eigenvalues differ widely, the order of preference is the reverse (Seber 1984).

**Univariate Tests and the Test for Sphericity**

There are cases, such as a repeated measures model, that allow transformation of a multivariate problem into a univariate problem (Huynh and Feldt 1970). Using univariate tests in a multivariate context is valid

- if the response design matrix \( M \) is orthonormal (\( M'M = \text{Identity} \)).
- if \( M \) yields more than one response the coefficients of each transformation sum to zero.
- if the sphericity condition is met. The sphericity condition means that the \( M \)-transformed responses are uncorrelated and have the same variance. \( M'\Sigma M \) is proportional to an identity matrix, where \( \Sigma \) is the covariance of the \( Y \)’s.
If these conditions hold, the diagonal elements of the $E$ and $H$ test matrices sum to make a univariate sums of squares for the denominator and numerator of an $F$-test. Note that if the above conditions do not hold, then an error message will be produced. In the case of Golf Balls.jmp, an identity matrix is specified as the $M$-matrix. Identity matrices cannot be transformed to a full rank matrix after centralization of column vectors and ortho-normalization. So the univariate request is ignored.

To view univariate and sphericity tests, open Dogs.jmp from the sample data directory. Click on the MANOVA script or refer to Figure 7.1 to see the model specification dialog.

Check the Univariate Tests Also check box in the Response Specification dialog, specify Repeated Measures from the Response Design popup menu, and enter Time for the Y Name and check the box beside Univariate Tests Also. You will see a Sphericity Test table, like the one shown in Figure 7.9, and adjusted univariate $F$-tests in the multivariate report tables.

The sphericity test checks the appropriateness of an unadjusted univariate $F$-test for the within-subject effects using the Mauchly criterion to test the sphericity assumption (Anderson 1958). The sphericity test and the univariate tests are always done using an orthonormalized $M$ matrix. You interpret the sphericity test as follows:

- If the sphericity Chi-square test is not significant, you can use the unadjusted univariate $F$-tests.
- If the sphericity test is significant, use the multivariate or the adjusted univariate tests.

The univariate $F$-statistic has an approximate $F$-distribution even without sphericity, but the degrees of freedom for numerator and denominator are reduced by some fraction epsilon ($\epsilon$). Box (1954), Geisser and Greenhouse (1958), and Huynh-Feldt (1976) offer techniques for estimating the epsilon degrees-of-freedom adjustment. Muller and Barton (1989) recommend the Geisser-Greenhouse version, based on a study of power.

The epsilon adjusted tests in the multivariate report are labeled G-G (Greenhouse-Geisser) or H-F (Huynh-Feldt), with the epsilon adjustment shown in the value column.

Figure 7.9 Sphericity test

<table>
<thead>
<tr>
<th>Sphericity Test</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mauchly Criterion</td>
<td>0.1752841</td>
</tr>
<tr>
<td>ChiSquare</td>
<td>18.930873</td>
</tr>
<tr>
<td>DF</td>
<td>5</td>
</tr>
<tr>
<td>Prob &gt; Chisq</td>
<td>0.0045328</td>
</tr>
</tbody>
</table>
Multivariate Model with Repeated Measures

One common use of multivariate fitting is to analyze data with repeated measures, also called *longitudinal data*. A subject is measured repeatedly across time, and the data are arranged so that each of the time measurements form a variable. Because of correlation between the measurements, data should not be stacked into a single column and analyzed as a univariate model unless the correlations form a pattern termed *sphericity*. See the previous section, “Univariate Tests and the Test for Sphericity,” p. 143, for more details about this topic.

With repeated measures, the analysis is divided into two layers:

- Between-subject (or across-subject) effects are modeled by fitting the sum of the repeated measures columns to the model effects. This corresponds to using the **Sum** response function, which is an M-matrix that is a single vector of 1’s.

- Within-subjects effects (repeated effects, or time effects) are modeled with a response function that fits differences in the repeated measures columns. This analysis can be done using the **Contrast** response function or any of the other similar differencing functions: Polynomial, Helmert, Profile, or **Mean**. When you model differences across the repeated measures, think of the differences as being a new within-subjects effect, usually time. When you fit effects in the model, interpret them as the interaction with the within-subjects effect. For example, the effect for Intercept becomes the Time (within-subject) effect, showing overall differences across the repeated measures. If you have an effect A, the within-subjects tests are interpreted to be the tests for the A*Time interaction, which model how the differences across repeated measures vary across the A effect.

Table 7.1 “Corresponding Multivariate and Univariate Tests,” p. 146, shows the relationship between the response function and the model effects compared with what a univariate model specification would be. Using both the **Sum** (between-subjects) and **Contrast** (within-subjects) models, you should be able to reconstruct the tests that would have resulted from stacking the responses into a single column and obtaining a standard univariate fit.

There is a direct and an indirect way to perform the repeated measures analyses:

- The direct way is to use the popup menu item Repeated Measures. This prompts you to name the effect that represents the within-subject effect across the repeated measures. Then it fits both the **Contrast** and the **Sum** response functions. An advantage of this way is that the effects are labeled appropriately with the within-subjects effect name.

- The indirect way is to specify the two response functions individually. First, do the **Sum** response function and second, do either **Contrast** or one of the other functions that model differences. You will have to remember to associate the within-subjects effect with the model effects in the contrast fit.

Repeated Measures Example

As an example, consider a study by Cole and Grizzle (1966). The results are in the Dogs.jmp table in the sample data folder. Sixteen dogs are assigned to four groups defined by variables drug and dep1, each having two levels. The dependent variable is the blood concentration of histamine at 0, 1, 3, and 5 minutes after injection of the drug. The log of the concentration is used to minimize the correlation between the mean and variance of the data.
Assign LogHist0, LogHist1, LogHist3, and LogHist5 to the Y role. Select drug and dep1 and select **Full Factorial** from the Macros pop-up menu. Select **Manova** from the Personality menu, and click **Run**. Select **Repeated Measures** from the Choose Response pop-up menu.

A window (see Figure 7.10) appears for specifying an arbitrary name to represent the effect across the Y variables. This is usually a time effect, so enter Time.

**Figure 7.10 Repeated Measures Window**

If you check the **Univariate Tests Also** check box, the report includes univariate tests, which are calculated as if the responses were stacked into a single column.

Table 7.1 “Corresponding Multivariate and Univariate Tests,” p. 146, shows how the multivariate tests for a **Sum** and **Contrast** response designs correspond to how univariate tests would be labeled if the data for columns LogHist0, LogHist1, LogHist3, and LogHist5 were stacked into a single Y column, with the new rows identified with a nominal grouping variable, Time.

<table>
<thead>
<tr>
<th>Sum M-Matrix Between Subjects</th>
<th>Contrast M-Matrix Within Subjects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multivariate Test</td>
<td>Univariate Test</td>
</tr>
<tr>
<td>intercept</td>
<td>intercept</td>
</tr>
<tr>
<td>drug</td>
<td>drug</td>
</tr>
<tr>
<td>depl</td>
<td>depl</td>
</tr>
</tbody>
</table>

The between-subjects analysis is produced first. This analysis is the same (except titling) as it would have been if **Sum** had been selected on the popup menu.

The within-subjects analysis is produced next. This analysis is the same (except titling) as it would have been if **Contrast** had been selected on the popup menu, though the within-subject effect name (Time) has been added to the effect names in the report. Note that the position formerly occupied by **Intercept** is **Time**, because the intercept term is estimating overall differences across the repeated measurements.
A Compound Multivariate Model

JMP can handle data with layers of repeated measures. For example, see the Cholesterol.jmp data table. Groups of five subjects belong to one of four treatment groups called A, B, Control, and Placebo. Cholesterol was measured in the morning and again in the afternoon once a month for three months (the data are fictional). In this example the response columns are arranged chronologically with time of day within month.

To analyze this experimental design, complete the Fit Model dialog by declaring treatment as the only effect and all six response columns as Y variables. Specify the Personality as Manova. When you click Run, the four tables for the initial fit appear. Part of the report is shown in Figure 7.11.

You can see in the Least Squares Means table that the four treatment groups began the study with very similar mean cholesterol values. The A and B treatment groups appear to have lower cholesterol values at the end of the trial period. The control and placebo groups remain unchanged.

Next, choose Compound from the response design popup menu. You complete this dialog to tell JMP how the responses are arranged in the data table and the number of levels of each response. In the cholesterol example, the time of day columns are arranged within month. Therefore, you name time of day as one factor and the month effect as the other factor. Note that testing the interaction effect is optional. Complete the window as shown in Figure 7.12.
When you click **OK**, the tests for each effect display. Parts of the report are shown in Figure 7.13.

- With a p-value of 0.6038, the interaction between Time and *treatment* is not significant. This means there is no difference in *treatment* between AM and PM. Note that since Time has two levels (AM and PM), the exact F-test is given.

- With p-values of <.0001, the interaction between Month and *treatment* is significant. This suggests that the differences between treatment groups change with Month. The LS Means plot shown above indicates no difference among the groups in April, but the difference between (A,B) and (Control, Placebo) becomes large in May and even larger in June.

- The interaction effect between Month, Time, and *treatment* is not statistically significant.

**Figure 7.13** Cholesterol Study Results

<table>
<thead>
<tr>
<th>Test</th>
<th>Value</th>
<th>Exact F</th>
<th>NumDF</th>
<th>DenDF</th>
<th>Prob-F</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>treatment</em></td>
<td>0.1186121</td>
<td>0.346</td>
<td>3</td>
<td>16</td>
<td>0.6038</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Test</th>
<th>Value</th>
<th>Approx F</th>
<th>NumDF</th>
<th>DenDF</th>
<th>Prob-F</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Month</em></td>
<td>0.013025</td>
<td>36.6103</td>
<td>6</td>
<td>38</td>
<td>&lt;0.001*</td>
</tr>
<tr>
<td><em>Time</em></td>
<td>1.319817</td>
<td>10.197</td>
<td>6</td>
<td>22</td>
<td>&lt;0.001*</td>
</tr>
<tr>
<td><em>Month</em></td>
<td>0.753209</td>
<td>123.4369</td>
<td>6</td>
<td>18.328&lt;0.001*</td>
<td></td>
</tr>
<tr>
<td><em>Time</em></td>
<td>0.255502</td>
<td>28.0263</td>
<td>3</td>
<td>18</td>
<td>&lt;0.001*</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Test</th>
<th>Value</th>
<th>Approx F</th>
<th>NumDF</th>
<th>DenDF</th>
<th>Prob-F</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Month</em></td>
<td>0.6523742</td>
<td>1.1435</td>
<td>6</td>
<td>38</td>
<td>0.3619</td>
</tr>
<tr>
<td><em>Time</em></td>
<td>0.3582613</td>
<td>1.1638</td>
<td>6</td>
<td>22</td>
<td>0.5498</td>
</tr>
<tr>
<td><em>Month</em></td>
<td>0.4705659</td>
<td>1.1839</td>
<td>6</td>
<td>18.328&lt;0.001*</td>
<td></td>
</tr>
<tr>
<td><em>Time</em></td>
<td>0.4008469</td>
<td>2.1378</td>
<td>3</td>
<td>16</td>
<td>0.1350</td>
</tr>
</tbody>
</table>
Commands for Response Type and Effects

The Custom Test popup option displays the Custom Test dialog for setting up custom tests of effect levels. See “Custom Test,” p. 64 in the “Standard Least Squares: Perspectives on the Estimates” chapter for a description of how to use the Custom Test dialog to create custom tests.

The popup menu icon beside each effect name gives you the commands shown here, to request additional information about the multivariate fit:

- **Test Details** displays the eigenvalues and eigenvectors of the $E^{-1}H$ matrix used to construct multivariate test statistics.
- **Centroid Plot** plots the centroids (multivariate least-squares means) on the first two canonical variables formed from the test space.
- **Save Canonical Scores** saves variables called Canon[1], Canon[2], and so on, as columns in the current data table. These columns have both the values and their formulas.
- **Contrast** performs the statistical contrasts of treatment levels that you specify in the contrasts dialog.

**Note:** The Contrast command is the same as for regression with a single response. See the “LSMeans Contrast,” p. 43 in the “Standard Least Squares: Introduction” chapter, for a description and examples of the LSMeans Contrast commands.

**Test Details (Canonical Details)**

As an example, open Fisher’s Iris data, Iris.jmp, found in the Sample Data folder (Mardia, Kent, and Bibby 1979). The Iris data have three levels of Species named Virginica, Setosa, and Versicolor. There are four measures (Petal length, Petal width, Sepal length, and Sepal width) taken on each sample. Fit a MANOVA model for the Species effect, with the four petal and sepal measures assigned as responses (Y). Choose the Identity response model. Then select the Test Details command from the Species popup menu.

The eigenvalues, eigenvectors, and canonical correlations appear (see Figure 7.14).

**Figure 7.14 Test Details**

<table>
<thead>
<tr>
<th>Species</th>
<th>Value</th>
<th>Approx. F</th>
<th>NumDF</th>
<th>DenDF</th>
<th>Prob&gt;F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wilks' Lambda</td>
<td>0.924388</td>
<td>199.1453</td>
<td>8</td>
<td>200</td>
<td>&lt;0.001*</td>
</tr>
<tr>
<td>Pillai's Trace</td>
<td>0.1819868</td>
<td>53.4605</td>
<td>8</td>
<td>200</td>
<td>&lt;0.001*</td>
</tr>
<tr>
<td>Hotelling-Lawley Trace</td>
<td>33.4732</td>
<td>5931.70</td>
<td>8</td>
<td>200</td>
<td>&lt;0.001*</td>
</tr>
<tr>
<td>Roy's Max Root</td>
<td>22.151620</td>
<td>1185.2874</td>
<td>4</td>
<td>146</td>
<td>&lt;0.001*</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Canonical</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Eigenvalue</td>
<td></td>
</tr>
<tr>
<td>3.21419262</td>
<td>0.96042380</td>
</tr>
<tr>
<td>0.59959164</td>
<td>0.47118402</td>
</tr>
<tr>
<td>1.2950-15</td>
<td>0</td>
</tr>
<tr>
<td>-6.1174-16</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Eigenv</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Sepal length</td>
<td>-0.80884059</td>
</tr>
<tr>
<td>Sepal width</td>
<td>-0.1455612</td>
</tr>
<tr>
<td>Petal length</td>
<td>0.11555286</td>
</tr>
<tr>
<td>Petal width</td>
<td>0.23195298</td>
</tr>
</tbody>
</table>
Eigenvalue lists the eigenvalues of the $E^{-1}H$ matrix used in computing the multivariate test statistics.

Canonical Corr lists the canonical correlations associated with each eigenvalue. This is the canonical correlation of the transformed responses with the effects, corrected for all other effects in the model.

Eigvec lists the eigenvectors of the $E^{-1}H$ matrix, or equivalently of $(E + H)^{-1}H$.

The Centroid Plot

The Centroid Plot command (accessed from the red triangle next to Species) plots the centroids (multivariate least-squares means) on the first two canonical variables formed from the test space, as in Figure 7.15. The first canonical axis is the vertical axis so that if the test space is only one dimensional the centroids align on a vertical axis. The centroid points appear with a circle corresponding to the 95% confidence region (Mardia, Kent, and Bibby, 1980). When centroid plots are created under effect tests, circles corresponding to the effect being tested appear in red. Other circles appear blue. Biplot rays show the directions of the original response variables in the test space.

Click the Centroid Val disclosure icon to show additional information, shown in Figure 7.15.

The first canonical axis with an eigenvalue accounts for much more separation than does the second axis. The means are well separated (discriminated), with the first group farther apart than the other two. The first canonical variable seems to load the petal length variables against the petal width variables. Relationships among groups of variables can be verified with Biplot Rays and the associated eigenvectors.
Save Canonical Scores (Canonical Correlation)

Canonical correlation analysis is not a specific command, but it can be done by a sequence of commands in the multivariate fitting platform:

- Choose the **Fit Model** command.
- Specify Y's and X's, select **Manova** from the **Personality** drop-down menu, and click **Run**.
- Choose the **Identity** from the Choose Response pop-up menu. Click **Run**.
- Select **Test Details** and then **Save Canonical Scores** from the **Whole Model** popup commands. The details list the canonical correlations (Canonical Corr) next to the eigenvalues. The saved variables are called Canon[1], Canon[2], and so on. These columns contain both the values and their formulas.
- To obtain the canonical variables for the X side, repeat the same steps but interchange the X and Y variables. If you already have the columns Canon[n] appended to the data table, the new columns are called Canon[1] (or another number) that makes the name unique.

For example, try the Linnerud data from Rawlings (1988) called Exercise.jmp found in the Sample Data folder. It has the physiological X variables weight, waist, and pulse, and the exercise Y variables chins, situps, and jumps. Figure 7.16 shows how the Whole Model table looks after the details are requested.

The output canonical variables use the eigenvectors shown as the linear combination of the Y variables. For example, the formula for canon[1] is

\[ 0.02503681 \times \text{chins} + 0.00637953 \times \text{situps} - 0.0052909 \times \text{jumps} \]

This canonical analysis does not produce a standardized variable with mean 0 and standard deviation 1, but it is easy to define a new standardized variable with the calculator that has these features.
Discriminant Analysis

Discriminant analysis is a method of predicting some level of a one-way classification based on known values of the responses. The technique is based on how close a set of measurement variables are to the multivariate means of the levels being predicted. Discriminant analysis is more fully implemented using the Discriminant Platform ("Discriminant Analysis," p. 475).

In JMP you specify the measurement variables as $Y$ effects and the classification variable as a single $X$ effect. The multivariate fitting platform gives estimates of the means and the covariance matrix for the data, assuming the covariances are the same for each group. You obtain discriminant information with the Save Discrim command in the popup menu next to the MANOVA platform name. This command saves distances and probabilities as columns in the current data table using the initial $E$ and $H$ matrices.

For a classification variable with $k$ levels, JMP adds $k$ distance columns, $k$ classification probability columns, the predicted classification column, and two columns of other computational information to the current data table.

Again use Fisher’s Iris data (Iris.jmp in the Sample Data folder) as found in Mardia, Kent, and Bibby. There are $k = 3$ levels of species and four measures on each sample. The Save Discrim command in the Manova Fit drop-down menu adds the following nine columns to the Iris.jmp data table.

- $\text{SqDist}[0]$ is the quadratic form needed in the Mahalanobis distance calculations.
- $\text{SqDist}[\text{setosa}]$ is the Mahalanobis distance of the observation from the Setosa centroid.
- $\text{SqDist}[\text{versicolor}]$ is the Mahalanobis distance of the observation from the Versicolor centroid.
- $\text{SqDist}[\text{virginica}]$ is the Mahalanobis distance of the observation from the Virginica centroid.
- $\text{Prob}[0]$ is the sum of the negative exponentials of the Mahalanobis distances, used below.
- $\text{Prob}[\text{setosa}]$ is the probability of being in the Setosa category.
- $\text{Prob}[\text{versicolor}]$ is the probability of being in the Versicolor category.
- $\text{Prob}[\text{virginica}]$ is the probability of being in the Virginica category.
- $\text{Pred Species}$ is the species that is most likely from the probabilities.

You can use the new columns in the data table with other JMP platforms to summarize the discriminant analysis with reports and graphs. For example, if you use the Fit Y by X platform and specify Pred Species as $X$ and Species as $Y$ variable, the Contingency Table report shown in Figure 7.17 summarizes the discriminant classifications. Three misclassifications are identified.
### Figure 7.17 Two-Way Table of Predicted and Actual Species

<table>
<thead>
<tr>
<th>Specie</th>
<th>setosa</th>
<th>versicolor</th>
<th>virginica</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>50</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Total %</td>
<td>33.33</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Row %</td>
<td>100.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Pred Specie</td>
<td>0</td>
<td>49</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>9.00</td>
<td>32.00</td>
<td>8.87</td>
</tr>
<tr>
<td></td>
<td>9.00</td>
<td>96.00</td>
<td>2.00</td>
</tr>
<tr>
<td></td>
<td>9.00</td>
<td>97.99</td>
<td>2.04</td>
</tr>
<tr>
<td>virginica</td>
<td>0</td>
<td>2</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>9.00</td>
<td>1.33</td>
<td>32.67</td>
</tr>
<tr>
<td></td>
<td>9.00</td>
<td>4.00</td>
<td>96.00</td>
</tr>
<tr>
<td></td>
<td>9.00</td>
<td>2.02</td>
<td>96.00</td>
</tr>
<tr>
<td></td>
<td>5.00</td>
<td>50</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>33.33</td>
<td>33.33</td>
<td>33.33</td>
</tr>
</tbody>
</table>
Multiple Response Fitting
Discriminant Analysis

Chapter 7
Chapter 8

Fitting Dispersion Effects with the LogLinear Variance Model
The Fit Model Platform

This fitting platform allows you to model both the expected value and the variance of a response using regression models. The log of the variance is fit to one linear model and the expected response is fit to a different linear model simultaneously.

**Note:** The estimates are demanding in their need for a lot of well-designed, well-fitting data. You need more data to fit variances than you do means.

For many engineers, the goal of an experiment is not to maximize or minimize the response itself, but to aim at a target response and achieve minimum variability. The loglinear variance model provides a very general and effective way to model variances, and can be used for unreplicated data, as well as data with replications.

Modeling dispersion effects is not very widely covered in textbooks, with the exception of the Taguchi framework. In a Taguchi-style experiment, this is handled by taking multiple measurements across settings of an outer array, constructing a new response which measures the variability off-target across this outer array, and then fitting the model to find out the factors that produce minimum variability. This kind of modeling requires a specialized design that is a complete cartesian product of two designs. The method of this chapter models variances in a more flexible, model-based approach. The particular performance statistic that Taguchi recommends for variability modeling is $STD = -\log(s)$. In JMP’s methodology, the $\log(s^2)$ is modeled and combined with a model that has a mean. The two are basically equivalent, since $\log(s^2)=2\log(s)$. 

## Contents

- The Loglinear Variance Model ................................................................. 157
- Estimation Method .................................................................................. 157

Loglinear Variance Models in JMP ............................................................ 157
- Model Specification .................................................................................. 157
- Example .................................................................................................... 158
- Displayed Output ..................................................................................... 159
- Platform Options ..................................................................................... 160
- Examining the Residuals .......................................................................... 161
- Profiling the Fitted Model ........................................................................ 162
- Comments ............................................................................................... 164
The Loglinear Variance Model

The loglinear-variance model (Harvey 1976, Cook and Weisberg 1983, Aitken 1987, Carroll and Ruppert 1988) provides a neat way to model the variance simply through a linear model. In addition to having regressor terms to model the mean response, there are regressor terms in a linear model to model the log of the variance:

\[
\begin{align*}
\text{mean model: } & \quad E(y) = X\beta \\
\text{variance model: } & \quad \log(\text{Variance}(y)) = Z\lambda,
\end{align*}
\]

or equivalently

\[
\text{Variance}(y) = \exp(Z\lambda)
\]

where the columns of $X$ are the regressors for the mean of the response, and the columns of $Z$ are the regressors for the variance of the response. The regular linear model parameters are represented by $\beta$, and $\lambda$ represents the parameters of the variance model.

Estimation Method

Log-linear variance models are estimated using REML.

Loglinear Variance Models in JMP

This section introduces a new kind of effect, a dispersion effect, labeled as a log-variance effect, that can model changes in the variance of the response. This is implemented in the Fit Model platform by a fitting personality called the Loglinear Variance personality.

Model Specification

Log-linear variance effects are specified in the Fit Model dialog by highlighting them and selecting LogVariance Effect from the Attributes drop-down menu. &LogVariance appears at the end of the effect. When you use this attribute, it also changes the fitting Personality at the top to LogLinear Variance. If you want an effect to be used for both the mean and variance of the response, then you must specify it twice, once with the LogVariance option.

The effects you specify with the log-variance attribute become the effects that generate the $Z$s in the model, and the other effects become the $X$s in the model.
Example

The data table InjectionMolding.jmp contains the experimental results from a 7-factor $2^{7-3}$ fractional factorial design with four added centerpoints [from Myers and Montgomery, 1995, page 519, originally Montgomery, 1991]. Preliminary investigation determined that the mean response only seemed to vary with the first two factors, Mold Temperature, and Screw Speed, and the variance seemed to be affected by Holding Time.

**Figure 8.1 Injection Molding Data**

<table>
<thead>
<tr>
<th>Pattern</th>
<th>MoldTemp</th>
<th>Screw Speed</th>
<th>Hold Time</th>
<th>Gate Size</th>
<th>Cycle Time</th>
<th>Moisture</th>
<th>Pressure</th>
<th>Shrinkage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 ------</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>6</td>
</tr>
<tr>
<td>2 +++++</td>
<td>1</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>10</td>
</tr>
<tr>
<td>3 +++++</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>12</td>
</tr>
<tr>
<td>4 +++++</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>86</td>
</tr>
<tr>
<td>5 +++++</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 +++++</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>15</td>
</tr>
<tr>
<td>7 +++++</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>26</td>
</tr>
<tr>
<td>8 +++++</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>86</td>
</tr>
<tr>
<td>9 +++++</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>10 +++++</td>
<td>1</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>12</td>
</tr>
<tr>
<td>11 +++++</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>34</td>
</tr>
<tr>
<td>12 +++++</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>56</td>
</tr>
<tr>
<td>13 +++++</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>-1</td>
<td>16</td>
</tr>
<tr>
<td>14 +++++</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>-1</td>
<td>6</td>
</tr>
<tr>
<td>15 +++++</td>
<td>-1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>37</td>
</tr>
<tr>
<td>16 +++++</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>52</td>
</tr>
<tr>
<td>17 +++++</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>25</td>
</tr>
<tr>
<td>18 6000000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>29</td>
</tr>
<tr>
<td>19 6000000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>24</td>
</tr>
<tr>
<td>20 6000000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>27</td>
</tr>
</tbody>
</table>

To proceed with the analysis, select Analyze > Fit Model and complete the Fit Model dialog as shown in Figure 8.2. After Hold Time was added to the model, it was selected and changed to a LogVariance effect through the Attributes popup menu. This also forced the fitting personality to change to Loglinear Variance. Click the Run button to start the fitting.
Displayed Output

The top portion of the resulting report shows the fitting of the Expected response, with reports similar to standard least squares, though actually derived from restricted maximum likelihood (REML).
The second portion of the report shows the fit of the variance model. The **Variance Parameter Estimates** report shows the estimates and relevant statistics. Two hidden columns are provided:

- The hidden column \( \exp(\text{Estimate}) \) is the exponential of the estimate. So, if the factors are coded to have +1 and -1 values, then the +1 level for a factor would have the variance multiplied by the \( \exp(\text{Estimate}) \) value and the -1 level would have the variance multiplied by the reciprocal of this column. To see a hidden column, right-click on the report and select the name of the column from the **Columns** menu that appears.

- The hidden column labeled \( \exp(2|\text{Estimate}|) \) is the ratio of the higher to the lower variance if the regressor has the range -1 to +1. The report also shows the standard error, chi-square, \( p \)-value, and profile likelihood confidence limits of each estimate. The residual parameter is the overall estimate of the variance, given all other regressors are zero.

Does the variance model fit significantly better than the original model? The likelihood ratio test for this question compares the fitted model with the model where all parameters are zero except the intercept, the model of equal-variance. In this case the \( p \)-value is highly significant. Changes in **Hold Time** change the variance.

The **Variance Effect Likelihood Ratio Tests** refit the model without each term in turn to create the likelihood ratio tests. These are generally more trusted than Wald tests.

### Platform Options

To access platform options, click on the red triangle menu next to Loglinear Variance Fit.

### Save Columns

Each of these commands creates one or more columns in the data table.

- **Prediction Formula** creates a new column, called *colname Mean*, containing the predicted values for the mean computed by the specified model.
Variance Formula creates a new column, called colname Variance, containing the predicted values for the variance computed by the specified model.

Std Dev Formula creates a new column, called colname Std Dev, containing the predicted values for the standard deviation computed by the specified model.

Residuals creates a new column called colname Residual containing the residuals, which are the observed response values minus predicted values.

Studentized Residuals creates a new column called colname Studentized Residual. The new column values are the residuals divided by their standard error.

Std Error of Predicted creates a new column, called Std Err Pred colname, containing the standard errors of the predicted values.

Std Error of Individual creates a new column, called Std Err Indiv colname, containing the standard errors of the individual predicted values.

Mean Confidence Interval creates two new columns, Lower 95% Mean colname and Upper 95% Mean colname that are the bounds for a confidence interval for the prediction mean.

Indiv Confidence Interval creates two new columns, Lower 95% Indiv colname and Upper 95% Indiv colname that are the bounds for a confidence interval for the prediction mean.

Row Diagnostics

Plot Actual by Predicted displays the observed values by the predicted values of $Y$. This is the leverage plot for the whole model.

Plot Studentized Residual by Predicted displays the Studentized residuals by the predicted values of $Y$.

Plot Studentized Residual by Row displays the Studentized residuals by row.

Profiler, Contour Profiler, and Surface Profiler are the standard JMP profilers, detailed in the “Standard Least Squares: Exploring the Prediction Equation” chapter.

Examining the Residuals

To see the dispersion effect, we invoked the Oneway platform on Shrinkage Residual (produced using the Save Columns > Residuals command) by Hold Time. With this plot it is easy to see the variance go up as Hold Time is increased. This is done by treating Hold Time as a nominal factor, though it is originally continuous in the fit above.
Profiling the Fitted Model

The **Profiler**, **Contour Profiler**, or **Surface Profiler** can be used to gain more insight on the fitted model. Each can be selected from the platform drop-down menu under the **Profilers** submenu. For example, suppose that the goal was to find the factor settings that achieved a target of 36.35 for the response, but at the smallest variance. Fit the models and choose Profiler from the report menu. For example, Figure 8.6 shows the Profiler set up to match a target value for a mean and to minimize variance.

One of the best ways to see the relationship between the mean and the variance (both modeled with the LogVariance personality) is through looking at the individual prediction confidence intervals about the mean. To see prediction intervals in the Profiler, select **Prediction Intervals** from its drop-down menu. Regular confidence intervals (those shown by default in the Profiler) do not show information about the variance model as well as individual prediction confidence intervals do. Prediction intervals show both the mean and variance model in one graph.

If \( Y \) is the modeled response, and you want a prediction interval for a new observation at \( x_n \), then

\[
\hat{\sigma}^2 \big|_{x_n} = \hat{\sigma}^2_y \big|_{x_n} + \hat{\sigma}^2_{\nu} \big|_{x_n}
\]

where

- \( \hat{\sigma}^2 \big|_{x_n} \) is the variance for the individual prediction at \( x_n \)
- \( \hat{\sigma}^2_y \big|_{x_n} \) is the variance of the distribution of \( Y \) at \( x_n \)
- \( \hat{\sigma}^2_{\nu} \big|_{x_n} \) is the variance of the sampling distribution of \( Y \), and is also the variance for the mean.

Because the variance of the individual prediction contains the variance of the distribution of \( Y \), the effects of the changing variance for \( Y \) can be seen. Not only are the individual prediction intervals wider, but they can change shape with a change in the variance effects. Figure 8.7 shows prediction intervals for the situation in Figure 8.6.
Figure 8.6 Profiler to Match Target and Minimize Variance

Figure 8.7 Prediction Intervals
Comments

Every time another parameter is estimated for the mean model, at least one more observation is needed, and preferably more. But with variance parameters, several more observations for each variance parameter are needed to obtain reasonable estimates. It takes more data to estimate variances than it does means.

The log-linear variance model is a very flexible way to fit dispersion effects, and the method deserves much more attention than it has received so far in the literature.
Chapter 9

Logistic Regression for Nominal and Ordinal Response

The Fit Model Platform

If the model response is nominal, the Fit Model platform fits a linear model to a multi-level logistic response function using maximum likelihood. Likelihood-ratio statistics and Lack of Fit tests are computed for the whole model. Likelihood-ratio tests and Wald tests can be computed for each effect in the model. Options include confidence limits and odds ratios for the maximum likelihood parameter estimates.

If the response variable is ordinal, the platform fits the cumulative response probabilities to the logistic distribution function of a linear model using maximum likelihood. Likelihood-ratio test statistics are provided for the whole model and lack of fit.

For simple main effects, you can use the Fit Y by X platform described in the Basic Analysis and Graphing book to see a cumulative logistic probability plot for each effect. Details for these models are discussed in the Basic Analysis and Graphing book, and in the appendix “Statistical Details,” p. 621.
Contents

Introduction to Logistic Models ................................. 167
The Statistical Report ............................................. 168
  Logistic Plot ..................................................... 169
  Iteration History ............................................... 170
  Whole Model Test ............................................... 170
  Lack of Fit Test (Goodness of Fit) .......................... 172
  Parameter Estimates ............................................ 173
  Likelihood-ratio Tests ......................................... 174
Platform Options ................................................... 174
  Plot Options ...................................................... 174
  Likelihood Ratio Tests ......................................... 174
  Wald Tests for Effects ......................................... 174
  Confidence Intervals ........................................... 175
  Odds Ratios (Nominal Responses Only) ..................... 175
  Inverse Prediction .............................................. 178
  Save Commands .................................................. 180
  ROC Curve ....................................................... 181
  Lift Curve ........................................................ 182
  Confusion Matrix ............................................... 183
  Profiler .......................................................... 183
Validation .......................................................... 183
  Nominal Logistic Model Example: The Detergent Data .... 183
  Ordinal Logistic Example: The Cheese Data .................. 187
  Quadratic Ordinal Logistic Example: Salt in Popcorn Data 193
  What to Do If Your Data Are Counts in Multiple Columns 195
Introduction to Logistic Models

Logistic regression fits nominal $Y$ responses to a linear model of $X$ terms. To be more precise, it fits probabilities for the response levels using a logistic function. For two response levels the function is

$$P(Y = r_1) = \left(1 + e^{-Xb}\right)^{-1}$$

where $r_1$ is the first response

or equivalently

$$\log \left( \frac{P(Y = r_1)}{P(Y = r_2)} \right) = Xb$$

where $r_1$ and $r_2$ are the two responses

For $r$ nominal responses, where $r > 2$, it fits $r - 1$ sets of linear model parameters of the form

$$\log \left( \frac{P(Y = j)}{P(Y = r)} \right) = X_j b$$

The fitting principal of maximum likelihood means that the $\beta$s are chosen to maximize the joint probability attributed by the model to the responses that did occur. This fitting principal is equivalent to minimizing the negative log-likelihood ($-\text{LogLikelihood}$)

$$\text{Loss} = -\text{logLikelihood} = -\log \left\{ \text{Prob} \left( \sum_{i=1}^{n} i\text{th row has the } y\text{th response} \right) \right\}$$

as attributed by the model.

As an example, consider an experiment that was performed on metal ingots prepared with different heating and soaking times. The ingots were then tested for readiness to roll. See Cox (1970). The Ingots.jmp data table in the Sample Data folder has the experimental results.
The categorical variable called ready has values 1 and 0 for readiness and not readiness to roll, respectively.

The Fit Model platform fits the probability of the not readiness (0) response to a logistic cumulative distribution function applied to the linear model with regressors heat and soak:

\[
\text{Probability (not ready to roll)} = \frac{1}{1 + e^{-(\beta_0 + \beta_1 \text{heat} + \beta_2 \text{soak})}}
\]

The parameters are estimated by minimizing the sum of the negative logs of the probabilities attributed to the observations by the model (maximum likelihood).

To analyze this model, select Analyze > Fit Model. The ready variable is Y, the response, and heat and soak are the model effects. The count column is the Freq variable. When you click Run, iterative calculations take place. When the fitting process converges, the nominal/ordinal regression report appears. The following sections discuss the report layout and statistical tables, and show examples.

The Statistical Report

Initially the logistic platform produces the reports shown here. Lack of fit tests show only if they are applicable and Likelihood-ratio tests are done by default; Wald Tests may be requested.
All tests compare the fit of the specified model with subset or superset models, as illustrated in Figure 9.1. If a test shows significance, then the higher order model is justified.

- Whole model tests: if the specified model is significantly better than a reduced model without any effects except the intercepts.
- Lack of Fit tests: if a saturated model is significantly better than the specified model.
- Effect tests: if the specified model is significantly better than a model without a given effect.

Figure 9.1 Relationship of Statistical Tables

Tests are a comparison of model fits

- Whole Model Test
- Wald Effect Tests
- Likelihood-ratio Effect Tests (default)
- Lack-of-Fit Test (Goodness of Fit $G^2$)

Logistic Plot

If your model contains a single continuous effect, then a logistic report similar to the one in Fit Y By X appears. See the Basic Analysis and Graphing book for an interpretation of these plots.
Iteration History

After launching Fit Model, an iterative estimation process begins and is reported iteration by iteration. After the fitting process completes, you can open the Iteration History report and see the iteration steps. If the fitting takes too long, you can cancel by pressing the Escape key (Esc-Period on the Macintosh) at any time. Otherwise the iteration process stops when either the log-likelihood doesn't change by more than a very small relative amount (Obj-Criterion), the parameter estimates don't change by a small relative amount (Delta-Criterion), or 15 iterations have been performed.

<table>
<thead>
<tr>
<th>Iter</th>
<th>Objective</th>
<th>Gradient</th>
<th>Norm Gradient</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>268.2479588</td>
<td>18.501468591</td>
<td>3506.4990148</td>
</tr>
<tr>
<td>1</td>
<td>756.294807072</td>
<td>8.140706087</td>
<td>727.00273343</td>
</tr>
<tr>
<td>2</td>
<td>53.360329197</td>
<td>2.9100640839</td>
<td>197.00411238</td>
</tr>
<tr>
<td>3</td>
<td>48.349885528</td>
<td>1.0822544601</td>
<td>51.053641722</td>
</tr>
<tr>
<td>4</td>
<td>47.69181265</td>
<td>0.193179067</td>
<td>8.4032263493</td>
</tr>
<tr>
<td>5</td>
<td>47.67282905</td>
<td>0.00575825247</td>
<td>0.3218031172</td>
</tr>
<tr>
<td>6</td>
<td>47.67280563</td>
<td>8.5934561e-6</td>
<td>0.0004112622</td>
</tr>
<tr>
<td>7</td>
<td>47.67280563</td>
<td>1.3898118e-11</td>
<td>8.618795e-10</td>
</tr>
</tbody>
</table>

Whole Model Test

The Whole Model table shows tests that compare the whole-model fit to the model that omits all the regressor effects except the intercept parameters. The test is analogous to the Analysis of Variance table for continuous responses. The negative log-likelihood corresponds to the sums of squares, and the Chi-square test corresponds to the \( F \)-test.
The Whole Model table shows these quantities:

- **Model** lists the model labels called **Difference** (difference between the Full model and the Reduced model), Full (model that includes the intercepts and all effects), and **Reduced** (the model that includes only the intercepts).

- **–LogLikelihood** records an associated negative log-likelihood for each of the models.

- **Difference** is the difference between the **Reduced** and Full models. It measures the significance of the regressors as a whole to the fit.

- **Full** describes the negative log-likelihood for the complete model.

- **Reduced** describes the negative log-likelihood that results from a model with only intercept parameters. For the ingot experiment, the **–LogLikelihood** for the reduced model that includes only the intercepts is 53.49.

- **DF** records an associated degrees of freedom (DF) for the Difference between the Full and Reduced model. For the ingots experiment, there are two parameters that represent different heating and soaking times, so there are 2 degrees of freedom.

- **Chi-Square** is the Likelihood-ratio Chi-square test for the hypothesis that all regression parameters are zero. It is computed by taking twice the difference in negative log-likelihoods between the fitted model and the reduced model that has only intercepts.

- **Prob>ChiSq** is the probability of obtaining a greater Chi-square value by chance alone if the specified model fits no better than the model that includes only intercepts.
**R² (U)** shows the ratio of the difference to the reduced negative log-likelihood values. It is sometimes referred to as $U$, the uncertainty coefficient. $R²$ ranges from zero for no improvement to 1 for a perfect fit. A Nominal model rarely has a high $R²$, and it has an $R²$ of 1 only when all the probabilities of the events that occur are 1.

$AICc$ is the corrected Akaike Information Criterion.

$BIC$ is the Bayesian Information Criterion.

Observations (or Sum Wgts) is the total number of observations in the sample.

**Measure** gives several measures of fit to assess model accuracy.

- **Entropy $R²$** compares the log-likelihoods from the fitted model and the constant probability model.
- **Generalized $R²$** is a generalization of the $R²$ measure that simplifies to the regular $R²$ for continuous normal responses. It is similar to the Entropy $R²$, but instead of using the log-likelihood, it uses the $2/n$ root of the likelihood.
- **Mean -Log p** is the average of $-\log(p)$, where $p$ is the fitted probability associated with the event that occurred.
- **RMSE** is the root mean square error, where the differences are between the response and $p$ (the fitted probability for the event that actually occurred).
- **Mean Abs Dev** is the average of the absolute values of the differences between the response and $p$ (the fitted probability for the event that actually occurred).
- **Misclassification Rate** is the rate for which the response category with the highest fitted probability is not the observed category.

For Entropy $R²$ and Generalized $R²$, values closer to 1 indicate a better fit. For Mean -Log $p$, RMSE, Mean Abs Dev, and Misclassification Rate, smaller values indicate a better fit.

After fitting the full model with two regressors in the ingots example, the $-\log$Likelihood on the Difference line shows a reduction to 5.82 from the Reduced $-\log$Likelihood of 53.49. The ratio of Difference to Reduced (the proportion of the uncertainty attributed to the fit) is 10.9% and is reported as the $R²$ (U).

To test that the regressors as a whole are significant (the Whole Model test), a Chi-square statistic is computed by taking twice the difference in negative log-likelihoods between the fitted model and the reduced model that has only intercepts. In the ingots example, this Chi-square value is $2 \times 5.82 = 11.64$, and is significant at 0.003.

**Lack of Fit Test (Goodness of Fit)**

The next questions that JMP addresses are whether there is enough information using the variables in the current model or whether more complex terms need to be added. The Lack of Fit test, sometimes called a Goodness of Fit test, provides this information. It calculates a pure-error negative log-likelihood by constructing categories for every combination of the regressor values in the data (Saturated line in the Lack Of Fit table), and it tests whether this log-likelihood is significantly better than the Fitted model.
The **Saturated** degrees of freedom is \( m-1 \), where \( m \) is the number of unique populations. The **Fitted** degrees of freedom is the number of parameters not including the intercept. For the *Ingots* example, these are 18 and 2 DF, respectively. The **Lack of Fit** DF is the difference between the Saturated and Fitted models, in this case \( 18 - 2 = 16 \).

The **Lack of Fit** table lists the negative log-likelihood for error due to **Lack of Fit**, error in a **Saturated** model (pure error), and the total error in the **Fitted** model. Chi-square statistics test for lack of fit.

In this example, the lack of fit Chi-square is not significant (\( \text{Prob}>\text{ChiSq} = 0.617 \)) and supports the conclusion that there is little to be gained by introducing additional variables, such as using polynomials or crossed terms.

**Parameter Estimates**

The **Parameter Estimates** report gives the parameter estimates, standard errors, and associated hypothesis test. The **Covariance of Estimates** report gives the variances and covariances of the parameter estimates.
Likelihood-ratio Tests

The Likelihood Ratio Tests command produces a table like the one shown here. The Likelihood-ratio Chi-square tests are calculated as twice the difference of the log-likelihoods between the full model and the model constrained by the hypothesis to be tested (the model without the effect). These tests can take time to do because each test requires a separate set of iterations.

This is the default test if the fit took less than ten seconds to complete.

Platform Options

The red triangle menu next to the analysis name gives you the additional options that are described next.

Plot Options

These options are described in the Basic Analysis and Graphing book.

Likelihood Ratio Tests


Wald Tests for Effects
Platform Options

One downside to likelihood ratio tests is that they involve refitting the whole model, which uses another series of iterations. Therefore, they could take a long time for big problems. The logistic fitting platform gives an optional test, which is more straightforward, serving the same function. The Wald Chi-square is a one-step linear approximation to the likelihood-ratio test, and it is a by-product of the calculations. Though Wald tests are considered less trustworthy, they do provide an adequate significance indicator for screening effects. Each parameter estimate and effect is shown with a Wald test. This is the default test if the fit takes more than ten seconds to complete.

Likelihood-ratio tests are the platform default and are discussed under “Likelihood-ratio Tests,” p. 174. We highly recommend using this default option.

Confidence Intervals

You can also request profile likelihood confidence intervals for the model parameters. When you select the Confidence Intervals command, a dialog prompts you to enter \( \alpha \) to compute the \( 1 - \alpha \) confidence intervals, or you can use the default of \( \alpha = 0.05 \). Each confidence limit requires a set of iterations in the model fit and can be expensive. Furthermore, the effort does not always succeed in finding limits.

<table>
<thead>
<tr>
<th>Parameter Estimates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Term</td>
</tr>
<tr>
<td>Intercept</td>
</tr>
<tr>
<td>heat</td>
</tr>
<tr>
<td>soak</td>
</tr>
</tbody>
</table>

Odds Ratios (Nominal Responses Only)

When you select Odds Ratios, a report appears showing Unit Odds Ratios and Range Odds Ratios, as shown in Figure 9.2.

Figure 9.2 Odds Ratios

<table>
<thead>
<tr>
<th>Odds Ratios</th>
</tr>
</thead>
<tbody>
<tr>
<td>For ready odds of 0 versus 1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unit Odds Ratios</th>
</tr>
</thead>
<tbody>
<tr>
<td>Term</td>
</tr>
<tr>
<td>heat</td>
</tr>
<tr>
<td>soak</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Range Odds Ratios</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per change in regressor over entire range</td>
</tr>
<tr>
<td>Term</td>
</tr>
<tr>
<td>heat</td>
</tr>
<tr>
<td>soak</td>
</tr>
</tbody>
</table>
From the introduction (for two response levels), we had

\[
\log \left( \frac{\text{Prob}(Y = r_1)}{\text{Prob}(Y = r_2)} \right) = Xb \text{ where } r_1 \text{ and } r_2 \text{ are the two response levels}
\]

so the odds ratio

\[
\frac{\text{Prob}(Y = r_1)}{\text{Prob}(Y = r_2)} = \exp(X\beta) = \exp(\beta_0) \cdot \exp(\beta_1X_1) \cdots \exp(\beta_iX_i)
\]

Note that \(\exp(\beta_0(X_i + 1)) = \exp(\beta_0X_i) \cdot \exp(\beta_0)\). This shows that if \(X_i\) changes by a unit amount, the odds is multiplied by \(\exp(\beta_0)\), which we label the unit odds ratio. As \(X_i\) changes over its whole range, the odds is multiplied by \(\exp((X_{\text{high}} - X_{\text{low}})\beta_i)\) which we label the range odds ratio. For binary responses, the log odds ratio for flipped response levels involves only changing the sign of the parameter, so you may want the reciprocal of the reported value to focus on the last response level instead of the first.

Two-level nominal effects are coded 1 and -1 for the first and second levels, so range odds ratios or their reciprocals would be of interest.

**Dose Response Example**

In the *Dose Response.jmp* sample data table, the dose varies between 1 and 12. Using Fit Model, we got the following report after requesting *Odds Ratio* from the platform drop-down menu.
The unit odds ratio for dose is 1.606 (which is $\exp(0.474)$) and indicates that the odds of getting a $Y = 0$ rather than $Y = 1$ improves by a factor of 1.606 for each increase of one unit of dose. The range odds ratio for dose is 183.8 ($\exp((12-1)*0.474)$) and indicates that the odds improve by a factor of 183.8 as dose is varied between 1 and 12.
Inverse Prediction

For a two-level response, the Inverse Prediction command finds the \( x \) value that results in a specified probability. For example, using the Ingots.jmp data, ignore the Soak variable, and fit the probability of ready by heat using the Fit Y by X command for a simple logistic regression (Count is Freq). The cumulative logistic probability plot shows the result.

Note that the fitted curve crosses the 0.9 probability level at a heat level of about 39.5, which is the inverse prediction. To be more precise and to get a fiducial confidence interval, you can use the Inverse Prediction command for Fit Y by X (see the Basic Analysis and Graphing book for more discussion of the Fit Y by X simple logistic analysis). When you specify exactly 0.9 in the Inverse Prediction dialog, the predicted value (inverse prediction) for heat is 39.8775, as shown in the table below.
However, if you have another regressor variable (Soak), you must use the Fit Model platform. Then the Inverse Prediction command displays the Inverse Prediction dialog shown in Figure 9.3, for requesting the probability of obtaining a given value for one independent variable. To complete the dialog, click and type values in the editable X and Probability columns. Enter a value for a single X (heat or soak) and the probabilities you want for the prediction. Set the remaining independent variable to missing by clicking in its X field and deleting. The missing regressor is the value that it will predict.
See the appendix “Statistical Details,” p. 621, for more details about inverse prediction.

Save Commands

If you have ordinal or nominal response models, the **Save Probability Formula** command creates new data table columns.

If the response is numeric and has the ordinal modeling type, the **Save Quantiles** and **Save Expected Values** commands are also available.

The **Save** commands create the following new columns:

- **Save Probability Formula** creates columns in the current data table that save formulas for linear combinations of the response levels, prediction formulas for the response levels, and a prediction formula giving the most likely response.

  For a nominal response model with $r$ levels, JMP creates

  - columns called $\text{Lin}[j]$ that contain a linear combination of the regressors for response levels $j = 1, 2, \ldots, r - 1$
  - a column called $\text{Prob}[r]$, with a formula for the fit to the last level, $r$
• columns called Prob[j] for j < r with a formula for the fit to level j
• a column called Most Likely responsename that picks the most likely level of each row based on the computed probabilities.

For an ordinal response model with r levels, JMP creates
• a column called Linear that contains the formula for a linear combination of the regressors without an intercept term
• columns called Cum[j], each with a formula for the cumulative probability that the response is less than or equal to level j, for levels j = 1, 2, ... r - 1. There is no Cum[j = 1, 2, ... r - 1] that is 1 for all rows
• columns called Prob[j = 1, 2, ... r - 1], for 1 < j < r, each with the formula for the probability that the response is level j. Prob[1] is Cum[1], and Prob[r] is 1–Cum[r-1].

• a column called Most Likely responsename that picks the most likely level of each row based on the computed probabilities.

Save Quantiles creates columns in the current data table named OrdQ.05, OrdQ.50, and OrdQ.95 that fit the quantiles for these three probabilities.

Save Expected Value creates a column in the current data table called Ord Expected that is the linear combination of the response values with the fitted response probabilities for each row and gives the expected value.

ROC Curve

Receiver Operating Characteristic (ROC) curves measure the sorting efficiency of the model’s fitted probabilities to sort the response levels. ROC curves can also aid in setting criterion points in diagnostic tests. The higher the curve from the diagonal, the better the fit. An introduction to ROC curves is found in the Basic Analysis and Graphing book. If the logistic fit has more than two response levels, it produces a generalized ROC curve (identical to the one in the Partition platform). In such a plot, there is a curve for each response level, which is the ROC curve of that level versus all other levels. Details on these ROC curves are found in "Graphs for Goodness of Fit," p. 318 in the "Recursive Partitioning" chapter.

Figure 9.4 shows the ROC Curve using the Ingots.jmp data table. Specify both heat and soak as model effects, count as Freq, and ready as Y.
Lift Curve

Produces a lift curve for the model. A lift curve shows the same information as an ROC curve, but in a way to dramatize the richness of the ordering at the beginning. The \( Y \)-axis shows the ratio of how rich that portion of the population is in the chosen response level compared to the rate of that response level as a whole. See “Lift Curves,” p. 321 in the “Recursive Partitioning” chapter for more details on lift curves.

Figure 9.5 shows the lift curve for the same model specified for the ROC curve (Figure 9.4).
Confusion Matrix

A confusion matrix is a two-way classification of the actual response levels and the predicted response levels. For a good model, predicted response levels should be the same as the actual response levels. The confusion matrix gives a way of assessing how the predicted responses aligns with the actual responses.

Profiler

Brings up the prediction profiler, showing the fitted values for a specified response probability as the values of the factors in the model are changed. This feature is available for both nominal and ordinal responses. For detailed information on profiling features, refer to the “Profiling” chapter.

Validation

Validation is the process of using part of a data set to estimate model parameters, and using the other part to assess the predictive ability of the model.

- The training set is the part that estimates model parameters.
- The validation set is the part that assesses or validates the predictive ability of the model.
- The test set is a final, independent assessment of the model’s predictive ability. The test set is available only when using a validation column.

The training, validation, and test sets are created by subsetting the original data into parts. This is done through the use of a validation column in the Fit Model launch window.

The validation column's values determine how the data is split, and what method is used for validation:

- If the column has two distinct values, then training and validation sets are created.
- If the column has three distinct values, then training, validation, and test sets are created.
- If the column has more than three distinct values, or only one, then no validation is performed.

When validation is used, model fit statistics are given for the training, validation, and test sets.

Nominal Logistic Model Example: The Detergent Data

A market research study was undertaken to evaluate preference for a brand of detergent (Ries and Smith 1963). The results are in the Detergent.jmp sample data table. The model is defined by

- the response variable, brand with values m and x
- an effect called softness (water softness) with values soft, medium, and hard
- an effect called previous use with values yes and no
- an effect called temperature with values high and low
- a count variable, count, which gives the frequency counts for each combination of effect categories.
The study begins by specifying the full three-factor factorial model as shown by the Fit Model dialog in Figure 9.6. To specify a factorial model, highlight the three main effects in the column selector list. Then select **Full Factorial** from the **Macros** popup menu.

The tables in Figure 9.7 show the three-factor model as a whole to be significant (**Prob>ChiSq = 0.0006**) in the Whole Model table. The Effect Likelihood Ratio Tests table shows that the effects which include **softness** do not contribute significantly to the model fit.
Next, use the Fit Model Dialog again to remove the softness factor and its interactions because they don’t appear to be significant. You can do this easily by double-clicking the softness factor in the Fit Model dialog. A dialog then appears asking if you want to remove the other factors that involve softness (click Yes). This leaves the two-factor factorial model in Figure 9.8.
The Whole Model Test table shows that the two-factor model fits as well as the three-factor model. In fact, the three-factor Whole Model table in Figure 9.9 shows a larger Chi-square value (32.83) than the Chi-square value for the two-factor model (27.17). This results from the change in degrees of freedom used to compute the Chi-square values and their probabilities.
The report shown in Figure 9.9 supports the conclusion that previous use of a detergent brand has a strong effect on detergent preference, and water temperature has a borderline significant effect, and the interaction between temperature and previous use is not significant statistically (temperature levels do not depend on previous use).

**Ordinal Logistic Example: The Cheese Data**

If the response variable has an ordinal modeling type, the platform fits the cumulative response probabilities to the logistic function of a linear model using maximum likelihood. Likelihood-ratio test statistics are provided for the whole model and lack of fit. Wald test statistics are provided for each effect.

If there is an ordinal response and a single continuous numeric effect, the ordinal logistic platform in Fit Y by X displays a cumulative logistic probability plot.
Logistic Regression for Nominal and Ordinal Response

Chapter 9

Ordinal Logistic Example: The Cheese Data


Note: If there are many response levels, the ordinal model is much faster to fit and uses less memory than the nominal model.

As an example of ordinal logistic model fitting, McCullagh and Nelder (1983) report an experiment by Newell to test whether various cheese additives (A to D) had an effect on taste. Taste was measured by a tasting panel and recorded on an ordinal scale from 1 (strong dislike) to 9 (excellent taste). The data are in the Cheese.jmp sample data table.

To run the model, assign Response as Y, Cheese as the effect, and Count as Freq.

The method in this example required only seven iterations to reduce the background –LogLikelihood of 429.9 to 355.67. This reduction yields a likelihood-ratio Chi-square for the whole model of 148.45 with 3 degrees of freedom, showing the difference in perceived cheese taste to be highly significant.
The Lack of Fit test happens to be testing the ordinal response model compared to the nominal model. This is because the model is saturated if the response is treated as nominal rather than ordinal, giving 21 additional parameters, which is the Lack of Fit degrees of freedom. The nonsignificance of Lack of Fit leads one to believe that the ordinal model is reasonable.

There are eight intercept parameters because there are nine response categories. There are only three structural parameters. As a nominal problem, there are $8 \times 3 = 24$ structural parameters.

When there is only one effect, its test is equivalent to the Likelihood-ratio test for the whole model. The Likelihood-ratio Chi-square is 148.45, different than the Wald Chi-square of 115.15, which illustrates the point that Wald tests are to be regarded with some skepticism.

**Note:** **Likelihood Ratio Tests** is a default table; **Wald Tests** must be checked as an additional option on the platform drop-down menu.

To see if a cheese additive is preferred, look for the most negative values of the parameters (Cheese D’s effect is the negative sum of the others, shown in Table 9.1.).

**Table 9.1** Parameter Estimates and Preferences for Cheese Additives in Cheese.jmp

<table>
<thead>
<tr>
<th>Cheese</th>
<th>Estimate</th>
<th>Preference</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>-0.8622</td>
<td>2nd place</td>
</tr>
<tr>
<td>B</td>
<td>2.4896</td>
<td>least liked</td>
</tr>
<tr>
<td>C</td>
<td>0.8477</td>
<td>3rd place</td>
</tr>
<tr>
<td>D</td>
<td>-2.4750</td>
<td>most liked</td>
</tr>
</tbody>
</table>

You can also use the Fit Y by X platform for this model, which treats ordinal responses like nominal and shows a contingency table analysis. See Figure 9.10. The Fit Model platform can be used, but you must set the ordinal response, **Response**, to nominal. Nominal Fit Model results are shown in Figure 9.11. The negative log-likelihood values (84.381) and the likelihood chi-square values (168.76) are the same.
Figure 9.10 Fit Y by X Platform Results for Cheese.jmp

Contingency Analysis of Response By Cheese

Mosaic Plot
Frequency Count

Contingency Table

Tests

<table>
<thead>
<tr>
<th>N</th>
<th>DF</th>
<th>-LogLikelihood</th>
<th>RSquare (U)</th>
</tr>
</thead>
<tbody>
<tr>
<td>208</td>
<td>24</td>
<td>84.381046</td>
<td>0.1983</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Test</th>
<th>ChiSquare</th>
<th>Prob&gt;ChiSq</th>
</tr>
</thead>
<tbody>
<tr>
<td>Likelihood Ratio</td>
<td>160.782</td>
<td>&lt;.0001*</td>
</tr>
<tr>
<td>Pearson</td>
<td>162.492</td>
<td>&lt;.0001*</td>
</tr>
</tbody>
</table>

Warning: 20% of cells have expected count less than 5, ChiSquare suspect.
If you want to see a graph of the response probabilities as a function of the parameter estimates for the four cheeses, you can create a new continuous variable (call it Score) with the formula from the Formula Editor shown in Figure 9.12.
Use the new variable as a response surface effect in the Fit Model dialog as shown. To create the model in Figure 9.13, select Score in the column selector list, and then select Response Surface from the Macros popup menu on the Fit Model dialog.

**Figure 9.13 Model Dialog For Ordinal Logistic Regression**

Click Run to see the analysis report and the cumulative logistic probability plot in Figure 9.14. The distance between each curve is the fitted response probability for the levels in the order for the levels on the right axis of the plot.
Quadratic Ordinal Logistic Example: Salt in Popcorn Data

The Ordinal Response Model can fit a quadratic surface to optimize the probabilities of the higher or lower responses. The arithmetic in terms of the structural parameters is the same as that for continuous responses. Up to five factors can be used, but this example has only one factor, for which there is a probability plot.

Consider the case of a microwave popcorn manufacturer who wants to find out how much salt consumers like in their popcorn. To do this, the manufacturer looks for the maximum probability of a favorable response as a function of how much salt is added to the popcorn package. An experiment controls salt amount at 0, 1, 2, and 3 teaspoons, and the respondents rate the taste on a scale of 1=low to 5=high. The optimum amount of salt is the amount that maximizes the probability of more favorable responses. The ten observations for each of the salt levels are shown in Table 9.2.

<table>
<thead>
<tr>
<th>Salt Amount</th>
<th>Salt Rating Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>no salt</td>
<td>1 3 2 4 2 1 4 3 4</td>
</tr>
<tr>
<td>1 tsp.</td>
<td>4 5 3 4 5 5 4 5 5</td>
</tr>
<tr>
<td>2 tsp.</td>
<td>4 3 5 1 4 2 5 4 3</td>
</tr>
<tr>
<td>3 tsp.</td>
<td>3 1 2 3 1 2 1 2 1</td>
</tr>
</tbody>
</table>
Use **Fit Model** with the *Salt in Popcorn.jmp* sample data to fit the ordinal taste test to the surface effect of salt. Use *Taste Test* as Y. Highlight *Salt* in the Select Columns box, and then select **Macros > Response Surface**.

The report shows how the quadratic model fits the response probabilities. The curves, instead of being shifted logistic curves, become a folded pile of curves where each curve achieves its optimum at the same point. The critical value is at \(\text{Mean}(X) - 0.5 \cdot b_1/b_2\) where \(b_1\) is the linear coefficient and \(b_2\) is the quadratic coefficient. This formula is for centered \(X\). From the Parameter Estimates table you can compute the optimum as \(1.5 - 0.5 \cdot (0.5637/1.3499) = 1.29\) teaspoons of salt.

---

**Figure 9.15** Ordinal Logistic Fit for Salt in Popcorn.jmp

![Ordinal Logistic Fit for Taste Test](image)
The distance between each curve measures the probability of each of the five response levels. The probability for the highest response level is the distance from the top curve to the top of the plot rectangle. This distance reaches a maximum when the amount of salt is about 1.3 teaspoons. All curves share the same critical point.

The parameter estimates for Salt and Salt*Salt become the coefficients used to find the critical value. Although it appears as a minimum, it is only a minimum with respect to the probability curves. It is really a maximum in the sense of maximizing the probability of the highest response. The Solution portion of the report is shown under Response Surface in Figure 9.15, where 1.29 is shown under Critical Value.

**What to Do If Your Data Are Counts in Multiple Columns**

Data that are frequencies (counts) listed in several columns of your data table are not the form you need for logistic regression. For example, the Ingots2.jmp data table in the data folder (see Figure 9.16) has columns Nready and NNotReady that give the number of ready and number of not ready ingots for each combination of Heat and Soak values. To do a logistic regression, you need the data organized like the table in Figure 9.16.

To make a new table, suitable for logistic regression, select the Stack command from the Tables menu. Complete the Stack dialog by choosing Nready and NNotReady as the columns to stack, and then click OK in the Stack dialog. This creates the new table to the right in Figure 9.16. If you use the default column names, Label is the response (Y) column and Data is the frequency column.

The example in the section “Introduction to Logistic Models,” p. 167, shows a logistic regression using a sample data table Ingots.jmp. It has a frequency column called count (equivalent to the Data column in the table below) and a response variable called Ready, with values 1 to represent ingots that are ready and 0 for not ready.

**Figure 9.16 Original Data Table**

<table>
<thead>
<tr>
<th>Heat</th>
<th>Soak</th>
<th>Nready</th>
<th>NNotReady</th>
<th>Nready</th>
<th>NTotal</th>
<th>P</th>
<th>Loss</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7</td>
<td>1</td>
<td>10</td>
<td>2</td>
<td>0.5000</td>
<td>6.0316</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>1.7</td>
<td>1.7</td>
<td>0.5000</td>
<td>11.7306</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>2.2</td>
<td>2.2</td>
<td>0.5000</td>
<td>4.6526</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>7</td>
<td>2.8</td>
<td>2.8</td>
<td>0.5000</td>
<td>3.3176</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>7</td>
<td>4</td>
<td>4</td>
<td>0.5000</td>
<td>6.2303</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>4</td>
<td>31</td>
<td>3.5</td>
<td>0.5000</td>
<td>21.4876</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td>1.7</td>
<td>1.7</td>
<td>0.5000</td>
<td>29.8050</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4</td>
<td>2.2</td>
<td>2.2</td>
<td>0.5000</td>
<td>22.6724</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>2.8</td>
<td>2.8</td>
<td>0.5000</td>
<td>21.4076</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>0.5000</td>
<td>13.1638</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>7</td>
<td>1</td>
<td>1.5</td>
<td>0.5000</td>
<td>38.8162</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>7</td>
<td>1.7</td>
<td>4</td>
<td>0.5000</td>
<td>38.4986</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>7</td>
<td>2.2</td>
<td>21</td>
<td>0.5000</td>
<td>14.5591</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>21</td>
<td>2.8</td>
<td>21</td>
<td>0.5000</td>
<td>12.2494</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Figure 9.17** Stacked Data Table

<table>
<thead>
<tr>
<th>Heat</th>
<th>Soak</th>
<th>Ntotal</th>
<th>P</th>
<th>Loss</th>
<th>Label</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7</td>
<td>1</td>
<td>10</td>
<td>0.5000</td>
<td>6.9315</td>
<td>Need</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>1</td>
<td>10</td>
<td>0.5000</td>
<td>6.9315</td>
<td>Need</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>1.7</td>
<td>17</td>
<td>0.5000</td>
<td>11.7335</td>
<td>Need</td>
</tr>
<tr>
<td>4</td>
<td>7</td>
<td>1.7</td>
<td>17</td>
<td>0.5000</td>
<td>11.7335</td>
<td>Need</td>
</tr>
<tr>
<td>5</td>
<td>7</td>
<td>2.2</td>
<td>7</td>
<td>0.5000</td>
<td>4.8520</td>
<td>Need</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>2.2</td>
<td>7</td>
<td>0.5000</td>
<td>4.8520</td>
<td>Need</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>2.8</td>
<td>12</td>
<td>0.5000</td>
<td>8.3778</td>
<td>Need</td>
</tr>
<tr>
<td>8</td>
<td>7</td>
<td>2.8</td>
<td>12</td>
<td>0.5000</td>
<td>8.3778</td>
<td>Need</td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>9</td>
<td>9</td>
<td>0.5000</td>
<td>6.2952</td>
<td>Need</td>
</tr>
<tr>
<td>10</td>
<td>7</td>
<td>4</td>
<td>9</td>
<td>0.5000</td>
<td>6.2952</td>
<td>Need</td>
</tr>
<tr>
<td>11</td>
<td>14</td>
<td>1</td>
<td>31</td>
<td>0.5000</td>
<td>21.4876</td>
<td>Need</td>
</tr>
<tr>
<td>12</td>
<td>14</td>
<td>1</td>
<td>31</td>
<td>0.5000</td>
<td>21.4876</td>
<td>Need</td>
</tr>
<tr>
<td>13</td>
<td>14</td>
<td>1.7</td>
<td>43</td>
<td>0.5000</td>
<td>29.8853</td>
<td>Need</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>1.7</td>
<td>43</td>
<td>0.5000</td>
<td>29.8853</td>
<td>Need</td>
</tr>
</tbody>
</table>
Generalized Linear Models provide a unified way to fit responses that don’t fit the usual requirements of least-squares fits. In particular, frequency counts, which are characterized as having a Poisson distribution indexed by a model, are easily fit by a Generalized Linear Model.

The technique, pioneered by Nelder and Wedderburn (1972), involves a set of iteratively reweighted least-squares fits of a transformed response.

Additional features of JMP’s Generalized Linear Model personality are

- likelihood ratio statistics for user-defined contrasts, that is, linear functions of the parameters, and $p$-values based on their asymptotic chi-square distributions
- estimated values, standard errors, and confidence limits for user-defined contrasts and least-squares means
- graphical profilers for examining the model
- confidence intervals for model parameters based on the profile likelihood function
- optional bias-corrected maximum likelihood estimator discussed by Firth (1993).
Contents

Generalized Linear Models ......................................................... 199
The Generalized Linear Model Personality .................................. 199
Examples of Generalized Linear Models ....................................... 200
  Model Selection and Deviance .................................................. 202
Examples ........................................................................... 203
  Poisson Regression ............................................................... 203
  Poisson Regression with Offset ................................................ 205
  Normal Regression, Log Link .................................................... 208
Platform Commands ............................................................... 211
Generalized Linear Models

While traditional linear models are used extensively in statistical data analysis, there are types of problems for which they are not appropriate.

- It may not be reasonable to assume that data are normally distributed. For example, the normal distribution (which is continuous) may not be adequate for modeling counts or measured proportions.
- If the mean of the data is naturally restricted to a range of values, the traditional linear model may not be appropriate, since the linear predictor can take on any value. For example, the mean of a measured proportion is between 0 and 1, but the linear predictor of the mean in a traditional linear model is not restricted to this range.
- It may not be realistic to assume that the variance of the data is constant for all observations. For example, it is not unusual to observe data where the variance increases with the mean of the data.

A generalized linear model extends the traditional linear model and is, therefore, applicable to a wider range of data analysis problems. See the section “Examples of Generalized Linear Models,” p. 200 for the form of a probability distribution from the exponential family of distributions.

As in the case of traditional linear models, fitted generalized linear models can be summarized through statistics such as parameter estimates, their standard errors, and goodness-of-fit statistics. You can also make statistical inference about the parameters using confidence intervals and hypothesis tests. However, specific inference procedures are usually based on asymptotic considerations, since exact distribution theory is not available or is not practical for all generalized linear models.

The Generalized Linear Model Personality

Generalized linear models are fit as a personality of the Fit Model Dialog. After selecting Analyze > Fit Model, select Generalized Linear Model from the drop-down menu before or after assigning the effects to the model.
When you specify that you are fitting a generalized linear model, the Fit Model dialog changes to allow you to select a Distribution and a Link Function. In addition, an Offset button, an option for overdispersion tests and intervals, and an option for Firth Bias-adjusted Estimates appears.

### Examples of Generalized Linear Models

You construct a generalized linear model by deciding on response and explanatory variables for your data and choosing an appropriate link function and response probability distribution. Explanatory variables can be any combination of continuous variables, classification variables, and interactions.

#### Table 10.1 Examples of Generalized Linear Models

<table>
<thead>
<tr>
<th>Model</th>
<th>Response Variable</th>
<th>Distribution</th>
<th>Canonical Link Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traditional Linear Model</td>
<td>continuous</td>
<td>Normal</td>
<td>identity, ( g(\mu) = \mu )</td>
</tr>
<tr>
<td>Logistic Regression</td>
<td>a count or a binary random variable</td>
<td>Binomial</td>
<td>logit, ( g(\mu) = \log\left(\frac{\mu}{1 - \mu}\right) )</td>
</tr>
</tbody>
</table>
JMP fits a generalized linear model to the data by maximum likelihood estimation of the parameter vector. There is, in general, no closed form solution for the maximum likelihood estimates of the parameters. JMP estimates the parameters of the model numerically through an iterative fitting process. The dispersion parameter $\phi$ is also estimated by dividing the Pearson goodness-of-fit statistic by its degrees of freedom. Covariances, standard errors, and confidence limits are computed for the estimated parameters based on the asymptotic normality of maximum likelihood estimators.

A number of link functions and probability distributions are available in JMP. The built-in link functions are:

- **identity**: $g(\mu) = \mu$
- **logit**: $g(\mu) = \log\left(\frac{\mu}{1-\mu}\right)$
- **probit**: $g(\mu) = \Phi^{-1}(\mu)$, where $\Phi$ is the standard normal cumulative distribution function
- **log**: $g(\mu) = \log(\mu)$
- **reciprocal**: $g(\mu) = \frac{1}{\mu}$
- **power**: $g(\mu) = \begin{cases} \mu^\lambda & \text{if } \lambda \neq 0 \\ \log(\mu) & \text{if } \lambda = 0 \end{cases}$
- **complementary log-log**: $g(m) = \log(-\log(1 - \mu))$

The available distributions and associated variance functions are:

- **normal**: $V(\mu) = 1$
- **binomial (proportion)**: $V(\mu) = \mu(1 - \mu)$
- **Poisson**: $V(\mu) = \mu$
- **Exponential**: $V(\mu) = \mu^2$

**Note:** When you select the **Binomial** distribution, a second Y variable specifying a binary response or the number of trials is required.

---

**Table 10.1 Examples of Generalized Linear Models (Continued)**

<table>
<thead>
<tr>
<th>Model</th>
<th>Response Variable</th>
<th>Distribution</th>
<th>Canonical Link Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poisson Regression in Log Linear Model</td>
<td>a count</td>
<td>Poisson</td>
<td>$\log \cdot g(\mu) = \log(\mu)$</td>
</tr>
<tr>
<td>Exponential Regression</td>
<td>positive continuous</td>
<td>Exponential</td>
<td>$\frac{1}{\mu}$</td>
</tr>
</tbody>
</table>
Model Selection and Deviance

An important aspect of generalized linear modeling is the selection of explanatory variables in the model. Changes in goodness-of-fit statistics are often used to evaluate the contribution of subsets of explanatory variables to a particular model. The deviance, defined to be twice the difference between the maximum attainable log likelihood and the log likelihood at the maximum likelihood estimates of the regression parameters, is often used as a measure of goodness of fit. The maximum attainable log likelihood is achieved with a model that has a parameter for every observation. The following table displays the deviance for each of the probability distributions available in JMP.

Table 10.2 Deviance Functions

<table>
<thead>
<tr>
<th>Distribution</th>
<th>Deviance</th>
</tr>
</thead>
<tbody>
<tr>
<td>normal</td>
<td>[ \sum_i w_i (y_i - \mu_i)^2 ]</td>
</tr>
<tr>
<td>Poisson</td>
<td>[ 2 \sum_i w_i \left[ y_i \log \left( \frac{y_i}{\mu_i} \right) - (y_i - \mu_i) \right] ]</td>
</tr>
<tr>
<td>binomial(^a)</td>
<td>[ 2 \sum_i w_i \left[ y_i \log \left( \frac{y_i}{\mu_i} \right) + (1 - y_i) \log \left( \frac{1 - y_i}{1 - \mu_i} \right) \right] ]</td>
</tr>
<tr>
<td>exponential</td>
<td>[ 2 \sum_i \left[ - \log \left( \frac{y_i}{\mu_i} \right) + \left( \frac{y_i - \mu_i}{\mu_i} \right) \right] ]</td>
</tr>
</tbody>
</table>

\(a\). In the binomial case, \(y_i = r_i \div m_i\), where \(r_i\) is a binomial count and \(m_i\) is the binomial number of trials parameter.

The Pearson chi-square statistic is defined as

\[ \chi^2 = \sum_i \frac{w_i (y_i - \mu_i)^2}{V(\mu_i)} \]

where \(y_i\) is the \(i^{th}\) response, \(\mu_i\) is the corresponding predicted mean, \(V(\mu_i)\) is the variance function, and \(w_i\) is a known weight for the \(i^{th}\) observation. If no weight is known, \(w_i = 1\) for all observations.

One strategy for variable selection is to fit a sequence of models, beginning with a simple model with only an intercept term, and then include one additional explanatory variable in each successive model. You can measure the importance of the additional explanatory variable by the difference in deviances or fitted log likelihoods between successive models. Asymptotic tests computed by JMP enable you to assess the statistical significance of the additional term.
Examples

The following examples illustrate how to use JMP's generalized linear models platform.

Poisson Regression

This example uses data from a study of nesting horseshoe crabs. Each female crab had a male crab resident in her nest. This study investigated whether there were other males, called satellites, residing nearby. The data set CrabSatellites.jmp contains a response variable listing the number of satellites, as well as variables describing the female crab's color, spine condition, weight, and carapace width. The data are shown in Figure 10.2.

Figure 10.2 Crab Satellite Data

To fit the Poisson loglinear model:

- Select Analyze > Fit Model
- Assign satell as Y
- Assign color, spine, width, and weight as Effects
- Choose the Generalized Linear Model Personality
- Choose the Poisson Distribution

The Log Link function should be selected for you automatically.

- Click Run.

The results are shown in Figure 10.3.
Figure 10.3 Crab Satellite Results

### Generalized Linear Model Fit
- Response: satell
- Distribution: Poisson
- Link: Log
- Estimation Method: Maximum Likelihood
- Observations: 173

#### Whole Model Test
<table>
<thead>
<tr>
<th>L-R</th>
<th>-2LogLikelihood</th>
<th>ChiSquare</th>
<th>DF</th>
<th>Prob&gt;ChiSq</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>452.44163</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reduced</td>
<td>404.34468</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Effect Tests
- Source: DF | ChiSquare | Prob>ChiSq
- color: 3 | 9.2403455 | 0.0266*
- spine: 2 | 1.798722  | 0.4076 |
- width: 1 | 0.118819  | 0.7324 |
- weight: 1 | 0.0430842 | 0.8026 |

#### Parameter Estimates
<table>
<thead>
<tr>
<th>Term</th>
<th>Estimate</th>
<th>Std Error</th>
<th>ChiSquare</th>
<th>Prob&gt;ChiSq</th>
<th>Lower CL</th>
<th>Upper CL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>-0.710104</td>
<td>0.659606</td>
<td>8.579157</td>
<td>0.4470</td>
<td>-1.97949</td>
<td>0.55929</td>
</tr>
<tr>
<td>color[Lit Med]</td>
<td>0.327594</td>
<td>0.133167</td>
<td>8.777306</td>
<td>0.0046*</td>
<td>0.063193</td>
<td>0.591659</td>
</tr>
<tr>
<td>color[Med]</td>
<td>0.0025929</td>
<td>0.0737287</td>
<td>7.220824</td>
<td>0.0091</td>
<td>-0.00891</td>
<td>0.209235</td>
</tr>
<tr>
<td>color[Dark]</td>
<td>-0.186351</td>
<td>0.0652747</td>
<td>3.080687</td>
<td>0.0691</td>
<td>-0.31874</td>
<td>0.04606</td>
</tr>
<tr>
<td>spine[Both]</td>
<td>0.0012069</td>
<td>0.0047146</td>
<td>0.041546</td>
<td>0.8342</td>
<td>-0.00939</td>
<td>0.011802</td>
</tr>
<tr>
<td>spine[One Worn</td>
<td>0.138912</td>
<td>0.131818</td>
<td>1.913356</td>
<td>0.1634</td>
<td>-0.16899</td>
<td>0.446816</td>
</tr>
<tr>
<td>width</td>
<td>0.0167487</td>
<td>0.0490197</td>
<td>0.118891</td>
<td>0.7324</td>
<td>-0.07091</td>
<td>0.111121</td>
</tr>
<tr>
<td>weight</td>
<td>0.0004965</td>
<td>0.0001663</td>
<td>0.043692</td>
<td>0.8026</td>
<td>0.000172</td>
<td>0.000324</td>
</tr>
</tbody>
</table>

#### Studentized Deviance Residual by Predicted

The Whole Model Test table gives information to compare the whole-model fit to the model that contains only the intercept parameter. The Reduced model is the model containing only an intercept. The Full model contains all of the effects as well as the intercept. The Difference is the difference of the log likelihoods of the full and reduced models. The Prob>ChiSq is analogous to a whole-model F-test.
Second, goodness-of-fit statistics are presented. Analogous to lack-of-fit tests, they test for adequacy of the model. Low p-values for the ChiSquare goodness-of-fit statistics indicate that you may need to add higher-order terms to the model, add more covariates, change the distribution, or (in Poisson and binomial cases especially) consider adding an overdispersion parameter. AICc is also included and is the corrected Akaike’s Information Criterion, where

$$AICc = -2\log\text{likelihood} + 2k + \frac{2k(k + 1)}{n - k - 1}$$

and k is the number of estimated parameters in the model and n is the number of observations in the data set. This value may be compared with other models to determine the best-fitting model for the data. The model having the smallest value, as discussed in Akaike (1974), is usually the preferred model.

The Effect Tests table shows joint tests that all the parameters for an individual effect are zero. If an effect has only one parameter, as with simple regressors, then the tests are no different from the tests in the Parameter Estimates table.

The Parameter Estimates table shows the estimates of the parameters in the model and a test for the hypothesis that each parameter is zero. Simple continuous regressors have only one parameter, as with simple regressors, then the tests are no different from the tests in the Parameter Estimates table.

The Effect Tests table shows joint tests that all the parameters for an individual effect are zero. If an effect has only one parameter, as with simple regressors, then the tests are no different from the tests in the Parameter Estimates table.

The Parameter Estimates table shows the estimates of the parameters in the model and a test for the hypothesis that each parameter is zero. Simple continuous regressors have only one parameter. Models with complex classification effects have a parameter for each anticipated degree of freedom. Confidence limits are also displayed.

### Poisson Regression with Offset

The sample data table *Ship Damage.JMP* is adapted from one found in McCullagh and Nelder (1983). It contains information on a certain type of damage caused by waves to the forward section of the hull. Hull construction engineers are interested in the risk of damage associated with three variables: ship Type, the year the ship was constructed (*Yr Made*) and the block of years the ship saw service (*Yr Used*).

In this analysis we use the variable *Service*, the log of the aggregate months of service, as an offset variable. An offset variable is one that is treated like a regression covariate whose parameter is fixed to be 1.0.

These are most often used to scale the modeling of the mean in Poisson regression situations with log link. In this example, we use log(months of service) since one would expect that the number of repairs be proportional to the number of months in service. To see how this works, assume the linear component of the GLM is called *eta*. Then with a log link function, the model of the mean with the offset included is:

$$\exp[\log(\text{months of service}) + \eta] = [(\text{months of service}) \times \exp(\eta)].$$

To run this example, assign

- **Generalized Linear Model** as the Personality
- **Poisson** as the Distribution, which automatically selects the **Log** link function
- **N to Y**
- **Service** to Offset
- **Type**, **Yr Made**, **Yr Used** as effects in the model
- **Overdispersion Tests and Intervals** with a check mark

The Fit Model dialog should appear like the one shown in Figure 10.4.
When you click Run, you see the report shown in Figure 10.5. Notice that all three effects (Type, Yr Made, Yr Used) are significant.
Figure 10.5 Ship Damage Report

### Generalized Linear Model Fit

**Offset:** None  
**Overdispersion parameter estimated by Pearson ChiSq/DF**  
**Response:** N  
**Distribution:** Poisson  
**Link:** Log  
**Estimation Method:** Maximum Likelihood  
**Observations (or Sum Wghts) = 34**

#### Whole Model Test

<table>
<thead>
<tr>
<th>Model</th>
<th>LogLikelihood</th>
<th>ChiSquare</th>
<th>DF</th>
<th>Prob&gt;ChiSq</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>49.3773439</td>
<td>63.6495</td>
<td>8</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Reduced</td>
<td>72.200727</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Goodness Of Fit Statistic

<table>
<thead>
<tr>
<th>Statistic</th>
<th>ChiSquare</th>
<th>DF</th>
<th>Prob&gt;ChiSq</th>
<th>Overdispersion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pearson</td>
<td>42.2789</td>
<td>25</td>
<td>0.0003*</td>
<td>1.0311</td>
</tr>
<tr>
<td>Deviance</td>
<td>30.9694</td>
<td>25</td>
<td>0.0385*</td>
<td></td>
</tr>
</tbody>
</table>

**AICc**  
110.3198

#### Effect Tests

<table>
<thead>
<tr>
<th>Source</th>
<th>DF</th>
<th>ChiSquare</th>
<th>Prob&gt;ChiSq</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>4</td>
<td>13.897527</td>
<td>0.0003*</td>
</tr>
<tr>
<td>Year Made</td>
<td>3</td>
<td>18.572694</td>
<td>0.0003*</td>
</tr>
<tr>
<td>Year Used</td>
<td>1</td>
<td>0.9844562</td>
<td>0.3120*</td>
</tr>
</tbody>
</table>

#### Parameter Estimates

<table>
<thead>
<tr>
<th>Term</th>
<th>Estimate</th>
<th>StdError</th>
<th>ChiSquare</th>
<th>Prob&gt;ChiSq</th>
<th>Lower CL</th>
<th>Upper CL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>-5.91765</td>
<td>0.127537</td>
<td>7753.533</td>
<td>&lt;.001*</td>
<td>-6.81907</td>
<td>-5.07299</td>
</tr>
<tr>
<td>Type[A]</td>
<td>0.1862341</td>
<td>0.0800927</td>
<td>3.901814</td>
<td>0.0503*</td>
<td>-0.11051</td>
<td>0.4829841</td>
</tr>
<tr>
<td>Type[B]</td>
<td>0.24712</td>
<td>0.145829</td>
<td>5.2940134</td>
<td>0.0214*</td>
<td>-0.026966</td>
<td>0.511206</td>
</tr>
<tr>
<td>Year Made[09]</td>
<td>-3.495184</td>
<td>0.3147564</td>
<td>22.805087</td>
<td>&lt;.001*</td>
<td>-4.34659</td>
<td>-2.64378</td>
</tr>
<tr>
<td>Year Used[09]</td>
<td>0.3206543</td>
<td>0.2782257</td>
<td>2.188383</td>
<td>0.14033</td>
<td>-0.12027</td>
<td>0.761577</td>
</tr>
<tr>
<td>Year Used[10]</td>
<td>0.2048998</td>
<td>0.1181249</td>
<td>2.9823877</td>
<td>0.0842</td>
<td>-0.027838</td>
<td>0.437037</td>
</tr>
<tr>
<td>Year Used[11]</td>
<td>0.3267171</td>
<td>0.1227565</td>
<td>3.649407</td>
<td>0.0566*</td>
<td>-0.04795</td>
<td>0.691487</td>
</tr>
<tr>
<td>Year Used[12]</td>
<td>0.4102342</td>
<td>0.0760131</td>
<td>3.394582</td>
<td>0.0120*</td>
<td>-0.343911</td>
<td>0.164044</td>
</tr>
</tbody>
</table>

#### Studentized Deviance Residual by Predicted

![Graph showing studentized deviance residuals against predicted values.](image)
Normal Regression, Log Link

Consider the following data set, where $x$ is an explanatory variable and $y$ is the response variable.

Using Fit Y By X, you can easily see that $y$ varies nonlinearly with $x$ and that the variance is approximately constant (see Figure 10.7). A normal distribution with a log link function is chosen to model these data; that is, $\log(\mu_i) = x_i'\beta$ so that $\mu_i = \exp(x_i'\beta)$. The completed Fit Model dialog is shown in Figure 10.8.
**Figure 10.7** Y by X Results for Nor.jmp

![Bivariate Fit of Y By X](image)

**Figure 10.8** Nor.jmp Fit Model Dialog

![Model Specification](image)
After clicking Run, you get the following report.

**Figure 10.9 Nor.jmp Results**

Because the distribution is normal, the Studentized Deviance residuals and the Deviance residuals are the same. To see this, select Diagnostic Plots > Deviance Residuals by Predicted from the platform drop-down menu.
Platform Commands

The following commands are available in the Generalized Linear Model report.

**Custom Test** allows you to test a custom hypothesis. Refer to “Custom Test,” p. 64 in the “Standard Least Squares: Perspectives on the Estimates” chapter for details on custom tests.

**Contrast** allows you to test for differences in levels within a variable. If a contrast involves a covariate, you can specify the value of the covariate at which to test the contrast.

In the Crab Satellite example, suppose you want to test whether the dark-colored crabs attracted a different number of satellites than the medium-colored crabs. Selecting **Contrast** brings up the following dialog.
Here you choose color, the variable of interest. When you click Go, you are presented with a Contrast Specification dialog.

To compare the dark-colored to the medium-colored, click the + button beside Dark and Dark Med, and the - button beside Medium and Light Medium.

Click Done to get the Contrast report shown here.
Since the Prob>Chisq is less than 0.05, we have evidence that there is a difference in satellite attraction based on color.

**Inverse Prediction** is used to predict an X value, given specific values for Y and the other X variables. This can be used to predict continuous variables only. For more details about Inverse Prediction, see “Inverse Prediction,” p. 66 in the “Standard Least Squares: Perspectives on the Estimates” chapter.

**Covariance of Estimates** produces a covariance matrix for all the effects in a model. The estimated covariance matrix of the parameter estimator is given by

\[ \Sigma = -H^{-1} \]

where \( H \) is the Hessian (or second derivative) matrix evaluated using the parameter estimates on the last iteration. Note that the dispersion parameter, whether estimated or specified, is incorporated into \( H \). Rows and columns corresponding to aliased parameters are not included in \( \Sigma \).

**Correlation of Estimates** produces a correlation matrix for all the effects in a model. The correlation matrix is the normalized covariance matrix. That is, if \( \sigma_{ij} \) is an element of \( \Sigma \), then the corresponding element of the correlation matrix is \( \sigma_{ij}/\sigma_i \sigma_j \), where \( \sigma_i = \sqrt{\sigma_{ii}} \).

**Profiler** brings up the Profiler for examining prediction traces for each X variable. Details on the profiler are found in “The Profiler,” p. 91 in the “Standard Least Squares: Exploring the Prediction Equation” chapter.

**Contour Profiler** brings up an interactive contour profiler. Details are found in “Contour Profiler,” p. 557 in the “Profiling” chapter.

**Surface Profiler** brings up a 3-D surface profiler. Details of Surface Plots are found in the “Plotting Surfaces” chapter.
Diagnostic Plots is a submenu containing commands that allow you to plot combinations of residuals, predicted values, and actual values to search for outliers and determine the adequacy of your model. Deviance is discussed above in “Model Selection and Deviance,” p. 202. The following plots are available:

- Studentized Deviance Residuals by Predicted
- Studentized Pearson Residuals by Predicted
- Deviance Residuals by Predicted
- Pearson Residuals By Predicted
- Actual by Predicted
- Regression Plot is available only when there is one continuous predictor and no more than one categorical predictor.
- Linear Predictor Plot is a plot of responses transformed by the inverse link function. This plot is available only when there is one continuous predictor and no more than one categorical predictor.

Save Columns is a submenu that lets you save certain quantities as new columns in the data table.

<table>
<thead>
<tr>
<th>Residual Type</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deviance</td>
<td>$r_{Di} = \sqrt{d_i \cdot \text{sign}(y_i - \mu_i)}$</td>
</tr>
<tr>
<td>Studentized Deviance</td>
<td>$r_{Di} = \frac{\text{sign}(y_i - \mu_i) \cdot \sqrt{d_i}}{\sqrt{\phi(1 - b_i)}}$</td>
</tr>
<tr>
<td>Pearson</td>
<td>$r_{Pi} = (y_i - \mu_i) \cdot \frac{\omega_i}{\sqrt{V(\mu_i)}}$</td>
</tr>
</tbody>
</table>
Table 10.3 Residual Formulas (Continued)

<table>
<thead>
<tr>
<th>Residual Type</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Studentized Pearson</td>
<td>$r_{Pi} = \frac{y_i - \mu_i}{\sqrt{\nu_i(1 - \hat{h}_i)}}$</td>
</tr>
</tbody>
</table>

where $(y_i - \mu)$ is the raw residual, $\text{sign}(y_i - \mu)$ is 1 if $(y_i - \mu)$ is positive and -1 if $(y_i - \mu)$ is negative, $d_i$ is the square root of the contribution to the total deviance from observation $i$, $\phi$ is the dispersion parameter, $V(\mu_i)$ is the variance function, $\nu_i$ is the variance of the $i^{th}$ individual observation, $\omega_i$ is a user-specified prior weight ($\omega_i = 1$ if the weight is not specified), and $\hat{h}_i$ is the $i^{th}$ diagonal element of the matrix $W_e^{-1/2}X(X'W_eX)^{-1}X'W_e^{1/2}$, where $W_e$ is the weight matrix used in computing the expected information matrix.

For additional information regarding residuals and generalized linear models, see “The GENMOD Procedure” in the SAS/STAT User Guide documentation.
The Screening platform helps select a model that fits a two-level screening design by indicating which factors have the largest effect on the response. An example of a screening report is shown in Figure 11.1.

Figure 11.1 Screening Platform Report

- **Term**
  - Catalyst: 18.2506
  - Temperature: 6.1256
  - Concentration: -3.1250
  - Feed Rate: -1.0000
  - Stir Rate: 3.0000
  - Catalyst×Temperature: 5.2506
  - Catalyst×Concentration: 9.6250
  - Temperature×Concentration: -4.7500
  - Catalyst×Feed Rate: 9.7500
  - Temperature×Feed Rate: -0.0000
  - Concentration×Feed Rate: 0.0000
  - Catalyst×Stir Rate: 0.0000
  - Temperature×Stir Rate: 0.1250
  - Concentration×Stir Rate: 1.1250
  - Feed Rate×Stir Rate: 0.0000

- **Contrast**
  - Length t-Ratio: 10.00
  - p-Value: 0.0036*

- **Individual**
  - Length t-Ratio: 6.53
  - p-Value: 0.0011*

- **Simultaneous**
  - Length t-Ratio: 6.093
  - p-Value: 0.0016*

- **Half Normal Plot**
  - Catalyst
  - Temperature
  - Catalyst×Temperature
  - Temperature×Concentration

- **Length PSE=0.005**
  - p-Value derived from a simulation of 10,000 Length t ratios.
  - Make Model → Run Model
Contents

The Screening Platform ................................................................. 219
  Using the Screening Platform .................................................... 219
  Comparing Screening and Fit Model ........................................... 219
Launch the Platform ........................................................................ 222
Report Elements and Commands .................................................. 222
  Contrasts .............................................................................. 222
  Half Normal Plot ................................................................... 223
  Launching a Model .................................................................. 223
Tips on Using the Platform ............................................................ 224
  Statistical Details ................................................................... 224
Analyzing a Plackett-Burman Design ........................................... 226
Analyzing a Supersaturated Design ............................................... 227
The Screening Platform

For two-level screening designs, the goal is to search for large effects. The screening platform looks for these big effects, helping you formulate a model for fitting the screening design.

Screening situations depend on effect sparsity, where most effects are assumed to be inactive. Using this assumption, the smaller estimates can be used to help estimate the error in the model and determine whether the larger effects are real. Basically, if all the effects are inactive, they should vary randomly, with no effect deviating substantially from the other effects.

Using the Screening Platform

If your data are all two-level and orthogonal, then all the statistics in this platform should work well.

If categorical terms have more than two levels, then the Screening platform is not appropriate for the design. JMP treats the level numbers as a continuous regressor. The variation across the factor is scattered across main and polynomial effects for that term.

For highly supersaturated main effect designs, the Screening platform is effective in selecting factors, but is not as effective at estimating the error or the significance. The Monte Carlo simulation to produce $p$-values uses assumptions that are valid for this case.

If your data are not orthogonal, then the constructed estimates are different from standard regression estimates. JMP can pick out big effects, but it does not effectively test each effect. This is because later effects are artificially orthogonalized, making earlier effects look more significant.

Note that the Screening platform is not appropriate for mixture designs.

Comparing Screening and Fit Model

Consider Reactor Half Fraction.jmp, from the Sample Data folder. The data are derived from a design in Box, Hunter, and Hunter (1978). We are interested in a model with main effects and two-way interactions. This example uses a model with fifteen parameters for a design with sixteen runs.

Figure 11.2 shows the result of using the Fit Model platform, where a factorial to degree 2 model is specified. This result illustrates why the Screening platform is needed.
JMP can calculate parameter estimates, but degrees of freedom for error, standard errors, \( t \)-ratios, and \( p \)-values are all missing. Rather than use Fit Model, it is better to use the Screening platform, which specializes in getting the most information out of these situations, leading to a better model. The output from the Screening platform for the same data is shown in Figure 11.3.

### Figure 11.2  Traditional Saturated Reactor Half Fraction.jmp Design Output

#### Response Percent Reacted

**Summary of Fit**

| Term                        | Estimate | Std Error | t Ratio | Prob>|t| |
|-----------------------------|----------|-----------|---------|------|
| Intercept                   | 65.25    |           |         |      |
| Feed Rate(10,15)            | -1       |           |         |      |
| Catalyst(1,2)               | 10.25    |           |         |      |
| Stir Rate(100,120)          | 0        |           |         |      |
| Temperature(140,180)        | 6.125    |           |         |      |
| Concentration(3,6)          | -3.125   |           |         |      |
| Feed Rate*Catalyst          | 0.75     |           |         |      |
| Feed Rate*Stir Rate         | 0.25     |           |         |      |
| Feed Rate*Temperature       | -0.375   |           |         |      |
| Feed Rate*Concentration     | 0.525    |           |         |      |
| Catalyst*Stir Rate          | 0.75     |           |         |      |
| Catalyst*Temperature        | 5.375    |           |         |      |
| Catalyst*Concentration      | 0.525    |           |         |      |
| Stir Rate*Temperature       | 0.125    |           |         |      |
Figure 11.3 Reactor Half Fraction.jmp Screening Design Report

Compare the following differences between the Fit Model report and the Screening report.

- Estimates labeled **Contrast**. Effects whose individual $p$-value is less than 0.1 are highlighted.
- A $t$-ratio is calculated using Lenth's PSE (pseudo-standard error). The PSE is shown below the Half Normal Plot.
- Both individual and simultaneous $p$-values are shown. Those that are less than 0.05 are shown with an asterisk.
- A Half Normal plot enables you to quickly examine the effects. Effects initially highlighted in the effects list are also labeled in this plot.
Launch the Platform

The Screening platform is launched via Analyze > Modeling > Screening. The completed launch window is shown in Figure 11.4. This window was used to produce the report in Figure 11.3.

For this example, all continuous factors, except the response factor, are selected as the screening effects, $X$. Percent Reacted is selected as the response $Y$. JMP constructs interactions automatically, unlike Fit Model, where the interactions are added distinctly.

Figure 11.4 Screening Platform Launch Window for Reactor Half Fraction.jmp

Report Elements and Commands

The following information is shown by default in the Screening platform report.

Contrasts

The Contrasts section shows the following columns.

- **Term** is the factor name.
- **Contrast** is the estimate for the factor. For orthogonal designs, this number is the same as the regression parameter estimate. This is not the case for non-orthogonal designs. An asterisk might appear next to the contrast, indicating lack of orthogonality.
- **Bar Chart** shows the $t$-ratios with blue lines marking a critical value at 0.05 significance.
Lenth t-Ratio is Lenth’s t-ratio, calculated as \( \frac{\text{Contrast}}{\text{PSE}} \), where PSE is Lenth’s Pseudo-Standard Error. See “Lenth’s Pseudo-Standard Error,” p. 225 for details.

Individual p-Value is analogous to the standard \( p \)-values for a linear model. Small values of this value indicate a significant effect. Refer to “Statistical Details,” p. 224 for details.

Simultaneous p-Value is used like the individual \( p \)-value, but is multiple-comparison adjusted.

Aliases appears only if there are exact aliases of later effects to earlier effects.

Half Normal Plot

The Half Normal Plot shows the absolute value of the contrasts against the normal quantiles for the absolute value normal distribution. Significant effects show as being separated from the line toward the upper right of the graph.

Note that this plot is interactive. Select different model effects by dragging a rectangle around the effects of interest. Alternatively, you can Control-click effect names in the report. The Half Normal Plot for Reactor Half Fraction.jmp is shown in Figure 11.5.

Figure 11.5 Half Normal Plot for Reactor Half Fraction.jmp

Launching a Model

The two buttons at the bottom of the plot construct a model using the currently selected effects.

- Make Model launches the Fit Model window populated with selected effects and responses.
- Run launches the Fit Model window, but also runs the model immediately.
Tips on Using the Platform

**Higher-Order Effects.** Control-click to select more or fewer effects. The effect selection is not constrained by hierarchy. For example, if $A*B$ is selected, check to make sure the lower-order effects (the $A$ and $B$ main effects) are also selected. Control-click to select them if they are not already selected.

**Re-running the Analysis.** Do not expect the $p$-values to be exactly the same if the analysis is re-run. The Monte Carlo method should give similar, but not identical, values if the same analysis is repeated.

**Statistical Details**

**Operation**

The Screening platform has a carefully defined order of operations.

- First, the main effect terms enter according to the absolute size of their contrast. All effects are orthogonalized to the effects preceding them in the model. The method assures that their order is the same as it would be in a forward stepwise regression. Ordering by main effects also helps in selecting preferred aliased terms later in the process.

- After main effects, all second-order interactions are brought in, followed by third-order interactions, and so on. The second-order interactions cross with all earlier terms before bringing in a new term. For example, with size-ordered main effects $A$, $B$, $C$, and $D$, $B*C$ enters before $A*D$. If a factor has more than two levels, square and higher-order polynomial terms are also considered.

- An effect that is an exact alias for an effect already in the model shows in the alias column. Effects that are a linear combination of several previous effects are not displayed. If there is partial aliasing (a lack of orthogonality) the effects involved are marked with an asterisk.

- The process continues until $n$ effects are obtained, where $n$ is the number of rows in the data table, thus fully saturating the model. If complete saturation is not possible with the factors, JMP generates random orthogonalized effects to absorb the rest of the variation. They are labeled Null $n$ where $n$ is a number. For example, this situation occurs if there are exact replicate rows in the design.
Chapter 11

Analyzing Screening Designs

Tips on Using the Platform

Lenth’s Pseudo-Standard Error

At this point, Lenth’s method (Lenth, 1989) identifies inactive effects from which it constructs an estimate of the residual standard error, known as the Lenth Pseudo Standard Error (PSE).

The value for Lenth’s PSE is shown at the bottom of the Screening report. From the PSE, \( t \)-ratios are obtained. To generate \( p \)-values, a Monte Carlo simulation of 10,000 runs of \( n-1 \) purely random values is created and Lenth \( t \)-ratios are produced from each set. The \( p \)-value is the interpolated fractional position among these values in descending order. The simultaneous \( p \)-value is the interpolation along the \( \max(|t|) \) of the \( n-1 \) values across the runs. This technique is similar to that in Ye and Hamada (2000).

If you want to run more or less than the 10,000 default runs, you must assign a value to a global JSL variable named LenthSimN. As an example, using the sample data Reactor Half Fraction.jmp:

1. Open the sample data, Reactor Half Fraction.jmp.
2. Select Analyze > Modeling > Screening.
3. Select Percent Reacted as the response variable, \( Y \).
4. Select all the other continuous variables as effects, \( X \).
5. Click OK.
6. Select Script > Save Script to Script Window from the red-triangle menu of the report.
7. Add LenthSimN=50000; to the top of the Script Window (above the code).
8. Highlight LenthSimN=50000; and the remaining code.
9. Run the script from the Script Window.

Note that if LenthSimN=0, the standard \( t \)-distribution is used (not recommended).

Screening as an Orthogonal Rotation

Mathematically, the Screening platform takes the \( n \) values in the response vector and rotates them into \( n \) new values. The rotated values are then mapped by the space of the factors and their interactions.

\[
\text{Contrasts} = T' \times \text{Responses}
\]

where \( T \) is an orthonormalized set of values starting with the intercept, main effects of factors, two-way interactions, three-way interactions, and so on, until \( n \) values have been obtained. Since the first column of \( T \) is an intercept, and all the other columns are orthogonal to it, these other columns are all contrasts, that is, they sum to zero. Since \( T \) is orthogonal, it can serve as \( X \) in a linear model. It does not need inversion, since \( T' \) is also \( T^{-1} \) and \( (T'T)^{-1} \). The contrasts are the parameters estimated in a linear model.

If no effect in the model is active after the intercept, the contrasts are just an orthogonal rotation of random independent variates into different random independent variates. These newly orthogonally rotated variates have the same variance as the original random independent variates. To the extent that some effects are active, the inactive effects still represent the same variation as the error in the model. The hope is that the effects and the design are strong enough to separate the active effects from the random error effects.
Plackett-Burman designs are an alternative to fractional-factorial screening designs. Two-level fractional factorial designs must, by their nature, have a number of runs that are a power of two. Plackett-Burman designs exist for 12-, 24-, and 28-run designs.

Weld-Repaired Castings.jmp from the Sample Data folder uses a Plackett-Burman design, and is found in textbooks such as Giesbrecht and Gumpertz (2004) and Box, Hunter, and Hunter (2005). Seven factors are thought to be influential on weld quality. The seven factors include Initial Structure, Bead Size, Pressure Treatment, Heat Treatment, Cooling Rate, Polish, and Final Treatment. A Plackett-Burman design with 12 runs is used to investigate the importance of the seven factors. The response is $100 \times \log(\text{lifetime})$. (There are also four terms that were used to model error that are not used in this analysis.)

Using the Screening platform, select the seven effects as $X$ and Log Life as $Y$. (If terms are automatically populated in the Screening Platform launch window, remove the four error terms listed as effects.) Click OK. Figure 11.6 appears, showing only a single significant effect.
Note asterisks mark four terms, indicating that they are not orthogonal to effects preceding them, and the obtained contrast value was after orthogonalization. So, they would not match corresponding regression estimates.

### Analyzing a Supersaturated Design

Supersaturated designs have more factors than runs. The objective is to determine which effects are active. They rely heavily on effect sparsity for their analysis, so the Screening platform is ideal for their analysis.

As an example, look at Supersaturated.jmp, from the Sample Data folder, a simulated data set with 18 factors but only 12 runs. Y is generated by

\[ Y = 2(X^7) + 5(X^{10}) - 3(X^{15}) + \varepsilon \]

where \( \varepsilon \sim N(0,1) \). So, \( Y \) has been constructed with three active factors.

To detect the active factors, run the Screening platform with \( X_1 - X_{18} \) as \( X \) and \( Y \) as \( Y \). The report shown in Figure 11.7 appears.

---

**Figure 11.7** Screening Report for Supersaturated.jmp

<table>
<thead>
<tr>
<th>Term</th>
<th>Contrast</th>
<th>Length t-Ratio</th>
<th>Individual p-Value</th>
<th>Simultaneous p-Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>X_9</td>
<td>5.12018</td>
<td>18.76</td>
<td>0.0004*</td>
<td>0.0612*</td>
</tr>
<tr>
<td>X_5</td>
<td>-3.48789</td>
<td>-11.34</td>
<td>0.0008*</td>
<td>0.0435*</td>
</tr>
<tr>
<td>X_7</td>
<td>-1.70569</td>
<td>6.42</td>
<td>0.0008*</td>
<td>0.0177*</td>
</tr>
<tr>
<td>X_8</td>
<td>-0.65701</td>
<td>-2.04</td>
<td>0.0484</td>
<td>0.3681</td>
</tr>
<tr>
<td>X_1</td>
<td>0.35381</td>
<td>1.20</td>
<td>0.1971</td>
<td>0.8452</td>
</tr>
<tr>
<td>X_4</td>
<td>-0.26032</td>
<td>1.03</td>
<td>0.3764</td>
<td>0.9702</td>
</tr>
<tr>
<td>X_3</td>
<td>-0.25482</td>
<td>-0.94</td>
<td>0.3184</td>
<td>0.8098</td>
</tr>
<tr>
<td>X_7</td>
<td>-0.10814</td>
<td>-0.40</td>
<td>0.7264</td>
<td>1.0000</td>
</tr>
<tr>
<td>X_8</td>
<td>-0.07050</td>
<td>-0.28</td>
<td>0.9702</td>
<td>1.0000</td>
</tr>
<tr>
<td>X_9</td>
<td>0.02080</td>
<td>0.10</td>
<td>0.9365</td>
<td>1.0000</td>
</tr>
<tr>
<td>X_2</td>
<td>0.00000</td>
<td>0.03</td>
<td>0.9365</td>
<td>1.0000</td>
</tr>
</tbody>
</table>

Lenth PVal=0.27342
P-Values derived from a simulation of 10000 Lenth ratios.
Supersaturated main effects bias makes p-values too small.
Analyzing Screening Designs
Analyzing a Supersaturated Design

Note that the three active factors have been highlighted. One other factor, $X_{18}$, has also been highlighted. It shows in the Half Normal plot close to the blue line, indicating that it is close to the 0.1 cutoff significance value. The 0.1 critical value is generous in its selection of factors so you don’t miss those that are possibly active.

The contrasts of 5.1, –3, and 1.8 are close to their simulated values (5, –3, 2). However, the similarity of these values can be increased by using a regression model, without the effect of orthogonalization.

The $p$-values, while useful, are not entirely valid statistically, since they are based on a simulation that assumes orthogonal designs, which is not the case for supersaturated designs.
Chapter 12

Nonlinear Regression
The Nonlinear Platform

The Nonlinear command fits models that are nonlinear in their parameters, using least-squares or a custom loss function. You do not need to use this platform if the model is nonlinear in the variables but linear in the parameters. Similarly, you can use the linear platforms if you can transform your model to be linear in the parameters.

Nonlinear models are more difficult to fit than linear models. They require more preparation with the specification of the model and initial guesses for parameter values. Iterative methods are used to search for the least-squares estimates, and there is no guarantee that a solution will be found. Indeed it is possible to diverge, or even to converge on a local solution that is not the least-squares solution. Nonlinear fits do not have some of the nice properties that linear models have, and the results must be interpreted with caution. For example, there is no well defined $R^2$ statistic; the standard errors of the estimates are approximations; and leverage plots are not provided.

Nonlinear fitting begins with a formula for the model that you build in a column using the formula editor or select using JMP’s built-in model library. The formula is specified with parameters to be estimated. After entering the formula, select the Nonlinear command and work with its interactive iteration Control Panel to do the fitting.

The platform itself is easy to use. The iterative techniques employed in JMP are variations of the Gauss-Newton method with a line search. This method employs derivatives of the model with respect to each parameter, but these derivatives are obtained automatically by the platform. The Newton-Raphson method is also available by requesting second derivatives. There are features for finding profile confidence limits of the parameters and for plotting the fitted function if the model is a function of just one column.

It is also possible to define special loss functions to use instead of least-squares. The loss function can be a function of the model, other variables, and parameters. When a custom loss function is defined, the platform minimizes the sum of the loss function across rows; thus, if you want maximum likelihood, specify something that sums to the negative of the log-likelihood as the loss.
Contents

The Nonlinear Fitting Process ......................................................... 231
A Simple Exponential Example ....................................................... 231
  Creating a Formula with Parameters ........................................... 231
  Launch the Nonlinear Platform .................................................. 232
  Drive the Iteration Control Panel ............................................. 233
Using the Model Library ............................................................... 235
  Customizing the Nonlinear Model Library ................................... 239
  Details for the Formula Editor .................................................. 239
Details of the Iteration Control Panel ........................................... 240
  Panel Buttons ........................................................................... 241
  The Current Parameter Estimates ............................................... 242
  Save Estimates ......................................................................... 242
  Confidence Limits ..................................................................... 242
  The Nonlinear Fit Popup Menu .................................................. 242
Details of Solution Results ............................................................ 248
  The Solution Table ................................................................... 248
  Excluded Points ....................................................................... 249
  Profile Confidence Limits ........................................................ 250
  Fitted Function Graph ................................................................ 251
Chemical Kinetics Example ............................................................ 252
How Custom Loss Functions Work .................................................. 253
Maximum Likelihood Example: Logistic Regression ......................... 255
Iteratively Reweighted Least Squares Example ................................ 257
Probit Model with Binomial Errors: Numerical Derivatives ................ 260
Poisson Loss Function ................................................................... 262
Notes Concerning Derivatives ....................................................... 264
Notes on Effective Nonlinear Modeling ........................................ 266
Notes Concerning Scripting .......................................................... 267
Nonlinear Modeling Templates ....................................................... 268
The Nonlinear Fitting Process

The Nonlinear command on the Analyze > Modeling submenu launches an interactive nonlinear fitting facility. You orchestrate the fitting process as a coordination of three important parts of JMP: the data table, the formula editor, and the Nonlinear platform.

- You define the column and its prediction formula with the formula editor. The formula is specified with parameters to be estimated. Use the formula editor to define parameters and give them initial values.
- Launch the Nonlinear platform with the response variable in the Y role and the model column with fitting formula in the Prediction Column. If no $Y$ column is given, then the Prediction Column formula is for residuals. If you have a loss column specified, then you might not need either a Prediction column or $Y$ column specification.
- Interact with the platform through the iteration Control Panel.

A Simple Exponential Example

The US Population.jmp table in the Nonlinear Examples of the Sample Data folder illustrates a simple nonlinear exponential model.

The pop (population) values are modeled as a nonlinear function of year. To see the nonlinear formula, highlight the X-formula column (which contains the model). Then select the Formula command in the Cols menu. The column formula editor appears with a formula that describes an exponential model for the growth of population in the U. S. between 1790 and 1990.

Creating a Formula with Parameters

When you fit a nonlinear formula to data, the first step is to create a column in the data table using the formula editor to build a prediction formula, which includes parameters to be estimated. The formula contains the parameters' initial values.

Begin in the formula editor by defining the parameters for the nonlinear formula. Select Parameters from the popup menu above the column selector list. The list changes from the column selector list to a parameter selector list. When New Parameter appears in the selector list, click on it and respond to the New Parameter definition dialog. Use this dialog to name the parameter and assign it an initial value. When you click OK, the new parameter name appears in the selector list. Continue this process to create additional parameters. The population example uses two parameters. You can now build the formula you need by using data table columns and parameters.

The parameter names are arbitrary and in this example were given initial values chosen as follows:

- $B_0$ is the prediction of population at year 1790, which should be near 3.93, the actual value of the first recorded population value in the data table. Therefore, 3.9 seems to be a reasonable initial value for $B_0$. 
• The B1 growth rate parameter is given the initial value of 0.022, which is close to the estimate of the slope you get when you fit the natural log of pop to year with a straight line (or Fit Special and specify ln transformation for pop). This initial value seems reasonable because the nonlinear exponential model can have similar final parameter estimates.

You can now build a formula using data table columns and parameters.

$$B0^* \exp(B1^* (year - 1790))$$

Enter the formula by clicking on column names, parameter names, operator keys, and function list items in the formula editor panel. Alternatively, double-click on the formula in the formula editor to change it into text-edit mode. The formula can be typed in as text.

See the JMP User Guide for information about building formulas.

Launch the Nonlinear Platform

When the formula is complete, choose Analyze > Modeling > Nonlinear and complete the Launch dialog as shown in Figure 12.1. Select the pop as Y, Response, and the column with the fitting formula (X-formula) as X, Predictor Formula.

The model formula (and formula for a loss function if there is one) appear in text form in the Formulas area at the bottom of the Nonlinear Launch dialog (see Figure 12.1).
A $Y$ variable is not needed if the fitting formula calculates residuals instead of predicted values or if there is a custom loss function. In some cases with loss functions, even the $X$, Predictor Formula column (the model) is not necessary.

**Note:** You can also select Weight, Freq, By, and Group columns. If the Weight column contains a formula, it is recalculated for each iteration. This also causes the column with the predicted value to update at each iteration. If you specify a Group variable, then when you do the plot, JMP overlays a curve for each value of the Group column. This assumes that the model is only a function of the Group column and one other continuous column.

The Expand Intermediate Formulas checkbox tells JMP that if an ingredient column to the formula is a column that itself has a formula, to substitute the inner formula, as long as it refers to other columns. To prevent an ingredient column from expanding, use the Other column property with a name of "Expand Formula” and a value of 0.

**Drive the Iteration Control Panel**

When you complete the Launch dialog, click OK to see the Iteration Control Panel. The Control Panel lets you tailor the nonlinear fitting process. The parameters’ initial values from the formula construction show in the Control Panel. Edit the Stop Limit fields if you need more or less accuracy for the converged solutions. If you edit the Current Values of the parameters, click Reset to set them for the next fit. Click Go to start the fitting iterations. You can watch the iterations progress in the Control Panel.

If the iterations do not converge, then try other parameter starting values; each time you click Reset and rerun the fit, the sum of squares error is recalculated, so it is easy to try many values. Sometimes locking some parameters and iterating on the rest can be helpful. If the model is a function of only one column, then use the sliders on the output Plot to visually modify the curve to fit better.

If the iterations converge, then a solution report appears and additional fields appear in the Control Panel, as shown in Figure 12.2. Click Confidence Limits, which now shows at the bottom of the Iteration Control Panel, to calculate profile-likelihood confidence intervals on the parameter estimates. These confidence limits show in the Solution table (see Figure 12.3). The confidence limit calculations involve a new set of iterations for each limit of each parameter, and the iterations often do not find the limits successfully.
When there is a single factor, the results include a graph of the response by the factor as shown in Figure 12.3. The solution estimates for the parameters are listed beneath the plot with sliders to alter the values and modify the fitted curve accordingly.

Click the **Confidence Limits** button to generate confidence intervals for the parameters.
Using the Model Library

The built-in model library is invoked by clicking the **Model Library** button on the Nonlinear launch dialog. Once it is invoked, a window called Nonlinear Model Library appears.
There are about 33 models included in this library. Users can select one of the models and click either *Show Graph* or *Make Formula*.

Click *Show Graph* to show a 2-D theoretical curve for one-parameter models and a 3-D surface plot for two-parameter models. No graph is available for models with more than two explanatory (X) variables. On the graph window, change the default initial values of parameters using the slider, or clicking and typing values in directly (see Figure 12.5).
Chapter 12
Nonlinear Regression

Using the Model Library

Figure 12.5 Example Graph in Model Library

The **Reset** button sets the initial values of parameters back to their default values.

Click **Show Points** to overlay the actual data points to the plot. The dialog in Figure 12.6 opens asking you to assign columns into X and Y roles, and an optional Group role. The Group role allows for fitting the model to every level of a categorical variable. If you specify a Group role here, also specify the Group column on the platform launch window (Figure 12.1).

Figure 12.6 Roles
The platform uses the actual data to estimate starting values for the parameters. Showing points allows you to adjust the parameter values to see how well the model fits for different values of the parameters. For the US population example, the points are shown in Figure 12.7.

Figure 12.7 Show Points

Clicking Make Formula at this point (after using Show Points) creates a new column in the data table which has the formula as a function of the latest parameter starting values.

**Note 1:** If you click Make Formula before using the Show Points button, you are asked to provide the X and Y roles, and an optional Group role (see Figure 12.6), and then are brought back to the plot so you have the opportunity to adjust the parameters starting values if desired. At that point click Make Formula again to create the new column.

**Note 2:** If you click Make Formula from the Nonlinear Model Library window (Figure 12.4) without using the Show Graph button, you are first asked to assign X and Y roles, and an optional Group role (see Figure 12.6). Then you are brought to the plot so you have the opportunity to adjust the parameters starting values. At that point click Make Formula again to create the new column.

Once the formula is created in the data table, continue the analysis by assigning the new column as the X, Predictor Formula in the Nonlinear launch dialog.

Many of the models in the model library are named Model A, Model B, etc., whose definitions are shown in Table 12.2 “Guide to Nonlinear Modeling Templates,” p. 268.
Customizing the Nonlinear Model Library

The Model Library is created by a built-in script named NonlinLib.jsl, located in the Builtin Scripts subdirectory of the folder that contains JMP (Windows and Linux) or the Application Package (Macintosh). You can customize the nonlinear library script by modifying this script.

To add a model, you must add three lines to the list named Listofmodellist#. These three lines are actually a list themselves which consists of the following three parts.

- Model name, a quoted string
- Model formula, an expression
- Model scale

For example, suppose you want to add a model called “Simple Exponential Growth” that has the form

$$y = b_1 e^{kx}$$

Add the following lines to the NonlinLib.jsl script

```javascript
{//Simple Exponential Growth
 "Simple Exponential Growth",
 Expr(Parameter({b1=2, k=0.5}, b1*exp(k * :X))),
 lowx = -1; highx = 2; lowy = 0; highy = 2},
```

Some things to note:

- The first line is simply an open bracket (starting the list) and an optional comment. The second line is the string that is displayed in the model library window.
- The values of lowx, highx, lowy, and highy specify the initial window for the theoretical graph.
- There is a comma as the last character in the example above. If this is the final entry in the Listofmodellist# list, the comma can be omitted.
- If the model uses more than two parameters, replace the last line (containing the graph limits) with the quoted string “String Not Available”.

To delete a model, delete the corresponding three-lined list from the Listofmodellist# list.

Details for the Formula Editor

In the formula editor, when you add a parameter, note the checkbox for Expand Into Categories, selecting column. This command is used to add several parameters (one for each level of a categorical variable for example) at once. When you select this option, a dialog appears that allows you to select a column. After selection, a new parameter appears in the Parameters list with the name D_column, where D is the name you gave the parameter. This is, in a sense, a macro that inserts a Match expression containing a separate parameter for each level of the selected column.

Once you decide where the list of parameters should be inserted in the formula, click the new parameter name to insert the group of parameters into the prediction formula.
Details of the Iteration Control Panel

The Nonlinear platform appears with the Iteration Control Panel shown in Figure 12.8. The initial Control Panel has these features:

- A processing messages area, which shows the progress of the fitting processing
- Editable parameter fields for starting values for the parameters. Click **Reset** after you edit these.
- Buttons to start (**Go**), stop (**Stop**), and step (**Step**) through the fitting process
- A **Reset** button to reset the editable values into the formula, reset the iteration values, and calculate the SSE at these new values.
- Initial values for convergence criteria and step counts
- A popup menu with fitting options to specify computational methods and save confidence limits. These popup menu items are described in the next section.

**Figure 12.8 Iteration Control Panel Before Fitting**

After the fitting process converges, controls appear at the bottom of the Control Panel that let you specify the alpha level and convergence criterion for computation of confidence limits and predictions (Figure 12.9). When you click **Confidence Limits**, the results appear in the Solution table as shown previously in Figure 12.3.
The next sections describe the features of the iteration Control Panel in more detail.

**Panel Buttons**

- **Go** starts an iterative fitting process. The process runs in the background so that you can do other things while it runs. If you want to re-run the model, you must first click the **Reset** button. A message in the status bar reminds you to do so if you click **Go** multiple times.

- **Stop** stops the iterative process. Because the platform only listens to events between steps, it might take a few seconds to get a response from **Stop**. Iterations can be restarted by clicking **Go** again.

- **Step** takes a single iteration in the process.

- **Reset** resets the iteration counts and convergence criteria, copies the editable values into the internal formulas, and then calculates the SSE for these new values. Use **Reset** if you want to:
  - take extra steps after the iterations have stopped. For example, extra steps are needed if you set the **Stop Limit** in order to solve for greater accuracy.
  - edit the parameter estimates to clear the previous fitting information and begin iterations using these new starting values.
  - calculate the SSE with the current parameter values.
The Current Parameter Estimates

The Control Panel also shows the Current Value of the parameter estimates and the SSE values as they compute. At the start, these are the initial values given in the formula. Later, they are values that result from the iterative process. The SSE is missing before iterations begin and is the first SSE displayed after the nonlinear fit.

If you want to change the parameter values and start or continue the fitting process, click and edit the parameters in the Current Value column of the parameter estimates. Then click Reset, followed by Go.

Note: Nonlinear makes its own copy of the column formula, so if you open the formula editor for the model column, the changes you make there will not affect an active Nonlinear platform. The parameter values are not stored back into the column formula until you click Save Estimates.

Save Estimates

After the nonlinear fitting is complete, the Save Estimates button appears on the Control Panel. When you click Save Estimates, the parameter estimates are stored into the column formula, causing the column to be recalculated by the data table. If you are using By-groups, this does not work because the formula is in the source table, instead of the By-groups.

Confidence Limits

The Confidence Limits button is available above the Solution Table after fitting. It computes confidence intervals for each parameter estimate. These intervals are profile-likelihood confidence limits, and each limit for each parameter involves a new set of iterations, so it can take a lot of time and result in missing values if the iterations fail to find solutions. The calculations do not run in the background but you can cancel them by typing the Escape key (Esc-period key on the Mac). See “The Solution Table,” p. 248, for details about confidence limits.

The Nonlinear Fit Popup Menu

The popup menu icon on the Nonlinear Fit title bar lets you tailor the fitting process, request additional information about the results, and save confidence limits as new columns in the current data table.

The following list describes each of the popup menu items:

Parameter Bounds

To set bounds on the parameters, select the Parameter Bounds option to reveal new editable fields next to the parameter values, into which you can enter lower and upper bounds to the parameters. Unbounded parameters are signified by leaving the field as a missing value (.

If you save a script, the bounds are saved in this manner:

Parameter Bounds(paramName(lower, upper)...)
**Plot**

If the prediction formula is a function of exactly one other continuous variable and you specify the response separately as the $Y$ variable, then **Plot** shows a plot of the function and the observed data (see Figure 12.3). If you specify a Group variable at launch, then a curve shows for each group. The initial estimates of the parameters show beneath the plot, with sliders to adjust the values. You can use these sliders to adjust the parameters for and obtain an empirical fit of the prediction function and use the resulting parameter estimates and starting values for the nonlinear fitting process.

**Iteration Options**

Iteration options let you specify options for the optimization algorithm.

- **Iteration Log** opens an additional window (named **Iteration Log**) and records each step of the fitting process. The iteration log lets you see parameter estimates at each step and the objective criterion as they change at each step during the fitting process.

- **Numeric Derivatives Only** is useful when you have a model that is too messy to take analytic derivatives for. It can also be valuable in obtaining convergence in tough cases.

- **Second Deriv Method** uses second derivatives as well as first derivatives in the iterative method to find a solution. With second derivatives, the method is called Newton-Raphson rather than Gauss-Newton. This method is only useful if the residuals are unusually large or if you specify a custom loss function and your model is not linear in its parameters.

  **Note:** You can also request the second derivative method with a check box on the launch dialog.

- **Newton** chooses whether Gauss-Newton (for regular least squares) or Newton-Raphson (for models with loss functions) as the optimization method.

- **QuasiNewton SR1** chooses QuasiNewton SR1 as the optimization method.

- **QuasiNewton BFGS** chooses QuasiNewton BFGS as the optimization method.

- **Accept Current Estimates** tells JMP to produce the solution report with the current estimates, even if the estimates did not converge.

- **Show Derivatives** shows the derivatives of the nonlinear formula in the JMP log. Use the **Log** command in the **View** or **Window** menu to see the JMP log if it is not currently open. See “Notes Concerning Derivatives,” p. 264, for technical information about derivatives.

- **Unthreaded** runs the iterations in the main computational thread. In most cases, JMP does the computations in a separate computational thread. This improves the responsiveness of JMP while doing other things during the nonlinear calculations. However, there are some isolated cases (models that have side effects that call display routines, for example) that should be run in the main thread, so this option should be turned on.

**Profiler**

The Profilers submenu brings up three facilities for viewing the prediction surface. Details on profiling are discussed in “Profiling Features in JMP,” p. 535.
Profiler brings up the JMP Profiler. The Profiler lets you view vertical slices of the surface across each x-variable in turn, as well as find optimal values of the factors. Details of the Profiler are discussed in “The Profiler,” p. 91 in the “Standard Least Squares: Exploring the Prediction Equation” chapter.

Contour Profiler brings up the JMP Contour Profiler. The Contour profiler lets you see two-dimensional contours as well as three dimensional mesh plots. Details of the Contour Profiler are discussed in “Contour Profiler,” p. 557 in the “Profiling” chapter.

Surface Profiler creates a three-dimensional surface plot. There must be two continuous factors for this facility to work. Details of surface plots are discussed in the “Plotting Surfaces” chapter.

Parameter Profiler brings up the JMP Profiler and profiles the SSE or loss as a function of the parameters. Details of the Profiler are discussed in “The Profiler,” p. 91 in the “Standard Least Squares: Exploring the Prediction Equation” chapter.

Parameter Contour Profiler brings up the JMP Contour Profiler and profiles the SSE or loss as a function of the parameters. Details of the Contour Profiler are discussed in “Contour Profiler,” p. 557 in the “Profiling” chapter.

Parameter Surface Profiler creates a three-dimensional surface plot and profiles the SSE or loss as a function of the parameters. Details of surface plots are discussed in the “Plotting Surfaces” chapter.

**SSE Grid**

To explore the sensitivity of the fit with respect to the parameter estimates, you can create a grid around the solution estimates and compute the error sum of squares for each value. The solution estimates should have the minimum SSE.

To create a grid table, use the **SSE Grid** command, which opens the Specify Grid for Output dialog, shown here. Edit the values in the dialog to customize the grid.

The Specify Grid for Output table shows these items:

- **Parameter** lists the parameters in the fitting model (B0 and B1 in the figure above).
- **Min** displays the minimum parameter value used in the grid calculations. By default, Min is the solution estimate minus 2.5 times the ApproxStdErr.
- **Max** displays the maximum parameter value used in the grid calculations. By default, Max is the solution estimate plus 2.5 times the ApproxStdErr.
**Number of Points** gives the number of points to create for each parameter. To calculate the total number of points in the new grid table, multiply all the **Number of Points** values. Initially **Number of Points** is 11 for the first two parameters and 3 for the rest. If you specify new values, use odd values to ensure that the grid table includes the solution estimates. Setting **Number of Points** to 0 for any parameter records only the solution estimate in the grid table.

When you click **Go**, JMP creates a new untitled table with grid coordinates, like the table shown in Figure 12.10. A highlighted X marks the solution estimate row if the solution is in the table. You can use the **Scatterplot 3D** command in the **Graph** menu to explore the SSE or likelihood surface.

---

**Figure 12.10** Data Table with Grid Coordinates

<table>
<thead>
<tr>
<th>Solution Estimate</th>
<th>57</th>
<th>16.052597631</th>
<th>0.013133915</th>
<th>131.147.779864</th>
</tr>
</thead>
<tbody>
<tr>
<td>58</td>
<td>16.052597631</td>
<td>0.6133975645</td>
<td>8582.69498669</td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>16.052597631</td>
<td>0.01891214</td>
<td>5249.98882323</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>16.052597631</td>
<td>0.619248555</td>
<td>3023.7918122</td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>16.052597631</td>
<td>0.014198513</td>
<td>2245.5741473</td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>16.052597631</td>
<td>0.6144521624</td>
<td>3.117.827888</td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>16.052597631</td>
<td>0.6174159119</td>
<td>5918.3829317</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>16.052597631</td>
<td>0.6159764614</td>
<td>10325.052748</td>
<td></td>
</tr>
</tbody>
</table>

---

**Revert to Original Parameters**

The **Revert to Original Parameters** command resets the Nonlinear platform to use the originally-specified parameters (**i.e.** the parameters that existed before any fitting).

**Remember Solution**

The **Remember Solution** command is used to stage a series of restricted estimates for use in constructing tests on the restrictions. This command is only used after you finish estimating for each model.

For example, suppose you want to test an unrestricted exponential model with a model where one parameter is constrained. First, set the parameter to its restricted value and check the **Lock** box for it. Then, click **Go** to obtain the restricted results. Click the **Remember Solution** command to remember this solution. Now, uncheck the lock and repeat the procedure, clicking **Reset**, then clicking **Go**, then **Remember Solution**. JMP then shows the fitting statistics for each solution, and a test comparing the solutions. Figure 12.11 shows an example using **US Population.jmp**, where the **b1** parameter is constrained to be 1 in the restricted model.
Custom Estimate

The **Custom Estimate** command lets you provide an expression involving only parameters. JMP calculates the expression using the current estimates, and also calculates a standard error of the expression using a first-order Taylor series approximation.

Custom Inverse Prediction

Given a $y$-value, the **Custom Inverse Prediction** command calculates the $x$-value yielding this $y$-value for the estimated model. It also calculates a standard error. JMP must be able to invert the model to obtain an inverse expression, and it can only do this if the model is a function of one variable mentioned one time in the expression. The standard error is based on the first-order Taylor series approximation using the inverted expression. The confidence interval uses a $t$-quantile with the standard error, and is a Wald interval.

Save Pred Confind Limits and Save Indiv Confind Limits

The **Save** options create new columns in the current data table called **LowerM**, **UpperM**, **LowerI**, and **UpperI** that contain the estimated lower- and upper-95% confidence limits computed using the asymptotic linear approximation. **Save Pred Confind Limits** saves confidence limits of the nonlinear fit, i.e. the expected or fitted response, which involves the variances in the estimates, but does not involve the variance of the error term itself. **Save Indiv Confind Limits** saves confidence limit values for the individual predicted values, which adds the variance of the error term to the variance of prediction involving the estimates, to form the interval.

Save Formulas

**Save Prediction Formula**  Creates a new column containing the prediction model as its formula, with all the parameters replaced by their estimates. The values produced will be the same as in the Model column after you click the Save Estimates button. The resulting column will be called “Fitted name” where “name” is the name of the column specifying the model.
Save Std Error of Predicted  Creates a new column containing the formula for the standard error of the prediction, with all the parameters replaced by their estimates. This standard error accounts for all the uncertainty in the parameter estimates, but does not add the uncertainty in predicting individual Y's. The resulting column will be called StdError Fitted name where name is the name of the column specifying the model. The formula is of the form 
\[ \text{Sqrt(VecQuadratic(matrix1, vector1))} \] where matrix1 is the covariance matrix associated with the parameter estimates, and vector1 is a composition of the partial derivatives of the model with respect to each parameter.

Save Std Error of Individual  Creates a new column containing the formula for the standard error of the individual value, with all the parameters replaced by their estimates. This standard error accounts for the uncertainty in both the parameter estimates and in the error for the model. The resulting column will be called StdError Indiv name where name is the name of the column specifying the model. The formula is of the form 
\[ \text{Sqrt(VecQuadratic(matrix1, vector1)+mse)} \] where matrix1 is the covariance matrix associated with the parameter estimates, vector1 is a composition of the partial derivatives of the model with respect to each parameter, and mse is the estimate of error variance.

Save Residual Formula  Creates a column containing a formula to calculate the residuals from the current model. The new column is named Residuals name where name is the name of the column specifying the model.

Save Inverse Prediction Formula  Creates a column containing a formula to predict the x value given the y value. The resulting column is called InvPred name where name is the name of the predicted column. Two additional columns are created with formulas for the standard error of prediction and the standard error of individual, named StdError InvPred name and StdErrIndiv InvPred name respectively.

The internal implementation of this uses the same routine as the JSL operator InvertExpr, and has the same limitations, that the expression contain invertible expressions only for the expression path leading to the inversion target, that the target be in the formula only once, and that it use favorable assumptions to limit functions to an invertible region.

Save Specific Solving Formula  is, in simple cases, equivalent to Save Inverse Prediction Formula. However, this command allows the formula to be a function of several variables and allows expressions to be substituted. This feature only works for solving easily invertible operators and functions that occur just once in the formula.

After selecting this command, a dialog appears that allows you to select the variable to solve for. Here, you can also edit the names of the columns in the resulting table.
You can also substitute values for the names in the dialog. In these cases, the formula is solved for those values.

**Note:** The standard errors, confidence intervals, and hypothesis tests are correct only if the loss function used is a proper negative log likelihood.

**Show Prediction Expression**

The **Show Prediction Expression** command toggles the display of the fitting expression at the top of the report.

**Details of Solution Results**

When you click **Go** on the iteration Control Panel, the fitting process begins. The iterations run in the background until the method either converges or fails to converge. During fitting, process messages on the Control Panel monitor the iterative process. When the iteration process completes, these messages show whether the convergence criteria are met.

If the convergence criteria are met, reports are appended to the iteration Control Panel. The **Solution table** and **Correlation of Estimates** table always appear. The graph of the fitted function is available only if the prediction formula is a function of one other variable (see Figure 12.3).

**The Solution Table**

When the iterations are complete, the results display in the Solution table.

- **SSE** shows the residual sum of squares error. SSE is the objective that is to be minimized. If a custom loss function is specified, this is the sum of the loss function.
- **DFE** is the degrees of freedom for error, which is the number of observations used minus the number of parameters fitted.
- **MSE** shows the mean squared error. It is the estimate of the variance of the residual error, which is the SSE divided by the DFE.
- **RMSE** estimates the standard deviation of the residual error, which is square root of the MSE described above.
- **Parameter** lists the names that you gave the parameters in the fitting formula.
**Nonlinear Regression**

**Details of Solution Results**

- **Estimate**: lists the parameter estimates produced. Keep in mind that with nonlinear regression, there may be problems with this estimate even if everything seems to work.

- **ApproxStdErr**: lists the approximate standard error, which is computed analogously to linear regression. It is formed by the product of the RMSE and the square root of the diagonals of the derivative cross-products matrix inverse.

- **Lower CL and Upper CL**: are the lower and upper 100(1 – \(\alpha\)) percent confidence limits for the parameters. They are missing until you click the **Confidence Limits** on the Control Panel. The upper and lower confidence limits are based on a search for the value of each parameter after minimizing with respect to the other parameters, that produces a SSE greater by a certain amount than the solution's minimum SSE. The goal of this difference is based on the \(F\)-distribution. The intervals are sometimes called *likelihood confidence intervals* or *profile likelihood confidence intervals* (Bates and Watts 1988; Ratkowsky 1990).

**Excluded Points**

Sometimes, data is held back as a set for cross-validation of the results. The Nonlinear platform now calculates statistics of fit for excluded data. You can use this feature in conjunction with **Remember Solution** to change the exclusions, and get a new report reflecting the different exclusions.

For example, the following report uses *US Population.jmp*. Ten percent of the data points were excluded, then a nonlinear fit was run. This solution was remembered as “First Excluded”, then another ten percent of the data points were excluded. This solution was remembered as “Second Excluded”. The numbers in your report might differ from those in Figure 12.12.
Profile confidence limits all start with a goal $SSE$, which is a sum of squared errors (or sum of loss function) that an F-test considers significantly different from the solution $SSE$ at the given alpha level. If the loss function is specified to be a negative log-likelihood, then a Chi-square quantile is used instead of an $F$ quantile. For each parameter's upper confidence limit, the parameter value is moved up until the $SSE$ reaches the goal $SSE$, but as the parameter value is moved up, all the other parameters are adjusted to be least squares estimates subject to the change in the profiled parameter. Conceptually, this is a compounded set of nested iterations, but internally there is a way to do this with one set of iterations developed by Johnston and DeLong (see SAS/Stat 9.1 vol. 3 pp. 1666-1667).
The diagram in Figure 12.13, shows the contour of the goal SSE or negative likelihood, with the least squares (or least loss) solution inside the shaded region:

- The asymptotic standard errors produce confidence intervals that approximate the region with an ellipsoid and take the parameter values at the extremes (at the horizontal and vertical tangents).
- Profile confidence limits find the parameter values at the extremes of the true region, rather than the approximating ellipsoid.

Likelihood confidence intervals are more trustworthy than confidence intervals calculated from approximate standard errors. If a particular limit cannot be found, computations begin for the next limit. When you have difficulty obtaining convergence, try the following:

- use a larger alpha, resulting in a shorter interval, more likely to be better behaved
- use the option for second derivatives
- relax the confidence limit criteria.

**Fitted Function Graph**

If the prediction formula is a function of exactly one other variable and you specify the response separately as the $Y$ variable, then the Plot disclosure button displays a plot of the function and the observed data as shown here.

The sliders to the right of the estimates beneath the graph can be used to experiment with the parameter values and observe the effect on the curve. As you change parameter values, the graph changes accordingly.
Chemical Kinetics Example

In pharmacology, the relationship between the concentration of an available dissolved organic substrate and the rate of uptake of the substrate is often modeled by the Michaelis-Menten equation, of the form

\[ Y = \frac{V_{\text{max}} x}{K + x} \]

where \( Y \) is the velocity of uptake and \( x \) is the concentration. The parameters \( V_{\text{max}} \) and \( K \) estimate the maximum velocity and transport constant, respectively. The Chemical Kinetics.jmp data table (found in the Nonlinear Examples folder of the sample data) records the uptake velocity of a glucose-type substrate in an incubated sediment sample. The data table stores the Michaelis-Menten model with starting parameter values of \( V_{\text{max}}=0.04 \) and \( K=0.1 \).

1. Select **Nonlinear** from the **Analyze > Modeling** menu and assign **Model (x)** as the **X, Predictor Formula** and **Velocity (y)** as **Y, Response**. Click **OK** and when the Control Panel appears. The Plot shows the model at the current starting values.

2. Next, adjust the **Low** and **High** values of the \( k \) slider to be -2 to 2. Use the slider to change the value of \( k \) slightly, so you can get a better starting fit.

3. Click **Go** to continue the iteration steps until convergence.

Figure 12.14 illustrates the fitting process described above.
Chapter 12

Nonlinear Regression

How Custom Loss Functions Work

Figure 12.14 Example of Plot Option to Observe Nonlinear Fitting Process

The **SSE Grid** option in the Nonlinear Fit popup menu helps you investigate the error sum of squares around the parameter estimates. After you select the **SSE Grid** option, click **Go** in the Specify Grid for Output report to create a new table that gives the SSE for each combination of the parameters. In the data table, a highlighted x marks the solution that the nonlinear platform found. Alternatively, you can view the SSE surface using the Surface Plot platform.

**How Custom Loss Functions Work**

The nonlinear facility can minimize or maximize functions other than the default sum of squares residual. This section shows the mathematics of how it is done.
Suppose that \( f(\beta) \) is the model. Then the Nonlinear platform attempts to minimize the sum of the loss functions written as

\[
L = \sum_{i=1}^{n} \rho(f(\beta))
\]

The loss function \( \rho(\bullet) \) for each row can be a function of other variables in the data table. It must have non-zero first- and second-order derivatives. The default \( \rho(\bullet) \) function, squared-residuals, is

\[
\rho(f(\beta)) = (y - f(\beta))^2
\]

To specify a model with a custom loss function, construct a variable in the data table and build the loss function. After launching the Nonlinear platform, select the column containing the loss function as the loss variable.

The nonlinear minimization formula works by taking the first two derivatives of \( \rho(\bullet) \) with respect to the model, and forming the gradient and an approximate Hessian as follows:

\[
L = \sum_{i=1}^{n} \rho(f(\beta))
\]

\[
\frac{\partial L}{\partial \beta_j} = \sum_{i=1}^{n} \frac{\partial \rho(f(\beta))}{\partial f} \frac{\partial f}{\partial \beta_j}
\]

\[
\frac{\partial^2 L}{\partial \beta_j \partial \beta_k} = \sum_{i=1}^{n} \left[ \frac{\partial^2 \rho(f(\beta))}{(\partial f)^2} \frac{\partial f}{\partial \beta_j} \frac{\partial f}{\partial \beta_k} + \frac{\partial \rho(f(\beta))}{\partial f} \frac{\partial^2 f}{\partial \beta_j \partial \beta_k} \right]
\]

If \( f(\bullet) \) is linear in the parameters, the second term in the last equation is zero. If not, you can still hope that its sum is small relative to the first term, and use

\[
\frac{\partial^2 L}{\partial \beta_j \partial \beta_k} = \sum_{i=1}^{n} \frac{\partial^2 \rho(f(\beta))}{(\partial f)^2} \frac{\partial f}{\partial \beta_j} \frac{\partial f}{\partial \beta_k}
\]

The second term will probably be small if \( \rho \) is the squared residual because the sum of residuals is small—zero if there is an intercept term. For least squares, this is the term that distinguishes Gauss-Newton from Newton-Raphson. In JMP, the second term is calculated only if the option **Second Deriv. Method** is checked.

**Note:** The resulting model standard errors, confidence intervals, and hypothesis tests are correct only if the loss function used is a proper negative log likelihood.
Parameters in the Loss Function

You can use parameters in loss functions but they might not be the same as the parameters in the model. JMP uses first and second derivatives for these parameters, which means it takes full Newton-Raphson steps for these parameters.

Maximum Likelihood Example: Logistic Regression

In this example, we show several variations of minimizing a loss function, in which the loss function is the negative of a log-likelihood function, thus producing maximum likelihood estimates.

The Logistic w Loss.jmp data table in the Nonlinear Examples sample data folder has an example for fitting a logistic regression using a loss function. The Y column is the proportion of responses (proportion number of 1s) for equal-sized samples of x values. The Model Y column has the linear model formula. However, the Loss column has the nonlinear formula shown below. It is the negative log-likelihood for each observation, which is the negative log of the probability of getting the response that you did get.

Model Y

\[ b_0 + b_1 x \]

Loss

\[
\begin{align*}
Y = 1 & \rightarrow \log \left( \frac{1}{1 + \exp(-Model\ Y)} \right) \\
\text{else} & \rightarrow \log \left( 1 - \frac{1}{1 + \exp(-Model\ Y)} \right)
\end{align*}
\]

To run the model, choose Analyze > Modeling > Nonlinear and complete the Launch dialog by using Model Y as the X, Predictor Formula, and Loss as the Loss function. Click OK to see the Iteration Control Panel. The initial values of zero (or 1e-100, very close to zero) for the parameters \( b_0 \) and \( b_1 \) are satisfactory.

Click Go to run the model. The results show in the Solution table with the negative log-likelihood as the Loss.
Maximum Likelihood Example: Logistic Regression

The same problem can be handled differently by defining a model column formula that absorbs the logistic function and a loss function that uses the model to form the probability for a categorical response level. Model 2 Y holds the model. The loss function is Loss2.

Model 2 Y

\[
\frac{1}{1 + \exp(b_0 + b_1 \cdot X)}
\]

Loss2

- If\( Y = 1 \):
  \[ \log \left( \frac{\text{Model } 2 \ Y}{1 - \text{Model } 2 \ Y} \right) \]

- Else:
  \[ \log \left( \frac{1 - \text{Model } 2 \ Y}{\text{Model } 2 \ Y} \right) \]

In this situation it is best to use second derivatives because the model is nonlinear. With least squares, the second derivatives are multiplied by residuals, which are usually near zero. For custom loss functions, second derivatives can play a stronger role.

Select Nonlinear again and complete the role assignment dialog with Model 2 Y as X, Predictor Formula, and Loss 2 as the loss function. Check the Second Derivatives check box on the Launch dialog and click OK. Then run the model again. The Solution table shows the same log-likelihood values and same parameter estimates as before.
Iteratively Reweighted Least Squares Example

Iteratively Reweighted Least Squares (IRLS) is used for robust regression (Holland and Welsch 1977) and to fit maximum likelihoods for many models (McCullagh and Nelder 1983). The Nonlinear platform can use a weight column with a formula and repeatedly reevaluate the formula if it is a function of the model. These methods can serve as automatic outlier down-weighters because, depending on the weight function, large residual values can lead to very small weights. For example, Beaton and Tukey (1974) suggest minimizing the function

\[ \sum_{i=1}^{n} \rho(r_i) \]

where

\[ \rho(r_i) = \begin{cases} \frac{B^2}{2} \left( 1 - \left( \frac{r_i}{B} \right)^2 \right) & \text{if } |r_i| \leq B \\ \frac{B^2}{2} \left( 1 - \left( \frac{B}{r_i} \right)^2 \right) & \text{if } |r_i| > B \end{cases} \]

\( r = \frac{|R|}{\sigma} \)

\( R \) is the residual

\( \sigma \) is a measure of the error, such as \( 1.5 \times \text{med}(|\text{LS residuals}|) \), (Myers, 1989),

\( B \) = a tuning constant, usually between 1 and 3.

The IRLS Example.jmp sample data table has columns constructed to illustrate an IRLS process.

<table>
<thead>
<tr>
<th>IRLS Example Notes</th>
<th>Iteratively Reweight</th>
<th>IRLS Example</th>
<th>Columns (UTF)</th>
<th>model</th>
<th>B</th>
<th>weight</th>
<th>weight2</th>
</tr>
</thead>
<tbody>
<tr>
<td>pop</td>
<td>pop</td>
<td>year</td>
<td>model</td>
<td>B</td>
<td>weight</td>
<td>weight2</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3.03</td>
<td>1980</td>
<td>-3265987.1</td>
<td>1.9</td>
<td>0.0117</td>
<td>0.0117</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>6.31</td>
<td>1980</td>
<td>-2441765.7</td>
<td>1.9</td>
<td>0.0377</td>
<td>0.0367</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>5.24</td>
<td>1980</td>
<td>-2737903.8</td>
<td>1.9</td>
<td>0.0308</td>
<td>0.0306</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>9.84</td>
<td>1980</td>
<td>-3142114.1</td>
<td>1.9</td>
<td>0.7965</td>
<td>0.7955</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>12.07</td>
<td>1980</td>
<td>-2950710.1</td>
<td>1.6</td>
<td>0.7962</td>
<td>0.7953</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>17.02</td>
<td>1980</td>
<td>-2367423.9</td>
<td>1.8</td>
<td>0.7910</td>
<td>0.7910</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>23.19</td>
<td>1980</td>
<td>-3424327.8</td>
<td>1.8</td>
<td>0.7867</td>
<td>0.7867</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>31.44</td>
<td>1980</td>
<td>-3461426</td>
<td>1.9</td>
<td>0.7824</td>
<td>0.7824</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>39.82</td>
<td>1980</td>
<td>-2965512.2</td>
<td>1.6</td>
<td>0.7770</td>
<td>0.7770</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>56.16</td>
<td>1980</td>
<td>-2538230.3</td>
<td>1.9</td>
<td>0.7735</td>
<td>0.7735</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>82.06</td>
<td>1980</td>
<td>-2573920.1</td>
<td>1.0</td>
<td>0.7600</td>
<td>0.7600</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>75.89</td>
<td>1980</td>
<td>-3611925</td>
<td>1.8</td>
<td>0.7643</td>
<td>0.7643</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>91.87</td>
<td>1980</td>
<td>-3649019.1</td>
<td>1.8</td>
<td>0.7687</td>
<td>0.7687</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>136.71</td>
<td>1980</td>
<td>-3685210.5</td>
<td>1.8</td>
<td>0.7650</td>
<td>0.7650</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>132.78</td>
<td>1980</td>
<td>-3726760.2</td>
<td>1.9</td>
<td>0.7562</td>
<td>0.7502</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>131.42</td>
<td>1940</td>
<td>-3765469.3</td>
<td>1.6</td>
<td>0.7454</td>
<td>0.7454</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>151.23</td>
<td>1940</td>
<td>-3844269.7</td>
<td>1.8</td>
<td>0.7465</td>
<td>0.7405</td>
<td></td>
</tr>
</tbody>
</table>

The IRLS Example table columns use the following formulas:

- the model column (model), with a model formula that uses three parameters \( b_0 \), \( b_1 \), and \( b_2 \)
Nonlinear Regression
Iteratively Reweighted Least Squares Example

\[ \text{pop} = (b_0 + b_1 \times \text{year} + b_2 \times \text{year}^2) \]

- \( B \), a tuning constant
- the weight column (weight), with a formula that uses \( \text{model} \), \( B \), and a local variable \( t1 \), a measure of error:

\[
\begin{align*}
&\text{if} \quad 1.5 \cdot \text{Col Quantile}(|\text{model}|, 0.5) \\
&\quad \leq B \\
&\quad \text{then} \quad \begin{cases} 
1 - & \text{t1} \\
0 & \text{else}
\end{cases} \\
&\text{else}
\end{align*}
\]

Myers (1989) suggests limiting the tuning constant to a range of 1 to 3. If you’re having trouble getting your model to converge, try moving the tuning constant closer to 2. For this example, \( B \) (the tuning factor) is equal to 1.9. Myers also proposes using a measure of error computed as \( 1.5 \cdot \text{med}(|\text{LS residuals}|) \). In this example, the formula includes a JSL statement that defines the local variable \( t1 \) as \( 1.5 \cdot \text{quantiles}_{0.5}(|\text{model}|) \).

**Note:** The variable that specifies the model must appear in the weight formula so that weights are updated with each iteration. If the actual formula is used, JMP treats the parameters as different sets of parameters and doesn’t update them.

To complete the IRLS example, follow these steps:

1. (Simple Least Squares Step) Select **Analyze > Modeling > Nonlinear**. Choose \( \text{model} \) as the **X, Predictor Formula** column but don’t select a weight yet. The parameter estimates from this least squares analysis provide starting values for the weighted model. Click **OK** on the Launch dialog and then **Go** when the Control Panel appears. You should get the starting values shown here.
At the end of the iterations, click **Save Estimates** on the Control Panel to set the $b_0$, $b_1$, and $b_2$ parameters to these estimates, which are needed for the IRLS step.

(IRLS Step) Again, select **Nonlinear**. Assign **model** as the predictor formula column and **weight** as the **Weight** variable. Click **OK** to see the Control Panel and then click **Go** to get the final parameter estimates shown in Figure 12.15. The SSE is reduced from 136.2935 for the least squares analysis to 3.0488 for the IRLS analysis.

IRLS gives small weights to extreme values, which tend to reject them from the analysis. Years 1940 and 1950 are easy to identify as outliers because their weights are very small. IRLS reduces the impact of overly influential data points and can thereby better model the rest of the data. Figure 12.16 shows a partial listing of the final data table.
The Ingots2.jmp file in the Sample Data folder records the numbers of ingots tested for readiness after different treatments of heating and soaking times.
The response variable, $N_{\text{Ready}}$, is binomial, depending on the number of ingots tested ($N_{\text{Total}}$) and the heating and soaking times. Maximum likelihood estimates for parameters from a probit model with binomial errors are obtained using

- numerical derivatives
- the negative log-likelihood as a loss function
- the Newton-Raphson method.

The average number of ingots ready is the product of the number tested and the probability that an ingot is ready for use given the amount of time it was heated and soaked. Using a probit model, the fitting equation for the model variable, $P$, is

\[
\text{Normal Distribution}[b_0 + b_1 \cdot \text{Heat} + b_2 \cdot \text{Soak}]
\]

The argument to the Normal Distribution function is a linear model of the treatments. Because the Normal Distribution function is used, the Nonlinear platform specifies numerical derivatives. For more information on numeric derivatives see “Notes Concerning Derivatives,” p. 264.

To specify binomial errors, the loss function, Loss, has the formula

\[-[N_{\text{Ready}} \cdot \log(p) + (N_{\text{Total}} - N_{\text{Ready}}) \cdot \log(1 - p)]\]

To complete the Nonlinear Launch dialog, specify $P$ as the X, Predictor Formula and Loss as Loss. Click Second Derivatives on the Launch dialog. Click OK, then click Go on the Control Panel.

Default starting values of (near) zero for the parameters should result in the solution shown in Figure 12.17. JMP used the Newton-Raphson, or Second Derivatives method, to obtain the solution.
Poisson Loss Function

A Poisson distribution is often used as a model to fit frequency counts.

\[ P(Y = n) = \frac{e^{-\mu} \mu^n}{n!}, \; n = 0, 1, 2, \ldots \]

where \( \mu \) can be a single parameter, or a linear model with many parameters. Many texts and papers show how the model can be transformed and fit with iteratively reweighted least squares (Nelder and Wedderburn 1972). However, in JMP it is more straightforward to fit the model directly. For example, McCullagh and Nelder (1989) show how to analyze the number of reported damage incidents caused by waves to cargo-carrying vessels. The data are in the Ship Damage.jmp sample data, and includes columns called model and Poisson.
The formula for the Poisson column is the loss function (or –log-likelihood) for the Poisson distribution, which is the log of the probability distribution function:

\[-(N^*\text{model} - \exp(\text{model}) - \log(\Gamma(N+1)))\]

where \(\Gamma\) is the \(\Gamma\) function \(\Gamma(n + 1) = n!\) and \(e^{\text{model}}\) represents \(\mu\).

The formula for \(\text{model}\) is

To run the model, choose Analyze > Modeling > Nonlinear. In the Launch dialog, select \(\text{model}\) as the \(X\), Predictor Formula and Poisson as Loss, and then click OK. In the Control Panel, set the initial value for \(b_0\) to 1, the other parameters to 0, and click Go. The table in Figure 12.18 shows the results after the model has run and you select Confidence Limits.
Notes Concerning Derivatives

The nonlinear platform takes symbolic derivatives for formulas with most common operations. This section shows what kind of derivative expressions result.

If you open the Negative Exponential.jmp nonlinear sample data example, the actual formula looks something like this:

\[
\text{Parameter} \{b0=0.5, b1=0.5,\}b0*(1-\text{Exp}(-b1*X))
\]

The Parameter block in the formula is hidden if you use the formula editor, but that is how it is stored in the column and how it appears in the Nonlinear Launch dialog. Two parameters named \(b0\) and \(b1\) are given initial values and used in the formula to be fit.

The Nonlinear platform makes a separate copy of the formula, and edits it to extract the parameters from the expression and maps the references to them to the place where they will be estimated. Nonlinear takes the analytic derivatives of the prediction formula with respect to the parameters. If you use the Show Derivatives command, you get the resulting formulas listed in the log, like this:

Prediction Model:

\[
\text{b0 * First(T#1=1-(T#2=\text{Exp}(-b1*X)), T#3=-(1*T#2*X))}
\]

The Derivative of Model with respect to the parameters is:

\[
\{T#1, T#3*b0\}
Notes Concerning Derivatives

The derivative facility works like this:

- In order to avoid calculating subexpressions repeatedly, the prediction model is threaded with assignments to store the values of subexpressions that it will need for derivative calculations. The assignments are made to names like $T#1$, $T#2$, and so forth.

- When the prediction model needs additional subexpressions evaluated, it uses the `First` function, which returns the value of the first argument expression, and also evaluates the other arguments. In this case additional assignments will be needed for derivatives.

- The derivative table itself is a list of expressions, one expression for each parameter to be fit. For example, the derivative of the model with respect to $b_0$ is $T#1$; its thread in the prediction model is $1 - \exp(-b_1 \times X)$. The derivative with respect to $b_1$ is $T#3 \times b_0$, which is $-(-1 \times \exp(-b_1 \times X) \times X) \times b_0$ if you substitute in the assignments above. Although many optimizations are made, it doesn't always combine the operations optimally, as you can see by the expression for $T#3$, which doesn't remove a double negation.

If you ask for second derivatives, then you get a list of $m(m+1)/2$ second derivative expressions in a list, where $m$ is the number of parameters.

If you specify a loss function, then the formula editor takes derivatives with respect to parameters, if it has any, and it takes first and second derivatives with respect to the model, if there is one.

If the derivative mechanism doesn’t know how to take the analytic derivative of a function, then it takes numerical derivatives, using the `NumDeriv` function. If this occurs, then the platform shows the delta it used to evaluate the change in the function with respect to a delta change in the arguments. You may need to experiment with different delta settings to obtain good numerical derivatives.

**Tips**

There are always many ways to represent a given model, and some ways behave much better than other forms. Ratkowsky (1990) covers alternative forms in his text.

If you have repeated subexpressions that occur several places in a formula, then it is better to make an assignment to a temporary variable, and then refer to it later in the formula. For example, one of the model formulas above was this:

```plaintext
If(Y==0, Log(1/(1+Exp(model))), Log(1 - 1/(1 + Exp(model))));
```

This could be simplified by factoring out an expression and assigning it to a local variable:

```plaintext
temp=1/(1+Exp(model));
If(Y==0, Log(temp), Log(1-temp));
```

The derivative facility can track derivatives across assignments and conditionals.
Notes on Effective Nonlinear Modeling

We strongly encourage you to *center polynomials*.

Anywhere you have a complete polynomial term that is linear in the parameters, it is always good to center the polynomials. This improves the condition of the numerical surface for optimization. For example, if you have an expression like

\[ a_1 + b_1 x + c_1 x^2 \]

you should transform it to

\[ a_2 + b_2 (x - \bar{x}) + c_2 (x - \bar{x})^2 \]

The two models are equivalent, apart from a transformation of the parameters, but the second model is far easier to fit if the model is nonlinear.

The transformation of the parameters is easy to solve.

\[
\begin{align*}
  a_1 &= a_2 - b_2 \bar{x} + c_2 \bar{x} \\
  b_1 &= b_2 - 2c_2 \bar{x} \\
  c_1 &= c_2
\end{align*}
\]

If the number of iterations still goes to the maximum, increase the maximum number of iterations and select **Second Deriv Method** from the red triangle menu.

There is really no one omnibus optimization method that works well on all problems. JMP has options like **Newton**, **QuasiNewton BFGS**, **QuasiNewton SR1**, **Second Deriv Method**, and **Numeric Derivatives Only** to expand the range of problems that are solvable by the Nonlinear Platform.

So if JMP’s defaults are unable to converge to the solution for a particular problem, using various combinations of these settings increase the odds of obtaining convergence.

Some models are very sensitive to starting values of the parameters. Working on new starting values is often effective. Edit the starting values and click **Reset** to see the effect.

The plot often helps. Use the sliders to visually modify the curve to fit better. The parameter profilers can help, but may be too slow for anything but small data sets.
Notes Concerning Scripting

If you are using a JSL script to run the Nonlinear platform, then the following commands could be useful, along with the commands listed under the Nonlinear platform popup menu.

**Table 12.1 JSL commands for Nonlinear**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>Model( Parameter([name=expr, ...], expr) )</code></td>
<td>The model to fit. If not specified, it looks in the ( X ) column's formula, if there is an ( X ) column.</td>
</tr>
<tr>
<td><code>Loss(expr)</code> or <code>Loss( Parameter([name=expr, ...], expr) )</code></td>
<td>The loss function to use. If not specified, it looks in the Loss columns formula, if there is a loss column.</td>
</tr>
<tr>
<td><code>Go</code></td>
<td>Like the ( \text{Go} ) button, it starts the iterations, but unlike the ( \text{Go} ) button, the iterations run in the foreground instead of the background.</td>
</tr>
<tr>
<td><code>Finish</code></td>
<td>Used instead of the ( \text{Go} ) command. ( \text{Finish} ) halts script execution until the fit is complete.</td>
</tr>
<tr>
<td><code>Reset</code></td>
<td>Same as the ( \text{Reset} ) button.</td>
</tr>
<tr>
<td><code>Set Parameter(name=expression, ...)</code></td>
<td>To provide new starting values. Expression may even be a Column function like <code>Col Maximum</code>. ( name ) is a parameter name.</td>
</tr>
<tr>
<td><code>Lock Parameter(name, ...)</code></td>
<td>To Lock or Unlock. ( name ) is a parameter name.</td>
</tr>
<tr>
<td><code>Save Estimates</code></td>
<td>Same as the <code>Save Estimates</code> button</td>
</tr>
<tr>
<td><code>Confidence Limits</code></td>
<td>Same as the <code>Confidence Limits</code> button</td>
</tr>
<tr>
<td><code>SSE Grid(name(first,last), ...)</code></td>
<td>To calculate the SSE on a Grid, on ( n ) values in the range specified for each parameter. Unspecified parameters are left at the solution value.</td>
</tr>
</tbody>
</table>

The first example below uses a By-group and specifies an expression to evaluate to get starting values. The second example specifies the model itself.

Nonlinear(x(Model), y(pop), By(group),
   Set Parameter(B0=ColMinimum(Pop), B1=.03),
   Go);
Nonlinear(y(pop),
   Model(
      Parameter({B0=3.9, B1=0.022},
         B0*Exp(B1*(year-1790))),
      SSEGrid(B0(2,20,10), B1(.01,.05,6)));
Nonlinear Modeling Templates

This section shows examples of some nonlinear models and sources of data for each model. These models and others are in the Model Library, discussed in the section “Using the Model Library,” p. 235.

Table 12.2 Guide to Nonlinear Modeling Templates

<table>
<thead>
<tr>
<th>Data Reference</th>
<th>Formula</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meyers (1988), p. 310</td>
<td>$\frac{\theta_1 x}{\theta_2 + x}$</td>
<td>A Michaelis-Menten</td>
</tr>
<tr>
<td>Draper and Smith (1981), p. 522</td>
<td>$\theta_1[1 - \exp(\theta_2 x)]$</td>
<td>B</td>
</tr>
<tr>
<td>Draper and Smith (1981), p. 476</td>
<td>$\theta_1 + (0.49 - \theta_1)\exp[-\theta_2(x - 8)]$</td>
<td>C</td>
</tr>
<tr>
<td>Draper and Smith (1981), p. 519</td>
<td>$\exp\left{-\theta_1 x_1 \exp\left[-\theta_2 \cdot \left(\frac{1}{x_2} - \frac{1}{620}\right)\right]\right}$</td>
<td>D</td>
</tr>
<tr>
<td>Draper and Smith (1981), p. 519</td>
<td>$\frac{\theta_2}{\theta_1 x}$</td>
<td>E</td>
</tr>
<tr>
<td>Bates and Watts (1988), p. 310</td>
<td>$\theta_1 + \theta_2\exp(\theta_3 x)$</td>
<td>F Asymptotic Regression</td>
</tr>
<tr>
<td>Bates and Watts (1988), p. 310</td>
<td>$\frac{\theta_1}{1 + \theta_2\exp(\theta_3 x)}$</td>
<td>G Logistic</td>
</tr>
<tr>
<td>Bates and Watts (1988), p. 310</td>
<td>$\theta_1\exp[-\exp(\theta_2 - \theta_3 x)]$</td>
<td>H Gompertz Growth</td>
</tr>
<tr>
<td>Draper and Smith (1981), p. 524</td>
<td>$\theta_1[1 - (\theta_2 x)^{-\theta_3}]$</td>
<td>I</td>
</tr>
</tbody>
</table>
Table 12.2 Guide to Nonlinear Modeling Templates (Continued)

<table>
<thead>
<tr>
<th>Data Reference</th>
<th>Formula</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draper and Smith (1981), p. 524, N</td>
<td>( \theta_1 - \ln[1 + \theta_2 \exp(-\theta_3 x)] )</td>
<td>J Loglogistic</td>
</tr>
<tr>
<td>Draper and Smith (1981), p. 524, P</td>
<td>( \theta_1 + \frac{\theta_2}{\theta_3 x} )</td>
<td>K</td>
</tr>
<tr>
<td>Draper and Smith (1981), p. 524, P</td>
<td>( \ln[\theta_1 \exp(-\theta_2 x) + (1 - \theta_1) \exp(-\theta_3 x)] )</td>
<td>L</td>
</tr>
<tr>
<td>Bates and Watts (1988), p. 271</td>
<td>( \frac{\theta_1 \theta_3 (x_2 - \frac{x_3}{1.632})}{1 + \theta_2 x_1 + \theta_3 x_2 + \theta_4 x_3} )</td>
<td>M</td>
</tr>
<tr>
<td>Bates and Watts (1988), p. 310</td>
<td>( \frac{\theta_2 \theta_3 + \theta_1 x}{\theta_3 + x} )</td>
<td>O Morgan-Mercer-Florin</td>
</tr>
<tr>
<td>Bates and Watts (1988), p. 310</td>
<td>( \frac{\theta_1}{1 + \theta_2 \exp(-\theta_3 x)} )</td>
<td>P Richards Growth</td>
</tr>
<tr>
<td>Bates and Watts (1988), p. 274</td>
<td>( \frac{\theta_1}{\theta_2 + x_1} + \theta_3 x_2 + \theta_4 x_2^2 + \theta_5 x_2^3 + (\theta_6 + \theta_7 x_2^2) x_2 \exp \left( \frac{-x_1}{\theta_8 + \theta_9 x_2^2} \right) )</td>
<td>S</td>
</tr>
</tbody>
</table>
Chapter 13

Creating Neural Networks
Using the Neural Platform

The Neural platform implements a fully-connected multi-layer perceptron with one or two layers. Use neural networks to predict one or more response variables using a flexible function of the input variables. Neural networks can be very good predictors when it is not necessary to describe the functional form of the response surface, or to describe the relationship between the inputs and the response.

Figure 13.1 Example of a Neural Network
Contents

Overview of Neural Networks ......................................................... 273
Launch the Neural Platform ......................................................... 273
  The Neural Launch Window ..................................................... 274
  The Model Launch ................................................................. 275
Model Reports ......................................................................... 280
  Training and Validation Measures of Fit ................................. 281
  Confusion Statistics .............................................................. 282
Model Options ....................................................................... 282
Example of a Neural Network ...................................................... 284
Overview of Neural Networks

Think of a neural network as a function of a set of derived inputs, called hidden nodes. The hidden nodes are nonlinear functions of the original inputs. You can specify up to two layers of hidden nodes, with each layer containing as many hidden nodes as you want.

Figure 13.2 shows a two-layer neural network with three X variables and one Y variable. In this example, the first layer has two nodes, and each node is a function of all three nodes in the second layer. The second layer has three nodes, and all nodes are a function of the three X variables. The predicted Y variable is a function of both nodes in the second layer.

The functions applied at the nodes of the hidden layers are called activation functions. The activation function is a transformation of a linear combination of the X variables. For more details about the activation functions, see “Hidden Layer Structure,” p. 278.

The function applied at the response is a linear combination (for continuous responses), or a logistic transformation (for nominal or ordinal responses).

The main advantage of a neural network model is that it can efficiently model different response surfaces. Given enough hidden nodes and layers, any surface can be approximated to any accuracy. The main disadvantage of a neural network model is that the results are not easily interpretable, since there are intermediate layers rather than a direct path from the X variables to the Y variables, as in the case of regular regression.

Note: Most features discussed in this chapter are for JMP Pro only, and are designated as such with a note.

Launch the Neural Platform

To launch the Neural platform, select Analyze > Modeling > Neural.

Launching the Neural platform is a two-step process. First, enter your variables on the Neural launch window. Second, specify your options in the Model Launch.
The Neural Launch Window

Use the Neural launch window to specify X and Y variables, a validation column, and to enable missing value coding. The Validation button and Missing Value Coding option are available only in JMP Pro.

Table 13.1 Description of the Neural Launch Window

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Y, Response</strong></td>
<td>Choose the response variable. When multiple responses are specified, the models for the responses share all parameters in the hidden layers (those parameters not connected to the responses).</td>
</tr>
<tr>
<td><strong>X, Factor</strong></td>
<td>Choose the input variables.</td>
</tr>
<tr>
<td><strong>Freq</strong></td>
<td>Choose a frequency variable.</td>
</tr>
<tr>
<td><strong>Validation</strong></td>
<td><strong>Note</strong>: This button appears only in JMP Pro. Choose a validation column. For more information, see “Validation Method,” p. 276.</td>
</tr>
<tr>
<td><strong>By</strong></td>
<td>Choose a variable to create separate models for each level of the variable.</td>
</tr>
</tbody>
</table>
Table 13.1 Description of the Neural Launch Window  (Continued)

<table>
<thead>
<tr>
<th>Missing Value Coding</th>
<th>Note: This option is available only in JMP Pro.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Check this box to enable missing value imputation and coding. If this option is not checked, rows with missing values are ignored.</td>
</tr>
<tr>
<td></td>
<td>For continuous variables, missing values are replaced by the mean of the variable. Also, a missing value indicator variable is created and included in the model. If a variable is transformed, the imputation occurs after the transformation.</td>
</tr>
<tr>
<td></td>
<td>For categorical variables, the missing values are not imputed, but are treated as another level of the variable in the model.</td>
</tr>
</tbody>
</table>

The Model Launch

Use the Model Launch dialog to specify the validation method, the structure of the hidden layer, whether to use gradient boosting, and other fitting options.

Figure 13.4 The Model Launch Dialog
After you click Go to fit a model, you can reopen the Model Launch Dialog and change the settings to fit another model.

### Validation Method

Neural networks are very flexible models and have a tendency to overfit data. When that happens, the model predicts the fitted data very well, but predicts future observations poorly. To mitigate overfitting, the Neural platform does the following:

- applies a penalty on the model parameters
- uses an independent data set to assess the predictive power of the model

Validation is the process of using part of a data set to estimate model parameters, and using the other part to assess the predictive ability of the model.

- The training set is the part that estimates model parameters.
- The validation set is the part that estimates the optimal value of the penalty, and assesses or validates the predictive ability of the model.
- The test set is a final, independent assessment of the model's predictive ability. The test set is available only when using a validation column. See Table 13.3.

The training, validation, and test sets are created by subsetting the original data into parts. Table 13.3 describes several methods for subsetting a data set.

---

### Table 13.2 Description of the Model Launch Dialog

<table>
<thead>
<tr>
<th>Validation Method</th>
<th>Select the method that you want to use for model validation. For details, see “Validation Method,” p. 276.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hidden Layer Structure or Hidden Nodes</td>
<td><strong>Note:</strong> The standard edition of JMP uses only the TanH activation function, and can fit only neural networks with one hidden layer. Specify the number of hidden nodes of each type in each layer. For details, see “Hidden Layer Structure,” p. 278.</td>
</tr>
<tr>
<td>Boosting</td>
<td><strong>Note:</strong> These options are available only in JMP Pro. Specify options for gradient boosting. For details, see “Boosting,” p. 279.</td>
</tr>
<tr>
<td>Fitting Options</td>
<td><strong>Note:</strong> These options are available only in JMP Pro. Specify options for variable transformation and model fitting. For details, see “Fitting Options,” p. 279.</td>
</tr>
<tr>
<td>Go</td>
<td>Fits the neural network model and shows the model reports.</td>
</tr>
</tbody>
</table>
### Table 13.3 Validation Methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Description and Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excluded Rows</td>
<td>Uses row states to subset the data. Rows that are unexcluded are used as the training set, and excluded rows are used as the validation set. For more information about using row states and how to exclude rows, see <em>Using JMP</em>.</td>
</tr>
<tr>
<td>Holdback</td>
<td>Randomly divides the original data into the training and validation sets. You can specify the proportion of the original data to use as the validation set (holdback).</td>
</tr>
<tr>
<td>KFold</td>
<td>Divides the original data into K subsets. In turn, each of the K sets is used to validate the model fit on the rest of the data, fitting a total of K models. The model giving the best validation statistic is chosen as the final model. This method is best for small data sets, because it makes efficient use of limited amounts of data.</td>
</tr>
</tbody>
</table>
| Validation Column | **Note**: The use of a validation column is available only in JMP Pro. Uses the column's values to divide the data into parts. The column is assigned using the Validation role on the Neural launch window. See Figure 13.3. The column's values determine how the data is split, and what method is used for validation:  
  - If the column has three unique values, then:  
    - the smallest value is used for the Training set.  
    - the middle value is used for the Validation set.  
    - the largest value is used for the Test set.  
  - If the column has two unique values, then only Training and Validation sets are used.  
  - If the column has more than three unique values, then KFold validation is performed. |
Hidden Layer Structure

**Note:** The standard edition of JMP uses only the TanH activation function, and can fit only neural networks with one hidden layer.

The Neural platform can fit one or two-layer neural networks. Increasing the number of nodes in the first layer, or adding a second layer, makes the neural network more flexible. You can add an unlimited number of nodes to either layer. The second layer nodes are functions of the X variables. The first layer nodes are functions of the second layer nodes. The Y variables are functions of the first layer nodes.

The functions applied at the nodes of the hidden layers are called activation functions. An activation function is a transformation of a linear combination of the X variables. Table 13.4 describes the three types of activation functions.

**Table 13.4 Activation Functions**

<table>
<thead>
<tr>
<th>Activation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TanH</td>
<td>The hyperbolic tangent function is a sigmoid function. TanH transforms values to be between -1 and 1, and is the centered and scaled version of the logistic function. The hyperbolic tangent function is: $\frac{e^{2x} - 1}{e^{2x} + 1}$ where $x$ is a linear combination of the X variables.</td>
</tr>
<tr>
<td>Linear</td>
<td>The identity function. The linear combination of the X variables is not transformed. The Linear activation function is most often used in conjunction with one of the non-linear activation functions. In this case, the Linear activation function is placed in the second layer, and the non-linear activation functions are placed in the first layer. This is useful if you want to first reduce the dimensionality of the X variables, and then have a nonlinear model for the Y variables. For a continuous Y variable, if only Linear activation functions are used, the model for the Y variable reduces to a linear combination of the X variables. For a nominal or ordinal Y variable, the model reduces to a logistic regression.</td>
</tr>
<tr>
<td>Gaussian</td>
<td>The Gaussian function. Use this option for radial basis function behavior, or when the response surface is Gaussian (normal) in shape. The Gaussian function is: $e^{-x^2}$ where $x$ is a linear combination of the X variables.</td>
</tr>
</tbody>
</table>
Boosting

**Note:** This feature is available only in JMP Pro.

Boosting is the process of building a large additive neural network model by fitting a sequence of smaller models. Each of the smaller models is fit on the scaled residuals of the previous model. The models are combined to form the larger final model. The process uses validation to assess how many component models to fit, not exceeding the specified number of models.

Boosting is often faster than fitting a single large model. However, the base model should be a 1 to 2 node single-layer model, or else the benefit of faster fitting can be lost if a large number of models is specified.

Use the Boosting panel in the Model Launch to specify the number of component models and the learning rate. Use the Hidden Layer Structure panel in the Model Launch to specify the structure of the base model.

The learning rate must be $0 < r \leq 1$. Learning rates close to 1 result in faster convergence on a final model, but also have a higher tendency to overfit data. Use learning rates close to 1 when a small Number of Models is specified.

As an example of how boosting works, suppose you specify a base model consisting of one layer and two nodes, with the number of models equal to eight. The first step is to fit a one-layer, two-node model. The predicted values from that model are scaled by the learning rate, then subtracted from the actual values to form a scaled residual. The next step is to fit a different one-layer, two-node model on the scaled residuals of the previous model. This process continues until eight models are fit, or until the addition of another model fails to improve the validation statistic. The component models are combined to form the final, large model. In this example, if six models are fit before stopping, the final model consists of one layer and $2 \times 6 = 12$ nodes.

**Fitting Options**

**Note:** These options are available only in JMP Pro.

Table 13.4 describes the model fitting options that you can specify.

**Table 13.5 Fitting Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transform Covariates</td>
<td>Transforms all continuous variables to near normality using either the Johnson Su or Johnson Sb distribution. Transforming the continuous variables helps to mitigate the negative effects of outliers or heavily skewed distributions. See the Save Transformed Covariates option in “Model Options,” p. 282.</td>
</tr>
<tr>
<td>Robust Fit</td>
<td>Trains the model using least absolute deviations instead of least squares. This option is useful if you want to minimize the impact of response outliers. This option is available only for continuous responses.</td>
</tr>
</tbody>
</table>
Penalty Method

The penalty is \( \lambda p(\beta) \), where \( \lambda \) is the penalty parameter, and \( p() \) is a function of the parameter estimates, called the penalty function. Validation is used to find the optimal value of the penalty parameter.

Table 13.6 Descriptions of Penalty Methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Penalty Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Squared</td>
<td>( \sum \beta_i^2 )</td>
<td>Use this method if you think that most of your X variables are contributing to the predictive ability of the model.</td>
</tr>
<tr>
<td>Absolute</td>
<td>( \sum</td>
<td>\beta_i</td>
</tr>
<tr>
<td>Weight Decay</td>
<td>( \sum \frac{\beta_i^2}{1 + \beta_i^2} )</td>
<td></td>
</tr>
<tr>
<td>NoPenalty</td>
<td>none</td>
<td>Does not use a penalty. You can use this option if you have a large amount of data and you want the fitting process to go quickly. However, this option can lead to models with lower predictive performance than models that use a penalty.</td>
</tr>
</tbody>
</table>

Model Reports

A model report is created for every neural network model. Measures of fit appear for the training and validation sets. Additionally, confusion statistics appear when the response is nominal or ordinal.
Training and Validation Measures of Fit

Measures of fit appear for the training and validation sets. See Figure 13.5.

Table 13.7 Descriptions of the Training and Validation Measures of Fit

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generalized RSquare</td>
<td>A generalization of the Rsquare measure that simplifies to the regular Rsquare for continuous responses. Similar to the Entropy RSquare, but instead of using the log-likelihood, the Generalized RSquare uses the $2/n$ root of the likelihood. It is scaled to have a maximum of 1. The value is 1 for a perfect model, and 0 for a model no better than a constant model.</td>
</tr>
<tr>
<td>Entropy RSquare</td>
<td>Compares the log-likelihoods from the fitted model and the constant probability model. Appears only when the response is nominal or ordinal.</td>
</tr>
<tr>
<td>RSquare</td>
<td>Gives the Rsquare for the model.</td>
</tr>
<tr>
<td>RMSE</td>
<td>Gives the root mean square error. When the response is nominal or ordinal, the differences are between the response and p (the fitted probability for the response level that actually occurred).</td>
</tr>
<tr>
<td>Mean Abs Dev</td>
<td>The average of the absolute values of the differences between the response and the predicted response. When the response is nominal or ordinal, the predicted response is p (the fitted probability for the response level that actually occurred).</td>
</tr>
</tbody>
</table>
Model Options

If there are multiple responses, fit statistics are given for each response, and an overall Generalized Rsquare and -LogLikelihood is given.

Confusion Statistics

For nominal or ordinal responses, a Confusion Matrix report and Confusion Rates report is given. See Figure 13.5. The Confusion Matrix report shows a two-way classification of the actual response levels and the predicted response levels. For a categorical response, the predicted level is the one with the highest predicted probability. The Confusion Rates report is equal to the Confusion Matrix report, with the numbers divided by the row totals.

Model Options

Each model report has a red triangle menu containing options for producing additional output or saving results. Table 13.8 describes the options in the red triangle menus.

Table 13.8 Model Report Options

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Shows a diagram representing the hidden layer structure.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Estimates</td>
<td>Shows the parameter estimates in a report.</td>
</tr>
<tr>
<td>Profiler</td>
<td>Launches the Prediction Profiler. For nominal or ordinal responses, each response level is represented by a separate row in the Prediction Profiler. For details about the options in the red triangle menu, see the “Profiling” chapter.</td>
</tr>
<tr>
<td>Categorical Profiler</td>
<td>Launches the Prediction Profiler. Similar to the Profiler option, except that all categorical probabilities are combined into a single profiler row. Available only for nominal or ordinal responses. For details about the options in the red triangle menu, see the “Profiling” chapter.</td>
</tr>
</tbody>
</table>
Table 13.8 Model Report Options (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contour Profiler</td>
<td>Launches the Contour Profiler. This is available only when the model contains more than one continuous factor. For details about the options in the red triangle menu, see the “Profiling” chapter.</td>
</tr>
<tr>
<td>Surface Profiler</td>
<td>Launches the Surface Profiler. This is available only when the model contains more than one continuous factor. For details about the options in the red triangle menu, see the “Profiling” chapter.</td>
</tr>
<tr>
<td>ROC Curve</td>
<td>Creates an ROC curve. Available only for nominal or ordinal responses. For details about ROC Curves, see “ROC Curve,” p. 319 in the “Recursive Partitioning” chapter.</td>
</tr>
<tr>
<td>Lift Curve</td>
<td>Creates a lift curve. Available only for nominal or ordinal responses. For details about Lift Curves, see “Lift Curves,” p. 321 in the “Recursive Partitioning” chapter.</td>
</tr>
<tr>
<td>Plot Actual by Predicted</td>
<td>Plots the actual versus the predicted response. Available only for continuous responses.</td>
</tr>
<tr>
<td>Plot Residual by Predicted</td>
<td>Plots the residuals versus the predicted responses. Available only for continuous responses.</td>
</tr>
<tr>
<td>Save Formulas</td>
<td>Creates new columns in the data table containing formulas for the predicted response and the hidden layer nodes.</td>
</tr>
<tr>
<td>Save Profile Formulas</td>
<td>Creates new columns in the data table containing formulas for the predicted response. Formulas for the hidden layer nodes are embedded in this formula. This option produces formulas that can be used by the Flash version of the Profiler.</td>
</tr>
<tr>
<td>Save Fast Formulas</td>
<td>Creates new columns in the data table containing formulas for the predicted response. Formulas for the hidden layer nodes are embedded in this formula. This option produces formulas that evaluate faster than the other options, but cannot be used in the Flash version of the Profiler.</td>
</tr>
<tr>
<td>Make SAS Data Step</td>
<td>Creates SAS code that you can use to score a new data set.</td>
</tr>
<tr>
<td>Save Validation</td>
<td>Creates a new column in the data table that identifies which rows were used in the training and validation sets. This option is not available when a Validation column is specified on the Neural launch window. See “The Neural Launch Window,” p. 274.</td>
</tr>
</tbody>
</table>
Example of a Neural Network

This example uses the Boston Housing.jmp data table. Suppose you want to create a model to predict the median home value as a function of several demographic characteristics. Follow the steps below to build the neural network model:

1. Launch the Neural platform by selecting Analyze > Modeling > Neural.
2. Assign mvalue to the Y, Response role.
3. Assign the other columns (crim through lstat) to the X, Factor role.
4. Click OK.
5. Enter 0.2 for the Holdback Proportion.
6. Enter 3 for the number of TanH nodes in the first layer.
7. Check the Transform Covariates option.
8. Click Go.

The report is shown in Figure 13.6.

**Note**: Results will vary due to the random nature of choosing a validation set.
Results are provided for both the training and validation sets. Use the results of the validation set as a representation of the model's predictive power on future observations.

The R-Square statistic for the Validation set is 0.838, signifying that the model is predicting well on data not used to train the model. As an additional assessment of model fit, select **Plot Actual by Predicted** from the Model red-triangle menu. The plot is shown in Figure 13.7.

**Figure 13.7** Actual by Predicted Plot

The points fall along the line, signifying that the predicted values are similar to the actual values.

To get a general understanding of how the \( X \) variables are impacting the predicted values, select **Profiler** from the Model red-triangle menu. The profiler is shown in Figure 13.8.

**Figure 13.8** Profiler
Some of the variables have profiles with positive slopes, and some negative. For example, rooms has a positive slope. This indicates that the more rooms a home has, the higher the predicted median value. The variable age is the proportion of owner-occupied units built prior to 1940. This variable has a negative slope, indicating that the more older homes there are in the area, the lower the median value.
The Gaussian Process platform is used to model the relationship between a continuous response and one or more continuous predictors. These models are common in areas like computer simulation experiments, such as the output of finite element codes, and they often perfectly interpolate the data. Gaussian processes can deal with these no-error-term models, in which the same input values always result in the same output value.

The Gaussian Process platform fits a spatial correlation model to the data, where the correlation of the response between two observations decreases as the values of the independent variables become more distant.

The main purpose for using this platform is to obtain a prediction formula that can be used for further analysis and optimization.

**Figure 14.1** Example of a Gaussian Process Prediction Surface
Contents

Launching the Platform ......................................................... 289
The Gaussian Process Report ................................................. 290
  Actual by Predicted Plot .................................................. 291
  Model Report ................................................................. 291
  Marginal Model Plots ....................................................... 293
Platform Options ............................................................... 293
Borehole Hypercube Example ................................................. 294
Launching the Platform

To launch the Gaussian Process platform, choose Analyze > Modeling > Gaussian Process from the main menu bar. Here, we illustrate the platform with 2D Gaussian Process Example.jmp data set, found in the Sample Data folder.

**Figure 14.2** Gaussian Process Launch Dialog

The launch dialog has the following options:

- **Estimate Nugget Parameter** introduces a ridge parameter into the estimation procedure. This is useful if there is noise or randomness in the response, and you would like the prediction model to smooth over the noise instead of perfectly interpolating.

- **Correlation Type** lets you choose the correlation structure used in the model. The platform fits a spatial correlation model to the data, where the correlation of the response between two observations decreases as the values of the independent variables become more distant.
  - **Gaussian** restricts the correlation between two points to always be non-zero, no matter the distance between the points.
  - **Cubic** lets the correlation between two points to be zero for points far enough apart. This method can be considered a generalization of a cubic spline.

- **Minimum Theta Value** lets you set the minimum theta value used in the fitted model. The default is 0. The theta values are analogous to a slope parameter in regular regression models. If a theta value is 0 in the fitted model, then that X variable has no influence on the predicted values.

In this example, we are interested in finding the explanatory power of the two X-variables (X1 and X2) on Y. A plot of X1 and X2 shows their even dispersal in the factor space.
Since this is generated data, we can look at the function that generates the Y values. It is this function that we want to estimate.

The Gaussian Process Report

For this example we use the Gaussian correlation structure. After clicking OK from the launch dialog, the following report appears.
Chapter 14

Gaussian Processes

291

Gaussian Process Report

Figure 14.3 Gaussian Process Default Report

Actual by Predicted Plot

The Actual by Predicted plot shows the actual \( Y \) values on the \( y \)-axis and the jackknife predicted values on the \( x \)-axis. One measure of goodness-of-fit is how well the points lie along the 45 degree diagonal line.

The jackknife values are really pseudo-jackknife values because they are not refit unless the row is excluded. Therefore, the correlation parameters still have the contribution of that row in them, but the prediction formula does not. If the row is excluded, neither the correlation parameters nor the prediction formula have the contribution.

Model Report

The Model Report shows a functional ANOVA table for the model parameters that the platform estimates. Specifically, it is an analysis of variance table, but the variation is computed using a function-driven method.

The Total Variation is the integrated variability over the entire experimental space.

For each covariate, we can create a marginal prediction formula by averaging the overall prediction formula over the values of all the other factors. The functional main effect of \( X_1 \) is the integrated total variation due to \( X_1 \) alone. In this case, we see that 37.6% of the variation in \( Y \) is due to \( X_1 \).

The ratio of (Functional \( X_1 \) effect)/(Total Variation) is the value listed as the Main Effect in the Model report. A similar ratio exists for each factor in the model.
Functional interaction effects, computed in a similar way, are also listed in the Model Report table.

Summing the value for main effect and all interaction terms gives the Total Sensitivity, the amount of influence a factor and all its two-way interactions have on the response variable.

**Mu, Theta, and Sigma**

The Gaussian correlation structure uses the product exponential correlation function with a power of 2 as the estimated model. This comes with the assumptions that $Y$ is Normally distributed with mean $\mu$ and covariance matrix $\sigma^2 R$. The $R$ matrix is composed of elements

$$r_{ij} = \exp\left(-\sum_k \theta_k (x_{ik} - x_{jk})^2\right)$$

In the Model report, $\mu$ is the Normal distribution mean, $\sigma^2$ is the Normal Distribution parameter, and the Theta column corresponds to the values of $\theta_k$ in the definition of $R$.

These parameters are all fitted via maximum likelihood.

**Note:** If you see **Nugget parameters set to avoid singular variance matrix**, JMP has added a ridge parameter to the variance matrix so that it is invertible.

The Cubic correlation structure also assumes that $Y$ is Normally distributed with mean $\mu$ and covariance matrix $\sigma^2 R$. The $R$ matrix is composed of elements

$$r_{ij} = \prod_k \rho(d; \theta_k) \quad d = x_{ik} - x_{jk}$$

where

$$\rho(d; \theta) = \begin{cases} 
1 - 6(d\theta)^2 + 6(|d\theta|)^3, & |d| \leq \frac{1}{2\theta} \\
2(1 - |d\theta|)^3, & \frac{1}{2\theta} < |d| \leq \frac{1}{\theta} \\
0, & \frac{1}{\theta} < |d|
\end{cases}$$

For more information see Santer (2003). The theta parameter used in the cubic correlation is the reciprocal of the parameter used in the literature. The reason is so that when a parameter (theta) has no effect on the model, then it has a value of zero, instead of infinity.
Marginal Model Plots

The Marginal Model plots are shown in Figure 14.4.

Figure 14.4 Marginal Model Plots

These plots show the average value of each factor across all other factors. In this two-dimensional example, we examine slices of X1 from –1 to 1, and plot the average value at each point.

Platform Options

The Gaussian Process platform has the following options:

- **Profiler** brings up the standard Profiler.
- **Contour Profiler** brings up the Contour Profiler.
- **Surface Profiler** brings up the Surface Profiler.

Details on Profiling are found in the “Profiling” chapter.

- **Save Prediction Formula** creates a new column in the table containing the prediction formula.
- **Save Variance Formula** creates a new column in the table containing the variance formula.
- **Save Jackknife Predicted Values** stores the jackknife predicted values to the data table. These are the x-axis values for the Actual by Predicted Plot.
- **Script** the standard JMP Script menu.

In Figure 14.5, we use the saved prediction formula to compare the prediction to the actual data points.
Borehole Hypercube Example

A more complicated model is seen using Borehole Latin Hypercube.jmp, found in the Design Experiment folder.

To launch the analysis, fill out the Gaussian Process dialog as shown in Figure 14.6.

Figure 14.5 Two Views of the Prediction Surface and Actual Ys

Figure 14.6 Borehole Latin Hypercube Launch Dialog
When you click OK, the following Actual by Predicted plot appears.

![Actual by Predicted Plot](image)

Since the points are close to the 45 degree diagonal line, we can be confident that the Gaussian process prediction model is a good approximation to the true function that generated the data.

The Model Report shows us that this is mainly due to one factor, log10 Rw. The main effect explains 87.5% of the variation, with 90.5% explained when all second-order interactions are included.

Most of the variation is explained by log10Rw

<table>
<thead>
<tr>
<th>Column</th>
<th>Column</th>
<th>Main Effect</th>
<th>Log10 Rw</th>
<th>Log10 Rw</th>
<th>Interaction</th>
<th>Interaction</th>
<th>Interaction</th>
<th>Interaction</th>
<th>Interaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>log10 Rw</td>
<td>4.644710</td>
<td>0.025108</td>
<td>0.002619</td>
<td>0.010219</td>
<td>0.0084610</td>
<td>0.0016360</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>log10 R</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Factors with a theta value of 0 do not impact the prediction formula at all. It is as if they have been dropped from the model.
The Marginal Model plots confirm that $\log_{10} R_w$ is a highly involved participant in $Y$’s variation.
The **Partition** platform recursively partitions data according to a relationship between the $X$ and $Y$ values, creating a tree of partitions. It finds a set of cuts or groupings of $X$ values that best predict a $Y$ value. It does this by exhaustively searching all possible cuts or groupings. These splits (or partitions) of the data are done recursively forming a tree of decision rules until the desired fit is reached. This is a powerful platform, since it picks the optimum splits from a large number of possible splits.

The platform offers three methods for growing the final predictive tree:

- Decision Tree
- Bootstrap Forest (JMP Pro only)
- Boosted Tree (JMP Pro only)

**Figure 15.1** Example of Partition

[Diagram of a decision tree shown above]
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Partitioning</td>
<td>299</td>
</tr>
<tr>
<td>Launching the Partition Platform</td>
<td>299</td>
</tr>
<tr>
<td>Partition Method</td>
<td>300</td>
</tr>
<tr>
<td>Decision Tree</td>
<td>300</td>
</tr>
<tr>
<td>Bootstrap Forest</td>
<td>311</td>
</tr>
<tr>
<td>Boosted Tree</td>
<td>314</td>
</tr>
<tr>
<td>Validation</td>
<td>317</td>
</tr>
<tr>
<td>Graphs for Goodness of Fit</td>
<td>318</td>
</tr>
<tr>
<td>Actual by Predicted Plot</td>
<td>318</td>
</tr>
<tr>
<td>ROC Curve</td>
<td>319</td>
</tr>
<tr>
<td>Lift Curves</td>
<td>321</td>
</tr>
<tr>
<td>Missing Values</td>
<td>322</td>
</tr>
<tr>
<td>Example</td>
<td>323</td>
</tr>
<tr>
<td>Decision Tree</td>
<td>324</td>
</tr>
<tr>
<td>Bootstrap Forest</td>
<td>325</td>
</tr>
<tr>
<td>Boosted Tree</td>
<td>327</td>
</tr>
<tr>
<td>Compare Methods</td>
<td>328</td>
</tr>
<tr>
<td>Statistical Details</td>
<td>330</td>
</tr>
</tbody>
</table>
Introduction to Partitioning

Variations of partitioning go by many names and brand names: decision trees, CART\textsuperscript{TM}, CHAID\textsuperscript{TM}, C4.5, C5, and others. The technique is often taught as a data mining technique because

- it is good for exploring relationships without having a good prior model,
- it handles large problems easily, and
- the results are very interpretable.

A classic application is where you want to turn a data table of symptoms and diagnoses of a certain illness into a hierarchy of questions to ask new patients in order to make a quick initial diagnosis.

The factor columns (X’s) can be either continuous or categorical (nominal or ordinal). If an X is continuous, then the splits (partitions) are created by a cutting value. The sample is divided into values below and above this cutting value. If the X is categorical, then the sample is divided into two groups of levels.

The response column (Y) can also be either continuous or categorical (nominal or ordinal). If Y is continuous, then the platform fits means. If Y is categorical, then the fitted value is a probability. In either case, the split is chosen to maximize the difference in the responses between the two branches of the split.

For more information on split criteria, see “Statistical Details,” p. 330.

Launching the Partition Platform

To launch the Partition platform, select Analyze > Modeling > Partition. The Partition launch window is shown in Figure 15.2, using the Boston Housing.jmp data table.

Figure 15.2 Partition Launch Window
Partition Method

The Partition platform provides three methods for producing a final tree:

- For the Decision Tree method, see “Decision Tree,” p. 300.
- For the Bootstrap Forest method, see “Bootstrap Forest,” p. 311.
- For the Boosted Tree method, see “Boosted Tree,” p. 314.

Note: Bootstrap Forest and Boosted Tree are available only in JMP Pro.

Decision Tree

The Decision Tree method makes a single pass through the data and produces a single tree. You can interactively grow the tree one split at a time, or grow the tree automatically if validation is used.
As an example, use the Boston Housing.jmp data table. Launch the Partition platform and assign mvalue to the Y, Response role. Assign all the other variables to the X, Factor role. If using JMP Pro, select Decision Tree from the Method menu, then click OK. The initial report is shown in Figure 15.3.

![Figure 15.3 Decision Tree Initial Report](image)

The Split button is used to partition the data, creating a tree of partitions. Repeatedly splitting the data results in branches and leaves of the tree. This can be thought of as growing the tree. The Prune button is used to combine the most recent split back into one group.

Note the reported statistics:

- **RSquare** is the current $R^2$ value.
- **N** is the number of observations (if no Freq variable is used).
- **Number of Splits** is the current number of splits.
- **AICc** is the corrected Akaike's Information Criterion.
- **Count** gives the number of rows in the branch.
- **Mean** gives the average response for all rows in that branch.
- **Std Dev** gives the standard deviation of the response for all rows in that branch.

Initially, all rows are in one branch. In order to determine the first split, each X column must be considered. The candidate columns are shown in the Candidates report. As shown in Figure 15.4, the rooms column has the largest SS (sums of squares), and is therefore the optimum split to make. See “Statistical Details,” p. 330 for more information about SS.
The optimum split is noted by an asterisk. However, there are cases where the SS is higher for one variable, but the Logworth is higher for a different variable. In this case > and < are used to point in the best direction for each variable. The asterisk corresponds to the condition where they agree. See "Statistical Details," p. 330 for more information about LogWorth.

Click the Split button and notice the first split was made on the column rooms, at a value of 6.943. Open the two new candidate reports. See Figure 15.5.
Chapter 15  Recursive Partitioning  

Partition Method

Figure 15.5 First Split

The original 506 observations are now split into two parts:

- A left leaf, corresponding to rooms < 6.943, has 430 observations.
- A right leaf, corresponding to rooms \( \geq 6.943 \), has 76 observations.

For the left leaf, the next split would happen on the column \( \text{lstat} \), which has a SS of 7,311.85. For the right leaf, the next split would happen on the column \( \text{rooms} \), which has a SS of 3,060.95. Since the SS for the left leaf is higher, using the Split button again will produce a split on the left leaf, on the column \( \text{lstat} \).

Click the Split button to make the next split. See Figure 15.6.
The 430 observations from the previous left leaf are now split into two parts:

- A left leaf, corresponding to $lstat \geq 14.43$, has 175 observations.
- A right leaf, corresponding to $lstat < 14.43$, has 255 observations.

The 506 original observations are now split into three parts:

- A leaf corresponding to $rooms < 6.943$ and $lstat \geq 14.43$.
- A leaf corresponding to $rooms < 6.943$ and $lstat < 14.43$.
- A leaf corresponding to $rooms \geq 6.943$.

The predicted value for the observations in each leaf is the average response. The plot is divided into three sections, corresponding to the three leaves. These predicted values are shown on the plot with black lines. The points are put into random horizontal positions in each section. The vertical position is based on the response.
Stopping Rules

If validation is not used, the platform is purely interactive. Keep pushing the Split button until the result is satisfactory. Without cross-validation enabled, Partition is an exploratory platform intended to help you investigate relationships interactively.

When cross-validation is used, the user has the option to perform automatic splitting. This allows for repeated splitting without having to repeatedly click the Split button. See “Automatic Splitting,” p. 310 for details on the stopping rule.

Categorical Responses

When the response is categorical, the report differs in several ways (see Figure 15.7). The differences are described here, using the Car Poll.jmp data table:

- The G^2 statistic is given instead of the Mean and Std Dev at the top of each leaf, and instead of SS in the Candidates report. See “Statistical Details,” p. 330 for more information about G^2.

- The Rate statistic gives the proportion of observations in the leaf that are in each response level. The colored bars represent those proportions.

- The Prob statistic is the predicted value (a probability) for each response level. The Y axis of the plot is divided into sections corresponding to the predicted probabilities of the response levels for each leaf. The predicted probabilities always sum to one across the response levels. Random jitter is added to points in the X and Y direction in a leaf. See “Statistical Details,” p. 330 for more information about the Prob statistic.

- For the plot, the vertical position is random.

- The Color Points button appears. This colors the points on the plot according to the response levels.
Figure 15.7 Categorical Report

Node Options

This section describes the options on the red triangle menu of each node.

Split Best finds and executes the best split at or below this node.

Split Here splits at the selected node on the best column to split by.
**Split Specific** lets you specify where a split takes place. This is useful in showing what the criterion is as a function of the cut point, as well as in determining custom cut points. After selecting this command, the following window appears.

**Figure 15.8 Window for the Split Specific Command**

The **Split at** menu has the following options:

- **Optimal Value** splits at the optimal value of the selected variable.
- **Specified Value** allows you to specify the level where the split takes place.
- **Output Split Table** produces a data table showing all possible splits and their associated split value.
- **Prune Below** eliminates the splits below the selected node.
- **Prune Worst** finds and removes the worst split below the selected node.
- **Select Rows** selects the data table rows corresponding to this leaf. You can extend the selection by holding down the Shift key and choosing this command from another node.
- **Show Details** produces a data table that shows the split criterion for a selected variable. The data table, composed of split intervals and their associated criterion values, has an attached script that produces a graph for the criterion.
- **Lock** prevents a node or its subnodes from being chosen for a split. When checked, a lock icon is shown in the node title.

**Platform Options**

The section describes the options on the platform red triangle menu.
Display Options gives a submenu consisting of items that toggle report elements on and off.

Show Points shows or hides the points. For categorical responses, this option shows the points or colored panels.

Show Tree shows or hides the large tree of partitions.

Show Graph shows or hides the partition graph.

Show Split Bar shows or hides the colored bars showing the split proportions in each leaf. This is for categorical responses only.

Show Split Stats shows or hides the split statistics. See “Statistical Details,” p. 330 for more information on the categorical split statistic $G^2$.

Show Split Prob shows or hides the Rate and Prob statistics. This is for categorical responses only. See “Statistical Details,” p. 330 for more information on Rate and Prob.

Show Split Candidates shows or hides the Candidates report.

Sort Split Candidates sorts the candidates report by the statistic or the log(worth), whichever is appropriate. This option can be turned on and off. When off, it doesn’t change any reports, but new candidate reports are sorted in the order the $X$ terms are specified, rather than by a statistic.

Split Best splits the tree at the optimal split point. This is the same action as the Split button.

Prune Worst removes the terminal split that has the least discrimination ability. This is equivalent to hitting the Prune Button.

Minimum Size Split presents a dialog box where you enter a number or a fractional portion of the total sample size which becomes the minimum size split allowed. The default is 5. To specify a fraction of the sample size, enter a value less than 1. To specify an actual number, enter a value greater than or equal to 1.

Lock Columns reveals a check box table to allow you to interactively lock columns so that they are not considered for splitting. You can toggle the display without affecting the individual locks.

Plot Actual by Predicted produces a plot of actual values by predicted values. This is for continuous responses only.

Small Tree View displays a smaller version of the partition tree to the right of the scatterplot.

Leaf Report gives the mean and count or rates for the bottom-level leaves of the report.

Column Contributions brings up a report showing how each input column contributed to the fit, including how many times it was split and the total $G^2$ or Sum of Squares attributed to that column.

Split History shows a plot of $R^2$ vs. the number of splits. If you use validation, separate curves are drawn for training and validation $R^2$.

K Fold Crossvalidation shows a Crossvalidation report, giving fit statistics for both the training and folded sets. For more information on validation, see “Validation,” p. 317.

ROC Curve is described in the section “ROC Curve,” p. 319. This is for categorical responses only.

Lift Curve is described in the section “Lift Curves,” p. 321. This is for categorical responses only.
**Show Fit Details** shows several measures of fit and a confusion matrix. The confusion matrix is a two-way classification of actual and predicted response. This is for categorical responses only.

**Entropy RSquare** compares the log-likelihoods from the fitted model and the constant probability model.

**Generalized RSquare** is a generalization of the Rsquare measure that simplifies to the regular Rsquare for continuous normal responses. It is similar to the Entropy RSquare, but instead of using the log-likelihood, it uses the $2/n$ root of the likelihood. It is scaled to have a maximum of 1. The value is 1 for a perfect model, and 0 for a model no better than a constant model.

**Mean -Log p** is the average of $-\log(p)$, where $p$ is the fitted probability associated with the event that occurred.

**RMSE** is the root mean square error, where the differences are between the response and $p$ (the fitted probability for the event that actually occurred).

**Mean Abs Dev** is the average of the absolute values of the differences between the response and $p$ (the fitted probability for the event that actually occurred).

**Misclassification Rate** is the rate for which the response category with the highest fitted probability is not the observed category.

For Entropy RSquare and Generalized RSquare, values closer to 1 indicate a better fit. For Mean -Log p, RMSE, Mean Abs Dev, and Misclassification Rate, smaller values indicate a better fit.

**Save Columns** is a submenu for saving model and tree results, and creating SAS code.

- **Save Residuals** saves the residual values from the model to the data table.
- **Save Predicteds** saves the predicted values from the model to the data table.
- **Save Leaf Numbers** saves the leaf numbers of the tree to a column in the data table.
- **Save Leaf Labels** saves leaf labels of the tree to the data table. The labels document each branch that the row would trace along the tree, with each branch separated by "&". An example label could be "size(Small,Medium)&size(Small)". However, JMP does not include redundant information in the form of category labels that are repeated. When a category label for a leaf references an inclusive list of categories in a higher tree node, JMP places a caret (^) where the tree node with redundant labels occurs. Therefore, "size(Small,Medium)&size(Small)" is presented as ^&size(Small).
- **Save Prediction Formula** saves the prediction formula to a column in the data table. The formula is made up of nested conditional clauses that describe the tree structure.
- **Save Leaf Number Formula** saves a column containing a formula in the data table that computes the leaf number.
- **Save Leaf Label Formula** saves a column containing a formula in the data table that computes the leaf label.
- **Make SAS DATA Step** creates SAS code for scoring a new data set.
- **Make Tolerant SAS DATA Step** creates SAS code that can score a data set with missing values.

**Color Points** colors the points based on their response level. This is for categorical responses only, and does the same thing as the Color Points button (see “Categorical Responses,” p. 305).

**Script** is the typical JMP script submenu, used to repeat the analysis or save a scripts.
Note: JMP 8 had a Partition Preference, and a Partition platform option, called Missing Value Rule. These have both been removed for JMP 9. The new method for handling missing values is described in “Missing Values,” p. 322.

Automatic Splitting

The Go button (shown in Figure 15.9) appears when you have validation enabled. For more information on using validation, see “Validation,” p. 317.

The Go button provides for repeated splitting without having to repeatedly click the Split button. When you click the Go button, the platform performs repeated splitting until the validation R-Square is better than what the next 10 splits would obtain. This rule may produce complex trees that are not very interpretable, but have good predictive power.

Using the Go button turns on the Split History command. If using the Go button results in a tree with more than 40 nodes, the Show Tree command is turned off.

Figure 15.9 The Go Button
Bootstrap Forest

**Note:** The Bootstrap Forest method is available only in JMP Pro.

The Bootstrap Forest method makes many trees, and averages the predicted values to get the final predicted value. Each tree is grown on a different random sample (with replacement) of observations, and each split on each tree considers only a random sample of candidate columns for splitting. The process can use validation to assess how many trees to grow, not to exceed the specified number of trees.

Another word for bootstrap-averaging is *bagging*. Those observations included in the growing of a tree are called the in-bag sample, abbreviated IB. Those not included are called the out-of-bag sample, abbreviated OOB.

**Bootstrap Forest Fitting Options**

If the Bootstrap Forest method is selected on the platform launch window, the Bootstrap Forest options window appears after clicking **OK**. Figure 15.10 shows the window using the *Car Poll.jmp* data table. The column *sex* is used as the response, and the other columns are used as the predictors.

![Bootstrap Forest Fitting Options](image)

The options on the Bootstrap Forest options window are described here:

- **Number of rows** gives the number of observations in the data table.
- **Number of terms** gives the number of columns specified as predictors.
- **Number of trees in the forest** is the number of trees to grow, and then average together.
- **Number of terms sampled per split** is the number of columns to consider as splitting candidates at each split. A new random sample of columns is taken from the candidates for each split.
- **Bootstrap sample rate** is the proportion of observations to sample (with replacement) for growing each tree. A new random sample is generated for each tree.
Minimum Splits Per Tree is the minimum number of splits for each tree.

Minimum Size Split is the minimum number of observations needed on a candidate split.

Early Stopping is checked to perform early stopping. If checked, the process stops growing additional trees if adding more trees doesn’t improve the validation statistic. If not checked, the process continues until the specified number of trees is reached. This option appears only if validation is used.

Multiple Fits over number of terms is checked to create a bootstrap forest for several values of Number of Terms. The lower value is specified above by the Number of terms samples per split option. The upper value is specified by the following option:

Max Number of terms is the maximum number of terms to consider for a split.

Bootstrap Forest Report

The Bootstrap Forest report is shown in Figure 15.11.

Figure 15.11 Bootstrap Forest
Chapter 15

Recursive Partitioning

Chapter 15

Recursive Partitioning

Partition Method

Chapter 15

Recursive Partitioning

313

Chapter 15

Recursive Partitioning

Partition Method

Page dimensions: 612.0x792.0

Chapter 15

Recursive Partitioning

Partition Method

The results on the report are described here:

Model Validation - Set Summaries provides fit statistics for all the models fit if you selected the Multiple Fits option on the options window.

Specifications provides information on the partitioning process.

Overall Statistics provides fit statistics for both the training and validation sets.

Confusion Matrix provides two-way classifications of actual and predicted response levels for both the training and validation sets. This is available only with categorical responses.

Cumulative Validation provides a plot of the fit statistics versus the number of trees. The Cumulative Details report below the plot is a tabulation of the data on the plot. This is only available when validation is used.

Per-Tree Summaries gives summary statistics for each tree.

Bootstrap Forest Platform Options

The Bootstrap Forest report red-triangle menu has the following options:

Show Trees is a submenu for displaying the Tree Views report. The report produces a picture of each component tree.

None does not display the Tree Views Report.

Show names displays the trees labeled with the splitting columns.

Show names categories displays the trees labeled with the splitting columns and splitting values.

Show names categories estimates displays the trees labeled with the splitting columns, splitting values, and summary statistics for each node.

Plot Actual by Predicted provides a plot of actual versus predicted values. This is only for continuous responses.

Column Contributions brings up a report showing how each input column contributed to the fit, including how many times it was split and the total $G^2$ or Sum of Squares attributed to that column.

ROC Curve is described in the section “ROC Curve,” p. 319. This is for categorical responses only.

Lift Curve is described in the section “Lift Curves,” p. 321. This is for categorical responses only.

Save Columns is a submenu for saving model and tree results, and creating SAS code.

Save Predicteds saves the predicted values from the model to the data table.

Save Prediction Formula saves the prediction formula to a column in the data table.

Save Tolerant Prediction Formula saves the prediction formula to a column in the data. This formula can predict even with missing values.

Save Residuals saves the residuals to the data table. This is for continuous responses only.

Save Cumulative Details creates a data table containing the fit statistics for each tree.

Make SAS DATA Step creates SAS code for scoring a new data set.

Make Tolerant SAS DATA Step creates SAS code that can score a data set with missing values.

Script is the typical JMP script submenu, used to repeat the analysis or save a scripts.
Boosted Tree

**Note:** The Boosted Tree method is available only in JMP Pro.

Boosting is the process of building a large, additive decision tree by fitting a sequence of smaller trees. Each of the smaller trees is fit on the scaled residuals of the previous tree. The trees are combined to form the larger final tree. The process can use validation to assess how many stages to fit, not to exceed the specified number of stages.

The tree at each stage is short, typically 1-5 splits. After the initial tree, each stage fits the residuals from the previous stage. The process continues until the specified number of stages is reached, or, if validation is used, until fitting an additional stage no longer improves the validation statistic. The final prediction is the sum of the estimates for each terminal node over all the stages.

If the response is categorical, the residuals fit at each stage are offsets of linear logits. The final prediction is a logistic transformation of the sum of the linear logits over all the stages.

For categorical responses, only those with two levels are supported.

**Boosted Tree Fitting Options**

If the Boosted Tree method is selected on the platform launch window, the Boosted Tree options window appears after clicking **OK**. See Figure 15.12.

![Figure 15.12 Boosted Tree Options Window](image)

The options on the Boosted Tree options window are described here:

- **Number of Layers** is the maximum number of stages to include in the final tree.
- **Splits per Tree** is the number of splits for each stage.
- **Learning Rate** is a number such that $0 < r \leq 1$. Learning rates close to 1 result in faster convergence on a final tree, but also have a higher tendency to overfit data. Use learning rates closer to 1 when a small Number of Layers is specified.
- **Overfit Penalty** is a biasing parameter that helps to protect against fitting probabilities equal to zero.
- **Minimum Size Split** is the minimum number of observations needed on a candidate split.
Early Stopping is checked to perform early stopping. If checked, the boosting process stops fitting additional stages if adding more stages doesn’t improve the validation statistic. If not checked, the boosting process continues until the specified number of stages is reached. This option is available only if validation is used.

Multiple Fits over splits and learning rate is checked to create a boosted tree for every combination of Splits per Tree and Learning Rate. The lower ends of the combinations are specified by the Splits per Tree and Learning Rate options. The upper ends of the combinations are specified by the following options:

Max Splits Per Tree is the upper end for Splits per Tree.

Max Learning Rate is the upper end for Learning Rate.

Boosted Tree Report

The Boosted Tree report is shown in Figure 15.13.

Figure 15.13 Boosted Tree Report

The results on the report are described here:

<table>
<thead>
<tr>
<th>N Splits</th>
<th>N Layers</th>
<th>Learning Rate</th>
<th>Rate</th>
<th>Entropy Rate</th>
<th>F-Square</th>
<th>Misclassification Rate</th>
<th>Avg. Log p</th>
<th>RMS Error</th>
<th>Avg. Abs Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>10</td>
<td>0.1</td>
<td>-0.030</td>
<td>0.4464</td>
<td>0.9895</td>
<td>0.0015</td>
<td>0.4926</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>20</td>
<td>0.1</td>
<td>0.0157</td>
<td>0.3425</td>
<td>0.8758</td>
<td>0.4909</td>
<td>0.4906</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>16</td>
<td>0.1</td>
<td>0.0456</td>
<td>0.4786</td>
<td>0.7190</td>
<td>0.6078</td>
<td>0.4916</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>12</td>
<td>0.1</td>
<td>-0.164</td>
<td>0.4800</td>
<td>0.7590</td>
<td>0.5208</td>
<td>0.4977</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specifications

Target Column: sex
Number of Layers: 20
Number of training rows: 230
Number of validation rows: 79
Splits Per Tree: 4
Learning Rate: 0.1
Overfit Penalty: 0.0001

Overall Statistics

<table>
<thead>
<tr>
<th>Measure</th>
<th>Training</th>
<th>Validation Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entropy R Square</td>
<td>0.1224</td>
<td>0.0167 1-LogLikelihood of model</td>
</tr>
<tr>
<td>Generalized R Square</td>
<td>0.1955</td>
<td>0.0213 -LogLikelihood of model</td>
</tr>
<tr>
<td>Mean Log p</td>
<td>0.6956</td>
<td>0.0756 Σ(LogLikelihood)ln</td>
</tr>
<tr>
<td>RMSE</td>
<td>0.4565</td>
<td>0.4862 Σ((y-p)^2)/n</td>
</tr>
<tr>
<td>Mean Abs Dev</td>
<td>0.4449</td>
<td>0.4862 Σ</td>
</tr>
<tr>
<td>Misclassification Rate</td>
<td>0.2281</td>
<td>0.2425 Σ</td>
</tr>
<tr>
<td>N</td>
<td>230</td>
<td>73</td>
</tr>
</tbody>
</table>

Confusion Matrix

<table>
<thead>
<tr>
<th>Actual</th>
<th>Predicted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Female</td>
<td>Male</td>
</tr>
<tr>
<td>Female</td>
<td>46</td>
</tr>
<tr>
<td>Male</td>
<td>15</td>
</tr>
<tr>
<td>Validation</td>
<td>Female</td>
</tr>
<tr>
<td>Female</td>
<td>17</td>
</tr>
<tr>
<td>Male</td>
<td>16</td>
</tr>
</tbody>
</table>

The results on the report are described here:
Model Validation - Set Summaries provides fit statistics for all the models fit if you selected the Multiple Splits option on the options window.

Specifications provides information on the partitioning process.

Overall Statistics provides fit statistics for both the training and validation sets.

Confusion Matrix provides confusion statistics for both the training and validation sets. This is available only with categorical responses.

Cumulative Validation provides a plot of the fit statistics versus the number of stages. The Cumulative Details report below the plot is a tabulation of the data on the plot. This is only available when validation is used.

**Boosted Tree Platform Options**

The Boosted Tree report red-triangle menu has the following options:

- **Show Trees** is a submenu for displaying the Tree Views report. The report produces a picture of the tree at each stage of the boosting process.
  - **None** does not display the Tree Views Report.
  - **Show names** displays the trees labeled with the splitting columns.
  - **Show names categories** displays the trees labeled with the splitting columns and splitting values.
  - **Show names categories estimates** displays the trees labeled with the splitting columns, splitting values, and summary statistics for each node.

- **Plot Actual by Predicted** provides a plot of actual versus predicted values. This is only for continuous responses.

- **Column Contributions** brings up a report showing how each input column contributed to the fit, including how many times it was split and the total $G^2$ or Sum of Squares attributed to that column.

- **ROC Curve** is described in the section “ROC Curve,” p. 319. This is for categorical responses only.

- **Lift Curve** is described in the section “Lift Curves,” p. 321. This is for categorical responses only.

- **Save Columns** is a submenu for saving model and tree results, and creating SAS code.
  - **Save Predicteds** saves the predicted values from the model to the data table.
  - **Save Prediction Formula** saves the prediction formula to a column in the data table.
  - **Save Tolerant Prediction Formula** saves the prediction formula to a column in the data. This formula can predict even with missing values.
  - **Save Residuals** saves the residuals to the data table. This is for continuous responses only.
  - **Save Offset Estimates** saves the offsets from the linear logits. This is for categorical responses only.
  - **Save Tree Details** creates a data table containing split details and estimates for each stage.
  - **Save Cumulative Details** creates a data table containing the fit statistics for each stage.
  - **Make SAS DATA Step** creates SAS code for scoring a new data set.
  - **Make Tolerant SAS DATA Step** creates SAS code that can score a data set with missing values.

- **Script** is the typical JMP script submenu, used to repeat the analysis or save a scripts.
Validation

If you grow a tree with enough splits, partitioning can overfit data. When this happens, the model predicts the fitted data very well, but predicts future observations poorly. Validation is the process of using part of a data set to estimate model parameters, and using the other part to assess the predictive ability of the model.

- The *training* set is the part that estimates model parameters.
- The *validation* set is the part that assesses or validates the predictive ability of the model.
- The *test* set is a final, independent assessment of the model's predictive ability. The test set is available only when using a validation column (see Table 15.1).

The training, validation, and test sets are created by subsetting the original data into parts. Table 15.2 describes several methods for subsetting a data set.

**Table 15.2 Validation Methods**

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Excluded Rows</td>
<td>Uses row states to subset the data. Rows that are unexcluded are used as the training set, and excluded rows are used as the validation set. For more information about using row states and how to exclude rows, see <em>Using JMP</em>.</td>
</tr>
<tr>
<td>Holdback</td>
<td>Randomly divides the original data into the training and validation data sets. The <em>Validation Portion</em> (see Table 15.1) on the platform launch window is used to specify the proportion of the original data to use as the validation data set (holdback).</td>
</tr>
<tr>
<td>KFold</td>
<td>Divides the original data into K subsets. In turn, each of the K sets is used to validate the model fit on the rest of the data, fitting a total of K models. The model giving the best validation statistic is chosen as the final model. KFold validation can be used only with the Decision Tree method. To use KFold, select <em>K Fold Crossvalidation</em> from the platform red-triangle menu, see “Platform Options,” p. 307. This method is best for small data sets, because it makes efficient use of limited amounts of data.</td>
</tr>
</tbody>
</table>
The graph for goodness of fit depends on which type of response you use. The Actual by Predicted plot is for continuous responses, and the ROC Curve and Lift Curve are for categorical responses.

**Actual by Predicted Plot**

For continuous responses, the Actual by Predicted plot shows how well the model fits the data. Each leaf is predicted with its mean, so the x-coordinates are these means. The actual values form a scatter of points around each leaf mean. A diagonal line represents the locus of where predicted and actual values are the same. For a perfect fit, all the points would be on this diagonal.

<table>
<thead>
<tr>
<th>Validation Column</th>
<th>Note: The use of a validation column is available only in JMP Pro.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Uses a column's values to divide the data into parts. The column is assigned using the Validation role on the Partition launch window. See Table 15.1. The column's values determine how the data is split, and what method is used for validation:</td>
</tr>
<tr>
<td></td>
<td>• If the column's values are 0, 1 and 2, then:</td>
</tr>
<tr>
<td></td>
<td>– Rows with 0 are assigned to the Training set</td>
</tr>
<tr>
<td></td>
<td>– Rows with 1 are assigned to the Validation set</td>
</tr>
<tr>
<td></td>
<td>– Rows with 2 are assigned to the Test set</td>
</tr>
<tr>
<td></td>
<td>• If the column's values are 0 and 1, then only Training and Validation sets are used.</td>
</tr>
</tbody>
</table>

**Graphs for Goodness of Fit**

The graph for goodness of fit depends on which type of response you use. The Actual by Predicted plot is for continuous responses, and the ROC Curve and Lift Curve are for categorical responses.
**ROC Curve**

The ROC curve is for categorical responses. The classical definition of ROC curve involves the count of True Positives by False Positives as you accumulate the frequencies across a rank ordering. The True Positive $y$-axis is labeled “Sensitivity” and the False Positive $X$-axis is labeled “1-Specificity”. The idea is that if you slide across the rank ordered predictor and classify everything to the left as positive and to the right as negative, this traces the trade-off across the predictor’s values.

To generalize for polychotomous cases (more than 2 response levels), Partition creates an ROC curve for each response level versus the other levels. If there are only two levels, one is the diagonal reflection of the other, representing the different curves based on which is regarded as the “positive” response level.
ROC curves are nothing more than a curve of the sorting efficiency of the model. The model rank-orders the fitted probabilities for a given \( Y \)-value, then starting at the lower left corner, draws the curve \( up \) when the row comes from that category, and to the right when the \( Y \) is another category.

In the following picture, \( n_1 \) is the number of \( Y \)'s where \( Y=1 \) and \( n_0 \) is the number of \( Y \)'s where \( Y=0 \)

If the model perfectly rank-orders the response values, then the sorted data has all the targeted values first, followed by all the other values. The curve moves all the way to the top before it moves at all to the right.

**Figure 15.14** ROC for Perfect Fit

If the model does not predict well, it wanders more or less diagonally from the bottom left to top right.
In practice, the curve lifts off the diagonal. The area under the curve is the indicator of the goodness of fit, with 1 being a perfect fit.

If a partition contains a section that is all or almost all one response level, then the curve lifts almost vertically at the left for a while. This means that a sample is almost completely sensitive to detecting that level. If a partition contains none or almost none of a response level, the curve at the top will cross almost horizontally for a while. This means that there is a sample that is almost completely specific to not having that response level.

Because partitions contain clumps of rows with the same (i.e. tied) predicted rates, the curve actually goes slanted, rather than purely up or down.

For polytomous cases, you get to see which response categories lift off the diagonal the most. In the CarPoll example above, the European cars are being identified much less than the other two categories. The American's start out with the most sensitive response (Size(Large)) and the Japanese with the most negative specific (Size(Large)'s small share for Japanese).

**Lift Curves**

A lift curve shows the same information as an ROC curve, but in a way to dramatize the richness of the ordering at the beginning. The Y-axis shows the ratio of how rich that portion of the population is in the chosen response level compared to the rate of that response level as a whole. For example, if the top-rated 10% of fitted probabilities have a 25% richness of the chosen response compared with 5% richness over the whole population, the lift curve would go through the X-coordinate of 0.10 at a Y-coordinate of 25% / 5%, or 5. All lift curves reach (1,1) at the right, as the population as a whole has the general response rate.
In problem situations where the response rate for a category is very low anyway (for example, a direct mail response rate), the lift curve explains things with more detail than the ROC curve.

**Figure 15.15 Lift Curve**

Sorted from highest predicted rate to lowest predicted rate.

**Missing Values**

The Partition platform has methods for handling missing values in both $Y$ and $X$ variables.

**Missing Responses**

The handling of missing values for responses depends on if the response is categorical or continuous.
Chapter 15

Recursive Partitioning

Example

Categorical

If the Missing Value Categories checkbox (see Figure 15.2) is not selected, missing rows are not included in the analysis. If the Missing Value Categories checkbox is selected, the missing rows are entered into the analysis as another level of the variable.

Continuous

Rows with missing values are not included in the analysis.

Missing Predictors

The handling of missing values for predictors depends on if it is categorical or continuous.

Categorical

If the variable is used as a splitting variable, and if the Missing Value Categories checkbox (see Figure 15.2) is not selected, then each missing row gets randomly assigned to one of the two sides of the split. When this happens using the Decision Tree method, the **imputes** message appears showing how many times this has happened. See Figure 15.16.

If the variable is used as a splitting variable, and if the Missing Value Categories checkbox is selected, the missing rows are entered into the analysis as another level of the variable.

Continuous

If the variable is used as a splitting variable, then each missing row gets randomly assigned to one of the two sides of the split. When this happens using the Decision Tree method, the **imputes** message appears showing how many times this has happened. See Figure 15.16.

---

**Figure 15.16** Impute Message

<table>
<thead>
<tr>
<th>RSquare</th>
<th>N of Stmts</th>
<th>Imputes</th>
<th>AICc</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.936</td>
<td>383</td>
<td>2</td>
<td>53.872</td>
</tr>
</tbody>
</table>

Ten observations were missing and randomly assigned to a split

---

Example

The examples in this section use the **Boston Housing.jmp** data table. Suppose you are interested in creating a model to predict the median home value as a function of several demographic characteristics.

The Partition platform can be used to quickly assess if there is any relationship between the response and the potential predictor variables. Build a tree using all three partitioning methods, and compare the results.
Decision Tree

Follow the steps below to grow a tree using the Decision Tree method:

1. Select **Analyze > Modeling > Partition**.
2. Assign *mvalue* to the **Y, Response** role.
3. Assign the other variables (crim through lstat) to the **X, Factor** role.
4. If using JMP Pro, select the **Decision Tree** option from the Method menu. If using JMP, the Decision Tree option is the method that gets used.
5. Enter 0.2 for the **Validation Portion**.
6. Click **OK**.
7. On the platform report window, click **Go** to perform automatic splitting.
8. Select **Plot Actual by Predicted** from the platform red-triangle menu.

A portion of the report is shown in Figure 15.17.
Follow the steps below to grow a tree using the Bootstrap Forest method:

1. Select Analyze > Modeling > Partition.
2. Assign mvalue to the Y, Response role.
3. Assign the other variables (crim through lstat) to the X, Factor role.
4. Select Bootstrap Forest from the Method menu.
5. Enter 0.2 for the Validation Portion.
6. Click OK.
7. Check the Early Stopping option on the Bootstrap Forest options window.
8. Click OK.
9. Select **Plot Actual by Predicted** from the red-triangle menu.

The report is shown in Figure 15.18.

---

**Figure 15.18** Bootstrap Forest Report

![Bootstrap Forest Report](image-url)

---
Boosted Tree

Follow the steps below to grow a tree using the Boosted Tree method:

1. Select Analyze > Modeling > Partition.
2. Assign mvalue to the Y, Response role.
3. Assign the other variables (crim through lstat) to the X, Factor role.
4. Select Boosted Tree from the Method menu.
5. Enter 0.2 for the Validation Portion.
6. Click OK.
7. Check the Early Stopping option on the Boosted Tree options window.
8. Click OK.
9. Select Plot Actual by Predicted on the red-triangle menu.

The report is shown in Figure 15.19.
Compare Methods

The Decision Tree method produced a tree with 7 splits. The Bootstrap Forest method produced a final tree with 20 component trees. The Boosted Tree method produced a final tree with 50 component trees.

The Validation R-Square from the three methods are different, with the Boosted Tree having the best:

- Decision Tree 0.647
- Bootstrap Forest 0.716
- Boosted Tree 0.847
The actual-by-predicted plots show that the Boosted Tree method is best at predicting the actual median home values. The points on the plot are closer to the line for the Boosted Tree method.

Figure 15.20 shows a summary of the **Column Contributions** report from each method.

---

**Figure 15.20 Column Contributions**

All three methods indicate that **rooms** and **lstat** are the most important variables for predicting median home value.
Statistical Details

This section provides some quantitative details and other information.

**General**

The response can be either continuous, or categorical (nominal or ordinal). If $Y$ is categorical, then it is fitting the probabilities estimated for the response levels, minimizing the residual log-likelihood chi-square [2*entropy]. If the response is continuous, then the platform fits means, minimizing the sum of squared errors.

The factors can be either continuous, or categorical (nominal or ordinal). If an $X$ is continuous, then the partition is done according to a splitting "cut" value for $X$. If $X$ is categorical, then it divides the $X$ categories into two groups of levels and considers all possible groupings into two levels.

**Splitting Criterion**

For continuous responses, the statistic is the Sum of Squares (SS). This is the change in the error sum-of-squares due to the split.

A candidate SS that has been chosen is

$$ SS_{test} = SS_{parent} - (SS_{right} + SS_{left}) $$

where SS in a node is just $s^2(n - 1)$.

For categorical responses, the criterion is the likelihood-ratio chi-square, reported as $G^2$ in the report. This is actually twice the [natural log] entropy or twice the change in the entropy. Entropy is $\sum -\log(p)$ for each observation, where $p$ is the probability attributed to the response that occurred.

A candidate $G^2$ that has been chosen is

$$ G^2_{test} = G^2_{parent} - (G^2_{left} + G^2_{right}). $$

When Partition calculates a $G^2$ or $R^2$ on excluded data for a categorical response, it uses the rate value $0.25/\bar{m}$ when it encounters a zero rate in a group with $\bar{m}$ rows. Otherwise, a missing statistic would be reported, since the logarithm of zero is undefined.

LogWorth is reported in node Candidate reports. LogWorth is calculated as:

$$ -\log_{10}(p\text{-value}) $$

where the adjusted $p$-value is calculated in a complex manner that takes into account the number of different ways splits can occur. This calculation is very fair compared to the unadjusted $p$-value, which favors $X$’s with many levels, and the Bonferroni $p$-value, which favors $X$’s with small numbers of levels. Details on the method are discussed in a white paper “Monte Carlo Calibration of Distributions of Partition Statistics” found on the jmp website www.jmp.com.
Predicted Probabilities in Decision Tree and Bootstrap Forest

The predicted probabilities for the Decision Tree and Bootstrap Forest methods are calculated as described below by the Prob statistic.

For categorical responses in Decision Tree, the Show Split Prob command shows the following statistics:

**Rate** is the proportion of observations at the node for each response level.

**Prob** is the predicted probability for that node of the tree. The method for calculating Prob for the $i^{th}$ response level at a given node is as follows:

$$
\text{Prob}_i = \frac{n_i + \text{prior}_i}{\sum (n_i + \text{prior}_i)}
$$

where the summation is across all response levels, $n_i$ is the number of observations at the node for the $i^{th}$ response level, and prior$_i$ is the prior probability for the $i^{th}$ response level, calculated as

$$
\text{prior}_i = \lambda \cdot \text{prior}_i + (1-\lambda) \cdot P_i
$$

where $\text{prior}_i$ is the prior from the parent node, $P_i$ is the Prob$_i$ from the parent node, and $\lambda$ is a weighting factor currently set at 0.9.

The estimate, Prob, is the same that would be obtained for a Bayesian estimate of a multinomial probability parameter with a conjugate Dirichlet prior.

The method for calculating Prob assures that the predicted probabilities are always non-zero.
The Time Series platform lets you explore, analyze, and forecast univariate time series. A time series is a set \( y_1, y_2, \ldots, y_N \) of observations taken over a series of equally-spaced time periods. The analysis begins with a plot of the points in the time series. In addition, the platform displays graphs of the autocorrelations and partial autocorrelations of the series. These indicate how and to what degree each point in the series is correlated with earlier values in the series. You can interactively add:

- **Variograms** a characterization of process disturbances
- **AR coefficients** autoregressive coefficients
- **Spectral Density Plots** versus period and frequency, with white noise tests.

These graphs can be used to identify the type of model appropriate for describing and predicting (forecasting) the evolution of the time series. The model types include:

- **ARIMA** autoregressive integrated moving-average, often called Box-Jenkins models
- **Seasonal ARIMA** ARIMA models with a seasonal component
- **Smoothing Models** several forms of exponential smoothing and Winter’s method
- **Transfer Function Models** for modeling with input series.

**Note:** The Time Series Launch dialog requires that one or more continuous variables be assigned as the time series. Optionally, you can specify a time ID variable, which is used to label the time axis, or one or more input series. If a time ID variable is specified, it must be continuous, sorted ascending, and without missing values.
## Contents

Launch the Platform ................................. 335

Time Series Commands ......................... 336
   Graph ........................................ 337
   Autocorrelation .............................. 337
   Partial Autocorrelation ................. 337
   Variogram ................................ 338
   AR Coefficients ............................. 338
   Spectral Density ............................ 339
   Save Spectral Density .................... 340
   Number of Forecast Periods ............. 341
   Difference ................................ 341

Modeling Reports .............................. 342
   Model Comparison Table .................. 342
   Model Summary Table ..................... 343
   Parameter Estimates Table .............. 345
   Forecast Plot ................................ 346
   Residuals .................................. 346
   Iteration History ......................... 346
   Model Report Options ..................... 347

ARIMA Model ................................ 347
Seasonal ARIMA ................................. 348
ARIMA Model Group ......................... 349

Transfer Functions .............................. 350
   Report and Menu Structure ............... 350
   Diagnostics ................................ 352
   Model Building .............................. 353
   Transfer Function Model ................. 354
   Model Reports ............................... 356
   Model Comparison Table ................. 358
   Fitting Notes ................................ 358

Smoothing Models ............................... 358
Launch the Platform

To begin a time series analysis, choose the Time Series command from the Analyze > Modeling submenu to display the Time Series Launch dialog (Figure 16.1). This dialog allows you to specify the number of lags to use in computing the autocorrelations and partial autocorrelations. It also lets you specify the number of future periods to forecast using each model fitted to the data. After you select analysis variables and click OK on this dialog, a platform launches with plots and accompanying text reports for each of the time series (Y) variables you specified.

Select Columns into Roles

You assign columns for analysis with the dialog in Figure 16.1. The selector list at the left of the dialog shows all columns in the current table. To cast a column into a role, select one or more columns in the column selector list and click a role button. Or, drag variables from the column selector list to one of the following role boxes:

- **X, Time ID** for the x-axis, one variable used for labeling the time axis
- **Y, Time Series** for the y-axis, one or more time series variables.

If you use a X, Time ID variable, you can specify the time frequency by using the Time Frequency column property. The choices are Annual, Monthly, Weekly, Daily, Hourly, Minute, and Second. This lets JMP take things like leap years and leap days into account. If no frequency is specified, the data is treated as equally spaced numeric data.

To remove an unwanted variable from an assigned role, select it in the role box and click Remove. After assigning roles, click OK to see the analysis for each time series variable versus the time ID.

You set the number of lags for the autocorrelation and partial autocorrelation plots in the Autocorrelation Lags box. This is the maximum number of periods between points used in the computation of the correlations. It must be more than one but less than the number of rows. A commonly used rule of thumb for the maximum number of lags is \( n/4 \), where \( n \) is the number of observations. The Forecast Periods box allows you to set the number of periods into the future that the fitted models are forecast. By default, JMP uses 25 lags and 25 forecast periods.

The data for the next examples are in the Seriesg.jmp table found in the Time Series sample data folder (Box and Jenkins 1976). The time series variable is Passengers and the Time ID is Time.
The Time Series Graph

The Time Series platform begins with a plot of each times series by the time ID, or row number if no time ID is specified (Figure 16.2). The plot, like others in JMP, has features to resize the graph, highlight points with the cursor or brush tool, and label points. See the Using JMP for a discussion of these features.

If you open Time Series Basic Diagnostic Tables, graphs of the autocorrelation and partial autocorrelation (Figure 16.3) of the time series are shown.

The platform popup menu, discussed next, also has fitting commands and options for displaying additional graphs and statistical tables.

Time Series Commands

The platform red-triangle menu has the options described in the following sections.
Chapter 16

Time Series Analysis

Time Series Commands

Graph

The Time Series platform begins by showing a time series plot, like the one shown previously in Figure 16.2. The **Graph** command on the platform popup menu has a submenu of controls for the time series plot with the following commands.

- **Time Series Graph** hides or displays the time series graph.
- **Show Points** hides or displays the points in the time series graph.
- **Connecting Lines** hides or displays the lines connecting the points in the time series graph.
- **Mean Line** hides or displays a horizontal line in the time series graph that depicts the mean of the time series.

Autocorrelation

The **Autocorrelation** command alternately hides or displays the autocorrelation graph of the sample, often called the *sample autocorrelation function*. This graph describes the correlation between all the pairs of points in the time series with a given separation in time or lag. The autocorrelation for the \( k \)th lag is

\[
\begin{align*}
    r_k &= \frac{c_k}{c_0} \\
    c_k &= \frac{1}{N} \sum_{t = k + 1}^{N} (y_t - \bar{y})(y_{t-k} - \bar{y})
\end{align*}
\]

where \( \bar{y} \) is the mean of the \( N \) nonmissing points in the time series. The bars graphically depict the autocorrelations.

By definition, the first autocorrelation (lag 0) always has length 1. The curves show twice the large-lag standard error (± 2 standard errors), computed as

\[
\text{SE}_k = \sqrt{\frac{1}{N} \left( \frac{k - 1}{1 + 2 \sum_{i=1}^{k-1} r_i^2} \right)}
\]

The autocorrelation plot for the **Seriesg** data is shown on the left in Figure 16.3. You can examine the autocorrelation and partial autocorrelations plots to determine whether the time series is stationary (meaning it has a fixed mean and standard deviation over time) and what model might be appropriate to fit the time series.

In addition, the Ljung-Box \( Q \) and \( p \)-values are shown for each lag. The \( Q \)-statistic is used to test whether a group of autocorrelations is significantly different from zero or to test that the residuals from a model can be distinguished from white-noise.

Partial Autocorrelation

The **Partial Autocorrelation** command alternately hides or displays the graph of the sample partial autocorrelations. The plot on the right in Figure 16.3 shows the partial autocorrelation function for the **Seriesg** data. The solid blue lines represent ± 2 standard errors for approximate 95% confidence limits, where the standard error is computed.
SE_k = \frac{1}{\sqrt{n}} \text{ for all } k

Figure 16.3  Autocorrelation and Partial Correlation Plots

Variogram

The Variogram command alternately displays or hides the graph of the variogram. The variogram measures the variance of the differences of points \( k \) lags apart and compares it to that for points one lag apart. The variogram is computed from the autocorrelations as

\[ V_k = \frac{1 - r_k + 1}{1 - r_1} \]

where \( r_k \) is the autocorrelation at lag \( k \). The plot on the left in Figure 16.4 shows the Variogram graph for the Seriesg data.

AR Coefficients

The AR Coefficients command alternately displays or hides the graph of the least squares estimates of the autoregressive (AR) coefficients. The definition of these coefficients is given below. These coefficients approximate those that you would obtain from fitting a high-order, purely autoregressive model. The right-hand graph in Figure 16.4 shows the AR coefficients for the Seriesg data.
The **Spectral Density** command alternately displays or hides the graphs of the spectral density as a function of period and frequency (Figure 16.5).

The least squares estimates of the coefficients of the Fourier series

\[ a_i = \frac{2}{N} \sum_{i=1}^{N} y_i \cos(2\pi f_i i) \]

and

\[ b_i = \frac{2}{N} \sum_{i=1}^{N} y_i \sin(2\pi f_i i) \]

where \( f_i = i/N \) are combined to form the periodogram \( I(f_i) = \frac{N}{2}(a_i^2 + b_i^2) \), which represents the intensity at frequency \( f_i \).

The periodogram is smoothed and scaled by \( 1/(4\pi) \) to form the spectral density.
The *Fisher's Kappa* statistic tests the null hypothesis that the values in the series are drawn from a normal distribution with variance 1 against the alternative hypothesis that the series has some periodic component. Kappa is the ratio of the maximum value of the periodogram, $I(f_i)$, and its average value. The probability of observing a larger Kappa if the null hypothesis is true is given by

$$ (k > \kappa) = 1 - \sum_{j=0}^{q} (-1)^j \left( \frac{q}{j} \right) \left[ \max \left( 1 - \frac{2j}{q}, 0 \right) \right]^{q-1} $$

where $q = N/2$ if $N$ is even, $q = (N - 1)/2$ if $N$ is odd, and $\kappa$ is the observed value of Kappa. The null hypothesis is rejected if this probability is less than the significance level $\alpha$.

For $q - 1 > 100$, Bartlett's *Kolmogorov-Smirnov* compares the normalized cumulative periodogram to the cumulative distribution function of the uniform distribution on the interval $(0, 1)$. The test statistic equals the maximum absolute difference of the cumulative periodogram and the uniform CDF. If it exceeds $\alpha/(\sqrt{N})$, then reject the hypothesis that the series comes from a normal distribution. The values $\alpha = 1.36$ and $\alpha = 1.63$ correspond to significance levels 5% and 1% respectively.

**Figure 16.5** Spectral Density Plots

**Save Spectral Density**

*Save Spectral Density* creates a new table containing the spectral density and periodogram where the $i$th row corresponds to the frequency $f_i = 1/N$ (that is, the $i$th harmonic of $1/N$).

The new data table has these columns:

- **Period** is the period of the $i$th harmonic, $1/f_i$.
- **Frequency** is the frequency of the harmonic, $f_i$.
- **Angular Frequency** is the angular frequency of the harmonic, $2\pi f_i$.
- **Sine** is the Fourier sine coefficients, $a_i$.
- **Cosine** is the Fourier cosine coefficients, $b_i$. 
**Periodogram** is the periodogram, $P(f)$.

**Spectral Density** is the spectral density, a smoothed version of the periodogram.

**Number of Forecast Periods**

The **Number of Forecast Periods** command displays a dialog for you to reset the number of periods into the future that the fitted models will forecast. The initial value is set in the Time Series Launch dialog. All existing and future forecast results will show the new number of periods with this command.

**Difference**

Many time series do not exhibit a fixed mean. Such nonstationary series are not suitable for description by some time series models such as those with only autoregressive and moving average terms (ARMA models). However, these series can often be made stationary by differencing the values in the series. The differenced series is given by

$$w_t = (1 - B)^d (1 - B^s)^D y_t$$

where $t$ is the time index and $B$ is the backshift operator defined by $By_t = y_{t-1}$.

The **Difference** command computes the differenced series and produces graphs of the autocorrelations and partial autocorrelations of the differenced series. These graphs can be used to determine if the differenced series is stationary.

Several of the time series models described in the next sections accommodate a differencing operation (the ARIMA, Seasonal ARIMA models, and some of the smoothing models). The **Difference** command is useful for determining the order of differencing that should be specified in these models.

The Specify Differencing dialog appears in the report window when you select the Difference command. It allows you to specify the differencing operation you want to apply to the time series. Click **Estimate** to see the results of the differencing operation. The Specify Differencing dialog allows you to specify the Nonseasonal Differencing Order, $d$, the Seasonal Differencing Order, $D$, and the number of Periods Per Season, $s$. Selecting zero for the value of the differencing order is equivalent to no differencing of that kind.

The red triangle menu on the Difference plot has the following options:

- **Graph** controls the plot of the differenced series and behaves the same as those under the Time Series **Graph** menu.
Autocorrelation alternately displays or hides the autocorrelation of the differenced series.

Partial Autocorrelation alternately hides or displays the partial autocorrelations of differenced series.

Variogram alternately hides or displays the variogram of the differenced series.

Save appends the differenced series to the original data table. The leading \( d + sD \) elements are lost in the differencing process. They are represented as missing values in the saved series.

### Modeling Reports

The time series modeling commands are used to fit theoretical models to the series and use the fitted model to predict (forecast) future values of the series. These commands also produce statistics and residuals that allow you to ascertain the adequacy of the model you have elected to use. You can select the modeling commands repeatedly. Each time you select a model, a report of the results of the fit and a forecast is added to the platform results.

The fit of each model begins with a dialog that lets you specify the details of the model being fit as well as how it will be fit. Each general class of models has its own dialog, as discussed in their respective sections. The models are fit by maximizing the likelihood function, using a Kalman filter to compute the likelihood function. The ARIMA, seasonal ARIMA, and smoothing models begin with the following report tables.

### Model Comparison Table

Figure 16.6 shows the Model Comparison Report.

#### Figure 16.6 Model Comparison

The Model Comparison table summarizes the fit statistics for each model. You can use it to compare several models fitted to the same time series. Each row corresponds to a different model. The models are sorted by the AIC statistic. The Model Comparison table shown above summarizes the ARIMA models \((1, 0, 0)\), \((0, 0, 1)\), \((1, 0, 1)\), and \((1, 1, 1)\) respectively. Use the Report checkbox to show or hide the Model Report for a model.

The Model Comparison report has red-triangle menus for each model, with the following options:

- **Fit New** opens a window giving the settings of the model. You can change the settings to fit a different model.

- **Simulate Once** provides one simulation of the model out \( k \) time periods. The simulation is shown on the Model Comparison time series plot. To change \( k \), use the Number of Forecast Periods option on the platform red-triangle menu.
Simulate More provides the specified number of simulations of the model out \( k \) time periods. The simulations are shown on the Model Comparison time series plot. To change \( k \), use the Number of Forecast Periods option on the platform red-triangle menu.

Remove Model Simulation removes the simulations for the given model.

Remove All Simulation removes the simulations for all models.

Generate Simulation generates simulations for the given model, and stores the results in a data table. You specify the random seed, number of simulations, and the number of forecast periods.

Set Seed is used to specify the seed for generating the next forecasts.

The Model Comparison report provides plots for a model when the Graph checkbox is selected. Figure 16.7 shows the plots for the ARIMA(1,1,1) model.

![Model Plots](image)

The top plot is a time series plot of the data, forecasts, and confidence limits. Below that are plots of the autocorrelation and partial autocorrelation functions.

Model Summary Table

Each model fit generates a Model Summary table, which summarizes the statistics of the fit. In the formulae below, \( n \) is the length of the series and \( k \) is the number of fitted parameters in the model.

\[
\text{DF} \quad \text{is the number of degrees of freedom in the fit, } n - k.
\]

\[
\text{Sum of Squared Errors} \quad \text{is the sum of the squared residuals.}
\]
### Variance Estimate

The unconditional sum of squares (SSE) divided by the number of degrees of freedom, SSE / (n – k). This is the sample estimate of the variance of the random shocks, described in the section “ARIMA Model,” p. 347.

### Standard Deviation

Is the square root of the variance estimate. This is a sample estimate of the standard deviation of the random shocks.

### Akaike's Information Criterion (AIC), Schwarz's Bayesian Criterion (SBC or BIC)

Smaller values of these criteria indicate better fit. They are computed:

\[
\text{AIC} = -2 \log \text{likelihood} + 2k \quad \text{and} \quad \text{SBC} = -2 \log \text{likelihood} + k \ln(n)
\]

### RSquare

RSquare is computed

\[
1 - \frac{\text{SSE}}{\text{SST}} \quad \text{where} \quad \text{SST} = \sum_{i=1}^{n} (y_i - \bar{y})^2 \quad \text{and} \quad \text{SSE} = \sum_{i=1}^{n} (y_i - \hat{y}_i)^2 \quad \text{where} \quad \hat{y}_i \text{ are the one-step-ahead forecasts,}
\]

and \( \bar{y} \) is the mean \( y_i \).

If the model fits the series badly, the model error sum of squares, SSE might be larger than the total sum of squares, SST and \( R^2 \) will be negative.

### RSquare Adj

The adjusted \( R^2 \) is

\[
1 - \left[ \frac{(n - 1)}{(n - k)} \left( 1 - R^2 \right) \right]
\]

### MAPE

Is the Mean Absolute Percentage Error, and is computed

\[
100 \sum_{i=1}^{n} \left| \frac{y_i - \hat{y}_i}{y_i} \right|
\]

### MAE

Is the Mean Absolute Error, and is computed

\[
\frac{1}{n} \sum_{i=1}^{n} |y_i - \hat{y}_i|
\]

### -2LogLikelihood

Is minus two times the natural log of the likelihood function evaluated at the best-fit parameter estimates. Smaller values are better fits.
Stable indicates whether the autoregressive operator is stable. That is, whether all the roots of
\( \phi(z) = 0 \) lie outside the unit circle.

Invertible indicates whether the moving average operator is invertible. That is, whether all the roots of
\( \theta(z) = 0 \) lie outside the unit circle.

Note: The \( \phi \) and \( \theta \) operators are defined in the section “ARIMA Model,” p. 347.

Parameter Estimates Table

| Term | Lag | Estimate | Std Error | t Ratio | Prob>|t| |
|------|-----|----------|-----------|---------|-------|
| AR1  | 1   | -0.479762| 0.111624  | -4.14   | 0.001 |
| MA1  | 1   | -0.386542| 0.070139  | -5.51   | 0.001 |
| Intercept | 0 | 2.450862 | 2.256442 | 0.75    | 0.4523 |

The Parameter Estimates table gives the estimates for the time series model parameters. Each type of model has its own set of parameters. They are described in the sections on specific time series models. The Parameter Estimates table has these terms:

**Term** lists the name of the parameter. These are described below for each model type. Some models contain an intercept or mean term. In those models, the related constant estimate is also shown. The definition of the constant estimate is given under the description of ARIMA models.

**Factor (Seasonal ARIMA only)** lists the factor of the model that contains the parameter. This is only shown for multiplicative models. In the multiplicative seasonal models, Factor 1 is nonseasonal and Factor 2 is seasonal.

**Lag (ARIMA and Seasonal ARIMA only)** lists the degree of the lag or backshift operator that is applied to the term to which the parameter is multiplied.

**Estimate** lists the parameter estimates of the time series model.

**Std Error** lists the estimates of the standard errors of the parameter estimates. They are used in constructing tests and confidence intervals.

**t Ratio** lists the test statistics for the hypotheses that each parameter is zero. It is the ratio of the parameter estimate to its standard error. If the hypothesis is true, then this statistic has an approximate Student’s \( t \)-distribution. Looking for a \( t \)-ratio greater than 2 in absolute value is a common rule of thumb for judging significance because it approximates the 0.05 significance level.

**Prob>|t|** lists the observed significance probability calculated from each \( t \)-ratio. It is the probability of getting, by chance alone, a \( t \)-ratio greater (in absolute value) than the computed value, given a true hypothesis. Often, a value below 0.05 (or sometimes 0.01) is interpreted as evidence that the parameter is significantly different from zero.

The Parameter Estimates table also gives the Constant Estimate, for models that contain an intercept or mean term. The definition of the constant estimate is given under “ARIMA Model,” p. 347.
Forecast Plot

Each model has its own Forecast plot. The Forecast plot shows the values that the model predicts for the time series. It is divided by a vertical line into two regions. To the left of the separating line the one-step-ahead forecasts are shown overlaid with the input data points. To the right of the line are the future values forecast by the model and the confidence intervals for the forecasts.

You can control the number of forecast values by changing the setting of the Forecast Periods box in the platform launch dialog or by selecting Number of Forecast Periods from the Time Series drop-down menu. The data and confidence intervals can be toggled on and off using the Show Points and Show Confidence Interval commands on the model’s popup menu.

Residuals

The graphs under the residuals section of the output show the values of the residuals based on the fitted model. These are the actual values minus the one-step-ahead predicted values. In addition, the autocorrelation and partial autocorrelation of these residuals are shown. These can be used to determine whether the fitted model is adequate to describe the data. If it is, the points in the residual plot should be normally distributed about the zero line and the autocorrelation and partial autocorrelation of the residuals should not have any significant components for lags greater than zero.

Iteration History

The model parameter estimation is an iterative procedure by which the log-likelihood is maximized by adjusting the estimates of the parameters. The iteration history for each model you request shows the value of the objective function for each iteration. This can be useful for diagnosing problems with the fitting procedure. Attempting to fit a model which is poorly suited to the data can result in a large number of iterations that fail to converge on an optimum value for the likelihood. The Iteration History table shows the following quantities:

- **Iter** lists the iteration number.
- **Iteration History** lists the objective function value for each step.
Step lists the type of iteration step.
Obj-Criterion lists the norm of the gradient of the objective function.

Model Report Options

The title bar for each model you request has a popup menu, with the following options for that model:

- **Show Points** hides or shows the data points in the forecast graph.
- **Show Confidence Interval** hides or shows the confidence intervals in the forecast graph.
- **Save Columns** creates a new data table with columns representing the results of the model.
- **Save Prediction Formula** saves the data and prediction formula to a new data table.
- **Create SAS Job** creates SAS code that duplicates the model analysis in SAS.
- **Submit to SAS** submits code to SAS that duplicates the model analysis. If you are not connected to a SAS server, prompts guide you through the connection process.
- **Residual Statistics** controls which displays of residual statistics are shown for the model. These displays are described in the section “Time Series Commands,” p. 336; however, they are applied to the residual series.

ARIMA Model

An AutoRegressive Integrated Moving Average (ARIMA) model predicts future values of a time series by a linear combination of its past values and a series of errors (also known as random shocks or innovations). The ARIMA command performs a maximum likelihood fit of the specified ARIMA model to the time series.

For a response series \( \{y_t\} \), the general form for the ARIMA model is:

\[
\phi(B)(w_t - \mu) = \theta(B)a_t
\]

where

- \( t \) is the time index
- \( B \) is the backshift operator defined as \( B y_t = y_{t-1} \)

\[
w_t = (1 - B)^d y_t \text{ is the response series after differencing}
\]

\( \mu \) is the intercept or mean term.
\( \phi(B) \) and \( \theta(B) \), respectively, the autoregressive operator and the moving average operator and are written

\[
\phi(B) = 1 - \phi_1 B - \phi_2 B^2 - \ldots - \phi_p B^p \quad \text{and} \quad \theta(B) = 1 - \theta_1 B - \theta_2 B^2 - \ldots - \theta_q B^q
\]

\( a_t \) are the sequence of random shocks.

The \( a_t \) are assumed to be independent and normally distributed with mean zero and constant variance.
The model can be rewritten as
\[ \phi(B)w_t = \delta + \theta(B)a_t \]
where the constant estimate \( \delta \) is given by the relation
\[ \delta = \phi(B)\mu = \mu - \phi_1\mu - \phi_2\mu - \ldots - \phi_p\mu. \]

The ARIMA command displays the Specify ARIMA Model dialog, which allows you to specify the ARIMA model you want to fit. The results appear when you click **Estimate**.

**Seasonal ARIMA**

In the case of **Seasonal ARIMA** modeling, the differencing, autoregressive, and moving average operators are the product of seasonal and nonseasonal polynomials:

\[ w_t = (1 - B)^d (1 - B^s)^D y_t \]
\[ \varphi(B) = (1 - \varphi_1 B - \varphi_{1,2} B^2 - \ldots - \varphi_{1,p} B^p)(1 - \varphi_2 B^s - \varphi_{2,2} B^{2s} - \ldots - \varphi_{2,p} B^{ps}) \]
\[ \phi(B) = (1 - \theta_1 B - \theta_2 B^2 - \ldots - \theta_q B^q)(1 - \phi_1 B - \phi_2 B^2 - \ldots - \phi_P B^P) \]

where \( s \) is the number of periods in a season. The first index on the coefficients is the factor number (1 indicates nonseasonal, 2 indicates seasonal) and the second is the lag of the term.

The Seasonal ARIMA dialog appears when you select the Seasonal ARIMA command. It has the same elements as the ARIMA dialog and adds elements for specifying the seasonal autoregressive order (\( P \)), seasonal differencing order (\( D \)), and seasonal moving average order (\( Q \)). Also, the Periods Per Season box lets you specify the number of periods per season (\( s \)). The seasonal ARIMA models are denoted as Seasonal ARIMA(\( p,d,q \))(\( P,D,Q \)).

**ARIMA Model Group**

The ARIMA Model Group option on the platform red-triangle menu allows the user to fit a range of ARIMA or Seasonal ARIMA models by specifying the range of orders. Figure 16.8 shows the dialog.
Transfer Functions

This example analyzes the gas furnace data (seriesJ.jmp) from Box and Jenkins. To begin the analysis, select Input Gas Rate as the Input List and Output CO2 as the Y, Time Series. The launch dialog should appear as in Figure 16.9.

Figure 16.9 Series J Launch Dialog

When you click OK, the report in Figure 16.10 appears.

Report and Menu Structure

This preliminary report shows diagnostic information and groups the analysis in two main parts. The first part, under Time Series Output CO2, contains analyses of the output series, while the Input Time Series Panel, contains analyses on the input series. The latter may include more than one series.
Each report section has its own set of commands. For the output (top) series, the commands are accessible from the red triangle on the outermost outline bar (Transfer Function Analysis). For the input (bottom) series, the red triangle is located on the inner outline bar (Input Series: Input Gas Rate).

Figure 16.11 shows these two command sets. Note their organization. Both start with a Graph command. The next set of commands are for exploration. The third set is for model building. The fourth set includes functions that control the platform.
Both parts give basic diagnostics, including the sample mean (Mean), sample standard deviation (Std), and series length (N).

In addition, the platform tests for stationarity using Augmented Dickey-Fuller (ADF) tests.

- **Zero Mean ADF** tests against a random walk with zero mean, *i.e.*
  \[ x_t = \phi x_{t-1} + \epsilon_t \]

- **Single Mean ADF** tests against a random walk with a non-zero mean, *i.e.*
  \[ x_t - \mu = \phi(x_{t-1} - \mu) + \epsilon_t \]

- **Trend ADF** tests against a random walk with a non-zero mean and a linear trend, *i.e.*
  \[ x_t - \mu - \beta t = \phi(x_{t-1} - \mu - \beta(t-1)) + \epsilon_t \]

Basic diagnostics also include the autocorrelation and partial autocorrelation functions, as well as the Ljung-Box Q-statistic and p-values, found under the **Time Series Basic Diagnostics** outline node.

The **Cross Correlation** command adds a cross-correlation plot to the report. The length of the plot is twice that of an autocorrelation plot, or \(2 \times \text{ACF length} + 1\).
The plot includes plots of the output series versus all input series, in both numerical and graphical forms. The blue lines indicate standard errors for the statistics.

**Model Building**

Building a transfer function model is quite similar to building an ARIMA model, in that it is an iterative process of exploring, fitting, and comparing.

Before building a model and during the data exploration process, it is sometimes useful to prewhiten the data. This means find an adequate model for the input series, apply the model to the output, and get residuals from both series. Compute cross-correlations from residual series and identify the proper orders for the transfer function polynomials.

To prewhiten the input series, select the Prewhitening command. This brings up a dialog similar to the ARIMA dialog where you specify a stochastic model for the input series. For our SeriesJ example, we use an ARMA(2,2) prewhitening model, as shown in Figure 16.13.
Figure 16.13 Prewhitening Dialog

Click **Estimate** to reveal the Prewhitening plot.

Patterns in these plots suggest terms in the transfer function model.

**Transfer Function Model**

A typical transfer function model with m inputs can be represented as

\[ Y_t - \mu = \frac{\omega_1(B)\theta(B)}{\delta_1(B)\phi(B)} X_{1,t} + \ldots + \frac{\omega_m(B)\theta(B)}{\delta_m(B)\phi(B)} X_{m,t-dm} + \epsilon_t \]

where

- \( Y_t \) denotes the output series
- \( X_1 \) to \( X_m \) denote input series
Chapter 16

Time Series Analysis

Transfer Functions

\( e_t \) represents the noise series

\( X_{1,t-d_1} \) indicates the series \( X_1 \) is indexed by \( t \) with a \( d_1 \)-step lag

\( \mu \) represents the mean level of the model

\( \phi(B) \) and \( \theta(B) \) represent autoregressive and moving average polynomials from an ARIMA model

\( \omega_k(B) \) and \( \delta_k(B) \) represent numerator and denominator factors (or polynomials) for individual transfer functions, with \( k \) representing an index for the 1 to \( m \) individual inputs.

Each polynomial in the above model can contain two parts, either nonseasonal, seasonal, or a product of the two as in seasonal ARIMA. When specifying a model, leave the default 0 for any part that you do not want in the model.

Select Transfer Function to bring up the model specification dialog.

**Figure 16.14 Transfer Function Specification Dialog**

The dialog consists of several parts.

- **Noise Series Orders** contains specifications for the noise series. Lowercase letters are coefficients for non-seasonal polynomials, and uppercase letters for seasonal ones.

- **Choose Inputs** lets you select the input series for the model.

- **Input Series Orders** specifies polynomials related to the input series. The first three orders deal with non-seasonal polynomials. The next four are for seasonal polynomials. The final is for an input lag.

In addition, there are three options that control model fitting.

- **Intercept** specifies whether \( \mu \) is zero or not.

- **Alternative Parameterization** specifies whether the general regression coefficient is factored out of the numerator polynomials.
Constrain Fit  toggles constraining of the AR and MA coefficients.

Forecast Periods  specifies the number of forecasting periods for forecasting.

Using the information from prewhitening, we specify the model as shown in Figure 16.14.

Model Reports

The analysis report is titled Transfer Function Model and is indexed sequentially. Results for the Series J example are shown in Figure 16.15.

Model Summary  gathers information that is useful for comparing models.

Parameter Estimates  shows the parameter estimates and is similar to the ARIMA version. In addition, the Variable column shows the correspondence between series names and parameters. The table is followed by the formula of the model. Note the notation $B$ is for the backshift operator.

Residuals, Iteration History  are the same as their ARIMA counterparts.

Interactive Forecasting  provides a forecasting graph based on a specified confidence interval. The functionality changes based on the number entered in the Forecast Periods box.

If the number of Forecast Periods is less than or equal to the Input Lag, the forecasting box shows the forecast for the number of periods. A confidence interval around the prediction is shown in blue, and this confidence interval can be changed by entering a number in the Confidence Interval box above the graph.
If the number of forecast periods is larger than the number of lags (say, eight in our example), the presentation is a little different.

8 forecast periods with an input lag of 3

Choose the input series (here, there is only one.)

Choose one of the $8 - 3 = 5$ recent values

Alter this value by using this slider or entering directly into the boxes above

Here, you manipulate lagged values of the series by entering values into the edit boxes next to the series, or by manipulating the sliders. As before, the confidence interval can also be changed. The results of your changes are reflected in real time in the Interactive Forecasting graph.

The following commands are available from the report drop-down menu.

- **Save Columns** creates a new data table containing the input and output series, a time column, predicted output with standard errors, residuals, and 95% confidence limits.
- **Create SAS Job** creates PROC ARIMA code that can reproduce this model.
- **Submit to SAS** submits PROC ARIMA code to SAS that reproduces the model.
Model Comparison Table

The model comparison table works like its ARIMA counterpart by accumulating statistics on the models you specify.

<table>
<thead>
<tr>
<th>Model</th>
<th>DF</th>
<th>Variance</th>
<th>AIC</th>
<th>SEC</th>
<th>RSquare</th>
<th>-2logL</th>
<th>Weights</th>
<th>2.4.6.8</th>
<th>MAPE</th>
<th>MAE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer Function Model (1)</td>
<td>280</td>
<td>0.0587346</td>
<td>24.1874851</td>
<td>11.251427</td>
<td>0.992</td>
<td>3.225514</td>
<td>0.096759</td>
<td>0.596759</td>
<td>0.307630</td>
<td>0.165500</td>
</tr>
<tr>
<td>Transfer Function Model (2)</td>
<td>292</td>
<td>0.0588643</td>
<td>15.5397797</td>
<td>46.589676</td>
<td>0.966</td>
<td>4.401233</td>
<td>0.303231</td>
<td>0.303231</td>
<td>0.308171</td>
<td>0.165500</td>
</tr>
</tbody>
</table>

Fitting Notes

A regression model with serially correlated errors can be specified by including regressors in the model and not specifying any polynomial orders.

Intervention analysis can also be conducted, but prewhitening is no longer meaningful.

Currently, the transfer function model platform has limited capability of supporting missing values.

Smoothing Models

JMP offers a variety of smoothing techniques.

Smoothing models represent the evolution of a time series by the model:

\[ y_t = \mu_t + \beta_t t + s(t) + a_t \]

where
μ_t is the time-varying mean term,

β_t is the time-varying slope term,

ι(t) is one of the s time-varying seasonal terms,

α_t are the random shocks.

Models without a trend have β_t = 0 and nonseasonal models have ι(t) = 0. The estimators for these time-varying terms are

L_t smoothed level that estimates μ_t

T_t is a smoothed trend that estimates β_t

Stj−j for j = 0, 1, ..., s – 1 are the estimates of the ι(t).

Each smoothing model defines a set of recursive smoothing equations that describes the evolution of these estimators. The smoothing equations are written in terms of model parameters called smoothing weights. They are

α, the level smoothing weight

γ, the trend smoothing weight

ϕ, the trend damping weight

δ, the seasonal smoothing weight.

While these parameters enter each model in a different way (or not at all), they have the common property that larger weights give more influence to recent data while smaller weights give less influence to recent data.

Each smoothing model has an ARIMA model equivalent. You may not be able to specify the equivalent ARIMA model using the ARIMA command because some smoothing models intrinsically constrain the ARIMA model parameters in ways the ARIMA command will not allow.

### Smoothing Model Dialog

The Smoothing Model dialog appears in the report window when you select one of the smoothing model commands.
The **Confidence Intervals** popup list allows you to set the confidence level for the forecast confidence bands. The dialogs for seasonal smoothing models include a **Periods Per Season** box for setting the number of periods in a season. The **Constraints** popup list lets you to specify what type of constraint you want to enforce on the smoothing weights during the fit. The constraints are:

**Zero To One** keeps the values of the smoothing weights in the range zero to one.

**Unconstrained** allows the parameters to range freely.

**Stable Invertible** constrains the parameters such that the equivalent ARIMA model is stable and invertible.

**Custom** expands the dialog to allow you to set constraints on individual smoothing weights. Each smoothing weight can be **Bounded**, **Fixed**, or **Unconstrained** as determined by the setting of the popup menu next to the weight’s name. When entering values for fixed or bounded weights, the values can be positive or negative real numbers.

The example shown here has the Level weight ($\alpha$) fixed at a value of 0.3 and the Trend weight ($\gamma$) bounded by 0.1 and 0.8. In this case, the value of the Trend weight is allowed to move within the range 0.1 to 0.8 while the Level weight is held at 0.3. Note that you can specify all the smoothing weights in advance by using these custom constraints. In that case, none of the weights would be estimated from the data although forecasts and residuals would still be computed. When you click **Estimate**, the results of the fit appear in place of the dialog.

### Simple Exponential Smoothing

The model for simple exponential smoothing is $y_t = \mu_t + \alpha_t$.

The smoothing equation, $L_t = \alpha y_t + (1 - \alpha) L_{t-1}$, is defined in terms of a single smoothing weight $\alpha$. This model is equivalent to an ARIMA(0, 1, 1) model where

$$(1 - B)y_t = (1 - \theta B)\alpha_t \quad \text{with} \; \theta = 1 - \alpha.$$  

The moving average form of the model is

$$y_t = a_t + \sum_{j=1}^{\infty} \alpha a_{t-j}$$
Double (Brown) Exponential Smoothing

The model for double exponential smoothing is \( y_t = \mu_t + \beta_1 t + a_t \).

The smoothing equations, defined in terms of a single smoothing weight \( \alpha \) are
\[
L_t = \alpha y_t + (1 - \alpha)L_{t-1} \quad \text{and} \quad T_t = \alpha (L_t - L_{t-1}) + (1 - \alpha) T_{t-1}.
\]

This model is equivalent to an ARIMA(0, 1, 1)(0, 1, 1)1 model
\[
(1 - B) y_t = (1 - \theta B)^2 a_t \quad \text{where} \quad \theta_1, 1 = \theta_2, 1 \quad \text{with} \quad \theta = 1 - \alpha.
\]

The moving average form of the model is
\[
y_t = a_t + \sum_{j=1}^{\infty} (2\alpha + (j-1)\alpha^2) a_{t-j}
\]

Linear (Holt) Exponential Smoothing

The model for linear exponential smoothing is \( y_t = \mu_t + \beta_1 t + a_t \).

The smoothing equations defined in terms of smoothing weights \( \alpha \), \( \gamma \) are
\[
L_t = \alpha y_t + (1 - \alpha)(L_{t-1} + T_{t-1}) \quad \text{and} \quad T_t = \gamma (L_t - L_{t-1}) + (1 - \gamma) T_{t-1}
\]

This model is equivalent to an ARIMA(0, 2, 2) model where
\[
(1 - B)^2 y_t = (1 - \theta B - \theta_2 B^2) a_t \quad \text{with} \quad \theta_1 = 2 - \alpha - \alpha \gamma \quad \text{and} \quad \theta_2 = \alpha - 1.
\]

The moving average form of the model is
\[
y_t = a_t + \sum_{j=1}^{\infty} (\alpha + j\alpha \gamma) a_{t-j}
\]

Damped-Trend Linear Exponential Smoothing

The model for damped-trend linear exponential smoothing is \( y_t = \mu_t + \beta_1 t + a_t \).

The smoothing equations in terms of smoothing weights \( \alpha \), \( \gamma \), and \( \phi \) are
\[
L_t = \alpha y_t + (1 - \alpha)(L_{t-1} + \phi T_{t-1}) \quad \text{and} \quad T_t = \gamma (L_t - L_{t-1}) + (1 - \gamma) \phi T_{t-1}
\]

This model is equivalent to an ARIMA(1, 1, 2) model where
\[
(1 - \phi B)(1 - B) y_t = (1 - \theta_1 B - \theta_2 B^2) a_t \quad \text{with} \quad \theta_1 = 1 + \phi - \alpha - \alpha \gamma \phi \quad \text{and} \quad \theta_2 = (\alpha - 1) \phi.
\]
The moving average form of the model is
\[ y_t = \alpha_t + \sum_{j=1}^{\infty} \left( \frac{\alpha + \alpha \gamma \varphi (\varphi^j - 1)}{\varphi - 1} \right) \alpha_{t-j} \]

**Seasonal Exponential Smoothing**

The model for seasonal exponential smoothing is \( y_t = \mu_t + s(t) + a_t \).

The smoothing equations in terms of smoothing weights \( \alpha \) and \( \delta \) are
\[ L_t = \alpha (y_t - S_{t-1}) + (1 - \alpha) L_{t-1} \quad \text{and} \quad S_t = \delta (y_t - L_{t-1}) + (1 - \delta) \phi S_{t-1} \]

This model is equivalent to a seasonal ARIMA(0, 1, 1)(0, 1, 0)S model where we define
\[ \theta_1 = \theta_{1,1}, \theta_2 = \theta_{2,s} = \theta_{2,s}, \text{ and } \theta_3 = -\theta_1, \theta_{2,s} \]

so
\[ (1 - B)(1 - B^s)y_t = (1 - \theta_1 B - \theta_2 B^s - \theta_3 B^{s+1})a_t \]

with
\[ \theta_1 = 1 - \alpha, \theta_2 = \delta (1 - \alpha), \text{ and } \theta_3 = (1 - \alpha)(\delta - 1). \]

The moving average form of the model is
\[ y_t = \alpha_t + \sum_{j=1}^{\infty} \psi_j a_{t-j} \text{ where } \psi = \begin{cases} \alpha & \text{for } j \mod s \neq 0 \\ \alpha + \delta(1 - \alpha) & \text{for } j \mod s = 0 \end{cases} \]

**Winters Method (Additive)**

The model for the additive version of the Winters method is \( y_t = \mu_t + \beta_t + s(t) + a_t \).

The smoothing equations in terms of weights \( \alpha, \gamma, \) and \( \delta \) are
\[ L_t = \alpha (y_t - S_{t-1}) + (1 - \alpha) (L_{t-1} + T_{t-1}), \quad T_t = \gamma (L_t - L_{t-1}) + (1 - \gamma) T_{t-1}, \quad \text{and} \quad S_t = \delta (y_t - L_t) + (1 - \delta) S_{t-1}. \]

This model is equivalent to a seasonal ARIMA(0, 1, s+1)(0, 1, 0)s model
\[ (1 - B)(1 - B^s)y_t = \left( 1 - \sum_{i=1}^{s+1} \theta_i B^i \right) a_t \]
The moving average form of the model is

\[ y_t = a_t + \sum_{j=1}^{\infty} \psi_j a_{t-j} \]

where

\[ \psi = \begin{cases} 
\alpha + j\alpha\gamma, & j \text{ mod } s \neq 0 \\
\alpha + j\alpha\gamma + \delta(1 - \alpha), & j \text{ mod } s = 0 
\end{cases} \]
Chapter 17

Categorical Response Analysis
The Categorical Platform

The Categorical platform does tabulation and summarization of categorical response data, including multiple response data, and calculates test statistics. It is designed to handle survey and other categorical response data, such as defect records, side effects, etc.

Figure 17.1 Example of a Categorical Analysis

The Categorical platform does tabulation and summarization of categorical response data, including multiple response data, and calculates test statistics. It is designed to handle survey and other categorical response data, such as defect records, side effects, etc.
Contents

The Categorical Platform .................................................. 367
Launching the Platform .................................................... 367
Failure Rate Examples ...................................................... 370
  Response Frequencies .................................................... 370
  Indicator Group ........................................................... 371
  Multiple Delimited ......................................................... 372
  Multiple Response By ID .................................................. 373
  Multiple Response .......................................................... 374
Categorical Reports .......................................................... 374
  Report Content ............................................................. 374
  Report Format ............................................................... 376
  Statistical Commands ..................................................... 378
  Save Tables ................................................................. 381
The Categorical Platform

The Categorical platform has capabilities similar to other platforms. The choice of platforms depends on your focus, the shape of your data, and the desired level of detail. Table 17.1 shows several of JMP’s analysis platforms, and their strengths.

Table 17.1 Comparing JMP’s Categorical Analyses

<table>
<thead>
<tr>
<th>Platform</th>
<th>Specialty</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution</td>
<td>Separate, ungrouped categorical responses.</td>
</tr>
<tr>
<td>Fit Y By X: Contingency</td>
<td>Two-way situations, including chi-square tests, correspondence analysis, agreement.</td>
</tr>
<tr>
<td>Pareto Plot</td>
<td>Graphical analysis of multiple-response data, especially multiple-response defect data, with more rate tests than Fit Y By X.</td>
</tr>
<tr>
<td>Variability Chart: Attribute</td>
<td>Attribute gauge studies, with more detail on rater agreement.</td>
</tr>
<tr>
<td>Fit Model</td>
<td>Logistic categorical responses and generalized linear models.</td>
</tr>
<tr>
<td>Partition, Neural Net</td>
<td>Specific categorical response models.</td>
</tr>
</tbody>
</table>

The strength of the categorical platform is that it can handle responses in a wide variety of formats without needing to reshape the data.

Launching the Platform

Open Failure3Freq.jmp in the Quality Control folder located in the sample data. Click on Analyze > Modeling > Categorical to obtain the launch dialog. The platform has a unique launch dialog. The buttons select groups of columns (as opposed to single columns like other JMP dialogs) for each of the situations.
**Response Roles**

Use the response roles buttons to choose selected columns as responses with specified roles. The response roles are summarized in Table 17.2, with the first four roles describing single response data and the last five roles describing multiple response data.

**Table 17.2 Response Roles**

<table>
<thead>
<tr>
<th>Response Role</th>
<th>Description</th>
<th>Example Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separate Responses</td>
<td>Separate responses are in each column, resulting in a separate analysis for each column.</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Jane</td>
</tr>
<tr>
<td>Aligned Responses</td>
<td>Responses share common categories across columns, resulting in better-organized reports.</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Jane</td>
</tr>
<tr>
<td>Repeated Measures</td>
<td>Aligned responses from an individual across different times or situations.</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Jane</td>
</tr>
</tbody>
</table>
Table 17.2  Response Roles  (Continued)

<table>
<thead>
<tr>
<th>Response Role</th>
<th>Description</th>
<th>Example Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rater Agreement</td>
<td>Aligned responses from different raters evaluating the same unit, to study agreement across raters.</td>
<td>Drink</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Coffee Like</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tea Dislike</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Water Like</td>
</tr>
<tr>
<td>Multiple Response</td>
<td>Aligned responses, where multiple responses are entered across several columns, but treated as one grouped response.</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Jane</td>
</tr>
<tr>
<td>Multiple Response by ID</td>
<td>Multiple responses across rows that have the same ID values.</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Jane</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Jane</td>
</tr>
<tr>
<td>Multiple Delimited</td>
<td>Several responses in a single cell, separated by commas.</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Jane</td>
</tr>
<tr>
<td>Indicator Group</td>
<td>Binary responses across columns, like checked or not, yes or no, but all in a related group.</td>
<td>ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>John</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Jane</td>
</tr>
<tr>
<td>Response Frequencies</td>
<td>Columns containing frequency counts for each response level, all in a related group.</td>
<td>Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B</td>
</tr>
</tbody>
</table>

**Other Launch Dialog Options**

The Launch dialog has standard JMP options (like By variables) and additionally:

- **X, Grouping Categories** defines sample groups to break the counts into.
- **Sample Size** For multiple response roles with summarized data, defines the number of individual units in the group for which that frequency is applicable to. For example, a Freq column might say there were 50 defects, where the sample size variable would say that they reflect the defects for a batch of 100 units.
- **Freq** is for presummarized data, specifying the column containing frequency counts for each row.
- **ID** is only required and used when Multiple Response by ID is used.
### Categorical Response Analysis

#### Chapter 17

**Unique occurrences within ID** allows duplicate response levels within a subject to be counted only once. An ID variable must be specified.

**Grouping Option** is used to give results for individual X variables, or for combinations of the variables.

- **Combinations** gives frequency results for combinations of the X variables.
- **Each Individually** gives frequency results for each X variable individually.
- **Both** gives frequency results for combinations of the X variables, and individually.

## Failure Rate Examples

The following examples come from testing a fabrication line on three different occasions under two different conditions. Each set of operating conditions yielded 50 data points. Inspectors recorded the following kinds of defects:

1. contamination
2. corrosion
3. doping
4. metallization
5. miscellaneous
6. oxide defect
7. silicon defect

Each unit could have several defects or even several defects of the same kind. We illustrate the data in a variety of different shapes all supported directly by the Categorical platform.

### Response Frequencies

Suppose the data have columns containing frequency counts for each batch and a column showing the total number of units of the batch (as in `Failure3Freq.jmp`).

<table>
<thead>
<tr>
<th>clean</th>
<th>date</th>
<th>contamination</th>
<th>corrosion</th>
<th>doping</th>
<th>metallization</th>
<th>miscellaneous</th>
<th>oxide defect</th>
<th>silicon defect</th>
<th>SampleSize</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 after OCT 1</td>
<td>12</td>
<td>2</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>2 after OCT 2</td>
<td>10</td>
<td>1</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>3 after OCT 3</td>
<td>8</td>
<td>2</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>4 before OCT 1</td>
<td>14</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>8</td>
<td>1</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>5 before OCT 2</td>
<td>15</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>4</td>
<td>8</td>
<td>0</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>6 before OCT 3</td>
<td>22</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>50</td>
<td></td>
</tr>
</tbody>
</table>

To generate the appropriate analysis, highlight the frequency variables and click **Response Frequencies**. The X, **Grouping Category** columns are **clean** and **date**, and **SampleSize** is **Sample Size**.
Chapter 17

Categorical Response Analysis

Failure Rate Examples

371

In the resulting output, a frequency count table shows the total number of defects for each defect type. There is a separate row for each of the six batches. The last two columns show the total number of defects (Responses) and the total number of units (Cases).

Figure 17.3 Defect Rate Output

<table>
<thead>
<tr>
<th>Indicator Group</th>
<th>clean</th>
<th>contamination</th>
<th>corrosion</th>
<th>doping</th>
<th>metallization</th>
<th>miscellaneous</th>
<th>oxide defect</th>
<th>silicon defect</th>
<th>Responses</th>
<th>Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>after OCT 1</td>
<td>12</td>
<td>2</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>23</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>OCT 2</td>
<td>10</td>
<td>1</td>
<td>1</td>
<td>5</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>23</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>OCT 3</td>
<td>8</td>
<td>3</td>
<td>0</td>
<td>5</td>
<td>9</td>
<td>0</td>
<td>1</td>
<td>17</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>before OCT 1</td>
<td>14</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>8</td>
<td>1</td>
<td>31</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>OCT 2</td>
<td>15</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>4</td>
<td>8</td>
<td>0</td>
<td>39</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>OCT 3</td>
<td>22</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>9</td>
<td>3</td>
<td>2</td>
<td>39</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>-All</td>
<td>81</td>
<td>12</td>
<td>7</td>
<td>21</td>
<td>10</td>
<td>21</td>
<td>8</td>
<td>163</td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

Indicator Group

In some cases, the data is not yet summarized, so there are individual records for each unit. We illustrate this situation in Failures3Indicators.jmp.
With data like this, specify all the defect columns with the **Indicator Group** button. The X, **Grouping Category** columns are clean and date. When you click OK, you get the same output as in the Response Group example (Figure 17.3).

### Multiple Delimited

Suppose that the inspector entered the observed defects for each unit. The defects are listed in a single column, delimited by a comma. (*Failures3Delimited.jmp*). Note in the partial data table, shown below, that some units did not have any observed defects, so the failures column is empty.

<table>
<thead>
<tr>
<th>failures</th>
<th>clean</th>
<th>date</th>
<th>id</th>
<th>id label</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>oxide defect</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>contamination,oxide defect</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>contamination</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>oxide defect</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>contamination</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>contamination,contamination</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>contamination</td>
<td>before OCT 1</td>
<td>OCT 1 before</td>
<td></td>
</tr>
</tbody>
</table>

To get the appropriate analysis, specify the delimited defect columns with the **Multiple Delimited** button. The results are identical to those in Figure 17.3.

**Note:** If more than one delimited column is specified, separate analyses are produced for each column.
Multiple Response By ID

Suppose each failure type is a separate record, with an ID column that can be used to link together different defect types for each unit, as in Failure3ID.jmp.

Launch the Categorical platform with columns specified as in Figure 17.4. Column roles are similar to the other defect examples, but note that N is used as Freq and SampleSize is used as Sample Size.

Results are identical to those in Figure 17.3.
Multiple Response

Suppose that the defects for each unit are entered via a web page, but since each unit rarely has more than three defect types, the form has three fields to enter any of the defect types for a unit, as in Failure3MultipleField.jmp.

Select the three columns containing defect types (Failure1, Failure2, and Failure3), and click the Multiple Response button. After specifying clean and date as X, Grouping variables, click OK to see the analysis results. Figure 17.5 lists failure types and counts for each failure type from the Multiple Response analysis.

Figure 17.5 Multiple Response Failures from Failure3MultipleField.jmp

Categorical Reports

Report Content

The Categorical platform produces a report with several tables and charts. Frequency, Share of Responses, Rate Per Case tables, and a Share Chart are included by default. You can also select a Frequency Chart. A Crosstab Format, instead of a Table Format can also be selected. The defect data for Failure3Freq.jmp is illustrated below.
Chapter 17

Categorical Response Analysis

Categorical Reports

The topmost table is a **Frequency** count table, showing the frequency counts for each category with the total frequency (**Responses**) and total units (**Cases**) on the right. In this example, we have total defects for each defect type by the 6 batches. The last two columns show the total number of defects (**Responses**) and the total number of units (**Cases**).

### Frequency

<table>
<thead>
<tr>
<th>clean date</th>
<th>contamination</th>
<th>corrosion</th>
<th>doping</th>
<th>metallization</th>
<th>miscellaneous</th>
<th>oxide defect</th>
<th>silicon defect</th>
<th>Responses</th>
<th>Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>after</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OCT 1</td>
<td>12</td>
<td>2</td>
<td>0</td>
<td>4</td>
<td>2</td>
<td>0</td>
<td>2</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>OCT 2</td>
<td>10</td>
<td>1</td>
<td>1</td>
<td>6</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>OCT 3</td>
<td>9</td>
<td>3</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>17</td>
<td>50</td>
</tr>
<tr>
<td>before</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OCT 1</td>
<td>14</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>6</td>
<td>1</td>
<td>31</td>
<td>50</td>
</tr>
<tr>
<td>OCT 2</td>
<td>15</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>4</td>
<td>6</td>
<td>0</td>
<td>36</td>
<td>50</td>
</tr>
<tr>
<td>OCT 3</td>
<td>22</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>36</td>
<td>50</td>
</tr>
<tr>
<td>-All-</td>
<td>61</td>
<td>12</td>
<td>7</td>
<td>21</td>
<td>10</td>
<td>21</td>
<td>8</td>
<td>196</td>
<td>300</td>
</tr>
</tbody>
</table>

The **Share of Responses** table is built by dividing each count by the total number of responses.

### Share of Responses

<table>
<thead>
<tr>
<th>clean date</th>
<th>contamination</th>
<th>corrosion</th>
<th>doping</th>
<th>metallization</th>
<th>miscellaneous</th>
<th>oxide defect</th>
<th>silicon defect</th>
<th>Responses</th>
<th>Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>after</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OCT 1</td>
<td>0.5217</td>
<td>0.0879</td>
<td>0.0800</td>
<td>0.1759</td>
<td>0.0879</td>
<td>0.9455</td>
<td>0.0870</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>OCT 2</td>
<td>0.4345</td>
<td>0.0435</td>
<td>0.0435</td>
<td>0.2174</td>
<td>0.9455</td>
<td>0.9879</td>
<td>0.1364</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>OCT 3</td>
<td>0.4706</td>
<td>0.1765</td>
<td>0.0800</td>
<td>0.2941</td>
<td>0.8669</td>
<td>0.9598</td>
<td>0.0860</td>
<td>17</td>
<td>50</td>
</tr>
<tr>
<td>before</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OCT 1</td>
<td>0.4518</td>
<td>0.0845</td>
<td>0.0322</td>
<td>0.0845</td>
<td>0.0845</td>
<td>0.2651</td>
<td>0.0322</td>
<td>31</td>
<td>50</td>
</tr>
<tr>
<td>OCT 2</td>
<td>0.9539</td>
<td>0.0867</td>
<td>0.0687</td>
<td>0.0353</td>
<td>0.1333</td>
<td>0.2039</td>
<td>0.0960</td>
<td>39</td>
<td>50</td>
</tr>
<tr>
<td>OCT 3</td>
<td>0.8111</td>
<td>0.0558</td>
<td>0.0833</td>
<td>0.1111</td>
<td>0.9609</td>
<td>0.9623</td>
<td>0.0580</td>
<td>39</td>
<td>50</td>
</tr>
<tr>
<td>-All-</td>
<td>0.5003</td>
<td>0.0759</td>
<td>0.0430</td>
<td>0.1313</td>
<td>0.8625</td>
<td>0.1313</td>
<td>0.0580</td>
<td>169</td>
<td>360</td>
</tr>
</tbody>
</table>

As an example, examine the second row of the table (corresponding to October 2, after cleaning). The 10 contamination defects were (10/23)=43.5% of all defects.

The **Rate Per Case** table divides each count in the frequency table by the total number of cases.

### Rate Per Case

<table>
<thead>
<tr>
<th>clean date</th>
<th>contamination</th>
<th>corrosion</th>
<th>doping</th>
<th>metallization</th>
<th>miscellaneous</th>
<th>oxide defect</th>
<th>silicon defect</th>
<th>Responses</th>
<th>Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>after</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OCT 1</td>
<td>0.2400</td>
<td>0.0640</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
</tr>
<tr>
<td>OCT 2</td>
<td>0.2000</td>
<td>0.0620</td>
<td>0.0620</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0620</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
</tr>
<tr>
<td>OCT 3</td>
<td>0.1800</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0620</td>
<td>0.0600</td>
<td>0.0600</td>
</tr>
<tr>
<td>before</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OCT 1</td>
<td>0.2000</td>
<td>0.0640</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
</tr>
<tr>
<td>OCT 2</td>
<td>0.3000</td>
<td>0.0640</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
</tr>
<tr>
<td>OCT 3</td>
<td>0.4400</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
<td>0.0600</td>
</tr>
<tr>
<td>-All-</td>
<td>0.2700</td>
<td>0.0630</td>
<td>0.0230</td>
<td>0.0790</td>
<td>0.0790</td>
<td>0.0790</td>
<td>0.0790</td>
<td>0.0790</td>
<td>0.0790</td>
</tr>
</tbody>
</table>

For example, in the first row of the table (October 1, after cleaning), the 12 contamination defects are from 50 units, making the rate per unit 24%.
Categorical Response Analysis
Categorical Reports

The **Share Chart** presents two bar chart columns. The bar chart on the left shows the **Share of Responses** as a divided bar chart. The bar length is proportional to the percentage of responses for each type. Since a bar in one sample might reflect a much higher frequency than a bar in another sample, the bar chart on the right shows the number of responses. The bar filled with a gradient means the number of responses for that bar is more than the width of the bar chart allows.

<table>
<thead>
<tr>
<th></th>
<th>Response</th>
<th>Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>after OCT 1</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>after OCT 2</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>after OCT 3</td>
<td>17</td>
<td>50</td>
</tr>
<tr>
<td>before OCT 1</td>
<td>31</td>
<td>50</td>
</tr>
<tr>
<td>before OCT 2</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>before OCT 3</td>
<td>39</td>
<td>50</td>
</tr>
<tr>
<td>--- All</td>
<td>160</td>
<td>300</td>
</tr>
</tbody>
</table>

The **Frequency Chart** shows response frequencies. The bars in the chart on the left reflect the frequency count on the same scale. The bar chart on the right shows the number of units.

<table>
<thead>
<tr>
<th></th>
<th>Response</th>
<th>Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>after OCT 1</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>after OCT 2</td>
<td>23</td>
<td>50</td>
</tr>
<tr>
<td>after OCT 3</td>
<td>17</td>
<td>50</td>
</tr>
<tr>
<td>before OCT 1</td>
<td>31</td>
<td>50</td>
</tr>
<tr>
<td>before OCT 2</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>before OCT 3</td>
<td>39</td>
<td>50</td>
</tr>
<tr>
<td>--- All</td>
<td>160</td>
<td>300</td>
</tr>
</tbody>
</table>

Note again that the gradient-filled bars are used when the number of responses or units is more than the width of the bar chart allows.

The **Transposed Freq Chart** option produces a transposed version of the Frequency Chart. Marginal totals are given for each response, as opposed to each **X** variable.

**Report Format**

The default report format is the **Table Format**.
To gather all three statistics for each sample and response together, use the **Crosstab format**.

Both **Table Format** and **Crosstab Format** have transposed versions (**Table Transposed** and **Crosstab Transposed**). These are useful when there are a lot of response categories but not a lot of samples.
Statistical Commands

The following commands appear in the platform menu depending on context.

Table 17.3 Categorical Platform Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Supported Response Contexts</th>
<th>Question</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Response Homogeneity</td>
<td>• Separate Responses</td>
<td>Are the probabilities across the response categories the same across sample categories?</td>
<td>Marginal Homogeneity (Independence) Test, both Pearson and Chi-square likelihood ratio chi-square</td>
</tr>
<tr>
<td></td>
<td>• Aligned Responses</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Repeated Measures</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Response Frequencies (if no Sample Size)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Each Response</td>
<td>• Multiple Response</td>
<td>For each response category, are the rates the same across sample categories?</td>
<td>Poisson regression on sample for each defect frequency.</td>
</tr>
<tr>
<td></td>
<td>• Multiple Response by ID (with Sample Size)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Multiple Delimited</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Response Frequencies with Sample Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agreement Statistic</td>
<td>• Rater Agreement</td>
<td>How closely do raters agree, and is the lack of agreement symmetrical?</td>
<td>Kappa for agreement, Bowker/McNemar for symmetry.</td>
</tr>
<tr>
<td>Transition Report</td>
<td>• Repeated Measures</td>
<td>How have the categories changed across time?</td>
<td>Transition counts and rates matrices.</td>
</tr>
</tbody>
</table>

Test Response Homogeneity

In this situation, there is typically one categorical response variable and one categorical sample variable. Multiple sample variables are treated as a single variable.
The test is the chi-square test for marginal homogeneity, testing that the response probabilities are the same across samples. This is equivalent to a test for independence when the sample category is like a response. There are two versions of this test, the Pearson form and the Likelihood Ratio form, both with chi-square statistics. The Test Options menu is used to show or hide the Likelihood Ratio or Pearson tests.

As an example, open Car Poll.jmp and launch the Categorical platform. Choose country as a Separate Response and marital status as an X, Grouping Category. When the report appears, select Test Response Homogeneity from the platform menu.

The Share Chart seems to indicate that the married group has higher probability to buy American cars, and the single group has higher probability to buy Japanese cars, but the statistical test only shows a significance of 0.08. Therefore, the difference in response probabilities across marital status is not statistically significant at an alpha level of 0.05.

Test Each Response

When there are multiple responses, each response category can be modeled separately. The question is whether the response rates are the same across samples. For each response category, we assume the frequency count has a random Poisson distribution. The rate test is obtained using a Poisson regression (through generalized linear models) of the frequency per unit modeled by the sample categorical variable. The result is a likelihood ratio chi-square test of whether the rates are different across samples.
Categorical Response Analysis

This test can also be done by the Pareto platform, as well as in the Generalized Linear Model personality of the Fit Model platform.

As an example, open Failure3Freq.jmp. We want to compare the samples across the clean treatment variable, so launch the Categorical platform and assign all the defect columns as Response Frequencies, with clean as an X, Grouping variable and SampleSize as Sample Size. Click OK. Select Test Each Response from the platform menu.

For which defects are the rates significantly different across the clean treatments? The \( p \)-values show that oxide defect is the most significantly different, followed by contamination, then doping. The other defects are not significantly different with this amount of data.

**Relative Risk**

The Relative Risk option is used to compute relative risks for different responses. The risk of responses is computed for each level of the X, Grouping variable. The risks are compared to get a relative risk. This option is available only when the Unique occurances within ID box is checked on the platform launch window.

A common application of this analysis is when the responses represent adverse events (side effects), and the \( X \) variable represents a treatment (drug vs. placebo). The risk for getting each side effect is computed for both the drug and placebo. The relative risk is the ratio of the two risks.

**Conditional Association**

The Conditional Association option is used to compute the conditional probability of one response given a different response. A table and color map of the conditional probabilities are given. This option is available only when the Unique occurances within ID box is checked on the platform launch window.
A common application of this analysis is when the responses represent adverse events (side effects) from a drug. The computations represent the conditional probability of one side effect given the presence of another side effect.

**Rater Agreement**

The Rater Agreement analysis answers the questions of how closely raters agree with one another and if the lack of agreement is symmetrical.

As an example, open **Attribute Gauge.jmp**. The Attribute Chart script runs the Variability Chart platform, which has a test for agreement among raters.

![Agreement Comparisons Table]

Launch the Categorical platform and designate the three raters (A, B, and C) as Rater Agreement responses in the launch dialog. In the resulting report, you have a similar test for agreement that is augmented by a symmetry test that the lack of agreement is symmetric.

![Agreement Statistics Table]

**Save Tables**

The Save Tables menu on the platform red-triangle menu has the following options:

- **Save Frequencies** saves the Frequency report to a new data table, without the marginal totals.
- **Save Share of Responses** saves the Share of Responses report to a new data table, without the marginal totals.
- **Save Rate Per Case** saves the Rate Per Case report to a new data table, without the marginal totals.
- **Save Transposed Frequencies** saves the Transposed Freq Chart report to a new data table, without the marginal totals.
- **Save Transposed Share of Responses** saves a transposed version of the Share of Responses report to a new data table
- **Save Transposed Rate Per Case** saves a transposed version of the Rate Per Case report to a new data table.
Save Test Rates saves the results of the Test Each Response option to a new data table.

Save Test Homogeneity saves the results of the Test Response Homogeneity option to a new data table. This option is available only when using Aligned Responses.
The Choice platform is designed for use in market research experiments, where the ultimate goal is to discover the preference structure of consumers. Then, this information is used to design products or services that have the attributes most desired by consumers.

Features provided in the Choice platform include:

- ability to use information about consumer traits as well as product attributes.
- integration of data from one, two, or three sources.
- ability to use the integrated profiler to understand, visualize, and optimize the response (utility) surface.
- provides subject-level scores for segmenting or clustering your data.
- uses a special default bias-corrected maximum likelihood estimator described by Firth (1993). This method has been shown to produce better estimates and tests than MLEs without bias correction. In addition, bias-corrected MLEs ameliorate separation problems that tend to occur in logistic-type models. Refer to Heinze and Schemper (2002) for a discussion of the separation problem in logistic regression.

The Choice platform is not appropriate to use for fitting models that involve:

- ranking or scoring.
- nested hierarchical choices. (PROC MDC in SAS/ETS can be used for such analysis.)
Introduction to Choice Modeling

Choice modeling, pioneered by McFadden (1974), is a powerful analytic method used to estimate the probability of individuals making a particular choice from presented alternatives. Choice modeling is also called conjoint modeling, discrete choice analysis, and conditional logistic regression.

The Choice Modeling platform uses a form of conditional logistic regression. Unlike simple logistic regression, choice modeling uses a linear model to model choices based on response attributes and not solely upon subject characteristics. For example, in logistic regression, the response might be whether you buy brand A or brand B as a function of ten factors or characteristics that describe you such as your age, gender, income, education, etc. However, in choice modeling, you might be choosing between two cars that are a compound of ten attributes such as price, passenger load, number of cup holders, color, GPS device, gas mileage, anti-theft system, removable-seats, number of safety features, and insurance cost.

Choice Statistical Model

Parameter estimates from the choice model identify consumer utility, or marginal utilities in the case of a linear utility function. Utility is the level of satisfaction consumers receive from products with specific attributes and is determined from the parameter estimates in the model.

The choice statistical model is expressed as follows.

Let $X[k]$ represent a subject attribute design row, with intercept

Let $Z[j]$ represent a choice attribute design row, without intercept

Then, the probability of a given choice for the $k^{th}$ subject to the $j^{th}$ choice of $m$ choices is

$$P_{jk} = \frac{\exp(\beta'(X[k] \otimes Z[j]))}{\sum_{l=1}^{m} \exp(\beta'(X[k] \otimes Z[l]))}$$

where

$\otimes$ is the Kronecker row-wise product
the numerator calculates for the $j^{th}$ alternative actually chosen, and
the denominator sums over the $m$ choices presented to the subject for that trial.

Product Design Engineering

When engineers design a product, they routinely make hundreds or thousands of small design decisions. Most of these decisions are not tested by prospective customers. Consequently, these products are not optimally designed. However, if customer testing is not too costly and test subjects (prospective customers) are readily available, it is worthwhile to test more of these decisions via consumer choice experiments.
Modeling costs have recently decreased with improved product and process development techniques and methodologies. Prototyping, including pure digital prototyping, is becoming less expensive, so it is possible to evaluate the attributes and consequences of more alternatives. Another important advancement is the use of the Internet to deliver choice experiments to a wide audience. You can now inform your customers that they can have input into the design of the next product edition by completing a web survey.

Choice modeling can be added to Six Sigma programs to improve consumer products. Six Sigma aims at making products better by improving the manufacturing process and ensuring greater performance and durability. But, Six Sigma programs have not addressed one very important aspect of product improvement—making the products that people actually want. Six Sigma programs often consider the Voice of the Customer and can use customer satisfaction surveys. However, while these surveys can disclose what is wrong with the product, they fail to identify consumer preferences with regard to specific product attributes. Choice experiments provide a tool that enables companies to gain insight for actual customer preferences. Choice modeling analysis can reveal such preferences.

Market research experiments have a long history of success, but performing these experiments has been expensive, and research has previously focused on price elasticity and competitive situations. It is by using these same techniques for product design engineering where choice modeling can have the most impact.

### Data for the Choice Platform

The Choice platform is unique because it is designed to use data from one, two or three different data tables.

- **Profile data** describe the attributes associated with each choice. Each choice can comprise many different attributes, and each attribute is listed as a column in the data table. There is a row for each possible choice, and each possible choice contains a unique ID.

- **Response data** contain the experimental results and have the choice set IDs for each trial as well as the actual choice selected by the subject. Each subject usually has several trials, or choice sets, to cover several choice possibilities. There can be more than one row of data for each subject. For example, an experiment might have 100 subjects with each subject making 12 choice decisions, resulting in 1200 rows in this data table. The Response data are linked to the Profile data through the choice set columns and the actual choice response column. Choice set refers to the set of alternatives from which the subject makes a choice. Grouping variables are sometimes used to align choice indices when more than one group is contained within the data.

- **Subject data** are optional, depending on whether subject effects are to be modeled. This source contains one or more attributes or characteristics of each subject and a subject identifier. The Subject data table contains the same number of rows as subjects and has an identifier column that matches a similar column in the Response data table. You can also put Subject data in the Response data table, but it is still specified as a subject table.

If all your data are contained in one table, you can use the Choice platform, but additional effort is necessary. See the section “One-Table Analysis,” p. 402.
Example: Pizza Choice

Suppose that you are supplying pizza for an airline. You want to find pizza attributes that are optimal for the flying population. So, you have a group of frequent flyers complete a choice survey. In order to weigh the importance of each attribute and to determine whether there are any interactions between the different attributes, you give them a series of choices that require them to state their preference between each pair of choices. One pair of choices might be between two types of pizza that they like, or between two types of pizza that they do not like. Hence, the choice might not always be easy.

This example examines pizza choices where three attributes, each with two levels, are presented to the subjects:

- crust (thick or thin),
- cheese (mozzarella or Monterey Jack),
- topping (pepperoni or none).

Suppose a subject likes thin crust with mozzarella cheese and no topping, but the choices given to the subject are either a thick crust with mozzarella cheese and pepperoni topping, or a thin crust with Monterey Jack cheese and no topping. Since neither of these pizzas is ideal, the subject has to weigh which of the attributes are more important.

The profile data table lists all the pizza choice combinations that you want to present to the subjects. Each choice combination is given an ID. The profile data table is shown in Figure 18.1.

![Pizza Profile Data Table](image)

For the actual survey or experiment, each subject is given four trials, where each trial consists of stating his or her preference between two choice profiles (Choice1 and Choice2). The choice profiles given for each trial are referred to as a choice set. One subject’s choice trials can be different from another subject’s trials. Refer to the DOE Choice Design platform for generating optimal choice designs. Twelve runs from the first three subjects are shown in Figure 18.2.
Notice that each choice value refers to an ID value in the Profile data table which has the attribute information.

If data about the subject are to be used, a separate Subject data table is needed. This table includes a subject ID column and characteristics of the subject. In the pizza example, the only characteristic or attribute about the Subject is Gender. Subject data for the first three subjects are shown in Figure 18.3. Notice that the response choices and choice sets in the response data table use the ID names given in the profile data set. Similarly, the subject identifications in the response data table match those in the subject data table.

Since the Choice platform can use several data tables, no initial assumption is made about using the current data table—as is the case with other JMP platforms. You must select the data table for each of the three choice data sources. You are prompted to select the profile data set and the response data set. If you want to model subject attributes, then a subject data set must also be selected. You can expand or collapse each section of the Choice dialog box, as needed.

To illustrate the Choice platform, three data sets from the pizza example are used and are found in the sample data directory. The first data set is entered into the Profile Data section of the Choice Dialog Box, as shown in Figure 18.4.
Launch the Choice Platform and Select Data Sets

- Select **Analyze > Modeling > Choice** to open the launch dialog box. You see three separate sections for each of the data sources.
- Click on **Select Data Table** under Profile Data. A new dialog box opens, which prompts you to specify the data table for the profile data. You can select from any of the data sets already open in the current JMP session, or you can select **Other**. Selecting **Other** allows you to open a file that is not currently open.
- Select **Pizza Profiles.jmp**. The columns from this table now populate the field under **Select Columns** in the Choice Dialog box.
- Select ID for **Profile ID** under **Pick Role Variables** and Add Crust, Cheese, and Topping under **Construct Model Effects**. If the **Profile ID** column does not uniquely identify each row in the profile data table, you need to add **Grouping** columns until the combination of **Grouping** and **Profile ID** columns uniquely identify the row, or profile. For example, if **Profile ID** = 1 for **Survey** = A, and a different **Profile ID** = 1 for **Survey** = B, then **Survey** would be used as a **Grouping** column. In this simple experiment, all eight combinations of the three two-level factors were used.

**Figure 18.4** Profile Data Set Dialog Box

The second data set is the Response Data containing the experimental results. For the pizza example, **Choice1** and **Choice2** are the profile ID choices given to a subject on each of four trials. The **Choice** column contains the chosen preference between **Choice1** and **Choice2**.

- Open the Response Data section of the dialog box. Click **Select Data Table**. When the Response Data Table dialog box opens, select **Pizza Responses.jmp**.
- Select **Choice** for the **Profile ID Chosen**, and **Choice1** and **Choice2** for the **Profile ID Choices**.
Launch the Choice Platform and Select Data Sets

- The **Subject ID** is optional, but is needed if you later want to model subject effects or if you later want to cluster subjects into groups.

- **Freq** and **Weight** are used to weight the analysis. For example, if you have summarized a set that had the same trial **Freq** is used for the count in that row of the response data table.

- Select **Subject** for **Subject ID** to identify individual subjects for later analysis. If you are not interested in assessing subjects at this time, it is not necessary to enter the subject data set into the model. The completed dialog box, without the subject data set, is shown in Figure 18.5.

---

**Figure 18.5** Response Data Set Dialog Box
Choice Model Output

Click on Run to obtain the results. These results are shown in Figure 18.6.

- The resulting parameter estimates are sometimes referred to as part-worths. Each part-worth is the coefficient of utility associated with that attribute. By default, these estimates are based upon the Firth bias-corrected maximum likelihood estimators, and are, therefore, considered to be more accurate than MLEs without bias correction.

- Comparison criteria are used to help determine the better-fitting model(s) when more than one model is investigated for your data. The model with the lower or lowest criterion value is believed to be the better or best model. Three criteria are shown in the Choice Model output and include AICc (corrected Akaike’s Information Criterion), -2*LogLikelihood, and -2*Firth Loglikelihood. The AICc formula is:

\[
\text{AICc} = -2 \text{loglikelihood} + \frac{2k(k+1)}{n-k-1}
\]

where \(k\) is the number of estimated parameters in the model and \(n\) is the number of observations in the dataset. Note that the -2*Firth Loglikelihood result is only included in the report when the Firth Bias-adjusted Estimates checkbox is checked in the launch window. (See Figure 18.5.) This option is checked by default. The decision to use or not use the Firth Bias-adjusted Estimates does not affect the AICc score or the -2*Loglikelihood results.

- Likelihood ratio tests appear for each effect in the model. These results are obtained by default if the model is fit quickly (less than five seconds); otherwise, you can click on the Choice Model drop down menu and select Likelihood Ratio Tests.

![Figure 18.6 Choice Model Results with No Subject Data for Pizza Example](image)

The profiler option is particularly valuable in understanding the model. It shows the value of the linear model, or the utility, as you change each factor, one at a time.
Launch the Choice Platform and Select Data Sets

- You specify the profiler option by selecting Profiler in the platform menu. The Prediction Profiler is shown in Figure 18.7.

- In this example involving only main effects, the factor showing the greatest difference is Cheese, favoring Mozzarella.

- If there were interactions in the model, more exploration of the profiler would be needed in order to understand the response surface.

---

**Figure 18.7 Prediction Profiler with No Subject Data for Pizza Example**

---

**Subject Effects**

If you want to include subject effects in the model, you need to open the Subject data table section of the Choice dialog box. Suppose you are interested in Gender main effects.

- Open the Subject Data section of the launch dialog box. Click Select Data Table, and when the Subject Data Table opens, select Pizza Subjects.jmp.

- Specify Subject as Subject ID, and add Gender under Construct Model Effects. The Subject data dialog box section for the pizza example is shown in Figure 18.8.

- Click on Run.
Chapter 18
Choice Modeling
Launch the Choice Platform and Select Data Sets

Figure 18.8 Choice Model Subject Data Dialog Box for Pizza Example

Figure 18.9 shows the parameter estimates and the likelihood ratio tests for the Choice Model with subject effects included. Strong interactions are seen between Gender and Crust and between Gender and Topping. When the Crust and Topping factors are assessed for the entire population, the effects are not significant. However, the effects of Crust and Topping are strong when they are evaluated between Gender groups.

Figure 18.9 Choice Model Results with Subject Effects for Pizza Example

- Cheese is significant as main effect
- Crust and Topping are only significant when interacted with Gender
- Subject-effect by Response-effect interaction
- Response-only effects
Launch the Choice Platform and Select Data Sets

The profiler is used to explore the response surface of the model. Click on the Choice Model drop-down menu and select the **Profiler**. You can Alt-click on any segment of the Profiler graphics to lock that particular factor level. (F is locked by default in this example.) A solid vertical line appears in place of the dotted line. Other factor settings can then be assessed easily for the locked factor level.

- As shown in Figure 18.10, when the female (F) level of **Gender** is locked, the Profiler shows that females prefer pizza with thin crust, mozzarella cheese, and no topping. For example, the Utility measure is higher for Crust equals Thin, meaning that females prefer thin crust.
- Now, switch **Gender** to M to assess male pizza preferences. As shown in Figure 18.11, males prefer thick crust, mozzarella cheese, and pepperoni topping.

**Figure 18.10 Prediction Profiler with Subject Data and Female Level Factor Setting**

**Figure 18.11 Prediction Profiler with Subject Data and Male Level Factor Setting**

**Utility Grid Optimization**

The Prediction Profiler allows you to optimize the utility function over a grid of fixed subject factor settings without having to manually manipulate profiler settings:

- Click on the platform drop-down-menu, select **Profiler**, and verify that one of the subject factors is locked. If not, Alt-click within the Profiler plot to lock the desired factor level. Set the Utility function to the maximum values for the other factors by sliding the red dotted vertical line.
Click on the red-triangle menu of the Prediction Profiler and select **Desirability Functions**. A new row is added to the Prediction Profiler, displaying overall desirability traces and measures. Utility and Desirability Functions are shown together in Figure 18.12.

**Figure 18.12 Utility and Desirability Functions**

![Prediction Profiler](image)

From the red-triangle menu of the Prediction Profiler, select **Maximize for each Grid Point**. A Remembered Settings table containing the grid settings with the maximum utility and desirability functions, and a table of differences between grids is displayed. See Figure 18.13. As illustrated, this feature can be a very quick and useful tool for selecting the most desirable attribute combinations for a factor.

**Figure 18.13 Utility and Desirability Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Crust</th>
<th>Cheese</th>
<th>Topping</th>
<th>Gender</th>
<th>Utility</th>
<th>Desirability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid1</td>
<td>Thin</td>
<td>Mozzarella</td>
<td>None</td>
<td>F</td>
<td>3.3415063</td>
<td>0.026201</td>
</tr>
<tr>
<td>Grid2</td>
<td>Thick</td>
<td>Mozzarella</td>
<td>Pepperoni</td>
<td>M</td>
<td>3.6288305</td>
<td>0.337771</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Differences</th>
<th>Grid1</th>
<th>Grid2</th>
<th>Utility</th>
<th>Desirability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid1</td>
<td>Grid2</td>
<td>0.1791349</td>
<td>0.0175656</td>
<td></td>
</tr>
</tbody>
</table>

The grid setting for females shows that the greatest utility and desirability values are obtained when the pizza attributes are thin crust, mozzarella cheese, and no topping. For males, the grid setting shows that the highest utility and desirability values are obtained when the pizza attributes are thick crust, mozzarella cheese, and pepperoni topping.
Platform Options

The Choice Modeling platform has many available options. To access these options, click on the platform drop-down menu.

- **Likelihood Ratio Tests** test the significance of each effect in the model. These are done by default if the estimate of cpu time is less than five seconds.
- **Joint Factor Tests** test each factor in the model by constructing a likelihood ratio test for all the effects involving that factor.
- **Confidence Intervals** produce a 95% confidence interval for each parameter (by default), using the profile-likelihood method. Shift-click on the platform drop-down menu and select **Confidence Intervals** to input alpha values other than 0.05.
- **Correlation of Estimates** shows the correlations of the parameter estimates.
- **Effect Marginals** show the fitted utility values for different levels in the effects, with neutral values used for unrelated factors.
- **Profiler** produces a response surface viewer that takes vertical cross-sections across each factor, one at a time.
- **Save Utility Formula** makes a new column with a formula for the utility, or linear model, that is estimated. This is in the profile data table, except if there are subject effects. In that case, it makes a new data table for the formula. This formula can be used with various profilers with subsequent analyses.
- **Save Gradients by Subject** constructs a new table that has a row for each subject containing the average (Hessian-scaled-gradient) steps on each parameter. This corresponds to using a Lagrangian multiplier test for separating that subject from the remaining subjects. These values can later be clustered, using the built-in-script, to indicate unique market segments represented in the data.
- **Model Dialog** shows the Choice dialog box, which can be used to modify and re-fit the model. You can specify new data sets, new IDs, and new model effects.

Example: Valuing Trade-offs

The Choice Modeling platform is also useful for determining the relative importance of product attributes. Even if the attributes of a particular product that are important to the consumer are known, information about preference trade-offs with regard to these attributes might be unknown. By gaining such information, a market researcher or product designer is able to incorporate product features that represent the optimal trade-off from the perspective of the consumer.

The advantages of this approach to product design can be found in the following example. It is already known that four attributes are important for laptop design—hard-disk size, processor speed, battery life, and selling price. The data gathered for this study are used to determine which of four laptop attributes (Hard Disk, Speed, Battery Life, and Price) are most important. It also assesses whether or not there are Gender or Job differences seen with these attributes.

- Select Analyze > Modeling > Choice to open the launch dialog box.
Chapter 18
Choice Modeling
Example: Valuing Trade-offs

- Open Laptop Profile.jmp from the sample data directory and Select Data Table under Profile Data. Select Laptop Profile.jmp. A partial listing of the Profile Data table is shown in Figure 18.14. The complete data set consists of 24 rows, 12 for Survey 1 and 12 for Survey 2. Survey and Choice Set define the grouping columns and Choice ID represents the four attributes of laptops: Hard Disk, Speed, Battery Life, and Price.

Figure 18.14 Profile Data Set for the Laptop Example

<table>
<thead>
<tr>
<th>Survey</th>
<th>Choice Set</th>
<th>Choice ID</th>
<th>Hard Disk</th>
<th>Speed</th>
<th>Battery Life</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>40 GB</td>
<td>1.68 GHz</td>
<td>6 hours</td>
<td>$1,000</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td>40 GB</td>
<td>2 GHz</td>
<td>4 hours</td>
<td>$1,500</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>1</td>
<td>80 GB</td>
<td>1.68 GHz</td>
<td>6 hours</td>
<td>$1,500</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>1</td>
<td>80 GB</td>
<td>2 GHz</td>
<td>4 hours</td>
<td>$1,200</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>1</td>
<td>80 GB</td>
<td>1.68 GHz</td>
<td>8 hours</td>
<td>$1,200</td>
</tr>
<tr>
<td>6</td>
<td>3</td>
<td>2</td>
<td>40 GB</td>
<td>2.0 GHz</td>
<td>6 hours</td>
<td>$1,000</td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td>1</td>
<td>80 GB</td>
<td>2.0 GHz</td>
<td>4 hours</td>
<td>$1,500</td>
</tr>
<tr>
<td>8</td>
<td>4</td>
<td>1</td>
<td>80 GB</td>
<td>1.68 GHz</td>
<td>6 hours</td>
<td>$1,200</td>
</tr>
<tr>
<td>9</td>
<td>5</td>
<td>1</td>
<td>40 GB</td>
<td>2.0 GHz</td>
<td>6 hours</td>
<td>$1,200</td>
</tr>
</tbody>
</table>

- Select Choice ID for Profile ID, and ADD Hard Disk, Speed, Battery Life, and Price for the model effects.
- Select Survey and Choice Set as the Grouping columns. The Profile Data dialog box is shown in Figure 18.15.

Figure 18.15 Profile Data Dialog Box for Laptop Study
• Click on Response Data > Select Data Table > Other > OK and select Laptop Runs.jmp from the sample data directory.

• Select Response as the Profile ID Chosen, Choice1 and Choice2 as the Profile ID Choices, Survey and Choice Set as the Grouping columns, and Person as Subject ID. The Response Data dialog box is shown in Figure 18.16.

Figure 18.16 Response Data Dialog Box for Laptop Study

• To run the model without subject effects, click on Run.

• Choose Profiler from the red-triangle menu.
Example: Valuing Trade-offs

Figure 18.17 Laptop Results Without Subject Effects

Results of this study show that while all the factors are important, the most important factor in the laptop study is **Hard Disk**. The respondents prefer the larger size. Note that respondents did not think a price increase from $1000 to $1200 was important, but an increase from $1200 to $1500 was considered important. This effect is easily visualized by examining the factors interactively with the Prediction Profiler. Such a finding can have implications for pricing policies, depending on external market forces.

To include subject effect for the laptop study, simply add to the Choice Modeling dialog box:

- Under Subject Data, **Select Data Table > Other > OK > Laptop Subjects.jmp**.
- **Select Person as Subject ID and ADD Gender and Job as the model effects.** The Subject Data dialog box is shown in Figure 18.18.
Click on Run.

Results are shown in Figure 18.19, Figure 18.20, and Figure 18.23.
Figure 18.20 Laptop Likelihood Ratio Test Results With Subject Data

<table>
<thead>
<tr>
<th>Source</th>
<th>L.R.</th>
<th>ChsSquare</th>
<th>DF</th>
<th>Prob&gt;ChiSq</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Disk</td>
<td>23.197</td>
<td>1</td>
<td>1</td>
<td>&lt; 0.0001</td>
</tr>
<tr>
<td>Speed</td>
<td>7.417</td>
<td>1</td>
<td>1</td>
<td>0.0068</td>
</tr>
<tr>
<td>Battery Life</td>
<td>8.639</td>
<td>1</td>
<td>1</td>
<td>0.0046</td>
</tr>
<tr>
<td>Price</td>
<td>14.624</td>
<td>2</td>
<td>2</td>
<td>&lt; 0.0001</td>
</tr>
<tr>
<td>Gender*Hard Disk</td>
<td>5.433</td>
<td>1</td>
<td>1</td>
<td>0.0198</td>
</tr>
<tr>
<td>Gender*Speed</td>
<td>3.603</td>
<td>1</td>
<td>1</td>
<td>0.0531</td>
</tr>
<tr>
<td>Gender*Battery Life</td>
<td>4.422</td>
<td>1</td>
<td>1</td>
<td>0.0350</td>
</tr>
<tr>
<td>Gender*Price</td>
<td>7.889</td>
<td>2</td>
<td>2</td>
<td>&lt; 0.014</td>
</tr>
<tr>
<td>Job*Hard Disk</td>
<td>3.648</td>
<td>1</td>
<td>1</td>
<td>0.0510</td>
</tr>
<tr>
<td>Job*Speed</td>
<td>3.848</td>
<td>1</td>
<td>1</td>
<td>0.0506</td>
</tr>
<tr>
<td>Job*Battery Life</td>
<td>3.108</td>
<td>1</td>
<td>1</td>
<td>0.0742</td>
</tr>
<tr>
<td>Job*Price</td>
<td>6.512</td>
<td>2</td>
<td>2</td>
<td>0.0386</td>
</tr>
</tbody>
</table>

Selecting Joint Factor Tests from the platform menu gives the table shown in Figure 18.21. Notice that neither Gender nor Job is significant.

Figure 18.21 Joint Factor Test for Laptop

<table>
<thead>
<tr>
<th>Source</th>
<th>L.R.</th>
<th>ChsSquare</th>
<th>DF</th>
<th>Prob&gt;ChiSq</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard Disk</td>
<td>31.095</td>
<td>2</td>
<td>2</td>
<td>&lt; 0.0001</td>
</tr>
<tr>
<td>Speed</td>
<td>15.714</td>
<td>3</td>
<td>3</td>
<td>0.0037</td>
</tr>
<tr>
<td>Battery Life</td>
<td>15.612</td>
<td>3</td>
<td>3</td>
<td>0.0016</td>
</tr>
<tr>
<td>Price</td>
<td>27.700</td>
<td>6</td>
<td>6</td>
<td>0.0061</td>
</tr>
<tr>
<td>Gender</td>
<td>23.698</td>
<td>5</td>
<td>5</td>
<td>0.0082</td>
</tr>
<tr>
<td>Job</td>
<td>20.188</td>
<td>5</td>
<td>5</td>
<td>0.0072</td>
</tr>
</tbody>
</table>

Selecting Effect Marginals from the platform menu displays the table shown in Figure 18.22. The marginal effects of each level for each factor are displayed. Notice that the marginal effects for each factor across all levels sum to zero.

Figure 18.22 Marginal Effects for Laptop
Results with subject effects show that neither Gender nor Job make a difference with regard to laptop attributes. Figure 18.20, Figure 18.23, and Figure 18.24 indicate that the interaction Gender*Hard Disk is significant, with a p-value of 0.0198 from the likelihood ratio chi-square value. A larger slope is shown for Hard Disk in the Prediction Profiler for females.

One-Table Analysis

The Choice Modeling platform can also be used if all of your data are in one table. For this one-table scenario, you use only the Profile Data section of the Choice Dialog box. Subject-specific terms can be used in the model, but not as main effects. Two advantages, both offering more model-effect flexibility than the three-table specification, are realized by using a one-table analysis:

- Interactions can be selectively chosen instead of automatically getting all possible interactions between subject and profile effects as seen when using three tables.
Unusual combinations of choice sets are allowed. This means, for example, that the first trial can have a choice set of two, the second trial can consist of a choice set of three, the third trial can have a choice set of five, and so on. With multiple tables, in contrast, it is assumed that the number of choices for each trial is fixed.

A choice response consists of a set of rows, uniquely identified by the Grouping columns. An indicator column is specified for Profile ID in the Choice Dialog box. This indicator variable uses the value of 1 for the chosen profile row and 0 elsewhere. There must be exactly one “1” for each Grouping combination.

Example: One-Table Pizza Data

This example illustrates how the pizza data are organized for the one-table situation. Figure 18.25 shows a subset of the combined pizza data. Open Pizza Combined.jmp from the sample data directory to see the complete table. Each subject completes four choice sets, with each choice set or trial consisting of two choices. For this example, each subject has eight rows in the data set. The indicator variable specifies the chosen profile for each choice set. The columns Subject and Trial together identify the choice set, so they are the Grouping columns.

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>M</td>
<td>1</td>
<td>1</td>
<td>ThickSkin</td>
<td>0</td>
<td>Thin</td>
</tr>
<tr>
<td>2</td>
<td>M</td>
<td>1</td>
<td>1</td>
<td>ThinPepper</td>
<td>1</td>
<td>Thin</td>
</tr>
<tr>
<td>3</td>
<td>M</td>
<td>1</td>
<td>2</td>
<td>ThinPepper</td>
<td>0</td>
<td>Thin</td>
</tr>
<tr>
<td>4</td>
<td>M</td>
<td>1</td>
<td>2</td>
<td>ThinElga</td>
<td>1</td>
<td>Thin</td>
</tr>
<tr>
<td>5</td>
<td>M</td>
<td>1</td>
<td>2</td>
<td>TrinOld</td>
<td>1</td>
<td>Thin</td>
</tr>
<tr>
<td>6</td>
<td>M</td>
<td>1</td>
<td>3</td>
<td>TrinEll</td>
<td>0</td>
<td>Thin</td>
</tr>
<tr>
<td>7</td>
<td>M</td>
<td>1</td>
<td>4</td>
<td>ThickEll</td>
<td>1</td>
<td>Thin</td>
</tr>
<tr>
<td>8</td>
<td>M</td>
<td>1</td>
<td>4</td>
<td>ThickSkin</td>
<td>0</td>
<td>Thin</td>
</tr>
</tbody>
</table>

To analyze the data in this format, open the Profile Data section in the Choice Dialog box, shown in Figure 18.26.

- Specify Pizza Combined.jmp as the data set.
- Specify Indicator as the Profile ID, Subject and Trial as the Grouping variables, and add Crust, Cheese, and Topping as the main effects.
- Click Run.
A new dialog box appears asking if this is a one-table analysis with all of the data in the Profile Table.

- Click **Yes** to fit the model, as shown in Figure 18.27.
Select **Profiler** from the drop-down menu to obtain the results shown in Figure 18.28. Notice that the parameter estimates and the likelihood ratio test results are identical to the results obtained for the Choice Model with only two tables, shown in Figure 18.6 and Figure 18.7.

**Figure 18.28** Prediction Profiler for Pizza Data One-Table Analysis

Segmentation

Market researchers sometimes want to analyze the preference structure for each subject separately in order to see whether there are groups of subjects that behave differently. However, there are usually not enough data to do this with ordinary estimates. If there are sufficient data, you can specify "By groups" in the Response Data or you could introduce a Subject identifier as a subject-side model term. This approach, however, is costly if the number of subjects is large. Other segmentation techniques discussed in the literature include Bayesian and mixture methods.

You can also use JMP to segment by clustering subjects using response data. For example, after running the model using the Pizza Profiles.jmp, Pizza Responses.jmp, and the optional Pizza Subjects.jmp data sets, click on the drop-down menu for the Choice Model platform and select **Save Gradients by Subject**. A new data table is created containing the average Hessian-scaled gradient on each parameter, and there is one row for each subject.

**Note:** This feature is regarded as an experimental method, since, in practice, little research has been conducted on its effectiveness.
These gradient values are the subject-aggregated Newton-Raphson steps from the optimization used to produce the estimates. At the estimates, the total gradient is zero, and

$$\Delta = H^{-1}g = 0$$

where \(g\) is the total gradient of the log-likelihood evaluated at the MLE, and

$$H^{-1}$$ is the inverse Hessian function or the inverse of the negative of the second partial derivative of the log-likelihood.

But, the disaggregation of \(\Delta\) results in

$$\Delta = \sum_{ij} \Delta_{ij} = \sum_{ij} H^{-1} g_{ij} = 0$$

where \(i\) is the subject index, \(j\) is the choice response index for each subject, \(\Delta_{ij}\) are the partial Newton-Raphson steps for each run, and \(g_{ij}\) is the gradient of the log-likelihood by run.

The mean gradient step for each subject is then calculated as:

$$\Delta_i = \frac{\sum_j \Delta_{ij}}{n_i}$$

where \(n_i\) is the number of runs per subject.

These \(\Delta_i\) are related to the force that subject \(i\) is applying to the parameters.

If groups of subjects have truly different preference structures, these forces are strong, and they can be used to cluster the subjects.

The \(\Delta_i\) are the gradient forces that are saved.

A partial data table with these subject forces is shown in Figure 18.29.

**Figure 18.29** Gradients by Subject for Pizza Data

You can cluster these values by clicking on the drop-down menu of **Hierarchical Clustering** in the new data table and selecting **Run Script**. The resulting dendrogram of the clusters is shown in Figure 18.30.
Now, select the number of clusters desired by moving the diamond indicator at the top or bottom of the dendrogram. Alternatively, you can select Number of Clusters in the platform drop-down menu and enter a number. You can save the cluster IDs by clicking on the drop-down menu of Hierarchical Clustering and selecting Save Clusters. A new column called Cluster is created in the data table containing the gradients. Each subject has been assigned a Cluster value that is associated with other subjects having similar gradient forces. Refer to “Hierarchical Clustering,” p. 447 in the “Clustering” chapter for a discussion of other available options of Hierarchical Clustering. The gradient columns can be deleted since they were used only to obtain the clusters. Your data table then contains only Subject and Cluster variables.

If you click on Run Script under the Merge Data Back menu, as shown in the partial gradient-by-subject table in Figure 18.31, the cluster information becomes a part of the Subject data table.
The columns in the Subject data table are now Subject, Gender, and Cluster, as shown in Figure 18.32.

This table can then be used for further analysis. For example, select Analyze > Fit Y by X. Then, specify Gender as the Y, Response and Cluster as X, Factor. For the pizza example, this analysis is depicted in Figure 18.33.
Figure 18.33 shows that Cluster 1 contains only males, Cluster 2 is half male and female, and Cluster 3 is all female. If desired, you could now refit and analyze the model with the addition of the Cluster variable.

**Special Data Rules**

**Default choice set**

If in every trial you can choose any of the response profiles, you can omit the Profile ID Choices selection under Pick Role Variables in the Response Data section of the Choice Dialog Box. Then the Choice Model platform assumes that all choice profiles are available on each run.
Subject Data with Response Data

If you have subject data in the Response data table, just select this table as the Select Data Table under the Subject Data. In this case, a Subject ID column does not need to be specified. In fact, it is not used. It is generally assumed that the subject data repeats consistently in multiple runs for each subject.

Logistic Regression

Ordinary logistic regression can be done with the Choice Modeling platform.

Note: The Fit Y by X and Fit Model platforms are more convenient to use than the Choice Modeling platform for logistic regression modeling. This section is used only to demonstrate that the Choice Modeling platform can be used for logistic regression, if desired.

If your data are already in the choice-model format, you might want to use the steps given below for logistic regression analysis. However, three steps are needed:

• Create a trivial Profile data table with a row for each response level.
• Put the explanatory variables into the Response data.
• Specify the Response data table, again, for the Subject data table.

An example of using the Choice Modeling platform for logistic regression follows:

1. Select Analyze > Modeling > Choice > Select Data Table > Other > OK.
2. Open the sample data set Lung Cancer Responses.jmp. Notice this data table has only one column (Lung Cancer) with two rows (Cancer and NoCancer).
3. Select Lung Cancer as the Profile ID and Add Lung Cancer as the model effect. The Profile Data dialog box is shown in Figure 18.34.
4. Click on the disclosure button for Response Data > Select Data Table > Other > OK.
5. Open the sample data set Lung Cancer Choice.jmp.
6. Select Lung Cancer for Profile ID Chosen, Choice1 and Choice2 for Profile ID Choices, and Count for Freq. The Response Data launch dialog box is shown in Figure 18.35.
7. Click on the disclosure button for Subject Data > Select Data Table > Lung Cancer Choice.jmp > OK.

8. Add Smoker as the model effect. The Subject Data launch dialog box is shown in Figure 18.36.

Figure 18.36 Subject Data for Lung Cancer Example


Choice Modeling results are shown in Figure 18.37.

Figure 18.37 Choice Modeling Logistic Regression Results for the Cancer Data

Compare these results with those of logistic regression under the Fit Model platform:

- Open Lung Cancer.jmp in the sample data directory.
Select **Analyze > Fit Model**. Automatic specification of the columns is: **Lung Cancer** for **Y**, **Count** for **Freq**, and **Smoker** for **Add** under **Construct Model Effects**. The **Nominal Logistic** personality is automatically selected.

Click on **Run**. The nominal logistic fit for the data is shown in Figure 18.38.

---

**Figure 18.38** Fit Model Nominal Logistic Regression Results for the Cancer Data

<table>
<thead>
<tr>
<th>Nominal Logistic Fit for Lung Cancer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converged in Gradient, 4 Iterations</td>
</tr>
<tr>
<td>iterations</td>
</tr>
<tr>
<td>Whole Model Test</td>
</tr>
<tr>
<td>Model</td>
</tr>
<tr>
<td>Difference</td>
</tr>
<tr>
<td>Full</td>
</tr>
<tr>
<td>Reduced</td>
</tr>
<tr>
<td>R2Square (U)</td>
</tr>
<tr>
<td>AIC</td>
</tr>
<tr>
<td>BIC</td>
</tr>
<tr>
<td>Observations (or Sum Wghts)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Measures</th>
<th>Training Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entrpy R Square</td>
<td>0.0101 = 1 - LogLikelihood(LogLikelihood)</td>
</tr>
<tr>
<td>Generalized R Square</td>
<td>0.0105 = 1 - LogLikelihood(LogLikelihood) / (1 - LogLikelihood(LogLikelihood))</td>
</tr>
<tr>
<td>Mean Log p</td>
<td>0.0881 = LogLikelihood</td>
</tr>
<tr>
<td>MSE</td>
<td>0.4966</td>
</tr>
<tr>
<td>Mean Abs Dev</td>
<td>0.4933</td>
</tr>
<tr>
<td>Misclassification Rate</td>
<td>0.4732</td>
</tr>
<tr>
<td>N</td>
<td>1.416</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter Estimates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Term</td>
</tr>
<tr>
<td>Intercept</td>
</tr>
<tr>
<td>Smoker[NonSmoker]</td>
</tr>
</tbody>
</table>

For log odds of Cancer/No Cancer

<table>
<thead>
<tr>
<th>Covariance of Estimates</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Effect Likelihood Ratio Tests</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
</tr>
<tr>
<td>Smoker</td>
</tr>
</tbody>
</table>

Notice that the likelihood ratio chi-square test for Smoker*Lung Cancer in the Choice model matches the likelihood ratio chi-square test for Smoker in the Logistic model. The reports shown in Figure 18.37 and Figure 18.38 support the conclusion that smoking has a strong effect on developing lung cancer. See the “Logistic Regression for Nominal and Ordinal Response” chapter for details.
Transforming Data

Transforming Data to Two Analysis Tables

Although data are often in the Response/Profile/Subject form, the data are sometimes specified in another format that must be manipulated into the normalized form needed for choice analysis. For example, consider the data from Daganzo, found in Daganzo Trip.jmp. This data set contains the travel time for three transportation alternatives and the preferred transportation alternative for each subject. A partial listing of the data set is shown in Figure 18.39.

Each choice number listed must first be converted to one of the travel mode names. This transformation is easily done by using the Choose function in the formula editor, as follows.

- Create a new column labeled Choice Mode. Specify the modeling type as Nominal. Right-click on the Choice Mode column and select Formula.
- Click on Conditional under the Functions (grouped) command, select Choose, and press the comma key twice to obtain additional arguments for the function.
- Click on Choice for the Choose expression (expr), and double-click on each clause entry box to enter "Subway", "Bus", and "Car" (with the quotation marks) as shown in Figure 18.40.

The choice response is now in the correct format. Since each row contains a choice made by each subject, another column containing a sequence of numbers should be created to identify the subjects. This can be done by creating a column with the Subject label. Then, enter a 1 in the first row of the column, a 2 in the second row of the column. Finally, highlight the first and second rows of the column, right-click, and select Fill > Continue sequence to end of table. A partial listing of the modified table is shown in Figure 18.41.
In order to construct the Profile data, each alternative needs to be expressed in a separate row.

- Use the Stack operation by clicking on Tables > Stack and filling in the entry fields as shown in Figure 18.42. Give this new data table a name, such as Stacked Daganzo.jmp, so that you can use this table for future analyses. Click OK. A partial view of the resulting table is shown in Figure 18.43.
• Make a subset of the stacked data with just Subject, Mode, and Travel Time by selecting these columns and selecting Tables > Subset > OK. A partial data table is shown in Figure 18.44.

**Figure 18.44 Partial Subset Table of Daganzo Data**

<table>
<thead>
<tr>
<th>Subject</th>
<th>Mode</th>
<th>Travel Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Subway</td>
<td>18.491</td>
</tr>
<tr>
<td>2</td>
<td>Bus</td>
<td>18.196</td>
</tr>
<tr>
<td>3</td>
<td>Car</td>
<td>23.99</td>
</tr>
<tr>
<td>4</td>
<td>Subway</td>
<td>15.123</td>
</tr>
<tr>
<td>5</td>
<td>Bus</td>
<td>11.373</td>
</tr>
<tr>
<td>6</td>
<td>Car</td>
<td>14.192</td>
</tr>
<tr>
<td>7</td>
<td>Subway</td>
<td>19.489</td>
</tr>
</tbody>
</table>

• Make another subset of the original data with just Subject and Choice Mode. Then, add three constant columns for the choice set: Choice1, Choice2, and Choice3, as shown in Figure 18.45.

**Figure 18.45 Partial Subset Table of Daganzo Data with Choice Set**

<table>
<thead>
<tr>
<th>Choice Mode</th>
<th>Subject</th>
<th>Choice1</th>
<th>Choice2</th>
<th>Choice3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus</td>
<td>1</td>
<td>Subway</td>
<td>Car</td>
<td></td>
</tr>
<tr>
<td>Bus</td>
<td>2</td>
<td>Subway</td>
<td>Car</td>
<td></td>
</tr>
<tr>
<td>Bus</td>
<td>3</td>
<td>Subway</td>
<td>Car</td>
<td></td>
</tr>
<tr>
<td>Bus</td>
<td>4</td>
<td>Subway</td>
<td>Car</td>
<td></td>
</tr>
<tr>
<td>Bus</td>
<td>5</td>
<td>Subway</td>
<td>Car</td>
<td></td>
</tr>
<tr>
<td>Bus</td>
<td>6</td>
<td>Subway</td>
<td>Car</td>
<td></td>
</tr>
<tr>
<td>Bus</td>
<td>7</td>
<td>Subway</td>
<td>Car</td>
<td></td>
</tr>
</tbody>
</table>

• Specify the model, as shown in Figure 18.46.
Run the model. The resulting parameter estimate now expresses the utility coefficient for Travel Time and is shown in Figure 18.47.
The negative coefficient implies that increased travel time has a negative effect on consumer utility or satisfaction. The likelihood ratio test result indicates that the Choice model with the effect of Travel Time is significant.

**Transforming Data to One Analysis Table**

Rather than creating two or three tables, it can be more practical to transform the data so that only one table is used. For the one-table format, the subject effect is added as above. A response indicator column is added instead of using three different columns for the choice sets (Choice1, Choice2, Choice3). The transformation steps for the one-table scenario include:

- Create or open *Stacked Daganzo.jmp* from the steps shown in *Transforming Data to Two Analysis Tables*.
- Add a new column labeled Response and right-click on the column. Select Formula.
- Select Conditional > If from the formula editor and select the column Choice Mode for the expression.
- Type “=” and select Mode.
- Type 1 for the Then Clause and 0 for the Else Clause. Click OK. The completed formula should look like Figure 18.48.

![Figure 18.47 Parameter Estimate for Travel Time of Daganzo Data](image)

<table>
<thead>
<tr>
<th>Parameter Estimates</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Term</td>
<td>Estimate</td>
<td>Std Error</td>
</tr>
<tr>
<td>Travel Time</td>
<td>-0.341</td>
<td>0.07422</td>
</tr>
<tr>
<td>AICc</td>
<td>98.76855</td>
<td></td>
</tr>
<tr>
<td>BIC</td>
<td>78.99534</td>
<td></td>
</tr>
<tr>
<td>-2LogLikelihood</td>
<td>98.98331</td>
<td></td>
</tr>
<tr>
<td>-2LogLikelihood N</td>
<td>94.98094</td>
<td></td>
</tr>
</tbody>
</table>

**Effect Likelihood Ratio Tests**

<table>
<thead>
<tr>
<th>Source</th>
<th>ChiSquare</th>
<th>DF</th>
<th>Prob&gt;ChiSq</th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel Time</td>
<td>48.371</td>
<td>1</td>
<td>&lt;0.0001</td>
</tr>
</tbody>
</table>

![Figure 18.48 Formula for Response Indicator for Stacked Daganzo Data](image)
Subset the data table by selecting Subject, Travel Time, and Response and then select Tables > Subset > OK. A partial listing of the new data table is shown in Figure 18.49.

![Figure 18.49 Partial Table of Stacked Daganzo Data Subset]

Select Analyze > Modeling > Choice to open the launch dialog box and specify the model as shown in Figure 18.50.

![Figure 18.50 Choice Dialog Box for Subset of Stacked Daganzo Data for One-Table Analysis]

Select Run. A pop-up dialog window asks if this is a one-table analysis with all the data in the Profile Table. Select Yes to obtain the parameter estimate expressing the utility Travel Time coefficient, shown in Figure 18.51.
Notice that the result is identical to that obtained for the two-table model, shown earlier in Figure 18.47. This chapter illustrates the use of the Choice Modeling platform with simple examples. This platform can also be used for more complex models, such as those involving more complicated transformations and interaction terms.
The Multivariate platform specializes in exploring how many variables relate to each other. The platform begins by showing a standard correlation matrix. The Multivariate platform popup menu gives the additional correlations options and other techniques for looking at multiple variables such as

- a scatterplot matrix with normal density ellipses.
- inverse, partial, and pairwise correlations.
- a covariance matrix.
- nonparametric measures of association.
- simple statistics (such as mean and standard deviation).
- an outlier analysis that shows how far a row is from the center, respecting the correlation structure.
- a principal components facility with several options for rotated components and a table showing rotated factor patterns and communalities.
- imputation of missing data.

All plots and the current data table are linked. You can highlight points on any scatterplot in the scatterplot matrix, or the outlier distance plot. The points are highlighted on all other plots and are selected in the data table.
Contents

Launch the Platform and Select Options ................................................. 423
  Correlations Multivariate ................................................................. 424
  CI of Correlation .................................................................................. 425
  Inverse Correlations and Partial Correlations ....................................... 425
  Set a Level ............................................................................................. 426
  Scatterplot Matrix ................................................................................ 426
  Covariance Matrix ................................................................................ 429
  Pairwise Correlations .......................................................................... 429
  Color Maps ............................................................................................ 429
  Simple Statistics ................................................................................... 430
  Nonparametric Correlations ................................................................. 431
  Outlier Analysis ..................................................................................... 431
  Principal Components .......................................................................... 434
  Item Reliability ....................................................................................... 434
  Parallel Coordinate Plot ....................................................................... 436
  Ellipsoid 3D Plot .................................................................................... 436
  Impute Missing Data ............................................................................ 437

Computations and Statistical Details ..................................................... 438
  Pearson Product-Moment Correlation .................................................... 438
  Nonparametric Measures of Association .............................................. 438
  Inverse Correlation Matrix ................................................................... 440
  Distance Measures ................................................................................ 440
  Cronbach's a ......................................................................................... 441
Launch the Platform and Select Options

When you choose **Analyze > Multivariate Methods > Multivariate** and select a data table, you can choose several different estimation methods for the correlations, including a **Default** option. These Estimation Method options are available to provide flexibility with various data sets and to accommodate personal preferences, as shown below:

- The **Default** option enables the JMP platform to choose between the **REML** or **Pairwise** methods, depending upon the number of rows and columns in your dataset, and whether or not missing data is present. If your dataset has more than 10 columns or more than 5000 rows, **Pairwise** will be chosen, otherwise, **REML** will be used as the **Default** method.

- **REML** (restricted maximum likelihood) estimates are less biased than the **ML** (maximum likelihood) estimation method. This method computes marginal likelihoods based upon error contrasts and is useful in the estimation of variance components as well as covariance functions. It is useful in mixed-models, where repeated measures are found across variables and an unstructured covariance matrix is assumed. See SAS PROC MIXED. **REML** uses all of your data, even if missing cells are present, and is most useful for smaller datasets. Because of the bias-correction factor, this method is slow if your dataset is large and there are many missing data values. If there are no missing cells in the data, then the **REML** estimate is equivalent to the sample covariance matrix. For additional information on **REML**, see “**REML Results**,” p. 112 in the “Standard Least Squares: Random Effects” chapter.

- For large datasets with missing cells, **ML** is useful. The **ML** estimates are similar to the **REML** estimates, but the **ML** estimates are generated faster. Observations with missing values are not excluded. For small datasets, **REML** is preferred over **ML** because **REML**'s variance and covariance estimates are less biased.

- The **Robust** method is particularly useful if you suspect that your data have one or more outliers. **Robust** essentially ignores the outlying values by substantially down-weighting them. A sequence of iteratively reweighted fits of the data is done using the weight:

  \[ w_i = \begin{cases} 
  1.0 & \text{if } Q < K \\
  K/Q & \text{otherwise,}
  \end{cases} \]
where \( K \) is a constant equal to the 0.9 quantile of a chi-square distribution with the degrees of freedom equal to the number of columns in the dataset, and

\[
Q = (y_i - \mu)^T (S^2)^{-1} (y_i - \mu)
\]

where \( y_i \) is the response for the \( i \)th observation, \( \mu \) is the population mean, \( S^2 \) is current estimate of the covariance matrix, and \( T \) is the transpose matrix operation.

- **Row-wise** estimation does not use observations containing missing cells. The **Row-wise** option is useful if you want to check compatibility with earlier JMP versions (before JMP 8), if you want to explore the relationship of missing versus nonmissing cells within the dataset, or if you want to exclude any observations that have missing data. (Row-wise estimation was the only estimation method available before JMP 8.)

- **Pairwise** performs correlations for all rows for each pair of columns having nonmissing values.

REML and **Pairwise** are the methods used most frequently. You can also estimate missing values by using the estimated covariance matrix and then using the **Impute Missing Data** command, shown later in this chapter. See “Impute Missing Data,” p. 437.

The multivariate report first shows the standard correlation matrix and scatterplot matrix. The platform popup menu shown here lists additional correlation options and other techniques for looking at multiple variables. The following sections describe the tables and plots offered by the Multivariate platform.

In most of the following analysis options, a missing value in an observation does not cause the entire observation to be deleted. However, the **Pairwise Correlations** command excludes rows that are missing for either of the variables under consideration. The **Simple Statistics > Univariate** command calculates its statistics column-by-column, without regard to missing values in other columns.

Many of the following examples use the **Solubility.jmp** sample data table.

### Correlations Multivariate

The **Correlations Multivariate** option gives the Correlations table, which is a matrix of correlation coefficients that summarizes the strength of the linear relationships between each pair of response (Y) variables. This correlation matrix is calculated by the method you select in the launch dialog.

<table>
<thead>
<tr>
<th></th>
<th>1-Octanol</th>
<th>Ether</th>
<th>Chloroform</th>
<th>Benzeno</th>
<th>Carbon Tetrachloride</th>
<th>Hexane</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Octanol</td>
<td>1.00000</td>
<td>0.9043</td>
<td>0.5976</td>
<td>0.7197</td>
<td>0.6151</td>
<td>0.6046</td>
</tr>
<tr>
<td>Ether</td>
<td>0.9043</td>
<td>1.0000</td>
<td>0.5146</td>
<td>0.9411</td>
<td>0.9210</td>
<td>0.8718</td>
</tr>
<tr>
<td>Chloroform</td>
<td>0.5976</td>
<td>0.5146</td>
<td>1.0000</td>
<td>0.9411</td>
<td>0.9210</td>
<td>0.8718</td>
</tr>
<tr>
<td>Benzeno</td>
<td>0.7197</td>
<td>0.9411</td>
<td>0.9411</td>
<td>1.0000</td>
<td>0.9573</td>
<td>0.9091</td>
</tr>
<tr>
<td>Carbon Tetrachloride</td>
<td>0.6151</td>
<td>0.9210</td>
<td>0.9573</td>
<td>1.0000</td>
<td>0.9496</td>
<td></td>
</tr>
<tr>
<td>Hexane</td>
<td>0.6046</td>
<td>0.8718</td>
<td>0.8718</td>
<td>0.9091</td>
<td>1.0000</td>
<td></td>
</tr>
</tbody>
</table>
CI of Correlation

To obtain the two-tailed confidence intervals of the correlations, select **CI of Correlation** from the red-triangle of the Multivariate report. The default confidence coefficient is 95%, but you can change the value by using the **Set a Level** command. Confidence intervals for the correlations of the *Solubility.jmp* data are shown in Figure 19.1.

<table>
<thead>
<tr>
<th>Variable</th>
<th>by Variable</th>
<th>Correlation</th>
<th>Lower 95%</th>
<th>Upper 95%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ether</td>
<td>1-Octanol</td>
<td>0.9243</td>
<td>0.8907</td>
<td>0.9555</td>
</tr>
<tr>
<td>Chloroform</td>
<td>1-Octanol</td>
<td>0.8978</td>
<td>0.8427</td>
<td>0.9284</td>
</tr>
<tr>
<td>Chloroform</td>
<td>Ether</td>
<td>0.8148</td>
<td>0.7212</td>
<td>0.8869</td>
</tr>
<tr>
<td>Benzene</td>
<td>1-Octanol</td>
<td>0.7197</td>
<td>0.6657</td>
<td>0.7814</td>
</tr>
<tr>
<td>Benzene</td>
<td>Ether</td>
<td>0.6489</td>
<td>0.4911</td>
<td>0.7855</td>
</tr>
<tr>
<td>Benzoic</td>
<td>Chloroform</td>
<td>0.9411</td>
<td>0.8072</td>
<td>0.9829</td>
</tr>
<tr>
<td>Carbon Tetrachloride 1-Octanol</td>
<td>0.9518</td>
<td>0.8472</td>
<td>0.7412</td>
<td></td>
</tr>
<tr>
<td>Carbon Tetrachloride Ether</td>
<td>0.9228</td>
<td>0.8763</td>
<td>0.8841</td>
<td></td>
</tr>
<tr>
<td>Carbon Tetrachloride Chloroform</td>
<td>0.9210</td>
<td>0.8763</td>
<td>0.8909</td>
<td></td>
</tr>
<tr>
<td>Carbon Tetrachloride Benzene</td>
<td>0.9272</td>
<td>0.9225</td>
<td>0.9722</td>
<td></td>
</tr>
<tr>
<td>Hexane</td>
<td>1-Octanol</td>
<td>0.8648</td>
<td>0.6537</td>
<td>0.7335</td>
</tr>
<tr>
<td>Hexane</td>
<td>Ether</td>
<td>0.8404</td>
<td>0.6640</td>
<td>0.8928</td>
</tr>
<tr>
<td>Hexane</td>
<td>Benzene</td>
<td>0.9718</td>
<td>0.9023</td>
<td>0.9401</td>
</tr>
<tr>
<td>Hexane</td>
<td>Carbon Tetrachloride</td>
<td>0.9498</td>
<td>0.9201</td>
<td>0.9604</td>
</tr>
</tbody>
</table>

Inverse Correlations and Partial Correlations

The inverse correlation matrix (**Inverse Corr** table), shown at the top in the next figure, provides useful multivariate information. The diagonal elements of the matrix are a function of how closely the variable is a linear function of the other variables. In the inverse correlation, the diagonal is $1/(1 - R^2)$ for the fit of that variable by all the other variables. If the multiple correlation is zero, the diagonal inverse element is 1. If the multiple correlation is 1, then the inverse element becomes infinite and is reported missing.
Launch the Platform and Select Options

The partial correlation table (Partial Corr table) shows the partial correlations of each pair of variables after adjusting for all the other variables. This is the negative of the inverse correlation matrix scaled to unit diagonal.

### Set α Level

The Multivariate platform allows you to interactively specify any alpha value for the correlation confidence intervals. Four alpha values are listed: 0.01, 0.05, 0.10, and 0.50. Selecting the Other command brings up a dialog where you can enter any other value. The default value of alpha is 0.05.

### Scatterplot Matrix

To help you visualize the correlations, a scatterplot for each pair of response variables displays in a matrix arrangement, as shown in Figure 19.2. The scatterplot matrix is shown by default. If the scatterplots are not showing, select Scatterplot Matrix from the platform popup menu. The cells of the scatterplot matrix are size-linked so that stretching a plot from any cell resizes all the scatterplot cells.

By default, a 95% bivariate normal density ellipse is imposed on each scatterplot. If the variables are bivariate normally distributed, this ellipse encloses approximately 95% of the points. The correlation of the variables is seen by the collapsing of the ellipse along the diagonal axis. If the ellipse is fairly round and is not diagonally oriented, the variables are uncorrelated.
The popup menu next on the Scatterplot Matrix title bar button lets you tailor the matrix with color and density ellipses and by setting the $\alpha$-level.

- **Show Points** toggles the display of points on and off in the scatterplot matrix.
- **Density Ellipses** toggles the display of the density ellipses on the scatterplots constructed by the $\alpha$ level that you choose. By default they are 95% ellipses.
- **Shaded Ellipses** provides color inside each ellipse.
- **Show Correlations** shows the correlation of each histogram in the upper left corner of each scatterplot.
- **Show Histogram** draws histograms in the diagonal of the scatterplot matrix. These histograms can be specified as **Horizontal** or **Vertical**. In addition, you can toggle the counts that label each bar with the **Show Counts** command.

**Figure 19.2** Example of a Scatterplot Matrix

Two clusters of correlations: The first two variables and the next four.
Launch the Platform and Select Options

**Ellipse** $\alpha$ lets you select from a submenu of standard $\alpha$-levels or select the **Other** command and specifically set the $\alpha$ level for the density ellipses.

**Ellipses Transparency** lets you select a transparency value from a submenu or select the **Other** command to specify any desired transparency value. The default transparency value is 0.2.

**Ellipse Color** lets you select from a palette of colors to change the color of the ellipses.

You can reorder the scatterplot matrix columns by dragging a diagonal (label) cell to another position on the diagonal. For example, if you drag the cell of the column labeled Ether diagonally down one cell, the columns reorder as shown in Figure 19.3.

When you look for patterns in the whole scatterplot matrix with reordered columns, you clearly see the variables cluster into groups based on their correlations, as illustrated previously by the two groups showing in Figure 19.2.

**Figure 19.3** Reorder Scatterplot Matrix
**Covariance Matrix**

The **Covariance Matrix** command displays the covariance matrix for the analysis.

```
<table>
<thead>
<tr>
<th></th>
<th>1-Octanol</th>
<th>Ether</th>
<th>Chloroform</th>
<th>Benzene</th>
<th>Carbon Tetrachloride</th>
<th>Hexane</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Octanol</td>
<td>0.67953</td>
<td>0.7097</td>
<td>0.57058</td>
<td>0.72775</td>
<td>0.64207</td>
<td>0.59393</td>
</tr>
<tr>
<td>Ether</td>
<td>0.70270</td>
<td>0.80217</td>
<td>0.98944</td>
<td>0.79522</td>
<td>0.80506</td>
<td>0.76796</td>
</tr>
<tr>
<td>Chloroform</td>
<td>0.57555</td>
<td>0.95945</td>
<td>1.34944</td>
<td>1.24469</td>
<td>1.36976</td>
<td>1.41442</td>
</tr>
<tr>
<td>Benzene</td>
<td>0.72776</td>
<td>0.79022</td>
<td>1.34416</td>
<td>1.51350</td>
<td>1.49577</td>
<td>1.56172</td>
</tr>
<tr>
<td>Carbon Tetrachloride</td>
<td>0.64301</td>
<td>0.86056</td>
<td>1.36568</td>
<td>1.46527</td>
<td>1.81295</td>
<td>1.98448</td>
</tr>
<tr>
<td>Hexane</td>
<td>0.65000</td>
<td>0.76756</td>
<td>1.41412</td>
<td>1.58172</td>
<td>1.86446</td>
<td>1.94596</td>
</tr>
</tbody>
</table>
```

**Pairwise Correlations**

The **Pairwise Correlations** table is shown by selecting the **Pairwise Correlations** option from the red-triangle menu of the Multivariate title bar. It lists the Pearson product-moment correlations for each pair of Y variables. The correlations are calculated by the pairwise deletion method. The count values differ if any pair has a missing value for either variable. The Pairwise Correlations report also shows significance probabilities and compares the correlations with a bar chart. (See Figure 19.4.) All results like significance probabilities, confidence limits, and so on, under this outline, are based on the pairwise method.

**Figure 19.4 Pairwise Correlations Report**

```
<table>
<thead>
<tr>
<th>Variable</th>
<th>by Variable</th>
<th>Correlation</th>
<th>Count</th>
<th>Lower 95%</th>
<th>Upper 95%</th>
<th>Signif Prob</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ether</td>
<td>1-Octanol</td>
<td>0.8043</td>
<td>72</td>
<td>0.8967</td>
<td>0.6586</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Chloroform</td>
<td>1-Octanol</td>
<td>0.5874</td>
<td>72</td>
<td>0.4347</td>
<td>0.7294</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Chloroform</td>
<td>Ether</td>
<td>0.9145</td>
<td>72</td>
<td>0.3212</td>
<td>0.6668</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Benzene</td>
<td>1-Octanol</td>
<td>0.7197</td>
<td>72</td>
<td>0.5867</td>
<td>0.8154</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Benzene</td>
<td>Ether</td>
<td>0.8408</td>
<td>72</td>
<td>0.4911</td>
<td>0.7055</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Benzene</td>
<td>Chloroform</td>
<td>0.8411</td>
<td>72</td>
<td>0.4972</td>
<td>0.9528</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Carbon Tetrachloride</td>
<td>1-Octanol</td>
<td>0.8151</td>
<td>72</td>
<td>0.4412</td>
<td>0.7412</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Carbon Tetrachloride</td>
<td>Ether</td>
<td>0.5326</td>
<td>72</td>
<td>0.2465</td>
<td>0.6041</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Carbon Tetrachloride</td>
<td>Chloroform</td>
<td>0.8218</td>
<td>72</td>
<td>0.3876</td>
<td>0.9506</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Carbon Tetrachloride</td>
<td>Benzene</td>
<td>0.9233</td>
<td>72</td>
<td>0.4305</td>
<td>0.9742</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Hexane</td>
<td>1-Octanol</td>
<td>0.8468</td>
<td>72</td>
<td>0.4327</td>
<td>0.7236</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Hexane</td>
<td>Ether</td>
<td>0.5494</td>
<td>72</td>
<td>0.3640</td>
<td>0.6326</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Hexane</td>
<td>Chloroform</td>
<td>0.8719</td>
<td>72</td>
<td>0.5923</td>
<td>0.9181</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Hexane</td>
<td>Benzene</td>
<td>0.9601</td>
<td>72</td>
<td>0.6561</td>
<td>0.9423</td>
<td>&lt;.001*</td>
</tr>
<tr>
<td>Hexane</td>
<td>Carbon Tetrachloride</td>
<td>0.8468</td>
<td>72</td>
<td>0.4327</td>
<td>0.7236</td>
<td>&lt;.001*</td>
</tr>
</tbody>
</table>
```

**Color Maps**

The Color Map submenu gives you three choices: **Color Map On Correlations**, **Color Map On p-values**, and **Cluster the Correlations**. The first option produces the cell plot on the left of Figure 19.5, showing the correlations among variables on a scale from red (+1) to blue (-1). **Color Map on p-values** shows the significance of the correlations on a scale from p = 0 (red) to p = 1 (blue). **Cluster the Correlations** groups variables that have similar correlations together, which (in the case of Figure 19.5 looks exactly like the color map on correlations.)
Figure 19.5  Cell Plots

Simple Statistics

The Simple Statistics submenu allows you to display simple statistics (mean, standard deviation, and so on) for each column. These statistics can be calculated in two ways that differ when there are missing values in the data table.

**Univariate Simple Statistics** are calculated on each column, regardless of values in other columns. These values match the ones that would be produced using the Distribution platform.

**Multivariate Simple Statistics** are the statistics corresponding to the estimation method selected in the launch dialog. If REML, ML, or Robust methods are selected, the mean vector and covariance matrix are estimated by that selected method. If the Row-wise method is selected, all rows with at least one missing value are excluded from the calculation of means and variances. Finally, if the Pairwise method is selected, the mean and variance are calculated for each column.
Nonparametric Correlations

When you select Nonparametric Correlations from the platform popup menu, the Nonparametric Measures of Association table is shown. The Nonparametric submenu offers these three nonparametric measures:

- **Spearman’s Rho** is a correlation coefficient computed on the ranks of the data values instead of on the values themselves.
- **Kendall’s Tau** is based on the number of concordant and discordant pairs of observations. A pair is **concordant** if the observation with the larger value of X also has the larger value of Y. A pair is **discordant** if the observation with the larger value of X has the smaller value of Y. There is a correction for tied pairs (pairs of observations that have equal values of X or equal values of Y).
- **Hoeffding’s D** is a statistical scale that ranges from –0.5 to 1, with large positive values indicating dependence. The statistic approximates a weighted sum over observations of chi-square statistics for two-by-two classification tables, and detects more general departures from independence.

The Nonparametric Measures of Association report also shows significance probabilities for all measures and compares them with a bar chart similar to the one in Figure 19.4.

See “Computations and Statistical Details,” p. 438, for computational information.

Note: The nonparametric correlations are always calculated by the Pairwise method, even if other methods have been chosen in the launch dialog.

Outlier Analysis

The Outlier Analysis submenu toggles the display of three plots:

- Mahalanobis Distance
- Jackknife Distances
- $T^2$ Statistic.

These all measure distance in the multivariate sense (with respect to the correlation structure), as in the normal ellipse contours shown here. Point A is an outlier because it is outside the correlation structure rather than because it is an outlier in any of the coordinate directions.
Figure 19.6 shows the Mahalanobis distance of each point from the multivariate mean (centroid). The standard Mahalanobis distance depends on estimates of the mean, standard deviation, and correlation for the data. The distance is plotted for each observation number. Extreme multivariate outliers can be identified by highlighting the points with the largest distance values. See “Computations and Statistical Details,” p. 438, for more information.

**Figure 19.6 Mahalanobis Outlier Distance Plot**

![Mahalanobis Distances](image)

JMP can also calculate an alternate distance using a jackknife technique. The distance for each observation is calculated with estimates of the mean, standard deviation, and correlation matrix that do not include the observation itself. The jackknifed distances are useful when there is an outlier. In this case, the Mahalanobis distance is distorted and tends to disguise the outlier or make other points look more outlying than they are.

**Figure 19.7 Jackknifed Distances Plot**

![Jackknife Distances](image)
A third option is the $T^2$ statistic. This is the square of the Mahalanobis distance, and is preferred for multivariate control charts. The plot includes the value of the calculated $T^2$ statistic, as well as its upper control limit. Values that fall outside this limit may be an outlier.

**Figure 19.8 $T^2$ Statistic Plot**

![T^2 Statistic Plot]

**Saving Distances and Values**

Each of the three outlier methods allows you to save distances back to the data table. To save the distances, use the popup menu beside the name of the distance you want to save. For example, the following figure saves values for the $T^2$ statistic.

![Distances Saved in Data Table]

There is no formula saved with the distance column. This means the distance is not recomputed if you modify the data table. If you add or delete columns or change values in the data table, you should select Analyze > Multivariate Methods > Multivariate again to compute new distances.

**Figure 19.9 Distances Saved in Data Table**

<table>
<thead>
<tr>
<th>Labels</th>
<th>1-Octanol</th>
<th>Ether</th>
<th>Chloroform</th>
<th>Benzene</th>
<th>Carbon Tetrachloride</th>
<th>Hexane</th>
<th>$T^2$</th>
</tr>
</thead>
<tbody>
<tr>
<td>METHANOL</td>
<td>-0.70</td>
<td>-1.10</td>
<td>-1.20</td>
<td>-1.90</td>
<td>-2.10</td>
<td>-2.80</td>
<td>6.78</td>
</tr>
<tr>
<td>ETHANOL</td>
<td>-0.30</td>
<td>-0.60</td>
<td>-0.80</td>
<td>-1.30</td>
<td>-1.40</td>
<td>-2.10</td>
<td>6.40</td>
</tr>
<tr>
<td>PROPAHOL</td>
<td>0.20</td>
<td>-0.020</td>
<td>-0.40</td>
<td>-0.70</td>
<td>-0.80</td>
<td>-1.52</td>
<td>2.90</td>
</tr>
<tr>
<td>BUTANOL</td>
<td>0.080</td>
<td>0.080</td>
<td>0.40</td>
<td>-0.120</td>
<td>-0.40</td>
<td>-0.70</td>
<td>1.12</td>
</tr>
<tr>
<td>BUTYRINOL</td>
<td>1.600</td>
<td>1.20</td>
<td>1.050</td>
<td>0.920</td>
<td>0.40</td>
<td>-0.40</td>
<td>1.27</td>
</tr>
<tr>
<td>HEXANOL</td>
<td>2.00</td>
<td>1.00</td>
<td>1.090</td>
<td>1.300</td>
<td>0.900</td>
<td>0.400</td>
<td>1.72</td>
</tr>
</tbody>
</table>
In addition to saving the distance values for each row, a column property is created that holds the distance value (for Mahalanobis Distance and Jackknife distance) or a list containing the UCL of the $T^2$ statistic.

**Principal Components**

Principal components is a technique to take linear combinations of the original variables such that the first principal component has maximum variation, the second principal component has the next most variation subject to being orthogonal to the first, and so on. See the chapter “Principal Components,” p. 465 for details on principal components.

**Item Reliability**

Item reliability indicates how consistently a set of instruments measures an overall response. Cronbach's $\alpha$ (Cronbach 1951) is one measure of reliability. Two primary applications for Cronbach's $\alpha$ are industrial instrument reliability and questionnaire analysis.

Cronbach's $\alpha$ is based on the average correlation of items in a measurement scale. It is equivalent to computing the average of all split-half correlations in the data set. The Standardized $\alpha$ can be requested if the items have variances that vary widely. The items in the scale can be continuous, as in a Likert scale, or categorical.

Cronbach's $\alpha$ is not related to a significance level $\alpha$. Also, item reliability is unrelated to survival time reliability analysis.
As an example, consider the Danger.jmp data in the Sample Data folder. This table lists 30 items having some level of inherent danger. Three groups of people (students, nonstudents, and experts) ranked the items according to perceived level of danger. Note that Nuclear power is rated as very dangerous (1) by both students and nonstudents but was ranked low (20) by experts. On the other hand, motorcycles are ranked fifth or sixth by the three judging groups.

You can use Cronbach’s $\alpha$ to evaluate the agreement in the perceived way the groups ranked the items. The results at the bottom in Figure 19.10 show an overall $\alpha$ of 0.8666, which indicates a high correlation of the ranked values among the three groups. Further, when you remove the experts from the analysis, the Nonstudents and Students ranked the dangers nearly the same, with Cronbach’s $\alpha$ scores of 0.7785 and 0.7448, respectively. Nunnally (1979) suggests a Cronbach’s $\alpha$ of 0.7 as a rule-of-thumb acceptable level of agreement.

To look at the influence of an individual item, JMP excludes it from the computations and shows the effect of the Cronbach’s $\alpha$ value. If $\alpha$ increases when you exclude a variable (item), that variable is not highly correlated with the other variables. If the $\alpha$ decreases, you can conclude that the variable is correlated with the other items in the scale. Computations for Cronbach’s $\alpha$ are given in the next section, “Computations and Statistical Details,” p. 438.

Note that in this kind of example, where the values are the same set of ranks for each group, standardizing the data has no effect.
Correlations and Multivariate Techniques

Chapter 19

Launch the Platform and Select Options

Figure 19.10 Cronbach’s α Report

<table>
<thead>
<tr>
<th></th>
<th>Nonstudents</th>
<th>Experts</th>
<th>Students</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonstudents</td>
<td>1.0000</td>
<td>0.5933</td>
<td>0.6216</td>
</tr>
<tr>
<td>Experts</td>
<td>0.5933</td>
<td>1.0000</td>
<td>0.6374</td>
</tr>
<tr>
<td>Students</td>
<td>0.6216</td>
<td>0.6374</td>
<td>1.0000</td>
</tr>
</tbody>
</table>

Parallel Coordinate Plot

The Parallel Coordinate Plot option shows or hides a parallel coordinate plot of the variables.

Figure 19.11 Parallel Coordinate Plot

Ellipsoid 3D Plot

The Ellipsoid 3D Plot toggles a 95% confidence ellipsoid around three chosen variables. When the command is first invoked, a dialog asks which three variables to include in the plot.
Launch the Platform and Select Options

**Figure 19.12** Ellipsoid 3D Plot

**Impute Missing Data**

JMP will now impute missing data. For example, delete several of the values within the first ten rows of Solubility.jmp, as shown in Figure 19.13.

**Figure 19.13** Partial Solubility.jmp with missing data

<table>
<thead>
<tr>
<th>Labels</th>
<th>1-Octanol</th>
<th>Ether</th>
<th>Chloroform</th>
<th>Benzene</th>
<th>Carbon Tetrachloride</th>
<th>Hexane</th>
</tr>
</thead>
<tbody>
<tr>
<td>METHANOL</td>
<td>*</td>
<td>-1.150</td>
<td>-1.250</td>
<td>-1.890</td>
<td>-2.109</td>
<td>-2.809</td>
</tr>
<tr>
<td>ETHANOL</td>
<td>-0.319</td>
<td>*</td>
<td>-0.850</td>
<td>*</td>
<td>-1.403</td>
<td>*</td>
</tr>
<tr>
<td>PROPANOL</td>
<td>0.259</td>
<td>-0.020</td>
<td>-0.410</td>
<td>-0.700</td>
<td>*</td>
<td>-1.520</td>
</tr>
</tbody>
</table>

Click on Analyze > Multivariate Methods > Multivariate and select all of the continuous columns as Y, Columns. Click on the Multivariate platform drop-down menu and select **Impute Missing Data**. All missing data values will be replaced by estimated values, as shown in Figure 19.14.
Imputed values are expectations conditional on the non-missing values for each row. The mean and covariance matrix, which is estimated by the method chosen in the launch dialog, is used for the imputation calculation. All multivariate tests and options are then available for the imputed data set.

**Computations and Statistical Details**

**Pearson Product-Moment Correlation**

The Pearson product-moment correlation coefficient measures the strength of the linear relationship between two variables. For response variables $X$ and $Y$, it is denoted as $r$ and computed as

$$r = \frac{\sum (x-x)^2(y-y)}{\sqrt{\sum (x-x)^2 \sum (y-y)^2}}.$$  

If there is an exact linear relationship between two variables, the correlation is 1 or –1, depending on whether the variables are positively or negatively related. If there is no linear relationship, the correlation tends toward zero.

**Nonparametric Measures of Association**

For the Spearman, Kendall, or Hoeffding correlations, the data are first ranked. Computations are then performed on the ranks of the data values. Average ranks are used in case of ties.

**Spearman’s ρ (rho) Coefficients**

Spearman’s ρ correlation coefficient is computed on the ranks of the data using the formula for the Pearson’s correlation previously described.

**Kendall’s τb Coefficients**

Kendall’s $\tau_b$ coefficients are based on the number of concordant and discordant pairs. A pair of rows for two variables is concordant if they agree in which variable is greater. Otherwise they are discordant, or tied.
The formula
\[ \tau_b = \frac{\sum \text{sgn}(x_i - x_j) \text{sgn}(y_i - y_j)}{\sqrt{\frac{T_0 - T_1}{T_0 - T_2}}} \]
computes Kendall's \( \tau_b \) where
\[ T_0 = \frac{n(n - 1)}{2}, \]
\[ T_1 = \frac{\sum ((t_i)(t_i - 1))}{2}, \text{ and} \]
\[ T_2 = \frac{\sum ((u_i)(u_i - 1))}{2}, \]
Note that \( \text{sgn}(z) \) is equal to 1 if \( z > 0 \), 0 if \( z = 0 \), and -1 if \( z < 0 \).
The \( t_i \) (the \( u_i \)) are the number of tied \( x \) (respectively \( y \)) values in the \( i \)th group of tied \( x \) (respectively \( y \)) values, \( n \) is the number of observations, and Kendall's \( \tau_b \) ranges from -1 to 1. If a weight variable is specified, it is ignored.
Computations proceed in the following way:
- Observations are ranked in order according to the value of the first variable.
- The observations are then re-ranked according to the values of the second variable.
- The number of interchanges of the first variable is used to compute Kendall’s \( \tau_b \).

**Hoeffding’s D Statistic**

The formula for Hoeffding’s \( D \) (1948) is
\[ D = 30 \left( \frac{(n-2)(n-3)D_1 + D_2 - 2(n-2)D_3}{n(n-1)(n-2)(n-3)(n-4)} \right) \]
where:
\[ D_1 = S_i(Q_i - 1)(Q_i - 2) \]
\[ D_2 = S_i(R_i - 1)(S_i - 1)(S_i - 2) \]
\[ D_3 = (R_i - 1)(S_i - 2)(Q_i - 1) \]
The \( R_i \) and \( S_i \) are ranks of the \( x \) and \( y \) values, and the \( Q_i \) (sometimes called bivariate ranks) are one plus the number of points that have both \( x \) and \( y \) values less than the \( i \)th points. A point that is tied on its \( x \) value or \( y \) value, but not on both, contributes 1/2 to \( Q_i \) if the other value is less than the corresponding value for the \( i \)th point. A point tied on both \( x \) and \( y \) contributes 1/4 to \( Q_i \).
When there are no ties among observations, the \( D \) statistic has values between -0.5 and 1, with 1 indicating complete dependence. If a weight variable is specified, it is ignored.
Inverse Correlation Matrix

The inverse correlation matrix provides useful multivariate information. The diagonal elements of the inverse correlation matrix, sometimes called the variance inflation factors (VIF), are a function of how closely the variable is a linear function of the other variables. Specifically, if the correlation matrix is denoted $R$ and the inverse correlation matrix is denoted $R^{-1}$, the diagonal element is denoted $r_{ii}^{\text{VIF}}$ and is computed as

$$r_{ii}^{\text{VIF}} = \frac{1}{1 - R_{i}^2}$$

where $R_{i}^2$ is the coefficient of variation from the model regressing the $i$th explanatory variable on the other explanatory variables. Thus, a large $r_{ii}^{\text{VIF}}$ indicates that the $i$th variable is highly correlated with any number of the other variables.

Note that the definition of $R^2$ changes for no-intercept models. For no-intercept and hidden-intercept models, JMP uses the $R^2$ from the uncorrected Sum of Squares, i.e. from the zero model, rather than the corrected sum of squares, from the mean model.

Distance Measures

The Outlier Distance plot shows the Mahalanobis distance of each point from the multivariate mean (centroid). The Mahalanobis distance takes into account the correlation structure of the data as well as the individual scales. For each value, the distance is denoted $d_i$ and is computed as

$$d_i = \sqrt{(Y_i - \bar{Y})^T S^{-1} (Y_i - \bar{Y})}$$

where:

- $Y_i$ is the data for the $i$th row
- $\bar{Y}$ is the row of means
- $S$ is the estimated covariance matrix for the data

The reference line drawn on the Mahalanobis Distance plot is computed as $\sqrt{F \times \text{nvars}}$ where $\text{nvars}$ is the number of variables and the computation for $F$ in formula editor notation is:

$$F \text{ Quantile}(0.95, \text{nvars}, \text{n} - \text{nvars} - 1, \text{centered at 0})$$

If a variable is an exact linear combination of other variables, then the correlation matrix is singular and the row and the column for that variable are zeroed out. The generalized inverse that results is still valid for forming the distances.

The $T^2$ distance is just the square of the Mahalanobis distance, so $T_i^2 = d_i^2$. The upper control limit on the $T^2$ is

$$UCL = \frac{(n-1)^2}{n} \beta \left[ \frac{\nu_1 + \nu_2 - 1}{2} \right]$$
where

\[ n = \text{number of observations} \]
\[ p = \text{number of variables (columns)} \]
\[ \alpha = \alpha^{\text{th}} \text{quantile} \]
\[ \beta = \text{beta distribution} \]

Multivariate distances are useful for spotting outliers in many dimensions. However, if the variables are
highly correlated in a multivariate sense, then a point can be seen as an outlier in multivariate space without
looking unusual along any subset of dimensions. Said another way, when data are correlated, it is possible
for a point to be unremarkable when seen along one or two axes but still be an outlier by violating the
correlation.

**Statistical Warning:** This outlier distance is not particularly robust in the sense that outlying points
themselves can distort the estimate of the covariances and means in such a way that outliers are disguised.
You might want to use the alternate distance command so that distances are computed with a jackknife
method. The alternate distance for each observation uses estimates of the mean, standard deviation, and
correlation matrix that do not include the observation itself.

**Cronbach’s \( \alpha \)**

Cronbach’s \( \alpha \) is defined as

\[
\alpha = \frac{k \sum \xi \rho}{1 + (k - 1) \sum \xi \rho}
\]

where

\[ k = \text{the number of items in the scale} \]
\[ \xi = \text{the average covariance between items} \]
\[ \rho = \text{the average variance between items}. \]

If the items are standardized to have a constant variance, the formula becomes

\[
\alpha = \frac{k r}{1 + (k - 1) r}
\]

where

\[ r = \text{the average correlation between items}. \]

The larger the overall \( \alpha \) coefficient, the more confident you can feel that your items contribute to a reliable
scale or test. The coefficient can approach 1.0 if you have many highly correlated items.
Clustering is the technique of grouping rows together that share similar values across a number of variables. It is a wonderful exploratory technique to help you understand the clumping structure of your data. JMP provides three different clustering methods:

- Hierarchical clustering is appropriate for small tables, up to several thousand rows. It combines rows in an hierarchical sequence portrayed as a tree. In JMP, the tree, also called a dendrogram, is a dynamic, responding graph. You can choose the number of clusters you like after the tree is built.
- $K$-means clustering is appropriate for larger tables, up to hundreds of thousands of rows. It makes a fairly good guess at cluster seed points. It then starts an iteration of alternately assigning points to clusters and recalculating cluster centers. You have to specify the number of clusters before you start the process.
- Normal mixtures are appropriate when data is assumed to come from a mixture of multivariate normal distributions that overlap. Maximum likelihood is used to estimate the mixture proportions and the means, standard deviations, and correlations jointly. This approach is particularly good at estimating the total counts in each group. However each point, rather than being classified into one group, is assigned a probability of being in each group. The EM algorithm is used to obtain estimates.

After the clustering process is complete, you can save the cluster assignments to the data table or use them to set colors and markers for the rows.
**Introduction to Clustering Methods**

Clustering is a multivariate technique of grouping rows together that share similar values. It can use any number of variables. The variables must be numeric variables for which numerical differences makes sense. The common situation is that data are not scattered evenly through $n$-dimensional space, but rather they form clumps, locally dense areas, modes, or clusters. The identification of these clusters goes a long way towards characterizing the distribution of values.

JMP provides two approaches to clustering:

- **Hierarchical clustering** for small tables, up to several thousand rows
- **$k$-means and normal mixtures** clustering for large tables, up to hundreds of thousands of rows.

Hierarchical clustering is also called *agglomerative clustering* because it is a combining process. The method starts with each point (row) as its own cluster. At each step the clustering process calculates the distance between each cluster, and combines the two clusters that are closest together. This combining continues until all the points are in one final cluster. The user then chooses the number of clusters that seems right and cuts the clustering tree at that point. The combining record is portrayed as a tree, called a *dendrogram*, with the single points as leaves, the final single cluster of all points as the trunk, and the intermediate cluster combinations as branches. Since the process starts with $n(n+1)/2$ distances for $n$ points, this method becomes too expensive in memory and time when $n$ is large.

Hierarchical clustering also supports character columns. If the column is ordinal, then the data value used for clustering is just the index of the ordered category, treated as if it were continuous data. If the column is nominal, then the categories must match to contribute a distance of zero. They contribute a distance of 1 otherwise.

JMP offers five rules for defining distances between clusters: Average, Centroid, Ward, Single, and Complete. Each rule can generate a different sequence of clusters.

$K$-means clustering is an iterative follow-the-leader strategy. First, the user must specify the number of clusters, $k$. Then a search algorithm goes out and finds $k$ points in the data, called *seeds*, that are not close to each other. Each seed is then treated as a cluster center. The routine goes through the points (rows) and assigns each point to the cluster it is closest to. For each cluster, a new cluster center is formed as the means (centroid) of the points currently in the cluster. This process continues as an alternation between assigning points to clusters and recalculating cluster centers until the clusters become stable.

Normal mixtures clustering, like $k$-means clustering, begins with a user-defined number of clusters and then selects distance seeds. JMP uses the cluster centers chosen by $k$-means as seeds. However, each point, rather than being classified into one group, is assigned a probability of being in each group.

SOMs are a variation on $k$-means where the cluster centers are laid out on a grid. Clusters and points close together on the grid are meant to be close together in the multivariate space. See “Self Organizing Maps,” p. 461.

$K$-means, normal mixtures, and SOM clustering are doubly-iterative processes. The clustering process iterates between two steps in a particular implementation of the EM algorithm:

- The *expectation step* of mixture clustering assigns each observation a probability of belonging to each cluster.
Chapter 20

The Cluster Launch Dialog

- For each cluster, a new center is formed using every observation with its probability of membership as a weight. This is the maximization step.

This process continues alternating between the expectation and maximization steps until the clusters become stable.

**Note:** For $k$-means clustering, you can choose a variable whose values form preset fixed centers for clusters, instead of using the default random seeds for clusters.

### The Cluster Launch Dialog

When you choose **Cluster** from the **Analyze > Multivariate Methods** submenu, the Hierarchical Cluster Launch dialog shown in Figure 20.1 appears. The data table used is Birth Death Subset.jmp.

Choose **KMeans** from the Options menu to see the KMeans launch dialog. See “K-Means Clustering,” p. 453 for more information about the KMeans method.

### Figure 20.1 Hierarchical Cluster Launch Dialog

You can specify as many $Y$ variables as you want by selecting the variables in the column selector list and clicking **Y, Columns**.

For Hierarchical clustering, you must also choose one of the clustering distance options: Average, Centroid, Ward, Single, and Complete, and Fast Ward. The clustering methods differ in how the distance between two clusters is computed. These clustering methods are discussed under “Technical Details for Hierarchical Clustering,” p. 451.

By default, data are first standardized by the column mean and standard deviation. Uncheck the **Standardize Data** check box if you do not want the cluster distances computed on standardized values.
You can use the **Data is distance matrix** option if you have a data table of distances instead of raw data. If your raw data consists of \( n \) observations, the distance table should have \( n \) rows and \( n \) columns, with the values being the distances between the observations. The distance table needs to have an additional column giving a unique identifier (such as row number) that matches the column names of the other \( n \) columns. The diagonal elements of the table should be zero, since the distance between a point and itself is zero. For an example of what the distance table should look like, use the option “Save Distance Matrix,” p. 450.

An **Ordering** column can (optionally) be specified in the Hierarchical Clustering launch dialog. In the ordering column, clusters are sorted by their mean value. One way to utilize this feature is to complete a Principal Components analysis (using **Multivariate**) and save the first principal component to use as an **Ordering** column. The clusters are then sorted by these values.

Hierarchical clustering supports character columns as follows. \( K \)-Means clustering only supports numeric columns.

- For Ordinal columns, the data value used for clustering is just the index of the ordered category, treated as if it were continuous data. These data values are standardized like continuous columns.
- For Nominal columns, the categories must either match to contribute a distance of zero, or contribute a standardized distance of 1.

**Hierarchical Clustering**

The **Hierarchical** option clusters rows that group the points (rows) of a JMP table into clusters whose values are close to each other relative to those of other clusters. Hierarchical clustering is a process that starts with each point in its own cluster. At each step, the two clusters that are closest together are combined into a single cluster. This process continues until there is only one cluster containing all the points. This kind of clustering is good for smaller data sets (a few hundred observations).

To see a simple example of hierarchical clustering, select the **Birth Death Subset.jmp** data table. The data are the 1976 crude birth and death rates per 100,000 people.

When you select the **Cluster** command, the Cluster Launch dialog (shown previously in Figure 20.1) appears. In this example the **birth** and **death** columns are used as cluster variables in the default method, Ward's minimum variance, for hierarchical clustering.

In clustering problems, it is especially useful to assign a label variable so that you can determine which observations cluster together. In this example, **country** is the label variable.

When you click **OK**, the clustering process proceeds. The Hierarchical Cluster platform report (see Figure 20.2) consists of a Clustering History table, a dendrogram tree diagram, and a plot of the distances between the clusters. If you assigned a variable the label role, its values identify each observation on the dendrogram.
Clustering
Hierarchical Clustering

Figure 20.2 Hierarchical Cluster Report

The clustering sequence is easily visualized with the help of the dendrogram, shown in Figure 20.2. A dendrogram is a tree diagram that lists each observation, and shows which cluster it is in and when it entered its cluster.

You can drag the small diamond-shaped handle at either the top or bottom of the dendrogram to identify a given number of clusters. If you click on any cluster stem, all the members of the cluster highlight in the dendrogram and in the data table.

The scree plot beneath the dendrogram has a point for each cluster join. The ordinate is the distance that was bridged to join the clusters at each step. Often there is a natural break where the distance jumps up suddenly. These breaks suggest natural cutting points to determine the number of clusters.
Open the Clustering History table to see the results shown in Figure 20.3.

**Figure 20.3 Clustering History**

<table>
<thead>
<tr>
<th>Number of Clusters</th>
<th>Distance</th>
<th>Leader</th>
<th>Joiner</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>0.0000000006</td>
<td>PHILIPPINES</td>
<td>THAILAND</td>
</tr>
<tr>
<td>32</td>
<td>0.104271097</td>
<td>BANGLADESH</td>
<td>SAUDI ARABIA</td>
</tr>
<tr>
<td>31</td>
<td>0.104271097</td>
<td>POLAND</td>
<td>USSR</td>
</tr>
<tr>
<td>30</td>
<td>0.104271097</td>
<td>GERMANY, FED REP OF UNITED KINGDOM</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>0.104271097</td>
<td>AUSTRALIA</td>
<td>YUGOSLAVIA</td>
</tr>
<tr>
<td>28</td>
<td>0.123491892</td>
<td>BRAZIL</td>
<td>PHILIPPINES</td>
</tr>
<tr>
<td>27</td>
<td>0.140113736</td>
<td>TAIWAN</td>
<td>KOREA, REPUBLIC OF CHINA</td>
</tr>
<tr>
<td>26</td>
<td>0.140113736</td>
<td>FRANCE</td>
<td>ITALY</td>
</tr>
<tr>
<td>25</td>
<td>0.140113736</td>
<td>AUSTRIA</td>
<td>GERMANY, DEM REP</td>
</tr>
<tr>
<td>24</td>
<td>0.140113736</td>
<td>CANADA</td>
<td>JAPAN</td>
</tr>
<tr>
<td>23</td>
<td>0.156496644</td>
<td>SWITZERLAND</td>
<td>UNITED STATES</td>
</tr>
<tr>
<td>22</td>
<td>0.209873552</td>
<td>VIETNAM</td>
<td>ZAIRE</td>
</tr>
<tr>
<td>21</td>
<td>0.24473086</td>
<td>ARGENTINA</td>
<td>POLAND</td>
</tr>
<tr>
<td>20</td>
<td>0.254246336</td>
<td>MEXICO</td>
<td>VENEZUELA</td>
</tr>
<tr>
<td>19</td>
<td>0.25426376</td>
<td>TAIWAN</td>
<td>MALAYSIA</td>
</tr>
<tr>
<td>18</td>
<td>0.282881089</td>
<td>BRAZIL</td>
<td>CHINA</td>
</tr>
<tr>
<td>17</td>
<td>0.282901656</td>
<td>ALGERIA</td>
<td>IRAQ</td>
</tr>
<tr>
<td>16</td>
<td>0.289590127</td>
<td>FRANCE</td>
<td>SWITZERLAND</td>
</tr>
<tr>
<td>15</td>
<td>0.308234544</td>
<td>AUSTRIA</td>
<td>GERMANY, FED REP OF USA</td>
</tr>
<tr>
<td>14</td>
<td>0.308234544</td>
<td>AUSTRIA</td>
<td>CANADA</td>
</tr>
<tr>
<td>13</td>
<td>0.312813290</td>
<td>IRAN</td>
<td>SOUTH AFRICA</td>
</tr>
<tr>
<td>12</td>
<td>0.445451502</td>
<td>BANGLADESH</td>
<td>VIETNAM</td>
</tr>
<tr>
<td>11</td>
<td>0.517878988</td>
<td>INDIA</td>
<td>IRAN</td>
</tr>
<tr>
<td>10</td>
<td>0.612559572</td>
<td>ARGENTINA</td>
<td>FRANCE</td>
</tr>
<tr>
<td>9</td>
<td>0.733842726</td>
<td>ARGENTINA</td>
<td>AUSTRALIA</td>
</tr>
<tr>
<td>8</td>
<td>0.793425688</td>
<td>ALGERIA</td>
<td>BANGLADESH</td>
</tr>
<tr>
<td>7</td>
<td>0.823015930</td>
<td>BRAZIL</td>
<td>INDIA</td>
</tr>
<tr>
<td>6</td>
<td>0.908321646</td>
<td>TAIWAN</td>
<td>USSR</td>
</tr>
<tr>
<td>5</td>
<td>1.504765514</td>
<td>ARGENTINA</td>
<td>AUSTRIA</td>
</tr>
<tr>
<td>4</td>
<td>1.603814782</td>
<td>BRAZIL</td>
<td>TAIWAN</td>
</tr>
<tr>
<td>3</td>
<td>2.389576184</td>
<td>AFGHANISTAN</td>
<td>AFGHANISTAN</td>
</tr>
<tr>
<td>2</td>
<td>2.590472542</td>
<td>ARGENTINA</td>
<td>BRAZIL</td>
</tr>
<tr>
<td>1</td>
<td>2.697474106</td>
<td>AFGHANISTAN</td>
<td>ARGENTINA</td>
</tr>
</tbody>
</table>

The number of clusters begins with 33, which is the number of rows in the data table minus one. You can see that the two closest points, the Philippines and Thailand, are joined to reduce the number of existing clusters to 32. They show as the first Leader and Joiner in the Clustering History table. The next two closest points are Bangladesh and Saudi Arabia, followed by Poland and USSR. When Brazil is joined by the Philippines in the sixth line, the Philippines had already been joined by Thailand, making it the first cluster with three points. The last single point to be joined to others is Afghanistan, which reduces the number of clusters from four to three at that join. At the very end a cluster of seven points led by Afghanistan is joined by the rest of the points, led by Argentina. The order of the clusters at each join is unimportant, essentially an accident of the way the data was sorted.
Hierarchical Cluster Options

Hierarchical clustering has the popup menu with the following commands.

**Color Clusters** assigns colors to the rows of the data table corresponding to the cluster the row belongs to. Also colors the dendogram according to the clusters. The colors automatically update if you change the number of clusters.

**Mark Clusters** assigns markers to the rows of the data table corresponding to the cluster the row belongs to. The markers automatically update if you change the number of clusters.

**Number of Clusters** prompts you to enter a number of clusters and positions the dendrogram slider to that number.

**Show Dendrogram** shows or hides the dendrogram.

**Dendrogram Scale** contains options for scaling the dendrogram. **Even Spacing** shows the distance between each join point as equal. **Geometric Spacing** is useful when there are many clusters and you want the clusters near the top of the tree to be more visible than those at the bottom. (This option is the default for more than 256 rows). **Distance Scale** shows the actual joining distance between each join point, and is the same scale used on the plot produced by the **Distance Graph** command.

**Distance Graph** shows or hides the scree plot at the bottom of the histogram.

**Show NCluster Handle** shows or hides the handles on the dendrogram used to manually change the number of clusters.

**Zoom to Selected Rows** is used to zoom the dendrogram to a particular cluster after selecting the cluster on the dendrogram. Alternatively, you can double-click on a cluster to zoom in on it.

**Release Zoom** returns the dendrogram to original view after zooming.

**Pivot on Selected Cluster** reverses the order of the two sub-clusters of the currently selected cluster.

**Color Map** is an option to add a color map showing the values of all the data colored across its value range. There are several color theme choices in a submenu. Another term for this feature is **heat map**.

**Two way clustering** adds clustering by column. A color map is automatically added with the column dendrogram at its base. The columns must be measured on the same scale.

**Positioning** provides options for changing the positions of dendograms and labels.

**Legend** shows or hides a legend for the colors used in a color map. This option is available only if a color map is enabled.

**More Color Map Columns** creates a color map according to the values of a single column.

**Save Clusters** creates a data table column containing the cluster number.

**Save Display Order** creates a data table column containing the order the row is presented in the dendogram.

**Save Cluster Hierarchy** saves information needed if you are going to do a custom dendrogram with scripting. For each clustering it outputs three rows, the joiner, the leader, and the result, with the cluster centers, size, and other information.

**Save Distance Matrix** makes a new data table containing the distances between the observations.
Parallel Coord Plots creates a parallel coordinate plot for each cluster. For details about the plots, see Basic Analysis and Graphing.

Script contains options common to all platforms used for repeating analyses and saving scripts.

Technical Details for Hierarchical Clustering

The following description of hierarchical clustering methods gives distance formulas that use the following notation. Lowercase symbols generally pertain to observations and uppercase symbols to clusters.

\( n \) is the number of observations
\( v \) is the number of variables
\( x_i \) is the \( i \)th observation
\( C_K \) is the \( K \)th cluster, subset of \( \{1, 2, \ldots, n\} \)
\( \bar{x} \) is the sample mean vector
\( \bar{x}_K \) is the mean vector for cluster \( C_K \)
\( \|x\| \) is the square root of the sum of the squares of the elements of \( x \) (the Euclidean length of the vector \( x \))
\( d(x_i, x_j) \) is \( \|x\|^2 \)

**Average Linkage** In average linkage, the distance between two clusters is the average distance between pairs of observations, or one in each cluster. Average linkage tends to join clusters with small variances and is slightly biased toward producing clusters with the same variance. See Sokal and Michener (1958).

Distance for the average linkage cluster method is

\[
D_{KL} = \frac{\sum_{i \in C_K} \sum_{j \in C_L} \frac{d(x_i, x_j)}{N_K N_L}}{N_K N_L}
\]

**Centroid Method** In the centroid method, the distance between two clusters is defined as the squared Euclidean distance between their means. The centroid method is more robust to outliers than most other hierarchical methods but in other respects might not perform as well as Ward’s method or average linkage. See Milligan (1980).

Distance for the centroid method of clustering is

\[
D_{KL} = \|\bar{x}_K - \bar{x}_L\|^2
\]
Ward’s  In Ward’s minimum variance method, the distance between two clusters is the ANOVA sum of squares between the two clusters added up over all the variables. At each generation, the within-cluster sum of squares is minimized over all partitions obtainable by merging two clusters from the previous generation. The sums of squares are easier to interpret when they are divided by the total sum of squares to give the proportions of variance (squared semipartial correlations).

Ward’s method joins clusters to maximize the likelihood at each level of the hierarchy under the assumptions of multivariate normal mixtures, spherical covariance matrices, and equal sampling probabilities.

Ward’s method tends to join clusters with a small number of observations and is strongly biased toward producing clusters with roughly the same number of observations. It is also very sensitive to outliers. See Milligan (1980).

Distance for Ward’s method is

\[
D_{KL} = \frac{\sum_{i=K}^{L} \sum_{j=K}^{L} (x_i - x_j)^2}{\frac{1}{N_K} + \frac{1}{N_L}}
\]

Single Linkage  In single linkage the distance between two clusters is the minimum distance between an observation in one cluster and an observation in the other cluster. Single linkage has many desirable theoretical properties. See Jardine and Sibson (1976), Fisher and Van Ness (1971), and Hartigan (1981). Single linkage has, however, fared poorly in Monte Carlo studies. See Milligan (1980). By imposing no constraints on the shape of clusters, single linkage sacrifices performance in the recovery of compact clusters in return for the ability to detect elongated and irregular clusters. Single linkage tends to chop off the tails of distributions before separating the main clusters. See Hartigan (1981). Single linkage was originated by Florek et al. (1951a, 1951b) and later reinvented by McQuitty (1957) and Sneath (1957).

Distance for the single linkage cluster method is

\[
D_{KL} = \min_{i \in K} \min_{j \in L} d(x_i, x_j)
\]

Complete Linkage  In complete linkage, the distance between two clusters is the maximum distance between an observation in one cluster and an observation in the other cluster. Complete linkage is strongly biased toward producing clusters with roughly equal diameters and can be severely distorted by moderate outliers. See Milligan (1980).

Distance for the Complete linkage cluster method is

\[
D_{KL} = \max_{i \in K} \max_{j \in L} d(x_i, x_j)
\]

Fast Ward  is a method of applying the Ward’s minimum variable method more quickly for large numbers of rows. It is used automatically whenever there are more than 2000 rows.
K-Means Clustering

The \( k \)-means approach to clustering performs an iterative alternating fitting process to form the number of specified clusters. The \( k \)-means method first selects a set of \( n \) points called \textit{cluster seeds} as a first guess of the means of the clusters. Each observation is assigned to the nearest seed to form a set of temporary clusters. The seeds are then replaced by the cluster means, the points are reassigned, and the process continues until no further changes occur in the clusters. When the clustering process is finished, you see tables showing brief summaries of the clusters. The \( k \)-means approach is a special case of a general approach called the \textit{EM algorithm}, where E stands for Expectation (the cluster means in this case) and the M stands for maximization, which means assigning points to closest clusters in this case.

The \( k \)-means method is intended for use with larger data tables, from approximately 200 to 100,000 observations. With smaller data tables, the results can be highly sensitive to the order of the observations in the data table.

\( K \)-Means clustering only supports numeric columns. \( K \)-Means clustering ignores model types (nominal and ordinal), and treat all numeric columns as continuous columns.

To see the KMeans cluster launch dialog (see Figure 20.4), select \textbf{KMeans} from the Options menu on the platform launch dialog. The figure uses the \textit{Cytometry.jmp} data table.

\textbf{Figure 20.4 KMeans Launch Dialog}

The dialog has the following options:

\textbf{Columns Scaled Individually} is used when variables don’t share a common measurement scale, and you don’t want one variable to dominate the clustering process. For example, one variable may have values that are between 0-1000, and another variable may have values between 0-10. In this situation, you can use the option so the clustering process is not dominated by the first variable.

\textbf{Johnson Transform} can be used to balance highly skewed variables, or to be bring outliers closer to the center of the rest of the values.
K-Means Control Panel

As an example of KMeans clustering, use the Cytometry.jmp sample data table. Add the variables CD3 and CD8 as Y, Columns variables. Click OK. The Control Panel appears, and is shown in Figure 20.5.

Figure 20.5 Iterative Clustering Control Panel

The Iterative Clustering red-triangle menu has the **Save Transformed** option. This saves the Johnson transformed variables to the data table. This option is available only if the Johnson Transform option is selected on the launch dialog (Figure 20.4).

The Control Panel has these options:

- **Declutter** is used to locate outliers in the multivariate sense. Plots are produced giving distances between each point and that points nearest neighbor, the second nearest neighbor, up to the $k^{th}$ nearest neighbor. You are prompted to enter $k$. Beneath the plots are options to create a scatterplot matrix, and save the distances to the data table. If an outlier is identified, you may want to exclude the row from the clustering process.

- **Method** is used to choose the clustering method. The available methods are:
  - **KMeans Clustering** is described in this section.
  - **Normal Mixtures** is described in “Normal Mixtures,” p. 456.
  - **Robust Normal Mixtures** is described in “Normal Mixtures,” p. 456.
  - **Self Organizing Map** is described in “Self Organizing Maps,” p. 461.

- **Number of Clusters** is the number of clusters to form.

- **Optional range of clusters** is an upper bound for the number of clusters to form. If a number is entered here, the platform creates separate analyses for every integer between **Number of clusters** and this one.

- **Single Step** enables you to step through the clustering process one iteration at a time using a **Step** button, or automate the process using a **Go** button.
Use within-cluster std deviations If you don’t use this option, all distances are scaled by an overall estimate of the standard deviation of each variable. If you use this option, then it will calculate distances scaled by the standard deviation estimated for each cluster.

Shift distances using sampling rates assumes that you have a mix of unequally sized clusters, and points should give preference to being assigned to larger clusters because there is a greater prior probability that it is from a larger cluster. This option is an advanced feature. The calculations for this option are implied, but not shown for normal mixtures.

K-Means Report

Clicking Go in the Control Panel in Figure 20.5 produces the K-Means report, shown in Figure 20.6.

The report gives summary statistics for each cluster:

- count of number of observations
- means for each variable
- standard deviations for each variable.

K-Means Platform Options

These options are accessed from the red-triangle menus, and apply to KMeans, Normal Mixtures, Robust Normal Mixtures, and Self-Organizing Map methods.

Biplot shows a plot of the points and clusters in the first two principal components of the data. Circles are drawn around the cluster centers with area proportional to the number of points in the cluster. Below the plot is an option to save the cluster colors to the data table.
Clustering

Normal Mixtures

Biplot Options contains options for controlling the Biplot.

Show Biplot Rays allows you to show or hide the biplot rays.

Biplot Ray Position allows you to position the biplot ray display. This is viable since biplot rays only signify the directions of the original variables in canonical space, and there is no special significance to where they are placed in the graph.

Mark Clusters assigns markers to the rows of the data table corresponding to the clusters.

Biplot 3D shows a three-dimensional biplot of the data. Three variables are needed to use this option.

Parallel Coord Plots creates a parallel coordinate plot for each cluster. For details about the plots, see Basic Analysis and Graphing. The plot report has options for showing and hiding the data and means.

Scatterplot Matrix creates a scatterplot matrix using all the variables.

Save Colors to Table colors each row with a color corresponding to the cluster it is in.

Save Clusters creates a new column with the cluster number that each row is assigned to. For normal mixtures, this is the cluster that is most likely.

Save Cluster Formula creates a new column with a formula to evaluate which cluster the row belongs to.

Save Mixture Probabilities creates a column for each cluster and saves the probability an observation belongs to that cluster in the column. This is available for Normal Mixtures and Robust Normal Mixtures clustering only.

Save Mixture Formulas creates columns with mixture probabilities, but stores their formulas in the column and needs additional columns to hold intermediate results for the formulas. Use this feature if you want to score probabilities for excluded data, or data you add to the table. This is available for Normal Mixtures and Robust Normal Mixtures clustering only.

Save Density Formula saves the density formula in the data table. This is available for Normal Mixtures clustering only.

Simulate Clusters creates a new data table containing simulated clusters using the mixing probabilities, means, and standard deviations.

Remove removes the clustering report.

Normal Mixtures

Normal mixtures is an iterative technique, but rather than being a clustering method to group rows, it is more of an estimation method to characterize the cluster groups. Rather than classifying each row into a cluster, it estimates the probability that a row is in each cluster. See McLachlan and Krishnan (1997).

The normal mixtures approach to clustering predicts the proportion of responses expected within each cluster. The assumption is that the joint probability distribution of the measurement columns can be approximated using a mixture of multivariate normal distributions, which represent different clusters. The distributions have mean vectors and covariance matrices for each cluster.

Hierarchical and k-means clustering methods work well when clusters are well separated, but when clusters overlap, assigning each point to one cluster is problematic. In the overlap areas, there are points from several clusters sharing the same space. It is especially important to use normal mixtures rather than k-means.
clustering if you want an accurate estimate of the total population in each group, because it is based on
membership probabilities, rather than arbitrary cluster assignments based on borders.

To perform Normal Mixtures, select that option on the Method menu of the Iterative Clustering Control
Panel (Figure 20.5). After selecting Normal Mixtures, the control panel looks like Figure 20.7.

**Figure 20.7 Normal Mixtures Control Panel**

![Normal Mixtures Control Panel](image)

Some of the options on the panel are described in “K-Means Control Panel,” p. 454. The other options are
described below:

- **Diagonal Variance** is used to constrain the off-diagonal elements of the covariance matrix to zero. In
  this case, the platform fits multivariate normal distributions that have no correlations between the
  variables.

  This is sometimes necessary in order to avoid getting a singular covariance matrix, when there are
  fewer observations than columns.

- **Tours** is the number of independent restarts of estimation process, each with different starting values.
  This helps to guard against finding local solutions.

- **Maximum Iterations** is the maximum number of iterations of the convergence stage of the EM
  algorithm.

- **Converge Criteria** is the difference in the likelihood at which the EM iterations stop.

For an example of Normal Mixtures, open the `Iris.jmp` sample data table. This data set was first introduced
by Fisher (1936), and includes four different measurements: sepal length, sepal width, petal length, and
petal width, performed on samples of 50 each for three species of iris.

**Note:** Your results may not exactly match these results due to the random selection of initial centers.
On the Cluster launch dialog, assign all four variables to the Y, Columns role, select KMeans from Method menu, and click OK. Select Normal Mixtures from the Method menu, specify 3 for the Number of Clusters, and click Go. The report is shown in Figure 20.8.

Figure 20.8 Normal Mixtures Report

The report gives summary statistics for each cluster:

- count of number of observations and proportions
- means for each variable
- standard deviations for each variable
- correlations between variables
Robust Normal Mixtures

The Robust Normal Mixtures option is available if you suspect you may have outliers in the multivariate sense. Since regular Normal Mixtures is sensitive to outliers, the Robust Normal Mixtures option uses a more robust method for estimating the parameters. For details, see “Additional Details for Robust Normal Mixtures,” p. 460.

To perform Robust Normal Mixtures, select that option on the Method menu of the Iterative Clustering Control Panel (Figure 20.5). After selecting Robust Normal Mixtures, the control panel looks like Figure 20.9.

Some of the options on the panel are described in “K-Means Control Panel,” p. 454. The other options are described below:

**Diagonal Variance** is used to constrain the off-diagonal elements of the covariance matrix to zero. In this case, the platform fits multivariate normal distributions that have no correlations between the variables.

This is sometimes necessary in order to avoid getting a singular covariance matrix, when there are fewer observations than columns.

**Huber Coverage** is a number between 0 and 1. Robust Normal Mixtures protects against outliers by down-weighting them. Huber Coverage can be loosely thought of as the proportion of the data that is not considered outliers, and not down-weighted. Values closer to 1 result in a larger proportion of the data not being down-weighted. In other words, values closer to 1 protect only against the most extreme outliers. Values closer to 0 result in a smaller proportion of the data not being down-weighted, and may falsely consider less extreme data points to be outliers.
Complete Tours is the number of times to restart the estimation process. This helps to guard against the process finding a local solution.

Initial Guesses is the number of random starts within each tour. Random starting values for the parameters are used for each new start.

Max Iterations is the maximum number of iterations during the convergence stage. The convergence stage starts after all tours are complete. It begins at the optimal result out of all the starts and tours, and from there converges to a final solution.

Platform Options

For details on the red-triangle options for Normal Mixtures and Robust Normal Mixtures, see “K-Means Platform Options,” p. 455.

Details of the Estimation Process

Normal Mixtures uses the EM algorithm to do fitting because it is more stable than the Newton-Raphson algorithm. Additionally we’re using a Bayesian regularized version of the EM algorithm, which allows us to smoothly handle cases where the covariance matrix is singular. Since the estimates are heavily dependent on initial guesses, the platform will go through a number of tours, each with randomly selected points as initial centers.

Doing multiple tours makes the estimation process somewhat expensive, so considerable patience is required for large problems. Controls allow you to specify the tour and iteration limits.

Additional Details for Robust Normal Mixtures

Because Normal Mixtures is sensitive to outliers, JMP offers an outlier robust alternative called Robust Normal Mixtures. This uses a robust method of estimating the normal parameters. JMP computes the estimates via maximum likelihood with respect to a mixture of Huberized normal distributions (a class of modified normal distributions that was tailor-made to be more outlier resistant than the normal distribution).

The Huberized Gaussian distribution has pdf \( \Phi_k(x) \).

\[
\Phi_k(x) = \frac{\exp(-\rho(x))}{c_k}
\]

\[
\rho(x) = \begin{cases} 
  \frac{x^2}{2} & \text{if } |x| \leq k \\
  k|x| - \frac{k^2}{2} & \text{if } |x| > k
\end{cases}
\]

\[
c_k = \sqrt{2\pi} [\Phi(k) - \Phi(-k)] + 2 \frac{\exp(-k^2/2)}{k}
\]
So, in the limit as $k$ becomes arbitrarily large, $\Phi_k(x)$ tends toward the normal PDF. As $k \to 0$, $\Phi_k(x)$ tends toward the exponential (Laplace) distribution.

The regularization parameter $k$ is set so that $P(\text{Normal}(x) < k) = \text{Huber Coverage}$, where $\text{Normal}(x)$ indicates a multivariate normal variate. Huber Coverage is a user field, which defaults to 0.90.

### Self Organizing Maps

The Self-Organizing Maps (SOMs) technique was developed by Teuvo Kohonen (1989) and further extended by a number of other neural network enthusiasts and statisticians. The original SOM was cast as a learning process, like the original neural net algorithms, but the version implemented here is done in a much more straightforward way as a simple variation on $k$-means clustering. In the SOM literature, this would be called a batch algorithm using a locally weighted linear smoother.

The goal of a SOM is to not only form clusters, but form them in a particular layout on a cluster grid, such that points in clusters that are near each other in the SOM grid are also near each other in multivariate space. In classical $k$-means clustering, the structure of the clusters is arbitrary, but in SOMs the clusters have the grid structure. This grid structure helps to interpret the clusters in two dimensions: clusters that are close are more similar than distant clusters.

To create a Self Organizing Map, select that option on the Method menu of the Iterative Clustering Control Panel (Figure 20.5). After selecting Self Organizing Map, the control panel looks like Figure 20.10.

**Figure 20.10** Self Organizing Map Control Panel

Some of the options on the panel are described in "K-Means Control Panel," p. 454. The other options are described below:

- **N Rows** is the number of rows in the cluster grid.
- **N Columns** is the number of columns in the cluster grid.
462 Clustering
Self Organizing Maps

Bandwidth  a higher bandwidth results in a more detailed fitting of the data.

As an example of a SOM, use the Iris.jmp sample data table to follow the steps below:
1. Select Analyze > Multivariate Methods > Cluster.
2. Assign all four columns as Y, Column variables.
3. Select K Means on the Options menu.
4. Uncheck Columns Scaled Individually.
5. Click OK.
6. Select Self Organizing Map from the Method menu on the Control Panel.
7. Since we know the data consists of three species, set Number of Clusters equal to 3.
8. Set N Rows equal to 1 and N Columns equal to 3.
9. Click Go. The report is shown in Figure 20.11.

Figure 20.11  Self Organizing Map Report

The report gives summary statistics for each cluster:
• count of number of observations
• means for each variable
• standard deviations for each variable.

For details on the red-triangle options for Self Organizing Maps, see “K-Means Platform Options,” p. 455.
Implementation Technical Details

The SOM implementation in JMP proceeds as follows:

- The first step is to obtain good initial cluster seeds that provide a good coverage of the multidimensional space. JMP uses principal components to determine the two directions which capture the most variation in the data.
- JMP then lays out a grid in this principal component space with its edges 2.5 standard deviations from the middle in each direction. The clusters seeds are formed by translating this grid back into the original space of the variables.
- The cluster assignment proceeds as with $k$-means, with each point assigned to the cluster closest to it.
- The means are estimated for each cluster as in $k$-means. JMP then uses these means to set up a weighted regression with each variable as the response in the regression, and the SOM grid coordinates as the regressors. The weighting function uses a ‘kernel’ function that gives large weight to the cluster whose center is being estimated, with smaller weights given to clusters farther away from the cluster in the SOM grid. The new cluster means are the predicted values from this regression.
- These iterations proceed until the process has converged.
Chapter 21
Principal Components
Reducing Dimensionality

The purpose of principal component analysis is to derive a small number of independent linear combinations (principal components) of a set of variables that capture as much of the variability in the original variables as possible.

JMP also offers several types of orthogonal and oblique Factor-Analysis-Style rotations to help interpret the extracted components.

Principal components can be accessed through the Multivariate platform, through the Scatterplot 3D platform, or through the Principal Components command on the Analyze > Multivariate Methods menu. All map to the same routines, documented in this chapter.

Figure 21.1 Example of Principal Components
Contents

Principal Components ......................................................... 467
Launch the Platform ............................................................... 467
Report ....................................................................................... 468
Platform Options ..................................................................... 468
  Factor Analysis ..................................................................... 471
Principal Components

If you want to see the arrangement of points across many correlated variables, you can use principal component analysis to show the most prominent directions of the high-dimensional data. Using principal component analysis reduces the dimensionality of a set of data. Principal components is a way to picture the structure of the data as completely as possible by using as few variables as possible.

For \( n \) original variables, \( n \) principal components are formed as follows:

- The first principal component is the linear combination of the standardized original variables that has the greatest possible variance.
- Each subsequent principal component is the linear combination of the standardized original variables that has the greatest possible variance and is uncorrelated with all previously defined components.

Each principal component is calculated by taking a linear combination of an eigenvector of the correlation matrix with a standardized original variable. The eigenvalues show the variance of each component.

Principal components representation is important in visualizing multivariate data by reducing it to dimensionalities that are graphable.

Launch the Platform

Select Analyze > Multivariate Methods > Principal Components to launch the platform. JMP presents you with a dialog box to specify the variables involved in the analysis. In this example, we use all the continuous variables from the Solubility.jmp data set.

The Estimation Method list provides different methods for calculating the correlations. For details on the methods, see the “Correlations and Multivariate Techniques” chapter.

Principal components analysis is also available in the Multivariate and Scatterplot 3D platforms.
The initial principal components report (Figure 21.2) summarizes the variation of the specified $Y$ variables with principal components. The principal components are derived from an eigenvalue decomposition of the correlation matrix, the covariance matrix, or on the unscaled and uncentered data.

The details in the report show how the principal components absorb the variation in the data. The principal component points are derived from the eigenvector linear combination of the standardized variables.

Figure 21.2 Principal Components/Factor Analysis Report

The report gives the eigenvalues and a bar chart of the percent of the variation accounted for by each eigenvalue. There is a Score plot and a Loadings plot as well.

Platform Options

The platform red-triangle menu has the following options:

- **Principal Components** allows you to choose to create the principal components based on Correlations, Covariances, or Unscaled.
- **Correlations** gives the correlations between the variables.
- **Covariance Matrix** gives the variances and covariances of the variables.
- **Eigenvalues** lists the eigenvalue that corresponds to each principal component in order from largest to smallest (first principal component, second principal component, and so on). The eigenvalues represent a partition of the total variation in the multivariate sample. They sum to the number of variables when the principal components analysis is done on the correlation matrix.
Eigenvectors  shows columns of values that correspond to the eigenvectors for each of the principal components, in order, from left to right. Using these coefficients to form a linear combination of the original variables produces the principal component variables.

Loading Matrix  shows columns corresponding to the factor loading for each component.

Summary Plots  shows or hides the summary information produced in the initial report. This information is shown in Figure 21.2.

Biplot  shows a plot which overlays the Score Plot and the Loading Plot.

Scree Plot  shows a scree plot of the eigenvalues vs. the number of components. This plot is useful for visualizing the dimensionality of the data space. For this example, the scree plot suggests that using two principal components is appropriate.

Score Plot  shows a matrix of scatterplots of the scores for pairs of principal components.

Loading Plot  shows a matrix of two-dimensional representations of factor loadings. The loading plot labels variables if the number of variables is 30 or fewer. If there are more than 30 variables, the labels are off by default.

Score Plot with Imputation  imputes any missing values and creates a score plot. This option is available only if there are missing values.

3D Score Plot  shows a 3D scatterplot of any principal component scores. When you first invoke the command, the first three principal components are presented.
The variables show as rays in the plot. These rays, called biplot rays, approximate the variables as a function of the principal components on the axes. If there are only two or three variables, the rays represent the variables exactly. The length of the ray corresponds to the eigenvalue or variance of the principal component.

**Factor Analysis** performs factor-analysis rotations of the principal components. For more information, see “Factor Analysis,” p. 471.

**Save Principal Components** saves the principal component to the data table, with a formula for computing the components. The formula can not evaluate rows with any missing values.

**Save Rotated Components** saves the rotated components to the data table, with a formula for computing the components. This option appears after the Factor Analysis option is used. The formula can not evaluate rows with missing values.
Save Principal Components with Imputation imputes missing values, and saves the principal components to the data table. The column contains a formula for doing the imputation, and computing the principal components. This option is available only if there are missing values.

Save Rotated Components with Imputation imputes missing values, and saves the rotated components to the data table. The column contains a formula for doing the imputation, and computing the rotated components. This option appears after the Factor Analysis option is used, and if there are missing values.

Script a menu common to all platforms allowing you to reproduce results or save scripts.

Factor Analysis

The Factor Analysis option on the platform red-triangle menu performs rotations of the principal components. When the option is selected, you are presented with the window shown in Figure 21.4.

Figure 21.4 Factor Analysis Window

Use this dialog to specify:

1. Factoring Method, either Principal Components or Maximum Likelihood. The use of maximum likelihood allows for hypothesis testing for testing how many factors are significant.

2. Prior Communality, Principal Components (where the diagonals are 1) or Common Factor Analysis (where the diagonals are SMC, the squared multiple correlation between $x_i$ and the other $p-1$ variables).

3. The number of factors to rotate.


After all selections are made, click OK. The report is shown in Figure 21.5.
Note that the first rotated component loads on the Carbon Tetrachloride-Chloroform-Benzene-Hexane cluster and that the second rotated component loads on the Ether–1-octanol cluster.

**Rotation Methods**

Rotations are used to better align the directions of the factors with the original variables so that the factors may be more interpretable. You hope for clusters of variables that are highly correlated to define the rotated factors. The rotation's success at clustering the interpretability is highly dependent on the number of factors that you choose to rotate.
Chapter 21

Principal Components

Platform Options

473

After the initial extraction, the factors are uncorrelated with each other. If the factors are rotated by an orthogonal transformation, the rotated factors are also uncorrelated. If the factors are rotated by an oblique transformation, the rotated factors become correlated. Oblique rotations often produce more useful patterns than do orthogonal rotations. However, a consequence of correlated factors is that there is no single unambiguous measure of the importance of a factor in explaining a variable.

Available orthogonal rotation methods are:

- **Varimax** specifies the orthogonal varimax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=ORTHOMAX` with `GAMMA=1`.
- **Biquartimax** specifies the orthogonal biquartimax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=ORTHOMAX(.5)`.
- **Equamax** specifies the orthogonal equamax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=ORTHOMAX` with `GAMMA=number of factors/2`.
- **Factorparsimax** specifies the orthogonal factor parsimax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=ORTHOMAX` with `GAMMA=number of variables`.
- **Orthomax** specifies the orthogonal orthomax rotation with orthomax weight $p$. The corresponding SAS Proc Factor option specification is either `ROTATE=ORTHOMAX` or `ROTATE=ORTHOMAX(p)`, which specifies $p$ as the orthomax weight or the `GAMMA=value`. The default $p$ value is 1 unless specified otherwise in the `GAMMA=` option. For additional information on orthomax weight, see the SAS documentation, “Simplicity Functions for Rotations.”
- **Parsimax** specifies the orthogonal parsimax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=ORTHOMAX` with `GAMMA=\left(\frac{nvar(nfact - 1)}{nvar + nfact - 2}\right)` where `nvar` is the number of variables, and `nfact` is the number of factors.
- **Quartimax** specifies the orthogonal quartimax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=ORTHOMAX(0)`.

Available oblique rotation methods are:

- **Biquartimin** specifies the oblique biquartimin rotation. The corresponding SAS Proc Factor option specification is `ROTATE=OBLIMIN(.5)` or `ROTATE=OBLIMIN` with `TAU=.5`.
- **Covarimin** specifies the oblique covarimin rotation. The corresponding SAS Proc Factor option specification is `ROTATE=OBLIMIN(1)` or `ROTATE=OBLIMIN` with `TAU=1`.
- **Obbiquartimax** specifies the oblique biquartimax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=OBBIQUARTIMAX`.
- **Obequamax** specifies the oblique equamax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=OBEQUAMAX`.
- **Obfactorparsimax** specifies the oblique factor parsimax rotation. The corresponding SAS Proc Factor option specification is `ROTATE=OBFACCTORPARSIMAX`.
- **Oblimin** specifies the oblique oblimin rotation with oblimin weight $p$. The corresponding SAS Proc Factor option specification is `ROTATE=OBLIMIN`, where the default $p$ value is zero, unless specified otherwise in the `TAU=` option. `ROTATE=OBLIMIN(p)` specifies $p$ as the oblimin weight or the `TAU=` value. For additional information on oblimin weight, see the SAS documentation, “Simplicity Functions for Rotations.”
Principal Components
Platform Options

**Obparsimax** specifies the oblique parsimax rotation. The corresponding SASProc Factor option specification is ROTATE=OBPARSIMAX.

**Obquartimax** specifies the oblique quartimax rotation. This is equivalent to the QUARTIMIN method. The corresponding SAS Proc Factor option specification is ROTATE=OBQUARTIMAX.

**Obvarimax** specifies the oblique varimax rotation. The corresponding SAS Proc Factor option specification is ROTATE=OBVARIMAX.

**Quartimin** specifies the oblique quartimin rotation. It is equivalent to the oblique quartimax method. The corresponding SAS Proc Factor option specification is ROTATE=OBLIMIN(0) or ROTATE=OBLIMIN with TAU=0.

**Promax** specifies oblique promax rotation. The corresponding SAS Proc Factor option specification is ROTATE=PROMAX.
Discriminant Analysis seeks to find a way to predict a classification ($X$) variable (nominal or ordinal) based on known continuous responses ($Y$). It can be regarded as inverse prediction from a multivariate analysis of variance (MANOVA). In fact, the Manova personality of Fit Model also provides some discriminant features.

Features include:

- A stepwise selection dialog to help choose variables that discriminate well.
- Choice among Linear, Quadratic, or Regularized-Parameter analyses.
- The discriminant scores, showing which groups each point is near.
- A misclassification summary.
- Plots of the points and means in a canonical space, which is the space that shows the best separation of means.
- Options to save prediction distances and probabilities to the data table.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>477</td>
</tr>
<tr>
<td>Discriminating Groups</td>
<td>477</td>
</tr>
<tr>
<td>Discriminant Method</td>
<td>478</td>
</tr>
<tr>
<td>Stepwise Selection</td>
<td>479</td>
</tr>
<tr>
<td>Canonical Plot</td>
<td>481</td>
</tr>
<tr>
<td>Discriminant Scores</td>
<td>481</td>
</tr>
<tr>
<td>Commands and Options</td>
<td>482</td>
</tr>
<tr>
<td>Validation</td>
<td>487</td>
</tr>
</tbody>
</table>
Introduction

Discriminant Analysis is an alternative to logistic regression. In logistic regression, the classification variable is random and predicted by the continuous variables, whereas in discriminant analysis the classifications are fixed, and the $Y$ variables are realizations of random variables. However, in both cases, the categorical value is predicted by the continuous.

There are several varieties of discriminant analysis. JMP implements linear and quadratic discriminant analysis, along with a method that blends both types. In linear discriminant analysis, it is assumed that the $Y$ variables are normally distributed with the same variances and covariances, but that there are different means for each group defined by $X$. In quadratic discriminant analysis, the covariances can be different across groups. Both methods measure the distance from each point in the data set to each group’s multivariate mean (often called a centroid) and classify the point to the closest group. The distance measure used is the Mahalanobis distance, which takes into account the variances and covariances between the variables.

Discriminating Groups

Fisher’s Iris data set is the classic example of discriminant analysis. Four measurements are taken from a sample consisting of three different species. The goal is to identify the species accurately using the values of the four measurements. Open Iris.jmp, and select Analyze > Multivariate Methods > Discriminant to launch the Discriminant Analysis platform. The launch dialog in Figure 22.1 appears.

If you want to find which variables discriminate well, click the checkbox for Stepwise Variable Selection. Otherwise, the platform uses all the variables you specify. In this example, specify the four continuous variables as $Y$, Covariates and Species as $X$, Categories.
Discriminant Method

JMP offers three kinds of Discriminant Analysis. All three calculate distances as the Mahalanobis distance from each point to each group’s multivariate mean. The difference in the methods is only in the covariance matrix used in the computations.

**Linear Discriminant Analysis** uses a common (within-) covariance matrix for all groups.

**Quadratic Discriminant Analysis** uses a separate covariance matrix for each group.

Quadratic discriminant suffers in small data sets because it does not have enough data to make nicely invertible and stable covariance matrices. Regularized discriminant ameliorates these problems and still allows for differences among groups.

**Regularized Discriminant Analysis** is a compromise between the linear and quadratic methods, governed by two arguments. When you choose **Regularized Discriminant Analysis**, a dialog appears allowing specification of these two parameters.

The first parameter (**Lambda, Shrinkage to Common Covariance**) specifies how to mix the individual and group covariance matrices. For this parameter, 1 corresponds to Linear Discriminant Analysis and 0 corresponds to Quadratic Discriminant Analysis.

The second parameter (**Gamma, Shrinkage to Diagonal**) specifies whether to deflate the non-diagonal elements, that is, the covariances across variables. If you choose 1, then the covariance matrix is forced to be diagonal.

Therefore, assigning 0,0 to these parameters is identical to requesting quadratic discriminant analysis. Similarly, a 1,0 assignment requests linear discriminant analysis. These cases, along with a Regularized Discriminant Analysis example with \( l=0.4 \) and \( g=0.4 \) are shown in Figure 22.2.

Use **Table 22.1** to help decide on the regularization.

**Table 22.1** Regularized Discriminant Analysis

<table>
<thead>
<tr>
<th>Use lower Lambda (Gamma) when:</th>
<th>Use higher Lambda (Gamma) when:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Covariances are different</td>
<td>Covariances are the same</td>
</tr>
<tr>
<td>(Variables are correlated)</td>
<td>(Variables are uncorrelated)</td>
</tr>
<tr>
<td>lots of data</td>
<td>little data</td>
</tr>
<tr>
<td>small number of variables</td>
<td>many variables</td>
</tr>
</tbody>
</table>
Figure 22.2 Linear, Quadratic, and Regularized Discriminant Analysis

Stepwise Selection

If you choose Stepwise Variable Selection, a dialog appears (Figure 22.3) to select variables. You can review which columns have large $F$ ratios or small $p$-values and control which columns are entered into the discriminant model. In addition, the dialog displays how many columns are currently in and out of the model, and the largest and smallest $p$-values to be entered or removed.
Discriminant Analysis

Chapter 22

Discriminating Groups

Figure 22.3 Stepwise Control Panel

Entered checkboxes show which columns are currently in the model. You can manually click columns in or out of the model.

Lock checkboxes are used when you want to force a column to stay in its current state regardless of any stepping by the buttons.

Step Forward adds the most significant column not already in the model.

Step Backward removes the least significant column already in the model.

Enter All enters all the columns into the model.

Remove All removes all the columns from the model.

Apply This Model is used when you are finished deciding the columns to include in the analysis, and want to proceed to estimation and scoring.

Figure 22.4 shows three forward steps, which add all the columns to the model except Sepal length.

Figure 22.4 Stepped Model
Click **Apply This Model** to estimate the model. After estimation and scoring are done, two reports are produced: a Canonical Plot (Figure 22.5), and a Scoring Report.

**Canonical Plot**

The Canonical Plot shows the points and multivariate means in the two dimensions that best separate the groups.

![Figure 22.5 Canonical Plot](image)

- Each row in the data set is a point, controlled by the **Canonical Options > Show Points** option.
- Each multivariate mean is a labeled circle. The size of the circle corresponds to a 95% confidence limit for the mean. Groups that are significantly different tend to have non-intersecting circles. This is controlled by the **Canonical Options > Show Means CL Ellipses** option.
- The directions of the variables in the canonical space is shown by labeled rays emanating from the grand mean. This is controlled by the **Canonical Options > Show Biplot Rays** option. You can drag the center of the biplot rays to other places in the graph.
- The option **Show Normal 50% Contours** shows areas that contain roughly 50% of the points for that group if the assumptions are correct. Under linear discriminant analysis, they are all the same size and shape.

In order to have the points color-coded like the centroid circles, use the **Color Points** option or button. This is equivalent to **Rows > Color or Mark by Column**, coloring by the classification column.

The canonical plot can also be referred to as a **biplot** when both the points and the variable direction rays are shown together, as in Figure 22.5. It is identical to the Centroid plot produced in the **Manova** personality of the Fit Model platform.

**Discriminant Scores**

The scores report shows how well each point is classified. The first five columns of the report represent the actual (observed) data values, showing row numbers, the actual classification, the distance to the mean of that classification, and the associated probability. JMP graphs \(-\log(\text{Prob})\) to show the loss in log-likelihood when a point is predicted poorly. When the red bar is large, the point is being poorly predicted.
Discriminant Analysis
Chapter 22

On the right of the graph, the report shows the category with the highest prediction probability, and, if they exist, other categories that have a predicted probability of over 0.1. An asterisk (*) indicates which points are misclassified.

In Figure 22.6, the option **Show Interesting Rows Only** option is set so that only those rows that have fitted probabilities between 0.05 and 0.95 or are misclassified are shown.

**Figure 22.6** Show Interesting Rows Only

<table>
<thead>
<tr>
<th>Discriminant Scores</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
</tr>
<tr>
<td>Sepal width</td>
</tr>
<tr>
<td>Petal length</td>
</tr>
<tr>
<td>Petal width</td>
</tr>
<tr>
<td>Training</td>
</tr>
<tr>
<td>Number Misclassified</td>
</tr>
<tr>
<td>Percent Misclassified</td>
</tr>
<tr>
<td>-2LogLikelihood</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Row</th>
<th>Actual</th>
<th>SoftMax(Actual)</th>
<th>Prob(Actual)</th>
<th>LogProb</th>
<th>Predicted</th>
<th>Prob(Pred)</th>
<th>Others</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>versicolor</td>
<td>0.87477</td>
<td>0.7974</td>
<td>0.224</td>
<td>versicolor</td>
<td>0.7674</td>
<td>versicolor 0.23</td>
</tr>
<tr>
<td>1</td>
<td>versicolor</td>
<td>0.41762</td>
<td>0.5002</td>
<td>0.008</td>
<td>versicolor</td>
<td>0.6528</td>
<td>versicolor 0.008</td>
</tr>
<tr>
<td>2</td>
<td>versicolor</td>
<td>0.87400</td>
<td>0.7166</td>
<td>0.033</td>
<td>versicolor</td>
<td>0.7165</td>
<td>versicolor 0.29</td>
</tr>
<tr>
<td>3</td>
<td>versicolor</td>
<td>0.41823</td>
<td>0.4520</td>
<td>0.284</td>
<td>versicolor</td>
<td>0.6900</td>
<td>versicolor 0.008</td>
</tr>
<tr>
<td>4</td>
<td>versicolor</td>
<td>0.50525</td>
<td>0.5557</td>
<td>0.045</td>
<td>versicolor</td>
<td>0.6403</td>
<td>versicolor 0.008</td>
</tr>
<tr>
<td>5</td>
<td>versicolor</td>
<td>0.87454</td>
<td>0.6956</td>
<td>0.567</td>
<td>versicolor</td>
<td>0.5655</td>
<td>versicolor 0.43</td>
</tr>
<tr>
<td>6</td>
<td>versicolor</td>
<td>0.81134</td>
<td>0.7425</td>
<td>0.298</td>
<td>versicolor</td>
<td>0.7425</td>
<td>versicolor 0.26</td>
</tr>
<tr>
<td>7</td>
<td>versicolor</td>
<td>2.44912</td>
<td>0.041</td>
<td>0.901</td>
<td>versicolor</td>
<td>0.8412</td>
<td>versicolor 0.008</td>
</tr>
<tr>
<td>8</td>
<td>versicolor</td>
<td>3.22698</td>
<td>0.0957</td>
<td>1.156</td>
<td>versicolor</td>
<td>0.8667</td>
<td>versicolor 0.14</td>
</tr>
<tr>
<td>9</td>
<td>versicolor</td>
<td>3.30367</td>
<td>0.7014</td>
<td>0.247</td>
<td>versicolor</td>
<td>0.7614</td>
<td>versicolor 0.22</td>
</tr>
<tr>
<td>10</td>
<td>versicolor</td>
<td>3.93593</td>
<td>0.9250</td>
<td>0.078</td>
<td>versicolor</td>
<td>0.9250</td>
<td>versicolor 0.008</td>
</tr>
<tr>
<td>11</td>
<td>versicolor</td>
<td>7.23555</td>
<td>0.1802</td>
<td>1.086</td>
<td>versicolor</td>
<td>0.8100</td>
<td>versicolor 0.008</td>
</tr>
<tr>
<td>12</td>
<td>versicolor</td>
<td>0.67520</td>
<td>0.6003</td>
<td>0.516</td>
<td>versicolor</td>
<td>0.6003</td>
<td>versicolor 0.49</td>
</tr>
<tr>
<td>13</td>
<td>versicolor</td>
<td>4.69351</td>
<td>0.6974</td>
<td>0.376</td>
<td>versicolor</td>
<td>0.6974</td>
<td>versicolor 0.31</td>
</tr>
<tr>
<td>14</td>
<td>versicolor</td>
<td>2.15526</td>
<td>0.0042</td>
<td>0.101</td>
<td>versicolor</td>
<td>0.8043</td>
<td>versicolor 0.19</td>
</tr>
</tbody>
</table>

**Indicates misclassified
Training
Counts: Actual Rows by Predicted Columns
setosa versicolor virginica
setosa 50 0 9
versicolor 0 40 2
virginica 0 1 49

The Counts report appears at the bottom of Figure 22.6. The counts are zero off the diagonal if everything is classified correctly.

**Commands and Options**

The following commands are available from the platform popup menu.

**Stepwise Variable Selection** returns to the stepwise control panel.

**Discriminant Method** chooses the discriminant method. Details are shown in the section “Discriminant Method,” p. 478.
Linear, Common Covariance  assumes a common covariance.
Quadratic, Different Covariances  which estimates different covariances.
Regularized, Compromise Method  a compromise method.

Score Data  shows or hides the listing of the scores by row in the Discriminant Scores portion of the report.

Score Options  deal with the scoring of the observations and includes the following:
Show Interesting Rows Only  shows rows that are misclassified and those where \( p > .05 \) and \( p < 0.95 \) for any \( p \), the attributed probability.
Show Classification Counts  shows a matrix of actual by predicted counts for each category. When the data are perfectly predicted, the off-diagonal elements are zero. If there are excluded rows, a separate matrix is given for the excluded rows. For more information, see “Validation,” p. 487.
Show Distances to each group  appends a table to show the squared distance to each group.
Show Probabilities to each group  appends a table to show the probabilities to each group.
ROC Curve  appends an ROC curve to the report.
Select Misclassified Rows  selects the misclassified rows in the original data table.
Select Uncertain Rows  selects the rows which have uncertain classifications in the data table. When this option is selected, a dialog box appears so you can specify the difference (0.1 is the default) to be marked as uncertain.
Save Formulas  saves formulas to the data table. The distance formulas are \( \text{Dist}[0] \), needed in the Mahalanobis distance calculations, and a \( \text{Dist}[\_] \) column for each \( X \)-level's Mahalanobis distance. Probability formulas are \( \text{Prob}[0] \), the sum of the exponentials of -0.5 times the Mahalanobis distances, and a \( \text{Prob}[\_] \) column for each \( X \)-level's posterior probability of being in that category. The \( \text{Pred} \) column holds the most likely level for each row.

Canonical Plot  shows or hides the Canonical Plot.

Canonical Options  provides commands that affect the Canonical Plot and include the following:
Show Points  shows or hides the points in the plot.
Show Means CL Ellipses  shows or hides the 95% confidence ellipse of each mean. The ellipses appear as a circle because of scaling. Categories with more observations have smaller circles.
Show Normal 50% Contours  shows or hides the normal contours which estimate the region where 50% of the level's points lie.
Show Biplot Rays  shows or hides the biplot rays. These rays indicate the directions of the variables in the canonical space.
Biplot Ray Position  allows you to specify the position and radius scaling (default = 1) of the biplot rays in the canonical plot.
Color Points  colors the points based on levels of the \( X \) variable. This statement is equivalent to selecting Rows > Color or Mark by Column and selecting the \( X \) variable.
Show Canonical Details  shows or hides the Canonical details. Details for the Iris data set are shown in Figure 22.7. The matrices at the bottom of the report are opened by clicking on the disclosure button beside their name and closed by clicking on the name of the matrix.
Save Canonical Scores  creates columns in the data table holding the canonical score for each observation. The new columns are named Canon[].

Save to New Data Table  saves the group means and the biplot rays on the canonical variables, together with the canonical scores to a new data table.

Canonical 3D Plot  is available only when there are four or more groups (levels). An example of this plot is shown in Figure 22.8. It shows a three-dimensional version of the Canonical Plot and respects other Canonical Options.
The example in Figure 22.8 is displayed by:

1. Open cereal.jmp.
2. Click on Analyze > Multivariate Methods > Discriminant.
3. Specify Calories, Protein, Fat, and Sodium as Y, Covariates.
4. Specify Manufacturer as X, Categories and click OK.
5. Click on the red triangle in the Discriminant Analysis title bar and select Canonical 3D Plot.
6. Click inside the plot and rotate the plot until you see the desired effect.

**Specify Priors** lets you specify the prior probabilities for each level of the X variable:

- **Equal Probabilities** assigns an equal probability to each level.
- **Proportional to Occurrence** assigns probabilities to each level according to their frequency in the data.
- **Other** brings up a dialog to allow custom specification of the priors, shown in Figure 22.9. By default, each level is assigned equal probabilities.
Consider New Levels is used when you have some points that may not fit any known group, but instead may be from an unscored, new group.

Save Discrim Matrices creates a global list (DiscrimResults) for use in the JMP scripting language. The list contains a list of YNames, a list of XNames, a list of XValues, a matrix of YMeans, and a matrix of YPartialCov (covariances). An example from the iris data DiscrimResults is

```{YNames = {"Sepal length", "Sepal width", "Petal length", "Petal Width"},
XName = "Species", XValues = {"setosa", "versicolor", "virginica"}, YMeans = [5.005999999999999 3.428000000000001 1.462 0.2459999999999999, 5.936 2.77 4.26 1.326, 6.587999999999998 2.974 5.552 2.026], YPartialCov = [0.2650081632653061 0.0927210843537413 0.167542857142858 0.03840136054421769, 0.0927210843537413 0.1153877551020407 0.055243537414966 0.03271020408163266, 0.167542857142858 0.055243537414966 0.1851877551020409 0.04266530612244898, 0.03840136054421769 0.03271020408163266 0.04266530612244898 0.04188163265306122]}
```

Get Discrim Matrices, only available through scripting, obtains the same values as Save Discrim Matrices, but returns them to the caller rather than storing them in the data table.

Show Within Covariances shows or hides the Covariance Matrix report. The report for this example is shown in Figure 22.10.
Show Group Means shows or hides a table with the means of each variable. Means are shown for each level and for all levels of the X variable. Figure 22.11 shows the Group Means table for this example.

**Figure 22.11 Group Means Table**

<table>
<thead>
<tr>
<th>Species</th>
<th>Count</th>
<th>Sepal length</th>
<th>Sepal width</th>
<th>Petal length</th>
<th>Petal width</th>
</tr>
</thead>
<tbody>
<tr>
<td>versicolor</td>
<td>50</td>
<td>5.93000000</td>
<td>2.77000000</td>
<td>4.26000000</td>
<td>1.24000000</td>
</tr>
<tr>
<td>virginica</td>
<td>50</td>
<td>6.98000000</td>
<td>2.77400000</td>
<td>5.55200000</td>
<td>2.02600000</td>
</tr>
<tr>
<td>All</td>
<td>150</td>
<td>5.84300000</td>
<td>3.05700000</td>
<td>3.75000000</td>
<td>1.19500000</td>
</tr>
</tbody>
</table>

**Validation**

Validation is the process of using part of a data set to build a model, and using the other part to assess the predictive ability of the model.

- The *training* set is the part that estimates model parameters.
- The *validation* set is the part that validates the predictive ability of the model.

Excluded rows are not included in the training set. When the Show Classification Counts option is chosen on the platform red-triangle menu, results are given for both training and validation (excluded) data. This helps you assess if the discriminant function has any predictive ability on data that was not used to build the function.

In the Discriminant Scores report, there is an indicator for excluded rows.
The PLS platform fits models using partial least squares (PLS). PLS balances the two objectives of explaining response variation and explaining predictor variation. It is especially useful since it is appropriate in analysis that have more $x$-variables than observations.

The number of factors to extract depends on the data. Basing the model on more extracted factors (successive linear combinations of the predictors also called components or latent vectors) optimally addresses one or both of two goals: explaining response variation and explaining predictor variation. In particular, the method of partial least squares balances the two objectives, seeking for factors that explain both response and predictor variation. Remember that extracting too many factors can cause over-fitting, (tailoring the model too much to the current data,) to the detriment of future predictions. The PLS platform enables you to choose the number of extracted factors by cross-validation, that is, fitting the model to part of the data and minimizing the prediction error for the unfitted part. It also allows for interactive exploration of the extracted factors through the use of the Profiler, which greatly simplifies the identification of the factors' meaning.
## Contents

- PLS ................................................................. 491
- Launch the Platform ............................................ 491
  - Model Coefficients and PRESS Residuals ............... 496
- Test Set Validation ............................................. 497
- Platform Options ................................................ 497
- Statistical Details .............................................. 502
  - Centering and Scaling .................................... 502
  - Missing Values .............................................. 502
Ordinary least squares regression, as implemented in JMP platforms such as Fit Model and Fit Y by X, has the single goal of minimizing sample response prediction error, seeking linear functions of the predictors that explain as much variation in each response as possible. The techniques implemented in the PLS platform have the additional goal of accounting for variation in the predictors, under the assumption that directions in the predictor space that are well sampled should provide better prediction for new observations when the predictors are highly correlated. The techniques implemented in the PLS platform work by extracting successive linear combinations of the predictors, called factors (also called components or latent vectors), which optimally address the combined goals of explaining response variation and explaining predictor variation. In particular, the method of partial least squares balances the two objectives, seeking factors that explain both response and predictor variation.

The most important point, however, is that PLS works in cases where OLS does not. If the data have more x-variables than observations, OLS cannot produce estimates, where PLS can.

**Launch the Platform**

As an example, open the Baltic.jmp data table. The data are reported in Umetrics (1995); the original source is Lindberg, Persson, and Wold (1983). Suppose that you are researching pollution in the Baltic Sea, and you would like to use the spectra of samples of sea water to determine the amounts of three compounds present in samples from the Baltic Sea: lignin sulfonate (pulp industry pollution), humic acids (natural forest products), and detergent (optical whitener). Spectrometric calibration is a type of problem in which partial least squares can be very effective. The predictors are the spectra emission intensities at different frequencies in sample spectrum (v1–v27), and the responses are the amounts of various chemicals in the sample.

For the purposes of calibrating the model, samples with known compositions are used. The calibration data consist of 16 samples of known concentrations of lignin sulfonate, humic acids, and detergent, with spectra based on 27 frequencies (or, equivalently, wavelengths).

Launch the PLS platform by selecting Analyze > Multivariate Methods > PLS. Assign ls, ha, and dt as Y, Response and v1–v27 as X, Factors. See launch dialog in Figure 23.1.
**Partial Least Squares**

**Launch the Platform**

**Figure 23.1** PLS Launch Dialog

No Scale does not scale the data. The data will not be divided by the standard deviation.

No Center does not center the data. The mean will not be subtracted from the data.

When you click OK, the initial PLS report appears. The PLS model is incomplete until you specify the number of factors to use in the model. The platform suggests a number in the Number of Latent Factors control panel as shown in Figure 23.2.

**Figure 23.2** Number of Latent Factors Control Panel

Use Cross Validation uses cross validation to choose the number of factors.

User Specified uses the number of latent factors specified in the number entry box. JMP provides the range of factors that can be used. In this example, the user can specify any number between 1 and 9.

For this example you use cross validation. Select **Use Cross Validation** and click **Go**. The cross validation procedure uses the one-at-a-time method. This method fits the model to all data points except one, then you check the capability of the model to predict response for the point omitted. Repeating this for each data point, you then can measure the overall capability of a given form of the model. JMP displays the results using the prediction root mean square error for each number of factors. See Figure 23.3.
The model with the lowest prediction RMSE has seven factors. However, notice that this is almost the same as a model with four factors. A model with four factors is preferable, so the prediction reports are based on the four-model factors.

There are plots of each $X$ score against its corresponding $Y$ score, as seen in Figure 23.4. As your analysis continues, this plot updates according to the number of scores you specify.

JMP determines the default number of dimensions as the smallest dimension (k) which gives a slope ratio (slope of $Y$ Score –$X$ Score chart/slope of $Y$ Score k–$X$ Score k chart) greater than 30. In the Baltic example, five latent vectors are extracted by default. Before selecting cross validation and clicking Go, five plots are shown. After running cross validation, the report changes to four plots as shown in Figure 23.4.

For the Baltic data, the percent of variation explained by each latent factor is shown in the Percent Variation Explained report (Figure 23.5). Note that most of the variation in $X$ is explained by three factors; most of the variation in $Y$ is explained by six or seven. Note that in this case, “factors” refers to latent variables, not columns in the data table.
The report also includes the Percent Variation Explained for Selected X Variables, and the same for the Y variables. See Figure 23.6. A combo box allows you to select different X and Y variables.

You also see plots of the predicted Y’s and predicted X’s, as shown in Figure 23.7. Note that these are the scaled values of X and Y, not the original values. Below these plots are a text box to enter a value to predict and four slider boxes to adjust the values of each latent factor.
Move the sliders to dynamically see each factor’s effect on the predictions. For example, moving the fourth slider in this example shows that this latent variable has a great effect on the second Y-variable (humic acid). This factor obviously represents a quantity that affects humic acid far more than lignin sulfonate or detergent. It may represent something that increases production of natural (rather than man-made) pollution.

Similarly, moving the second slider affects the amount of the 11th and 21st spectral values. Therefore, the physical quantity that this represents manifests itself through variations in those frequencies far more than the others, which remain essentially constant.

To predict the values of a specific row number, enter the row number in the text box above the score value sliders. For example, to predict the values of the first row, enter a 1 in the box. Predicted values appear on the graphs of both the X and Y factors (Figure 23.8).
Model Coefficients and PRESS Residuals

Both Model Coefficients reports and the PRESS Residuals report are closed initially. The Model Coefficients appear under the Prediction Graph, and are shown for this example in Figure 23.9.

Figure 23.9 Model Coefficients for Centered and Scaled Data
Note: If you checked the No Scale and No Center boxes on the launch dialog, the reported model coefficients are for uncentered and unscaled data, and the title changes to Model Coefficients.

The PRESS Residuals (Figure 23.10) appear above the prediction graph.

### Figure 23.10 PRESS Residuals

<table>
<thead>
<tr>
<th>Is</th>
<th>ha</th>
<th>df</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.2540951</td>
<td>-0.40404</td>
<td>63.113284</td>
</tr>
<tr>
<td>0.3815403</td>
<td>-0.295201</td>
<td>-17.201262</td>
</tr>
<tr>
<td>0.0360613</td>
<td>-0.01191</td>
<td>-20.333775</td>
</tr>
<tr>
<td>-0.1088038</td>
<td>0.023714</td>
<td>-1.866457</td>
</tr>
<tr>
<td>-0.025</td>
<td>-0.030001</td>
<td>-4.005078</td>
</tr>
<tr>
<td>-0.02072</td>
<td>0.039508</td>
<td>-11.2758</td>
</tr>
<tr>
<td>-0.102711</td>
<td>0.0060221</td>
<td>-11.64102</td>
</tr>
<tr>
<td>0.0969734</td>
<td>-0.015441</td>
<td>22.994919</td>
</tr>
<tr>
<td>-0.141904</td>
<td>-0.002341</td>
<td>4.254709</td>
</tr>
<tr>
<td>-0.105445</td>
<td>-0.050869</td>
<td>14.006062</td>
</tr>
<tr>
<td>0.1198319</td>
<td>-0.1180552</td>
<td>6.0822293</td>
</tr>
<tr>
<td>0.3310203</td>
<td>-0.057635</td>
<td>21.009099</td>
</tr>
<tr>
<td>-0.0888322</td>
<td>0.029555</td>
<td>-9.744834</td>
</tr>
<tr>
<td>0.0002448</td>
<td>0.05402227</td>
<td>-29.91227</td>
</tr>
<tr>
<td>-0.0195556</td>
<td>0.096231</td>
<td>-24.48254</td>
</tr>
<tr>
<td>-0.0620461</td>
<td>0.1814688</td>
<td>10.729884</td>
</tr>
</tbody>
</table>

### Test Set Validation

The quality of the model fit to the observed data cannot be used to choose the number of factors to extract; the number of extracted factors must be chosen on the basis of how well the model fits observations not involved in the modeling procedure itself.

One way of choosing the number of extracted factors is to fit the model to only part of the available data (the training set) and to measure how well models with different numbers of extracted factors fit the other part of the data (the test set). This is called test set validation.

To do this in JMP, select the test set and exclude them from the analysis. Then, fit a PLS model and save the prediction formula to the data table. This adds a column to the data table that contains predicted values for both the training set and test set.

### Platform Options

The PLS platform has several options available on the platform popup menu:

- **Show Points** shows or hides the points on the $Y$ scores vs. $X$ scores scatterplots.
- **Show Confidence Lines** shows or hides the confidence lines on the $Y$ scores vs. $X$ scores scatterplots.

Note that these should only be used for outlier detection, since the platform doesn’t compute traditional confidence lines.
Variable Importance Plot shows or hides a Variable Importance Plot. The statistics given are VIP statistics, see Wold (1994). The statistics summarize the contribution a variable makes to the model. If a variable has a small coefficient and a small VIP, then it is a candidate for deletion from the model. Wold in Umetrics (1995) considers a value of 0.8 to be a small VIP. The blue line on the VIP plot is drawn at 0.8.

![Variable Importance Plot](image)

**Figure 23.11** Variables Importance Plot

<table>
<thead>
<tr>
<th>Predictor</th>
<th>VIP</th>
</tr>
</thead>
<tbody>
<tr>
<td>v1</td>
<td>1.051759</td>
</tr>
<tr>
<td>v2</td>
<td>1.275445</td>
</tr>
<tr>
<td>v3</td>
<td>1.0652278</td>
</tr>
<tr>
<td>v4</td>
<td>0.070975</td>
</tr>
<tr>
<td>v5</td>
<td>0.0692264</td>
</tr>
<tr>
<td>v6</td>
<td>0.0700433</td>
</tr>
<tr>
<td>v7</td>
<td>0.0019264</td>
</tr>
<tr>
<td>v8</td>
<td>0.0100867</td>
</tr>
<tr>
<td>v9</td>
<td>0.0070335</td>
</tr>
<tr>
<td>v10</td>
<td>1.1435822</td>
</tr>
<tr>
<td>v11</td>
<td>1.1576569</td>
</tr>
<tr>
<td>v12</td>
<td>1.1571916</td>
</tr>
<tr>
<td>v13</td>
<td>1.1074582</td>
</tr>
<tr>
<td>v14</td>
<td>0.0959564</td>
</tr>
<tr>
<td>v15</td>
<td>0.0570832</td>
</tr>
<tr>
<td>v16</td>
<td>0.7250229</td>
</tr>
<tr>
<td>v17</td>
<td>0.704461</td>
</tr>
<tr>
<td>v18</td>
<td>0.711420</td>
</tr>
<tr>
<td>v19</td>
<td>0.7343961</td>
</tr>
<tr>
<td>v20</td>
<td>0.7931372</td>
</tr>
<tr>
<td>v21</td>
<td>0.6622679</td>
</tr>
<tr>
<td>v22</td>
<td>0.6991369</td>
</tr>
<tr>
<td>v23</td>
<td>0.6984269</td>
</tr>
<tr>
<td>v24</td>
<td>0.6957338</td>
</tr>
<tr>
<td>v25</td>
<td>1.0370967</td>
</tr>
<tr>
<td>v26</td>
<td>1.0655859</td>
</tr>
<tr>
<td>v27</td>
<td>1.1048445</td>
</tr>
</tbody>
</table>

Distance Plot shows or hides a Distance Plot. The x axis gives the distance from each point to the model with respect to the Y’s. The y axis gives the distance from each point to the model with respect to the X’s. In a good model, both X and Y distances are small, and the points are close to the origin (0,0). Use the plot to look for outliers in either direction. If a group of points are separate from the rest, and cluster together, then they might have something in common and could be analyzed separately. To output the plot data to a table, select Save > Save Scores and Distance from the platform menu. The table contains two columns, STDXSSE and STDYSSE, which are the residual sums of squares for standardized X and Y.
Figure 23.12 Distance Plot

Loadings Plots shows or hides X Loadings Plot and Y Loadings Plot. To output the plot data to a table, select Save > Save Loadings from the platform menu.

Figure 23.13 Loadings Plots

Scores Plots shows or hides X Scores Plot and Y Scores Plot. To output the plot data to a table, select Save > Save Scores and Distance from the platform menu.
Figure 23.14 Scores Plots

Diagnostics Plots shows various diagnostic plots for each response.
**Figure 23.15** Diagnostic Plots

- **Save** is a submenu of commands for saving model results.
  - **Save Prediction Formula** saves the prediction formula for each $Y$ to the data table.
  - **Save Y Residuals** saves the residuals for each $Y$ to the data table.
  - **Save X Residuals** saves the residuals for each $X$ to the data table.
  - **Save Percent Variation Explained for X Variables** saves to a new table the percent variation explained for each $X$ and number of factors. This is the information used to create the $X$ plot of Figure 23.6.
  - **Save Percent Variation Explained for Y Variables** saves to a new table the percent variation explained for each $Y$ and number of factors. This is the information used to create the $Y$ plot of Figure 23.6.
  - **Save Scores and Distance** saves to a new table the scores (used to create Figure 23.14) and the distances (used to create Figure 23.12). Also creates a Table Property/Script called PLS Scores, and attaches it to the original data table. The script contains JSL matrices of the scores.
  - **Save Loadings** saves the $X$ and $Y$ loadings in two new data tables. This is the information used to create Figure 23.13. Also creates a script called PLS Loadings, and attaches it to the original data table. The script contains JSL matrices of the loadings.
Partial Least Squares
Chapter 23
Statistical Details

Partial least squares (PLS) works by extracting one factor at a time. Let \( X = X_0 \) be the centered and scaled matrix of predictors and \( Y = Y_0 \) the centered and scaled matrix of response values. The PLS method starts with a linear combination \( t = X_0w \) of the predictors, where \( t \) is called a score vector and \( w \) is its associated weight vector. The PLS method predicts both \( X_0 \) and \( Y_0 \) by regression on \( t \):

\[
X_0 = tp', \quad \text{where } p' = (t't)^{-1}t'X_0
\]

\[
Y_0 = tc', \quad \text{where } c' = (t't)^{-1}t'Y_0
\]

The vectors \( p \) and \( c \) are called the \( X \)- and \( Y \)-loadings, respectively.

The specific linear combination \( t = X_0w \) is the one that has maximum covariance \( t'u \) with some response linear combination \( u = Y_0q \). Another characterization is that the \( X \)- and \( Y \)-weights \( w \) and \( q \) are proportional to the first left and right singular vectors of the covariance matrix \( X_0'Y_0 \) or, equivalently, the first eigenvectors of \( X_0'Y_0X_0 \) and \( Y_0'X_0Y_0 \) respectively.

This accounts for how the first PLS factor is extracted. The second factor is extracted in the same way by replacing \( X_0 \) and \( Y_0 \) with the \( X \)- and \( Y \)-residuals from the first factor

\[
X_1 = X_0 - X_0
\]

\[
Y_1 = Y_0 - Y_0
\]

These residuals are also called the deflated \( X \) and \( Y \) blocks. The process of extracting a score vector and deflating the data matrices is repeated for as many extracted factors as are desired.

Centering and Scaling

By default, the predictors and the responses are centered and scaled to have mean 0 and standard deviation 1. Centering the predictors and the responses ensures that the criterion for choosing successive factors is based on how much variation they explain, in either the predictors or the responses or both. Without centering, both the mean variable value and the variation around that mean are involved in selecting factors.

Scaling serves to place all predictors and responses on an equal footing relative to their variation in the data. For example, if \( \text{Time} \) and \( \text{Temp} \) are two of the predictors, then scaling says that a change of \( \text{std(Time)} \) in \( \text{Time} \) is roughly equivalent to a change of \( \text{std(Temp)} \) in \( \text{Temp} \).

Missing Values

Observations with any missing independent variables are excluded from the analysis, and no predictions are computed for such observations. Observations with no missing independent variables but any missing dependent variables are also excluded from the analysis, but predictions are computed.
Item Response Theory (IRT) is a method of scoring tests. Although classical test theory methods have been widely used for a century, IRT provides a better and more scientifically-based scoring procedure. Its advantages include:

- scoring tests at the item level, giving insight into the contributions of each item on the total test score
- producing scores of both the test takers and the test items on the same scale
- fitting nonlinear logistic curves, more representative of actual test performance than classical linear statistics.
Contents

Introduction to Item Response Theory ................................................................. 505
Launching the Platform ......................................................................................... 508
Item Analysis Output ............................................................................................. 510
  Characteristic Curves. ......................................................................................... 510
  Information Curves. ............................................................................................. 511
  Dual Plots ........................................................................................................... 511
Platform Commands ............................................................................................. 513
Technical Details .................................................................................................... 514
Introduction to Item Response Theory

Psychological measurement is the process of assigning quantitative values as representations of characteristics of individuals or objects, so-called psychological constructs. Measurement theories consist of the rules by which those quantitative values are assigned. Item response theory (IRT) is a measurement theory.

IRT utilizes a mathematical function to relate an individual’s probability of correctly responding to an item to a trait of that individual. Frequently, this trait is not directly measurable, and is therefore called a latent trait.

To see how IRT relates traits to probabilities, first examine a test question that follows the Guttman “perfect scale” as shown in Figure 24.1. The horizontal axis represents the amount of the theoretical trait that the examinee has. The vertical axis represents the probability that the examinee will get the item correct. (A missing value for a test question is treated as an incorrect response.) The curve in Figure 24.1 is called an item characteristic curve (ICC).

Figure 24.1 Item characteristic curve of a perfect scale item

This figure shows that a person who has ability less than the value \( b \) has a zero percent chance of getting the item correct. A person with trait level higher than \( b \) has a 100 percent chance of getting the item correct.

Of course, this is an unrealistic item, but it is illustrative in showing how a trait and a question probability relate to each other. More typical is a curve that allows probabilities that vary from zero to one. A typical curve found empirically is the S-shaped logistic function with a lower asymptote at zero and upper asymptote at one. It is markedly nonlinear. An example curve is shown in Figure 24.2.
The logistic model is the best choice to model this curve, since it has desirable asymptotic properties, yet is easier to deal with computationally than other proposed models (such as the cumulative normal density function). The model itself is

\[ P(\theta) = c + \frac{1 - c}{1 + e^{-a(\theta - b)}} \]

In this model, referred to as a 3PL (three-parameter logistic) model, the variable \( a \) represents the steepness of the curve at its inflection point. Curves with varying values of \( a \) are shown in Figure 24.3. This parameter can be interpreted as a measure of the discrimination of an item—that is, how much more difficult the item is for people with high levels of the trait than for those with low levels of the trait. Very large values of \( a \) make the model practically the step function shown in Figure 24.1. It is generally assumed that an examinee will have a higher probability of getting an item correct as their level of the trait increases. Therefore, \( a \) is assumed to be positive and the ICC is monotonically increasing. Some use this positive-increasing property of the curve as a test of the appropriateness of the item. Items whose curves do not have this shape should be considered as candidates to be dropped from the test.
Changing the value of $b$ merely shifts the curve from left to right, as shown in Figure 24.4. It corresponds to the value of $\theta$ at the point where $P(\theta)=0.5$. The parameter $b$ can therefore be interpreted as item difficulty where (graphically), the more difficult items have their inflection points farther to the right along their $x$-coordinate.

**Figure 24.4** Logistic curve for several values of $b$

Notice that

$$\lim_{\theta \to -\infty} P(\theta) = c$$

and therefore $c$ represents the lower asymptote, which can be non-zero. ICCs for several values of $c$ are shown graphically in Figure 24.5. The $c$ parameter is theoretically pleasing, since a person with no ability of the trait may have a non-zero chance of getting an item right. Therefore, $c$ is sometimes called the pseudo-guessing parameter.

**Figure 24.5** Logistic model for several values of $c$
By varying these three parameters, a wide variety of probability curves are available for modeling. A sample of three different ICCs is shown in Figure 24.6. Note that the lower asymptote varies, but the upper asymptote does not. This is because of the assumption that there may be a lower guessing parameter, but as the trait level increases, there is always a theoretical chance of 100% probability of correctly answering the item.

Figure 24.6 Three item characteristic curves

Note, however, that the 3PL model may be unnecessarily complex for many situations. If, for example, the c parameter is restricted to be zero (in practice, a reasonable restriction), there are fewer parameters to predict. This model, where only a and b parameters are estimated, is called the 2PL model.

Another advantage of the 2PL model (aside from its greater stability than the 3PL) is that b can be interpreted as the point where an examinee has a 50 percent chance of getting an item correct. This interpretation is not true for 3PL models.

A further restriction can be imposed on the general model when a researcher can assume that test items have equal discriminating power. In these cases, the parameter b is set equal to zero (essentially dropped from the model), leaving a single parameter to be estimated. This 1PL model is frequently called the Rasch model, named after Danish mathematician Georg Rasch, the developer of the model. The Rasch model is quite elegant, and is the least expensive to use computationally.

Caution: You must have a lot of data to produce stable parameter estimates using a 3PL model. 2PL models are frequently sufficient for tests that intuitively deserve a guessing parameter. Therefore, the 2PL model is the default and recommended model.

Launching the Platform

As an example, open the sample data file MathScienceTest.JMP. These data are a subset of the data from the Third International Mathematics and Science Study (TIMMS) conducted in 1996.

To launch the Item Analysis platform, select Analyze > Multivariate Methods > Item Analysis. This shows the dialog in Figure 24.7.
Y, Test Items are the questions from the test instrument.

Freq optionally specifies a variable used to specify the number of times each response pattern appears.

By performs a separate analysis for each level of the specified variable.

Specify the desired model (1PL, 2PL, or 3PL) by selecting it from the Model drop-down menu.

For this example, specify all fourteen continuous questions (Q1, Q2,..., Q14) as Y, Test Items and click OK. This accepts the default 2PL model.

Special note on 3PL Models

If you select the 3PL model, a dialog pops up asking for a penalty for the \( c \) parameters (thresholds). This is not asking for the threshold itself. The penalty it requests is similar to the type of penalty parameter that you would see in ridge regression, or in neural networks.

The penalty is on the sample variance of the estimated thresholds, so that large values of the penalty force the estimated thresholds’ values to be closer together. This has the effect of speeding up the computations, and reducing the variability of the threshold (at the expense of some bias).

In cases where the items are questions on a multiple choice test where there are the same number of possible responses for each question, there is often reason to believe (a priori) that the threshold parameters would be similar across items. For example, if you are analyzing the results of a 20-question multiple choice test where each question had four possible responses, it is reasonable to believe that the guessing, or threshold, parameters would all be near 0.25. So, in some cases, applying a penalty like this has some “physical intuition” to support it, in addition to its computational advantages.
Item Analysis Output

The following plots appear in Item Analysis reports.

Characteristic Curves

Item characteristic curves for each question appear in the top section of the output. Initially, all curves are shown stacked in a single column. They can be rearranged using the **Number of Plots Across** command, found in the drop down menu of the report title bar. For Figure 24.8, four plots across are displayed.

**Figure 24.8 Component Curves**

A vertical red line is drawn at the inflection point of each curve. In addition, dots are drawn at the actual proportion correct for each ability level, providing a graphical method of judging goodness-of-fit.

Gray information curves show the amount of information each question contributes to the overall information of the test. The information curve is the slope of the ICC curve, which is maximized at the inflection point.
**Figure 24.9 Elements of the ICC Display**

Questions provide varying levels of information for different ability levels. The gray information curves for each item show the amount of information that each question contributes to the total information of the test. The total information of the test for the entire range of abilities is shown in the Information Plot section of the report (Figure 24.10).

**Information Curves**

The information gained from item difficulty parameters in IRT models can be used to construct an increasing scale of questions, from easiest to hardest, on the same scale as the examinees. This structure gives information on which items are associated with low levels of the trait, and which are associated with high levels of the trait.

**Figure 24.10 Information Plot**

**Dual Plots**

The information gained from item difficulty parameters in IRT models can be used to construct an increasing scale of questions, from easiest to hardest, on the same scale as the examinees. This structure gives information on which items are associated with low levels of the trait, and which are associated with high levels of the trait.
JMP shows this correspondence with a dual plot. The dual plot for this example is shown in Figure 24.11.

Questions are plotted to the left of the vertical dotted line, examinees on the right. In addition, a histogram of ability levels is appended to the right side of the plot.

This example shows a wide range of abilities. Q10 is rated as difficult, with an examinee needing to be around half a standard deviation above the mean in order to have a 50% chance of correctly answering the question. Other questions are distributed at lower ability levels, with Q11 and Q4 appearing as easier. There are some questions that are off the displayed scale (Q7 and Q14).

The estimated parameter estimates appear below the Dual Plot, as shown in Figure 24.12.
Figure 24.12 Parameter Estimates

<table>
<thead>
<tr>
<th>Item</th>
<th>Difficulty</th>
<th>Discrimination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1</td>
<td>-0.1581</td>
<td>0.9505</td>
</tr>
<tr>
<td>Q2</td>
<td>-0.0481</td>
<td>1.2857</td>
</tr>
<tr>
<td>Q3</td>
<td>0.4392</td>
<td>1.0106</td>
</tr>
<tr>
<td>Q4</td>
<td>-3.7953</td>
<td>0.7221</td>
</tr>
<tr>
<td>Q5</td>
<td>-0.0883</td>
<td>1.1318</td>
</tr>
<tr>
<td>Q6</td>
<td>-1.0083</td>
<td>0.9495</td>
</tr>
<tr>
<td>Q7</td>
<td>-1.1111</td>
<td>0.0586</td>
</tr>
<tr>
<td>Q8</td>
<td>-0.3622</td>
<td>0.1303</td>
</tr>
<tr>
<td>Q9</td>
<td>-0.0527</td>
<td>1.2829</td>
</tr>
<tr>
<td>Q10</td>
<td>0.4977</td>
<td>1.0506</td>
</tr>
<tr>
<td>Q11</td>
<td>2.5284</td>
<td>1.3821</td>
</tr>
<tr>
<td>Q12</td>
<td>-0.0798</td>
<td>1.1507</td>
</tr>
<tr>
<td>Q13</td>
<td>-0.9568</td>
<td>1.0374</td>
</tr>
<tr>
<td>Q14</td>
<td>-10.345</td>
<td>0.2285</td>
</tr>
</tbody>
</table>

- **Item** identifies the test item.
- **Difficulty** is the $b$ parameter from the model. A histogram of the difficulty parameters is shown beside the difficulty estimates.
- **Discrimination** is the $a$ parameter from the model, shown only for 2PL and 3PL models. A histogram of the discrimination parameters is shown beside the discrimination estimates.
- **Threshold** is the $c$ parameter from the model, shown only for 3PL models.

### Platform Commands

The following three commands are available from the drop-down menu on the title bar of the report.

- **Number of Plots Across** brings up a dialog to specify how many plots should be grouped together on a single line. Initially, plots are stacked one-across. Figure 24.8 “Component Curves,” p. 510 shows four plots across.

- **Save Ability Formula** creates a new column in the data table containing a formula for calculating ability levels. Since the ability levels are stored as a formula, you can add rows to the data table and have them scored using the stored ability estimates. In addition, you can run several models and store several estimates of ability in the same data table.

The ability is computed using the IRT Ability function. The function has the following form

\[
\text{IRT Ability} (Q1, Q2, \ldots, Qn, [a1, a2, \ldots, an, b1, b2, \ldots, bn, c1, c2, \ldots, cn]);
\]

where $Q1, Q2, \ldots, Qn$ are columns from the data table containing items, $a1, a2, \ldots, an$ are the corresponding discrimination parameters, $b1, b2, \ldots, bn$ are the corresponding difficulty parameters for the items, and $c1, c2, \ldots, cn$ are the corresponding threshold parameters. Note that the parameters are entered as a matrix, surrounded by square brackets.

- **Script** accesses the standard script menu for saving and re-computing an analysis.
Technical Details

Note that $P(\theta)$ does not necessarily represent the probability of a positive response from a particular individual. It is certainly feasible that an examinee might definitely select an incorrect answer, or that an examinee may know an answer for sure, based on the prior experiences and knowledge of the examinee, apart from the trait level. It is more correct to think of $P(\theta)$ as the probability of response for a set of individuals with ability level $\theta$. Said another way, if a large group of individuals with equal trait levels answered the item, $P(\theta)$ predicts the proportion that would answer the item correctly. This implies that IRT models are item-invariant; theoretically, they would have the same parameters regardless of the group tested.

An assumption of these IRT models is that the underlying trait is unidimensional. That is to say, there is a single underlying trait that the questions measure which can be theoretically measured on a continuum. This continuum is the horizontal axis in the plots of the curves. If there are several traits being measured, each of which have complex interactions with each other, then these unidimensional models are not appropriate.
Chapter 25

Plotting Surfaces

The Surface Plot Platform

The Surface Plot platform functions both as a separate platform and as an option in model fitting platforms. Up to four dependent surfaces can be displayed in the same plot. The dependent variables section, below the plot, has four rows that correspond to the four surfaces. Depending on what you choose to view (sheets, points, isosurfaces, or density grids) and whether you supply a formula variable, different options appear in the dependent variables section.

Surface Plot is built using the 3-D scene commands from JMP’s scripting language. Complete documentation of the OpenGL-style scene commands is found in the JMP Scripting Guide.

In this platform, you can

- use the mouse to drag the surface to a new position;
- Right-click on the surface to change the background color or show the virtual ArcBall (which helps position the surface);
- enable hardware acceleration, which may increase performance if it is supported on your system;
- drag lights to different positions, assign them colors, and turn them on and off.

Figure 25.1 Example of a Surface Plot
## Contents

- Surface Plots ........................................................................................................ 517
- Launching the Platform. .................................................................................... 517
  - Plotting a Single Mathematical Function..................................................... 518
  - Plotting Points Only ................................................................................. 519
  - Plotting a Formula from a Column ............................................................ 520
  - Isosurfaces ................................................................................................. 522
- The Surface Plot Control Panel ........................................................................ 524
  - Appearance Controls .................................................................................. 525
  - Independent Variables ............................................................................... 525
  - Dependent Variables .................................................................................. 526
- Plot Controls and Settings ................................................................................ 527
  - Rotate ......................................................................................................... 527
  - Axis Settings ............................................................................................... 528
  - Lights ........................................................................................................ 529
  - Sheet or Surface Properties ....................................................................... 529
  - Other Properties and Commands .............................................................. 530
- Keyboard Shortcuts .......................................................................................... 531
Surface Plots

The Surface Plot platform is used to plot points and surfaces in three dimensions.

Surface plots are available as a separate platform (Graph > Surface Plot) and as options in many reports (known as the Surface Profiler). Its functionality is similar wherever it appears.

The plots can be of points or surfaces. When the surface plot is used as a separate platform (that is, not as a profiler), the points are linked to the data table—they are clickable, respond to the brush tool, and reflect the colors and markers assigned in the data table. Surfaces can be defined by a mathematical equation, or through a set of points defining a polygonal surface. These surfaces can be displayed smoothly or as a mesh, with or without contour lines. Labels, axes, and lighting are fully customizable.

Launching the Platform

To launch the platform, select Surface Plot from the Graph menu. If there is a data table open, this displays the dialog in Figure 25.2. If there is no data table open, click **OK**. You are presented with the default surface plot shown in Figure 25.3.

Specify the columns you want to plot by putting them in the **Columns** role. Only numeric variables can be assigned to the **Columns** role. Variables in the **By** role produce a separate surface plot for each level of the **By** variable.

When selected, the **Scale response axes independently** option gives a separate scale to each response on the plot. When not selected, the axis scale for all responses is the same as the scale for the first item entered in the **Columns** role.
Plotting a Single Mathematical Function

To produce the graph of a mathematical function without any data points, do not fill in any of the roles on the launch dialog. Simply click OK to get a default plot, as shown in Figure 25.3.

Figure 25.3 Default Surface Plot

Select the Show Formula checkbox to show the formula space.
The default function shows in the box. To plot your own function, enter it in this box.

**Plotting Points Only**

To produce a 3-D scatterplot of points, place the \(x\), \(y\), and \(z\)-columns in the **Columns** box. For example, using the Tiretread.jmp data, first select **Rows > Clear Row States**. Then select **Graph > Surface Plot**. Assign Silica, Silane, and Sulfur to the **Columns** role. Click **OK**.
Plotting a Formula from a Column

To plot a formula (i.e., a formula from a column in the data table), place the column in the Columns box. For example, use the Tiretread.jmp data table and select Graph > Surface Plot. Assign Pred Formula ABRASION to the Columns role. Click OK. You do not have to specify the factors for the plot, since the platform automatically extracts them from the formula.
Note that this only plots the prediction surface. To plot the actual values in addition to the formula, assign the ABRASION and Pred Formula ABRASION to the Columns role.

Figure 25.6 shows the launch dialog and the completed results.
Isosurfaces

Isosurfaces are the 3-D analogy to a 2-D contour plot. An isosurface requires a formula with three independent variables. The Resolution slider determines the $n \times n \times n$ cube of points that the formula is evaluated over. The Value slider in the Dependent Variable section picks the isosurface (that is, the contour level) value.

As an example, open the Tiretread.jmp data table and run the RSM for 4 Responses script. This produces a response surface model with dependent variables ABRASION, MODULUS, ELONG, and HARDNESS. Since isosurfaces require formulas, select Save Columns > Prediction Formula for ABRASION, MODULUS, and ELONG.
Now launch Surface Plot and designate the three prediction columns as those to be plotted.

When the report appears, select the Isosurface radio button. Under the **Dependent Variables** outline node, select **Both Sides** for all three variables.
For the tire tread data, one might set the hardness at a fixed minimum setting and the elongation at a fixed maximum setting, then use the slider for modulus to see which values of modulus are inside the limits set by the other two surfaces.

The Surface Plot Control Panel

The drop-down menu in the main Surface Plot title bar has three entries.

- **Control Panel** shows or hides the Control Panel.
- **Scale response axes independently** scales response axes independently. See explanation of Figure 25.2 on p. 517.
- **Script** the standard JMP Script menu.

The Control Panel consists of the following groups of options.
Chapter 25

Plotting Surfaces

The Surface Plot Control Panel

**Appearance Controls**

The first set of controls allows you to specify the overall appearance of the surface plot.

- **Sheet, points** is the setting for displaying sheets, points, and lines.
- **Isosurface** changes the display to show isosurfaces, described in “Isosurfaces,” p. 522.
- **Show formula** shows the formula edit box, allowing you to enter a formula to be plotted.

The **Resolution** slider affects how many points are evaluated for a formula. Too coarse a resolution means a function with a sharp change might not be represented very well, but setting the resolution high makes evaluating and displaying the surface slower.

**Independent Variables**

The independent variables controls are displayed in Figure 25.8.

When there are more than two independent variables, you can select which two are displayed on the $x$- and $y$-axes using the radio buttons in this panel. The sliders and text boxes set the current values of each variable, which is most important for the variables that are not displayed on the axes. In essence, the plot shows the three-dimensional slice of the surface at the value shown in the text box. Move the slider to see different slices.

**Lock Z Scale** locks the $z$-axis to its current values. This is useful when moving the sliders that are not on an axis.

**Grid** check boxes activate a grid that is parallel to each axis. The sliders allow you to adjust the placement of each grid. The resolution of each grid can be controlled by adjusting axis settings. As an example, Figure 25.9 shows a surface with the $X$ and $Y$ grids activated.
The dependent variables controls change depending on whether you have selected **Sheet**, **points** or **Isosurface** in the Appearance Controls.

### Controls for Sheet, Points

The Dependent Variables controls are shown in Figure 25.10 with its default menus.

**Formula**  lets you pick the formula(s) to be displayed in the plot as surfaces.

**Point Response Column**  lets you pick the column that holds values to be plotted as points. If a prediction formula column is chosen here, you can right-click on the response surface to access the Response Surface Properties window.
Plot Controls and Settings

Style menus appear after you have selected a Point Response Column. The style menu lets you choose how those points are displayed, as Points, Needles, a Mesh, Surface, or Off (not at all). Points shows individual points, which change according to the color and marker settings of the row in the data table. Needles draws lines from the x-y plane to the points, or, if a surface is also plotted, connects the surface to the points. Mesh connects the points into a triangular mesh. Surface overlays a smooth, reflective surface on the points.

Grid slider and checkbox activate a grid for the dependent variable. Use the slider to adjust the value where the grid is drawn, or type the value into the Grid Value box above the slider.

Controls for Isosurface

Most of the controls for Isosurface are identical to those of Sheet, points. Figure 25.11 shows the default controls, illustrating the slightly different presentation.

Figure 25.11 Dependent Variable Controls for Isosurfaces

![Sliders adjust the surface](image)

Dependent Variable Menu Options

There are several options for the Dependent Variable, accessed through the popup menu.

- **Formula** reveals or hides the Formula drop-down list.
- **Surface** reveals or hides the Surface drop-down list.
- **Points** reveals or hides the Point Response Column drop-down list.
- **Response Grid** reveals or hides the Grid controls.

Plot Controls and Settings

Rotate

The plot can be rotated in any direction by dragging it. Place the cursor anywhere on the plot where the cursor has a circular arrow attached to it, then click and drag the plot to rotate.
Plotting Surfaces
Chapter 25
Plot Controls and Settings

Figure 25.12 Example of Cursor Position for Rotating Plot

The Up, Down, Left, and Right arrow keys can also be used to rotate the plot.

Axis Settings

Double-click on an axis to reveal the axis control dialog shown below. The dialog allows you to change the Minimum, Maximum, Increment, and tick mark label Format.

Like other JMP graphs, the axes can be adjusted, stretched, and compressed using the grabber tool. Place the cursor over an axis to change it to the grabber.
Chapter 25
Plotting Surfaces
Plot Controls and Settings

Figure 25.13 Grabber Tools

Place grabber in the middle of axis to adjust.
Place grabber at the end of axis to stretch or compress.

Notice the orientation of grabber changes from vertical to horizontal

Lights

By default, the plot has lights shining on it. There are eight control knobs on the plot for changing the position and color of the lights. This is useful for highlighting different parts of a plot and creating contrast. Four of the eight knobs are show below.

Figure 25.14 Control Knobs for Lights

Activated light
Right-click in border to Reset lights
Light is off. Right-click on knob to turn on

Right-click on a knob to turn that light on or off. More lights turned on brighten a plot, and fewer lights darken it. Drag a knob to change the position of a light. Change the color of a light by right-clicking on the knob. The default color is white.

Sheet or Surface Properties

If you are plotting a Sheet, points, right-click on the sheet and select Sheet Properties to reveal a dialog for changing the sheet properties.
Plotting Surfaces
Plot Controls and Settings

Figure 25.15 Sheet Properties Dialog

- **Surface** lets you fill the surface with a solid color (the default), or a gradient of colors according to another dependent variable. If you choose a solid color, you may also change the color by clicking on the **Solid Color** bar. If you choose a gradient, options appear for changing the gradient.

- **Fill Type** allows you to color the surface using a solid color, or continuous or discrete gradients. If a gradient is chosen, the Show Legend option appears when you right click on the surface.

- **Mesh** allows you to turn on or off a surface mesh, for either the X or Y directions or both. If turned on, the **Mesh Color** option is revealed allowing you to change the color.

- **Contour** allows you to turn on or off a contour grid, either above, below, or on the surface. If turned on, the **Contour Color** option is revealed allowing you to change the color.

- **Limit X and Y to Point Response Column** limits the range of the plot to the range of the data in the Point Response Column, if one is activated. If checked, this essentially restricts the plot from extrapolating outside the range of the data in the Point Response Column.

If you are plotting a Isosurface, right-click on the surface and select **Surface Properties** to reveal a similar dialog. You can modify the surface color, opacity, and toggle a mesh.

**Other Properties and Commands**

- **Show Legend** shows a legend when the surface is colored using gradients.
- **Reset** resets the plot to the original viewpoint. Changes in wall and background color are not affected.
- **Settings** opens a dialog for changing many plot settings.
Chapter 25

Plotting Surfaces

Keyboard Shortcuts

Hide Lights Border  shows or hides lighting controls.
Wall Color  allows you to change the plot wall color.
Background Color  allows you to change the plot background color.
Rows  allows you to change row colors or markers, and also exclude, hide, and label points. These options only have affect if points are on the plot.
Use Hardware Acceleration  provides for faster rendering of the display. For example, if the plot redraws slowly when rotating, this option may help it to redraw faster.
Show ArcBall  provides options for using the ArcBall. The ArcBall is a sphere drawn around the plot to help visualize the directions of rotation.

Keyboard Shortcuts

The following keyboard shortcuts can be used to manipulate the surface plot. To get the plot back to the original viewpoint, right-click on the plot and select Reset.

Table 25.1  Surface Plot Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>left, right, up, and down arrows</td>
<td>spin</td>
</tr>
<tr>
<td>Home, End</td>
<td>diagonally spin</td>
</tr>
<tr>
<td>Enter (Return)</td>
<td>toggles ArcBall appearance</td>
</tr>
<tr>
<td>Delete</td>
<td>roll counterclockwise</td>
</tr>
<tr>
<td>Control</td>
<td>boost spin speed 10X</td>
</tr>
<tr>
<td>Shift</td>
<td>allows continual spinning</td>
</tr>
</tbody>
</table>
Plotting Surfaces
Keyboard Shortcuts
Chapter 26

Profiling
Response Surface Visualization, Optimization, and Simulation

Profiling is an approach to visualizing response surfaces by seeing what would happen if you change just one or two factors at a time. Essentially, a profile is a cross-section view.

Figure 26.1 Examples of Profilers
**Introduction to Profiling**

It is easy to visualize a response surface with one input factor $X$ and one output factor $Y$. It becomes harder as more factors and responses are added. The profilers provide a number of highly interactive cross-sectional views of any response surface.

Desirability profiling and optimization features are available to help find good factor settings and produce desirable responses.

Simulation and defect profiling features are available for when you need to make responses that are robust and high-quality when the factors have variation.

**Profiling Features in JMP**

There are five profiler facilities in JMP, accessible from a number of fitting platforms and the main menu. They are used to profile data column formulas.

**Table 26.1 Profiler Features Summary**

<table>
<thead>
<tr>
<th>Description</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profiler</strong></td>
<td>Shows vertical slices across each factor, holding other factors at current values</td>
</tr>
<tr>
<td><strong>Contour Profiler</strong></td>
<td>Horizontal slices show contour lines for two factors at a time</td>
</tr>
<tr>
<td><strong>Surface Profiler</strong></td>
<td>3-D plots of responses for 2 factors at a time, or a contour surface plot for 3 factors at a time</td>
</tr>
<tr>
<td><strong>Custom Profiler</strong></td>
<td>A non-graphical profiler and numerical optimizer</td>
</tr>
<tr>
<td><strong>Mixture Profiler</strong></td>
<td>A contour profiler for mixture factors</td>
</tr>
</tbody>
</table>

Profiler availability is shown in Table 15.2.

**Table 26.2 Where to Find JMP Profilers**

<table>
<thead>
<tr>
<th>Location</th>
<th>Profiler</th>
<th>Contour Profiler</th>
<th>Surface Profiler</th>
<th>Mixture Profiler</th>
<th>Custom Profiler</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Menu (as a Platform)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Fit Model: Least Squares</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Fit Model: Logistic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fit Model: LogVariance</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Introduction to Profiling

When the profiler is invoked as a platform, rather than through a fitting platform, you provide columns with formulas as the Y, Prediction Formula columns. These formulas could have been saved from the fitting platforms.

Table 26.2 Where to Find JMP Profilers (Continued)

<table>
<thead>
<tr>
<th>Location</th>
<th>Profiler</th>
<th>Contour Profiler</th>
<th>Surface Profiler</th>
<th>Mixture Profiler</th>
<th>Custom Profiler</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit Model: Generalized Linear</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nonlinear: Factors and Response</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nonlinear: Parameters and SSE</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Neural Net</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gaussian Process</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Design Prediction Variance</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Life Distribution</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fit Life by X</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Choice</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: In this chapter, we use the following terms interchangeably:

- factor, input variable, X column, independent variable, setting
- response, output variable, Y column, dependent variable, outcome

The **Profiler** (with a capital P) is one of several profilers (lowercase p). Sometimes, to distinguish the **Profiler** from other profilers, we call it the **Prediction Profiler**.

When the profiler is invoked as (main menu) a platform, rather than through a fitting platform, you provide columns with formulas as the Y, **Prediction Formula** columns. These formulas could have been saved from the fitting platforms.

Figure 26.2 Profiler Launch Window
The columns referenced in the formulas become the $X$ columns (unless the column is also a $Y$).

- **Y, Prediction Formula** are the response columns containing formulas.

- **Noise Factors** are only used in special cases for modeling derivatives. Details are in “Noise Factors (Robust Engineering),” p. 594.

- **Expand Intermediate Formulas** tells JMP that if an ingredient column to a formula is a column that itself has a formula, to substitute the inner formula, as long as it refers to other columns. To prevent an ingredient column from expanding, use the Other column property with a name of "Expand Formula" and a value of 0.

The **Surface Plot** platform is discussed in a separate chapter. The **Surface Profiler** is very similar to the **Surface Plot** platform, except **Surface Plot** has more modes of operation. Neither the **Surface Plot** platform nor the **Surface Profiler** have some of the capabilities common to other profilers.

---

**The Profiler**

The **Profiler** displays profile traces (see Figure 26.3) for each $X$ variable. A profile trace is the predicted response as one variable is changed while the others are held constant at the current values. The **Profiler** recomputes the profiles and predicted responses (in real time) as you vary the value of an $X$ variable.

- The vertical dotted line for each $X$ variable shows its current value or current setting. If the variable is nominal, the x-axis identifies categories. See “Interpreting the Profiles,” p. 538, for more details.

  For each $X$ variable, the value above the factor name is its current value. You change the current value by clicking in the graph or by dragging the dotted line where you want the new current value to be.

- The horizontal dotted line shows the current predicted value of each $Y$ variable for the current values of the $X$ variables.

- The black lines within the plots show how the predicted value changes when you change the current value of an individual $X$ variable. In fitting platforms, the 95% confidence interval for the predicted values is shown by a dotted blue curve surrounding the prediction trace (for continuous variables) or the context of an error bar (for categorical variables).

The **Profiler** is a way of changing one variable at a time and looking at the effect on the predicted response.
The **Profiler** in some situations computes confidence intervals for each profiled column. If you have saved both a standard error formula and a prediction formula for the same column, the **Profiler** offers to use the standard errors to produce the confidence intervals rather than profiling them as a separate column.

**Interpreting the Profiles**

The illustration in Figure 26.4 describes how to use the components of the **Profiler**. There are several important points to note when interpreting a prediction profile:

- The importance of a factor can be assessed to some extent by the steepness of the prediction trace. If the model has curvature terms (such as squared terms), then the traces may be curved.

- If you change a factor’s value, then its prediction trace is not affected, but the prediction traces of all the other factors can change. The \( Y \) response line must cross the intersection points of the prediction traces with their current value lines.

**Note:** If there are interaction effects or cross-product effects in the model, the prediction traces can shift their slope and curvature as you change current values of other terms. That is what interaction is all about. If there are no interaction effects, the traces only change in height, not slope or shape.
Prediction profiles are especially useful in multiple-response models to help judge which factor values can optimize a complex set of criteria.

Click on a graph or drag the current value line right or left to change the factor’s current value. The response values change as shown by a horizontal reference line in the body of the graph. When you click in the vertical axis, the X value at that point displays. Double-click in an axis to bring up a dialog that changes its settings.

**Thinking about Profiling as Cross-Sectioning**

In the following example using Tiretread.jmp, look at the response surface of the expression for MODULUS as a function of SULFUR and SILANE (holding SILICA constant). Now look at how a grid that cuts across SILANE at the SULFUR value of 2.3. Note how the slice intersects the surface. If you transfer that down below, it becomes the profile for SILANE. Similarly, note the grid across SULFUR at the SILANE value of 50. The intersection when transferred down to the SULFUR graph becomes the profile for SULFUR.
Figure 26.5 Profiler as a Cross-Section

Now consider changing the current value of SULFUR from 2.3 down to 1.5.
Figure 26.6 Profiler as a Cross-Section

In the Profiler, note the new value just moves along the same curve for SULFUR, the SULFUR curve itself doesn’t change. But the profile for SILANE is now taken at a different cut for SULFUR, and is a little higher and reaches its peak in the different place, closer to the current SILANE value of 50.

**Setting or Locking a Factor's Values**

If you Alt-click (Option-click on the Macintosh) in a graph, a dialog prompts you to enter specific settings for the factor.
For continuous variables, you can specify

- **Current Value** is the value used to calculate displayed values in the profiler, equivalent to the red vertical line in the graph.
- **Minimum Setting** is the minimum value of the factor's axis.
- **Maximum Value** is the maximum value of the factor's axis.
- **Number of Plotted Points** specifies the number of points used in plotting the factor's prediction traces.
- **Show** is a checkbox that allows you to show or hide the factor in the profiler.
- **Lock Factor Setting** locks the value of the factor at its current setting.

**Profiler Options**

The popup menu on the Profiler title bar has the following options:

- **Profiler** shows or hides the Profiler.
- **Contour Profiler** shows or hides the Contour Profiler.
- **Custom Profiler** shows or hides the Custom Profiler.
- **Mixture Profiler** shows or hides the Mixture Profiler.
- **Surface Profiler** shows or hides the Surface Profiler.

**Save As Flash (SWF)** allows you to save the Profiler (with reduced functionality) as an Adobe Flash file, which can be imported into presentation and web applications. An HTML page can be saved for viewing the Profiler in a browser. The **Save as Flash (SWF)** command is not available for categorical responses. For information on importing the Flash version of the Profiler into Microsoft PowerPoint, go to [www.jmp.com/support/swfhelp/en/powerpoint.shtml](http://www.jmp.com/support/swfhelp/en/powerpoint.shtml).

The Profiler will accept any JMP function, but the Flash Profiler only accepts the following functions: Add, Subtract, Multiply, Divide, Minus, Power, Root, Sqrt, Abs, Floor, Ceiling, Min, Max, Equal, Not Equal, Greater, Less, GreaterEqual, LessorEqual, Or, And, Not, Exp, Log, Log10, Sine, Cosine, Tangent, SinH, CosH, TanH, ArcSine, ArcCosine, ArcTangent, ArcSineH, ArcCosH, ArcTanH, Squish, If, Match, Choose.

- **Show Formulas** opens a JSL window showing all formulas being profiled.
- **Formulas for OPTMODEL** creates code for the OPTMODEL SAS procedure.
- **Script** has a submenu of commands available to all platforms that let you redo the analysis, or save the JSL commands for the analysis to a window or file.

The popup menu on the Prediction Profiler title bar has the following options:

- **Prop of Error Bars** appears under certain situations. See “Propagation of Error Bars,” p. 551.
- **Confidence Intervals** shows or hides the confidence intervals. The intervals are drawn by bars for categorical factors, and curves for continuous factors. These are available only when the profiler is used inside certain fitting platforms.
- **Sensitivity Indicator** shows or hides a purple triangle whose height and direction correspond to the value of the partial derivative of the profile function at its current value. This is useful in large profiles to be able to quickly spot the sensitive cells.
Desirability Functions  shows or hides the desirability functions, as illustrated by Figure 26.17 and Figure 26.18. Desirability is discussed in “Desirability Profiling and Optimization,” p. 546.

Maximize Desirability  sets the current factor values to maximize the desirability functions.

Maximization Options  allows you to refine the optimization settings through a dialog.

Maximize for Each Grid Point  can only be used if one or more factors are locked. The ranges of the locked factors are divided into a grid, and the desirability is maximized at each grid point. This is useful if the model you are profiling has categorical factors; then the optimal condition can be found for each combination of the categorical factors.

Save Desirabilities  saves the three desirability function settings for each factor, and the associated desirability values, as a Response Limits column property in the data table. These correspond to the coordinates of the handles in the desirability plots.
Set Desirabilities brings up a dialog where specific desirability values can be set.

Figure 26.10 Response Grid Window

Save Desirability Formula creates a column in the data table with a formula for Desirability. The formula uses the fitting formula when it can, or the response variables when it can’t access the fitting formula.

Reset Factor Grid displays a dialog for each value allowing you to enter specific values for a factor’s current settings. See the section “Setting or Locking a Factor’s Values,” p. 541 for details on these dialog boxes.

Factor Settings is a submenu that consists of the following options:

- **Remember Settings** adds an outline node to the report that accumulates the values of the current settings each time the Remember Settings command is invoked. Each remembered setting is preceded by a radio button that is used to reset to those settings.
- **Set To Data in Row** assigns the values of a data table row to the Profiler.
- **Copy Settings Script** and **Paste Settings Script** allow you to move the current Profiler’s settings to a Profiler in another report.
- **Append Settings to Table** appends the current profiler’s settings to the end of the data table. This is useful if you have a combination of settings in the Profiler that you want to add to an experiment in order to do another run.
- **Link Profilers** links all the profilers together, so that a change in a factor in one profiler causes that factor to change to that value in all other profilers, including Surface Plot. This is a global option, set or unset for all profilers.
- **Set Script** sets a script that is called each time a factor changes. The set script receives a list of arguments of the form
  \[
  \{factor1 = n1, factor2 = n2, \ldots\}
  \]
  For example, to write this list to the log, first define a function
  ```javascript
  ProfileCallbackLog = Function({arg},show(arg));
  ```
  Then enter ProfileCallbackLog in the Set Script dialog.
Similar functions convert the factor values to global values:

```
ProfileCallbackAssign = Function({arg},evalList(arg));
```

Or access the values one at a time:

```
ProfileCallbackAccess = Function({arg},f1=arg["f1"];f2=arg["f2"]);
```

**Output Grid Table** produces a new data table with columns for the factors that contain grid values, columns for each of the responses with computed values at each grid point, and the desirability computation at each grid point.

If you have a lot of factors, it is impractical to use the **Output Grid Table** command, since it produces a large table. In such cases, you should lock some of the factors, which are held at locked, constant values. To get the dialog to specify locked columns, Alt- or Option-click inside the profiler graph to get a dialog that has a **Lock Factor Setting** checkbox.

---

**Figure 26.11** Factor Settings Window

---

**Output Random Table** prompts for a number of runs and creates an output table with that many rows, with random factor settings and predicted values over those settings. This is equivalent to (but much simpler than) opening the Simulator, resetting all the factors to a random uniform distribution, then simulating output. This command is similar to **Output Grid Table**, except it results in a random table rather than a sequenced one.

The prime reason to make uniform random factor tables is to explore the factor space in a multivariate way using graphical queries. This technique is called **Filtered Monte Carlo**.

Suppose you want to see the locus of all factor settings that produce a given range of desirable response settings. By selecting and hiding the points that don’t qualify (using graphical brushing or the Data Filter), you see the possibilities of what is left: the opportunity space yielding the result you want.

**Alter Linear Constraints** allows you to add, change, or delete linear constraints. The constraints are incorporated into the operation of **Prediction Profiler**. See “Linear Constraints,” p. 555.

**Save Linear Constraints** allows you to save existing linear constraints to a Table Property/Script called **Constraint**. See “Linear Constraints,” p. 555.
**Default N Levels** allows you to set the default number of levels for each continuous factor. This option is useful when the Profiler is especially large. When calculating the traces for the first time, JMP measures how long it takes. If this time is greater than three seconds, you are alerted that decreasing the Default N Levels speeds up the calculations.

**Conditional Predictions** appears when random effects are included in the model. The random effects are shown and used in formulating the predicted value.

**Simulator** launches the Simulator. The Simulator enables you to create Monte Carlo simulations using random noise added to factors and predictions for the model. A typical use is to set fixed factors at their optimal settings, and uncontrolled factors and model noise to random values and find out the rate that the responses are outside the specification limits. For details see “The Simulator,” p. 572.

**Interaction Profiler** brings up interaction plots that are interactive with respect to the profiler values. This option can help visualize third degree interactions by seeing how the plot changes as current values for the terms are changed. The cells that change for a given term are the cells that do not involve that term directly.

### Desirability Profiling and Optimization

Often there are multiple responses measured and the desirability of the outcome involves several or all of these responses. For example, you might want to maximize one response, minimize another, and keep a third response close to some target value. In desirability profiling, you specify a desirability function for each response. The overall desirability can be defined as the geometric mean of the desirability for each response.

To use desirability profiling, select **Desirability Functions** from the **Prediction Profiler** red triangle menu.

**Note:** If the response column has a Response Limits property, desirability functions are turned on by default.

This command appends a new row to the bottom of the plot matrix, dedicated to graphing desirability. The row has a plot for each factor showing its desirability trace, as illustrated in Figure 26.12. It also adds a column that has an adjustable desirability function for each Y variable. The overall desirability measure shows on a scale of zero to one at the left of the row of desirability traces.
**About Desirability Functions**

The desirability functions are smooth piecewise functions that are crafted to fit the control points.

- The minimize and maximize functions are three-part piecewise smooth functions that have exponential tails and a cubic middle.
- The target function is a piecewise function that is a scale multiple of a normal density on either side of the target (with different curves on each side), which is also piecewise smooth and fit to the control points.

These choices give the functions good behavior as the desirability values switch between the maximize, target, and minimize values. For completeness, we implemented the upside-down target also.

JMP doesn't use the Derringer and Suich functional forms. Since they are not smooth, they do not always work well with JMP's optimization algorithm.

The control points are not allowed to reach all the way to zero or one at the tail control points.

**Using the Desirability Function**

To use a variable's desirability function, drag the function handles to represent a response value.

As you drag these handles, the changing response value shows in the area labeled Desirability to the left of the plots. The dotted line is the response for the current factor settings. The overall desirability shows to the left of the row of desirability traces. Alternatively, you can select Set Desirabilities to enter specific values for the points.
The next illustration shows steps to create desirability settings.

**Maximize**  The default desirability function setting is maximize (“higher is better”). The top function handle is positioned at the maximum Y value and aligned at the high desirability, close to 1. The bottom function handle is positioned at the minimum Y value and aligned at a low desirability, close to 0.

![Figure 26.13 Maximizing Desirability](image)

**Target**  You can designate a target value as “best.” In this example, the middle function handle is positioned at Y = 70 and aligned with the maximum desirability of 1. Y becomes less desirable as its value approaches either 45 or 95. The top and bottom function handles at Y = 45 and Y = 95 are positioned at the minimum desirability close to 0.

![Figure 26.14 Defining a Target Desirability](image)

**Minimize**  The minimize (“smaller is better”) desirability function associates high response values with low desirability and low response values with high desirability. The curve is the maximization curve flipped around a horizontal line at the center of plot.

![Figure 26.15 Minimizing Desirability](image)

**Note:** Dragging the top or bottom point of a maximize or minimize desirability function across the y-value of the middle point results in the opposite point reflecting, so that a Minimize becomes a Maximize, and vice versa.
The Desirability Profile

The last row of plots shows the desirability trace for each response. The numerical value beside the word Desirability on the vertical axis is the geometric mean of the desirability measures. This row of plots shows both the current desirability and the trace of desirabilities that result from changing one factor at a time.

For example, Figure 26.16 shows desirability functions for two responses. You want to maximize ABRASION and minimize MODULUS. The desirability plots indicate that you could increase the desirability by either lowering SILICA a little, or increasing SILANE or SULFUR.

Desirability Profiling for Multiple Responses

A desirability index becomes especially useful when there are multiple responses. The idea was pioneered by Derringer and Suich (1980), who give the following example. Suppose there are four responses, ABRASION, MODULUS, ELONG, and HARDNESS. Three factors, SILICA, SILANE, and SULFUR, were used in a central composite design.

The data are in the Tiretread.jmp table in the Sample Data folder. Use the RSM For 4 responses script in the data table, which defines a model for the four responses with a full quadratic response surface. The summary tables and effect information appear for all the responses, followed by the prediction profiler shown in Figure 26.17. The desirability functions are as follows:

1. Maximum ABRASION and maximum MODULUS are most desirable.
2. ELONG target of 500 is most desirable.
3. HARDNESS target of 67.5 is most desirable.
Select **Maximize Desirability** from the **Prediction Profiler** pop-up menu to maximize desirability. The results are shown in Figure 26.18. The desirability traces at the bottom decrease everywhere except the current values of the effects, which indicates that any further adjustment could decrease the overall desirability.
Propagation of Error Bars

Propagation of error (POE) is important when attributing the variation of the response in terms of variation in the factor values when the factor values are not very controllable.

In JMP’s implementation, the Profiler first looks at the factor and response variables to see if there is a Sigma column property (a specification for the standard deviation of the column, accessed through the Cols > Column Info dialog box). If the property exists, then the Prop of Error Bars command becomes accessible in the Prediction Profiler drop-down menu. This displays the 3σ interval that is implied on the response due to the variation in the factor.
The interval is calculated (assuming that the variation among the factors is uncorrelated) by

\[
\sum_{i=1}^{N} \left( \sigma_{x_i}^2 \times \left( \frac{\partial f}{\partial x_i} \right)^2 \right) + \sigma_y^2
\]

where \(f\) is the prediction function, \(x_i\) is the \(i\)th factor, and \(N\) is the number of factors.

Currently, these partial derivatives are calculated by numerical derivatives:

centered, with \(\delta = \text{xrange}/10000\)

POE limits increase dramatically in response surface models when you are over a more sloped part of the response surface. One of the goals of robust processes is to operate in flat areas of the response surface so that variations in the factors do not amplify in their effect on the response.

**Customized Desirability Functions**

It is possible to use a customized desirability function. For example, suppose you want to maximize using the following function.

**Figure 26.20** Maximizing Desirability Based on a Function

\[
\frac{\text{Pred Formula ABRASION}}{96} + \frac{\text{Pred Formula MODULUS}}{700} - \frac{33}{2} \left( \text{Pred Formula ELONG-450} + 1 \right) - \frac{1}{2} \left( \text{Pred Formula HARDNESS-67} + 1 \right)
\]
First, create a column called MyDesire that contains the above formula. Then, launch the Profiler using Graph > Profiler and include all the Pred Formula columns and the MyDesire column. Turn on the desirability functions by selecting Desirability Functions from the red-triangle menu. All the desirability functions for the individual effects must be turned off. To do this, first double-click in a desirability plot window, then select None in the dialog that appears (Figure 26.21). Set the desirability for MyDesire to be maximized.

Figure 26.21 Selecting No Desirability Goal

At this point, selecting Maximize Desirability uses only the custom MyDesire function.
Mixture Designs

When analyzing a mixture design, JMP constrains the ranges of the factors so that settings outside the mixture constraints are not possible. This is why, in some mixture designs, the profile traces appear to turn abruptly.

When there are mixture components that have constraints, other than the usual zero-to-one constraint, a new submenu, called Profile at Boundary, appears on the Prediction Profiler popup menu. It has the following two options:

- **Turn At Boundaries** lets the settings continue along the boundary of the restraint condition.
- **Stop At Boundaries** truncates the prediction traces to the region where strict proportionality is maintained.

---

**Figure 26.22 Maximized Custom Desirability**
Expanding Intermediate Formulas

The **Profiler** launch dialog has an **Expand Intermediate Formulas** checkbox. When this is checked, then when the formula is examined for profiling, if it references another column that has a formula containing references to other columns, then it substitutes that formula and profiles with respect to the end references—not the intermediate column references.

For example, when **Fit Model** fits a logistic regression for two levels (say A and B), the end formulas (\(\text{Prob}[A]\) and \(\text{Prob}[B]\)) are functions of the \(\text{Lin}[x]\) column, which itself is a function of another column \(x\). If **Expand Intermediate Formulas** is selected, then when \(\text{Prob}[A]\) is profiled, it is with reference to \(x\), not \(\text{Lin}[x]\).

In addition, using the **Expand Intermediate Formulas** checkbox enables the **Save Expanded Formulas** command in the platform red triangle menu. This creates a new column with a formula, which is the formula being profiled as a function of the end columns, not the intermediate columns.

Linear Constraints

The **Prediction Profiler**, **Custom Profiler** and **Mixture Profiler** can incorporate linear constraints into their operations. Linear constraints can be entered in two ways, described in the following sections.

**Pop-up Menu Item**

To enter linear constraints via the pop-up menu, select **Alter Linear Constraints** from either the **Prediction Profiler** or **Custom Profiler** pop-up menu.

Choose **Add Constraint** from the resulting dialog, and enter the coefficients into the appropriate boxes. For example, to enter the constraint \(p_1 + 2p_2 \leq 0.9\), enter the coefficients as shown in Figure 26.23. As shown, if you are profiling factors from a mixture design, the mixture constraint is present by default and cannot be modified.

![Figure 26.23 Enter Coefficients](image)

After you click **OK**, the **Profiler** updates the profile traces, and the constraint is incorporated into subsequent analyses and optimizations.

If you attempt to add a constraint for which there is no feasible solution, a message is written to the log and the constraint is not added. To delete a constraint, enter zeros for all the coefficients.
Constraints added in one profiler are not accessible by other profilers until saved. For example, if constraints are added under the Prediction Profiler, they are not accessible to the Custom Profiler. To use the constraint, you can either add it under the Custom Profiler pop-up menu, or use the Save Linear Constraints command described in the next section.

**Constraint Table Property/Script**

If you add constraints in one profiler and want to make them accessible by other profilers, use the Save Linear Constraints command, accessible through the platform pop-up menu. For example, if you created constraints in the Prediction Profiler, choose Save Linear Constraints under the Prediction Profiler pop-up menu. The Save Linear Constraints command creates or alters a Table Script called Constraint. An example of the Table Property is shown in Figure 26.24.

![Figure 26.24 Constraint Table Script](image)

The Constraint Table Property is a list of the constraints, and is editable. It is accessible to other profilers, and negates the need to enter the constraints in other profilers. To view or edit Constraint, right click on the pop-up menu and select Edit. The contents of the constraint from Figure 26.23 is shown below in Figure 26.25.

![Figure 26.25 Example Constraint](image)

The Constraint Table Script can be created manually by choosing New Script from the pop-up menu beside a table name.

**Note:** When creating the Constraint Table Script manually, the spelling must be exactly “Constraint”. Also, the constraint variables are case sensitive and must match the column name. For example, in Figure 26.25, the constraint variables are p1 and p2, not P1 and P2.

The Constraint Table Script is also created when specifying linear constraints when designing an experiment.
The `Alter Linear Constraints` and `Save Linear Constraints` commands are not available in the `Mixture Profiler`. To incorporate linear constraints into the operations of the `Mixture Profiler`, the `Constraint Table Script` must be created by one of the methods discussed in this section.

**Contour Profiler**

The `Contour Profiler` shows response contours for two factors at a time. The interactive contour profiling facility is useful for optimizing response surfaces graphically. Figure 26.26 shows an example of the Contour Profiler for the Tiretread sample data.

**Figure 26.26  Contour Profiler**

- There are slider controls and edit fields for both the $X$ and $Y$ variables.
- The `Current X` values generate the `Current Y` values. The `Current X` location is shown by the crosshair lines on the graph. The `Current Y` values are shown by the small red lines in the slider control.
- The other lines on the graph are the contours for the responses set by the $Y$ slider controls or by entering values in the `Contour` column. There is a separately colored contour for each response (4 in this example).
You can enter low and high limits to the responses, which results in a shaded region. To set the limits, you can click and drag from the side zones of the Y sliders or enter values in the Lo Limit or Hi Limit columns. If a response column's Spec Limits column property has values for Lower Spec Limit or Upper Spec Limit, those values are used as the initial values for Lo Limit and Hi Limit.

If you have more than two factors, use the radio buttons in the upper left of the report to switch the graph to other factors.

Right-click on the slider control and select Rescale Slider to change the scale of the slider (and the plot for an active X variable).

For each contour, there is a dotted line in the direction of higher response values, so that you get a sense of direction.

Right-click on the color legend for a response (under Response) to change the color for that response.

Contour Profiler Pop-up Menu

- **Grid Density** lets you set the density of the mesh plots (Surface Plots).
- **Graph Updating** gives you the options to update the Contour Profiler Per Mouse Move, which updates continuously, or Per Mouse Up, which waits for the mouse to be released to update. (The difference might not be noticeable on a fast machine.)
- **Surface Plot** hides or shows mesh plots.
- **Contour Label** hides or shows a label for the contour lines. The label colors match the contour colors.
- **Contour Grid** draws contours on the Contour Profiler plot at intervals you specify.
- **Factor Settings** is a submenu of commands that allows you to save and transfer the Contour Profiler’s settings to other parts of JMP. Details are in the section “Factor Settings,” p. 544.
- **Simulator** launches the Simulator. See “The Simulator,” p. 572.
- **Up Dots** shows or hides dotted lines corresponding to each contour. The dotted lines show the direction of increasing response values, so that you get a sense of direction.

Mixtures

For mixture designs, a Lock column appears in the **Contour Profiler** (Figure 26.27). This column allows you to lock settings for mixture values so that they are not changed when the mixture needs to be adjusted due to other mixture effects being changed. When locked columns exist, the shaded area for a mixture recognizes the newly restricted area.
Constraint Shading

Specifying limits to the Y’s shades the areas outside the limits as shown in Figure 26.28. The unshaded white area becomes the feasible region.

If a response column’s Spec Limits column property has values for Lower Spec Limit or Upper Spec Limit, those values are used as the initial values for Lo Limit and Hi Limit.
Mixture Profiler

The Mixture Profiler shows response contours for mixture experiment models, where three or more factors in the experiment are components (ingredients) in a mixture. The Mixture Profiler is useful for visualizing and optimizing response surfaces resulting from mixture experiments.

Figure 26.29 shows an example of the Mixture Profiler for the sample data in Plasticizer.jmp. To generate the graph shown, select Mixture Profiler from the Graph menu. In the resulting Mixture Profiler launch dialog, assign Pred Formula Y to the Y, Prediction Formula role and click OK. Delete the Lo and Hi limits from p1, p2, and p3.

Many of the features shown are the same as those of the Contour Profiler and are described on p. 558. Some of the features unique to the Mixture Profiler include:

- A ternary plot is used instead of a Cartesian plot. A ternary plot enables you to view three mixture factors at a time.
- If you have more than three factors, use the radio buttons at the top left of the Mixture Profiler window to graph other factors. For detailed explanation of radio buttons and plot axes, see “Explanation of Ternary Plot Axes,” p. 561.
- If the factors have constraints, you can enter their low and high limits in the Lo Limit and Hi Limit columns. This shades non-feasible regions in the profiler. As in Contour Plot, low and high limits can also be set for the responses.

Figure 26.29 Mixture Profiler
**Explanation of Ternary Plot Axes**

The sum of all mixture factor values in a mixture experiment is a constant, usually, and henceforth assumed to be 1. Each individual factor's value can range between 0 and 1, and three are represented on the axes of the ternary plot.

For a three factor mixture experiment in which the factors sum to 1, the plot axes run from a vertex (where a factor's value is 1 and the other two are 0) perpendicular to the other side (where that factor is 0 and the sum of the other two factors is 1). See Figure 26.30.

For example, in Figure 26.30, the proportion of \( p_1 \) is 1 at the top vertex and 0 along the bottom edge. The tick mark labels are read along the left side of the plot. Similar explanations hold for \( p_2 \) and \( p_3 \).

For an explanation of ternary plot axes for experiments with more than three mixture factors, see “More than Three Mixture Factors,” p. 561.

**Figure 26.30** Explanation of \( p_1 \) Axis.

---

**More than Three Mixture Factors**

The ternary plot can only show three factors at a time. If there are more than three factors in the model you are profiling, the total of the three on-axis (displayed) factors is 1 minus the total of the off-axis (non-displayed) factors. Also, the plot axes are scaled such that the maximum value a factor can attain is 1 minus the total for the off-axis factors.

For example Figure 26.31 shows the Mixture Profiler for an experiment with 5 factors. The Five Factor Mixture.jmp data table is being used, with the Y1 Predicted column as the formula. The on-axis factors are \( x_1, x_2 \) and \( x_3 \), while \( x_4 \) and \( x_5 \) are off-axis. The value for \( x_4 \) is 0.1 and the value for \( x_5 \) is 0.2, for a total of 0.3. This means the sum of \( x_1, x_2 \) and \( x_3 \) has to equal 1 – 0.3 = 0.7. In fact, their Current X values add to 0.7. Also, note that the maximum value for a plot axis is now 0.7, not 1.

If you change the value for either \( x_4 \) or \( x_5 \), then the values for \( x_1, x_2 \) and \( x_3 \) change, keeping their relative proportions, to accommodate the constraint that factor values sum to 1.
Mixture Profiler Options

The commands under the Mixture Profiler popup menu are explained below.

- **Ref Labels** shows or hides the labels on the plot axes.
- **Ref Lines** shows or hides the grid lines on the plot.
- **Show Points** shows or hides the design points on the plot. This feature is only available if there are no more than three mixture factors.
- **Show Current Value** shows or hides the three-way crosshairs on the plot. The intersection of the crosshairs represents the current factor values. The **Current X** values above the plot give the exact coordinates of the crosshairs.
- **Show Constraints** shows or hides the shading resulting from any constraints on the factors. Those constraints can be entered in the **Lo Limits** and **Hi Limits** columns above the plot, or in the Mixture Column Property for the factors.
- **Up Dots** shows or hides dotted line corresponding to each contour. The dotted lines show the direction of increasing response values, so that you get a sense of direction.
- **Contour Grid** draws contours on the plot at intervals you specify.
- **Remove Contour Grid** removes the contour grid if one is on the plot.
**Factor Settings** is a submenu of commands that allows you to save and transfer the Mixture Profiler settings to other parts of JMP. Details on this submenu are found in the discussion of the profiler on p. 544.

**Linear Constraints**

The Mixture Profiler can incorporate linear constraints into its operations. To do this, a Constraint Table Script must be part of the data table. See “Linear Constraints,” p. 555 for details on creating the Table Script.

When using constraints, unfeasible regions are shaded in the profiler. Figure 26.32 shows an example of a mixture profiler with shaded regions due to four constraints. The unshaded portion is the resulting feasible region. The constraints are below:

- \( 4p_2 + p_3 \leq 0.8 \)
- \( p_2 + 1.5p_3 \leq 0.4 \)
- \( p_1 + 2p_2 \geq 0.8 \)
- \( p_1 + 2p_2 \leq 0.95 \)

---

**Figure 26.32** Shaded Regions Due to Linear Constraints
Examples

Single Response

This example, adapted from Cornell (1990), comes from an experiment to optimize the texture of fish patties. The data is in Fish Patty.jmp. The columns Mullet, Sheepshead and Croaker represent what proportion of the patty came from that fish type. The column Temperature represents the oven temperature used to bake the patties. The column Rating is the response and is a measure of texture acceptability, where higher is better. A response surface model was fit to the data and the prediction formula was stored in the column Predicted Rating.

To launch the Mixture Profiler, select Graph > Mixture Profiler. Assign Predicted Rating to Y, Prediction Formula and click OK. The output should appear as in Figure 26.33.

The manufacturer wants the rating to be at least 5. Use the slider control for Predicted Rating to move the contour close to 5. Alternatively, you can enter 5 in the Contour edit box to bring the contour to a value of 5. Figure 26.34 shows the resulting contour.
The Up Dots shown in Figure 26.34 represent the direction of increasing Predicted Rating. Enter 5 in the Lo Limit edit box. The resulting shaded region shown in Figure 26.35 represents factor combinations that will yield a rating less than 5. To produce patties with at least a rating of 5, the manufacturer can set the factors values anywhere in the feasible (unshaded) region.

The feasible region represents the factor combinations predicted to yield a rating of 5 or more. Notice the region has small proportions of Croaker (<10%), mid to low proportions of Mullet (<70%) and mid to high proportions of Sheepshead (>30%).
Up to this point the fourth factor, Temperature, has been held at 400 degrees. Move the slide control for Temperature and watch the feasible region change.

Additional analyses may include:

- Simulate the response as a function of the random variation in the factors and model noise. See “The Simulator,” p. 572.

**Multiple Responses**

This example uses data from Five Factor Mixture.jmp. There are five continuous factors (x1–x5), one categorical factor (Type), and three responses, Y1, Y2 and Y3. A response surface model is fit to each response and the prediction equations are saved in Y1 Predicted, Y2 Predicted and Y3 Predicted.

Launch the Mixture Profiler and assign the three prediction formula columns to the Y, Prediction Formula role, then click OK. Enter 3 in the Contour edit box for Y3 Predicted so the contour shows on the plot. The output appears in Figure 26.36.
A few items to note about the output in Figure 26.36.

- All the factors appear at the top of the window. The mixture factors have low and high limits, which were entered previously as a Column Property. See Using JMP for more information about entering column properties. Alternatively, you can enter the low and high limits directly by entering them in the Lo Limit and Hi Limit boxes.
- Certain regions of the plot are shaded in gray to account for the factor limits.
- The on-axis factors, x1, x2 and x3, have radio buttons selected.
- The categorical factor, Type, has a radio button, but it cannot be assigned to the plot. The current value for Type is L1, which is listed immediately to the right of the Current X box. The Current X box for Type uses a 0 to represent L1.
- All three prediction equations have contours on the plot and are differentiated by color.

A manufacturer desires to hold Y1 less than 1, hold Y2 greater than 8 and hold Y3 between 4 and 5, with a target of 4.5. Furthermore, the low and high limits on the factors need to be respected. The Mixture Profiler can help you investigate the response surface and find optimal factor settings.

Start by entering the response constraints into the Lo Limit and Hi Limit boxes, as shown in Figure 26.37. Colored shading appears on the plot and designates unfeasible regions. The feasible region remains white (unshaded). Use the Response slider controls to position the contours in the feasible region.
The feasible region is small. Use the magnifier tool to zoom in on the feasible region shown with a box in Figure 26.37. The enlarged feasible region is shown in Figure 26.38.
The manufacturer wants to maximize $Y_1$, minimize $Y_2$ and have $Y_3$ at 4.5.

- Use the slider controls or Contour edit boxes for $Y_1$ Predicted to maximize the red contour within the feasible region. Keep in mind the Up Dots show direction of increasing predicted response.
- Use the slider controls or Contour edit boxes for $Y_2$ Predicted to minimize the green contour within the unshaded region.
- Enter 4.5 in the Contour edit box for $Y_3$ Predicted to bring the blue contour to the target value.

The resulting three contours don’t all intersect at one spot, so you will have to compromise. Position the three-way crosshairs in the middle of the contours to understand the factor levels that produce those response values.
As shown in Figure 26.39, the optimal factor settings can be read from the Current X boxes.

The factor values above hold for the current settings of x4, x5 and Type. Select Factor Settings > Remember Settings from the Mixture Profiler pop-up menu to save the current settings. The settings are appended to the bottom of the report window and appear as shown below.

With the current settings saved, you can now change the values of x4, x5 and Type to see what happens to the feasible region. You can compare the factor settings and response values for each level of Type by referring to the Remembered Settings report.
Chapter 26

Surface Profiler

The **Surface Profiler** shows a three-dimensional surface plot of the response surface. The functionality of **Surface Profiler** is the same as the **Surface Plot** platform, but with fewer options. Details of Surface Plots are found in the “Plotting Surfaces” chapter.

The Custom Profiler

The **Custom Profiler** allows you to optimize factor settings computationally, without graphical output. This is used for large problems that would have too many graphs to visualize well.

It has many fields in common with other profilers. The **Benchmark** field represents the value of the prediction formula based on current settings. Click **Reset Benchmark** to update the results.

The **Optimization** outline node allows you to specify the formula to be optimized and specifications about the optimization iterations. Click the **Optimize** button to optimize based on current settings.

![Custom Profiler Options](image)

**Custom Profiler Options**

- **Factor Settings**: is a submenu identical to the one covered on p. 544.
- **Log Iterations**: outputs iterations to a table.
- **Alter Linear Constraints**: allows you to add, change, or delete linear constraints. The constraints are incorporated into the operation of **Custom Profiler**. See “Linear Constraints,” p. 555.
- **Save Linear Constraints**: allows you to save existing linear constraints to a Table Property/Script called **Constraint**. See “Linear Constraints,” p. 555.
The Simulator

Simulation allows you to discover the distribution of model outputs as a function of the random variation in the factors and model noise. The simulation facility in the profilers provides a way to set up the random inputs and run the simulations, producing an output table of simulated values.

An example of this facility’s use would be to find out the defect rate of a process that has been fit, and see if it is robust with respect to variation in the factors. If specification limits have been set in the responses, they are carried over into the simulation output, allowing a prospective capability analysis of the simulated model using new factors settings.

In the Profiler, the Simulator is integrated into the graphical layout. Factor specifications are aligned below each factor’s profile. A simulation histogram is shown on the right for each response.

Figure 26.42 Profiler with Simulator
In the other profilers, the Simulator is less graphical, and kept separate. There are no integrated histograms, and the interface is textual. However, the internals and output tables are the same.

**Specifying Factors**

Factors (inputs) and responses (outputs) are already given roles by being in the Profiler. Additional specifications for the simulator are on how to give random values to the factors, and add random noise to the responses.

For each factor, the choices of how to give values are as follows:

- **Fixed** fixes the factor at the specified value. The initial value is the current value in the profiler, which may be a value obtained through optimization.

- **Random** gives the factor the specified distribution and distributional parameters.
  
  See the JMP User's Guide for descriptions of most of these random functions. If the factor is categorical, then the distribution is characterized by probabilities specified for each category, with the values normalized to sum to 1.

- **Normal weighted** is Normally distributed with the given mean and standard deviation, but a special stratified and weighted sampling system is used to simulate very rare events far out into the tails of the distribution. This is a good choice when you want to measure very low defect rates accurately. See “Statistical Details,” p. 606.

- **Normal truncated** is a normal distribution limited by lower and upper limits. Any random realization that exceeds these limits is discarded and the next variate within the limits is chosen. This is used to simulate an inspection system where inputs that do not satisfy specification limits are discarded or sent back.

- **Normal censored** is a normal distribution limited by lower and upper limits. Any random realization that exceeds a limit is just set to that limit, putting a density mass on the limits. This is used to simulate a re-work system where inputs that do not satisfy specification limits are reworked until they are at that limit.

- **Sampled** means that JMP picks values at random from that column in the data table.

- **External** means that JMP picks values at random from a column in another table. You are prompted to choose the table and column.

  The Aligned checkbox is used for two or more Sampled or External sources. When checked, the random draws come from the same row of the table. This is useful for maintaining the correlation structure between two columns. If the Aligned option is used to associate two columns in different tables, the columns must have equal number of rows.

In the Profiler, a graphical specification shows the form of the density for the continuous distributions, and provides control points that can be dragged to change the distribution. The drag points for the Normal are the mean and the mean plus or minus one standard deviation. The Normal truncated and censored add points for the lower and upper limits. The Uniform and Triangular have limit control points, and the Triangular adds the mode.
Expression allows you to write your own expression in JMP Scripting Language (JSL) form into a field. This gives you flexibility to make up a new random distribution. For example, you could create a censored normal distribution that guaranteed non-negative values with an expression like Max(0, RandomNormal(5,2)). In addition, character results are supported, so If(Random Uniform() < 0.2, “M”, “F”) works fine. After entering the expression, click the Reset button to submit the expression.

Multivariate allows you to generate a multivariate normal for when you have correlated factors. Specify the mean and standard deviation with the factor, and a correlation matrix separately.

Specifying the Response

If the model is only partly a function of the factors, and the rest of the variation of the response is attributed to random noise, then you will want to specify this with the responses. The choices are:

- **No Noise** just evaluates the response from the model, with no additional random noise added.
- **Add Random Noise** obtains the response by adding a normal random number with the specified standard deviation to the evaluated model.
- **Add Random Weighted Noise** is distributed like Add Random Noise, but with weighted sampling to enable good extreme tail estimates.
- **Add Multivariate Noise** yields a response as follows: A multivariate random normal vector is obtained using a specified correlation structure, and it is scaled by the specified standard deviation and added to the value obtained by the model.
Run the Simulation

Specify the number of runs in the simulation by entering it in the N Runs box.

After factor and response distributions are set, click the Simulate button to run the simulation.

Or, use the Make Table button to generate a simulation and output the results to a data table.

The table contains N Runs rows, simulated factor values from the specified distributions, and the corresponding response values. If spec limits are given, the table also contains a column specifying whether a row is in or out of spec.

The Simulator Menu

Automatic Histogram Update  toggles histogram update, which sends changes to all histograms shown in the Profiler, so that histograms update with new simulated values when you drag distribution handles.

Defect Profiler  shows the defect rate as an isolated function of each factor. This command is enabled when spec limits are available, as described below.

Defect Parametric Profile  shows the defect rate as an isolated function of the parameters of each factor’s distribution. It is enabled when the Defect Profiler is launched.

Simulation Experiment  is used to run a designed simulation experiment on the locations of the factor distributions. A dialog appears, allowing you to specify the number of design points, the portion of the factor space to be used in the experiment, and which factors to include in the experiment. For factors not included in the experiment, the current value shown in the Profiler is the one used in the experiment.

The experimental design is a Latin Hypercube. The output has one row for each design point. The responses include the defect rate for each response with spec limits, and an overall defect rate. After the experiment, it would be appropriate to fit a Gaussian Process model on the overall defect rate, or a root or a logarithm of it.

A simulation experiment does not sample the factor levels from the specified distributions. As noted above, the design is a Latin Hypercube. At each design point, N Runs random draws are generated with the design point serving as the center of the random draws, and the shape and variability coming from the specified distributions.

Spec Limits  shows or edits specification limits.

N Strata  is a hidden option accessible by holding down the Shift key before clicking the Simulator popup menu. This option allows you to specify the number of strata in Normal Weighted. For more information also see “Statistical Details,” p. 606.

Set Random Seed  is a hidden option accessible by holding down the Shift key before clicking the Simulator popup menu. This option allows you to specify a seed for the simulation starting point. This enables the simulation results to be reproducible, unless the seed is set to zero. The seed is set to zero by default. If the seed is non-zero, then the latest simulation results are output if the Make Table button is clicked.
Using Specification Limits

The profilers support specification limits on the responses, providing a number of features:

- In the Profiler, if you don't have the Response Limits property set up in the input data table to provide desirability coordinates, JMP looks for a Spec Limits property and constructs desirability functions appropriate to those Spec Limits.

- If you use the Simulator to output simulation tables, JMP copies Spec Limits to the output data tables, making accounting for defect rates and capability indices easy.

- Adding Spec Limits enables a feature called the Defect Profiler.

In the following example, we assume that the following Spec Limits have been specified.

**Table 26.3 Spec Limits for Tiretread.jmp data table**

<table>
<thead>
<tr>
<th>Response</th>
<th>LSL</th>
<th>USL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abrasion</td>
<td>110</td>
<td></td>
</tr>
<tr>
<td>Modulus</td>
<td></td>
<td>2000</td>
</tr>
<tr>
<td>Elong</td>
<td>350</td>
<td>550</td>
</tr>
<tr>
<td>Hardness</td>
<td>66</td>
<td>74</td>
</tr>
</tbody>
</table>

To set these limits in the data table, highlight a column and select Cols > Column Info. Then, click the Column Properties button and select the Spec Limits property.

If you are already in the Simulator in a profiler, another way to enter them is to use the Spec Limits command in the Simulator pop-up menu.

**Figure 26.45 Spec Limits**

After entering the spec limits, they are incorporated into the profilers. Click the Save button if you want the spec limits saved back to the data table as a column property.

With these specification limits, and the distributions shown in Figure 26.42, click the Simulate button. Notice the spec limit lines in the output histograms.
Look at the histogram for Abrasion. The lower spec limit is far above the distribution, yet the Simulator is able to estimate a defect rate for it. This despite only having 5000 runs in the simulation. It can do this rare-event estimation when you use a Normal weighted distribution.

Note that the Overall defect rate is close to the defect rate for Hardness, indicating that most of the defects are in the Hardness variable.

To see this weighted simulation in action, click the Make Table button and examine the Weight column. JMP generates extreme values for the later observations, using very small weights to compensate. Since the Distribution platform handles frequencies better than weights, there is also a column of frequencies, which is simply the weights multiplied by $10^{12}$.

The output data set contains a Distribution script appropriate to analyze the simulation data completely with a capability analysis.

**Simulating General Formulas**

Though the profiler and simulator are designed to work from formulas stored from a model fit, they work for any formula that can be stored in a column. A typical application of simulation is to exercise financial models under certain probability scenarios to obtain the distribution of the objectives. This can be done in JMP—the key is to store the formulas into columns, set up ranges, and then conduct the simulation.
The following JSL script creates the data table below with some initial scaling data and stores formulas into the output variables. It also launches the Profiler.

```julia
dt = newTable("Sales Model");
dt<<newColumn("Unit Sales",Values({1000,2000}));
dt<<newColumn("Unit Price",Values({2,4}));
dt<<newColumn("Unit Cost",Values({2,2.5}));
dt<<newColumn("Revenue",Formula(:Unit Sales*:Unit Price));
dt<<newColumn("Total Cost",Formula(:Unit Sales*:Unit Cost + 1200));
dt<<newColumn("Profit",Formula(:Revenue-:Total Cost), Set Property("Spec Limits",{LSL(0)}));
Profiler(Y(:Revenue,:Total Cost,:Profit), Objective Formula(Profit));
```

**Figure 26.47** Data Table Created from Script

<table>
<thead>
<tr>
<th>Inputs (Factors)</th>
<th>Outputs (Responses)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Sales</td>
<td>random uniform between 1000 and 2000</td>
</tr>
<tr>
<td>Unit Price</td>
<td>fixed</td>
</tr>
<tr>
<td>Unit Cost</td>
<td>random normal with mean 2.25 and std dev 0.1</td>
</tr>
<tr>
<td>Revenue</td>
<td>formula: Unit Sales*Unit Price</td>
</tr>
<tr>
<td>Total Cost</td>
<td>formula: Unit Sales*Unit Cost + 1200</td>
</tr>
<tr>
<td>Profit</td>
<td>formula: Revenue – Total Cost</td>
</tr>
</tbody>
</table>

Once they are created, select the **Simulator** from the **Prediction Profiler**. Use the specifications from Table 26.4 “Factors and Responses for a Financial Simulation,” p. 578 to fill in the Simulator.
Now, run the simulation which produces the following histograms in the **Profiler**.

It looks like we are not very likely to be profitable. By putting a lower specification limit of zero on **Profit**, the defect report would say that the probability of being unprofitable is 62%.

So we raise the **Unit Price** to $3.25 and rerun the simulation. Now the probability of being unprofitable is down to about 21%.
If unit price can’t be raised anymore, you should now investigate lowering your cost, or increasing sales, if you want to further decrease the probability of being unprofitable.

### The Defect Profiler

The defect profiler shows the probability of an out-of-spec output defect as a function of each factor, while the other factors vary randomly. This is used to help visualize which factor’s distributional changes the process is most sensitive to, in the quest to improve quality and decrease cost.

Specification limits define what is a defect, and random factors provide the variation to produce defects in the simulation. Both need to be present for a Defect Profile to be meaningful.

At least one of the Factors must be declared **Random** for a defect simulation to be meaningful, otherwise the simulation outputs would be constant. These are specified though the simulator Factor specifications.

**Important:** If you need to estimate very small defect rates, use **Normal weighted** instead of just **Normal**. This allows defect rates of just a few parts per million to be estimated well with only a few thousand simulation runs.

### About Tolerance Design

**Tolerance Design** is the investigation of how defect rates on the outputs can be controlled by controlling variability in the input factors.

The input factors have variation. Specification limits are used to tell the supplier of the input what range of values are acceptable. These input factors then go into a process producing outputs, and the customer of the outputs then judges if these outputs are within an acceptable range.

Sometimes, a Tolerance Design study shows that spec limits on input are unnecessarily tight, and loosening these limits results in cheaper product without a meaningful sacrifice in quality. In these cases, Tolerance Design can save money.

In other cases, a Tolerance Design study may find that either tighter limits or different targets result in higher quality. In all cases, it is valuable to learn which inputs the defect rate in the outputs are most sensitive to.

This graph shows the defect rate as a function of each factor as if it were a constant, but all the other factors varied according to their random specification. If there are multiple outputs with Spec Limits, then there is a defect rate curve color-coded for each output. A black curve shows the overall defect rate—this curve is above all the colored curves.
Graph Scale

Defect rates are shown on a cubic root scale, so that small defect rates are shown in some detail even though large defect rates may be visible. A log scale is not used because zero rates are not uncommon and need to be shown.

Expected Defects

Reported below each defect profile plot is the mean and standard deviation (SD). The mean is the overall defect rate, calculated by integrating the defect profile curve with the specified factor distribution.

In this case, the defect rate that is reported below all the factors is estimating the same quantity, the rate estimated for the overall simulation below the histograms (i.e. if you clicked the Simulate button). Since each estimate of the rate is obtained in a different way, they may be a little different. If they are very different, you may need to use more simulation runs. In addition, check that the range of the factor scale is wide enough so the integration covers the distribution well.

The standard deviation is a good measure of the sensitivity of the defect rates to the factor. It is quite small if either the factor profile were flat, or the factor distribution has a very small variance. Comparing SD’s across factors is a good way to know which factor should get more attention to reducing variation.

The mean and SD are updated when you change the factor distribution. This is one way to explore how to reduce defects as a function of one particular factor at a time. You can click and drag a handle point on the factor distribution, and watch the mean and SD change as you drag. However, changes are not updated across all factors until you click the Rerun button to do another set of simulation runs.
Simulation Method and Details

Assume we want a defect profile for factor $X_1$, in the presence of random variation in $X_2$ and $X_3$. A series of $n=\text{N Runs}$ simulation runs is done at each of $k$ points in a grid of equally spaced values of $X_1$. ($k$ is generally set at 17). At each grid point, suppose that there are $m$ defects due to the specification limits. At that grid point, the defect rate is $m/n$. With normal weighted, these are done in a weighted fashion. These defect rates are connected and plotted as a continuous function of $X_1$.

Notes

Recalculation  The profile curve is not recalculated automatically when distributions change, though the expected value is. It is done this way because the simulations could take a while to run.

Limited goals  Profiling does not address the general optimization problem, that of optimizing quality against cost, given functions that represent all aspects of the problem. This more general problem would benefit from a surrogate model and space filling design to explore this space and optimize to it.

Jagged Defect Profiles  The defect profiles tend to get uneven when they are low. This is due to exaggerating the differences for low values of the cubic scale. If the overall defect curve (black line) is smooth, and the defect rates are somewhat consistent, then you are probably taking enough runs. If the Black line is jagged and not very low, then increase the number of runs. 20,000 runs is often enough to stabilize the curves.

Defect Profiler Example

To show a common workflow with the Defect profiler, we use Tires.jsmp with the specification limits from Table 26.3. We also give the following random specifications to the three factors.

Select Defect Profiler to see the defect profiles. The curves, Means, and SDs will change from simulation to simulation, but will be relatively consistent.
The black curve on each factor shows the defect rate if you could fix that factor at the $x$-axis value, but leave the other features random.

Look at the curve for SILICA. As its values vary, its defect rate goes from the lowest 0.001 at SILICA=0.95, quickly up to a defect rate of 1 at SILICA=0.4 or 1.8. However, SILICA is itself random. If you imagine integrating the density curve of SILICA with its defect profile curve, you could estimate the average defect rate 0.033, also shown as the Mean for SILICA. This is estimating the overall defect rate shown under the simulation histograms, but by numerically integrating, rather than by the overall simulation. The Means for the other factors are similar. The numbers are not exactly the same. However, we now also get an estimate of the standard deviation of the defect rate with respect to the variation in SILICA. This value (labeled SD) is 0.055. The standard deviation is intimately related to the sensitivity of the defect rate with respect to the distribution of that factor.

Looking at the SDs across the three factors, we see that the SD for SULFUR is higher than the SD for SILICA, which is in turn much higher than the SD for SILANE. This means that to improve the defect rate, improving the distribution in SULFUR should have the greatest effect. A distribution can be improved in three ways: changing its mean, changing its standard deviation, or by chopping off the distribution by rejecting parts that don’t meet certain specification limits.

In order to visualize all these changes, there is another command in the Simulator pop-up menu, Defect Parametric Profile, which shows how single changes in the factor distribution parameters affect the defect rate.
Let's look closely at the SULFUR situation. You may need to enlarge the graph to see more detail.

First, note that the current defect rate (0.03) is represented in four ways corresponding to each of the four curves.

For the red curve, Mean Shift, the current rate is where the red solid line intersects the vertical red dotted line. The Mean Shift curve represents the change in overall defect rate by changing the mean of SULFUR. One opportunity to reduce the defect rate is to shift the mean slightly to the left. If you use the crosshair tool on this plot, you see that a mean shift reduces the defect rate to about 0.02.

For the blue curve, Std Narrow, the current rate represents where the solid blue line intersects the two dotted blue lines. The Std Narrow curves represent the change in defect rate by changing the standard deviation of the factor. The dotted blue lines represent one standard deviation below and above the current mean. The solid blue lines are drawn symmetrically around the center. At the center, the blue line typically reaches a minimum, representing the defect rate for a standard deviation of zero. That is, if we totally eliminate variation in SULFUR, the defect rate is still around 0.003. This is much better than 0.03. If you look at the other Defect parametric profile curves, you can see that this is better than reducing variation in the other factors, something we suspected by the SD value for SULFUR.

For the green curve, LSL Chop, there are no interesting opportunities in this example, because the green curve is above current defect rates for the whole curve. This means that reducing the variation by rejecting parts with too-small values for SULFUR will not help.
For the orange curve, USL Chop, there are good opportunities. Reading the curve from the right, the curve starts out at the current defect rate (0.03), then as you start rejecting more parts by decreasing the USL for SULFUR, the defect rate improves. However, moving a spec limit to the center is equivalent to throwing away half the parts, which may not be a practical solution.

Looking at all the opportunities over all the factors, it now looks like there are two good options for a first move: change the mean of SILICA to about 1, or reduce the variation in SULFUR. Since it is generally easier in practice to change a process mean than process variation, the best first move is to change the mean of SILICA to 1.

Figure 26.55 Adjusting the Mean of Silica

After changing the mean of SILICA, all the defect curves become invalid and need to be rerun. After clicking Rerun, we get a new perspective on defect rates.

Figure 26.56 Adjusted Defect Rates
Now, the defect rate is down to about 0.004, much improved. Further reduction in the defect rate can occur by continued investigation of the parametric profiles, making changes to the distributions, and rerunning the simulations.

As the defect rate is decreased further, the mean defect rates across the factors become relatively less reliable. The accuracy could be improved by reducing the ranges of the factors in the Profiler a little so that it integrates the distributions better.

This level of fine-tuning is probably not practical, because the experiment that estimated the response surface is probably not at this high level of accuracy. Once the ranges have been refined, you may need to conduct another experiment focusing on the area that you know is closer to the optimum.

**Stochastic Optimization Example**

This example is adapted from Box and Draper (1987) and uses Stochastic Optimization.jmp. A chemical reaction converts chemical “A” into chemical “B”. The resulting amount of chemical “B” is a function of reaction time and reaction temperature. A longer time and hotter temperature result in a greater amount of “B”. But, a longer time and hotter temperature also result in some of chemical “B” getting converted to a third chemical “C”. What reaction time and reaction temperature will maximize the resulting amount of “B” and minimize the amount of “A” and “C”? Should the reaction be fast and hot, or slow and cool?

**Figure 26.57 Chemical Reaction**

![Chemical Reaction Diagram]

The goal is to maximize the resulting amount of chemical “B”. One approach is to conduct an experiment and fit a response surface model for reaction yield (amount of chemical “B”) as a function of time and temperature. But, due to well known chemical reaction models, based on the Arrhenius laws, the reaction yield can be directly computed. The column Yield contains the formula for yield. The formula is a function of Time (hours) and reaction rates $k_1$ and $k_2$. The reaction rates are a function of reaction Temperature (degrees Kelvin) and known physical constants $\theta_1$, $\theta_2$, $\theta_3$, $\theta_4$. Therefore, Yield is a function of Time and Temperature.

**Figure 26.58 Formula for Yield**

\[
\frac{k_1 \times (\exp(-k_1 \times \text{Time}) - \exp(-k_2 \times \text{Time}))}{(k_2 - k_1)}
\]
You can use the **Profiler** to find the maximum **Yield**. Open Stochastic Optimization.jmp and run the attached script called **Profiler**. Profiles of the response are generated as follows.

**Figure 26.59** Profile of Yield

To maximize **Yield** use a desirability function. See “Desirability Profiling and Optimization,” p. 546. One possible desirability function was incorporated in the script. To view the function choose **Desirability Functions** from the **Prediction Profiler** pop-up menu.

**Figure 26.60** Prediction Profiler

From this point on, the desirability function will be hidden.

To maximize **Yield**, select **Maximize Desirability** from the **Prediction Profiler** pop-up menu. The Profiler then maximizes **Yield** and sets the graphs to the optimum value of **Time** and **Temperature**.
Chapter 26

The Simulator

Figure 26.61  Yield Maximum

The maximum Yield is approximately 0.62 at a Time of 0.116 hours and Temperature of 539.94 degrees Kelvin, or hot and fast. [Your results may differ slightly due to random starting values in the optimization process. Optimization settings can be modified (made more stringent) by selecting Maximization Options from the Prediction Profiler pop-up menu. Decreasing the Convergence Tolerance will enable the solution to be reproducible.]

In a production environment, process inputs can’t always be controlled exactly. What happens to Yield if the inputs (Time and Temperature) have random variation? Furthermore, if Yield has a spec limit, what percent of batches will be out of spec and need to be discarded? The Simulator can help us investigate the variation and defect rate for Yield, given variation in Time and Temperature.

Select Simulator from the Prediction Profiler pop-up menu. As shown in Figure 26.62, fill in the factor parameters so that Temperature is Normal weighted with standard deviation of 1, and Time is Normal weighted with standard deviation of 0.03. The Mean parameters default to the current factor values. Change the number of runs to 15,000. Yield has a lower spec limit of 0.55, set as a column property, and shows on the chart as a red line. If it doesn’t show by default, enter it by selecting Spec Limits on the Simulator pop-up menu.
With the random variation set for the input factors, you are ready to run a simulation to study the resulting variation and defect rate for Yield. Click the **Simulate** button.

---

**Figure 26.62** Initial Simulator Settings

![Diagram of the Initial Simulator Settings](image)

- **LSL** = 0.55
- **Mean** = factor value
- **Number of runs** = 15,000

---

**Figure 26.63** Simulation Results

![Diagram of the Simulation Results](image)

- **Defective batches below specification**
- **Defect rate** = 5.8%
- **Mean and standard deviation**
The predicted Yield is 0.62, but if the factors have the given variation, the average Yield is 0.60 with a standard deviation of 0.03.

The defect rate is about 5.7%, meaning that about 5.7% of batches are discarded. A defect rate this high is not acceptable.

What is the defect rate for other settings of Temperature and Time? Suppose you change the Temperature to 535, then set Time to the value that maximizes Yield? Enter settings as shown in Figure 26.64 then click Simulate.

Figure 26.64 Defect Rate for Temperature of 535

The defect rate decreases to about 1.8%, which is much better than 5.8%. So, what you see is that the fixed (no variability) settings that maximize Yield are not the same settings that minimize the defect rate in the presence of factor variation.

By running a Simulation Experiment you can find the settings of Temperature and Time that minimize the defect rate. To do this you simulate the defect rate at each point of a Temperature and Time design, then fit a predictive model for the defect rate and minimize it.

Before running the Simulation Experiment, save the factor settings that maximize Yield so you can reference them later. To do this, re-enter the factor settings (Mean and SD) from Figure 26.62 and select Factor Settings > Remember Settings from Prediction Profiler pop-up menu. A dialog prompts you to name the settings then click OK. The settings are appended to the report window.

Figure 26.65 Remembered Settings
Select **Simulation Experiment** from the **Simulator** pop-up menu. Enter 80 runs, and 1 to use the whole factor space in the experiment. A Latin Hypercube design with 80 design points is chosen within the specified factor space, and **N Runs** random draws are taken at each of the design points. The design point are the center of the random draws, and the shape and variance of the random draws coming from the factor distributions.

A table is created with the results of the experiment. The **Overall Defect Rate** is given at each design point. You can now fit a model that predicts the defect rate as a function of **Temperature** and **Time**. To do this, run the attached **Gaussian Process** script and wait for the results. The results are shown below. Your results will be slightly different due to the random draws in the simulation.

---

**Figure 26.66** Results of Gaussian Process Model Fit

---
The **Gaussian Process** platform automatically starts the **Prediction Profiler**. The desirability function is already set up to minimize the defect rate. To find the settings of Temperature and Time that minimizes the defect rate, select **Maximize Desirability** from the **Prediction Profiler** pop-up menu.

**Figure 26.67** Settings for Minimum Defect Rate

The settings that minimize the defect rate are approximately \( \text{Temperature} = 527 \) and \( \text{Time} = 0.27 \). Select **Factor Settings > Copy Settings Script** from the **Prediction Profiler** pop-up menu. Return to the original **Profiler** report window and select **Factor Settings > Paste Settings Script**. This sets **Temperature** and **Time** to those settings that minimize the defect rate. Use **Remember Settings** as before to save these new settings.

**Figure 26.68** Minimum Defect Settings

With the new settings in place, click the **Simulate** button to estimate the defect rate at the new settings.
Figure 26.69 Lower Defect Rate

At the new settings the defect rate is 0.065%, much better than the 5.7% for the settings that maximize Yield. That is a reduction of about 100x. Recall the average Yield from the first settings is 0.60 and the new average is 0.59. The decrease in average Yield of 0.01 is very acceptable when the defect rate decreases by 100x.

Because we saved the settings using Remember Settings, we can easily compare the old and new settings by selecting the radio buttons.
The chemist now knows what settings to use for a quality process. If the factors have no variation, the settings for maximum \textit{Yield} are hot and fast. But, if the process inputs have variation similar to what we've simulated, the settings for maximum \textit{Yield} produce a high defect rate. Therefore, to minimize the defect rate in the presence of factor variation, the settings should be cool and slow.

\section*{Noise Factors (Robust Engineering)}

Robust process engineering enables you to produce acceptable products reliably, despite variation in the process variables. Even when your experiment has controllable factors, there is a certain amount of uncontrollable variation in the factors that affects the response. This is called \textit{transmitted variation}. Factors with this variation are called \textit{noise factors}. Some factors you can't control at all, like environmental noise factors. Some factors can have their mean controlled, but not their standard deviation. This is often the case for intermediate factors that are output from a different process or manufacturing step.

A good approach to making the process robust is to match the target at the flattest place of the noise response surface so that the noise has little influence on the process. Mathematically, this is the value where the first derivatives of each response with respect to each noise factor are zero. JMP, of course, computes the derivatives for you.

To analyze a model with noise factors,

- Fit the appropriate model (using, for example, the \textbf{Fit Model} platform).
- Save the model to the data table with the \textbf{Save > Prediction Formula} command.
Launch the **Profiler** (from the **Graph** menu).

Assign the prediction formula to the **Y, Prediction Formula** role and the noise factors to the **Noise Factor** role.

Click **OK**.

The resulting profiler shows response functions and their appropriate derivatives with respect to the noise factors, with the derivatives set to have maximum desirability at zero.

Select **Maximize Desirability** from the **Profiler** menu.

This finds the best settings of the factors, balanced with respect to minimizing transmitted variation from the noise factors.

**Example**

As an example, use the **Tiretread.jmp** sample data set. This data set shows the results of a tire manufacturer's experiment whose objective is to match a target value of **HARDNESS** = 67.5 based on three factors: **SILICA**, **SILANE**, and **SULFUR** content. Suppose the **SILANE** and **SULFUR** content are easily (and precisely) controllable, but **SILICA** expresses variability that is worth considering.

For comparison, first optimize the factors for hardness without considering variation from the noise factor.

Select **Graph > Profiler** to launch the **Profiler**.

Assign **Pred Formula HARDNESS** to the **Y, Prediction Formula** role. Click **OK**.

Select **Desirability Functions** in the Prediction Profiler menu.

Double-click in the Desirability plot to open the Response Goal window. Change the pull-down menu to **Match Target**.

Select **Maximize Desirability** to find the optimum factor settings for our target value of **HARDNESS**.

We get the following **Profiler** display. Notice that the **SILICA** factor’s optimum value is on a sloped part of a profile curve. This means that variations in **SILICA** are transmitted to become variations in the response, **HARDNESS**.

**Note:** You may get different results from these because different combinations of factor values can all hit the target.
Now, we would like to not just optimize for a specific target value of HARDNESS, but also be on a flat part of the curve with respect to Silica. So, repeat the process and add SILICA as a noise factor.

1. Select Graph > Profiler.
2. Select Pred Formula HARDNESS and click Y, Prediction Formula.
3. Select SILICA and click Noise Factors.
4. Click OK.
5. Change the Pred Formula Hardness desirability function as before.

The resulting profiler has the appropriate derivative of the fitted model with respect to the noise factor, set to be maximized at zero, its flattest point.
6. Select **Maximize Desirability** to find the optimum values for the process factor, balancing for the noise factor.

This time, we have also hit the targeted value of **HARDNESS**, but our value of **SILICA** is on its flatter region. This means variation in **SILICA** will not transmit as much variation to **HARDNESS**.
You can easily see the effect this has on the variance of the predictions by following these steps for each profiler (one without the noise factor, and one with the noise factor):

1. Select **Simulator** from the platform menu.
2. Assign **SILICA** to have a random Normal distribution with a standard deviation of 0.05.
3. Click **Simulate**.
4. Click the **Make Table** button under the **Simulate to Table** node.

Doing these steps for both the original and noise-factor-optimal simulations results in two similar data tables, each holding a simulation. In order to make two comparable histograms of the predictions, we need the two prediction columns in a single data table.

5. Copy the **Pred Formula HARDNESS** column from one of the simulation tables into the other table. They must have different names, like **Without Noise Factor** and **With Noise Factor**.

6. Select **Analyze > Distribution** and assign both prediction columns as **Y**.

7. When the histograms appear, select **Uniform Scaling** from the **Distribution** main title bar.
The histograms show that there is much more variation in Hardness when the noise factor was not included in the analysis.

It is also interesting to note the shape of the histogram when the noise factor was included. In the comparison histograms above, note that the With Noise Factor distribution only has data trailing off in one direction. The predictions are skewed because Hardness is at a minimum with respect to SILICA, as shown in Figure 26.76. Therefore, variation in SILICA can only make HARDNESS increase. When the non-robust solution is used, the variation could be transmitted either way.

**Other Platforms**

Noise factor optimization is also available in the Contour Profiler, Custom Profiler, and Mixture Profiler.
Profiling Models Stored in Excel

The JMP Add-In for Excel lets you use the JMP Profiler to visualize models (formulas) stored in Excel worksheets. The add-in is automatically installed when you install JMP.

The Excel Model

An Excel model is simply one or more Excel formulas. Each formula must be a function of one or more other cells. As a simple example of an Excel formula, open the Demand.xls file from the Sample Import Data folder, usually located at C:\Program Files\SAS\JMP\9\Support Files English.

![Figure 26.77 Demand Model in Excel](image)

The formula is in cell B8, and is a calculation of the Overall Cost associated with having different amounts of product in stock. The formula can be seen in the Formula Bar, and is a function of four cells:

- **Amount Stocked** is the amount of product in stock.
- **Demand** is the customer demand for the product.
- **Air Freight** is the cost per unit to ship additional product by air when the demand exceeds the amount in stock.
- **Expiration Cost** is the cost per unit of disposing of unused product when the demand is less than the amount in stock.

The calculations of the formula are as follows:

- If **Amount Stocked** is less than **Demand**, then the company has to ship additional units, at a cost of \((\text{Demand}-\text{Amount Stocked}) \times \text{Air Freight}\). For example, if the demand is 8, but the company has only 6 in stock, then it has to ship 8-6=2 units at a cost of 2\(\times150=300\).
- If **Amount Stocked** is greater than **Demand**, then the company has to dispose of unused product, at a cost of \((\text{Amount Stocked}-\text{Demand}) \times \text{Expiration Cost}\). For example, if the demand is 5, but the company has 8 in stock, then it has to dispose of 8-5=3 units at a cost of 3\(\times50=150\).
If Amount Stocked is equal to Demand, then there is no shipping cost or disposal cost.

There is never both a shipping cost and a disposal cost at the same time.

Using the model in Excel, you can get the cost for only a given set of inputs at once. It is difficult to visualize how changing the value of one input affects the output. You can choose a different combination of the inputs to see how the cost is affected, but doing so for many combinations can take a long time.

Use the JMP Profiler to simultaneously see the effect of all inputs on the output. Also, you can quickly simulate a range of input combinations to see the resulting range of output values.

Using the JMP Add-In for Profiling

The JMP Add-In for Excel is installed in the following areas of Excel, depending on the version of Office that you have:

- In Excel 2010, all options are on the JMP ribbon.
- In Excel 2007, all options are on the JMP ribbon. (See Figure 26.78.)
- In Excel 2003, the menu is in the toolbar on a JMP button that produces a menu of options.

Profiling an Excel model is a two step process:

1. Use the Edit / New Model button to enter information about the model that JMP needs. This needs to be done only once per model. For details, see “Entering the Model Information,” p. 603.
2. Click the Run Model button to launch the JMP Profiler and run the Excel model. For details, see “Running the JMP Profiler,” p. 604.

Note: The Preferences, Data Table, Graph Builder, and Distribution buttons are not needed to profile an Excel model. Full details about these features are given in the Using JMP book.


**Entering the Model Information**

Before you can profile an Excel model, you must provide the information about the model that JMP needs. To do so, click the *Edit / New Model* button to open the Define Model window shown in Figure 26.79.

**Figure 26.79 Define Model Window**

---

Start and Name the Model

1. Click the + button at the top of the window.
2. Enter the name of the model.

Add the Inputs

1. Click the + button in the Inputs section.
2. Enter the name in the Input Name box, or click Choose to select a cell from the worksheet.
3. Click Choose next to Cell to select the cell that is an input to the formula.
4. Change the Minimum, Maximum, and Initial values, if you need to. These values define the initial plot ranges shown in the profiler.
5. Click Apply in the Inputs section.
6. Repeat steps 1-5 until you are finished adding inputs.
Add the Outputs
1. Click the + button in the Outputs section.
2. Enter the name in the Output Name box, or click Choose to select a cell from the worksheet.
3. Click Choose next to Cell to select the cell that contains the formula.
4. Click Apply in the Outputs section.
5. Repeat steps 1-4 until you are finished adding outputs.
Figure 26.80 shows a completed Define Model window.

Figure 26.80 Completed Define Model Window

After all information is entered for the inputs and outputs, click OK.

Note: When you save the .xls file in Word 2007, you might see a compatibility error. If so, click Continue to save the file.

Running the JMP Profiler

Follow these steps to run the model in the JMP Profiler.
1. Click Run Model.
2. Select the model that you want to use from the Model list.
3. Click Profile in JMP.

As shown in Figure 26.81, the model is run in the Profiler.

![Figure 26.81 Example of the Profiler Using Excel Models](image)

JMP runs a hidden copy of Excel in the background to drive all the Profiler calculations. Using a hidden copy ensures that the original Excel spreadsheet is not changed.

The Default N Levels option on the red-triangle menu affects the resolution of the profile lines. This option defaults to 17 when the Profiler runs a model stored in Excel, and to 41 when the model is stored directly in JMP. If the same model is stored in both Excel and JMP, the profile lines can appear different when the models are profiled. Increasing this value when using the Excel Profiler makes it slower.

### Using the Excel Profiler From JMP

Once an Excel file has the model inputs and outputs defined, you can profile the model from within JMP.

1. Select Graph > Excel Profiler.
2. Locate the Excel file containing the model and click Open.
3. If the Excel file contains multiple models, you are prompted to select the model that you want to Profile.

The Excel Profiler is also scriptable:

    Excel Profiler( "path to workbook", <"model name"> ) ;

If more than one model exists, and no model is specified, a window with the list of available models appears. For more information about scripting the Excel Profiler, see the Scripting Guide.

### Fit Group

For the REML and Stepwise personalities of the Fit Model platform, if models are fit to multiple Y’s, the results are combined into a Fit Group report. This enables the different Y’s to be profiled in the same Profiler. The Fit Group red-triangle menu has options for launching the joint Profiler. Profilers for the individual Y’s can still be used in the respective Fit Model reports.
Fit Group reports are also created when a By variable is specified for a Stepwise analysis. This allows for the separate models to be profiled in the same Profiler.

The Fit Group scripting command can be used to fit models in different platforms, and have the individual models profiled in the Profiler. For more details, see the Scripting Guide.

Statistical Details

**Normal Weighted Distribution**

JMP uses the multivariate radial strata method for each factor that uses the Normal Weighted distribution. This seems to work better than a number of Importance Sampling methods, as a multivariate Normal Integrator accurate in the extreme tails.

First, define strata and calculate corresponding probabilities and weights. For \( d \) random factors, the strata are radial intervals as follows.

**Table 26.5 Strata Intervals**

<table>
<thead>
<tr>
<th>Strata Number</th>
<th>Inside Distance</th>
<th>Outside Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>( \sqrt{d} )</td>
</tr>
<tr>
<td>1</td>
<td>( \sqrt{d} )</td>
<td>( \sqrt{d} + \sqrt{2d} )</td>
</tr>
<tr>
<td>2</td>
<td>( \sqrt{d} + \sqrt{2d} )</td>
<td>( \sqrt{d} + 2\sqrt{2d} )</td>
</tr>
<tr>
<td>( i )</td>
<td>( \sqrt{d} + (i - 1)\sqrt{2d} )</td>
<td>( \sqrt{d} + i\sqrt{2d} )</td>
</tr>
<tr>
<td>( N_{\text{Strata}} - 1 )</td>
<td>previous</td>
<td>( \infty )</td>
</tr>
</tbody>
</table>

The default number of strata is 12. To change the number of strata, a hidden command \( N \text{ Strata} \) is available if you hold the Shift key down while clicking on the red triangle next to Simulator.

**Figure 26.82** Showing the N Strata Menu Option
Increase the sample size as needed to maintain an even number of strata.

For each simulation run,

1. Select a strata as \( \text{mod}(i - 1, N_{\text{strata}}) \) for run \( i \).
2. Determine a random \( n \)-dimensional direction by scaling multivariate Normal (0,1) deviates to unit norm.
3. Determine a random distance using a chi-square quantile appropriate for the strata of a random uniform argument.
4. Scale the variates so the norm is the random distance.
5. Scale and re-center the variates individually to be as specified for each factor.

The resulting factor distributions are multivariate normal with the appropriate means and standard deviations when estimated with the right weights. Note that you cannot use the Distribution standard deviation with weights, because it does not estimate the desired value. However, multiplying the weight by a large value, like \( 10^{12} \), and using that as a Freq value results in the correct standard deviation.
References


Hsu, J. (1989), “Multiple Comparison Procedures” ASA Short Course notes, Columbus OH: Ohio State University.


Linnerud: see Rawlings (1988).


Myers, R.H. (1989), *Classical and Modern Regression with Applications*, Boston: PWS-KENT.
References


Miller, A.J. (1990), Subset Selection in Regression, New York: Chapman and Hall.


References


Umetrics (1995), *Multivariate Analysis (3-day course)*, Winchester, MA.


Western Electric Company (1956), *Statistical Quality Control Handbook*, currently referred to as the *AT&T Statistical Quality Control Handbook*.


This appendix discusses the different types of response models, their factors, their design coding, and parameterization. It also includes many other details of methods described in the main text.

The JMP system fits linear models to three different types of response models that are labeled continuous, ordinal, and nominal. Many details on the factor side are the same between the different response models, but JMP only supports graphics and marginal profiles on continuous responses—not on ordinal and nominal.

Different computer programs use different design-matrix codings, and thus parameterizations, to fit effects and construct hypothesis tests. JMP uses a different coding than the GLM procedure in the SAS system, although in most cases JMP and SAS GLM procedure produce the same results. The following sections describe the details of JMP coding and highlight those cases when it differs from that of the SAS GLM procedure, which is frequently cited as the industry standard.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Response Models</td>
<td>623</td>
</tr>
<tr>
<td>Continuous Responses</td>
<td>623</td>
</tr>
<tr>
<td>Nominal Responses</td>
<td>623</td>
</tr>
<tr>
<td>Ordinal Responses</td>
<td>625</td>
</tr>
<tr>
<td>The Factor Models</td>
<td>626</td>
</tr>
<tr>
<td>Continuous Factors</td>
<td>626</td>
</tr>
<tr>
<td>Nominal Factors</td>
<td>627</td>
</tr>
<tr>
<td>Ordinal Factors</td>
<td>637</td>
</tr>
<tr>
<td>The Usual Assumptions</td>
<td>643</td>
</tr>
<tr>
<td>Assumed Model</td>
<td>643</td>
</tr>
<tr>
<td>Relative Significance</td>
<td>643</td>
</tr>
<tr>
<td>Multiple Inferences</td>
<td>644</td>
</tr>
<tr>
<td>Validity Assessment</td>
<td>644</td>
</tr>
<tr>
<td>Alternative Methods</td>
<td>644</td>
</tr>
<tr>
<td>Key Statistical Concepts</td>
<td>645</td>
</tr>
<tr>
<td>Uncertainty, a Unifying Concept</td>
<td>645</td>
</tr>
<tr>
<td>The Two Basic Fitting Machines</td>
<td>646</td>
</tr>
<tr>
<td>Leverage Plot Details</td>
<td>648</td>
</tr>
<tr>
<td>Multivariate Details</td>
<td>651</td>
</tr>
<tr>
<td>Multivariate Tests</td>
<td>651</td>
</tr>
<tr>
<td>Approximate F-Test</td>
<td>652</td>
</tr>
<tr>
<td>Canonical Details</td>
<td>652</td>
</tr>
<tr>
<td>Discriminant Analysis</td>
<td>653</td>
</tr>
<tr>
<td>Power Calculations</td>
<td>654</td>
</tr>
<tr>
<td>Computations for the LSV</td>
<td>654</td>
</tr>
<tr>
<td>Computations for the LSN</td>
<td>655</td>
</tr>
<tr>
<td>Computations for the Power</td>
<td>655</td>
</tr>
<tr>
<td>Computations for Adjusted Power</td>
<td>656</td>
</tr>
<tr>
<td>Inverse Prediction with Confidence Limits</td>
<td>656</td>
</tr>
<tr>
<td>Details of Random Effects</td>
<td>657</td>
</tr>
</tbody>
</table>
The Response Models

JMP fits linear models to three different kinds of responses: continuous, nominal, and ordinal. The models and methods available in JMP are practical, are widely used, and suit the need for a general approach in a statistical software tool. As with all statistical software, you are responsible for learning the assumptions of the models you choose to use, and the consequences if the assumptions are not met. For more information see “The Usual Assumptions,” p. 643 in this chapter.

Continuous Responses

When the response column (column assigned the Y role) is continuous, JMP fits the value of the response directly. The basic model is that for each observation,

\[ Y = \text{(some function of the } X\text{'s and parameters)} + \text{error} \]

Statistical tests are based on the assumption that the error term in the model is normally distributed.

Fitting Principle for Continuous Response

The Fitting principle is called least squares. The least squares method estimates the parameters in the model to minimize the sum of squared errors. The errors in the fitted model, called residuals, are the difference between the actual value of each observation and the value predicted by the fitted model.

The least squares method is equivalent to the maximum likelihood method of estimation if the errors have a normal distribution. This means that the analysis estimates the model that gives the most likely residuals. The log-likelihood is a scale multiple of the sum of squared errors for the normal distribution.

Base Model

The simplest model for continuous measurement fits just one value to predict all the response values. This value is the estimate of the mean. The mean is just the arithmetic average of the response values. All other models are compared to this base model.

Nominal Responses

Nominal responses are analyzed with a straightforward extension of the logit model. For a binary (two-level) response, a logit response model is

\[ \log \left( \frac{P(y = 1)}{P(y = 2)} \right) = X\beta \]

which can be written

\[ P(y = 1) = F(X\beta) \]
The Response Models

where $F(x)$ is the cumulative distribution function of the standard logistic distribution

$$F(x) = \frac{1}{1 + e^{-x}} = \frac{e^x}{1 + e^x}$$

For $r$ response levels, JMP fits the probabilities that the response is one of $r$ different response levels given by the data values. The probability estimates must all be positive. For a given configuration of $X$'s, the probability estimates must sum to 1 over the response levels. The function that JMP uses to predict probabilities is a composition of a linear model and a multi-response logistic function. This is sometimes called a log-linear model because the logs of ratios of probabilities are linear models. JMP relates each response probability to the $r$th probability and fit a separate set of design parameters to these $r-1$ models.

$$\log \left( \frac{p(y = j)}{p(y = r)} \right) = X \beta_j(j) \text{ for } j = 1, ..., r-1$$

**Fitting Principle For Nominal Response**

The fitting principle is called maximum likelihood. It estimates the parameters such that the joint probability for all the responses given by the data is the greatest obtainable by the model. Rather than reporting the joint probability (likelihood) directly, it is more manageable to report the total of the negative logs of the likelihood.

The uncertainty (−log-likelihood) is the sum of the negative logs of the probabilities attributed by the model to the responses that actually occurred in the sample data. For a sample of size $n$, it is often denoted as $H$ and written

$$H = \sum_{i=1}^{n} -\log(p(y = y_i))$$

If you attribute a probability of 1 to each event that did occur, then the sum of the negative logs is zero for a perfect fit.

The nominal model can take a lot of time and memory to fit, especially if there are many response levels. JMP tracks the progress of its calculations with an iteration history, which shows the –log-likelihood values becoming smaller as they converge to the estimates.

**Base Model**

The simplest model for a nominal response is a set of constant response probabilities fitted as the occurrence rates for each response level across the whole data table. In other words, the probability that $y$ is response level $j$ is estimated by dividing the total sample count $n$ into the total of each response level $n_j$, and is written

$$p_j = \frac{n_j}{n}$$

All other models are compared to this base model. The base model serves the same role for a nominal response as the sample mean does for continuous models.
The $R^2$ statistic measures the portion of the uncertainty accounted for by the model, which is

$$1 - \frac{H(\text{full model})}{H(\text{base model})}$$

However, it is rare in practice to get an $R^2$ near 1 for categorical models.

**Ordinal Responses**

With an ordinal response ($Y$), as with nominal responses, JMP fits probabilities that the response is one of $r$ different response levels given by the data.

Ordinal data have an order like continuous data. The order is used in the analysis but the spacing or distance between the ordered levels is not used. If you have a numeric response but want your model to ignore the spacing of the values, you can assign the ordinal level to that response column. If you have a classification variable and the levels are in some natural order such as low, medium, and high, you can use the ordinal modeling type. For details about the function that is fitted, see the *Quality and Reliability Methods* book.

Ordinal responses are modeled by fitting a series of parallel logistic curves to the cumulative probabilities. Each curve has the same design parameters but a different intercept and is written

$$P(y \leq j) = F(\alpha_j + X\beta) \quad \text{for } j = 1, \ldots, r-1$$

where $r$ response levels are present and $F(x)$ is the standard logistic cumulative distribution function

$$F(x) = \frac{1}{1 + e^{-x}} = \frac{e^x}{1 + e^x}$$

Another way to write this is in terms of an unobserved continuous variable, $z$, that causes the ordinal response to change as it crosses various thresholds

$$y = \begin{cases} 
  r & \alpha_{r-1} \leq z \\
  j & \alpha_{j-1} \leq z < \alpha_j \\
  1 & z \leq \alpha_1
\end{cases}$$

where $z$ is an unobservable function of the linear model and error

$$z = X\beta + \varepsilon$$

and $\varepsilon$ has the logistic distribution.

These models are attractive in that they recognize the ordinal character of the response, they need far fewer parameters than nominal models, and the computations are fast even though they involve iterative maximum likelihood calculation.

A different but mathematically equivalent way to envision an ordinal model is to think of a nominal model where, instead of modeling the odds, you model the cumulative probability. Instead of fitting functions for all but the last level, you fit only one function and slide it to fit each cumulative response probability.
Fitting Principle For Ordinal Response

The maximum likelihood fitting principle for an ordinal response model is the same as for a nominal response model. It estimates the parameters such that the joint probability for all the responses that occur is the greatest obtainable by the model. It uses an iterative method that is faster and uses less memory than nominal fitting.

Base Model

The simplest model for an ordinal response, like a nominal response, is a set of response probabilities fitted as the occurrence rates of the response in the whole data table.

The Factor Models

The way the x-variables (factors) are modeled to predict an expected value or probability is the subject of the factor side of the model.

The factors enter the prediction equation as a linear combination of x values and the parameters to be estimated. For a continuous response model, where i indexes the observations and j indexes the parameters, the assumed model for a typical observation, $y_i$, is written

$$y_i = \beta_0 + \beta_1 x_{i1} + \ldots + \beta_k x_{ik} + \epsilon_i$$

where

- $y_i$ is the response
- $x_{ij}$ are functions of the data
- $\epsilon_i$ is an unobservable realization of the random error
- $\beta_j$ are unknown parameters to be estimated.

The way the x’s in the linear model are formed from the factor terms is different for each modeling type. The linear model x’s can also be complex effects such as interactions or nested effects. Complex effects are discussed in detail later.

Continuous Factors

Continuous factors are placed directly into the design matrix as regressors. If a column is a linear function of other columns, then the parameter for this column is marked zeroed or nonestimable. Continuous factors are centered by their mean when they are crossed with other factors (interactions and polynomial terms). Centering is suppressed if the factor has a Column Property of Mixture or Coding, or if the centered polynomials option is turned off when specifying the model. If there is a coding column property, the factor is coded before fitting.
Nominal Factors

Nominal factors are transformed into indicator variables for the design matrix. SAS GLM constructs an indicator column for each nominal level. JMP constructs the same indicator columns for each nominal level except the last level. When the last nominal level occurs, a one is subtracted from all the other columns of the factor. For example, consider a nominal factor A with three levels coded for GLM and for JMP as shown below.

Table A.1 Nominal Factor A

<table>
<thead>
<tr>
<th>GLM</th>
<th>JMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A1</td>
</tr>
<tr>
<td>A1</td>
<td>1</td>
</tr>
<tr>
<td>A2</td>
<td>0</td>
</tr>
<tr>
<td>A3</td>
<td>0</td>
</tr>
</tbody>
</table>

In GLM, the linear model design matrix has linear dependencies among the columns, and the least squares solution employs a generalized inverse. The solution chosen happens to be such that the A3 parameter is set to zero.

In JMP, the linear model design matrix is coded so that it achieves full rank unless there are missing cells or other incidental collinearity. The parameter for the A effect for the last level is the negative sum of the other levels, which makes the parameters sum to zero over all the effect levels.

Interpretation of Parameters

**Note:** The parameter for a nominal level is interpreted as the differences in the predicted response for that level from the average predicted response over all levels.

The design column for a factor level is constructed as the zero-one indicator of that factor level minus the indicator of the last level. This is the coding that leads to the parameter interpretation above.

Table A.2 Interpreting Parameters

<table>
<thead>
<tr>
<th>JMP Parameter Report</th>
<th>How to Interpret</th>
<th>Design Column Coding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>mean over all levels</td>
<td>1’</td>
</tr>
<tr>
<td>A[1]</td>
<td>α1 – 1/3(α1 + α2 + α3)</td>
<td>(A==1) – (A==3)</td>
</tr>
<tr>
<td>A[2]</td>
<td>α2 – 1/3(α1 + α2 + α3)</td>
<td>(A==2) – (A==3)</td>
</tr>
</tbody>
</table>
**Interactions and Crossed Effects**

Interaction effects with both GLM and JMP are constructed by taking a direct product over the rows of the design columns of the factors being crossed. For example, the GLM code

```plaintext
PROC GLM;
   CLASS A B;
   MODEL A B A*B;
```

yields this design matrix:

**Table A.3 Design Matrix**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>AB</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>B</td>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>

Using the JMP **Fit Model** command and requesting a factorial model for columns A and B produces the following design matrix. Note that A13 in this matrix is A1–A3 in the previous matrix. However, A13B13 is A13*A13 in the current matrix.

**Table A.4 Current Matrix**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>A1</th>
<th>A1</th>
<th>A2</th>
<th>A2</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>B</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>
The Factor Models

Nested Effects

Nested effects in GLM are coded the same as interaction effects because GLM determines the right test by what isn’t in the model. Any effect not included in the model can have its effect soaked up by a containing interaction (or, equivalently, nested) effect.

Nested effects in JMP are coded differently. JMP uses the terms inside the parentheses as grouping terms for each group. For each combination of levels of the nesting terms, JMP constructs the effect on the outside of the parentheses. The levels of the outside term need not line up across the levels of the nesting terms. Each level of nest is considered separately with regard to the construction of design columns and parameters.

Table A.5 Nested Effects

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>B(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>A1(A)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A1(A1)</td>
</tr>
<tr>
<td>A1</td>
<td>B1</td>
<td>1</td>
</tr>
<tr>
<td>A1</td>
<td>B2</td>
<td>1</td>
</tr>
<tr>
<td>A1</td>
<td>B3</td>
<td>1</td>
</tr>
<tr>
<td>A2</td>
<td>B1</td>
<td>1</td>
</tr>
<tr>
<td>A2</td>
<td>B2</td>
<td>1</td>
</tr>
<tr>
<td>A2</td>
<td>B3</td>
<td>1</td>
</tr>
</tbody>
</table>

The JMP coding saves memory and some computing time for problems with interactions of factors with few levels.
Table A.5 Nested Effects (Continued)

<p>| | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A2</td>
<td>B2</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>A2</td>
<td>B3</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>–1</td>
<td>–1</td>
<td>0</td>
</tr>
<tr>
<td>A3</td>
<td>B1</td>
<td>–1</td>
<td>–1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>A3</td>
<td>B2</td>
<td>–1</td>
<td>–1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>A3</td>
<td>B3</td>
<td>–1</td>
<td>–1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>–1</td>
</tr>
</tbody>
</table>

Least Squares Means across Nominal Factors

Least squares means are the predicted values corresponding to some combination of levels, after setting all the other factors to some neutral value. The neutral value for direct continuous regressors is defined as the sample mean. The neutral value for an effect with uninvolved nominal factors is defined as the average effect taken over the levels (which happens to result in all zeroes in our coding). Ordinal factors use a different neutral value in “Ordinal Least Squares Means,” p. 640. The least squares means might not be estimable, and if not, they are marked nonestimable. JMP’s least squares means agree with GLM’s (Goodnight and Harvey 1978) in all cases except when a weight is used, where JMP uses a weighted mean and GLM uses an unweighted mean for its neutral values.

The expected values of the cells in terms of the parameters for a three-by-three crossed model are:

Table A.6 Three-by-Three Crossed Model

<table>
<thead>
<tr>
<th>B1</th>
<th>B2</th>
<th>B3</th>
</tr>
</thead>
<tbody>
<tr>
<td>A 1</td>
<td>(\mu + \alpha_1 + \beta_1 + \alpha\beta_{11})</td>
<td>(\mu + \alpha_1 + \beta_2 + \beta_1\alpha_{21})</td>
</tr>
<tr>
<td>A 2</td>
<td>(\mu + \alpha_2 + \beta_1 + \alpha\beta_{21})</td>
<td>(\mu + \alpha_2 + \beta_2 + \beta_2\alpha_{22})</td>
</tr>
<tr>
<td>A 3</td>
<td>(\mu - \alpha_1 - \alpha_2 + \beta_1) – (\alpha\beta_{11} - \alpha\beta_{21})</td>
<td>(\mu - \alpha_1 - \alpha_2 + \beta_2 - \beta_1\alpha_{12}) – (\alpha\beta_{22})</td>
</tr>
</tbody>
</table>

Effective Hypothesis Tests

Generally, the hypothesis tests produced by JMP agree with the hypothesis tests of most other trusted programs, such as SAS PROC GLM (Hypothesis types III and IV). The following two sections describe where there are differences.

In the SAS GLM procedure, the hypothesis tests for Types III and IV are constructed by looking at the general form of estimable functions and finding functions that involve only the effects of interest and effects contained by the effects of interest (Goodnight 1978).
In JMP, the same tests are constructed, but because there is a different parameterization, an effect can be tested (assuming full rank for now) by doing a joint test on all the parameters for that effect. The tests do not involve containing interaction parameters because the coding has made them uninvolved with the tests on their contained effects.

If there are missing cells or other singularities, the JMP tests are different than GLM tests. There are several ways to describe them:

- JMP tests are equivalent to testing that the least squares means are different, at least for main effects. If the least squares means are nonestimable, then the test cannot include some comparisons and, therefore, loses degrees of freedom. For interactions, JMP is testing that the least squares means differ by more than just the marginal pattern described by the containing effects in the model.
- JMP tests an effect by comparing the SSE for the model with that effect with the SSE for the model without that effect (at least if there are no nested terms, which complicate the logic slightly). JMP parameterizes so that this method makes sense.
- JMP implements the effective hypothesis tests described by Hocking (1985, 80–89, 163–166), although JMP uses structural rather than cell-means parameterization. Effective hypothesis tests start with the hypothesis desired for the effect and include “as much as possible” of that test. Of course, if there are containing effects with missing cells, then this test will have to drop part of the hypothesis because the complete hypothesis would not be estimable. The effective hypothesis drops as little of the complete hypothesis as possible.
- The differences among hypothesis tests in JMP and GLM (and other programs) that relate to the presence of missing cells are not considered interesting tests anyway. If an interaction is significant, the test for the contained main effects are not interesting. If the interaction is not significant, then it can always be dropped from the model. Some tests are not even unique. If you relabel the levels in a missing cell design, then the GLM Type IV tests can change.

The following section continues this topic in finer detail.

**Singularities and Missing Cells in Nominal Effects**

Consider the case of linear dependencies among the design columns. With JMP coding, this does not occur unless there is insufficient data to fill out the combinations that need estimating, or unless there is some kind of confounding or collinearity of the effects.

With linear dependencies, a least squares solution for the parameters might not be unique and some tests of hypotheses cannot be tested. The strategy chosen for JMP is to set parameter estimates to zero in sequence as their design columns are found to be linearly dependent on previous effects in the model. A special column in the report shows what parameter estimates are zeroed and which parameter estimates are estimable. A separate singularities report shows what the linear dependencies are.

In cases of singularities the hypotheses tested by JMP can differ from those selected by GLM. Generally, JMP finds fewer degrees of freedom to test than GLM because it holds its tests to a higher standard of marginality. In other words, JMP tests always correspond to tests across least squares means for that effect, but GLM tests do not always have this property.

For example, consider a two-way model with interaction and one missing cell where A has three levels, B has two levels, and the A3B2 cell is missing.
The expected values for each cell are:

### Table A.7 Two-Way Model with Interaction

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>A1</th>
<th>A2</th>
<th>B1</th>
<th>A1B1</th>
<th>A2B1</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>B1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>A2</td>
<td>B1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>A3</td>
<td>B1</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>-1</td>
<td>-1</td>
</tr>
<tr>
<td>A1</td>
<td>B2</td>
<td>1</td>
<td>0</td>
<td>-1</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>A2</td>
<td>B2</td>
<td>0</td>
<td>1</td>
<td>-1</td>
<td>0</td>
<td>-1</td>
</tr>
<tr>
<td>A3</td>
<td>B2</td>
<td>-1</td>
<td>-1</td>
<td>-1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

The expected values for each cell are:

### Table A.8 Expected Values

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>B1</th>
<th>B2</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td></td>
<td>$\mu + \alpha_1 + \beta_1 + \alpha_1\beta_{11}$</td>
<td>$\mu + \alpha_1 - \beta_1 - \alpha_1\beta_{11}$</td>
</tr>
<tr>
<td>A2</td>
<td></td>
<td>$\mu + \alpha_2 + \beta_1 + \alpha_2\beta_{21}$</td>
<td>$\mu + \alpha_2 - \beta_1 - \alpha_2\beta_{21}$</td>
</tr>
<tr>
<td>A3</td>
<td></td>
<td>$\mu - \alpha_1 - \alpha_2 + \beta_1 - \alpha_1\beta_{11} - \alpha_2\beta_{21}$</td>
<td>$\mu - \alpha_1 - \alpha_2 - \beta_1 + \alpha_1\beta_{11} + \alpha_2\beta_{21}$</td>
</tr>
</tbody>
</table>

Obviously, any cell with data has an expectation that is estimable. The cell that is missing has an expectation that is nonestimable. In fact, its expectation is precisely that linear combination of the design columns that is in the singularity report

$$\mu - \alpha_1 - \alpha_2 - \beta_1 + \alpha_1\beta_{11} + \alpha_2\beta_{21}$$

Suppose that you want to construct a test that compares the least squares means of B1 and B2. In this example, the average of the rows in the above table give these least squares means.

$$\text{LSM}(B1) = (1/3)(\mu + \alpha_1 + \beta_1 + \alpha_1\beta_{11} + \mu + \alpha_2 + \beta_1 + \alpha_2\beta_{21} + \mu - \alpha_1 - \alpha_2 + \beta_1 - \alpha_1\beta_{11} - \alpha_2\beta_{21}) = \mu + \beta_1$$

$$\text{LSM}(B2) = (1/3)(\mu + \alpha_1 + \beta_1 - \alpha_1\beta_{11} + \mu + \alpha_2 - \beta_1 - \alpha_2\beta_{21} + \mu - \alpha_1 - \alpha_2 - \beta_1 + \alpha_1\beta_{11} + \alpha_2\beta_{21}) = \mu - \beta_1$$
LSM(B1) – LSM(B2) = 2β₁

Note that this shows that a test on the β₁ parameter is equivalent to testing that the least squares means are the same. But because β₁ is not estimable, the test is not testable, meaning there are no degrees of freedom for it.

Now, construct the test for the least squares means across the A levels.

\[
\begin{align*}
LSM(A1) &= (1/2)(\mu + \alpha_1 + \beta_1 + \alpha\beta_{11} + \mu + \alpha_1 - \beta_1 - \alpha\beta_{11}) \\
&= \mu + \alpha_1 \\
LSM(A2) &= (1/2)(\mu + \alpha_2 + \beta_1 + \alpha\beta_{21} + \mu + \alpha_2 - \beta_1 - \alpha\beta_{21}) \\
&= \mu + \alpha_2 \\
LSM(A3) &= (1/2)(\mu - \alpha_1 - \alpha_2 + \beta_1 - \alpha\beta_{11} + \mu - \alpha_1 - \alpha_2 - \beta_1 + \alpha\beta_{11} + \alpha\beta_{21}) \\
&= \mu - \alpha_1 - \alpha_2 \\
LSM(A1) - LSM(A3) &= 2\alpha_1 + \alpha_2 \\
LSM(A2) - LSM(A3) &= 2\alpha_2 + \alpha_1 \\
\end{align*}
\]

Neither of these turn out to be estimable, but there is another comparison that is estimable; namely comparing the two A columns that have no missing cells.

\[
LSM(A1) - LSM(A2) = \alpha_1 - \alpha_2
\]

This combination is indeed tested by JMP using a test with 1 degree of freedom, although there are two parameters in the effect.

The estimability can be verified by taking its inner product with the singularity combination, and checking that it is zero:

**Table A.9 Verification**

<table>
<thead>
<tr>
<th>parameters</th>
<th>singularity combination</th>
<th>combination to be tested</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>a₁</td>
<td>-1</td>
<td>1</td>
</tr>
<tr>
<td>a₂</td>
<td>-1</td>
<td>-1</td>
</tr>
<tr>
<td>b₁</td>
<td>-1</td>
<td>0</td>
</tr>
<tr>
<td>ab₁₁</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>ab₂₁</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>
It turns out that the design columns for missing cells for any interaction will always knock out degrees of freedom for the main effect (for nominal factors). Thus, there is a direct relation between the nonestimability of least squares means and the loss of degrees of freedom for testing the effect corresponding to these least squares means.

How does this compare with what GLM does? GLM and JMP do the same test when there are no missing cells. That is, they effectively test that the least squares means are equal. But when GLM encounters singularities, it focuses out these cells in different ways, depending on whether they are Type III or Type IV. For Type IV, it looks for estimable combinations that it can find. These might not be unique, and if you reorder the levels, you might get a different result. For Type III, it does some orthogonalization of the estimable functions to obtain a unique test. But the test might not be very interpretable in terms of the cell means.

The JMP approach has several points in its favor, although at first it might seem distressing that you might lose more degrees of freedom than with GLM:

1. The tests are philosophically linked to LSMs.
2. The tests are easy computationally, using reduction sum of squares for reparameterized models.
3. The tests agree with Hocking's “Effective Hypothesis Tests”.
4. The tests are whole marginal tests, meaning they always go completely across other effects in interactions.

The last point needs some elaboration: Consider a graph of the expected values of the cell means in the previous example with a missing cell for A3B2.

The graph shows expected cell means with a missing cell. The means of the A1 and A2 cells are profiled across the B levels. The JMP approach says you can't test the B main effect with a missing A3B2 cell, because the mean of the missing cell could be anything, as allowed by the interaction term. If the mean of the missing cell were the higher value shown, the B effect would likely test significant. If it were the lower, it would likely test nonsignificant. The point is that you don't know. That is what the least squares means are saying when they are declared nonestimable. That is what the hypotheses for the effects should be saying too—that you don't know.

If you want to test hypotheses involving margins for subsets of cells, then that is what GLM Type IV does. In JMP you would have to construct these tests yourself by partitioning the effects with a lot of calculations or by using contrasts.
Example of JMP and GLM differences

GLM works differently than JMP and produces different hypothesis tests in situations where there are missing cells. In particular, GLM does not recognize any difference between a nesting and a crossing in an effect, but JMP does. Suppose that you have a three-layer nesting of A, B(A), and C(A B) with different numbers of levels as you go down the nested design.

Table A.10 “Comparison of GLM and JMP Hypotheses,” p. 635, shows the test of the main effect A in terms of the GLM parameters. The first set of columns is the test done by JMP. The second set of columns is the test done by GLM Type IV. The third set of columns is the test equivalent to that by JMP; it is the first two columns that have been multiplied by a matrix

\[
\begin{bmatrix}
2 & 1 \\
1 & 2
\end{bmatrix}
\]

to be comparable to the GLM test. The last set of columns is the GLM Type III test. The difference is in how the test distributes across the containing effects. In JMP, it seems more top-down hierarchical. In GLM Type IV, the test seems more bottom-up. In practice, the test statistics are often similar.

Table A.10 Comparison of GLM and JMP Hypotheses

<table>
<thead>
<tr>
<th>Parameter</th>
<th>JMP Test for A</th>
<th>GLM-IV Test for A</th>
<th>JMP Rotated Test</th>
<th>GLM-III Test for A</th>
</tr>
</thead>
<tbody>
<tr>
<td>u</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>a1</td>
<td>0.6667</td>
<td>-0.3333</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>a2</td>
<td>-0.3333</td>
<td>0.6667</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>a3</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-1</td>
<td>-1</td>
</tr>
<tr>
<td>a1b1</td>
<td>0.1667</td>
<td>-0.0833</td>
<td>0.2222</td>
<td>0</td>
</tr>
<tr>
<td>a1b2</td>
<td>0.1667</td>
<td>-0.0833</td>
<td>0.3333</td>
<td>0</td>
</tr>
<tr>
<td>a1b3</td>
<td>0.1667</td>
<td>-0.0833</td>
<td>0.2222</td>
<td>0</td>
</tr>
<tr>
<td>a1b4</td>
<td>0.1667</td>
<td>-0.0833</td>
<td>0.2222</td>
<td>0</td>
</tr>
</tbody>
</table>
### Statistical Details

#### The Factor Models

**Table A.10** Comparison of GLM and JMP Hypotheses *(Continued)*

<table>
<thead>
<tr>
<th></th>
<th>0.166</th>
<th>0.3333</th>
<th>0</th>
<th>0.5</th>
<th>0</th>
<th>0.5</th>
<th>0</th>
<th>.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>a2b1</td>
<td>-0.166</td>
<td>0.3333</td>
<td>0</td>
<td>0.5</td>
<td>0</td>
<td>0.5</td>
<td>0</td>
<td>.5</td>
</tr>
<tr>
<td>a2b2</td>
<td>-0.166</td>
<td>0.3333</td>
<td>0</td>
<td>0.5</td>
<td>0</td>
<td>0.5</td>
<td>0</td>
<td>.5</td>
</tr>
<tr>
<td>a3b1</td>
<td>-0.111</td>
<td>-0.1111</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
</tr>
<tr>
<td>a3b2</td>
<td>-0.111</td>
<td>-0.1111</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
</tr>
<tr>
<td>a3b3</td>
<td>-0.111</td>
<td>-0.1111</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
<td>-0.3333</td>
</tr>
<tr>
<td>a1b1c1</td>
<td>0.083</td>
<td>-0.0417</td>
<td>0.1111</td>
<td>0</td>
<td>0.125</td>
<td>0</td>
<td>0.1212</td>
<td>0</td>
</tr>
<tr>
<td>a1b1c2</td>
<td>0.083</td>
<td>-0.0417</td>
<td>0.1111</td>
<td>0</td>
<td>0.125</td>
<td>0</td>
<td>0.1212</td>
<td>0</td>
</tr>
<tr>
<td>a1b2c1</td>
<td>0.055</td>
<td>-0.0278</td>
<td>0.1111</td>
<td>0</td>
<td>0.0833</td>
<td>0</td>
<td>0.0909</td>
<td>0</td>
</tr>
<tr>
<td>a1b2c2</td>
<td>0.055</td>
<td>-0.0278</td>
<td>0.1111</td>
<td>0</td>
<td>0.0833</td>
<td>0</td>
<td>0.0909</td>
<td>0</td>
</tr>
<tr>
<td>a1b2c3</td>
<td>0.055</td>
<td>-0.0278</td>
<td>0.1111</td>
<td>0</td>
<td>0.0833</td>
<td>0</td>
<td>0.0909</td>
<td>0</td>
</tr>
<tr>
<td>a1b3c1</td>
<td>0.083</td>
<td>-0.0417</td>
<td>0.1111</td>
<td>0</td>
<td>0.125</td>
<td>0</td>
<td>0.1212</td>
<td>0</td>
</tr>
<tr>
<td>a1b3c2</td>
<td>0.083</td>
<td>-0.0417</td>
<td>0.1111</td>
<td>0</td>
<td>0.125</td>
<td>0</td>
<td>0.1212</td>
<td>0</td>
</tr>
<tr>
<td>a1b4c1</td>
<td>0.083</td>
<td>-0.0417</td>
<td>0.1111</td>
<td>0</td>
<td>0.125</td>
<td>0</td>
<td>0.1212</td>
<td>0</td>
</tr>
<tr>
<td>a1b4c2</td>
<td>0.083</td>
<td>-0.0417</td>
<td>0.1111</td>
<td>0</td>
<td>0.125</td>
<td>0</td>
<td>0.1212</td>
<td>0</td>
</tr>
<tr>
<td>a2b1c1</td>
<td>-0.083</td>
<td>0.1667</td>
<td>0</td>
<td>0.25</td>
<td>0</td>
<td>0.25</td>
<td>0</td>
<td>0.25</td>
</tr>
</tbody>
</table>
Ordinal Factors

Factors marked with the ordinal modeling type are coded differently than nominal factors. The parameters estimates are interpreted differently, the tests are different, and the least squares means are different.

The theme for ordinal factors is that the first level of the factor is a control or baseline level, and the parameters measure the effect on the response as the ordinal factor is set to each succeeding level. The coding is appropriate for factors with levels representing various doses, where the first dose is zero:

<table>
<thead>
<tr>
<th>Term</th>
<th>Coded Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>a2</td>
</tr>
<tr>
<td>A1</td>
<td>0</td>
</tr>
<tr>
<td>A2</td>
<td>1</td>
</tr>
</tbody>
</table>

Table A.10 Comparison of GLM and JMP Hypotheses (Continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Coded Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>a2b1c2</td>
<td>-0.083 0.1667 0 0.25 0 0.25 0 0.25</td>
</tr>
<tr>
<td>a2b2c1</td>
<td>-0.083 0.1667 0 0.25 0 0.25 0 0.25</td>
</tr>
<tr>
<td>a2b2c2</td>
<td>-0.083 0.1667 0 0.25 0 0.25 0 0.25</td>
</tr>
<tr>
<td>a3b1c1</td>
<td>-0.055 0.0556 -0.1667 -0.1667 -0.1667 -0.1667 -0.1667</td>
</tr>
<tr>
<td>a3b2c1</td>
<td>-0.055 0.0556 -0.1667 -0.1667 -0.1667 -0.1667 -0.1667</td>
</tr>
<tr>
<td>a3b2c2</td>
<td>-0.055 0.0556 -0.1667 -0.1667 -0.1667 -0.1667 -0.1667</td>
</tr>
<tr>
<td>a3b3c1</td>
<td>-0.055 0.0556 -0.1667 -0.1667 -0.1667 -0.1667 -0.1667</td>
</tr>
<tr>
<td>a3b3c2</td>
<td>-0.055 0.0556 -0.1667 -0.1667 -0.1667 -0.1667 -0.1667</td>
</tr>
</tbody>
</table>

Table A.11 Ordinal Factors
From the perspective of the JMP parameterization, the tests for $A$ are:

**Table A.12** Tests for $A$

<table>
<thead>
<tr>
<th>parameter</th>
<th>GLM–IV test</th>
<th>JMP test</th>
</tr>
</thead>
<tbody>
<tr>
<td>$m$</td>
<td>0 0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{13}$</td>
<td>2 1</td>
<td>1 0</td>
</tr>
<tr>
<td>$a_{23}$</td>
<td>1 2</td>
<td>0 1</td>
</tr>
<tr>
<td>$a_{11}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{1:24}$</td>
<td>0.11111</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{1:34}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{2:12}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{3:13}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{3:23}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{11}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{12}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{21}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{31}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
<tr>
<td>$a_{32}$</td>
<td>0 0</td>
<td>0 0</td>
</tr>
</tbody>
</table>

So from JMP’s perspective, the GLM test looks a little strange, putting a coefficient on the $a_{1:24}$ parameter.

The pattern for the design is such that the lower triangle is ones with zeros elsewhere.
For a simple main-effects model, this can be written

\[ y = \mu + \alpha_2 X_{a \leq 2} + \alpha_3 X_{a \leq 3} + \varepsilon \]

noting that \( \mu \) is the expected response at \( A = 1 \), \( \mu + \alpha_2 \) is the expected response at \( A = 2 \), and \( \mu + \alpha_2 + \alpha_3 \) is the expected response at \( A = 3 \). Thus, \( \alpha_2 \) estimates the effect moving from \( A = 1 \) to \( A = 2 \) and \( \alpha_3 \) estimates the effect moving from \( A = 2 \) to \( A = 3 \).

If all the parameters for an ordinal main effect have the same sign, then the response effect is monotonic across the ordinal levels.

**Ordinal Interactions**

The ordinal interactions, as with nominal effects, are produced with a horizontal direct product of the columns of the factors. Consider an example with two ordinal factors A and B, each with three levels. JMP’s ordinal coding produces the design matrix shown next. The pattern for the interaction is a block lower-triangular matrix of lower-triangular matrices of ones.

**Table A.13 Ordinal Interactions**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>A2</th>
<th>A3</th>
<th>B2</th>
<th>B3</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>B1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>A1</td>
<td>B2</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>A1</td>
<td>B3</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>A2</td>
<td>B1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>A2</td>
<td>B2</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>A2</td>
<td>B3</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>A3</td>
<td>B1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>A3</td>
<td>B2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
</tr>
<tr>
<td>A3</td>
<td>B3</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

**Note:** When you test to see if there is no effect, there is not much difference between nominal and ordinal factors for simple models. However, there are major differences when interactions are specified. We recommend that you use nominal rather than ordinal factors for most models.
Hypothesis Tests for Ordinal Crossed Models

To see what the parameters mean, examine this table of the expected cell means in terms of the parameters, where $\mu$ is the intercept, $\alpha_2$ is the parameter for level A2, and so forth.

Table A.14 Expected Cell Means

<table>
<thead>
<tr>
<th></th>
<th>B1</th>
<th>B2</th>
<th>B3</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>$\mu$</td>
<td>$\mu + \alpha_2 + \alpha_1\beta_{12}$</td>
<td>$\mu + \beta_2 + \beta_3$</td>
</tr>
<tr>
<td>A2</td>
<td>$\mu + \alpha_2$</td>
<td>$\mu + \alpha_2 + \beta_2 + \alpha_2\beta_{22}$</td>
<td>$\mu + \alpha_2 + \beta_2 + \beta_3 + \alpha_2\beta_{22} + \alpha_2\beta_{23}$</td>
</tr>
<tr>
<td>A3</td>
<td>$\mu + \alpha_2 + \alpha_3$</td>
<td>$\mu + \alpha_2 + \alpha_3 + \beta_2 + \alpha_2\beta_{22} + \alpha_3\beta_{32} + \alpha_2\beta_{32} + \alpha_3\beta_{33}$</td>
<td>$\mu + \alpha_2 + \alpha_3 + \beta_2 + \beta_3 + \alpha_2\beta_{22} + \alpha_3\beta_{32} + \alpha_2\beta_{32} + \alpha_3\beta_{33}$</td>
</tr>
</tbody>
</table>

Note that the main effect test for A is really testing the A levels holding B at the first level. Similarly, the main effect test for B is testing across the top row for the various levels of B holding A at the first level. This is the appropriate test for an experiment where the two factors are both doses of different treatments. The main question is the efficacy of each treatment by itself, with fewer points devoted to looking for drug interactions when doses of both drugs are applied. In some cases it may even be dangerous to apply large doses of each drug.

Note that each cell’s expectation can be obtained by adding all the parameters associated with each cell that is to the left and above it, inclusive of the current row and column. The expected value for the last cell is the sum of all the parameters.

Though the hypothesis tests for effects contained by other effects differs with ordinal and nominal codings, the test of effects not contained by other effects is the same. In the crossed design above, the test for the interaction would be the same no matter whether A and B were fit nominally or ordinally.

Ordinal Least Squares Means

As stated previously, least squares means are the predicted values corresponding to some combination of levels, after setting all the other factors to some neutral value. JMP defines the neutral value for an effect with uninvolved ordinal factors as the effect at the first level, meaning the control or baseline level.

This definition of least squares means for ordinal factors maintains the idea that the hypothesis tests for contained effects are equivalent to tests that the least squares means are equal.

Singularities and Missing Cells in Ordinal Effects

With the ordinal coding, you are saying that the first level of the ordinal effect is the baseline. It is thus possible to get good tests on the main effects even when there are missing cells in the interactions—even if you have no data for the interaction.
Example with Missing Cell

The example is the same as above, with two observations per cell except that the A3B2 cell has no data. You can now compare the results when the factors are coded nominally with results when they are coded ordinally. The model as a whole fits the same as seen in tables shown in Figure A.1.

Table A.15 Observations

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>17</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>17</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>18</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>19</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>20</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>24</td>
<td>3</td>
<td>1</td>
</tr>
</tbody>
</table>

Figure A.1 Comparison of Summary Information for Nominal and Ordinal Fits

The parameter estimates are very different because of the different coding. Note that the missing cell affects estimability for all the nominal parameters but for none of the other ordinal parameters.
The singularity details show the linear dependencies (and also identify the missing cell by examining the values).

The effect tests lose degrees of freedom for nominal. In the case of B, there is no test. For ordinal, there is no loss because there is no missing cell for the base first level.

The least squares means are also different. The nominal LSMs are not all estimable, but the ordinal LSMs are. You can verify the values by looking at the cell means. Note that the A*B LSMs are the same for the two. Figure A.5 shows least squares means for an nominal and ordinal fits.
Appendix A
Statistical Details
The Usual Assumptions

The Usual Assumptions

Before you put your faith in statistics, reassure yourself that you know both the value and the limitations of the techniques you use. Statistical methods are just tools—they cannot guard you from incorrect science (invalid statistical assumptions) or bad data.

Assumed Model

Most statistics are based on the assumption that the model is correct. You assume that the equation really does determine the response up to a normally distributed random error. To the extent that your model may not be correct, you must attenuate your credibility in the statistical reports that result from the model.

Relative Significance

Many statistical tests do not evaluate the model in an absolute sense. Significant test statistics might only be saying that the model fits better than some reduced model, such as the mean. The model can appear to fit the data but might not describe the underlying physical model well at all.
Multiple Inferences

Often the value of the statistical results is not that you believe in them directly, but rather that they provide a key to some discovery. To confirm the discovery, you may need to conduct further studies. Otherwise, you might just be sifting through the data.

For instance, if you conduct enough analyses you can find 5% significant effects in five percent of your studies by chance alone, even if the factors have no predictive value. Similarly, to the extent that you use your data to shape your model (instead of testing the correct model for the data), you are corrupting the significance levels in your report. The random error then influences your model selection and leads you to believe that your model is better than it really is.

Validity Assessment

Some of the various techniques and patterns to look for in assessing the validity of the model are as follows:

- Model validity can be checked against a saturated version of the factors with Lack of Fit tests. The Fit Model platform presents these tests automatically if you have replicated x data in a nonsaturated model.
- You can check the distribution assumptions for a continuous response by looking at plots of residuals and studentized residuals from the Fit Model platform. Or, use the Save commands in the platform popup menu to save the residuals in data table columns. Then use the Analyze > Distribution on these columns to look at a histogram with its normal curve and the normal quantile plot. The residuals are not quite independent, but you can informally identify severely non-normal distributions.
- The best all-around diagnostic tool for continuous responses is the leverage plot because it shows the influence of each point on each hypothesis test. If you suspect that there is a mistaken value in your data, this plot helps determine if a statistical test is heavily influenced by a single point. Leverage plots are described in the Modeling and Multivariate Methods book.
- It is a good idea to scan your data for outlying values and examine them to see if they are valid observations. You can spot univariate outliers in the Distribution platform reports and plots. Bivariate outliers appear in Fit Y by X scatterplots and in the Multivariate scatterplot matrix. You can see trivariate outliers in a three-dimensional plot produced by the Graph > Scatterplot 3D. Higher dimensional outliers can be found with Principal Components or Scatterplot 3D, and with Mahalanobis and jack-knifed distances computed and plotted in the Multivariate platform.

Alternative Methods

The statistical literature describes special nonparametric and robust methods, but JMP implements only a few of them at this time. These methods require fewer distributional assumptions (nonparametric), and then are more resistant to contamination (robust). However, they are less conducive to a general methodological approach, and the small sample probabilities on the test statistics can be time consuming to compute.

If you are interested in linear rank tests and need only normal large sample significance approximations, you can analyze the ranks of your data to perform the equivalent of a Wilcoxon rank-sum or Kruskal-Wallis one-way test.
If you are uncertain that a continuous response adequately meets normal assumptions, you can change the modeling type from continuous to ordinal and then analyze safely, even though this approach sacrifices some richness in the presentations and some statistical power as well.

Key Statistical Concepts

There are two key concepts that unify classical statistics and encapsulate statistical properties and fitting principles into forms you can visualize:

- a unifying concept of uncertainty
- two basic fitting machines.

These two ideas help unlock the understanding of statistics with intuitive concepts that are based on the foundation laid by mathematical statistics.

Statistics is to science what accounting is to business. It is the craft of weighing and balancing observational evidence. Statistical tests are like credibility audits. But statistical tools can do more than that. They are instruments of discovery that can show unexpected things about data and lead to interesting new ideas. Before using these powerful tools, you need to understand a bit about how they work.

Uncertainty, a Unifying Concept

When you do accounting, you total money amounts to get summaries. When you look at scientific observations in the presence of uncertainty or noise, you need some statistical measurement to summarize the data. Just as money is additive, uncertainty is additive if you choose the right measure for it.

The best measure is not the direct probability because to get a joint probability you have to assume that the observations are independent and then multiply probabilities rather than add them. It is easier to take the log of each probability because then you can sum them and the total is the log of the joint probability.

However, the log of a probability is negative because it is the log of a number between 0 and 1. In order to keep the numbers positive, JMP uses the negative log of the probability. As the probability becomes smaller, its negative log becomes larger. This measure is called uncertainty, and it is measured in reverse fashion from probability.

In business, you want to maximize revenues and minimize costs. In science you want to minimize uncertainty. Uncertainty in science plays the same role as cost plays in business. All statistical methods fit models such that uncertainty is minimized.

It is not difficult to visualize uncertainty. Just think of flipping a series of coins where each toss is independent. The probability of tossing a head is 0.5, and $-\log(0.5) = 1$ for base 2 logarithms. The probability of tossing $h$ heads in a row is simply

$$ p = \left(\frac{1}{2}\right)^h $$
Solving for $b$ produces

$$b = -\log \rho$$

You can think of the uncertainty of some event as the number of consecutive “head” tosses you have to flip to get an equally rare event.

Almost everything we do statistically has uncertainty, $-\log \rho$, at the core. Statistical literature refers to uncertainty as negative log-likelihood.

### The Two Basic Fitting Machines

An amazing fact about statistical fitting is that most of the classical methods reduce to using two simple machines, the spring and the pressure cylinder.

**Springs**

First, springs are the machine of fit for a continuous response model (Farebrother, 1987). Suppose that you have $n$ points and that you want to know the expected value (mean) of the points. Envision what happens when you lay the points out on a scale and connect them to a common junction with springs (see Figure A.6). When you let go, the springs wiggle the junction point up and down and then bring it to rest at the mean. This is what must happen according to physics.

If the data are normally distributed with a mean at the junction point where springs are attached, then the physical energy in each point's spring is proportional to the uncertainty of the data point. All you have to do to calculate the energy in the springs (the uncertainty) is to compute the sum of squared distances of each point to the mean.

To choose an estimate that attributes the least uncertainty to the observed data, the spring settling point is chosen as the estimate of the mean. That is the point that requires the least energy to stretch the springs and is equivalent to the least squares fit.

---

**Figure A.6** Connect Springs to Data Points

That is how you fit one mean or fit several means. That is how you fit a line, or a plane, or a hyperplane. That is how you fit almost any model to continuous data. You measure the energy or uncertainty by the sum of squares of the distances you must stretch the springs.
Statisticians put faith in the normal distribution because it is the one that requires the least faith. It is, in a sense, the most random. It has the most non-informative shape for a distribution. It is the one distribution that has the most expected uncertainty for a given variance. It is the distribution whose uncertainty is measured in squared distance. In many cases it is the limiting distribution when you have a mixture of distributions or a sum of independent quantities. It is the distribution that leads to test statistics that can be measured fairly easily.

When the fit is constrained by hypotheses, you test the hypotheses by measuring this same spring energy. Suppose you have responses from four different treatments in an experiment, and you want to test if the means are significantly different. First, envision your data plotted in groups as shown here, but with springs connected to a separate mean for each treatment. Then exert pressure against the spring force to move the individual means to the common mean. Presto! The amount of energy that constrains the means to be the same is the test statistic you need. That energy is the main ingredient in the $F$-test for the hypothesis that tests whether the means are the same.

Pressure Cylinders

What if your response is categorical instead of continuous? For example, suppose that the response is the country of origin for a sample of cars. For your sample, there are probabilities for the three response levels, American, European, and Japanese. You can set these probabilities for country of origin to some estimate and then evaluate the uncertainty in your data. This uncertainty is found by summing the negative logs of the probabilities of the responses given by the data. It is written

$$H = \sum b_{y(i)} = \sum \log p_{y(i)}$$

The idea of springs illustrates how a mean is fit to continuous data. When the response is categorical, statistical methods estimate the response probabilities directly and choose the estimates that minimize the total uncertainty of the data. The probability estimates must be nonnegative and sum to 1. You can picture the response probabilities as the composition along a scale whose total length is 1. For each response observation, load into its response area a gas pressure cylinder, for example, a tire pump. Let the partitions between the response levels vary until an equilibrium of lowest potential energy is reached. The sizes of the partitions that result then estimate the response probabilities.

Figure A.7 shows what the situation looks like for a single category such as the medium size cars (see the mosaic column from Carpoll.jmp labeled medium in Figure A.8). Suppose there are thirteen responses (cars). The first level (American) has six responses, the next has two, and the last has five responses. The
response probabilities become $6/13$, $2/13$, and $5/13$, respectively, as the pressure against the response partitions balances out to minimize the total energy.

Figure A.7 Effect of Pressure Cylinders in Partitions

As with springs for continuous data, you can divide your sample by some factor and fit separate sets of partitions. Then test that the response rates are the same across the groups by measuring how much additional energy you need to push the partitions to be equal. Imagine the pressure cylinders for car origin probabilities grouped by the size of the car. The energy required to force the partitions in each group to align horizontally tests whether the variables have the same probabilities. Figure A.8 shows these partitions.

Figure A.8 A Mosaic Plot for Categorical Data

Leverage Plot Details

Leverage plots for general linear hypotheses were introduced by Sall (1980). This section presents the details from that paper. Leverage plots generalize the partial regression residual leverage plots of Belsley, Kuh, and Welsch (1980) to apply to any linear hypothesis. Suppose that the estimable hypothesis of interest is

$$L\beta = 0$$
The leverage plot characterizes this test by plotting points so that the distance of each point to the sloped regression line displays the unconstrained residual, and the distance to the x-axis displays the residual when the fit is constrained by the hypothesis.

Of course the difference between the sums of squares of these two groups of residuals is the sum of squares due to the hypothesis, which becomes the main ingredient of the $F$-test.

The parameter estimates constrained by the hypothesis can be written

$$b_0 = b - (X'X)^{-1}L'\lambda$$

where $b$ is the least squares estimate

$$b = (X'X)^{-1}X'y$$

and where lambda is the Lagrangian multiplier for the hypothesis constraint, which is calculated

$$\lambda = (L(X'X)^{-1}L')^{-1}Lb$$

Compare the residuals for the unconstrained and hypothesis-constrained residuals, respectively.

$$r = y - Xb$$
$$r_0 = r + X(X'X)^{-1}L'\lambda$$

To get a leverage plot, the $x$-axis values $v_x$ of the points are the differences in the residuals due to the hypothesis, so that the distance from the line of fit (with slope 1) to the $x$-axis is this difference. The $y$-axis values $v_y$ are just the $x$-axis values plus the residuals under the full model as illustrated in Figure A.9. Thus, the leverage plot is composed of the points

$$v_x = X(X'X)^{-1}L'\lambda \text{ and } v_y = r + v_x$$

Figure A.9 Construction of Leverage Plot
Superimposing a Test on the Leverage Plot

In simple linear regression, you can plot the confidence limits for the expected value as a smooth function of the regressor variable \( x \)

\[
\text{Upper } (x) = xb + t_{\alpha/2} \sqrt{\frac{x(X'X)^{-1}x'}{b}}
\]

\[
\text{Lower } (x) = xb - t_{\alpha/2} \sqrt{\frac{x(X'X)^{-1}x'}{b}}
\]

where \( x = [1 x] \) is the 2-vector of regressors.

This hyperbola is a useful significance-measuring instrument because it has the following nice properties:

- If the slope parameter is significantly different from zero, the confidence curve will cross the horizontal line of the response mean (left plot in Figure A.10).
- If the slope parameter is not significantly different from zero, the confidence curve will not cross the horizontal line of the response mean (plot at right in Figure A.10).
- If the \( t \)-test for the slope parameter is sitting right on the margin of significance, the confidence curve will have the horizontal line of the response mean as an asymptote (middle plot in Figure A.10).

This property can be verified algebraically or it can be understood by considering what the confidence region has to be when the regressor value goes off to plus or minus infinity.

---

**Figure A.10** Cases of Significant, Borderline, and Nonsignificant Confidence Curves.

Leverage plots make use of the same device by calculating a confidence function with respect to one variable while holding all other variables constant at their sample mean value.

For general hypothesis tests, JMP can display a curve with the same properties: the confidence function shows at the mean value in the middle, with adjusted curvature so that it crosses the horizon if the \( F \)-test is significant at some \( \alpha \)-level like 0.05.
Consider the functions
\[
\text{Upper}(z) = z + \sqrt{z^2 + \frac{F}{\alpha^2}}
\]
and
\[
\text{Lower}(z) = z - \sqrt{z^2 + \frac{F}{\alpha^2}}
\]
where \( F \) is the \( F \)-statistic for the hypothesis, \( F_\alpha \) is the reference value for significance \( \alpha \), and \( \bar{h} = \bar{x}(XX)^{-1}\bar{x} \), where \( \bar{x} \) is the regressors at a suitable middle value, such as the mean.

These functions serve the same properties listed above. If the \( F \)-statistic is greater than the reference value, the confidence functions cross the \( x \)-axis. If the \( F \)-statistic is less than the reference value, the confidence functions do not cross. If the \( F \)-statistic is equal to the reference value, the confidence functions have the \( x \)-axis as an asymptote. And the range between the confidence functions at the middle value is a valid confidence region of the predicted value at the point.

### Multivariate Details

The following sections show computations used for multivariate tests and related, exact and approximate \( F \)-statistics, canonical details, and discriminant functions. In the following sections, \( E \) is the residual cross product matrix and \( \bar{h} = \bar{x}(XX)^{-1}\bar{x} \) estimates the residual covariance matrix. Diagonal elements of \( E \) are the sum of squares for each variable. In discriminant analysis literature, this is often called \( W \), where \( W \) stands for \( within \).

### Multivariate Tests

Test statistics in the multivariate results tables are functions of the eigenvalues \( \lambda \) of \( E^{-1}H \). The following list describes the computation of each test statistic.

**Note:** After specification of a response design, the initial \( E \) and \( H \) matrices are premultiplied by \( M' \) and postmultiplied by \( M \).

<table>
<thead>
<tr>
<th>Table A.16 Computations for Multivariate Tests</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wilk’s Lambda</strong></td>
</tr>
<tr>
<td>( \Lambda = \frac{\det(E)}{\det(H + E)} = \prod_{i=1}^{n} \left( \frac{1}{1 + \lambda_i} \right) )</td>
</tr>
<tr>
<td><strong>Pillai’s Trace</strong></td>
</tr>
<tr>
<td>( V = \text{Trace}[H(H + E)^{-1}] = \sum_{i=1}^{n} \frac{\lambda_i}{1 + \lambda_i} )</td>
</tr>
</tbody>
</table>
**Statistical Details**

**Multivariate Details**

The whole model $L$ is a column of zeros (for the intercept) concatenated with an identity matrix having the number of rows and columns equal to the number of parameters in the model. $L$ matrices for effects are subsets of rows from the whole model $L$ matrix.

### Approximate $F$-Test

To compute $F$-values and degrees of freedom, let $p$ be the rank of $H + E$. Let $q$ be the rank of $L(X'X)^{-1}L'$, where the $L$ matrix identifies elements of $XX$ associated with the effect being tested. Let $v$ be the error degrees of freedom and $s$ be the minimum of $p$ and $q$. Also let $m = 0.5(p - q - 1)$ and $n = 0.5(v - p - 1)$.

Table A.17 “Approximate F-statistics,” p. 652, gives the computation of each approximate $F$ from the corresponding test statistic.

**Table A.16 Computations for Multivariate Tests**

<table>
<thead>
<tr>
<th>Test</th>
<th>Approximate $F$</th>
<th>Numerator DF</th>
<th>Denominator DF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wilk’s Lambda</td>
<td>$F = \left(1 - \frac{1}{\lambda_i^{1/2}}\right)\frac{(rt - 2u)}{pq}$</td>
<td>$pq$</td>
<td>$rt - 2u$</td>
</tr>
<tr>
<td>Pillai’s Trace</td>
<td>$F = \frac{V}{s - V}\left(\frac{2n + s + 1}{2m + s + 1}\right)$</td>
<td>$s(2m + s + 1)$</td>
<td>$s(2n + s + 1)$</td>
</tr>
<tr>
<td>Hotelling-Lawley</td>
<td>$F = \frac{2(sn + 1)U}{r(2m + s + 1)}$</td>
<td>$s(2m + i + 1)$</td>
<td>$2(sn + 1)$</td>
</tr>
<tr>
<td>Trace</td>
<td>$F = \frac{\Theta(v - \max(p, q) + q)}{\max(p, q)}$</td>
<td>$\max(p, q)$</td>
<td>$v - \max(p, q) + q$</td>
</tr>
</tbody>
</table>

**Canonical Details**

The canonical correlations are computed as

$$\rho_i = \frac{\lambda_i}{\sqrt{1 + \lambda_i}}$$
The canonical Y’s are calculated as

\[ Y = YMV \]

where \( Y \) is the matrix of response variables, \( M \) is the response design matrix, and \( V \) is the matrix of eigenvectors of \( E^{-1}H \). Canonical Y’s are saved for eigenvectors corresponding to eigenvalues larger than zero.

The total sample centroid is computed as

\[ \text{Grand} = \bar{y}MV \]

where \( V \) is the matrix of eigenvectors of \( E^{-1}H \).

The centroid values for effects are calculated as

\[ m = (c'_1 \tilde{x}_j, c'_2 \tilde{x}_j, \ldots, c'_g \tilde{x}_j) \quad \text{where} \quad c_i = \left( \mathbf{E}_i \left( \frac{E}{(N-r)} \mathbf{v}_i \right) \right)^{-1/2} \mathbf{v}_i \]

and the \( v_i \)s are columns of \( V \), the eigenvector matrix of \( E^{-1}H \), \( \tilde{x}_j \) refers to the multivariate least squares mean for the \( j \)th effect, \( g \) is the number of eigenvalues of \( E^{-1}H \) greater than 0, and \( r \) is the rank of the \( X \) matrix.

The centroid radii for effects are calculated as

\[ d = \sqrt{\frac{\chi^2_g(0.95)}{L(X'X)^{-1}L'}} \]

where \( g \) is the number of eigenvalues of \( E^{-1}H \) greater than 0 and the denominator \( L's \) are from the multivariate least squares means calculations.

**Discriminant Analysis**

The distance from an observation to the multivariate mean of the \( i \)th group is the Mahalanobis distance, \( D^2 \), and computed as

\[ D^2 = (y - \bar{y}_j)'S^{-1}(y - \bar{y}_j) = y' S^{-1} y - 2y' S^{-1} \bar{y}_j + \bar{y}_j' S^{-1} \bar{y}_j \]

where

\[ S = \frac{E}{N-1} \]

In saving discriminant columns, \( N \) is the number of observations and \( M \) is the identity matrix.
The **Save Discrim** command in the popup menu on the platform title bar saves discriminant scores with their formulas as columns in the current data table. **SqDist[0]** is a quadratic form needed in all the distance calculations. It is the portion of the Mahalanobis distance formula that does not vary across groups. **SqDist[i]** is the Mahalanobis distance of an observation from the *i*th centroid. **SqDist[0]** and **SqDist[i]** are calculated as

\[
\text{SqDist}[0] = y' S^{-1} y
\]

and

\[
\text{SqDist}[i] = \text{SqDist}[0] - 2y' S^{-1} \bar{y}_i + \bar{y}_i' S^{-1} \bar{y}_i
\]

Assuming that each group has a multivariate normal distribution, the posterior probability that an observation belongs to the *i*th group is

\[
\text{Prob}[i] = \frac{\exp(\text{Dist}[i])}{\text{Prob}[0]}
\]

where

\[
\text{Prob}[0] = \sum e^{-0.5\text{Dist}[i]}
\]

**Power Calculations**

The next sections give formulas for computing LSV, LSN, power, and adjusted power.

**Computations for the LSV**

For one-degree-freedom tests, the LSV is easy to calculate. The formula for the *F*-test for the hypothesis

\[
L \beta = 0
\]

is:

\[
F = \frac{(Lb)'(LXX)^{-1}L'}{(Lb)'(LXX)^{-1}Lb}/r
\]

Solving for *Lb*, a scalar, given an *F* for some *α*-level, like 0.05, and using a *t* as the square root of a one-degree-of-freedom *F*, making it properly two-sided, gives

\[
(Lb)^{LSV} = t_{\alpha/2} \sqrt{L(X'X)^{-1}L'}
\]

For *L* testing some \( \beta_j \), this is

\[
b_{j}^{LSV} = t_{\alpha/2} \sqrt{(X'X)^{-1}}_{ii}
\]
which can be written with respect to the standard error as

\[ b_i^{LSV} = t_{\frac{\alpha}{2}} \text{stderr}(b_i) \]

If you have a simple model of two means where the parameter of interest measures the difference between the means, this formula is the same as the LSD, least significant difference, from the literature

\[ \text{LSD} = t_{\frac{\alpha}{2}} \sqrt{\frac{1}{n_1} + \frac{1}{n_2}} \]

In the JMP Fit Model platform, the parameter for a nominal effect measures the difference to the average of the levels, not to the other mean. So, the LSV for the parameter is half the LSD for the differences of the means.

**Computations for the LSN**

The LSN solves for \( n \) in the equation:

\[ \alpha = 1 - \text{ProbF} \left( \frac{n\delta^2}{\sigma^2}, \frac{dFH}{n} \right) \]

where

- \( \text{ProbF} \) is the central \( F \)-distribution function
- \( dFH \) is the degrees of freedom for the hypothesis
- \( \delta^2 \) is the squared effect size, which can be estimated by \( \frac{SS(H)}{n} \)

When planning a study, the LSN serves as the lower bound.

**Computations for the Power**

To calculate power, first get the critical value for the central \( F \) by solving for \( FC \) in the equation

\[ \alpha = 1 - \text{ProbF} \left( F_C, dFH, n - dFH - 1 \right) \]

Then obtain the probability of getting this critical value or higher

\[ \text{Power} = (1) - \text{ProbF} \left( F_C, dFH, n - dFH - 1, \frac{n\delta^2}{\sigma^2} \right) \]

The last argument to \( \text{ProbF} \) is the noncentrality value

\[ \lambda = \frac{n\delta^2}{\sigma^2}, \text{ which can be estimated as } \frac{SS(H)}{\sigma^2} \text{ for retrospective power.} \]
Computations for Adjusted Power

The adjusted power is a function of a noncentrality estimate that has been adjusted to remove positive bias in the original estimate (Wright and O’Brien 1988). Unfortunately, the adjustment to the noncentrality estimate can lead to negative values. Negative values are handled by letting the adjusted noncentrality estimate be

\[ \hat{\lambda}_{\text{adj}} = \max \left[ 0, \frac{\hat{\lambda}(N - dfR - 1) - 2}{N - dfH - 1} \right] \]

where \( N \) is the actual sample size, \( dfH \) is the degrees of freedom for the hypothesis, \( dfR \) is the degrees of freedom for regression in the whole model, \( F_s \) is \( F_{\text{sample}} \) and \( F_C \) is \( F_{\text{Crit}} \).

The adjusted power is

\[ \text{Power}_{\text{adj}} = 1 - \text{ProbF}[F_C, dfH, n - dfH - 1, \hat{\lambda}_{\text{adj}}] \]

where \( F_{\text{crit}} \) is calculated as above.

Confidence limits for the noncentrality parameter are constructed according to Dwass (1955) as

Lower CL for \( \hat{\lambda} \) = \( dfH(\max[0, \sqrt{F_s - \frac{1}{F_C}}])^2 \)

Upper CL for \( \hat{\lambda} \) = \( dfH(\sqrt{F_s - \frac{1}{F_C}})^2 \)

where \( F_{\text{sample}} \) is the \( F \)-value reported in the effect test report and \( F_{\text{crit}} \) is calculated as above. Power confidence limits are obtained by substituting confidence limits for \( \hat{\lambda} \) into

\[ \text{Power} = 1 - \text{ProbF}[F_C, dfH, n - dfH - 1, \hat{\lambda}] \]

Inverse Prediction with Confidence Limits

Inverse prediction estimates values of independent variables. In bioassay problems, inverse prediction with confidence limits is especially useful. In JMP, you can request inverse prediction estimates of a single effect for continuous, nominal, and ordinal response models. If the response is a nominal variable and there is a single continuous effect, you can also request confidence limits for the inverse prediction estimate.

The confidence limits are computed using Fieller’s theorem, which is based on the following logic. The goal is predicting the value of a single regressor and its confidence limits given the values of the other regressors and the response.

Let \( b \) estimate the parameters \( \beta \) so that we have \( b \) distributed as \( N(\beta, V) \).

Let \( x \) be the regressor values of interest, with the \( i \)th value to be estimated.

Let \( y \) be the response value.

We desire a confidence region on the value of \( x[i] \) such that \( \beta x = y \) with all other values of \( x \) given.
The inverse prediction is just

\[ x[i] = \frac{y - \beta'(i)x(i)}{\beta[i]} \]

where the parenthesized-subscript “(i)” means that the \( i \)th component is omitted. A confidence interval can be formed from the relation:

\[ (y - b'x)^2 < t^2 x'Vx \]

with specified confidence if \( y = \beta'x \). A quadratic equation results of the form

\[ z^2 g + zh + f = 0 \]

where

\[ g = b[i]^2 - t^2 V[i, i] \]
\[ h = -2yb[i] + 2b[i]b'(i)x(i) - 2t^2 V[i, i]'x(i) \]
\[ f = y^2 - 2yb'(i)x(i) + (b'(i)x(i))^2 - t^2 x(i)'V(i)x(i) \]

It is possible for the quadratic equation to have only imaginary roots, in which case the confidence interval becomes the entire real line. In this situation, Wald intervals are used. If only one side of an interval is imaginary, the Fieller method is still used, but the imaginary side is returned as missing.

**Note:** JMP uses \( t \) values when computing the confidence intervals for inverse prediction. SAS uses \( z \) values, which can give different results.

## Details of Random Effects

The variance matrix of the fixed effects is always modified to include a Kackar-Harville correction. The variance matrix of the BLUPs and the covariances between the BLUPs and the fixed effects are not Kackar-Harville corrected because the corrections for these can be quite computationally intensive and use lots of memory when there are lots of levels of the random effects. In SAS, the Kackar-Harville correction is done for both fixed effects and BLUPs only when the `DDFM=KR` is set, so the standard errors from `PROC MIXED` with this option will differ from all the other options.

This implies:

- Standard errors for linear combinations involving only fixed effects parameters will match `PROC MIXED DDFM=KR`, assuming that one has taken care to transform between the different parameterizations used by `PROC MIXED` and JMP.
- Standard errors for linear combinations involving only BLUP parameters will match `PROC MIXED DDFM=Satterth`.
- Standard errors for linear combinations involving both fixed effects and BLUPS do not match `PROC MIXED` for any `DDFM` option if the data are unbalanced. However, these standard errors are between what
you get with the `DDFM=SATTERTH` and `DDFM=KR` options. If the data are balanced, JMP matches SAS for balanced data, regardless of the `DDFM` option, since the Kackar-Harville correction is null.

The degrees of freedom for tests involving only linear combinations of fixed effects parameters are calculated using the Kenward and Roger correction, so JMP’s results for these tests match `PROC MIXED` using the `DDFM=KR` option. If there are BLUPs in the linear combination, JMP uses a Satterthwaite approximation to get the degrees of freedom. So, the results follow a pattern similar to what is described for standard errors in the preceding paragraph.

For more details of the Kackar-Harville correction and the Kenward-Roger DF approach, see Kenward and Roger(1997). The Satterthwaite method is described in detail in the SAS `PROC MIXED` documentation.
Symbols
&LogVariance 157
&Random 110
^, redundant leaf labels 309

Numerics
2D Gaussian Process Example.jmp 289
–2LogLikelihood 344
95% bivariate normal density ellipse 426

A
Accept Current Estimates 243
Actual by Predicted 214
Actual by Predicted Plot 318
actual vs. regressor plot see Leverage Plot
Add 7–8, 97
Add Column 64
Add Multivariate Noise 574
Add Random Noise 574
Add Random Weighted Noise 574
added variable plot 37
ADF tests 352
Adjusted Power and Confidence Interval 74–75
agglomerative clustering 445
Agreement Statistic 378
AIC 344
AIC 123
Akaike’s Information Criterion 344
algorithms 621–658
Aligned Responses 368
Alpha 73
Alt-click 541
Alter Linear Constraints 545, 571
alternative methods 644
analysis of covariance example 52
analysis of variance example 50
Analysis of Variance table 25, 30–31, 99, 170
Angular Frequency 340

Animals.jmp 110
Annual 335
Append Settings to Table 544
Approx. F 143
approximate F test 652
ApproxStdErr 249
AR Coefficients 333, 338
ArcBall 531
ARIMA 333, 347–349, 359
Arrhenius 12
ArrheniusInv 12
assess validity 644
assumptions 643–645
AttributeGage.jmp 381
Augmented Dickey-Fuller test 352
Autocorrelation 337, 342
autocorrelation 336–337
Autocorrelation Lags 335
Automatic Histogram Update 575
autoregressive coefficients see AR coefficients
Autoregressive Order 348
Average Linkage 451

B
Backward 121, 124
Baltic.jmp 491
bar chart of correlations 429
Bartlett’s Kolmogorov-Smirnov 340
Baseball.jmp 108
Bayes Plot 84–86
between-subject 110, 146
bibliographic references 609–620
BIC 344
Big Class.jmp 32
Biplot 455
Biplot 3D 456
Biplot Options 456
Biplot Ray Position 456, 483
diplot rays 470
Biquartimax 473
Biquartimin 473
Birth Death Subset.jmp 447
bivariate normal density ellipse 426
Borehole Latin Hypercube.jmp 294
Bounded 360
Box Cox Y Transformation 91, 100–101
Box-Jenkins model see ARIMA
Box-Meyer Bayesian analysis 84
Brown smoothing 361
By role 242, 267

C
C. Total 29–30
calculation details 621–658
calibration 66–69
Candidates report, Partition platform 301
Canonical 3D Plot 484
canonical axis 150
Canonical Corr 150
canonical correlation 135, 151, 652
Canonical Curvature report 99
Canonical Options 483
canonical variables 149
Car Poll.jmp 379
Center Polynomials 15, 63
centroid 432, 440, 653
Centroid Method 451
Centroid Plot 149–150
Centroid Val 150
Cheese.jmp 188
Chemical Kinetics.jmp 252
Chi Square 172
Chi-Square 171
Choice Modeling 383–420
Choice Platform
  Launch Platform 388
  Response Data 389
  Segmentation 405
  Single Table Analysis 402
  subject effects 392
Cholesterol.jmp 147
citations 609–620
classification variable 152
Close All Below (Partition Platform) 307
Cluster platform 443–460
  compare methods 445
  example 447
  hierarchical 447–452
  introduction 445–446
  k-means 453–460
  launch 446–447
  normal mixtures 456–461
Cluster the Correlations 429
Clustering History table 447, 449
Coding column property 62
collinearity 40
Color Clusters and Mark Clusters 450
Color Map 450
Color Map On Correlations 429
Color Map On p-values 429
Color Points 309, 483
Column Contributions 308
Column Info 48
column property
  Coding 62
Combine 126, 128
Common Factor Analysis 471
Complete Linkage 452
Compound 140–141, 147
compound multivariate example 147–148
computational details 621–658
Conditional Confidence CI 113
Conditional Mean CI 113
Conditional Pred Formula 113
Conditional Pred Values 113
Conditional Predictions 114, 546
Conditional Residuals 113
Confidence Intervals 234
Confidence Intervals 175, 348, 360, 396, 542
Confidence Limits 233, 242, 249, 263, 267
Confidence Limits Button 234
Connecting Lines 337
Connecting Lines Report 45
constant estimate 345
Constrain fit 348
Constraints 555
Construct Model Effects 5
contaminating 84
Continue 14
continuous response model 623
Contour Grid 358, 362
Contour Label 358
Contour Profiler 91–92, 161–162, 213, 244, 357–594
Contrast 221
Contrast 140, 145–146, 149, 211
contrast 43
contrast M matrix 140, 146, 651
Control Panel 120–121, 231, 233
Control-click 8, 116
converge see iteration
Cook's D Influence 49
Copy Settings Script 544
Corrected Akaike's Information Criterion 123
correlation 421–441
correlation matrix 424
Correlation of Estimates 79, 213, 396
Correlation Type 289
Correlations Multivariate 424
Cosine 340
count data 195
covariance 421–441
Covariance Matrix 429
Covariance of Estimates 213
Covarimin 473
Cp 123
CrabSatellites.jmp 203
Create SAS Job 347
Cronbach's alpha 434–436, 441
Cross 7–8, 97
Cross Correlation 352
Cross Validation 492
crossed term 114
cross-product term 125, 538
Crosstab 377
Crosstab Transposed 377
Cross-validation 489
cross-validation report 493
Cube Plots 91, 96–97
Cubic 289
cumulative logistic probability plot 178
Current Estimates table 120–121
current predicted value 91, 537
Current Value 242, 542
current value 91, 537
Custom 140, 360
Custom Estimate 246
Custom Inverse Prediction 246
custom loss function 229, 233, 253–255
Custom Profiler 571
Custom Test 11, 64–65, 72, 149, 211
CV for variance components 116
Cytometry.jmp 454

D
Daganzo Trip.jmp 414
Daily 335
damped-trend linear exponential smoothing 361
Danger.jmp 435
Data Filter 545
data table of frequencies 195
decision trees 299
Default N Levels 546
Defect Parametric Profile 575, 583
Defect Profiler 580
Defect Profiler 575, 582
degenerate interval 68
Degree 6
Degree box 9
degrees of freedom 30
Delete Last Column 141
Delta 73
DenDF 143
dendrogram 445, 447–448
Dendrogram Scale command 450
Density Ellipse 426–427
derivative 264–265
design code 621
design matrix 639
desirability confidence curve 91, 537
Desirability Functions 543, 546
desirability trace 546
Detailed Comparisons Report 45
Detergent.jmp 183
deviance 202
Deviance Residuals by Predicted 214
DF 30, 32, 35, 171, 343
DFE 122, 248
diagnostic for SLS fit 31
Diagnostics Plots 500
Difference 171, 341
Differencing Order 348
dimensionality 467
discriminant analysis 135, 152, 653
Dispersion Effects 155–164
distance column 152
Distance Graph 450
Distance Scale 450
Distribution platform 644
DOE menu overview 78
Dogs.jmp 145
Dose Response.jmp 176
double exponential smoothing 361
double-click 75
drag 91, 96, 335, 428, 448, 537, 539, 547, 558
Drug.jmp 23, 49, 52, 54
dummy coding 33, 55, 61, 627
Durbin-Watson Test 47
Index

E

E matrix 139, 142, 152, 651
Edit Formula 48
effect 626–643
Effect Attributes 6
Effect Attributes and Transformations 10–12
Effect Leverage 14, 23, 27
Effect Leverage Pairs 49
Effect Leverage Plot 24
Effect Macros 6–9, 97
Effect Marginals 396, 401
Effect Screening 14, 27, 47, 57, 62, 80–82, 84–87
Effect Screening table 80
effect sparsity 80, 219
Effect Test table 4, 34
effective hypothesis tests 631
EigenValue 150
eigenvalue decomposition 99, 467–468, 653
Eigenvectors 469
Eigvec 150
Ellipse alpha 428
Ellipse Color 428
Ellipses Transparency 428
EM algorithm 453
Emphasis 14, 27
EMS (Traditional) 108
EMS method 64
Enter All 121, 124
Entered 122
epsilon adjustment 144
Equamax 473
Equivalence Test 45
Error 30–31
error matrix 142
error terms 111
Estimate 33, 82, 122, 249, 345, 348, 360
Estimate Nugget Parameter 289
Estimates 47, 57, 61, 64, 66, 72, 79–87
Even Spacing 450
evolution 359
Exact F 141
Excluded Effect 10
excluded rows 29
Exercise.jmp 151
Expand Intermediate Formulas 37, 555
Expand Into Categories, selecting column 239
Expanded Estimates 61
Expectation Maximization algorithm 453
expectation step 445
exponential regression example 231–235
exponential smoothing see Smoothing Models
Expression 574

F

F Ratio 31–32, 35
F Ratio
in quotes 122
F test, joint 64
Factor 345
factor analysis 434, 467–474
factor model 626–643
Factor Profiling 41, 47, 92, 95–96, 100–101
Factor Rotation 470
Factor Settings 544, 571
Factorial Sorted 9
Factorial to Degree 9
Factorparsimax 473
failure3Delimited.jmp 372
Failure3Freq.jmp 370
failure3Freq.jmp 380
failure3ID.jmp 373
failure3Indicators.jmp 371
failure3MultipleField.jmp 374
fiducial confidence limits 68
Fieller’s method 68
Filtered Monte Carlo 545
First 265
Firth Bias-adjusted Estimates 412
Fish Patty.jmp 564
Fisher’s Kappa 340
Fit Group 15, 605
Fit Model
Transformations 12
Fit Model dialog 1–16
Fit Model platform 1, 111, 119, 128, 137, 151–152, 194, 628
analysis of covariance 5–6, 52
analysis of variance 5–6, 23–26, 50
dialog overview 1–16
effects attributes 10–12
effects buttons 7–8
effects macros 8
Emphasis 14, 27
eexample 3–4, 66–69, 78–79, 92, 98–100,
108–109, 549–551, 557–559
examples 49
expanded estimates 61
fitting personality 12–13
launch 3–16
Index

logistic regression 165
Manova 5
multiple regression 5–6
multiple response 135–152
nested model 5–6
other options 15–16
polynomial regression 5–6
power analysis 71
prediction equation 101
random effects 105
repeated measures 5–6
response buttons 7
response surface 5–6
row diagnostics 46–47
Save 48–49
simple regression 5–6
SLS estimates 57–87
SLS introduction 21
SLS prediction equation 89
split-plot 5–6
stepwise regression 117
categorical terms 127–128
validity check 14
Fit Separately 15
Fit Special 232
Fit Y by X platform 152, 165, 189
Fitness.jmp 3, 119, 123
fitting machines 645
fitting personality 1, 3, 12–13
fitting principles 623–626
Five Factor Mixture.jmp 566
Fixed 573
Fixed 360
Flash object in Profiler 542
Football.jmp 127
forecast 333, 341–363
Forecast Periods 335, 346
Forecast plot 346
formula
editor 231–232
loss function 232
model 232
nonlinear fit 229
formulas used in JMP calculations 621–638
Forward 121, 123
Freq role 7, 78, 168, 178, 233
Frequency 340
frequency data table 195
Full 171
Full Factorial 6, 8, 184

full factorial Anova see Fit Model platform
Full Quadratic Model 18

G
Gaussian 289
Gaussian Process 287
Gaussian Process 289
Gauss-Newton method 229, 254
general fitting platform 1
Generalized Linear Model 13
Geometric Spacing 450
G-G 144
Go 84, 121, 123, 233, 241–242, 245, 248, 252, 263, 267, 310
goal SSE 250
Golf Balls.jmp 137
Goodness of Fit test 172
Graph 337, 341
Graph Updating 558
Greenhouse-Geisser 144
Grid Density 558
group similar rows see Cluster platform

H
H matrix 139, 142, 152, 651
Half Normal plot 221, 223
Hardware Acceleration 531
Hats 48
Helmert 140, 145
Hessian 254
H-F 144
hidden column 160
Hierarchical 446
hierarchical effects 128
Hoeffding’s D 431, 439
Holt smoothing 361
homogeneity of slopes 54
Hotelling-Lawley Trace 143
Hourly 335
Huynh-Feldt 144
hypothesis 647
hypothesis SSCP matrix 142
hypothesis test 630–637, 640

I
Identity 140, 151
Indicator Group 369
Indiv Confidence Interval 161
Individ Confidence Interval 48
Ingots.jmp 167, 178, 195
Ingots2.jmp 195, 260
InjectionMolding.jmp 158
interaction effect 31, 125, 538, 628
Interaction Plots 41, 95–96
Interaction plots 91
Interaction Profiler 546
Intercept 348
intercept 345
Inverse Corr table 425
inverse correlation 425, 440
Inverse Prediction 66–69, 178
inverse prediction 656–658
InvertExpr 247
Invertible 345
InvPred 247
Iris.jmp 149, 152, 457, 477
IRLS 257–260
IRLS Example.jmp 257
Isosurface 522
item reliability 434–436
Iter 346
Iteration Control Panel 231, 233
Iteration History 346
Iteration History report 170, 346, 624
Iteration Log 243
iteratively reweighted least squares 257–260

J
jackknife 432
Jackknife Distances 431
joint F test 64
Joint Factor Tests 396, 401
JSL 15, 267

K
K Fold Crossvalidation 308
Kendall’s Tau 431
Kendall’s tau-b 438
key concepts 645
KMeans 453
K-Means Clustering Platform
   SOMs 461
      Technical Details 463
Knotted Spline Effect 10
Knotted Splines
test for curvature 11
Kruskal-Wallis 644

L
L matrix 651
lack of fit error 31, 53
Lack of Fit table 31–33, 172, 189
Lag 345
Laptop Profile.jmp 397
Laptop Runs.jmp 398
Laptop Subjects.jmp 399
Latin Square design 114
layered design 105, 114
Leaf Report 308
least significant number 71, 76–77, 654–656
least significant value 71, 76–77, 654–656
Least Sq Mean 41
least squares fit
   estimates 57–87
   introduction 21, 623
   prediction equation 89, 101
least squares means 25, 630, 640
Least Squares Means table 26, 41, 138
Legend 450
Lenth’s method 80
Lenth’s PSE 221, 225
Lenth’s t-ratio 223
Level 41
level smoothing weight 359
Leverage Plot 23, 36–40, 54, 648–651
   confidence curves 39
      interpret 39–40
Lift Curve 321
Lift Curves 321
likelihood confidence intervals 249
Likelihood Ratio test 174, 189
Likelihood Ratio Tests 391
Likelihood Ratio Tests 174, 396
limitations of techniques 643–645
linear combination 467
Linear Constraints 563
Linear Constraints 555
linear dependence 631–634
linear exponential smoothing 361
Linear Model 17
linear rank tests 644
Link Profilers 544
Load Version 3 Model 16
Loading Plot 469
Loading Plots 499
Lock 122, 307
Lock Columns
   Partition platform 308
<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Factor Setting</td>
<td>542, 545</td>
</tr>
<tr>
<td>Lock Z Scale</td>
<td>525</td>
</tr>
<tr>
<td>Log</td>
<td>243</td>
</tr>
<tr>
<td>Log Iterations</td>
<td>571</td>
</tr>
<tr>
<td>Log Variance Effect</td>
<td>10</td>
</tr>
<tr>
<td>Logistic platform example</td>
<td>182–195, 253–256</td>
</tr>
<tr>
<td>response function</td>
<td>165</td>
</tr>
<tr>
<td>also see Fit Model platform, Fit Y by X platform</td>
<td></td>
</tr>
<tr>
<td>Logistic Stepwise Regression</td>
<td>129</td>
</tr>
<tr>
<td>Logistic w Loss.jmp</td>
<td>255</td>
</tr>
<tr>
<td>—LogLikelihood</td>
<td>171</td>
</tr>
<tr>
<td>Log-Linear Variance</td>
<td>155</td>
</tr>
<tr>
<td>LogLinear Variance</td>
<td>13</td>
</tr>
<tr>
<td>LogLinear Variance Model</td>
<td>155, 157–164</td>
</tr>
<tr>
<td>log-variance effect</td>
<td>157</td>
</tr>
<tr>
<td>longitudinal data</td>
<td>145</td>
</tr>
<tr>
<td>Loss</td>
<td>255</td>
</tr>
<tr>
<td>loss function</td>
<td>229, 232</td>
</tr>
<tr>
<td>custom</td>
<td>229, 253–255</td>
</tr>
<tr>
<td>Lost DFs</td>
<td>35</td>
</tr>
<tr>
<td>Lower CL and Upper CL</td>
<td>249</td>
</tr>
<tr>
<td>LS Means Plot</td>
<td>26</td>
</tr>
<tr>
<td>LSL Chop</td>
<td>584</td>
</tr>
<tr>
<td>LSMeans</td>
<td>42</td>
</tr>
<tr>
<td>LSMMeans Contrast</td>
<td>26, 43–45, 51</td>
</tr>
<tr>
<td>LSMMeans Plot</td>
<td>25, 41</td>
</tr>
<tr>
<td>LSMMeans Student’s t</td>
<td>45</td>
</tr>
<tr>
<td>LSMMeans Tukey’s HSD</td>
<td>45</td>
</tr>
<tr>
<td>LSN</td>
<td>71, 76–77, 654–656</td>
</tr>
<tr>
<td>LSV</td>
<td>71, 76–77, 654–656</td>
</tr>
<tr>
<td>Lung Cancer Responses.jmp</td>
<td>410</td>
</tr>
<tr>
<td>Lung Cancer.jmp</td>
<td>412</td>
</tr>
</tbody>
</table>

**M**

<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>M matrix</td>
<td>140, 142, 146, 651</td>
</tr>
<tr>
<td>machines of fit</td>
<td>645</td>
</tr>
<tr>
<td>Macros</td>
<td>8, 98, 184</td>
</tr>
<tr>
<td>MAE</td>
<td>344</td>
</tr>
<tr>
<td>Mahalanobis distance</td>
<td>432, 440</td>
</tr>
<tr>
<td>plot</td>
<td>431</td>
</tr>
<tr>
<td>Make Formula</td>
<td>236</td>
</tr>
<tr>
<td>Make Model</td>
<td>121, 128–129, 222</td>
</tr>
<tr>
<td>Make Table</td>
<td>575, 577</td>
</tr>
<tr>
<td>Mallow’s Cp criterion</td>
<td>123</td>
</tr>
<tr>
<td>Manova</td>
<td>13, 135</td>
</tr>
<tr>
<td>MANOVA</td>
<td>5, 13, 105, 143</td>
</tr>
<tr>
<td>Manova test tables</td>
<td>143</td>
</tr>
<tr>
<td>MAPE</td>
<td>344</td>
</tr>
<tr>
<td>Mauchly criterion</td>
<td>144</td>
</tr>
<tr>
<td>Max</td>
<td>244</td>
</tr>
<tr>
<td>Max RSq</td>
<td>33</td>
</tr>
<tr>
<td>Maximization Options</td>
<td>543</td>
</tr>
<tr>
<td>maximization step</td>
<td>446</td>
</tr>
<tr>
<td>Maximize</td>
<td>548</td>
</tr>
<tr>
<td>Maximize Desirability</td>
<td>543</td>
</tr>
<tr>
<td>Maximize for Each Grid Point</td>
<td>543</td>
</tr>
<tr>
<td>Maximize for each Grid Point</td>
<td>395</td>
</tr>
<tr>
<td>maximum likelihood</td>
<td>167, 624</td>
</tr>
<tr>
<td>Maximum Value</td>
<td>542</td>
</tr>
<tr>
<td>Mean</td>
<td>41, 140, 145</td>
</tr>
<tr>
<td>mean</td>
<td>623</td>
</tr>
<tr>
<td>Mean Confidence Interval</td>
<td>48, 161</td>
</tr>
<tr>
<td>Mean Line</td>
<td>337</td>
</tr>
<tr>
<td>mean model</td>
<td>157, 164</td>
</tr>
<tr>
<td>Mean of Response</td>
<td>29</td>
</tr>
<tr>
<td>mean shift</td>
<td>584</td>
</tr>
<tr>
<td>Mean Square</td>
<td>30, 32</td>
</tr>
<tr>
<td>measurement study</td>
<td>105</td>
</tr>
<tr>
<td>Mesh</td>
<td>530</td>
</tr>
<tr>
<td>Method</td>
<td>108</td>
</tr>
<tr>
<td>Min</td>
<td>244</td>
</tr>
<tr>
<td>Minimal Report</td>
<td>14, 27</td>
</tr>
<tr>
<td>Minimize</td>
<td>548</td>
</tr>
<tr>
<td>Minimum Setting</td>
<td>542</td>
</tr>
<tr>
<td>Minimum Size Split</td>
<td>308</td>
</tr>
<tr>
<td>Minimum Theta Value</td>
<td>289</td>
</tr>
<tr>
<td>Minute</td>
<td>335</td>
</tr>
<tr>
<td>missing cells</td>
<td>631–634, 640</td>
</tr>
<tr>
<td>nominal vs. ordinal factor</td>
<td>641–643</td>
</tr>
<tr>
<td>missing value</td>
<td>424</td>
</tr>
<tr>
<td>missing values</td>
<td>429</td>
</tr>
<tr>
<td>missing values (Fit Model)</td>
<td>14</td>
</tr>
<tr>
<td>Mixed</td>
<td>121</td>
</tr>
<tr>
<td>mixed model</td>
<td>103, 105</td>
</tr>
<tr>
<td>Mixture Effect</td>
<td>10</td>
</tr>
<tr>
<td>Mixture Profiler</td>
<td>560</td>
</tr>
<tr>
<td>Mixture Response Surface</td>
<td>9</td>
</tr>
<tr>
<td>Model</td>
<td>15, 30–31, 171</td>
</tr>
<tr>
<td>Model Comparison table</td>
<td>342</td>
</tr>
<tr>
<td>Model Dialog</td>
<td>396</td>
</tr>
<tr>
<td>Model effects</td>
<td>3</td>
</tr>
<tr>
<td>model effects buttons</td>
<td>7–8</td>
</tr>
<tr>
<td>model formula</td>
<td>232</td>
</tr>
<tr>
<td>Model Library</td>
<td>235</td>
</tr>
<tr>
<td>model significance</td>
<td>36</td>
</tr>
<tr>
<td>Model Summary table</td>
<td>343, 348</td>
</tr>
<tr>
<td>Monte Carlo simulation</td>
<td>219</td>
</tr>
</tbody>
</table>
Monthly 335
Moving Average Order 348
MSE 122, 248
Multiple Delimited 369
Multiple Response 369
Multiple Response by ID 369
Multiple Response fitting 135–152, 539, 549
Multivariate 574
Multivariate 421, 423
multivariate analysis of variance see Fit Model platform
multivariate estimates 141
multivariate least-squares means 149
multivariate mean 135, 432, 440
multivariate outliers 432
Multivariate platform 421–441, 651–654
example 435–436
principal components 434–474
multivariate regression 135–152

N

N Runs 575
N Strata 575, 606
nDF 122
Negative Exponential.jmp 264
negative log-likelihood 170, 646
negative variance components 107
Nest 7–8
nested effect 111, 114, 629, 635
neutral values 40
New Column 44
New Parameter dialog 231
Newton 243
Newton-Raphson method 229, 254
No Center 492
No Noise 574
No Rules 126
No Scale 492
Noah Decay.jmp 78
Noise Factors 594–600
Noise Factors 537
Nominal 172
nominal factor 627, 630–634
Nominal Logistic 13
nominal response model 623–625
nonestimable 626
Nonlinear 234
Nonlinear Model Library 235
Customizing 239
Nonlinear platform 229, 252, 255, 258, 263–269
derivatives 264–265
example 252
launch 252
nonmodal dialog box 3
Nonparametric Correlations 431
Nonparametric Measures of Association table 431
nonstationary time series 341
Norm KHC 113
Normal censored 573
normal density ellipse 426
normal distribution 106, 647
Normal Plot 83
Normal Truncated 573
Normal Weighted 606
Normal weighted 573, 577
Nparm 35
Nugget parameters 292
null hypothesis 71
Number 73
Number of Clusters 450
Number of Forecast Periods 341
Number of Plots Across 510
Number of Plotted Points 542
Number of Points 245
NumDeriv 265
Numeric Derivatives Only 243

O

Obiquartimax 473
Obequamax 473
Obfactorparsimax 473
Obj-Criterion 347
Oblimin 473
Obparsimax 474
Obquartimax 474
Observations 29, 172
Obvarimax 474
Odds Ratio 176
Odds Ratio Example 176
Odor Control Original.jmp 98
Offset 205
offset variable 205
Optimal Value 307
Option-click 341
OPTMODEL formulas 342
Ordered Differences Report 45
Index

ordinal crossed model 640
ordinal factor 640
ordinal interaction 639
ordinal least squares means 640
Ordinal Logistic 13
ordinal logistic regression 187
ordinal response model 623, 625–626
Orthog Coded 83
Orthog t-Ratio 83–84
Orthogonalize 141
Orthomax 473
orthonormal response design matrix 143
Other 428
Outlier Analysis 431–434
Outlier Distance plot 440
Output Grid Table 545
Output Random Table 545
Output Split Table 307
outside interval 68

P
p, d, q parameters 348
Pairwise Correlations 424
Pairwise Correlations table 429
Parallel Coord Plots 436
Parallel Coordinate Plot 436
Parameter 64, 122, 244, 248
Parameter Bounds 242
Parameter Contour Profiler 244
Parameter Estimate Population table 80–83
Parameter Estimates Population table 83
Parameter Estimates table 4, 33, 99, 138, 205, 345
parameter interpretation 627
Parameter Power 71–72
Parameter Profiler 244
Parameter Surface Profiler 244
Parameters 231
parameters in loss function 255
Parametric Survival 13
Pareto Plot 86
Parsimax 473
Partial Autocorrelation 337, 342
partial autocorrelation 336
Partial Corr table 139, 426
partial correlation 426
partial-regression residual leverage plot 37
Partition 297
Partition Platform 297–305
Paste Settings Script 544
PCA 434, 467–474
Pearson correlation 429, 438
Pearson Residuals By Predicted 214
Per Mouse Move 558
Per Mouse Up 558
Percent Variance Explained 493
Period 340
periodicity 349
Periodogram 341
periodogram 339
Periods Per Season 349, 360
personality 1, 3, 119
Pillai’s Trace 143
Pizza Choice Example 387–409
Pizza Combined.jmp 403
Pizza Profiles.jmp 389, 405
Pizza Responses.jmp 389, 405
Pizza Subjects.jmp 392, 405
Plot 243
Plot Actual by Predicted 47, 161
Plot Actual by Predicted (Partition) 308
Plot Effect Leverage 47
Plot Residual By Predicted 47
Plot Residual By Row 47
Plot Studentized Residual by Predicted 161
Plot Studentized Residual by Row 161
PLS 489–502
components 489
latent vectors 489
Missing Values 502
Platform Options 497
Statistical Details 502
Poisson loss function 262–264
Polynomial 140, 145
Polynomial to Degree 6, 9
Popcorn.jmp 42
population of levels 103
posterior probability 85
power 71, 77
Power Analysis 71–72, 77–87, 654–656
Power Plot 75–76
Predicted Values 48
Prediction Column role 231
prediction equation 54, 89, 101
Prediction Formula 48, 99, 160
prediction formula 180, 231, 626–639
Prediction Intervals 162
Prediction Profiler 91, 537
Predictor role 255–256, 258, 263
Press 47
Press Residuals 496
pressure cylinders fitting machine 647
Principal Components 471
principal components analysis 434, 467–474
prior probability 84
Prob to Enter 120
Prob to Leave 120
Prob>|t| 31, 83, 345
Prob>ChiSq 171
Prob>F 31, 33, 35, 143
Prob>F in quotes 122
probit example 260–262
process disturbance 333
product-moment correlation 429, 438
Profile 140, 145
profile confidence limits 250–251
Profile data 386
profile likelihood confidence intervals 249
profile trace 537
Profiler
and saved standard error formulas 49
Profiler 91, 161–162, 183, 213, 244, 396, 537
Profiler s 533–600
Prop of Error Bars 542, 551
Proportional Hazards 13
Proportional Hazards
also see Fit Model platform
prospective power analysis 77–79
Prune Below 307
Prune Worst 307–308
pseudo standard error 80
pure error 31

Q
quadratic equation 657
quadratic ordinal logistic regression 193
Quartimax 473
Quartimin 474
QuasiNewton BFGS 243
QuasiNewton SR1 243
questionnaire analysis 434–436

R
R 122
&R Random 110
Random 573
Random 6
Random Effect 10, 110–111, 119
random effects 64, 105
introduction 105
Range Odds Ratios 175
Rater Agreement 369
Reaction, jmp 82–83, 91, 95, 101, 125
reduce dimensions 467
Reduced 171
Ref Labels 562
Ref Lines 562
references 609–620
relative significance 643
reliability analysis 434–436
also see Survival platform
Remember Settings 544, 570
Remember Solution 245, 249
REML (Recommended) 108
REML method 64
results 112–113
Remove 7, 335
Remove All 121
Remove Contour Grid 562
Repeated Measures 140, 368
repeated measures design 105, 135
example 145, 147–148
replicated points 31
report layout emphasis 27
Reset 233, 241–242, 267
Reset Factor Grid 544
residual 30
residual matrix 142
Residual Statistics 347
residual/restricted maximum likelihood 112–113
Residuals 48, 161
residuals 105, 146, 623
Response data 386
Response Frequencies 369
Response Limits 576
response models 623–626
Response role 232
Response Specification dialog 140
Response Surface 6, 9, 97, 192
response surface 97–100
Response Surface Effect 10
Response Surface table 99
Restrict 126, 128
restricted vs. unrestricted parameterization 107
retrospective power analysis 71–72
rho see loss function
right-click 113, 116
RMSE 73, 85
<table>
<thead>
<tr>
<th>Index</th>
<th>669</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>S</strong></td>
<td></td>
</tr>
<tr>
<td>SALT IN POPCORN.JMP</td>
<td>194</td>
</tr>
<tr>
<td>sample autocorrelation function</td>
<td>337</td>
</tr>
<tr>
<td>sample of effects</td>
<td>103</td>
</tr>
<tr>
<td>SAMPLE SIZE AND POWER</td>
<td>78</td>
</tr>
<tr>
<td>Sampled</td>
<td>573</td>
</tr>
<tr>
<td>SAS GLM procedure</td>
<td>621, 623–637</td>
</tr>
<tr>
<td>saturated</td>
<td>32</td>
</tr>
<tr>
<td>save</td>
<td>47, 180, 246, 342, 644</td>
</tr>
<tr>
<td>Save as Flash (SWF)</td>
<td>542</td>
</tr>
<tr>
<td>Save Best Transformation</td>
<td>101</td>
</tr>
<tr>
<td>Save Canonical Scores</td>
<td>149, 151, 484</td>
</tr>
<tr>
<td>Save Cluster Hierarchy</td>
<td>450</td>
</tr>
<tr>
<td>Save Clusters</td>
<td>450, 456</td>
</tr>
<tr>
<td>Save Coding Table</td>
<td>49</td>
</tr>
<tr>
<td>Save Columns</td>
<td>99, 214, 347</td>
</tr>
<tr>
<td>Save Density Formula</td>
<td>456</td>
</tr>
<tr>
<td>Save Desirabilities</td>
<td>543</td>
</tr>
<tr>
<td>Save Desirability Formula</td>
<td>544</td>
</tr>
<tr>
<td>Save Discrim</td>
<td>152, 664</td>
</tr>
<tr>
<td>Save Display Order</td>
<td>450</td>
</tr>
<tr>
<td>Save Estimates</td>
<td>242, 259, 267</td>
</tr>
<tr>
<td>Save Expanded Formulas</td>
<td>555</td>
</tr>
<tr>
<td>Save Expected Values</td>
<td>180–181</td>
</tr>
<tr>
<td>Save Gradients by Subject</td>
<td>396, 405</td>
</tr>
<tr>
<td>Save Indiv Confid Limits</td>
<td>246</td>
</tr>
<tr>
<td>Save Inverse Prediction Formula</td>
<td>247</td>
</tr>
<tr>
<td>Save Leaf Label Formula</td>
<td>309</td>
</tr>
<tr>
<td>Save Leaf Labels</td>
<td>309</td>
</tr>
<tr>
<td>Save Leaf Number Formula</td>
<td>309</td>
</tr>
<tr>
<td>Save Leaf Numbers</td>
<td>309</td>
</tr>
<tr>
<td>Save Linear Constraints</td>
<td>545, 571</td>
</tr>
<tr>
<td>Save Loadings</td>
<td>501</td>
</tr>
<tr>
<td>Save Mixture Formulas</td>
<td>456</td>
</tr>
<tr>
<td>Save Mixture Probabilities</td>
<td>456</td>
</tr>
<tr>
<td>Save Percent Variation Explained for X Variables</td>
<td>501</td>
</tr>
<tr>
<td>Save Percent Variation Explained for Y Variables</td>
<td>501</td>
</tr>
<tr>
<td>Save Pred Confid Limits</td>
<td>246</td>
</tr>
<tr>
<td>Save Predicted</td>
<td>309, 313, 316</td>
</tr>
<tr>
<td>Save Predicted Values</td>
<td>48</td>
</tr>
<tr>
<td>Save Prediction Formula</td>
<td>246, 309, 313, 316, 501</td>
</tr>
<tr>
<td>Save Probability Formula</td>
<td>180</td>
</tr>
<tr>
<td>Save Quantiles</td>
<td>180–181</td>
</tr>
<tr>
<td>Save Residual Formula</td>
<td>247</td>
</tr>
<tr>
<td>Save Residuals</td>
<td>309, 313, 316</td>
</tr>
<tr>
<td>Save Scores and Distance</td>
<td>501</td>
</tr>
<tr>
<td>Save Specific Solving Formula</td>
<td>247</td>
</tr>
<tr>
<td>Save Specific Transformation</td>
<td>101</td>
</tr>
<tr>
<td>Save Spectral Density</td>
<td>340</td>
</tr>
<tr>
<td>Save Std Error of Individual</td>
<td>247</td>
</tr>
<tr>
<td>Save Std Error of Predicted</td>
<td>49, 247</td>
</tr>
<tr>
<td>Save to Data Table</td>
<td>15</td>
</tr>
<tr>
<td>Save to Script window</td>
<td>15</td>
</tr>
<tr>
<td>Save Utility Formula</td>
<td>396</td>
</tr>
<tr>
<td>Save X Residuals</td>
<td>501</td>
</tr>
<tr>
<td>Save Y Residuals</td>
<td>501</td>
</tr>
<tr>
<td>SBC</td>
<td>344</td>
</tr>
<tr>
<td>Scaled Estimates</td>
<td>62, 80</td>
</tr>
<tr>
<td>Scatterplot Matrix</td>
<td>426</td>
</tr>
<tr>
<td>scatterplot matrix</td>
<td>424</td>
</tr>
<tr>
<td>Schwartz’s Bayesian Criterion</td>
<td>344</td>
</tr>
<tr>
<td>Score Options</td>
<td>483</td>
</tr>
<tr>
<td>Score Plot</td>
<td>469</td>
</tr>
<tr>
<td>Scores Plot</td>
<td>493</td>
</tr>
<tr>
<td>Scores Plots</td>
<td>499</td>
</tr>
<tr>
<td>Scree Plot</td>
<td>469</td>
</tr>
<tr>
<td>screening analysis see Fit Model platform</td>
<td></td>
</tr>
<tr>
<td>Screening and Response Surface Methodology</td>
<td>13</td>
</tr>
<tr>
<td>screening design</td>
<td>80</td>
</tr>
<tr>
<td>Seasonal ARIMA</td>
<td>333</td>
</tr>
<tr>
<td>Seasonal ARIMA</td>
<td>348–349</td>
</tr>
<tr>
<td>seasonal exponential smoothing</td>
<td>362</td>
</tr>
<tr>
<td>seasonal smoothing weight</td>
<td>359</td>
</tr>
<tr>
<td>Second</td>
<td>335</td>
</tr>
<tr>
<td>Second Deriv Method</td>
<td>243</td>
</tr>
<tr>
<td>Second Deriv. Method</td>
<td>254</td>
</tr>
<tr>
<td>Second Derivatives</td>
<td>256, 261</td>
</tr>
<tr>
<td>select rows</td>
<td>448</td>
</tr>
<tr>
<td>select rows in data table</td>
<td>421</td>
</tr>
<tr>
<td>Sensitivity Indicator</td>
<td>542</td>
</tr>
<tr>
<td>Separate Response</td>
<td>379</td>
</tr>
<tr>
<td>Separate Responses</td>
<td>368</td>
</tr>
<tr>
<td>Sequential Tests</td>
<td>63</td>
</tr>
<tr>
<td>Seriesg.jmp</td>
<td>335</td>
</tr>
<tr>
<td>seriesJ.jmp</td>
<td>350</td>
</tr>
<tr>
<td>Set Desirabilities</td>
<td>544, 547</td>
</tr>
<tr>
<td>Set Random Seed</td>
<td>575</td>
</tr>
<tr>
<td>Set Script</td>
<td>544</td>
</tr>
<tr>
<td>Set To Data in Row</td>
<td>544</td>
</tr>
<tr>
<td>Shaded Ellipses</td>
<td>427</td>
</tr>
<tr>
<td>Shift-click</td>
<td>8</td>
</tr>
<tr>
<td>Ship</td>
<td>205</td>
</tr>
<tr>
<td>Ship Damage.JMP</td>
<td>205</td>
</tr>
<tr>
<td>Ship Damage.jmp</td>
<td>262</td>
</tr>
<tr>
<td>Show</td>
<td>542</td>
</tr>
<tr>
<td>Show Biplot Rays</td>
<td>456, 483</td>
</tr>
<tr>
<td>Show Canonical Details</td>
<td>483</td>
</tr>
<tr>
<td>Show Confidence Interval</td>
<td>346–347</td>
</tr>
<tr>
<td>Show Confidence Lines</td>
<td>497</td>
</tr>
<tr>
<td>Show Constraints</td>
<td>562</td>
</tr>
<tr>
<td>Show Correlations</td>
<td>427</td>
</tr>
<tr>
<td>Show Current Value</td>
<td>562</td>
</tr>
<tr>
<td>Show Derivatives</td>
<td>243, 264</td>
</tr>
<tr>
<td>Show Distances to each group</td>
<td>483</td>
</tr>
<tr>
<td>Show Formulas</td>
<td>542</td>
</tr>
<tr>
<td>Show Graph</td>
<td>236, 308</td>
</tr>
<tr>
<td>Show Histogram</td>
<td>427</td>
</tr>
<tr>
<td>Show Means CL Ellipses</td>
<td>483</td>
</tr>
<tr>
<td>Show Normal 50% Contours</td>
<td>483</td>
</tr>
<tr>
<td>Show Points</td>
<td>237, 308, 337, 346–347, 427, 483, 497, 562</td>
</tr>
<tr>
<td>Show Prediction Expression</td>
<td>59, 248</td>
</tr>
<tr>
<td>Show Probabilities to each group</td>
<td>483</td>
</tr>
<tr>
<td>Show Split Bar</td>
<td>308</td>
</tr>
<tr>
<td>Show Split Candidates</td>
<td>308</td>
</tr>
<tr>
<td>Show Split Prob</td>
<td>308</td>
</tr>
<tr>
<td>Show Split Stats</td>
<td>308</td>
</tr>
<tr>
<td>Show Tree</td>
<td>308</td>
</tr>
<tr>
<td>ShrinkageResidual</td>
<td>161</td>
</tr>
<tr>
<td>Sigma</td>
<td>351</td>
</tr>
<tr>
<td>Sigma</td>
<td>73</td>
</tr>
<tr>
<td>significance of model</td>
<td>36</td>
</tr>
<tr>
<td>significance probability</td>
<td>429</td>
</tr>
<tr>
<td>stepwise regression</td>
<td>117</td>
</tr>
<tr>
<td>simple exponential smoothing</td>
<td>360</td>
</tr>
<tr>
<td>Simulate</td>
<td>581</td>
</tr>
<tr>
<td>Simulation Experiment</td>
<td>575</td>
</tr>
<tr>
<td>Simulator</td>
<td>545, 572</td>
</tr>
<tr>
<td>Simulator</td>
<td>546</td>
</tr>
<tr>
<td>Sine</td>
<td>340</td>
</tr>
<tr>
<td>Single Linkage</td>
<td>452</td>
</tr>
<tr>
<td>singularity</td>
<td>631–634, 640</td>
</tr>
<tr>
<td>SLS fit</td>
<td>see Fit Model platform</td>
</tr>
<tr>
<td>Small Tree View</td>
<td>308</td>
</tr>
<tr>
<td>Smoothing Model dialog</td>
<td>359</td>
</tr>
<tr>
<td>smoothing models</td>
<td>333, 358–363</td>
</tr>
<tr>
<td>smoothing weight</td>
<td>359</td>
</tr>
<tr>
<td>Solubility.jmp</td>
<td>467</td>
</tr>
<tr>
<td>Solution table</td>
<td>99, 242, 248–249</td>
</tr>
<tr>
<td>Solve for Least Significant Number</td>
<td>74</td>
</tr>
<tr>
<td>Solve for Least Significant Value</td>
<td>74</td>
</tr>
<tr>
<td>Solve for Power</td>
<td>73</td>
</tr>
<tr>
<td>SOM Technical Details</td>
<td>463</td>
</tr>
<tr>
<td>SOMs</td>
<td>461</td>
</tr>
<tr>
<td>Sort Split Candidates</td>
<td>308</td>
</tr>
<tr>
<td>Source</td>
<td>30, 32, 34</td>
</tr>
<tr>
<td>sources</td>
<td>609–620</td>
</tr>
<tr>
<td>Spearman’s Rho</td>
<td>438</td>
</tr>
<tr>
<td>Spearman’s Rho</td>
<td>431</td>
</tr>
<tr>
<td>Spec Limits</td>
<td>575–576</td>
</tr>
<tr>
<td>Specified Value</td>
<td>307</td>
</tr>
<tr>
<td>Specify Differencing dialog</td>
<td>341</td>
</tr>
<tr>
<td>Spectral Density</td>
<td>339, 344</td>
</tr>
<tr>
<td>spectral density plots</td>
<td>333</td>
</tr>
<tr>
<td>sphericity</td>
<td>143, 145</td>
</tr>
<tr>
<td>Sphericity Test table</td>
<td>144</td>
</tr>
<tr>
<td>Split Best</td>
<td>306, 308</td>
</tr>
<tr>
<td>Split Here</td>
<td>306</td>
</tr>
<tr>
<td>Split History</td>
<td>308</td>
</tr>
<tr>
<td>split plot design</td>
<td>105</td>
</tr>
<tr>
<td>example</td>
<td>110–112</td>
</tr>
<tr>
<td>Split Specific</td>
<td>307</td>
</tr>
<tr>
<td>spring fitting machine</td>
<td>646–647</td>
</tr>
<tr>
<td>SS</td>
<td>122</td>
</tr>
<tr>
<td>SSE</td>
<td>30, 101, 122, 242, 248</td>
</tr>
<tr>
<td>SSE Grid</td>
<td>244, 253</td>
</tr>
<tr>
<td>SSR</td>
<td>30</td>
</tr>
<tr>
<td>SST</td>
<td>30</td>
</tr>
<tr>
<td>Stable</td>
<td>345</td>
</tr>
<tr>
<td>Stable Invertible</td>
<td>360</td>
</tr>
<tr>
<td>Stack</td>
<td>195</td>
</tr>
<tr>
<td>Stacked Daganzo.jmp</td>
<td>415</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>344</td>
</tr>
<tr>
<td>standard least squares</td>
<td>12, 23</td>
</tr>
<tr>
<td>estimates</td>
<td>57–87</td>
</tr>
<tr>
<td>introduction</td>
<td>21</td>
</tr>
<tr>
<td>prediction equation</td>
<td>89, 101</td>
</tr>
<tr>
<td>also see Fit Model platform</td>
<td></td>
</tr>
<tr>
<td>Term</td>
<td>Page Numbers</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Standardize Data</td>
<td>446</td>
</tr>
<tr>
<td>Standardized Estimate</td>
<td>83</td>
</tr>
<tr>
<td>statistical details</td>
<td>621–658</td>
</tr>
<tr>
<td>Std Beta</td>
<td>34</td>
</tr>
<tr>
<td>Std Dev Formula</td>
<td>161</td>
</tr>
<tr>
<td>Std Err Scale</td>
<td>85</td>
</tr>
<tr>
<td>Std Error</td>
<td>33, 41, 345</td>
</tr>
<tr>
<td>Std Error of Individual</td>
<td>48, 161</td>
</tr>
<tr>
<td>Std Error of Predicted</td>
<td>48, 161</td>
</tr>
<tr>
<td>Std Error of Residual</td>
<td>48</td>
</tr>
<tr>
<td>Std Narrow</td>
<td>84</td>
</tr>
<tr>
<td>StdErr Pred Formula</td>
<td>49</td>
</tr>
<tr>
<td>StdError Fitted</td>
<td>247</td>
</tr>
<tr>
<td>StdError Indiv</td>
<td>247</td>
</tr>
<tr>
<td>Step</td>
<td>121, 123, 241, 347</td>
</tr>
<tr>
<td>Step History table</td>
<td>120</td>
</tr>
<tr>
<td>stepwise regression</td>
<td>13, 117, 119, 128</td>
</tr>
<tr>
<td>categorical terms</td>
<td>127–128</td>
</tr>
<tr>
<td>Control panel</td>
<td>120–121</td>
</tr>
<tr>
<td>example</td>
<td>119, 123–126</td>
</tr>
<tr>
<td>Logistic</td>
<td>129</td>
</tr>
<tr>
<td>Stochastic Optimization.jmp</td>
<td>586</td>
</tr>
<tr>
<td>Stop</td>
<td>121, 241</td>
</tr>
<tr>
<td>Stop At Boundaries</td>
<td>554</td>
</tr>
<tr>
<td>Studentized Deviance Residuals by</td>
<td>214</td>
</tr>
<tr>
<td>Predicted</td>
<td></td>
</tr>
<tr>
<td>Studentized Pearson Residuals by</td>
<td>214</td>
</tr>
<tr>
<td>Predicted</td>
<td></td>
</tr>
<tr>
<td>Subject data</td>
<td>386</td>
</tr>
<tr>
<td>Submit to SAS</td>
<td>15, 347</td>
</tr>
<tr>
<td>substitution effect</td>
<td>54</td>
</tr>
<tr>
<td>subunit effect</td>
<td>105</td>
</tr>
<tr>
<td>Sum</td>
<td>140–141, 145–146</td>
</tr>
<tr>
<td>sum M matrix</td>
<td>146</td>
</tr>
<tr>
<td>Sum of Squared Errors</td>
<td>343</td>
</tr>
<tr>
<td>Sum of Squares</td>
<td>30, 32, 35</td>
</tr>
<tr>
<td>sum of squares</td>
<td>30</td>
</tr>
<tr>
<td>Sum of Squares Corrected Total</td>
<td>29</td>
</tr>
<tr>
<td>Sum of Weights</td>
<td>29</td>
</tr>
<tr>
<td>Sum Wgts</td>
<td>172</td>
</tr>
<tr>
<td>Summary of Fit table</td>
<td>4, 28–29</td>
</tr>
<tr>
<td>Surface Fill</td>
<td>530</td>
</tr>
<tr>
<td>Surface Plot</td>
<td>515</td>
</tr>
<tr>
<td>Constants</td>
<td>515</td>
</tr>
<tr>
<td>Control Panel</td>
<td>524</td>
</tr>
<tr>
<td>Dependent Variables</td>
<td>526</td>
</tr>
<tr>
<td>Variables</td>
<td>525</td>
</tr>
<tr>
<td>Surface Plot</td>
<td>558</td>
</tr>
<tr>
<td>Surface Profiler</td>
<td>571</td>
</tr>
<tr>
<td>Surface Profiler</td>
<td>91, 161–162, 213, 244, 517</td>
</tr>
<tr>
<td>survival regression</td>
<td>see Fit Model platform</td>
</tr>
<tr>
<td>symbolic derivative</td>
<td>264</td>
</tr>
<tr>
<td>synthetic denominator, effect</td>
<td>114</td>
</tr>
<tr>
<td>t Ratio</td>
<td>33, 82, 345</td>
</tr>
<tr>
<td>T^2 Statistic</td>
<td>431</td>
</tr>
<tr>
<td>Table Format</td>
<td>376</td>
</tr>
<tr>
<td>Table of Estimates</td>
<td>101</td>
</tr>
<tr>
<td>Table Transposed</td>
<td>377</td>
</tr>
<tr>
<td>Taguchi</td>
<td>155</td>
</tr>
<tr>
<td>Target</td>
<td>548</td>
</tr>
<tr>
<td>Term</td>
<td>33, 345</td>
</tr>
<tr>
<td>Test</td>
<td>143</td>
</tr>
<tr>
<td>Test Details</td>
<td>149, 151</td>
</tr>
<tr>
<td>Test Each Column Separately Also</td>
<td>140</td>
</tr>
<tr>
<td>Test Each Response</td>
<td>378, 380</td>
</tr>
<tr>
<td>Test Response Homogeneity</td>
<td>379</td>
</tr>
<tr>
<td>Test Response Homogeneity</td>
<td>378</td>
</tr>
<tr>
<td>test set</td>
<td>497</td>
</tr>
<tr>
<td>Test Slices</td>
<td>46</td>
</tr>
<tr>
<td>Time Frequency</td>
<td>335</td>
</tr>
<tr>
<td>Time ID role</td>
<td>335</td>
</tr>
<tr>
<td>Time Series Graph</td>
<td>337</td>
</tr>
<tr>
<td>Time Series platform</td>
<td>333, 335–363</td>
</tr>
<tr>
<td>ARIMA</td>
<td>347–349</td>
</tr>
<tr>
<td>commands</td>
<td>336–342</td>
</tr>
<tr>
<td>example</td>
<td>335–336</td>
</tr>
<tr>
<td>launch</td>
<td>335–336</td>
</tr>
<tr>
<td>modeling report</td>
<td>342–347</td>
</tr>
<tr>
<td>Seasonal ARIMA</td>
<td>348</td>
</tr>
<tr>
<td>smoothing models</td>
<td>358–363</td>
</tr>
<tr>
<td>Time Series Plot</td>
<td>336</td>
</tr>
<tr>
<td>Time Series role</td>
<td>335</td>
</tr>
<tr>
<td>Tiretread.jmp</td>
<td>519–520, 539, 582, 595</td>
</tr>
<tr>
<td>tiretread.jmp</td>
<td>549</td>
</tr>
<tr>
<td>Traditional statistics</td>
<td>12</td>
</tr>
<tr>
<td>training set</td>
<td>497</td>
</tr>
<tr>
<td>Transfer Function</td>
<td>355</td>
</tr>
<tr>
<td>Transfer Function Models</td>
<td>350</td>
</tr>
<tr>
<td>Transfer Function Models</td>
<td>333</td>
</tr>
<tr>
<td>transform covariate</td>
<td>53</td>
</tr>
<tr>
<td>Transformations</td>
<td>12</td>
</tr>
<tr>
<td>Transition Report</td>
<td>378</td>
</tr>
<tr>
<td>transmitted variation</td>
<td>594</td>
</tr>
<tr>
<td>tree diagram</td>
<td>447</td>
</tr>
<tr>
<td>trend</td>
<td>359</td>
</tr>
</tbody>
</table>
Variance Effect Likelihood Ratio Tests 160
Variance Estimate 344
Variance Formula 161
Variance Parameter Estimates 160
Varimax 473
VarioGram 333, 338, 342
VIF 34

W-Z
Wald test 174, 189
Ward's 452
Weekly 335
Weight role 7, 233, 257, 259
Weld-Repaired Castings.jmp 226
Whole Effects 127
Whole Model Leverage Plot 24, 37
Whole Model table 28, 142, 170
Wilcoxon rank-sum 644
Wilk's Lambda 143
Winter's method 362
within-subject 110, 144, 146
X role 255–256, 258, 263, 335
X, Predictor Formula 232
Y role 3, 7, 231–232, 335, 446
Y, Prediction Formula 337
zero eigenvalue 100
Zero To One 360
zeroed 626

U
uncertainty 645
Unconstrained 360
Unit Odds Ratios 175
Univariate 424
Univariate Tests Also 140, 144, 146
unrestricted vs. restricted parameterization 107
Unthreaded 243
Up Dots 558, 562
US Population.jmp 231, 245
Use Cross Validation 492
User Specified 492
USL Chop 585
usual assumptions 643–645

V
validity 644
Value 143
Variability Chart platform 103
variance components 105, 107